The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

PRODUCT MODULES AND OPTIONS. This guide contains descriptions of modules that are optional and for which you may not have purchased a license. Siebel’s Sample Database also includes data related to these optional modules. As a result, your software implementation may differ from descriptions in this guide. To find out more about the modules your organization has purchased, see your corporate purchasing agent or your Oracle sales representative.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS. Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.
Contents

Chapter 1:  What’s New in This Release

Chapter 2:  Overview of Field Service
Field Service  27
  Managing the Full Cycle of Field Service  28
  Dispatch Board  29
  Siebel Scheduler  30
  Mobile Computing Support  30
  Service Parts Information  31
  Field Service Engineer Information  31
  Field Service Engineer Activities  31
  Service Inventory  31
  Agreements and Contract Management  31
  Preventive Maintenance and Asset Measurements  32
  Shipping and Receiving  32
  Oracle Business Intelligence  33
  Siebel Wireless for Field Service  33
Field Service Application Design  33
Siebel Professional Services Automation  33
  Field Service Engines  33
Administrative Tasks  34

Chapter 3:  Service Support
Processing a Request for Service  37
Setting Up Service Support  38
  Creating a Service Activity Template  38
  Setting Up Service Metrics  39
  Setting the Default Opened Date and Time for an SR  39
Process Flow for Logging Service Requests  40
  Logging Service Requests  41
  Generating a Service Charge Quote  43
Updating a Service Request  43
  Generating Correspondence for a Service Request  45
Contents

Resolving a Service Request  46

Accounts Screen  46
  Accounts Across Organizations View  47
  Accounts View  48
  Contacts View  48
  Agreements View  48
  Entitlements View  48
  Service Profile View  48
  Account Reports  49

Service Screen  49
  Service Requests Across Organizations  50
  Service Requests Views  51
  Activity Plans View  56
  Activities View  56
  Attachments View  56
  Audit Trail View  56
  Calendar View  56
  Change Requests View  57
  Decision Issues View  57
  Messages View  57
  Service Details View  57
  Service Hours View  58
  Survey View  58
  Invoices View  58
  Metrics View  58
  Orders View  59
  Solutions View  59
  Charts View  59

Service Reports  61
  Audit Trail Overview  61
    Audit Trail Content  62
    Audit Trail for Siebel Remote Users  62

Service Request Solutions  63
  Setting Up Problem Resolutions  63

Setting Up Solutions  63
  Editing Resolution Documents  64

Administration - Solution Screen  65
  Solutions View  65
  Resolution Documents View  66
  Related Solutions View  66
Service Requests View  66
Change Requests View  66
Solution Categories View  66

Solutions Screen  66
Solutions View  67
Resolution Documents View  67
Related Solutions View  67
Service Requests View  67
Change Requests View  67
Customer Satisfaction Survey View  67

Chapter 4:  Field Service Activities

Field Service Activities  69
Field Service Activity Templates and Activity Plans  71
Category Field  72

Setting Up Field Service Activities  73
Setting Up Field Service Activity Templates  73
Alarms for Field Service Activities  74

Recording Field Service Activities  75
Monitoring Field Service Activities  78

Administration - Application Screen  78
Activity Templates View  79

Activities Screen  79
All Activities View  80
Charges View  82
Expense Tracker View  82
Part Tracker View  82
Instructions View  84
Invoices View  84
Readings View  84
Items View  85
Schedule View  85
Assignment Skills View  85
Steps View  86
Time Tracker View  86
Charts View  87

Activity Reports  87

Products Screen  88
Product Service Details View  88
Contents

Part Browser Screen  89
Using the Task UI Application to Perform Field Service Activities  89
  Scenario for Performing Field Service Activities with the Task UI Application  90
  Activating and Registering Tasks for Field Service Activities  90
  Example of Using the Task UI Application to Execute a Field Service Activity  90

Chapter 5: Setting Up and Using Scheduling
About Schedules in Siebel Field Service  94
About Siebel Scheduler  94
About the Appointment Booking System  96
Scenario for the Appointment Booking System  96
About the Scheduling Optimizer  96
About Schedule Horizons and Time Zones  98
About Scheduling Heuristic Methods  100
What Happens During Appointment Booking?  101
Guidelines for Setting Up Scheduling  102
  Rules Enforced by the Appointment Booking System  103
  Guidelines for Integrating Scheduling with Wireless Updates  103
  Guidelines for Integrating Scheduling with a Service Inventory System  104
  Guidelines for Integrating Preventive Maintenance with the Appointment Booking System  104
  Guidelines for Optimizing Schedules  104
Process of Setting Up Scheduling  106
Defining Schedule Hours  107
  Setting Hours of Availability  107
  Setting Exception Hours  108
Defining Service Regions  109
  Creating Service Regions  110
  Associating Schedules with Service Regions  112
  Specifying Parent Service Regions  112
  Defining Service Region Geographic Areas for the Optimizer  113
Defining Employee Availability and Schedules  116
  Defining Hours for Employees  117
  Adding Employee Schedule Information  118
  Specifying Employees as Unavailable  121
Creating Time Windows for Scheduling  121
Creating Constraint Sets for Scheduling  122
Defining Constraints 126
Defining Constraint Sets 126
Creating Parameter Sets for Scheduling 127
Defining Cost Functions for the Optimizer 134
Setting Up Server Key Mappings 136
Setting Server Component Task Parameters 139
Reloading the ABS and Optimizer Caches 140
  Loading Employee Data for Service Regions 142
  Loading Activities for Service Regions 143
  Reloading Service Regions to the Appointment Booking System Cache Manually 144
  Overriding a Row Limit 144
  Coalescing the Appointment Booking System 145
  Reloading Service Regions to the Optimizer Cache Manually 145
  Reloading the Appointment Booking System Cache Using Workflows 146
Process of Scheduling Activities 148
Adding Schedule Information for Activities (End User) 148
Booking Activity Appointments (End User) 150
  Booking Appointments from the Activities Screen 151
  Booking Appointments from the Service Screen 152
  Canceling Appointments 152
Locking Schedules and Assignments (End User) 153
Optimizing Schedules (End User) 155
  Optimizing Schedules Manually 156
  Stopping the Optimization of a Service Region 157
  About Optimization and Activity Status 157
Running Contract Scheduling (End User) 157
About Troubleshooting the Appointment Booking System and Optimizer 159
  Troubleshooting the Appointment Booking System 160
  Troubleshooting the Optimizer 163
About Configuring the Appointment Booking Display 165
About Enhancing the Performance of Siebel Scheduler 166
About the Relationship of Scheduler to the Server Request Broker 167
About Loading and Reloading Service Region Data 169
About Using Application Deployment Manager 171
Chapter 6: Setting Up and Using the Dispatch Board

About the Dispatch Board 173
About Process Flows for Dispatch Board Scheduling 174
Dispatch Board Screen Interface 175

Process of Setting Up the Dispatch Board 177
- Setting System Preferences for the Dispatch Board 178
- Setting User Preferences for the Dispatch Board 178
- Optimizing Display Speeds for the Dispatch Board 181
- Setting Up Dispatcher Users 183
- Displaying Additional Information on the Dispatch Board Y-Axis 183
- Adding Drilldowns to the Dispatch Board 185
- Adding Query Fields to the Dispatch Board 187
- Changing the Label Information Displayed on the Dispatch Board 188
- Changing the Time Zoom Intervals on the Dispatch Board 189
- Changing the Days of the Week Displayed on the Dispatch Board 190
- Enabling Applets for Drag and Drop onto the Dispatch Board 191
- Adding User Preference Colors for the Dispatch Board 192
- Optimizing Display Space on the Dispatch Board 193
- Restricting the Employees that Display on the Dispatch Board 194

Process of Assigning Activities 195
- Selecting Data to Display in the Dispatch Board’s Gantt Chart (End User) 195
- Searching for Activities in the Dispatch Board’s Gantt Chart (End User) 196
- Assigning Field Service Engineers for Activities (End User) 196
- Creating Activities with the Dispatch Board (End User) 198

About Using the Dispatch Board Gantt Chart to Assign Activities 198
About Rescheduling Appointments in the Dispatch Board 199

Chapter 7: Agreements

Agreements Overview 201
- Automatic Entitlements 202
- Agreement Management 202
- Agreement Charges and Invoicing 202

Process of Setting Up Agreements 202
- Defining Pricing for Agreements 203
- Setting Up Agreement Renewal 205
- Setting Up Agreement Validation 207
- Setting Up Agreement Approval 209
- Creating Agreements from Orders and Quotes 210
- Configuring Data Maps to Copy Specified Items 213
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating an Opportunity and Quote from an Agreement Line Item Renewal</td>
</tr>
<tr>
<td>Adding Assets to Agreement Line Items</td>
</tr>
<tr>
<td>Creating Revenue Plan Templates</td>
</tr>
<tr>
<td>Creating Term Templates</td>
</tr>
<tr>
<td>Running Charge Plans Using Workflows</td>
</tr>
<tr>
<td>Entitlements Overview</td>
</tr>
<tr>
<td>Process of Setting Up Entitlements</td>
</tr>
<tr>
<td>Setting System Preferences for Verifying Entitlements</td>
</tr>
<tr>
<td>Checking User Properties for Entitlements</td>
</tr>
<tr>
<td>Creating Entitlement Templates</td>
</tr>
<tr>
<td>Adding Schedule Information for Entitlements</td>
</tr>
<tr>
<td>Adding Escalation Times to Entitlements</td>
</tr>
<tr>
<td>Configuring Auto-Entitlement for Quotes and Orders</td>
</tr>
<tr>
<td>Process of Creating Agreements</td>
</tr>
<tr>
<td>Defining Agreements</td>
</tr>
<tr>
<td>Defining Charge Plans for Agreement Line Items</td>
</tr>
<tr>
<td>Defining Conditional Charge Plans for Agreement Line Items</td>
</tr>
<tr>
<td>Managing Agreement Line Item Revenue</td>
</tr>
<tr>
<td>Creating Documents for Agreements, Quotes, and Orders</td>
</tr>
<tr>
<td>Adding Agreement Terms to Agreements</td>
</tr>
<tr>
<td>Using Co-Terms</td>
</tr>
<tr>
<td>Process of Creating Entitlements</td>
</tr>
<tr>
<td>Defining Entitlements</td>
</tr>
<tr>
<td>Adding Service Request Information to Entitlements</td>
</tr>
<tr>
<td>Adding Preventive Maintenance Information to Entitlements</td>
</tr>
<tr>
<td>Workflows for Entitlement Creation and Verification</td>
</tr>
<tr>
<td>Workflow to Automatically Create Entitlements from an Entitlement Template</td>
</tr>
<tr>
<td>Workflow to Verify Entitlements on an Activity</td>
</tr>
<tr>
<td>Workflow to Verify Entitlements on an Order</td>
</tr>
<tr>
<td>Workflow to Verify Entitlements on a Quote</td>
</tr>
<tr>
<td>Workflow to Verify Entitlement on a Service Request</td>
</tr>
<tr>
<td>Workflow to Verify Entitlement with Best Response Time on a Service Request</td>
</tr>
<tr>
<td>Workflows for Agreement Renewal and Approval</td>
</tr>
<tr>
<td>Workflow to Automatically Renew Agreement Line Items</td>
</tr>
<tr>
<td>Workflow to Automatically Renew All Agreement Line Items</td>
</tr>
<tr>
<td>Workflow to Approve Agreements</td>
</tr>
<tr>
<td>Administration - Application Screen</td>
</tr>
<tr>
<td>Administration - Pricing Screen</td>
</tr>
<tr>
<td>Service Pricing View</td>
</tr>
</tbody>
</table>
Contents

Administration - Contracts Screen 247
   Entitlement Templates View 247
Administration - Product Screen 250
   Entitlements View 251
Agreements Screen 251
   Agreements List View 252
   Line Items View 253
   Entitlements View 255
   Service Requests View 257
   Financials View 257
   Terms and Totals View 259
   Activities View 259
   Activity Plans View 259
   Approval History View 259
   Attachments View 259
   Discounts View 260
   Notes View 260
   Orders View 260
Entitlements Screen 260
Agreements Charts 260
Agreements Reports 261

Chapter 8: Siebel Advanced Contracts
About Advanced Contracts 263
Scenario for Advanced Contracts 264
Process of Managing Advanced Contracts 265
Creating Benefit and Condition Templates 266
Adding Terms to Agreements 270
Adding Benefits to Agreements 271
Adding Conditions to Benefits 272
Verifying Compliance 272
About Workflows for Advanced Contracts 273
About Business Services for Advanced Contracts 274
   Contracts Accumulator Service 274
   Contracts Resolver Service 275
   Condition Evaluator Service 278
About Configuring the Revise Button 279
About Configuring the Add Benefits Button 279
About Configuring the Entitle Button 279
Using the Task UI Application to Add Assets to Agreements 280
  Scenario for Adding Assets to Agreements with the Task UI Application 280
  Activating and Registering Tasks for Adding Assets to Agreements 280
  Example of Using the Task UI Application to Add Assets to Agreements 281

Chapter 9: Charges and Invoices
Charges and Invoices Overview 283
About Cost, Price, and Rate Lists 284
Invoice Logic 285
  Logic for Service Requests 285
  Logic for Activities 286
  Logic for Agreements 286
Process of Setting Up Charging 288
  Setting Up NRC Plans 288
  Setting Up Use Plans 289
  Setting Up Conditional Charge Plans 293
  Defining Contract Schedules 294
Creating Charges 294
Recording Billable Expenses 295
Processes for Setting Up Invoicing 296
  Process for Setting Up Auto-Invoice 297
  Process for Setting Up Customized Invoices 297
  Creating Charge Consolidation Plans 297
Creating Invoices 298
  Creating Invoices Manually 298
  Generating Invoices Using Auto-Invoice 299
  Consolidating Charges to Create Invoices 300
Post-Generation Invoice Tasks 300
Workflows for Charges and Invoices 301
  Workflow to Create Agreement Charges 302
  Workflow to Generate All Agreement Charges 303
  Workflow to Create Conditional Charges 304
  Workflow to Consolidate Charges 304
  Workflow to Batch Consolidate Charges 306
Running Charges After Charge Consolidation Has Been Performed  307
Improving Workflow Performance and Scalability  307

Charges and Invoices Screens  308
  Service Screen  308
  Activities Screen  308
  Administration - Contracts Screen  310
  Agreements Screen  311
  Contacts Screen  313
  Accounts Screen  313
  Invoices Screen  314
  Invoice Report  317

Chapter 10: Using Third-Party Invoicing Applications
  Invoicing Integration Overview  319
    Invoicing Integration Terms  319
  Required Setup Procedures  320
    Configuring the Web Service  320
  Optional Setup Procedures  320
    Extending the Data Set  320
    Turning Off Invoicing  321
    Customizing Invoicing  321

Chapter 11: Fulfillment
  Fulfillment Overview  323
    Fulfillment Engine  323
    Part Locator Engine  328
  Parameters for the Fulfillment and Part Locator Engines  328
    Substitution and Allocation Flags  330
  Parameters for the Fulfillment Engine  331
    Setting Parameters for the Fulfillment and Part Locator Engines  333
    Invoking the Fulfillment Engine  334
  Setting Up and Configuring Order Fulfillment  334
    Setting Up Order Processes  334
    Setting Up the Fulfillment and Part Locator Engines  335
  Fulfilling Orders  335
  Administration - Product Screen  337
    Products View  337
    Product Service Details View  338
Administration - Data Screen 340
   Order Actions View 341
   Order Types View 341

Service Order Screen 341
   Line Items View 341
   Fulfillment View 344

Chapter 12: Service Inventory

Service Inventory Overview 345
   Inventory Structure 347
   Inventory Locations 348
   Inventory Relationships 351
   Tracking an Inventory Location 352
   Inventory and Product Serialization 354
   Asset Transactions 354
   Inventory Transactions 355
   Bulk Inventory Transactions 359
   Mobile Inventory Transactions 359

Setting Up Service Inventory 361
   Defining Products for Field Service 361
   Setting Up an Inventory 362
   Setting Up Inventory Transactions 363
   Synchronizing Remote and Local Databases 364

Tracking Inventory 364

Creating Inventory Transactions 365

Scraping Inventory 366

Administration - Service Screen 366
   Parts Movement Administration View 366
   Inventory Administration View 367

Administration - Product Screen 368
   Products View 368
   Product Service Details View 368

Inventory Screen 368
   Inventory Locations View 369
   Product Inventory View 370
   Generate Orders View 371
   Pending Orders View 371
   Vendors View 371
   Relationships View 371
Chapter 13: Shipping and Receiving

Shipping Orders
- Process Shipment Button

Receiving Orders

Checks and Validations for Shipping and Receiving
- Process Receipt Button

Shipping and Receiving Hierarchical Assets

Processing and Tracking Shipments

Processing and Tracking Receipts

Shipping Screen
- Shipments View

Shipping Reports

Receiving Screen
- All Pending Orders View
- Receive Orders Views
- Line Items Receipts View
- All Unknown Receipts View

Chapter 14: Quality

Features of Siebel Quality
- Quality and Release Manager

Example Process for Quality
- Process for Setting Up and Maintaining Quality
- Process for Logging Change Requests
- Process for Assessing Change Requests
- Process for Resolving Change Requests
Process for Verifying Change Request Closures 397
Process for Creating Patch Requests 398
Setting Up Roles and Responsibilities 399
Setting Up Lists of Values 399
Mapping Area-Subarea Combinations 401
Adding Release Product Builds 402
Logging Change Requests (QA End User) 403
Assessing Change Requests (Product Marketing End User) 405
Resolving Change Requests (Engineering End User) 408
Verifying Change Request Closures (QA End User) 413
Creating Patch Requests (Release Management End User) 414

Chapter 15: Cycle Counting and Replenishment

Cycle Counting 417
  Configuration of the Cycle Counting Engine 419
  System Preferences for the Cycle Counting Engine 421
  Parameters for the Cycle Counting Engine 422
  Invoking the Cycle Counting Engine 422
  Tracing Levels for the Cycle Counting Engine 423

Setting Up Cycle Counting 423
Running the Cycle Counting Engine 426

Replenishment Engine 427
  Configuration Parameters of the Replenishment Engine 428
  System Preferences for the Replenishment Engine 428
  Parameters for the Replenishment Engine 430
  Setting the Implementation Logic for the Replenishment Engine 430
  Invoking the Replenishment Engine 431

Setting Up Replenishment 432
Replenishing Inventory 432
Administration - Service Screen 433
  Inventory Location Types View 434
Products Screen 434
  Service Details View 434
Inventory Screen 435
  Inventory Locations View 436
Cycle Counts Screen 439
Cycle Counts Views 439
Cycle Counting Report 440

Chapter 16: Release Manager

Release Manager 441
  Release Manager Structure 442
  Product Release Process 443

Business Scenario for Release Manager 444
  Setup Scenario for Administrators 445
  Scenario for Product Marketing 445
  Scenario for Engineering 445
  Scenario for Quality Assurance 445
  Scenario for Technical Publications 446
  Maintenance Scenario for Administrators 446

Example Process Flow for Release Manager 446
  Administrator Setup Procedures 447
  Product Marketing End-User Procedures 447
  Engineering End-User Procedures 447
  Quality Assurance End-User Procedures 447
  Technical Publications End-User Procedures 448
  Administrator Maintenance Procedures 448

Administrator Setup Procedures for Release Manager 448
  Setting Up Releases 449
  Setting Up the Access List 449
  Setting Up Project Teams 449
  Setting Up Lists of Values 450
  Setting Up Activity Templates 452

Product Marketing End-User Procedures for Release Manager 452
  Creating Features and Subfeatures 453
  Adding MRDs 454
  Monitoring Features and MRDs 454
  Monitoring Release Items 454

Engineering End-User Procedures for Release Manager 455
  Adding Engineering Tasks and Linking Features 456
  Adding a Subtask to an Engineering Task 457
  Monitoring Engineering Tasks 457

Quality Assurance End-User Procedures for Release Manager 457
  Creating Test Plans and Linking Features 457
Creating Test Strategies 459
Recording a Test Pass and Linking a Test Plan 460
Associating Change Requests with a Test Pass 461
Monitoring Test Results 461

Technical Publications End-User Procedures for Release Manager 462
Creating Technical Documents and Linking Features 462
Adding Activity Plans to Technical Documents 463

Administrator Maintenance Procedures for Release Manager 463
Adding Product Prototypes 464
Synchronizing with Microsoft Project 464
Adding New Area and Subarea Combinations 464
Updating Test Plans and Test Strategies 465

Chapter 17: Assets
Properties of Assets 467
Asset Serialization 468
Asset Registration 469
Hierarchical Assets 469
Asset Transactions 469
Asset Swaps 470
Setting Up Assets 470
Creating Transactions and Components 472
Creating a Hierarchical Asset from a Product Bundle 472
Defining Field Engineer Assignments 472
Asset Mapping 476
Defining Asset Measurements 476
Obtaining Asset Information 477
Calculating the Value and Cost of an Asset 478
Associating Measurements with Assets 479
Recording Readings from Assets 479
Asset Dispatch Board 480
Setting User Preferences for the Asset Dispatch Board 480
Asset Dispatch Board Screen Interface 481
Using the Information Display Controls in the Gantt Chart 481
Scheduling Asset Activities 483
Administration - Pricing Screen 483
Asset Mapping View 484
Assets Screen 484
Assets View 485
Chapter 18: Warranties

Warranties 493
Setting Up Warranties 494
Obtaining Information Warranties 496
Administration - Service Screen 498
  Warranties View 498
Assets Screen 499
  Warranty View 499
Service Order Screen 499
  Warranty Subview 499
Products Screen 500
  Warranties View 500
Repairs Screen 500
  More Info View 500
Service Screen 500
  Service Details View 500

Chapter 19: Preventive Maintenance

Preventive Maintenance 501
Preventive Maintenance Triggers 502
  Logic Governing Triggers 503
  Prioritization of PM Plans for Date and Time Interval Triggers 504
Time Interval Triggers 505
Date Triggers 507
Usage Triggers 508
Threshold Triggers 508
Event Triggers 509

PM Plans and Actions 509
Service Request Templates 509

Preventive Maintenance Engine 510
  Validating PM Plans for an Asset 510
  Running the Preventive Maintenance Engine 511
  System Preferences for the Preventive Maintenance Engine 512
  Parameters for the Preventive Maintenance Engine 513

Setting Up the Preventive Maintenance Engine 515

Generating Preventive Maintenance Activities 517

Administration - Service Screen 518
  Service Request Templates View 518
  Service Request Template Activities View 518

Preventive Maintenance Screen 518
  Plans View 519
  Triggers View 520
  Products View 521
  Actions View 522
  History View 523

Assets Screen 523
  Plans Subview 523
  History Subview 523

Agreements Screen 523
  Preventive Maintenance Subview 523

Chapter 20: Repairs

Siebel Repair 525
  How Items Are Received for Repair 527
  Repair Numbers 527
  Repair Activities 528
  Repair Orders 528
  Asset Repair Histories 528
Contents

Process of Generating Inventory Transactions for Repairs 528
Setting Up and Configuring Repairs 531
  Setting Up Repair Activities 531
  Processing Defective Items for Repair 531
Repairs Screen 535
  More Info View 536
  Activity Plans View 536
  Activities View 536
  Repair Reports 536
Assets Screen 536
  Repairs View 536

Chapter 21: Barcodes

Barcode Concepts and Terms 537
Barcode Reader Input 537
The Barcode Interface 538
  The Barcode Toolbar 539
  Printing Barcodes in Reports 541
  Scanning Barcodes for Toolbar Actions 541
  Entering Information from a Barcode Reader 542
  Finding Information with a Barcode Reader 542
Setup and Configuration for Barcode Reading 543
  Setting Up a Barcode Interface 543
  Changing the Barcode Font for a Report 543

Appendix A: Engines Logging Levels

Business Service Engines for Siebel Field Service 545
  Server Component Aliases 545
  Logging Levels 546

Appendix B: Business Service Methods Reference for Field Service

Agreements 548
  FS Agreement Charge Business Service 548
  CalculateRCAdjustAmount Method 549
  GenerateAdjustmentCharge Method 549
  GenerateNRCCCharge Method 549
  GenerateRCCharge Method 549
  GenerateUsageCharge Method 550
FS Agreement Renewal Business Service 550
RenewAgreement Method 550
RenewAllAgreements Method 551
FS Holiday API Service 551
GetElapsedBusinessTime Method 551
IsHoliday Method 551
ISS Copy Service Business Service 552

Asset Management 552
FS Asset Swap Service Business Service 552
SwapAssetEntitlements Method 553
SwapAssetWarranties Method 553
FS Asset Warranty Service Business Service 554
CheckAssetWarranty Method 554
CreateAssetWarranty Method 554
GetAssetWarranties Method 555

Charges 555
FS Generate Conditional Charge Process Business Service 555
GenerateCharge Method 556
GetCondCharge Method 556
FS Service Charge Business Service 556
CreateExpenseCharge Method 558
CreateExpenseEntitlementCharge Method 559
CreateOrderCharges Method 559
CreatePartsCharge Method 560
CreatePartsEntitlementCharge Method 560
CreateServiceCharges Method 560
CreateTimeCharge Method 561
CreateTimeEntitlementCharge Method 561

Cycle Counting 561
FS Cycle Counting Business Service 562
GenerateCounts Method 562

Dispatch Board 562
FS Dispatch Board Utils Business Service 562
AssetAssignActivity Method 563
AssetUnassignActivity Method 563
AssignActivity Method 564
CalculateFromToAddresses Method 564
CalculateDistanceVals Method 565
GetCalculatedDistanceVals Method 566
GetEmployeeScores Method 566
GetWirelessCoverage Method 566
UnassignActivity Method 567
FS Service Region Business Service 567
GetServiceRegionId Method 567
FS Activity Cache Business Service 568
CleanUpCacheTable Method 568

Entitlements 568
FS Create Entitlement Business Service 568
CreateCoveredProds Method 569
CreateEntitlements Method 569
GetEntitlementTemplates Method 570
ValidateEntitlementTemplates Method 570
FS Verify Entitlement Business Service 570
GenerateList Method 571
GetBestPricedEntitlement Method 571
GetBestResponseTime Method 571
GetNextItem Method 572
GetPrice Method 572
GetResponseTime Method 572
GetTimeZone Method 573
ShowEntitlementPickList Method 573
UpdateEntitlementCounter Method 574
VerifyPricingEntitlement Method 574
VerifyServiceEntitlement Method 574

Fulfillment 574
FS Fulfillment Service Business Service 575
Fulfill Method 575
GenPickTickets Method 576
FS Part Locator Service Business Service 576
Locate Method 577

Inventory 577
FS Inventory Transaction Business Service 577
AddAssetsToTxn Method 577
AggrAssetsPerProdPerSource Method 578
BulkTransfer Method 578
CommitTxn Method 578
GetDetails Method 578
SetTxnDetails Method 579
SetTxnDetailsFromTxnSet Method 579

Invoices 579
FS Charge Consolidation Business Service 579
CancelInvoice Method 579
Contents

ConsolidateCharge Method 580

Preventive Maintenance 580
  FS Preventive Maintenance Business Service 580
  GeneratePM Method 580

Replenishment 581
  FS Replenish Business Service 581
  GenerateOrder Method 581
  UnlockAllInventories Method 581

Scheduling 582
  Invoking the ABS and Optimization Engine Methods 582
  ABS Methods 584
  CancelAppointment Method 585
  CancelRequest Method 585
  ConfirmAppointment Method 586
  DefragmentServiceRegion Method 587
  GetAppointment Method 587
  GetAppointments Method 588
  GetConfirmedAppointment Method 590
  LoadActivities Method 591
  LoadEmployees Method 592
  ReloadServiceRegion Method 592
  UnloadEmployees Method 593
  Optimization Engine Methods 593
  CancelAppointment Method 594
  GetConfirmedAppointment Method 594
  LoadActivities Method 595
  LoadEmployees Method 596
  Optimize Method 596
  ReloadServiceRegion Method 597
  StopOptimize Method 598
  UnloadEmployees Method 599

Index
Table 1 lists changes described in this version of the documentation to support release 8.0 of the software.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Optimizing Display Speeds for the Dispatch Board” on page 181</td>
<td>Clarified topic.</td>
</tr>
<tr>
<td>“Time Interval Triggers” on page 505</td>
<td>New user scenario and clarified the topic.</td>
</tr>
<tr>
<td>“Scheduling Parameters” on page 128</td>
<td>Clarification to Optimizer-Glued parameter and Optimizer - Save Interval parameter in table.</td>
</tr>
<tr>
<td>“Optimizing Display Space on the Dispatch Board” on page 193</td>
<td>New subtopic. Users can change the number of rows of employee information that is displayed, and also change the height of the display area.</td>
</tr>
<tr>
<td>“Restricting the Employees that Display on the Dispatch Board” on page 194</td>
<td>New subtopic. Users can determine the employees that display by selecting a service region and entering a date in the Dispatch Board.</td>
</tr>
<tr>
<td>“About Optimization and Activity Status” on page 157</td>
<td>New subtopic. The Optimizer can change the status of activities to obtain the best scheduling.</td>
</tr>
<tr>
<td>“Setting Up the Preventive Maintenance Engine” on page 515</td>
<td>New procedures for associating activity templates with a preventive maintenance (PM) plan, and associating service request templates with a PM plan.</td>
</tr>
<tr>
<td>“Actions View” on page 522</td>
<td>New information on the preventative maintenance trigger.</td>
</tr>
</tbody>
</table>
### What’s New in Siebel Field Service Guide, Version 8.0, Rev. A

Table 2 lists changes described in this version of the documentation to support release 8.0 of the software.

#### Table 2. New Product Features in Siebel Field Service Guide, Version 8.0, Rev.A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Bulk Inventory Transactions” on page 359</td>
<td>Describes how to transfer multiple assets to new inventory locations.</td>
</tr>
<tr>
<td>“FS Inventory Transaction Business Service” on page 577</td>
<td>Describes the new business service for transferring assets.</td>
</tr>
</tbody>
</table>


Table 3 lists changes described in this version of the documentation to support release 8.0 of the software.


<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 8, “Siebel Advanced Contracts”</td>
<td>This chapter has been moved from the 7.8 Siebel Life Sciences Guide and revised for this guide.</td>
</tr>
<tr>
<td>“Recommendation Field” on page 53</td>
<td>Describes the new Recommendation field for performing actions on a service request.</td>
</tr>
<tr>
<td>“Audit Trail Overview” on page 61</td>
<td>Describes changes in the Audit Trail functionality.</td>
</tr>
<tr>
<td>“Using the Task UI Application to Perform Field Service Activities” on page 89</td>
<td>Describes the new Task UI task for executing field service activities.</td>
</tr>
<tr>
<td>“Using the Task UI Application to Add Assets to Agreements” on page 280</td>
<td>Describes the new Task UI task for associating assets with contracts.</td>
</tr>
<tr>
<td>“FS Holiday API Service” on page 551</td>
<td>Describes the new service for calculating business time, committed time, and holidays.</td>
</tr>
</tbody>
</table>
This chapter describes the field service process, the application design, and the administrative tasks associated with Field Service. Topics include:

- Field Service on page 27
- Field Service Application Design on page 33
- Siebel Professional Services Automation on page 33
- Administrative Tasks on page 34

## Field Service

The field service process begins with service requests and orders. A service request is a customer’s request for information about or assistance with products or services. An order is a commitment on the part of the customer to purchase products and services at a specific price. Service requests are described in Chapter 3, “Service Support,” in this guide. Orders are described in Siebel Order Management Guide. Topics include:

- Managing the Full Cycle of Field Service on page 28
- Dispatch Board on page 29
- Siebel Scheduler on page 30
- Mobile Computing Support on page 30
- Service Parts Information on page 31
- Field Service Engineer Information on page 31
- Field Service Engineer Activities on page 31
- Service Inventory on page 31
- Agreements and Contract Management on page 31
- Preventive Maintenance and Asset Measurements on page 32
- Shipping and Receiving on page 32
- Oracle Business Intelligence on page 33
- Siebel Wireless for Field Service on page 33

The field service process typically consists of one of the following scenarios:

- A customer reports a problem to a service center and field engineers are dispatched to repair the item.

- A customer places an order with a service center and field engineers are dispatched to install the item.
Separate functional groups such as the service center, dispatch, field engineers, and parts business need to share information. Oracle's Siebel Field Service integrates call center, dispatch, field activities, and service parts information in a single application. Siebel Field Service provides service center agents, warehouse staff, and field service engineers with the tools to respond to service requests and orders. Siebel Field Service allows a variety of users to perform the following tasks:

- Receive service calls
- Verify service agreements and entitlements
- Enter a service request
- Search for solutions
- Create activities for a service request
- Assign and dispatch field service engineers
- Provide parts inventories for parts depots and trunk stock
- Provide detailed customer configuration
- Track parts consumption and logistics
- Manage inventory replenishment
- Integrate return materials authorizations and service orders
- Provide field service engineers with complete service details, including the required skills, tools, and parts for all service activities
- Manage repair of defective parts
- Set up and manage preventive maintenance plans
- Track and analyze service costs
- Prepare invoices for service and track payments
- Define characteristics of assets and records readings from equipment (assets) in the field for preventive maintenance, billing, and service

NOTE: A Siebel implementation may not have all the features described in this guide, depending on which software modules have been purchased.

Managing the Full Cycle of Field Service

Field service businesses use Siebel Field Service to manage the entire flow of field service operations. Inbound service center calls are managed in this sequence:

1. Enter a service request. Service request activities are created throughout the life cycle of the service request.
2. Verify the service level agreements for the caller.
3. Based on the diagnosis of the problem and the service level agreement, create a return material authorization (RMA) or a service order, and link it to the service request, to allow prompt resolution.
4 Fill the order and ship the replacement parts to the customer or the field engineer.
5 Dispatch activities to a field engineer with the right skill set, tools, time, and location.

When a call has been resolved, the engineer reports the details of the resolution from the field, updates the customer relationship database to reflect possible cross-selling opportunities, and updates and replenishes the service parts inventory on a just-in-time basis. An invoice can be issued to the customer as proof of work. Pending return material authorizations from customers are tracked from receiving the items and defective parts are managed through the repair cycle.

Siebel Field Service consists of the basic functions required by most service businesses, as well as optional functions that can be added to fit most field service requirements:

- Base Field Service modules:
  - Call Management
  - Account/Contact Management
  - Field Activities Management
  - Warranty Management
  - Asset Management
  - Service Order Management
  - On-Site Services Management
  - Knowledge Management
  - Dispatch Board
  - Service Inventory

- Optional Field Service modules:
  - Contract Management
  - Siebel Scheduler
  - Repair
  - Preventive Maintenance
  - Logistics Management
  - Shipping and Receiving
  - Quality Management (includes Quality and Release screens)
  - Barcodes
  - Pricer

**Dispatch Board**

Dispatch Board is a graphical user interface that allows call center personnel and dispatchers to select, schedule, and assign field service engineers to service activities.
The Dispatch Board screen shows all unplanned activities and a list of the selected field service engineers and their schedules. Dragging unplanned activities onto the schedules of field service engineers automatically assigns and schedules these activities.

**Siebel Scheduler**

Siebel Scheduler provides automatic scheduling of activities and optimization of a service calendar. Appointment booking and schedule optimization are based on service region data, employee data, and constraints. Insertion of activities into optimized schedules accommodates immediate scheduling needs; for example, service calls linked to contractual commitments (entitlements) and emergency events. The application provides worldwide scheduling capability.

Siebel Scheduler includes the following features:

- **Appointment scheduling** allows customer service representatives to automatically schedule customer visits without exceeding current labor capacity. Appointments based on a window of time can be given to the customer with granularity down to hours.

- **Siebel Scheduler** optimizes deployment schedules based on business-defined constraints (for example, minimizing travel and labor costs) while making sure that contractual commitments are met. High-priority calls can be scheduled immediately, resulting in the reassignment of lower-priority calls.

- **Siebel Scheduler** can insert service activities that need immediate attention into an already-optimized schedule. Siebel Scheduler can also respond to unplanned situations like a vehicle breakdown or unavailable field service engineers.

- **Siebel Scheduler** can use Siebel Assignment Manager to provide an optimized list of field service engineers for assignment to each service request or activity. Siebel Scheduler also provides to the Assignment Manager data on availability of employees.

- **Schedules** are optimized in batch mode based on business-defined criteria.

**Mobile Computing Support**

Field service engineers in the field can access Siebel Field Service on their laptop computers, handheld devices, or wireless devices. Later they can synchronize to send local changes to the Field Service server and to retrieve new information from this server. Siebel applications support synchronization over LANs, WANs, dial-up connections, wireless networks, and the Internet.

Siebel Field Service introduces uncommitted transactions for inventory transfers in the field. This allows for tracking of part movements without immediate access to records in the corporate computer. Upon synchronization with a Field Service server, these transactions may be committed and recorded in the server database.
Service Parts Information
Siebel Field Service provides full information about parts availability, including installation instructions, operational constraints, and warranty and manufacturing data. Siebel Field Service allows the field engineer to graphically navigate through the base configuration of any complex product and review the customer’s on-site configuration. Siebel Field Service supports parts comparison and replacement information so that field service operations can quickly identify alternative parts.

Field Service Engineer Information
Siebel Field Service tracks a wide variety of information for field service engineers such as skill sets, product expertise, location, and business, and contact data like cellular phone and paging information. Each field service engineer can define notification preferences so that a dispatcher or customer can contact the engineer efficiently. Integrated calendar posting and scheduling allows each field engineer to maintain a personal calendar.

Field Service Engineer Activities
When a service event is reported, Siebel Field Service defines the steps required to correct the problem, necessary tools, and required parts and skills. Information such as safety data, schematics, and technical notes on the products, may be linked to the service activities and parts data. Siebel Field Service also allows the capture of billing information related to an activity at a customer site, including parts, expenses, and labor charges.

Service Inventory
The Inventory module manages service parts inventory. Inventory is tracked in real time across locations and businesses, including trunk inventories, and is accessible from anywhere in the company. Siebel Service Inventory provides a Part Locator screen to find parts during the RMA/order process or during a dispatch operation. The Part Locator Engine offers real-time access to inventory, allowing end users to make accurate and informed decisions on parts shipments.

The Field Service Part Browser allows a field service engineer to investigate the availability of a product in all inventory locations within a field service business.

Agreements and Contract Management
Siebel Contract Management supports the contract life cycle, from service opportunity identification, service pricing, and proposal generation to service delivery on contractual commitments to contract additions, cancellations, and renewals.
With Siebel Contracts, end users can define the terms of an agreement between the customer and the service provider. These terms can include the service provider’s contractual obligations such as performance metrics, response time, equipment maintenance responsibilities, service pricing, discounts, and service entitlements. Agreement entitlements allow end users to define service offering details, specifying tiered pricing for offerings and determining customer assets’ levels of coverage.

Additionally, Siebel Contracts allows end users to specify the terms of installment payments, renting, leasing, financing, and use-based pricing. When a service contract is established, the contract’s recurring, nonrecurring and usage-based charges can be automatically invoiced. End users can also track and forecast financial and service revenue information resulting from the sale of service offerings, individual service contracts, and across the service organization overall.

Service providers can use product warranty and off-warranty contract expiration data to reprioritize service sales resources. Combined with Oracle Business Intelligence Applications, Siebel Contracts allows end users to assess customer service needs, personalize service offers, and customize coverages.

Preventive Maintenance and Asset Measurements

Preventive maintenance is often a critical revenue and cost-containment factor for a service business. Siebel Field Service allows customers to generate preventive maintenance management services automatically. The Preventive Maintenance module provides the ability to create automatically predefined preventive maintenance service requests and related activities based on usage or frequency.

Certain equipment (for example, photocopiers or printers) requires regular maintenance to remain in good condition. Service businesses often provide preventive maintenance services as part of their offerings. Those services are sometimes included in warranty agreements, or sold to the customer as part of the service contract.

Monitoring systems can automatically request maintenance when certain conditions are met; for example, a meter reading passes a threshold or a fixed time period has elapsed. These events trigger the creation of a service request.

To facilitate preventive maintenance, Siebel Field Service provides for the collection and processing of asset measurements. Readings taken either manually or automatically from equipment in the field are recorded in Field Service. These readings can be from gauges, counters, or meters attached to products. This data may be used to initiate service requests for repairs or preventive maintenance. Usage readings can be used for billing on a fee-per-use basis.

Shipping and Receiving

Shipping and Receiving are integrated with Siebel Service Inventory, and track customer orders to shipment. Siebel Shipping and Receiving manages internal orders to transfer stock among inventory locations and receives RMAs and orders, closing the loop with each customer.
Oracle Business Intelligence

Oracle Business Intelligence Applications provide managers with a tool for analysis of large volumes of records. The results of the analysis are displayed in charts and reports. See Oracle Business Intelligence Infrastructure Installation and Configuration Guide, Oracle Business Intelligence Applications Installation and Configuration Guide, and Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards User Guide.

Siebel Wireless for Field Service

Siebel Wireless provides real-time access to information through a wireless application protocol (WAP)-enabled mobile phone or wireless handheld device. With Siebel Wireless for Field Service professionals, users can update sales opportunities, review account and activity information, access calendar and contact details, order and track parts, respond to service requests, and send correspondence. See Siebel Wireless Administration Guide.

Field Service Application Design

Siebel Field Service operates as a single Windows NT service that runs components such as EIM, Optimization Engine, Assignment Manager, and so on. Siebel Server operates components as processes or threads based on the system preferences specified for each component. Thus, there can be multiple components running at the same time and each component can run a specified number of tasks at a given time.

Siebel Professional Services Automation

Siebel Field Service is integrated with Siebel Professional Services, allowing the two applications to share resource management, cost tracking, and billing of longer-term service projects with milestone achievement time lines. See Siebel Professional Services Automation Guide.

Field Service Engines

Siebel Field Service provides the following automated functions:

- **Renewal Engine.** Automatically renews agreement line items.
- **Charge Engine.** Automatically creates charges. These charges can then be consolidated using the Charge Consolidation Engine.
- **Charge Consolidation Engine.** Automatically generates invoices, based on defined charge consolidation plans.
- **Fulfillment Engine.** Analyzes orders, locates parts for each line item, returns the located parts (products or substitute products) to the user, allocates parts, and generates pick tickets.
Overview of Field Service ■ Administrative Tasks

■ **Part Locator Engine.** Analyzes orders, locates parts for each line item, and returns the located parts (products or substitute products) to the user. The user can manually allocate these parts and generate the pick tickets.

■ **Replenishment Engine.** Selects source and target inventories when restocking is needed and generates the orders required to obtain materials from an external provider, an internal inventory site, or an internal manufacturing facility.

■ **Cycle Counting Engine.** Generates cycle counting orders (parts lists).

■ **Preventive Maintenance Engine.** Generates service requests for the maintenance of assets, based on predefined triggers.

■ **Mobile Inventory Transaction Engine.** Generates inventory and asset transactions when a field service engineer reports part movements in the field.

To facilitate configuration, maintenance, and multilanguage support, these components are implemented as business services. For information about business services, see the chapter on business services in *Integration Platform Technologies: Siebel Enterprise Application Integration*. For information about setting logging levels for these engines, see Appendix A, "Engines Logging Levels."

### Administrative Tasks

This section describes the types of administrative tasks required for Field Service. Instructions for performing these tasks are provided in this guide and in other guides in the Siebel Business Applications documentation set.

The following administrative tasks are required:

- **Implementation and application administration.** You must define and structure a number of elements that are used throughout the application. These include currencies, exchange rates, organizations, divisions and positions in your organization, users and their responsibilities, service territories, and so on. These tasks are described in *Siebel Applications Administration Guide*.

- **Product management and administration.** Field Service provides two tables for product information: an internal product table and an external product table for competitive products. In addition to populating these tables, you must define a product categorization hierarchy, specify product features, and specify settings for products that will be tracked in inventory. You can also define price lists and associate them with products. These tasks are described in *Siebel Applications Administration Guide* and *Siebel Pricing Administration Guide*.

- **Marketing administration.** All the various elements of marketing information must be defined and set up for your implementation. These include accounts, contacts, and so on. These tasks are described in *Siebel Marketing User Guide*.

- **Assignment administration.** Siebel Assignment Manager allows you to automatically assign the appropriate people to specific tasks. Instructions for using Siebel Assignment Manager can be found in *Siebel Assignment Manager Administration Guide*.

- **Templates.** Service and preventive maintenance plans use activity and service request templates to define efficient service calls. These features are described in Chapter 3, "Service Support" and Chapter 4, "Field Service Activities."
Agreements and Entitlements. Service and preventive maintenance plans are based on contracts and entitlements that customers purchase. Setting up service agreements and entitlements is described in Chapter 7, “Agreements,” in this guide.

Inventory. Field Service includes the process of setting up a logical inventory structure and maintaining a physical inventory. These tasks are described in Chapter 12, “Service Inventory” and Chapter 15, “Cycle Counting and Replenishment” in this guide.
This chapter describes the way field service call centers process service calls from customers, set up service requests, and attempt to find immediate solutions. Topics include:

- Processing a Request for Service on page 37
- Setting Up Service Support on page 38
- Process Flow for Logging Service Requests on page 40
- Updating a Service Request on page 43
- Resolving a Service Request on page 46
- Accounts Screen on page 46
- Service Screen on page 49
- Service Reports on page 61
- Audit Trail Overview on page 61
- Service Request Solutions on page 63
- Setting Up Solutions on page 63
- Administration - Solution Screen on page 65
- Solutions Screen on page 66

### Processing a Request for Service

The workflow for processing a customer's request for service, shown in Figure 1 on page 38, includes the following steps:

1. Receive a request for service.
2. Generate a service request.
3. Verify the request, by confirming:
   - The account
   - The caller (contact)
   - Assets
   - Entitlements for service
   - Warranties
4. Try to solve the problem using known solutions.
5. If known solutions do not solve the problem, generate activities for service.
6 Order parts if needed.
7 Schedule a service engineer and assign activities to that service engineer, if needed.
8 Assign and schedule field service activities (see Chapter 5, “Setting Up and Using Scheduling” and Chapter 6, “Setting Up and Using the Dispatch Board” for more information).
9 Perform the activities.
10 Close the service request.

Figure 1. Workflow for Processing a Service Request

Setting Up Service Support
This section describes the process for requesting service. Topics include:

- Creating a Service Activity Template on page 38
- Setting Up Service Metrics on page 39
- Setting the Default Opened Date and Time for an SR on page 39

Creating a Service Activity Template
Follow these procedures to create a service activity template.

To create a service activity template
1 Navigate to the Administration - Data screen > Activity Templates view.
2 Create a new record and complete the fields as appropriate. For information about creating activity templates, see Chapter 4, “Field Service Activities.”

3 Click the Service Details view tab. Create a new record and complete the fields as appropriate.

4 Click one of the four subview tabs, as needed:
   - Service Activity Steps
   - Assignment Skills
   - Service Activity Items
   - Service Activity Instructions

5 Create a record and complete the fields as appropriate.

Setting Up Service Metrics

Follow these procedures to set up service metrics.

To set up service metrics

1 Navigate to the Administration - Service screen > Service Metrics view.
2 Create a record.

NOTE: Service metrics are named in the Service Metrics list, but they are defined in detail in the Entitlements screen. See “To define entitlement template metrics” on page 221. After entitlements and service metrics have been defined, you can associate an entitlement with a service request. See “To select an entitlement for a service request” on page 41.

Setting the Default Opened Date and Time for an SR

The Post Default Created Date To Date Saved user property in the Service Request business component controls the behavior of the Opened field in new service request records. For information about user properties, see Using Siebel Tools.

Possible values of the Post Default Created Date To Date Saved user property are as follows:
TRUE (Default). Sets the value of a new service request’s Opened field (the creation date and time) to the date and time when the record is first saved (in other words, the moment when the record is committed to the database).

This setting can help your organization to meet its service level commitments. If a service request’s Opened field displays the time and date it was opened, rather than the time and date it was first saved, then the service request will have aged by however long it takes a user to enter the service request data before a customer service representative (CSR) can see it in the system. If the system counts the time when (and not before) the service request is completed and saved, your service personnel can have the fully allotted time to respond to service requests.

For example, suppose a customer has a 24x7 entitlement with a 1-hour response time metric. This customer enters a service request in the Siebel customer application. 30 minutes elapse from the time this customer opens and begins entering a service request until the time it is completed and saved. If the Opened time is when the SR record is first created, your company’s CSRs have only 30 minutes to respond. If the Opened time is when the SR record is committed to the database, they have 1 hour to respond.

This setting can, however, set the value of the Opened field later than the Last Updated field. This is because the Last Updated field’s value is set when the record is created but not when it is first saved.

FALSE. Sets the value of the Opened field on a new service request to the date and time when the record is first created. If your company’s business process mandates that the time on a SR starts from when a CSR starts taking a customer call, then use this setting.

Follow these procedures to set up the default opened date and time for an SR.

To set the Post Default Created Date To Date Saved user property value
1. Log into Siebel Tools as an administrator.
2. Lock the appropriate project for editing.
3. In the Object Explorer, navigate to Business Component.
4. Query for the Service Request business component.
6. Query for the Post Default Created Date To Date Saved user property.
7. In the Value field, enter the desired value.

Process Flow for Logging Service Requests
The first set of tasks the service representative performs in response to a request for service includes recording the request and attempting to solve the problem. If the service representative cannot resolve the problem, the agent may set up field service activities, select the engineers, schedule the engineers, and, finally, inform the engineers of their assignments. Topics include:

Logging Service Requests on page 41
Logging Service Requests

The following procedures suggest a typical workflow that is initiated upon receiving a request for service.

**To verify an account, a contact, and an asset**
1. Navigate to the Accounts screen > Accounts List view.
2. Query for the caller’s account.
   - The Contacts list appears, showing authorized contacts for that account.
3. Query for the caller’s name and click the Assets view tab.
   - The Assets list shows assets associated with the selected account.
4. Query for the caller’s asset and click the Service Profile view tab.
   - The Service Profile list shows products associated with the selected account. The Assets list shows the assets associated with a selected product.

**To log a service request**
1. Navigate to the Service screen > Service Request List view.
2. Create a new record and complete the fields as appropriate.
   - **NOTE:** If the account has more than one address, choose the account using the select button to the right of the account field. The Siebel state model controls the behavior of the Status and Substatus fields. See *Siebel Business Process Framework: Workflow Guide* for a detailed explanation of the state model.

**To verify the service agreements and entitlements for an account**
1. Navigate to the Accounts screen > Account List view.
2. Drill down on the Account Name field for a selected account record and click the Agreements tab.
   - The Agreements list shows agreements associated with this account. The Start, End, and Valid fields show which agreements are in effect.
3. Click the Entitlements tab.
   - The Entitlements list shows agreements associated with this account. The Agreement field shows the agreement with which the entitlement is associated.

**To select an entitlement for a service request**
1. Navigate to the Service screen > Service Request List view.
2 Select a service request that has an associated account or contact.

3 In the menu bar, click Verify or Verify Best Time (see the following table).

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify</td>
<td>Displays the Pick Entitlement dialog box showing only entitlements that match the criteria for this service request. If no entitlements appear, the selected service request is not entitled to receive service.</td>
</tr>
<tr>
<td></td>
<td>Clicking the Verify button invokes a workflow. For more information, see &quot;Workflows for Entitlement Creation and Verification” on page 240.</td>
</tr>
<tr>
<td>Verify Best Time</td>
<td>Displays the Pick Entitlement dialog box showing, of the entitlements that match the criteria for this service request, only the entitlement with the earliest Date Committed. If no entitlement appears, the selected service request is not entitled to receive service.</td>
</tr>
<tr>
<td></td>
<td>Clicking the Verify Best Time button invokes a workflow. For more information, see &quot;Workflows for Entitlement Creation and Verification” on page 240.</td>
</tr>
</tbody>
</table>

4 In the Pick Entitlement dialog box, select an entitlement and click OK.

**To verify the valid hours for completing a service request**

1 For this procedure to work, you must first verify the entitlement. See "To verify the service agreements and entitlements for an account” on page 41.

2 Navigate to the Service screen > Service Request List view.

3 Drill down on the SR # field for a selected service request and click the Service Hours tab.

**To verify the warranties for an asset**

1 Navigate to the Service screen > Service Request List view.

2 Drill down on the SR # field for a selected service request and click the Service Details view tab.

3 In the Warranty As Of field, enter the date on which to verify a valid warranty and click Check Warranty.

**To associate a change request to a service request**

1 Navigate to the Service screen > Service Request List view.

2 Drill down on the SR # field for a selected service request and click the Change Requests view tab.

3 In the menu bar, click Add. In the Add Change Request dialog box, select an existing change request or create a new one.

   For information about entering change requests, see Chapter 14, “Quality.”
To associate an activity plan with a service request
1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Activity Plans view tab.
3. Create a new record and complete the fields as appropriate.
   For information about activity plans and activity templates, see Chapter 4, “Field Service Activities.”

To associate an activity with a service request
1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Activities view tab.
3. Create a new record and complete the fields as appropriate.

Generating a Service Charge Quote
To get the estimated cost of completing a service request, you can create a quote. A quote lists the costs to complete a service request, including labor hours and parts prices. The parts prices are based on the recommended part items required to complete the activity (or activities) associated with the service request.

To generate a quote for a service request
1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Service Details view tab.
3. Click the Auto Quote button. If the button is not available, make sure the Price List and Rate List fields are completed in the Service Details view.
   A quote line item appears in the Quotes view.
4. To view the quote, drill down on the Name field.
   **NOTE:** In a quote, the line items for labor are not priced.

Updating a Service Request
After a service request is opened, the service center or field service agent can add the following information to a service request.

To update activities for a service request
1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Activities view tab.
3 Select an activity and enter new values in the fields, as needed.

**To add an asset to a service request**
1 Navigate to the Service screen > Service Request List view.
2 Drill down on the SR # field for a selected service request that is not associated with an asset and click the Activities view tab.
3 Drill down on the Activity field for the associated service request and click the More Info view tab.
4 In the Asset # field, enter or select the number for the additional asset.

**NOTE:** A service request can be associated directly with only one asset. However, a service request can be associated with multiple activities, and each activity can have one associated asset. To associate multiple assets with a service request, create multiple activities, associate them with a service request, and associate each of the assets with a different activity. For information on managing defective assets, see Chapter 14, "Quality."

**To add additional assets to a service request**
1 Navigate to the Activities screen > Activity List view.
2 Create a new record and complete the fields as appropriate.
3 Drill down on the Type field for the associated service request and click the More Info view tab.
4 In the Asset # field, select the additional asset to associate with the service request.

**To verify field part movements**
1 Navigate to the Service screen > Service Request List view.
2 Drill down on the SR # field for a selected service request and click the Activities view tab.
3 Drill down on the Type field for the selected activity and click the Part Tracker view tab.

**To record a resolution for a service activity**
1 Navigate to the Service screen > Service Request List view.
2 Drill down on the SR # field for a selected service request and click the Activities view tab.
3 Drill down on the Type field for the selected activity and click the More Info view tab.
4 In the Resolution field, select a resolution.

**To review orders associated with a service request**
1 Navigate to the Service screen > Service Request List view.
2 Drill down on the SR # field for a selected service request and click the Orders view tab.
To generate and print an invoice for a service request
1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Invoices view tab.
3. In the menu bar, click Auto Invoice.
4. Drill down on the Invoice # field and click the Invoices Line Items view tab.
5. Click Reports > Customer Invoice and then click Run Now.
   The Siebel Report Viewer window appears with the invoice.
6. Click the Print button to print a standard invoice.

To view the performance measurements (metrics) for a service request
1. For this procedure to work, you must first verify the entitlement. See “To verify the service agreements and entitlements for an account” on page 41.
3. Drill down on the SR # field for a selected service request and click the Metrics view tab.
   The Metrics list contains read-only records of the metrics associated with this service request. Service metrics are defined in the Administration - Service screen, in the Entitlement Templates list on the Metrics view. See Chapter 7, “Agreements.”

To close a service request
1. Navigate to the Service screen > Service Request List view.
2. Select the service request you want to close, then in the Status field, select Closed.
   The system automatically changes the Substatus field to Resolved and sets the Closed field’s date and time to the current date and time.
   NOTE: After closing a service request, the record is read-only. The status of a service request must be changed back to Open before the record can accept any further changes.

Generating Correspondence for a Service Request
You can generate correspondence for a selected service request.

To generate correspondence for a service request
1. Navigate to the Service screen > Service Request List screen.
2. Select a service request for which you want to generate correspondence.
Choose File > Send Email. In the Pick Recipients dialog box, choose the contact associated with the selected service request and click OK.

**NOTE:** The selected service request does not become associated with any additional contacts added to the Recipients list for service request-related correspondence.

For more information about correspondence, see the chapter on correspondence in *Siebel Applications Administration Guide*.

## Resolving a Service Request

The procedures in this section suggest a workflow for researching and resolving a service request.

### To associate a service request with a related service request

1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Related SRs view tab.
3. Create a new record and complete the fields as appropriate.

### To verify associated change requests for a product

1. Navigate to the Products screen > Internal Product List view.
2. Drill down on the Product field and click the Change Requests view tab.

### To verify the repair history of a product

1. Navigate to the Repairs screen > FS Repairs List view.
2. Run a query on the Product field.
   - The Repairs list shows all repairs for the selected product.

### To find explanations (decision issues) for a service request

1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Decision Issues view tab.
3. To see more information related to a decision issue (such as literature and attachments), select the decision issue and drill down on the Name field.
4. Click the Attachments view tab to view files associated with this decision issue.

## Accounts Screen

This section describes how to use the Accounts screen. Topics include:

- Accounts Across Organizations View on page 47
Using the Accounts screen, a customer service representative can verify the following information for an incoming service call:

- The customer’s account (Accounts list or Service Profile view).
- The contact making the call (Contacts view or Service Profile view).
- The assets at the customer site that are associated with this account (Assets view or Service Profile view).
- The service agreements for this account (Agreements view).
- The entitlements for the service agreements belonging to this account (Entitlements view).

The customer service representative can automatically verify entitlements for specific service agreements by clicking one of the Verify buttons on the Service Request screen (see “Service Requests Views” on page 51).

- The history of service requests logged to this account (Service Requests view).
- Billing and shipping information for the account (Bill to/Ship to view).
- Invoices previously prepared for the account (Invoices view).

For more information about using the Accounts screen, see the chapters on Accounts in Siebel Applications Administration Guide.

**Accounts Across Organizations View**

An *organization* limits the visibility of data within a company. However, the All Accounts Across Organizations view shows all accounts within a company.

An employee can belong to one organization and account records can belong to one organization. The owner of an account record can see his or her account record in the My Accounts view, even if the account record belongs to a different organization. However, the same employee using the same login to Siebel Field Service, cannot see this account in the All Accounts view. The record is exposed only to those people who belong to the same organization.

For more information about setting up organizations, see the chapter on access control in Siebel Security Guide.
Accounts View

The Accounts view provides information about all accounts that belong to a service business. Use this list to verify the account for the individual placing a service request.

Contacts View

The customer service representative (CSR) uses the Contacts view to verify the person placing a service call. For more information about using the Contacts view, see *Siebel Fundamentals*.

Agreements View

The Agreements view displays all of the agreements associated with an account and the status of these agreements. *Table 4* describes items in agreement records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary</td>
<td>A check box that indicates this is a primary agreement for the selected account. This check box is for information only.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of agreement; for example, Service Level Agreement or Price Protection.</td>
</tr>
<tr>
<td>Valid</td>
<td>A check box that indicates this is an active agreement. When selected, an agreement may appear in the list that clicking the Verify button produces. See “Verify Button” on page 52.</td>
</tr>
</tbody>
</table>

For more information on using the Agreements view, see *Chapter 7, "Agreements."*

Entitlements View

The Entitlements view shows all of the entitlements for service that are associated with this account. The Quota fields indicate the number of service calls remaining for this entitlement. The Start and End Date fields show the valid range of dates for this entitlement. This view is read-only.

Service Profile View

The Service Profile view shows the products and assets associated with an account. The user can enter both new product and asset records in this view. The same Products and Assets subviews appear in References > Profile.
Account Reports

Account reports, listed in Table 5, are available from the Reports menu.

Table 5. Selected Account Reports for Service

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Account Service Profile</td>
<td>Describes details for products associated with the account, including product, product type, version, description, vendor and comment. This report also describes a purchase history including product information, implementation phase, and purchase date.</td>
</tr>
<tr>
<td>Smart Report Account Summary</td>
<td>Describes details of a selected account including account history, future revenue, satisfaction, organizational hierarchy, and service requests.</td>
</tr>
<tr>
<td>Smart Report Account Service Detail</td>
<td>Describes all service-related information for the selected account including service requests, customer satisfaction, and the history of service request resolution.</td>
</tr>
</tbody>
</table>

Service Screen

When responding to a service call, a customer service representative can create a service request on the Service screen. The service request tracks all activities connected with the call and records the service business’s entire response to the service call (activities, orders, parts movements, and assignments). Topics include:

- Service Requests Across Organizations on page 50
- Service Requests Views on page 51
- Activity Plans View on page 56
- Activities View on page 56
- Attachments View on page 56
- Audit Trail View on page 56
- Calendar View on page 56
- Change Requests View on page 57
- Decision Issues View on page 57
- Messages View on page 57

On the Service screen, the user can carry out the following tasks:

- To verify the entitlements for the account requesting service, click the Verify button.
- Find solutions that may resolve a service call (Solutions view).
- Set up new service requests (All/My Service Requests view).
- To show the current warranty coverage for an asset associated with a service request, choose the Check Warranty menu command (Service Details view).
Service Support ■ Service Screen

- Associate change requests with a service request (Change Requests view).
- Provide activity plans for a service request (Activity Plans view).
- Provide individual activities for a service request (Activities view).
- Assign activities to field service engineers using the Siebel Scheduler, Assignment Manager, or Dispatch Board (most Service Request views).
- Attach documents to a service request (Attachments view).
- Review orders for a service request (Orders view).
- To prepare an invoice for all billable activities and expenses for a service request, click the Auto Invoice button (Invoices view).

Service Requests Across Organizations

Service requests, like many other Siebel objects, have organizational visibility. This means:

- The All Service Requests view shows only service requests for the organizations to which the user has permission.
- The All Service Requests Across Organizations view shows the service requests for all organizations within a company.
- The My Service Requests view shows all service request records belonging to the user, even if the user is in a different organization.

For more information about setting up organizations, see the chapter on access control in Siebel Security Guide.
Service Requests Views

The Service Requests views create and track service requests. Table 6 describes items in service request records.

Table 6. Selected Items in the Service Requests View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Closed</td>
<td>The date and time that the service request was actually closed, displayed in the user's time zone.</td>
</tr>
<tr>
<td>Agent Committed</td>
<td>The date and time that the service request is expected to be closed, displayed in the user’s time zone. Choosing an entitlement automatically generates a value for this field, based on the response time in the service request metrics, the service calendar, and the date the service was requested.</td>
</tr>
<tr>
<td></td>
<td>Activities associated with this service request inherit the Agent Committed value. The Agent Committed field value in the service request appears in the Activity Due fields in the activities.</td>
</tr>
<tr>
<td></td>
<td>See also &quot;Agent Committed Time for a Service Request&quot; on page 53.</td>
</tr>
<tr>
<td>Agent Opened</td>
<td>The date and time that the service request was created, displayed in the user’s time zone. Depending on how the Post Default Created Date to Date Saved user property is set, this is when the SR is first saved or when it is first opened. See “Setting the Default Opened Date and Time for an SR” on page 39.</td>
</tr>
<tr>
<td>Assign</td>
<td>This command produces a dialog box with a list of field service employees, ranked based on administrative criteria. Select the employee best suited to be the owner of a selected service request.</td>
</tr>
<tr>
<td>Billable</td>
<td>A check box that indicates that the activities included in this service request are billable to the account.</td>
</tr>
<tr>
<td>Customer Closed</td>
<td>The date and time that the service request was actually closed, displayed in the customer’s time zone.</td>
</tr>
<tr>
<td>Customer Committed</td>
<td>The date and time that the service request is expected to be closed, displayed in the customer’s time zone.</td>
</tr>
<tr>
<td>Customer Opened</td>
<td>The date and time that the service request was created, displayed in the customer’s time zone. Depending on how the Post Default Created Date to Date Saved user property is set, this is when the SR is first saved or when it is first opened. See “Setting the Default Opened Date and Time for an SR” on page 39.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>An entitlement that provides special terms for billing the labor, expenses, and parts used in this service request. It also provides the calendar and hours in which the customer is entitled to service.</td>
</tr>
<tr>
<td>Group</td>
<td>Division responsible for communications with the customer regarding this service request. Divisions available in the picklist are those whose Organization Type is Service. For information about setting up divisions, see Siebel Security Guide.</td>
</tr>
</tbody>
</table>
How Service Requests and Other Business Component Object Types Are Numbered

Each new Business Component record (for example, service request, order, or activity) is automatically assigned a unique record ID (for example, SR #, Order #, Activity #, and so on).

By default, all Siebel applications use the ROW_ID for these values. The row ID is an alphanumeric value composed of a segment number followed by a sequential value. For example, the row ID 12-63Q0XT is composed of the segment number 12 and the sequential value 63Q0XT. To see the row ID for a selected record, choose View > Record. The dialog box that appears contains a value for Row #.

To display alternative values for the record ID, use one of the following methods:

- Use the Query function Expr: RowIdToRowIdNum ([ID]) to convert the alphanumeric value to a numeric value.
- Use a Sequence Object to automatically generate the value from an RDBMS database.
- Write a script on Buscomp_PreWriteRecord. (Do not use Buscomp_PreGetFieldValue.)

Verify Button

The Verify button finds the entitlements for a specified account, contact, product, and asset. Once the user selects an entitlement from the Pick Entitlement dialog box, the application computes the Commit Time for the service request from the Service Calendar associated with this entitlement and from the Response Time specified in the entitlement metrics. Verify searches the database for entitlements that match the following data supplied for the service request:

- Account
- Contact
- Product
- Asset (from the Service Details view)
Only entitlements that match this data appear in the Pick Entitlement dialog box. If no entitlements appear, the selected service request, service agreement, account, contact, product, or asset is not entitled to receive service.

For information about configuring the Verify button, see “Setting System Preferences for Verifying Entitlements” on page 219.

**NOTE:** The FS Holiday API Service provides APIs to calculate the Commit Time for a service request according to a specific schedule. For example, if an SR is logged for a customer call at 4:30 pm EST on Friday and the business rules mandate a 4-hour response time, the GetResponseTime method can be called from the FS Holiday API Service to set the Commit Time to 12:30 pm EST on Monday. See “FS Holiday API Service” on page 551 for more information.

**Recommendation Field**
The Recommendation field performs one of three actions on the service request. Choices are Dispatch, Escalate, and Return:

- Choosing Dispatch creates service activities by associating an activity plan template with the SR. The activity plan name is configurable on the SR Recommendation workflow.
- Choosing Escalate creates a new Repair order that inherits values from the following SR fields: Product, Asset, Return to Account, Price List, and Rate List.
- Choosing Return creates a new order line item and a new Repair order with the type, RMA Return, that inherits the values from the following SR fields: Account, Contact, Price List, Entitlement, and Order ID.

**NOTE:** You must activate the SR Recommendation workflow to use the Recommendation field.

**Agent Committed Time for a Service Request**
*Agent Committed* represents the contractual response period for service. Clicking the Verify button determines the value of Agent Committed and stores this value for a service request. The Agent Committed date and time are calculated based on the Date Opened, the Response Time metric, and the Service Calendar (schedule hours and exception hours). The result appears in the Agent Committed field. The Agent Committed time from the service request populates the Due field for activities.

The Agent Committed time allows the agent either to schedule events that are within acceptable time frames, defined by the service calendar, or to tell the customer that a requested event is outside of his or her service calendar and is therefore, billable.

Activities associated both directly (in the “Activities View” on page 56) and indirectly (in the “Activity Plans View” on page 56) with a service request inherit the Agent Committed date and time. The Agent Committed field value in the service request appears in the Activity Due fields in the activities.

**NOTE:** If the response time metric used to calculate the Agent Committed Time is not correctly defined in the Entitlements screen > Metrics view, the Agent Committed Time cannot be calculated. For more information, see “To manually add performance measurements (metrics) for an entitlement” on page 238.
Entitlement Rules for the Verify Button

System Preferences has three settings, listed in Table 7, which determine the action of the Verify button. For more information about the Verify button, see “Verify Button” on page 52.

Table 7. System Preferences for Verifying Entitlements

<table>
<thead>
<tr>
<th>System Preference Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Entitlement: Verify Consumer | This setting sets the conditions for checking the authorization of the contact requesting service. If TRUE, the entitlements displayed must meet one of these criteria:  
  - The contact for the entitlement matches the service request contact.  
  - The entitlement account is set to All Contacts, and the entitlement account matches the service request account or the account for the contact for the service request.  
  If no contact is selected, Siebel Field Service tries to verify the entitlement using the other entitlement settings. |
| Entitlement: Verify Dates | This setting checks that the service request falls within the time span of the entitlement. If TRUE, the entitlements displayed are only those that provide coverage on the date the service request was opened, a date between the start and end dates for the entitlement.  
  If the entitlement has no start or end date, it does not appear. |
| Entitlement: Verify Product | This setting checks that the asset or product is entitled to service. If TRUE, the agreements displayed must meet one of these criteria:  
  - The entitlement asset matches an asset in the service request.  
  - The entitlement product matches a product in the service request (no asset or serial number specified).  
  - The entitlement is set to All Products and the product or asset for the entitlement matches the product or asset for the service request.  
  If no product is selected, Siebel Field Service tries to verify the entitlement using the other Entitlement settings. |

Assign Command

The Assign menu command activates the Assignment Manager in interactive mode to provide a ranked list of field service engineers who are qualified and available to carry out a service request. The Assignment Manager can also run in dynamic and batch modes for any Assignment objects, including Accounts, Opportunities, and Campaigns.

**NOTE:** For using the Assignment Manager in Mobile mode, for mobile users, see Siebel Assignment Manager Administration Guide.
The Assignment Manager scores employees for assignment based on the factors specified in the following rules:

- **Check calendar.** If this option is enabled, an employee must have calendar availability to perform the task. This is based on the assignment rule, Earliest Start, Latest Start, and the Duration (of an activity). If the individual is not available, this employee is removed from the list of candidates.

- **Assignment availability.** The Assignment Manager passes a list of potential employees to the Appointment Booking System (ABS), which checks the employees’ service schedules (including their geographic service region assignments) and the activities already on their calendars. The ABS then returns the list of available employees to the Assignment Manager. In an optional step, the Assignment Manager may request that the ABS create and schedule a new activity for the chosen employee. For more information about the ABS, see Chapter 5, “Setting Up and Using Scheduling.”

- **Workload.** For each workload rule specified, the number of activities assigned to that employee that meet all of the workload criteria is calculated. This number is then reduced by the maximum workload. This result is used to generate a score that is inversely proportional to the workload rule weight \([\text{Workload score} = \text{Score} \times (1 - \frac{\text{current workload}}{\text{maximum workload}})].\) For example, if the workload rule is for Unassigned and Critical Service Requests, and if the maximum load for this rule is 10 and the weight for this workload is 20, then an employee load of 10 or greater receives a score of zero, and an employee with a load of 2 receives a score of 16.

- **Attribute match.** For each condition specified, the criteria are evaluated. If a condition is true, the score equals the weight specified; otherwise the score is zero. If the condition is not met and the condition is required, the total score for that employee or position is zero.

- **Expertise weighting.** For each condition that uses advanced weighting, the score for that condition is adjusted, based on the advanced weighting criteria. For the employee column that is matched, the expertise for that attribute type must also be analyzed. For example, if a condition is specified for a product (product expertise) match, with a weighting of 15, and expertise weightings of Expert, Intermediate, and Novice are 3, 2, and 1, respectively, the resulting scores for this factor would be 15, 10, and 5, respectively.

The total score for an employee is a sum of the scores for each individual factor, modified by the factors that override the total score and set the score to zero (check calendar, required attribute matches, and so on). The highest score represents the most likely individual for assignment.

The Assignment Engine is configured for the Service Request object to either assign automatically the highest scoring employee (using SmartScript) or to run in interactive mode. In interactive mode, the user selects the Assign command and the Assignment Manager returns a ranked list of employees in the Assign Employees dialog box. The user can then select an assignee. For information about setting up interactive assignment for Siebel objects, see Assignment Manager Configuration in the Siebel Assignment Manager Administration Guide.

**NOTE:** All assignment rules can be accessed by navigating to the Administration - Assignment screen. For more information, see Siebel Assignment Manager Administration Guide.
Activity Plans View

In the Activity Plans view, a field service agent can select a template to define the activities required to resolve a service request. Table 8 describes two fields and a check box in activity plan records.

Table 8. Selected Items in the Activity Plans View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Assignment</td>
<td>A check box that, when selected, instructs the Siebel Assignment Manager not to assign activities created as part of this activity plan.</td>
</tr>
<tr>
<td>Planned Start</td>
<td>The date and time to begin the activities that resolve a service request. The default is the date and time that the record is created.</td>
</tr>
<tr>
<td>Template</td>
<td>A set of activities for recurring tasks, selected from a drop-down list.</td>
</tr>
</tbody>
</table>

Activities View

In the Activities view, a field service agent can view activities for a service request, and add stand-alone activities. An administrator or dispatcher can manually assign field service engineers to each activity.

**NOTE:** To see the details of an activity, including its items, steps for completion, and instructions, drill down on the Type field. The Attachments view appears for this activity. Click, for example, the Items, Steps, or Instructions tab to see information related to the selected activity.

Attachments View

Use the Attachments view to add files created in another program (for example, spreadsheet files) to service requests. These files are stored in the Siebel file system in compressed form.

Audit Trail View

The Audit Trail view shows the history of changes that have been made to specific service request records. This view is read-only. For more information about the Audit Trail utility, see *Siebel Applications Administration Guide*.

Calendar View

The Calendar view displays the scheduled service activities for a selected service request over the next month, starting on a specified day. The user can select the Calendar view to view scheduled activities. For more information, see *Siebel Applications Administration Guide*.
Change Requests View

The Change Requests view describes manufacturing defects in components that are associated with a service request.

Decision Issues View

The Decision Issues view displays explanations that may be used internally or provided to the customer to solve a service request. The user can also add new decision issues to a selected service request.

Messages View

The Messages view records a message concerning the selected service request and sends a screen alert or an email to the person selected in the Employees field. For more information, see Siebel Applications Administration Guide.

Service Details View

The Service Details view shows the warranties covering an asset, the symptom reported for the asset, and the resolution code for a service request. Table 9 describes buttons, check boxes, and selected fields in Service Details records.

Table 9. Selected Items in the Service Details View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Warranty</td>
<td>Clicking this button displays the warranties in effect for an asset on the date in the Warranty As of field. Check marks appear next to the types of warranty that apply: Product, Components, or Manufacturer. To verify the warranties active on another date, change the date in the Warranty As of field and select Check Warranty. For more information about warranties, see Chapter 18, &quot;Warranties.&quot;</td>
</tr>
<tr>
<td>Product Warranty</td>
<td>A check box that indicates this type of warranty is in effect on the specified date. This check box is for information only.</td>
</tr>
<tr>
<td>Component Warranty</td>
<td>A check box that indicates this type of warranty is in effect on the specified date. This check box is for information only.</td>
</tr>
<tr>
<td>Manufacturer Warranty</td>
<td>A check box that indicates this type of warranty is in effect on the specified date. This check box is for information only.</td>
</tr>
<tr>
<td>Warranty As of</td>
<td>The date on which Check Warranty validates the coverage under warranties.</td>
</tr>
</tbody>
</table>
There can be one or more symptom codes for any problem description. A customer can report some symptoms during a service request, while the field service engineer may find other symptoms and report them on site as part of an activity, and the repair technician may report other symptoms in a repair station as part of a repair activity. All the symptoms reported appear in the dialog box available in the Symptoms field from the Service details view. This is possible because the symptoms are stored in an intersection table that also stores the activity and the service request ID.

Service Hours View
The Service Hours view shows the hours during which service is provided under the specified entitlement. Shaded areas represent service times. Service hours appear only if an entitlement is specified for the service request and has been verified.

Survey View
The Survey view records customer responses concerning the level of service received. After a customer service representative enters responses to the questions and saves the record, the survey calculates a customer satisfaction score.

Invoices View
The Invoices view shows the invoices billed against a service request. Select the Auto Invoice command (see “About the Auto Invoice Command” on page 299) in the Invoices view to generate new invoices using orders and activities that have a billable flag set. For more information about invoicing, see Chapter 9, "Charges and Invoices.”

Metrics View
The Metrics view provides benchmarks of performance for a service request. All fields are read-only.
Orders View

The Orders view presents the orders related to selected service requests. Table 10 shows the check box in order records.

Table 10. Selected Item in the Orders View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>A check box that indicates this order was approved. This check box is for information only. It does not have associated code.</td>
</tr>
</tbody>
</table>

Solutions View

The Solutions view associates existing solutions and related, frequently asked questions (FAQs) to a service request. Click on the name of the solution to go to the Solutions screen and the Resolution Documents view, which displays the names of files containing information supporting a solution.

Charts View

The Charts view provides the analysis of activities, listed in Table 11.

Table 11. Service Analysis Charts

<table>
<thead>
<tr>
<th>Chart</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aging Analysis by Product</td>
<td>The duration of a service request as a function of product.</td>
</tr>
<tr>
<td>Aging Analysis by Product Area</td>
<td>The duration of a service request as a function of field service product area.</td>
</tr>
<tr>
<td>Aging Analysis by Severity</td>
<td>The duration of a service request as a function of severity.</td>
</tr>
<tr>
<td>Aging Analysis by Status</td>
<td>The duration of a service request as a function of status (Open, Assigned, Pending, and so on).</td>
</tr>
<tr>
<td>Priority Analysis by Owner</td>
<td>The priority of service requests assigned to each field service engineer.</td>
</tr>
<tr>
<td>Status Analysis by Owner</td>
<td>The status of service requests assigned to each field service engineer.</td>
</tr>
<tr>
<td>Closed Service Requests by Owner</td>
<td>The history of closed service requests assigned to each field service engineer.</td>
</tr>
<tr>
<td>Closed Service Requests by Product</td>
<td>The history of closed service requests for each product.</td>
</tr>
<tr>
<td>Chart</td>
<td>Analysis</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Analysis</td>
<td>The number of service requests for each customer account.</td>
</tr>
<tr>
<td>New Service Requests</td>
<td>The number of new service requests per calendar period.</td>
</tr>
<tr>
<td>New Service Requests by Owner</td>
<td>The number of new service requests assigned to a field service engineer per calendar period or per product.</td>
</tr>
<tr>
<td>New Service Requests by Product</td>
<td>The number of new service requests for each product per calendar period.</td>
</tr>
<tr>
<td>Product Analysis</td>
<td>The number of new service requests for each product.</td>
</tr>
<tr>
<td>Product Version Analysis</td>
<td>The number of new service requests for each version of a product.</td>
</tr>
<tr>
<td>Severity and Priority Analysis</td>
<td>Two graphs:</td>
</tr>
<tr>
<td></td>
<td>- The number of service requests as a function of severity.</td>
</tr>
<tr>
<td></td>
<td>- The number of service requests as a function of priority.</td>
</tr>
<tr>
<td>Status and Area Analysis</td>
<td>Two graphs:</td>
</tr>
<tr>
<td></td>
<td>- The number of service requests as a function of status.</td>
</tr>
<tr>
<td></td>
<td>- The number of service requests as a function of field service product area.</td>
</tr>
<tr>
<td>Symptom and Resolution Analysis</td>
<td>Two graphs:</td>
</tr>
<tr>
<td></td>
<td>- The number of service requests as a function of symptom.</td>
</tr>
<tr>
<td></td>
<td>- The number of service requests as a function of resolution.</td>
</tr>
<tr>
<td>Trend Analysis by Product</td>
<td>The number of service requests for each product as a function of calendar period.</td>
</tr>
<tr>
<td>Aging Analysis by Priority</td>
<td>The duration of a service request as a function of priority.</td>
</tr>
<tr>
<td>Trend Analysis by Product Area</td>
<td>The number of service requests for each field service product as a function of calendar period.</td>
</tr>
<tr>
<td>Trend Analysis by Severity</td>
<td>The number of service requests for each severity level as a function of calendar period.</td>
</tr>
</tbody>
</table>
Table 11. Service Analysis Charts

<table>
<thead>
<tr>
<th>Chart</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Analysis by Source</td>
<td>The number of service requests logged in by a given route (email, phone, and so on) as a function of calendar period.</td>
</tr>
<tr>
<td>Trend Analysis by Status</td>
<td>The number of service requests with a given status as a function of calendar period.</td>
</tr>
</tbody>
</table>

**Service Reports**

Service reports, listed in Table 12, are available by clicking the Reports button.

Table 12. Service Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Request Activity (All)</td>
<td>Displays a page for each service request, with information about the service request and each of the associated activities.</td>
</tr>
<tr>
<td>Service Request Activity (Public)</td>
<td>Displays a page for each service request, with information about the service request and each of the associated activities.</td>
</tr>
<tr>
<td>Service Request Detail (Barcode)</td>
<td>Provides detailed information about each service request.</td>
</tr>
<tr>
<td>Service Request Detail (No Barcode)</td>
<td>Provides detailed information about each service request.</td>
</tr>
<tr>
<td>Service Request Summary</td>
<td>Provides a summary of each service request.</td>
</tr>
<tr>
<td>Smart Report Service Request Performance</td>
<td>Analyzes the aging of open service requests using three metrics: number of open service requests, call volume, and resolution time, each over the last six months.</td>
</tr>
</tbody>
</table>

**NOTE:** Use a query to limit the reports to service requests of interest.

**Audit Trail Overview**

Audit Trail creates a history of the changes that have been made to service requests. An audit trail is a record showing which operation was performed, when it was performed, and how the value was changed. Therefore, it is useful for examining the history of a particular service request. Audit Trail logs information without requiring any interaction with, or input from, your users. Topics include:

- Audit Trail Content on page 62
Audit Trail for Siebel Remote Users on page 62

By using Audit Trail, your users can track which employee modified a certain field and what data has been changed. An audit trail is created for each status change, along with a time stamp and the ID of the user who made the change.

For Siebel Remote users making changes to records, Audit Trail works for every Siebel Web deployment and configuration option, including synchronization. Audit Trail records not only show successfully committed transactions, but also transactions that did not get synchronized to the server because of conflicts.

An audit trail is written directly into the database, supporting both remote users and replicated databases. Changes to an audit trail field are cached in the application. Exiting from the Siebel Application and restarting it writes all cached changes to the database. Alternatively, when the cache size is reached, all cached entries are automatically written to the database even when a user has not exited from the application.

**NOTE:** Audit Trail supports the Service Requests and Asset Mgmt - Asset business components.

**Audit Trail Content**

Audit Trail will record the following information:

- Field
- Row ID of the record being changed
- Operation being performed (Update/New/Delete/Copy)
- Original value
- Changed value
- User ID performing the operation
- Date and time the operation was performed

**Audit Trail for Siebel Remote Users**

The following information applies to remote users:

- Disconnected users cannot view the audit trail. However, when they synchronize with the server, audit trail records are created on the server, which reflect the transactions the disconnected users made.

- Information that will be used to create audit trails is synchronized, but the trails themselves are not synchronized.

- If the transaction is rejected during the conflict resolution, the corresponding audit trail record is also rejected.

**NOTE:** It is recommended that you do not change the Audit Trail business service.
Service Request Solutions

Customer service organizations estimate that approximately 85 percent of incoming service requests have been previously resolved by other customer service representatives. To minimize costs and maximize the effectiveness of a call center, an organization can reuse the solutions for previously resolved problems.

The Solutions module allows you to store, organize, associate, and search the knowledge base for resolutions successfully used for similar problems or even published solutions for potential problems.

After a problem is successfully resolved, you can associate the solution with the service request for reference, in case the service request is reopened by the customer at a later date. Recording the solution also makes it possible for you to resolve similar service requests without doing extensive research. You can find an existing service request, solution, or resolution document that may provide information relevant for the current service request or product defect under investigation. You can quickly review the information and associate it with the current service request or product defect.

**NOTE:** Full text search of service requests is configurable. To configure the search engine for service requests, see *Siebel Search Administration Guide*.

### Setting Up Problem Resolutions

Use the Administration - Solution screen to find and add information that can provide immediate resolutions to requests for service. For more information, see Table 13.

Table 13. Views on the Administration - Solution Screen

<table>
<thead>
<tr>
<th>View</th>
<th>Role in Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution Documents</td>
<td>Associates with solutions document files that describe a problem and its solution.</td>
</tr>
<tr>
<td>Related Solutions</td>
<td>Associates related solutions with specific solutions.</td>
</tr>
<tr>
<td>Service Requests</td>
<td>Specifies service requests related to a specified solution.</td>
</tr>
<tr>
<td>Change Requests</td>
<td>Specifies change requests related to a specified solution.</td>
</tr>
<tr>
<td>Solution Categories</td>
<td>Associates solution categories with a solution.</td>
</tr>
</tbody>
</table>

For more information about setting up solutions, see “Setting Up Solutions” on page 63.

### Setting Up Solutions

Use the Administration - Solution screen to provide the information that can provide immediate solutions to requests for service.
To add a solution
1. Navigate to the Administration - Solution screen > Solutions view.
2. Create a new record and complete the fields as appropriate.

To add a resolution document to a solution
1. Navigate to the Administration - Solution screen > Solutions view.
2. Drill down on the Name field for a selected solution and click the Resolution Documents view tab.
3. Create a new record and complete the fields as appropriate.

NOTE: You can only choose a resolution document from the available list. To create a new resolution document, see "Resolution Documents View" on page 66.

To associate solutions with each other
1. Navigate to the Administration - Solution screen > Solutions view.
2. Drill down on the Name field for a selected solution and click the Related Solutions view tab.
3. Create a new record and complete the fields as appropriate.

To associate a service request with a solution
1. Navigate to the Administration - Solution screen > Solutions view.
2. Drill down on the Name field for a selected solution and click the Service Requests view tab.
3. Create a new record and complete the fields as appropriate.

To associate a change request with a solution
1. Navigate to the Administration - Solution screen > Solutions view.
2. Drill down on the Name field for a selected solution and click the Change Requests view tab.
3. Create a new record, and complete the fields as appropriate.

Editing Resolution Documents
Resolution documents are, by default, read-only. Use the following procedure to edit these documents in the Administration - Solution screen.

To allow editing of resolution documents
1. Start Siebel Tools.
2. Choose the SR Resolution Item list frame.
3. Choose the list column ResFileName.
4 Change the read-only property from TRUE to FALSE.
5 Compile and test the change.

Administration - Solution Screen

The Administration - Solution screen defines solutions to service requests and associated resolution documents, solutions, service requests, and change requests. It also provides predefined solution categories that add information to a solution.

The information provided in these views appears in the Solutions screen (see "Solutions Screen" on page 66). Descriptions of the views for this screen follow.

- Solutions View on page 67
- Resolution Documents View on page 66
- Related Solutions View on page 66
- Service Requests View on page 67
- Change Requests View on page 66
- Solution Categories View on page 66

Solutions View

The Solutions view records the name and description of a solution, plus the frequently asked questions (FAQs) to which the solution might respond. Table 14 shows the items in solutions records.

Table 14. Selected Items in the Solutions View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish Internal</td>
<td>A check box that indicates this information is available to internal users. The check box indicates this solution will not appear in solution lists exposed to customers over the Web, but appears on internal solution lists.</td>
</tr>
<tr>
<td>Publish External</td>
<td>A check box that indicates this information is available to external users. The check box indicates that this solution appears both in solution lists exposed to customers over the Web and on internal solution lists.</td>
</tr>
</tbody>
</table>

The More Info view for the Solutions list displays Solution Categories that provide additional predetermined pieces of information that add to this solution.
Resolution Documents View

The Resolution Documents view allows you to associate files with a service request. These files can contain information that contributes to solving the service request. Use the following procedure to create these documents in the Administration - Resolution Documents view.

To create a resolution document

1. Navigate to the Administration - Resolution Documents view.
2. In the Resolution Documents list, create a new record.
3. In the File Name field, navigate to an electronic document on your computer or on your network.

Related Solutions View

The Related Solutions view associates solutions records that may contribute to the resolution of a selected solution.

Service Requests View

The Service Requests view associates service requests that may contribute to a solution.

Change Requests View

The Change Requests view associates change requests that may contribute to a solution.

Solution Categories View

The Solution Categories view associates predefined solutions that may contribute to an overall solution.

Solutions Screen

The Solutions screen provides predefined solutions with associated resolution documents, solutions, service requests, and change requests. This information is defined in the "Administration - Solution Screen" on page 65. Most of the views in the Solutions screen are identical to those in the Administration - Solution screen, with the exception of Solution Categories, which is unavailable in the Solutions screen.

Most views in the Solutions screen allow users to add records. Descriptions of the views for this screen follow.

- Solutions View on page 67
Solutions View

The Solutions view displays the name and description of a solution, the FAQ to which the solution might respond, and an answer to the FAQ. These records are read-only.

Resolution Documents View

The Resolution Documents view associates a selected solution with files containing information that contributes to solving a service request.

Related Solutions View

The Related Solutions view associates a selected solution with solutions records that may contribute to the resolution of a selected solution.

Service Requests View

The Service Requests view associates a selected solution with a service requests that may contribute to this solution.

Change Requests View

The Change Requests view associates a selected solution with change requests that may contribute to a solution.

Customer Satisfaction Survey View

The Customer Satisfaction Survey view records the responses from customers on the effectiveness of service. The answers to predetermined questions contribute to a customer satisfaction score (Satisfaction Level). This survey is associated with a selected solution.
Field Service Activities

This chapter shows how Field Service uses activities. For general information about activities, see the Activities chapter of *Siebel Applications Administration Guide*. Topics include:

- Field Service Activities on page 69
- Setting Up Field Service Activities on page 73
- Recording Field Service Activities on page 75
- Administration - Application Screen on page 78
- Activities Screen on page 79
- Activity Reports on page 87
- Products Screen on page 88
- Part Browser Screen on page 89
- Using the Task UI Application to Perform Field Service Activities on page 89

Field Service Activities

Using Siebel Field Service, field service engineers work from activities. Activities are either attached to a service request or stand-alone. Using an activity template, Field Service can automatically provide a set of activities to carry out a service request. Topics include:

- Field Service Activity Templates and Activity Plans on page 71
- Category Field on page 72

In Siebel Field Service there are common types of activities:

- Service activities that fall into these categories:
  - Installation
  - Preventive maintenance
- Repair activities, including shipping and receiving

Field Service provides activities to track the tasks done in response to a service request, a preventive maintenance request, the report of a change request, and the request for a repair. The Activities screen records activities that must be assigned to field service or call center personnel.

Field service and repair activities are accompanied by detailed information for field service personnel, which includes steps, items (recommended parts/tools), skills and instructions, field part movements, expense recording, and time recording.

**NOTE:** Recommended parts and tools are called *Items*.

These are the major advantages of breaking down a service request into one or more activities:
Field Service Activities

- The ownership of the problem remains at the call management level, when required.
- The field service engineer looking at assigned activities can easily identify only the required information.
- Reporting is simplified.
- Activities can be assigned to more than one person.

**NOTE:** Field service activities can be stand-alone (for example, preventive maintenance activities) or, more commonly, attached to service requests. For complex preventive maintenance activities, it may be convenient to formalize the activity by creating a service request.

Field engineer activities are an extension of the Siebel Activity object, with Field Service customizations that specifically meet the requirements of engineers reporting complex, standardized service activities.

Activity objects may be associated with the following Siebel objects:

- Accounts
- Agreements
- Assets
- Campaigns
- Change requests (Quality screen)
- Contacts
- Messages
- Opportunities
- Order Items
- Preventive maintenance
- Programs
- Projects
- Repairs
- References
- Service requests

Activities, once generated, are assigned to appropriate engineers. Assigned activities are displayed on the engineers' calendars and the engineers may receive automatic notification by way of their laptop computers, handheld computers, cell phones, or pagers. Engineers can accept or decline an activity and, once accepted, use the Activities screen to report on its execution.

Assigning activities can take place manually, one by one, on the Activities, Service Requests, and Dispatch Board screens. The person assigning can select engineers manually or use the Assignment Manager (Assign menu command). Automatic assignment uses a variety of criteria for assignments, including skills, role priorities, availability, location, and cost.

Scheduling of assigned engineers can take place manually on the Activities screen, on the drag-and-drop interface of the Dispatch Board screen, or automatically using Siebel Scheduler.
For a description of assigning and scheduling activities, see Chapter 5, "Setting Up and Using Scheduling" and Chapter 6, "Setting Up and Using the Dispatch Board."

Field Service Activity Templates and Activity Plans

Activity plans are created using activity templates. Activity templates are collections of predefined activities. Activity plans may include schedule requirements for carrying out these activities.

In the Activity Plans views on the Service Requests, Accounts, and Repairs screens, only the activity templates for specific types of activity are visible. For example, when you generate an activity plan for opportunities, only activity plans of the type Opportunity are visible. When you select a template all the activities in that template and the child records of those activities (for example, Service Details, Items, Skills, and so on) are selected.

Fields Copied from Activity Templates

The following fields are copied from activity templates to an activity plan:

- Activity type
- Alarm
- Category
- Comments
- Cost Estimate
- Description
- Display In
- Duration
- Employee

**NOTE:** If Employee is defined in the Activity Template, then it is copied. Otherwise, the value in the Employee field depends on the activity category. If the activity category is not Field Engineer Activity, Repair Activity, Preventive Maintenance, or Other, then the Employee field is populated with the current login ID.

- Lock Assignment
- Priority
- Status

Child records associated with the template are copied to the following views on the Activities screen:

- Steps view
- Instructions view
- Items view
Skills view

**NOTE:** To copy the child records from the template, set the activity Category field to Field Service Activity, Preventive Maintenance, Repair Activity, or Other. See “All Activities View” on page 80.

For more information about views on the Activities screen, see “Activities Screen” on page 79.

**Category Field**

The Category field on the Service Details subview determines the following for activities generated from the activity template:

- Whether child records of the activities are created when the template is applied
- Whether assignment of the activity is locked
- How the activity is assigned

For more information about this subview, see "Service Details Subview” on page 79.

**Child Records**

If the Category field is set to Field Engineer Activity, Repair Activity, Preventive Maintenance, or Other, then any child records such as service activity steps or assignment skills will be created when the activity template is applied.

If the Category field is left blank or set to a value other than those listed in the previous paragraph, the activity records will be created when the template is applied, but no child records will be associated with the activities.

**Lock Assignment**

If the Category field is left blank, the Lock Assignment check box for the created activity is selected.

**Field Service Activity Assignment**

An activity created with activity templates can be assigned to any one of the following users:

- The employee specified in the template
- The employee who created the activity by applying an activity template (for example, in a sales situation)
- No employee

**NOTE:** This setting is recommended when Siebel Assignment Manager is to be used to assign the activity.
Field Service Activities ■ Setting Up Field Service Activities

The assignment is determined by the values in the Employee and Category fields of the activity record in the Activity Template Details list. Table 15 shows how the assignment is determined.

Table 15. Employees and Category Values Determine Activity Assignment

<table>
<thead>
<tr>
<th>Employees Field Value</th>
<th>Category Field Value</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT NULL</td>
<td>Any value (NULL or NOT NULL)</td>
<td>Assigned to the employee specified in the Employee field of the activity template.</td>
</tr>
<tr>
<td>NULL</td>
<td>Field Engineer Activity, Repair Activity, Preventive Maintenance, or Other</td>
<td>Not assigned. The Employee and Owner fields are blank in the created activity.</td>
</tr>
<tr>
<td>NULL</td>
<td>Not Field Engineer Activity, Repair Activity, Preventive Maintenance, or Other</td>
<td>Assigned to the employee who created the activity by applying the activity template.</td>
</tr>
</tbody>
</table>

Setting Up Field Service Activities

This section provides the procedures for setting up field service activities, which include defining activity templates and supplying information for carrying out each activity. Topics include:

■ Setting Up Field Service Activity Templates on page 73
■ Alarms for Field Service Activities on page 74

Setting Up Field Service Activity Templates

Follow these procedures to set up activities.

To define activity templates
1. Navigate to the Administration - Data screen > Activity Templates view.
2. Create a new record and complete the fields as appropriate.

To associate activities with activity templates
1. Navigate to the Administration - Data screen > Activity Templates view.
2. Drill down on a selected activity template and click the Activity Template Details view tab or the Service Details view tab.
3. Create a new record and complete the fields as appropriate.

To associate steps, skills, parts and tools, and instructions with an activity
1. Navigate to the Administration - Data screen > Activity Templates view.
2 Select an activity template and click the Service Details view tab.
3 Select an activity record and click the Service Activity Steps view tab.
4 Create a new record and complete the fields as appropriate.
5 Click the Assignment Skills view tab.
6 Create a new record and complete the fields as appropriate.
7 Click the Service Activity Items view tab.
8 Create a new record and complete the fields as appropriate.
9 Click the Service Activity Instructions view tab.
10 Create a new record and complete the fields as appropriate.

**Alarms for Field Service Activities**

Activities are attached to many Siebel business objects; for example, Service Requests and Opportunities. Siebel applications can notify the user of the start time for a pending activity. Selecting the Alarm check box in each Activity record turns on this notification.

Alarm notification displays a dialog box or pop-up window in the Siebel user interface at a predetermined interval before the start of each activity. The Alarm dialog box appears only once for each activity, unless the activity is repeated (the Repeat box is selected in the activity record). If the activity is repeated, the alarm appears at the specified time before the start of each instance of the activity.

Alarms work only through the user interface; they cannot trigger workflow processes. Because alarms require high interactivity, they are available only for Siebel Enterprise Applications that have high interactivity selected.

**Setting Alarms for Field Service Activities**

Alarms notify users of upcoming activities. One setting configures the time at which the notification takes place.

**To set the time that alarms appear**

1 From the application-level menu, choose Tools > User Preferences.
   The User Preferences screen appears.
2 On the link bar, click Calendar.
   The Calendar form appears.
3 In the Alarm Lead Time field, select a time from 5 to 120 minutes before the value of Planned Start for each activity.
Turning On Alarms for Field Service Activities
To set the alarm for an activity, select the Alarm box in an activity record on any screen that provides an Activities view or in the Calendar screen (see the following procedure).

**To turn on alarms for a calendar activity**
1. Navigate to the Calendar screen.
2. Create a new record and complete the fields as appropriate.
3. In the Calendar Detail view, select the Alarm check box.
4. Click Save This One.

Recording Field Service Activities
The following procedures suggest a typical workflow for a field service engineer who is working from a set of activities.

**To log expenses for an activity**
1. Navigate to the Activities screen > Activity List view.
2. Select an activity and drill down on the Type field.
3. Click the Expense Tracker view tab.
4. Create a new record and complete the fields as appropriate.

**To log hours spent on an activity**
1. Navigate to the Activities screen > Activity List view.
2. Select an activity and drill down on the Type field.
3. Click the Time Tracker view tab. To create a time tracker record, click Start.
   - The Start field is automatically filled in with the time you create the record.
4. To record the end time for an activity, click Stop.

**NOTE:** Instead of logging hours at the start and stop times of an activity, you can log hours anytime after the activity is completed. To do so, click the New button instead of the Start button, and then complete the necessary fields. If an entitlement is associated with the activity, enter only one record for all hours, even if they are a combination of regular, overtime, and extended overtime hours. Because there is an entitlement with metrics and a schedule, the Auto Charge feature will automatically determine regular, overtime, and extended overtime charges. However, if there is not an entitlement with metrics and a schedule, create separate records for each time period—regular, overtime, and extended overtime—spent on the activity. For more information, see “Process of Setting Up Entitlements” on page 218.
**Field Service Activities**

**Recording Field Service Activities**

1. **To verify the availability and order status of materials for an activity**
   - Navigate to the Activities screen > Activity List view.
   - Select an activity and click the Items view tab.
   - The associated parts and tools appear in the Items list. The Order #, Order Type, and Line Status fields show the status for receiving an ordered part.

   **NOTE:** A field service engineer can create an order from the Items list by clicking the menu button and selecting the type of order needed (Service or Sales). To verify the order or to view order details, save the record and click the hyperlink in the Order field.

2. **To order materials for a field service activity**
   - Navigate to the Activities screen > Activity List view.
   - Select an activity and click the Items view tab.
   - Select a record. Then from the menu drop-down list, choose Service Order.
   - To order all items that have not yet been ordered, choose Service Order All.
   - A new, unique order number appears in the Order # field as a hyperlink and the Order Type field shows Service Order. The order also appears in the Service Order screen.

3. **To verify on-hand inventory using the Part Browser**
   - Navigate to the Part Browser screen.
   - Select a part, then do the following:
     - Check the Inventory Level subview for the part’s availability, status, and quantity at that inventory location.
     - Check the Substitutes subview to see if there are any alternatives for a part.

4. **To verify on-hand inventory using Check Trunk**
   - Navigate to the Activities screen > Activity List view.
   - Select an activity record and drill down on the Type field.
   - Click the Items view tab.
   - Select the activity item and then click Check Trunk.
   - The Available Qty field is updated according to the current user’s trunk inventory.

5. **To record the movement of service parts in the field**
   - Navigate to the Activities screen > Activity List view.
   - Select an activity and click the Part Tracker view tab.
Add a part movement record and complete the fields as appropriate. If the part movement is an asset swap, see "To record the swapping of one asset for another" on page 77.

This creates an inventory transaction, an asset transaction, or both (depending on the source or destination) in the Field Service server.

**NOTE:** Part movements recorded in the field appear here only after the field service engineer has synchronized the mobile computer. If the engineer described the part with an add-in serial number, the part transfer appears here only after processing by an administrator.

**To record the swapping of one asset for another**

1. Navigate to the Activities screen > Activity List view.
2. Select an activity and click the Part Tracker view tab.
3. Create a new record for the uninstalled asset and complete the fields as appropriate.
   - Do not enter anything in the Swap Part Mvmt # field.
4. Add another record for the installed asset and complete the fields as appropriate. Select the uninstalled asset in the Swap Part Mvmt # field.
   - For more information on asset swapping, see “Asset Swaps” on page 470.

**To generate an invoice automatically for a field service activity**

1. Navigate to the Activities screen > Activity List view.
2. Drill down on a selected activity and click the Invoices view tab.
3. Click Auto Invoice. The activity must be billable in order to generate an invoice.

**To enter a new activity for a service request**

1. Navigate to the Service screen > Service Requests List view.
2. Select a service request and drill down on the SR # field.
3. Click the Activities view tab.
4. Create a new record and complete the fields as appropriate.

**To record additional recommended steps for a service request**

1. Navigate to the Activities screen > Activity List view.
2. Select an activity and drill down on the Type field.
3. Click the Steps view tab.
4. Create a new record and complete the fields as appropriate.
To record additional skills required to complete a service request
1. Navigate to the Activities screen > Activity List view.
2. Select an activity and drill down on the Type field.
3. Click the Assignment Skills view tab.
4. Create a new record and complete the fields as appropriate.
5. Select the newly created record.
6. In the Service Activity Skill Item subview, create a new record and complete the fields as appropriate.

To record additional instructions for a service request
1. Navigate to the Activities screen > Activity List view.
2. Select an activity and drill down on the Type field.
3. Click the Instructions view tab.
4. Create a new record and complete the fields as appropriate.

Monitoring Field Service Activities
A service center agent can use the following procedures to monitor the progress of a service request.

To review a field service engineer’s activities
1. Navigate to the Calendar screen.
2. From the Owner drop-down list, select the name of the field service engineer.
3. Click the Daily, Weekly, or Monthly view tab.

To verify part movements in the field
1. Navigate to the Activities screen > Activity List view.
2. Select an activity and drill down on the Type field.
3. Click the Part Tracker tab.
   A record of part movements appears in the Part Tracker list.

Administration - Application Screen
The Administration - Application Screen has a view and a subview that are suitable for defining Field Service-related activity plan templates.
Activity Templates View
The Activity Templates view creates activity plan templates for all Siebel applications. Any number of activities may be associated with these templates. Table 16 describes items in activity templates records.

Table 16. Selected Item in the Activity Templates View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>When selected, this check box indicates that the information can be accessed by customer and partner applications, as well as by employee applications.</td>
</tr>
<tr>
<td>Auto Trigger</td>
<td>When selected this check box moves the activities from this template to a sales stage, when the sales stage is selected for an opportunity.</td>
</tr>
</tbody>
</table>

Service Details Subview
The Service Details subview associates multiple activities with each activity template. This subview has tabs for associating steps, skills, parts and tools, and instructions with an activity.

Table 17 describes items in activity template detail records.

Table 17. Selected Item in the Service Details Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakable</td>
<td>When selected, allows Optimizer to insert a break into an activity. For information about Optimizer, see Chapter 5, “Setting Up and Using Scheduling.”</td>
</tr>
<tr>
<td>Category</td>
<td>Category under which the activities will fall. For information about the effects of selections in field, see &quot;Category Field&quot; on page 72.</td>
</tr>
<tr>
<td>Duration</td>
<td>Complete duration of the activity, expressed in minutes, and calculated as work time + break time.</td>
</tr>
<tr>
<td>Lead Time</td>
<td>Duration of travel to, or other preparation for, the activity.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>When selected, prevents reassignment of the activities.</td>
</tr>
<tr>
<td>Units</td>
<td>Units of measure for Lead Time field.</td>
</tr>
<tr>
<td>Work Time</td>
<td>Duration of work.</td>
</tr>
</tbody>
</table>

Activities Screen
The Activities screen manages all activities that a field service engineer carries out in response to a service call. Topics include:

All Activities View on page 80
Field Service Activities  ■ Activities Screen

- Charges View on page 82
- Expense Tracker View on page 82
- Part Tracker View on page 82
- Instructions View on page 84
- Invoices View on page 84
- Readings View on page 84
- Items View on page 85
- Schedule View on page 85
- Assignment Skills View on page 85
- Steps View on page 86
- Time Tracker View on page 86
- Charts View on page 87

### All Activities View

The All Activities view shows all activities, both active and closed, assigned to field service engineers. A field service engineer can add activities or modify existing activities; for example, change the status of an activity. The Activities view changes from a list to a form after you drill down on an activities record.

**NOTE:** The child records of activities (for example, Steps) may be available only for activities of certain types (for example, Service).

*Table 18* describes items in Activities records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>When selected, a check box that turns on a warning if the activity does not begin by the planned start date.</td>
</tr>
<tr>
<td>Billable</td>
<td>When selected, a check box that indicates that this activity is billable to the customer.</td>
</tr>
<tr>
<td>Category</td>
<td>Determines the type of child records that are inherited from the activity template. For more information, see &quot;Fields Copied from Activity Templates&quot; on page 71. It also determines the behavior of the Lock Assignment flag. For more information, see &quot;Rules for Assigning Activities&quot; on page 81.</td>
</tr>
<tr>
<td>Change Request #</td>
<td>The defect number for a product associated with this activity, chosen from a dialog box.</td>
</tr>
<tr>
<td>Defective Tag</td>
<td>The defective tag number (repair number) associated with this activity, chosen from a dialog box. Displayed in the form only.</td>
</tr>
</tbody>
</table>
Rules for Assigning Activities

When an activity is created with the Category field set to Field Engineer Activity, Repair Activity, Preventive Maintenance, or Other, the following occurs:

- No owner is assigned.
- The Lock Assignment flag is set to False—meaning that the Assignment Manager automatically assigns this activity.

After the record is saved, changing the Category value does not have these effects.

Use Siebel Tools to change the default for activity categories (set ASGN_USR_EXCLD_FLG to N; the default is Y).

Use the Lock Assignment flag in the "All Activities View" on page 80, the "Schedule View" on page 85, and the "Activity Templates View" on page 79 to change this assignment for individual activities. If this flag is selected, the Assignment Manager excludes this activity.

Table 18. Selected Items in the Activities View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due</td>
<td>This is the last time and date for an activity, usually used to indicate contractual commitments or deadlines. This field is automatically populated with the value from the Agent Committed field for the service request (see &quot;Agent Committed Time for a Service Request&quot; on page 53). Due is the same as the Latest Start field in the Schedules view on this screen.</td>
</tr>
<tr>
<td>Duration</td>
<td>The time required to carry out an activity, including breaks and travel time. The value is = Planned End – Planned Start. Displayed in the form only.</td>
</tr>
<tr>
<td>Employees</td>
<td>The names of the employees assigned to carrying out a selected activity. One employee may be identified as primary.</td>
</tr>
<tr>
<td>Repeat Frequency</td>
<td>The interval at which to repeat this activity: daily, weekly, monthly, quarterly, or yearly. The repeated activity appears multiple times in the service engineer’s calendar. The Dispatch Board cannot schedule repeated activities.</td>
</tr>
<tr>
<td>Private</td>
<td>When selected, a check box that indicates this activity is only visible to its owner. Displayed by clicking the menu button and selecting Columns Displayed.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>When selected, a check box that instructs the Assignment Manager not to assign this activity. For more information, see &quot;Rules for Assigning Activities&quot; on page 81.</td>
</tr>
<tr>
<td>Repeat Until</td>
<td>End date for repeating this activity.</td>
</tr>
<tr>
<td>Resolution Code</td>
<td>The solution code for an activity, chosen from a drop-down list. Also applies to a service request, and is labeled Resolution in the Service Requests view.</td>
</tr>
<tr>
<td>SR #</td>
<td>The service request associated with a selected activity.</td>
</tr>
<tr>
<td>Status</td>
<td>The state of an activity; for example, Approved, Unassigned, or Done. Clicking the hyperlink for the value Unscheduled in the Status field presents the Dispatch Board screen.</td>
</tr>
</tbody>
</table>
**Charges View**

The Charges view displays charges created for this activity. Field service engineers can generate charges manually or automatically, using the Auto Charge button, for any activities that are marked as billable and with the rate list specified.

When Auto Charge is used for an activity and the Entitlement field is populated, charge amounts are calculated based on:

- Time Tracker records (except for the Rate field)
- The Rate list and Price list
- The entitlement’s service hours and metrics (service details definitions and exceptions) set by the administrator in the Administration - Contracts screen
- The Schedule Hours and Exception Hours set by the administrator in the Administration - Service screen

When Auto Charge is used for an activity with the Entitlement field empty, charge amounts are calculated based on:

- Time Tracker records
- The Rate list and Price list

**Expense Tracker View**

The Expense Tracker view allows a field service engineer to record expenses related to an activity. *Table 19* describes the Billable check box in Expense Tracker records.

In the Expense Tracker view, a Complete button appears at the top of the Activity form. Clicking this button updates the Cost and Price fields for all the current activity’s parts, time, and expense records, and changes the value in the Activity record's % Complete field to 100. (Additionally, when the % Complete field reaches 100, the Status field value changes to Done.)

**Table 19. Selected Item in the Expense Tracker View**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable</td>
<td>When selected, a check box that indicates this expense is billable to the customer. When this flag is set, this record is used to create an invoice.</td>
</tr>
</tbody>
</table>

**Part Tracker View**

The Part Tracker view describes the transfer of parts in the field between the client, a service order, and the field service engineer's trunk inventory. *Table 20* describes items in Part Tracker records.

**NOTE:** Transactions between inventories and between inventories and customers are recorded on the Inventory Transactions screen. For more information, see "Inventory Transactions View" on page 373.
In the Part Tracker view, a Complete button appears at the top of the Activity form. Clicking this button updates the Cost and Price fields for all the current activity's parts, time, and expense records, and changes the value in the Activity record's % Complete field to 100. (Additionally, when the % Complete field reaches 100, the Status field value changes to Done.)

Table 20. Selected Item in the Part Tracker View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable</td>
<td>When selected, a check box that indicates this labor is billable to the customer. When this flag is set, this record is used to create an invoice. The service business can define expenses that are not billable; for example, a coffee break.</td>
</tr>
<tr>
<td>Commit</td>
<td>When selected, a check box that indicates this transaction was committed. This check box is set automatically after clicking the Commit button, if all validations are completed. For more information, see “Commit Button” on page 84.</td>
</tr>
<tr>
<td>Commit and Commit All buttons</td>
<td>The Commit button creates a transaction for a selected, uncommitted record. The Commit All button creates transactions for all uncommitted records. Once committed, a record becomes read-only. Committed records cannot be uncommitted. For more information, see “Commit Buttons” on page 360.</td>
</tr>
<tr>
<td>Source</td>
<td>This field describes the location from which the part originated.</td>
</tr>
<tr>
<td>Destination</td>
<td>This field describes the final customer location for this part.</td>
</tr>
<tr>
<td>Swap Part Mvmt #</td>
<td>The Swap Part Mvmt # creates a one-for-one swap relationship between an uninstalled asset and an installed asset. In the record of the uninstalled asset, the Swap Part Mvmt # field is left blank. In the record of the installed asset, the uninstalled asset is selected in the Swap Part Mvmt # field. For more information about asset swaps, see “Asset Swaps” on page 470.</td>
</tr>
<tr>
<td>Write-In Asset</td>
<td>When selected, a check box that indicates the serial number for an asset is not in the local database. The user selects this check box, and then enters a write-in serial number. This setting is for information only.</td>
</tr>
<tr>
<td>Write-In Serial Number</td>
<td>A field for entering a serial number. This is for an asset that is not yet in the Field Service database on the local computer. An administrator generates the inventory transaction for the asset after the user synchronizes.</td>
</tr>
</tbody>
</table>
Commit Button
The Commit buttons validate the movement of serialized and nonserialized assets that are already recorded in the local database. For the validation mechanism, see “Commit Buttons” on page 360. If these validations are successful, the Commit flag is set in Part Tracker records and inventory movements are recorded by transactions in the database. If an asset is defined in the part movement record, an asset transaction is also recorded.

A user can create a part movement record without changing the inventory levels in the database. To change inventory levels, select the Commit check box or click the Commit button.

If the mobile computer is disconnected, the local database is updated. When the mobile computer is synchronized with the Siebel server, the information about the part movement is transferred to the server. If the asset was identified in the database on the remote computer, the server records the change in inventory location in the database and then creates a transaction.

Once committed, a field part movement record is read-only.

Instructions View
The Instructions view records instructions for carrying out an activity. These instructions may be specific to a customer’s site.

Invoices View
The Invoices view displays invoices created for an activity and allows manual or automatic generation (using the Auto Invoice command) of invoices for any activities that are marked as billable. For more information, see “Invoices View” on page 310 and “About the Auto Invoice Command” on page 299.

Readings View
The Readings view displays key characteristics of an asset, defined in the Activities form, that may be recorded and tracked. The upper list describes measurements that are described for this product. The Readings form records data for the selected measurement collected from the asset. The Readings view collects information used to trigger preventive maintenance activities and use-based invoicing.
Items View

The Items view shows the recommended parts and tools that a field service engineer must have to complete an activity. An activity template can populate these records, and the owner of the activity can add records. Table 21 describes items in Items records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Trunk</td>
<td>Clicking this button displays a pop-up window with the product name, part number, inventory location, quantity requested, and quantity available for the selected activity item. The quantity available is a calculated quantity.</td>
</tr>
<tr>
<td>Order #</td>
<td>The number of a sales or service order, if this part or tool is on order, which the field technician selects from a dialog box.</td>
</tr>
</tbody>
</table>
| Tool       | When selected, a check box that indicates this is a tool rather than a part. This is for information only; there is no associated code.  
Note that product records are created in the Administration - Product screen. The Products form view contains a Tools check box, which when selected, indicates that the product is a service tool and not a part that a customer would buy. Selecting this check box has other effects; for example, the customer cannot order this product. |

Schedule View

The Schedule view provides an extended description of the schedule and the scheduling process for a selected activity, plus controls for booking or cancelling future appointments and for inserting an activity in an optimized schedule. Some of the fields in this view also appear in “All Activities View” on page 80. See “Adding Schedule Information for Activities (End User)” for more information about using this view.

Assignment Skills View

The Assignment Skills view describes the skills needed to complete an activity. This view contains lists of Service Activity Skills and Service Activity Skill Items. Various skills, such as product or language skills, are required for a field service engineer to carry out an activity. Add skill types (which appear in the drop-down list for the Item field) using the Administration - Assignment screen (see Siebel Assignment Manager Administration Guide). The Assignment Manager uses these attributes in assigning an activity to the right employee.
Steps View

The Steps view describes the recommended procedures for carrying out an activity. Table 22 describes an item in Steps view.

Table 22. Selected Items in the Steps View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Done</td>
<td>When selected, a check box that indicates this step was completed. This setting is for record keeping; it has no effect on other functions in Field Service.</td>
</tr>
</tbody>
</table>

Time Tracker View

The Time Tracker view allows a field service engineer to record the hours spent on each field service activity. Table 23 describes items in Time Tracker records.

In the Time Tracker view, a Complete button appears at the top of the Activity form. Clicking this button updates the Cost and Price fields for all the current activity’s parts, time, and expense records, and changes the value in the Activity record’s % Complete field to 100. (Additionally, when the % Complete field reaches 100, the Status field value changes to Done.)

Table 23. Selected Items in the Time Tracker View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable</td>
<td>When selected, a check box that indicates this labor is billable to the customer. When this flag is set, the Charge Engine uses this record to create an charge. The service business can define expenses that are not billable; for example, a coffee break.</td>
</tr>
<tr>
<td>Start</td>
<td>Clicking this button creates a new Time Tracker record, records the date and time, and defaults the Type field to Work.</td>
</tr>
<tr>
<td>Stop</td>
<td>Clicking this button records the stop date and time for the activity in the Time Tracker record. To resume an activity, the field service engineer must click Start to create a new record.</td>
</tr>
</tbody>
</table>
Charts View
The Charts view provides the charts listed in Table 24 for the analysis of activities.

Table 24. Activities Analyses

<table>
<thead>
<tr>
<th>Chart</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account and Type Analysis</td>
<td>Two graphs:</td>
</tr>
<tr>
<td></td>
<td>- The number of activities for each account.</td>
</tr>
<tr>
<td></td>
<td>- The number of activities for each type of account.</td>
</tr>
<tr>
<td>Contact Analysis</td>
<td>The number of activities for each contact.</td>
</tr>
<tr>
<td>New Activities Analysis</td>
<td>The number of new activities as a function of a calendar period.</td>
</tr>
<tr>
<td>Status Analysis by Owner</td>
<td>The number of activities for each owner.</td>
</tr>
<tr>
<td>Status and Priority Analysis</td>
<td>Two graphs:</td>
</tr>
<tr>
<td></td>
<td>- The number of activities for each status category.</td>
</tr>
<tr>
<td></td>
<td>- The number of activities for each priority category.</td>
</tr>
<tr>
<td>Symptom and Resolution Analysis</td>
<td>Two graphs:</td>
</tr>
<tr>
<td></td>
<td>- The number of activities of each symptom type.</td>
</tr>
<tr>
<td></td>
<td>- The number of activities for each resolution code.</td>
</tr>
<tr>
<td>Trend Analysis by Activity Type</td>
<td>The number of activities of each type as a function of calendar period.</td>
</tr>
<tr>
<td>Trend Analysis by Product</td>
<td>The number of activities for each product as a function of calendar period.</td>
</tr>
</tbody>
</table>

Activity Reports
The Reports menu provides the reports, listed in Table 25, for activities.

Table 25. Activities Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity List</td>
<td>A summary of all activities.</td>
</tr>
<tr>
<td>Field Engineer Activity Summary</td>
<td>A summary of all activities for field service engineers.</td>
</tr>
<tr>
<td>Field Engineer Activity Detail</td>
<td>A full report of each field service activity, printed one per page.</td>
</tr>
</tbody>
</table>
Products Screen

The Products screen has one view, Product Service Details, that is useful for field service activities.

Product Service Details View

The Product Service Details view provides information about service products and possible substitute products. The values are defined in the "Administration - Product Screen" on page 337. All fields are read-only. Table 26 describes items in Product Service Details records.

Table 26. Selected Items in the Product Service Details View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Below Safety</td>
<td>When selected, a check box that indicates the Fulfillment and Part Locator Engines can allocate this product when its level in inventory is below the safety level.</td>
</tr>
<tr>
<td>Auto Substitute</td>
<td>When selected, a check box that indicates the Fulfillment and Part Locator Engines can automatically substitute a product.</td>
</tr>
<tr>
<td>Auto Allocate</td>
<td>When selected, a check box that indicates the Fulfillment and Part Locator Engines can allocate this product. If this box is cleared, the engines do not allocate this product.</td>
</tr>
<tr>
<td>Field Replaceable</td>
<td>When selected, a check box that indicates this item may be replaced at the customer site. This is informational only.</td>
</tr>
<tr>
<td>Lead Time</td>
<td>The wait time for the product to arrive. Allows the user to order the part with enough lead time to serve the customer.</td>
</tr>
<tr>
<td>MTBF</td>
<td>Mean time between failures; a measure of dependability of the product.</td>
</tr>
<tr>
<td>MTTR</td>
<td>Mean time to repair; a measure of the time required to repair the product.</td>
</tr>
<tr>
<td>Return Defective</td>
<td>When selected, a check box that indicates this item, if defective, should be returned to the service center. This is informational and has no effect on other fields or functions.</td>
</tr>
<tr>
<td>Serialized</td>
<td>A check box that indicates this product and all of its assets are serialized. Serialized products are treated in a different way. Whenever a serialized product is shipped or received, Field Service expects the right number of assets with serial numbers.</td>
</tr>
<tr>
<td>Tool</td>
<td>A check box that indicates this item is a tool used in service procedures. This is informational and has no effect on other fields or functions.</td>
</tr>
</tbody>
</table>

NOTE: Serialized products are treated differently from nonserialized products. Whenever a serialized product is shipped or received, Field Service expects the right number of assets. For example, if four serialized hard drives are shipped or received, Field Service expects that four separate assets have been entered.
Substitute Products Subview
The Substitute Products subview specifies the product that the Fulfillment Engine may use to fill an order when the specified product is unavailable from inventory. All fields are read-only.

**NOTE:** Multiple substitute products can be established in the Administration - Product Screen.

The user chooses from products that are specified in the "Products View" on page 337. The Fulfillment Engine can choose this product if the specified product is unavailable and the Auto Substitute flag is selected.

**NOTE:** Substitutions are unidirectional. Product A may substitute for Product B, but Product B cannot substitute for Product A unless that substitution is explicitly defined.

Part Browser Screen
The Part Browser view allows a field service engineer to investigate the availability of products and substitute products in all inventory locations within the field service business, or only those inventory locations associated with that field service engineer. All fields are read-only.

Depending on the visibility of the user, the Part Browser can show the inventory across Organizations (see "All Inventory Locations Across Organizations" on page 369).

**NOTE:** Do not confuse the Part Browser view with the Part Locator. The Part Locator is a semi-automated mechanism that Field Service provides to find products among various inventory locations when fulfilling orders (see the "Part Locator Engine" on page 328). The Part Browser simply displays products and their inventory locations.

Using the Task UI Application to Perform Field Service Activities
Siebel Field Service includes the Execute Field Task Start to Finish task to streamline the process of starting and completing field repair activities. This repeatable task navigates through screens and views where you can enter multiple records in a way that is easier and faster than manually navigating through individual screens. As you change status (En Route, In Process, Done, and so on), the task framework captures the time that the status changed and records it as a variable that corresponds to a Time Tracker Type field LOV entry. As the status is updated, a Time Tracker entry is generated behind the scenes.

For information on using the Task UI application, see *Siebel Fundamentals*. For details on customizing, activating, and assigning access privileges for tasks, see *Siebel Business Process Framework: Task UI Guide*.
Scenario for Performing Field Service Activities with the Task UI Application

A field engineer must complete a Field Repair assignment. He uses the Task UI application for this activity by clicking Execute Field Task Start to Finish in the Task UI pane. He uses the Next button to move from screen to screen in the task.

He first reviews details for the activity, then checks his trunk inventory. He updates the status to Scheduled and views a map of the account service location. He updates the status to En Route and drives to the site. When he arrives, he sets the status to In Progress. Behind the scenes, the Task UI creates a Time Tracker record for the time he was en route. For more information on the Time Tracker feature, see Time Tracker View on page 86.

On site, the field engineer looks at the Review Instructions screen, reviews and records steps and takes readings. He records the asset transactions that he performed while doing the repair, and logs his time and expenses. Finally, he prints an invoice for the customer to sign.

Activating and Registering Tasks for Field Service Activities

To use the Execute Field Task Start to Finish task in the Task UI application, you must activate and assign access privileges for the following tasks:

- Execute Field Task Start to Finish
- Field Activity Execution
- Field Activity En Route
- Field Activity Invoicing
- Field Activity Preparation
- Replace Asset

For information about activating and assigning access privileges for tasks, see Siebel Business Process Framework: Task UI Guide.

Example of Using the Task UI Application to Execute a Field Service Activity

The following example lists the steps that an end user performs to use the Execute Field Task Start to Finish task.

To execute a Field Service Activity from Start to Finish

1. Navigate to Activities > Activity List.
2. Click the Task button.
3 In the Task UI pane, click Execute Field Task Start to Finish.

4 In the Review Address and Details screen, review and adjust any necessary fields, and click Next.

5 In the Check Trunk for Recommended Inventory screen, review the inventory information. The following options are available:
   ■ Check Trunk
   ■ Create Order for Selected Parts
   ■ Service Order All
   Click Next.

6 In the Update Status screen, choose an action for the activity, such as Mark as In Progress. Click Next.

7 In the Review and Submit screen, review the information for the activity, and click Submit.

8 In the Review and Record Steps screen, record the steps for this activity. You can choose from the options such as Automated Diagnostic Test, Customer Approval, Install New Parts, Customer Satisfaction Survey, or query for another step.

9 In the Choose Part Transaction screen, choose a part transaction for the activity or choose Continue.

10 In the Parts Transaction Summary screen, click the Commit or Commit All buttons to commit the part transactions in inventory.

11 In the Update Time Sheet screen, enter or update the time records for the selected activity.

12 In the Activity Expenses screen, enter or update the expense records for the selected activity.

13 In the Select Invoice Option screen, choose to generate an invoice, generate charges and review, or continue.

14 In the Review and Submit screen, review the activity, and click Submit.
5 Setting Up and Using Scheduling

This chapter describes the various aspects of scheduling. Topics include:

- About Schedules in Siebel Field Service on page 94
- About Siebel Scheduler on page 94
- About the Appointment Booking System on page 96
- Scenario for the Appointment Booking System on page 96
- About the Scheduling Optimizer on page 96
- About Schedule Horizons and Time Zones on page 98
- About Scheduling Heuristic Methods on page 100
- What Happens During Appointment Booking? on page 101
- Guidelines for Setting Up Scheduling on page 102
- Process of Setting Up Scheduling on page 106
- Defining Schedule Hours on page 107
- Defining Service Regions on page 109
- Defining Employee Availability and Schedules on page 116
- Creating Time Windows for Scheduling on page 121
- Creating Constraint Sets for Scheduling on page 122
- Creating Parameter Sets for Scheduling on page 127
- Defining Cost Functions for the Optimizer on page 134
- Setting Up Server Key Mappings on page 136
- Setting Server Component Task Parameters on page 139
- Reloading the ABS and Optimizer Caches on page 140
- Process of Scheduling Activities on page 148
- Adding Schedule Information for Activities (End User) on page 148
- Booking Activity Appointments (End User) on page 150
- Locking Schedules and Assignments (End User) on page 153
- Optimizing Schedules (End User) on page 155
- Running Contract Scheduling (End User) on page 157
- About Troubleshooting the Appointment Booking System and Optimizer on page 159
- About Configuring the Appointment Booking Display on page 165
About Schedules in Siebel Field Service

A schedule describes the hours in a week for which the customer is entitled to receive service.

**NOTE:** Depending on the Siebel application and screen, Schedule means the same as Service Hours or Service Calendar.

Schedules are based on a typical work week. For each schedule, an administrator can also specify holidays and excluded days for which contractually covered service is not offered to a customer.

About Siebel Scheduler

This section describes how users can assign and schedule personnel to carry out field service activities.

**NOTE:** In Siebel Field Service, the term *users* can include any of the following: dispatchers, who review one or many region schedules and manually rearrange them; call or service center representatives, who handle the customer calls and make appointments for service activities; automated processes (for example, workflows) which identify an activity and then perform automatic scheduling.

The process of scheduling field service engineers must take into account a wide range of factors, including availability of personnel, proximity to the customer site, skills, availability of parts, efficiency of scheduling, and optimizing costs to the service provider.

Field Service provides these tools for assigning and scheduling activities:

- **Manual assignment.** Manual assignment is available in any Activities view, where a dispatcher or customer service representative can fill in the Employees field. For procedures, see "Assigning Field Service Engineers for Activities (End User)" on page 196.

- **Dispatch Board.** This screen lets a dispatcher or customer service representative manually assign and schedule individual activities by dragging and dropping an activity onto a Gantt chart. See Chapter 6, “Setting Up and Using the Dispatch Board” for more information.

- **Assignment Manager.** This function provides a list of personnel who are qualified to carry out a service activity or service request. The list, based on a set of rules, is ranked by a score that indicates the engineer’s suitability. The dispatcher or customer service representative chooses a field service engineer from this list. See *Siebel Assignment Manager Administration Guide* for more information.
Appointment Booking System (ABS). Using the ABS, a customer service representative can schedule future appointments, with a choice of time periods from which a customer can select, and book appointments. The output of the ABS is the assignment of specific field service engineers to service activities on specific dates and times. See “About the Appointment Booking System” on page 96 for more information.

Optimization Engine. The main purpose of the Optimization Engine, or Optimizer, is to reorganize and reassign a schedule to reduce the cost of the schedule. The Optimizer uses a flexible set of constraints, availability, and cost considerations. See “Defining Cost Functions for the Optimizer” on page 134 for more information.

The Optimizer can reorganize schedules to meet contractual commitments for service, accommodate emergency service calls, and meet unforeseen events in the service organization (for example, sick days for field service engineers). These functions of the Optimizer are known as Contract Scheduling.

Contract Scheduling inserts high-priority service activities into a schedule with minimal disruption of the schedule and without significant increase in the cost of the schedule. Contract scheduling requires an immediate response. For contract commitments, the Optimizer can either fit the service activity into a free spot in a schedule or reschedule and reoptimize an entire schedule to accommodate a new activity. See “About the Scheduling Optimizer” on page 96 for more information.

After an activity is assigned and scheduled, the Workflow Manager can notify a field service engineer by sending, for example, an email or a notification to a wireless device. The engineer can then synchronize a mobile PC or handheld computer to obtain details about an activity.

Business Requirements for Scheduling
Typically, businesses that schedule personnel have the following needs:

- Match the right person to an activity, depending, for example, on the skills required for that activity.
- Minimize the cost of service. This usually means minimizing overtime, downtime, and travel.
- Respect contractual commitments (for example, service personnel must be onsite within 24 hours).

Businesses have to schedule service for three different time spans:

- For emergencies today, making sure that the best person can respond in the promised time frame.
- For the jobs occurring over the next week or two, ensuring that the appropriate people are efficiently utilized and not spending excess time traveling from site to site.
- For the weeks and months ahead, booking future jobs such as preventive maintenance and installations, using available resources efficiently.
About the Appointment Booking System

A significant portion of a service business is concerned with activities happening in the future, such as installations or preventive maintenance. The Siebel Appointment Booking System (ABS) is designed to automate the process of offering appointments to customers. The ABS operates in real time.

The ABS provides a list of available time slots for future appointments, and then reserves a selected appointment slot. Customers may prefer a shorter time slot, but the window should be large enough that there is a high probability that the engineer can meet a commitment.

Scenario for the Appointment Booking System

A cable service company employs customer service representatives who handle calls from customers wanting to have cable installed. The cable installation requires that customers be present to let the field service engineer into their residence. Customers generally do not want to spend the entire day waiting for the engineer to arrive, which means that they are much happier if the service representative can give them a time range.

When the customer calls to schedule the cable installation, the service representative asks the customer for a general time when he or she expects to be at home. The customer service representative then attempts to book an appointment for this approximate time. During this process, the ABS returns a time window during which the field service engineer can arrive. The customer service representative can then book appropriately skilled field service engineers for a particular time range. Installing the cable takes approximately one hour, so the service representative may give the customer a time slot from 8 A.M. to 12 P.M. Booking field service engineers for a time range rather than a specific time allows some leeway in case problems occur—for example, traffic jams or jobs that run for longer than anticipated.

About the Scheduling Optimizer

The Optimizer uses a number of complex algorithms to meet the following objectives:

- Assign field service engineers to service activities
- Schedule these activities
- Maximize the efficiency and the quality of service
- Minimize cost to the service organization

The Optimizer can also respond to immediate scheduling demands to provide break/fix activities that meet the requirements of service entitlements (for example, a response within four hours), emergencies (for example, breakdown of service vehicles), and changes in service personnel.
Schedule Optimization

Because most service costs are derived from labor, efficient use of labor is one of the primary goals of a service organization. Efficiency encompasses a broad array of objectives, some of which may conflict:

- Solving a service request the first time, which requires assigning a field service engineer with the right skills and parts.
- Skilled engineers can finish a task faster; however, they should also be assigned to more challenging work so their time is not wasted on trivial tasks.
- Where possible, travel between jobs should be minimized by grouping jobs in a particular area.
- Engineers should appear on site within contractually committed times.

The Optimizer provides automated, background optimization of the schedule for field service activities and optimal use of resources in each service region.

Business Priorities

Every business has a different definition of efficiency in delivering service. Businesses that have requirements for critical responses (for example, a utility company may have downed power lines) define efficiency as placing someone on site within the shortest time. In this case, response is more important than full utilization. Other businesses do not have stringent response requirements but require higher utilization to preserve profits. In either case, a service business needs to set priorities when scheduling and dispatching personnel.

Break/Fix Activities and Contract Scheduling

Most service businesses start the day with a schedule of activities to perform, such as maintenance, installations, and other booked repairs. During the day, customers may call for repairs (break/fix activities), requiring modification of schedules.

Customers with service contracts often have specific entitlements with a required response time. This response time may be tiered based on the level of the contract: standard contracts may promise engineers will be onsite within 24 hours, while premium contracts may specify response times as short as two hours.

Break/fix activities must be inserted into the schedule that the Optimizer has carefully optimized during the previous night. Optimizing the schedule again is usually not practical because optimization routines can run for an hour or two to determine good solutions. Customers want a service commitment immediately, often while they are on the phone. You must achieve a balance between trading optimized schedules for quick responses and customer satisfaction while still enforcing business rules.

The ideal solution for the customer service representatives, in response to break/fix requests, is to click a button and receive a time for a service call that respects contractual agreements and other constraints. The Optimizer addresses this need.
About Schedule Horizons and Time Zones

The ABS and Optimizer define the following time periods for scheduling of activities:

- **Glued period.** A time period, starting from today, when no scheduling of activities is permitted. This period is required to prevent changes to schedules and assignments that are already sent to field service engineers. A glued period is not required; you can set it to 0.

- **Contract Scheduling period.** The period of time in days for scheduling immediately pending activities for a specific service region. Typically, this period covers days 2 to 8 (starting from the end of the Glued period to a week from today).

- **Optimizer horizon.** A period of time that includes the Contract Scheduling period. This is the time period within which the Optimizer operates.

- **ABS horizon.** The period of time in days for scheduling future activities extending from the end of the Optimizer horizon to some time in the future. The ABS horizon is the length of time that is available to book appointments for a service region. Typically, this is from days 8 to 56 (starting a week from now to eight weeks).

Both the ABS and the Optimizer horizons are represented by a single time line (Figure 2), because both are measured from a current time (that is, the time for loading data—see “About Loading and Reloading Service Region Data” on page 169).

Figure 2 shows an example of how these time periods are typically defined. The Glued period is day 1. The Contract Scheduling period is days 2 through 7. The Optimizer horizon, which spans the Contract Scheduling period, is days 2 through 7. The ABS horizon is days 8 through 21, and appointment booking is done for that period of time.

| Day | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | ... | 30 |
|-----|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|    |

![Figure 2. Scheduling Horizons](image)

Activities move from right to left along this time line. For example, a service activity may follow this scenario:
About Schedule Horizons and Time Zones

An appointment to perform an activity is booked into a time slot some time 8 to 15 days from now. The ABS assigns the activity to an employee during the ABS horizon.

As the days go by, the scheduled activity moves closer to today. On day 8, it moves from the ABS horizon to the Optimizer horizon. In the Optimizer horizon, the Optimizer evaluates the schedule and determines the best time and person to carry out the service activity while trying to minimize the costs of a schedule.

The activity remains in the Optimizer horizon for 6 days, where the Optimizer may adjust the schedule at regular intervals, at least once each day. This readjustment may be necessary because of changes in personnel, emergency service calls, or service activities that are regulated by contractual commitments (for example, a warranty repair required within 12 hours).

On day 1, the Glued period begins and the schedule for the activities in a service region is locked.

About Using Long-Range ABS Horizons

You do not need to use the ABS to schedule items that are far into the future, such as six months ahead. This question can arise particularly with companies that schedule preventive maintenance activities months ahead of time. Usually, the ABS is not required because the activities are automatically scheduled when they are loaded into the ABS as soon as they enter the ABS horizon.

For example, assume today is March 1st and the ABS horizon is 14 days. A preventive maintenance activity can be set for May 1st (Earliest Start/Latest Start is May 1st 9 A.M./May 1st 12P.M.). This activity will remain unscheduled until April 17th. When the ABS is reloaded that evening, it queries and finds the activity. Because the activity is unscheduled, the ABS attempts to schedule it automatically using the Earliest Start/Latest Start values.

The only case where you might want to use the ABS to schedule long-range appointments is when you anticipate being so close to capacity that you are concerned about overbooking.

**NOTE:** Longer horizons require more memory; also, note the 10,000 query limit on activities for each service region.

Schedule Time Zones

Siebel Field Service stores all times using the UTC (Universal Time Coordinate). To display the local time in the user interface, the application converts the UTC to the appropriate local time zone. Service Calendars use Universal Time Coordinate conversions. For more information, see the chapter on ongoing application administration tasks in *Siebel Applications Administration Guide*.

**CAUTION:** UTC is not the same as GMT (Greenwich Mean Time). UTC does not observe daylight savings time, whereas GMT observes daylight savings time.

Scheduling uses the following time zones:

- **The customer’s time zone.** Appointments are booked in the customer’s time zone, which is assumed to be the same as the service region’s time zone.

- **The service center’s time zone.**

- **The service region’s time zone.** Activities displayed in the Gantt chart on the Dispatch Board are in the service region’s time zone.
About Scheduling Heuristic Methods

Both the ABS and the Optimizer use heuristic methods to schedule appointments. These heuristic methods are specified as part of the parameter set configuration—see “Creating Parameter Sets for Scheduling” on page 127 for more information.

Heuristics for the Appointment Booking System

There are three possible heuristic methods that the ABS can use to schedule appointments:

- **Earliest First.** The earliest available time slots are included in the set. The ABS examines each person in the schedule to find the first open slots after the Earliest Start date. This method may provide the fastest possible response for the activity. Companies that are booking activities for the same day prefer this method because it maximizes the amount of work people are performing.

- **Resource Loading.** Time slots are selected so that the schedules for employees are filled to the extent possible, one employee at a time. If two or more qualified employees are available, the time slots for the employee with the most complete (filled-up) schedule are selected for inclusion in the set. This heuristic method is primarily used for scheduling partners or on-call resources where the company wants to use as few resources as possible to meet the service needs.
  
  **TIP:** The number of time slots returned in response to the request is configurable through the parameter ABS - Default Number of Slots.

- **Resource Leveling.** Time slots are selected so that the schedules for qualified employees are evenly loaded, to the extent possible. This heuristic method is useful in situations where companies have salaried field service engineers who should be used when on schedule.
  
  **NOTE:** Selecting this heuristic method does not mean that the time slots for all employees in the schedule will be displayed. Multiple slots from the same employee might be shown if that employee is more lightly loaded.

Heuristics for the Optimizer

The Optimizer provides a choice of methods for obtaining solutions for a service region’s schedule. Each of these methods involves a different strategy to improve the schedule. All methods use operations to move two or a few appointments and activities in a schedule and then verify improvements in the overall cost of the schedule. For example, the Optimizer may try to swap a pair of activities between two field service engineers. This can change the cost of the schedule by changing the cost of travel, the amount and cost of overtime, and the rate billed by the field service engineer. Any reduction in cost is an improvement in the schedule. For more information, see “Defining Cost Functions for the Optimizer” on page 134.
There are five different classes of operations for moving appointments and activities in a schedule. Each optimization method uses all of these scheduling heuristics.

There are two basic optimization methods, which can be used alone, and three methods that can be used in combination with the basic methods. The following basic methods consistently search for and accept only improvements (lower cost) in the schedule:

- **Greedy search.** This method starts with an existing schedule and finds the first move that improves the schedule, accepts the move, and then uses this solution to find the next improvement. A Greedy search repeats this process until there is no more improvement or it reaches a time limit. This method is relatively fast, but the result solution is not as good as other methods.

- **Steepest search.** This method starts with an existing schedule, tries all moves, accepts the move that provides the greatest improvement in the schedule, and then uses this solution to find the next improvement. A Steepest search repeats this process until there is no more improvement or it reaches a time limit. This method takes longer, but generally produces lower-cost schedules.

The following methods, combined with either the Greedy search or the Steepest search, allow moves that temporarily increase the cost of a schedule to arrive at significant, overall improvements in the schedule. In all cases, the Greedy search or the Steepest search quickly finds an improved schedule, and then one of the following methods takes over and searches for improvements:

- **Tabu search.** This method accepts the next best solution even if it is not an improvement over the previous schedule. It keeps a *tabu* list of finite length that contains the results of previous moves. The Optimizer cannot repeat a move until a move drops off the list.

- **Fast Guided Local search.** This method adjusts the cost of a solution to reflect the number of times the Optimizer tried a move. This allows the Optimizer to try a wider range of changes.

- **Fast Guided Tabu search.** This method combines the Tabu search and the Fast Guided Local search. It often finds good solutions faster than either the Tabu or Fast Guided Local searches.

### What Happens During Appointment Booking?

This section describes the business and technical process flows that are followed when a customer service representative tries to book an appointment. See "Booking Activity Appointments (End User)" on page 150 for information about how to book appointments.

#### Appointment Booking Business Process Flow

The following describes a typical customer service center business process.

1. A request for service arrives from a customer.
2. The customer service representative opens a service request and selects an activity plan to generate activities for this request.
3. The agent clicks the Book Appt button in the Service screen or the Activities screen to get a list of appointment choices for the selected activity.
4 The customer service representative, who sees these choices in a dialog box, selects a time slot and clicks Confirm.

If none of the time slots work for the customer, the customer service representative clicks Cancel.

Appointment Booking Technical Process Flow
The following describes what happens within the ABS when the business process in “Appointment Booking Business Process Flow” on page 101 takes place.

1 When the customer service representative clicks the Book Appt button, the ABS searches for available time slots using the Earliest Start field and Latest Start field (if a value is supplied) to limit the search.

2 If the earliest and latest start are not specified, the ABS chooses from all of the time slots within the ABS horizon.

The ABS returns time slots and reserves these with a timed lock.

**NOTE:** The ABS returns possible time slots for the Earliest Start Time only.

3 If the customer service representative confirms a time slot, the ABS marks the selected slot as permanently used. The ABS then frees the other reserved time slots, writes the details of the selected slot to the activity record, and returns control to the client.

If the customer service representative cancels the time slot, the ABS frees all of the time slots reserved for this activity and returns control to the client.

**NOTE:** If the representative does not cancel these time slots, the time-out releases the slots.

Guidelines for Setting Up Scheduling
Consider the following when setting up scheduling:

- **Business model.** What is your business model? What part does scheduling play? Which Siebel application modules are you using?

- **Service regions.** Plan service regions so that movement of service personnel between regions is the exception. Geographic areas that define service regions may overlap. In addition, service regions can have parent regions that effectively widen the primary service region when manually assigning activities using the Dispatch Board. Thus, resources can be shared across areas by setting up regional hierarchies. See “Defining Service Regions” on page 109 for more information.

- **Server mapping.** Set up servers and processors to distribute the scheduling tasks efficiently. See “Setting Up Server Key Mappings” on page 136 and “Setting Server Component Task Parameters” on page 139 for more information.

- **Employees.** Assign employees to service regions.

  **NOTE:** Employees can be assigned to only one service region. See “Loading Employee Data for Service Regions” on page 142 for more information.

- **ZIP or Postal Codes.** Load ZIP Code and geocode data. See “Defining Service Region Geographic Areas for the Optimizer” on page 113 for more information.
Guidelines for Setting Up Scheduling

- **Constraints.** Set up hard constraints for the ABS and both hard and soft constraints for the Optimizer. The ABS uses only hard constraints. The Optimizer can use either hard or soft constraints. See “Creating Constraint Sets for Scheduling” on page 122 for more information.

- **Cost functions.** The Optimizer calculates a cost function for each proposed schedule. This function is the sum of factors that drive the optimization of a schedule; for example, the cost of overtime, travel distance, and penalties for violating soft constraints. For more information, see “Defining Cost Functions for the Optimizer” on page 134.

### Rules Enforced by the Appointment Booking System

When preparing a list of possible time slots, the ABS enforces the following rules:

- The time slots offered must equal the availability of the personnel for a service region.
- The time slots offered must match the personnel who have the required skills. You can enforce this rule the Use Assignment Manager scheduling parameter.

  **NOTE:** Assignment Manager scores do not affect the order or ranking of the time slots returned. They only determine whether an employee is eligible to own a particular activity.

- Time slots must meet other constraints; for example, never have an engineer do more than four installations per day. Other limits on field service activities can meet business or union requirements.
- The ABS can have activities that extend over more than one day.
- Activities that cross between the end of the Optimizer horizon and the beginning of the ABS period are treated as locked by both of these engines.

### Guidelines for Integrating Scheduling with Wireless Updates

Schedules constantly change in a service region, because a service engineer calls in sick, a customer cancels an appointment, or a repair takes longer than scheduled. Service businesses must continuously change to accommodate unexpected occurrences.

Wireless communications allow service resources to respond flexibly to change. For example, an engineer calls in sick. Using a solution provided by the ABS or Optimizer, Field Service can send pages or Short Message Service (SMS) messages to cell phones (mobile phones) to reschedule appointments. SMS can send messages up to 160 characters and request confirmation of message delivery.

In another example, when time is available unexpectedly, break or fix activities can be slotted into those times. The critical step is to reach the engineer through a wireless device and obtain acceptance. The wireless device can also provide basic information about the customer and the problem, preparing the engineer to enter the customer site informed and to fix the problem without assistance from the service center.
If a job runs over the scheduled time, an engineer can use a wireless device to send a message to a dispatcher or customer service representative; the customer service representative can then proactively inform the customer of the process.

Guidelines for Integrating Scheduling with a Service Inventory System

Approximately 70 percent of all break/fix calls require a part. Because most break/fix calls occur during the day, service engineers may not have the parts in their trunk inventories or the time to pick up replacement parts from a local depot. One solution is to schedule a service engineer who has the parts already available. When choosing appropriate personnel, you can use this option as one of the constraints.

If the response can wait until the next day, another solution is to reschedule the service call and drop-ship the parts to the customer overnight. Tight integration with the inventory system (which must track down to the trunk level) is critical to any scheduling system. Part utilization is set up using parameters. See “Creating Parameter Sets for Scheduling” on page 127 for more information.

Guidelines for Integrating Preventive Maintenance with the Appointment Booking System

The optional Preventive Maintenance module lets users to set triggers on assets that, when tripped, automatically create service requests and activities for these assets. There are two types of triggers—time-based and threshold-based.

Threshold-based preventive maintenance depends on asset readings (such as the number of copies made on a copier) and is reactive (taking a reading results in creating a service request). The service requests that the Preventive Maintenance Engine creates usually require immediate, not future action. Immediate actions use the Siebel Contract Scheduling module. The ABS is involved only if the service call can be delayed more than a specified number of days. See “Running Contract Scheduling (End User)” on page 157 for more information.

Time-based preventive maintenance triggers, for legal or contractual reasons, require periodic, proactive checks on equipment. The Preventive Maintenance Engine generates service requests and future activities. One of the activities could be an outbound call from the dispatcher or customer service representative to schedule a time for service. When the customer service representative calls the customer, the representative can use the ABS to negotiate a time.

Guidelines for Optimizing Schedules

The Optimizer is appropriate for field service businesses that have a large number of engineers within a concentrated area. Generally, if over 30 percent of a service force is located in the top ten areas, then optimization is appropriate. However, businesses that have the following needs should consider optimization.
Centralized Dispatch Model
A centralized dispatch model, in which a team of dispatchers handles most dispatching for the full service business, is often driven by a follow-the-sun support. Customers can call twenty-four hours a day and are routed to an open call center somewhere in the world.

Customer support representatives need to assign engineers to a call even though they do not know the local requirements and rules. The Optimizer has constraints so that when central dispatchers submit the activity, it is optimized to be consistent with local priorities. Most activities can be scheduled automatically at a central location; any exceptions can be handled manually by a local service manager, eliminating the need for dedicated dispatch personnel.

Enforcing Contractual or Legal Constraints
Many companies must comply with strict limits on work hours and hazardous work. Union agreements may stipulate special conditions, such as fairness in work assignments. Having a system that can automatically track these constraints significantly decreases the burden on service businesses.

Working in High-Traffic Areas
The majority of wasted time in a service business is usually spent getting to customer sites. Many service businesses find that their employees are either spending too much time in the office or are on the road needlessly, driving back and forth between engagements.

By handling two calls in one area, traveling time is decreased significantly and performance is increased by over 10 percent. As service businesses move to a revenue base, a 10 percent increase in revenue can yield an even higher gain in profits.

Amount of Optimization
Is it possible for a schedule to be too optimized? A schedule with high utilization (little free time) is usually a good thing. However, past a certain point, further optimization may bring diminished cost savings. Furthermore, highly optimized schedules are easily corrupted; minor changes can cause problems to ripple throughout a schedule.

For example, consider a day’s schedule for one engineer who is booked from 9 A.M. to 5 P.M. with no free time. If just one appointment runs over, the engineer will not be able to complete all activities, leaving at least one (or more) to overtime or the next day. Plus, unexpected events such as a vehicle breakdown can completely disrupt this fully booked schedule.

The goal is to create a schedule that is optimized but still flexible enough to accommodate change. There are two ways to do this:

- Create constraints limiting the percentage of hours booked.
- Extend the duration of activities to leave extra time.

The first method is preferable as it allows managers to set up a dependable level of work. With the second method, managers are not sure of the true workload for their region.
The balance of working time and available time depends on the business needs. Businesses that require more flexibility (and therefore lower utilization percentages) have the some or all of the following business requirements:

- High break/fix volume
- Critical response (for example, a power line down)
- Highly variable times for service delivery
- Many short activities (especially in a high-traffic areas)
- Tight contractual requirements

Service businesses with a need for higher utilization usually have the following business requirements:

- Longer activities (and therefore less travel)
- Preventive maintenance as the main type of service
- Lower break/fix occurrences
- Longer contractual response time

When determining the best level of utilization, consider your service needs and then set an approximate level. Then, adjust the optimization parameters to give the best results.

**Process of Setting Up Scheduling**

The following list shows the procedures that administrators typically perform to set up scheduling within Siebel Field Service. Your company may follow a different process according to its business requirements.

To set up and maintain scheduling, perform the following tasks:

- Defining Schedule Hours on page 107
- Defining Service Regions on page 109
- Defining Employee Availability and Schedules on page 116
- Creating Time Windows for Scheduling on page 121
- Creating Constraint Sets for Scheduling on page 122
- Creating Parameter Sets for Scheduling on page 127
- Defining Cost Functions for the Optimizer on page 134
- Setting Up Server Key Mappings on page 136
- Setting Server Component Task Parameters on page 139
- Reloading the ABS and Optimizer Caches on page 140

See also “About Troubleshooting the Appointment Booking System and Optimizer” on page 159 for more information about checks that you should carry out after performing the setup configuration.
Defining Schedule Hours

This task is a step in “Process of Setting Up Scheduling” on page 106.

For each schedule, you set schedule hours that define the hours of availability. The schedule may also include a set of exceptions (in the Exception Name field), which are defined in the All Exceptions view and the Exception Hours view.

To enter the hours for a schedule, perform the following tasks:

- Define the hours during which employees can be scheduled for activities. See “Setting Hours of Availability” on page 107 for more information.
- Define the hours during which employees cannot be scheduled for activities. See “Setting Exception Hours” on page 108 for more information.

See also “About Schedule Horizons and Time Zones” on page 98 for more information about how Scheduler uses schedule periods and time zones.

Setting Hours of Availability

This task is a step in “Process of Setting Up Scheduling” on page 106.

For each schedule, you set schedule hours that define the hours of availability (days of week, hours per day, and holidays) for service-providing entities (employees, partners, or business units). Exception hours are specific days or hours in a schedule for working (for example, Saturday morning in a 12xM-F schedule) or not working (for example, a midweek holiday in a 12xM-F schedule).

To create a schedule and set schedule hours

1. Navigate to the Administration - Service screen > Schedules view.
2. Create a new record and complete the fields as appropriate.
3. Click the Schedule Hours view tab.
4 Create a new record and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Time</td>
<td>Indicates the end of a time period on the selected day.</td>
</tr>
<tr>
<td>Shift Start Flag</td>
<td>Indicates a time period that begins a work shift. Anything before the next flagged time period is considered to be in the same shift. This flag helps the Optimizer handle swing shifts that start on one day and finish on another. The Shift Start flag is required for each shift in the schedule. Usually, this means that you have one Shift Start flag per day, except for the last day of a swing shift. See “Rules for Defining Employee Schedules” on page 116 for more information about setting shift starts.</td>
</tr>
<tr>
<td>Start Day</td>
<td>A day of the week that is included in the schedule.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Start of a time period on the selected day.</td>
</tr>
<tr>
<td>Type</td>
<td>Can have a value of Normal, Overtime, or Extended Overtime. The Appointment Booking System and Optimizer both use this value.</td>
</tr>
</tbody>
</table>

The Schedule Hours view defines the days and time periods in each day that are included in a schedule. For example, an 8x5 schedule defines time periods within eight hours on five days—for example, 9 A.M. until 5 P.M. Monday through Friday. However, each day could have more than one record, each with a separate time period—for example, 9-12 A.M. Monday and 2-5 P.M. Monday.

**NOTE:** An Extended Overtime period must be preceded by an Overtime period.

5 Repeat Step 2 through Step 4 for each day of the week on which you want to provide support in this schedule.

**NOTE:** Schedule hour records can reflect different time periods on the same day of the week. However, only one of these records can contain the start of a shift.

### Setting Exception Hours

This task is a step in “Process of Setting Up Scheduling” on page 106.

Exceptions represent special nonworking days or working days. Different exception records may define exceptions for different sites—for example, U.S. holidays for one site and Canadian holidays for another. You can define a day or continuous blocks of days as an exception to a schedule. In some cases, exception hours can define working and nonworking periods—for example, no work on Sunday from 6 A.M. to 12 A.M. in a 7x12 schedule. For other schedules, exception hours can define work periods on days that are not normal work hours—for example, Saturday morning for a 5x8 schedule.

To associate an exception with a schedule, define the exception and include this exception in the definition of a schedule.
You can also use exception hours to block the scheduled time slot for the owner of an activity, in order to allow another employee to be assigned to the activity in the same time slot. For information about defining the exception hours for an employee, see “Defining Hours for Employees” on page 117. If the defined exception hours block a time slot in which an activity was scheduled for the employee, the activity is rescheduled when you reload the service region.

To add exceptions and exception hours to a schedule

1. Navigate to the Administration - Service screen > Schedules view.
2. Drill down on the Name field for a selected schedule and click the All Exceptions view tab.
3. Create a new record and complete the fields as appropriate.
   The All Exceptions view names a set of exceptions to the hours defined in the Schedule Hours view. The Exception Hours view contains the definition of these exceptions.
4. Click the Exception Hours view tab.
5. Create a new record and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>A range of calendar days or hours within a specific day that define the exception hours.</td>
</tr>
<tr>
<td>End Date</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Reason for the exception to the schedule. Values may include, for example, Appointment, Deadline, Sick Time, and Vacation.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of billing rate. Can have a value of Normal, Overtime, or Extended Overtime. Overtime and Extended Overtime apply to exception hours that are marked as Working. The Appointment Booking System and the Optimizer use this value. For more information, see “About the Appointment Booking System” on page 96 and &quot;About the Scheduling Optimizer” on page 96.</td>
</tr>
<tr>
<td>Working</td>
<td>Indicates that the record defines a work period.</td>
</tr>
</tbody>
</table>

NOTE: Extended Overtime hours must be preceded by Overtime hours.

Defining Service Regions

This task is a step in “Process of Setting Up Scheduling” on page 106.

From a service management perspective, a service region is a grouping of service engineers in a geographical area for a particular purpose, usually the support of a certain set of products. Service managers try to manage the load within a service region by balancing proactive calls (installations, preventive or scheduled maintenance) with reactive calls. Service regions ease administrative burdens by allowing service managers to set consistent schedules, constraints, and costs for a large number of employees.
From a systems perspective, a service region is a defined grouping of service engineers and the activities that they perform. This definition allows Siebel Scheduler to create a bounded solution set, which has a finite solution space, as well as a finite number of activities to schedule. One of the assumptions of a service region is that two employees with the same skill set are both capable of performing a job. If the system were to deal in employees alone, there would be little binding the employees together; the rules regarding interchangeability would be too vague to effectively determine.

Every employee and service region has a predefined schedule that includes the days and hours that work may take place (normal work hours), plus exceptions that deviate from normal work hours.

To define a service region, perform the following tasks:

1. Create a service region record. See "Creating Service Regions" on page 110.
2. Associate a schedule with the service region. See "Associating Schedules with Service Regions" on page 112 for more information.
3. Specify any regions that will function as parent service regions. See "Specifying Parent Service Regions" on page 112 for more information.
4. Define the geographic area of the service region. See "Defining Service Region Geographic Areas for the Optimizer" on page 113 for more information.

### About Service Region Caches

The information relating to each service region (for example, the employees assigned to the service region) is cached in memory. Instead of allowing the ABS and the Optimizer to operate directly on the database, the server copies data from the database into memory caches, one for the ABS and one for the Optimizer. The ABS cache holds the time slots in the future, and the Optimizer cache holds the activities occurring over the next few days. This approach allows scheduling to be performed quickly and efficiently, reducing traffic and database CPU load.

Each service region has its own cache, which allows the Scheduler processes to be serviced independently. Siebel Scheduler can be run on separate CPUs within one server or separate boxes as required. The ABS (like the Optimizer) is also multithreaded, which means that each service region can accept multiple requests at the same time.

See "Reloading the ABS and Optimizer Caches" on page 140 and "About Loading and Reloading Service Region Data" on page 169 for more information.

### Creating Service Regions

This task is a step in "Process of Setting Up Scheduling" on page 106.

A service region is a geographic area defined by ZIP Codes and a service team. The ABS and the Optimizer handle service regions and their associated data when scheduling activities.
To create a service region

1. Navigate to the Administration - Scheduling screen > Service Regions List view.

The Service Regions view defines service regions in terms of the employees assigned to each region, geographic coordinates (in terms of geocode and ZIP Codes or postal codes), and the operation of the ABS and Optimizer for the selected service region.

2. Create a new record and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Travel Speed Per Hour</td>
<td>The average travel speed for field service engineers in the service region, used when the Optimizer calculates costs. See “Defining Cost Functions for the Optimizer” on page 134 for more information.</td>
</tr>
<tr>
<td>Average Travel Time (Minutes)</td>
<td>The amount of travel time that the ABS adds to an activity when calculating the duration of an activity (work time + average travel time).</td>
</tr>
<tr>
<td>Constraint Set</td>
<td>The constraint set that the ABS and Optimizer use in optimizing the schedule for the selected service region, defined in the Administration - Scheduling screen &gt; Constraint Sets view and the Administration - Scheduling screen &gt; Constraints view.</td>
</tr>
<tr>
<td>Cost Function</td>
<td>The cost function that the Optimizer uses in optimizing the schedule for the selected service region. See &quot;Defining Cost Functions for the Optimizer&quot; on page 134 for more information.</td>
</tr>
<tr>
<td>Cost List</td>
<td>A cost list for labor, used for calculating overtime costs. Costs Lists are defined in the Administration - Pricing screen &gt; Cost List view. See the Siebel Pricing Administration Guide for more information.</td>
</tr>
<tr>
<td>Minimum Travel Time</td>
<td>If the calculated travel time between two activities is less than this time, the Optimizer uses this time.</td>
</tr>
<tr>
<td>Parent Region</td>
<td>Select an existing service region as the parent region for the current record. See “Specifying Parent Service Regions” on page 112 for more information.</td>
</tr>
<tr>
<td>Parameter Set</td>
<td>The set of parameters that the ABS and Optimizer use. See “Creating Parameter Sets for Scheduling” on page 127 for more information.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The name of a schedule that the ABS uses. See “Defining Schedule Hours” on page 107 for more information.</td>
</tr>
<tr>
<td>Time Window</td>
<td>The name of a set of time windows that the ABS uses. See ”Creating Time Windows for Scheduling” on page 121.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>The name of a time zone used by the ABS and Optimizer. Time zones are defined in the Administration - Data screen &gt; Time Zone Administration view. See the Siebel Applications Administration Guide for more information.</td>
</tr>
</tbody>
</table>
Setting Up and Using Scheduling

Defining Service Regions

Associating Schedules with Service Regions

This task is a step in “Process of Setting Up Scheduling” on page 106.

A service region can have only one schedule. Each service region is assigned a schedule that the ABS and Optimizer use. This may be different than the schedule associated with each employee. Schedules are defined in the Administration - Service screen > Schedules view. See “Defining Schedule Hours” on page 107 for more information.

The ABS uses the service region schedule as a base, and then refines its choices of time slots based on the employee schedules. See “Defining Employee Availability and Schedules” on page 116 for more information. The Optimizer uses the field service engineers’ schedules, not the service region schedule, when calculating the best deployment of personnel.

To associate a schedule with a service region

1. Navigate to the Administration - Scheduling screen > Service Regions List view.
2. Select a service region record and in the Schedule field, select a schedule.

Specifying Parent Service Regions

This task is a step in “Process of Setting Up Scheduling” on page 106.

A parent region can be set for any service region. Parent regions affect the list of available employees on the Dispatch Board screen (see “Searching for Activities in the Dispatch Board’s Gantt Chart (End User)” on page 196) but do not have any effect on how scheduling is carried out.

NOTE: Selecting a parent region does not impact scheduling with the ABS or the Optimizer.

To specify a parent service region

1. Navigate to the Administration - Scheduling screen > Service Regions List view.
2. Select a service region record and in the Parent Service Region field, select a service region.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel Cost</td>
<td>The cost of travel per unit of travel. The Optimizer uses this value when calculating the Cost Function for a schedule.</td>
</tr>
<tr>
<td>Travel Unit of Measure</td>
<td>The unit of travel (miles or KM) that the Optimizer uses when calculating the Cost Function for a schedule.</td>
</tr>
</tbody>
</table>
Defining Service Region Geographic Areas for the Optimizer

This task is a step in “Process of Setting Up Scheduling” on page 106.

The geographic area of a service region is defined by ZIP Codes and geocodes. The Optimizer uses geocode data and ZIP Codes (or postal codes for international users) to identify addresses.

ZIP Codes are not used by the ABS directly—they are only used to default the service region to an activity. However, ZIP Codes are critical to Optimizer, as they, along with country codes, are used to lookup the underlying geocodes (latitude and longitude). These geocodes are in turn used to calculate the distance from activity to activity. If an activity is missing zip or country code, it is not loaded into the cache, as it cannot be calculated as part of a solution.

The Optimizer follows these rules for ZIP Codes:

- A service region can include more than one ZIP Code.
  
  **CAUTION:** It is recommended that no more than 150 ZIP Codes be used for each service region, particularly if your company is using optimization. This is because optimization routines store the solutions in memory for speed; past iterations are stored to prevent the same solutions from being examined again. If your service regions are going to exceed 150 ZIP Codes, you must test performance and scalability carefully. Very large service regions can cause the process memory to grow extremely large, sometimes reaching the limit inherent in Microsoft Windows. In such cases, consider using UNIX.

- More than one service region can include the same ZIP Code; this means that service regions can have geographic overlap.

  **NOTE:** Automatic assigning to a service region by ZIP Code is performed using a workflow.

Geocode data contains longitude and latitude coordinates for physical locations (for example, a customer site), down to minutes and seconds. The Optimizer can use data at any level of detail; for example, ZIP Codes or ZIP + 4 codes.

As a ZIP Code can cover several square miles, it is preferable to use ZIP + 4, which generally brings the accuracy to the level of buildings for businesses or to within a block or two for residential addresses.
The Optimizer requires, at minimum, ZIP or Postal Codes, country, longitude, and latitude. Five-digit ZIP Codes for the United States are shipped with your Siebel application’s seed data. ZIP Code information resides in the data model table (S_ZIPCODE). Table 27 shows the six columns in this table.

Table 27.  S_ZIPCODE Data Model Table

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZIP Code</td>
<td>Postal ZIP Code in alphanumeric text</td>
</tr>
<tr>
<td>City</td>
<td>Name of the city</td>
</tr>
<tr>
<td>State</td>
<td>Name of the state or province</td>
</tr>
<tr>
<td>Country</td>
<td>Name of the country</td>
</tr>
<tr>
<td>Longitude</td>
<td>Longitude number (0 to +/- 180, + for the eastern hemisphere and – for the western hemisphere) up to six decimal places</td>
</tr>
<tr>
<td>Latitude</td>
<td>Latitude number (0 to +/- 90, + for the northern hemisphere and – for the southern hemisphere) up to six decimal places</td>
</tr>
</tbody>
</table>

**NOTE:** Where longitude and latitude values are the same for two locations, the Optimizer uses the Minimum Travel Time. For more information about this field, see “Creating Service Regions” on page 110.

There are two ways to load data into the S_ZIPCODE table:

- Use the Siebel Enterprise Integration Manager. For more information, see *Siebel Enterprise Integration Manager Administration Guide*.
- Import data from the Administration - Data screen > ZIP Code Administration view.

**To add ZIP Codes for a service region**

1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. Select a service region record and drill down on the Name field hyperlink.
3. Click the Zip Codes view tab.
   - The Zip Codes view lists the ZIP Codes or Postal Codes that are included in a service region, plus city, state, country, longitude, and latitude for each ZIP Code.
   - For the Optimizer to schedule an activity, the address of the activity must have valid ZIP Codes and country specified. ZIP Codes must have the corresponding Geocodes specified. The Zip Code value can be a ZIP Code or a ZIP + 4 code.
4. Create a new record and complete the fields as appropriate.

**To import geocode data**

1. Navigate to the Administration - Data screen > ZIP Code Administration view.
2 Click the menu button and select Import from the drop-down list. The Import wizard appears.

3 Specify the filename containing the data to import and click Next.

4 Complete the information, including field mapping for the data records.

**Specifications for Geocode Data**
There are several vendors of geocode information. Be sure to specify the following information in geocode data:

- **Latitude format.** North of the equator is positive; south of the equator is negative. The data is interpreted to six decimal places.
- **Longitude format.** East of the prime meridian (Greenwich, UK) is positive; west of the prime meridian is negative. The data is interpreted to six decimal places.

The Siebel application stores its latitude and longitude in the decimal degrees format because this format is the most widely used and is easy to use for distance calculations, as shown in the following example.

<table>
<thead>
<tr>
<th></th>
<th>Decimal Degrees</th>
<th>Deg:Min:Sec</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latitude</td>
<td>37.830354</td>
<td>37:49:49.274N</td>
</tr>
<tr>
<td>Longitude</td>
<td>–122.284076</td>
<td>122:17:2.674W</td>
</tr>
</tbody>
</table>

Most data sets are in decimal degrees; if not, use the following formula to convert it from the degrees, minutes, seconds to decimal degrees:

Decimal degrees = Degrees + (Minutes/60) + (Seconds/3600)

Example:

37 Degrees, 25 Minutes, 40.5 Seconds

= 37. + (25/60) + (40.5/3600)

= 37. +.416666 +.01125

= 37.427916 degrees

**Data Cleansing**
Address and ZIP Code accuracy are critical for a schedule optimization. It is highly recommended that you use a data cleansing application, such as the Siebel Data Quality module. For more information, see *Siebel Data Quality Administration Guide*. 
**About Using ZIP Codes in Multiple Service Regions**

The Activity business object code associates an activity with a service region, based on the ZIP code. You may need to override this behavior by inserting your own logic if ZIP Codes are being used with more than one service region.

In general, it is recommended that you keep one service region for each ZIP Code, using skills on the employees to differentiate between products. The service manager can then simply redistribute employees by changing their skills and reloading the skills into Assignment Manager. If you use separate regions, employees must be unloaded from one service region and into another.

**NOTE:** More service regions mean a higher load time.

Service regions are not validated against the ZIP Code by Scheduler once it has been set on the activity. This allows activities to be moved to other service regions as required—for example, to cover additional activities caused by a marketing campaign in that service region. The ZIP Code should always be validated up front, preferably when the record is created.

**CAUTION:** Field Service assigns a service activity to a service region according to the ZIP Code of its account’s address. However, if a ZIP Code is in more than one service region, a service request is not automatically assigned to a service region and a customer service agent must manually select a service region for it.

---

**Defining Employee Availability and Schedules**

This task is a step in “Process of Setting Up Scheduling” on page 106.

Employee schedules (available and unavailable hours) are controlled by the Schedule field in the Administration - User screen > Employees > Service Details view and the exception records in the Administration - User screen > Employees > Employee Exception Hours view. The definition of the schedules that appear in the Schedule field are set in the Administration - Service screen > Schedules view.

The ABS uses the service region schedule as a base, and then refines its choices of time slots based on the employee schedules. See “Defining Schedule Hours” on page 107 for more information. The Optimizer uses the employee schedules only.

To define employee availability and schedules, perform the following tasks:

- **Defining Hours for Employees on page 117**
- **Adding Employee Schedule Information on page 118**
- **Specifying Employees as Unavailable on page 121**

**Rules for Defining Employee Schedules**

When setting schedules for field service engineers, you must follow these rules:

- A schedule must have only one shift start per day.
  
  To set up multiple shift start times, use multiple schedules, each for a separate shift.
The Shift Start flag should be set on the first time period in a day (the exception being when a shift extends over two days).

If a shift spans more than one day (for example, Monday 9–11:59 P.M. and Tuesday 12–4 A.M.) the first day should include the start of the shift.

The ABS, but not the Optimizer, can have activities that span more than one day.

It is recommended that no more than 150 employees be used for each service region, particularly if your company is using optimization.

You can schedule one or more breaks in a day.

The ABS does not consider overtime for a field service engineer.

The Optimizer can schedule activities in overtime and extended overtime.

**CAUTION:** Do not define breaks during overtime. The Optimizer ignores breaks that are scheduled during overtime and treats them as working time. This introduces inaccuracies into cost calculations.

### Defining Hours for Employees

This task is a step in “Process of Setting Up Scheduling” on page 106.

Perform the following procedures to associate a schedule with an employee and define exception hours for employees.

#### To associate a schedule with an employee

1. Navigate to the Administration - User screen > Employees view.
2. Drill down on the Last Name field for a selected employee and click the More Info view tab.
3. In the Schedule field, select a schedule.

#### To define exception hours for an employee

1. Navigate to the Administration - User screen > Employees view.
2. Drill down on the Last Name field for a selected employee and click the Employee Exception Hours view tab.
3. Create a new record and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Time at which the employee starts being unavailable for scheduling.</td>
</tr>
<tr>
<td>End</td>
<td>Time at which the employee's exception hours end and the employee is once more available for scheduling.</td>
</tr>
</tbody>
</table>
Adding Employee Schedule Information

The following must be taken into account when defining employee schedules:

- **Shifts.** See “Shifts” on page 118 for more information.
- **Skills.** See “Skills” on page 119 for more information.
- **Role priorities.** See “Role Priorities” on page 119 for more information.
- **Breaks.** See “Breaks” on page 119 for more information.
- **Travel.** See “Travel” on page 121 for more information.

See “Creating Constraint Sets for Scheduling” on page 122 for more information about constraints that can be set up to limit employee working hours, types of activities that can be performed, and so on.

### Shifts

One employee can have only one shift per day, which can include rate types of normal time (RT), overtime (OT), and extended overtime (EOT), as defined for each employee. A shift must use rate types in the following order:

1. **EOT**
2. **OT**
3. **RT**
4. **OT**
5. **EOT**

Any of these rate types can be missing from the definition of a shift, but the remaining types must be in this order. For example:

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working</td>
<td>Select this check box to indicate whether the hours specified are for a working or non-working exception. For example, you specify a Saturday morning exception for an employee who normally only works Monday to Friday. You then select the Working check box. This indicates that the service engineer is working for those additional hours and can be scheduled for activities during these hours. However, if you specify exceptions hours for a midweek holiday for the same employee and do not select the check box, this indicates to Scheduler that the employee is not working that particular day and cannot be scheduled for activities.</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason for which exception hours are being defined for the employee. For example, the employee may be on vacation or taking sick leave.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the appropriate rate type for the shift. This can be normal, overtime, or extended overtime. See “Shifts” on page 118 for more information.</td>
</tr>
</tbody>
</table>
Setting Up and Using Scheduling  ■ Defining Employee Availability and Schedules

6 OT
7 RT
8 OT

The rates for overtime and extended overtime are configured in the Administration - Pricing screen > Cost List > Cost List Line Items view as a percentage increase over regular time (Standard Cost). Standard Cost is set in the Administration - User screen > Employees > Service Details view.

Skills
Siebel Scheduler is capable of performing skill-based routing (that is, assigning only people with a particular skill set to a job). The engines use Assignment Manager to evaluate skills and return a list of appropriate employees, as follows:

1 Each activity is submitted to Assignment Manager.
2 Assignment Manager returns the appropriate people based on assignment rules.
3 The Optimizer uses only these people when it tries to schedule that job.

For more information about how to set up skills and evaluation rules, see Siebel Assignment Manager Administration Guide.

Role Priorities
For the purpose of assigning field service engineers to activities, administrators can add a role priority to each field service engineer who is a member of the asset service team. When Assignment Manager schedules field service engineers, it considers the role priority of the associated engineers. For example, Assignment Manager first tries to assign the primary engineer. If the primary engineer is not available, it tries to assign the secondary engineer and so on. The role priority for a field service engineer can be either primary, secondary, or tertiary.

NOTE: Employees can also be associated with an account to form an account service team. These team members can then have role priorities assigned to them. See “Account Service Team Configuration” on page 474 for more information.

Breaks
Schedules can include any number of breaks. Breaks are defined as employee breaks or activity breaks:

■ Employee breaks are defined in the employee’s schedule or as exceptions to this schedule.
■ Activity breaks are defined in Activities > Time Tracker as time periods with the Type field set to Break.

The following rules apply to the way the Optimizer uses breaks:

■ Breaks can have their start time = Start Time +1 second. This means that a break from 12 to 1 P.M. is the same as a break from 12:00:01 to 1:00:01.
Break times during OT or EOT are paid.

**NOTE:** Because breaks during overtime are considered paid time, it is recommended that you do not define breaks during overtime. Calculating these breaks may slow the Optimizer’s calculations.

Breaks can be allowed during activities or excluded from specific activities.

See "About the Breakable Flag" on page 120 for more information.

### To define different break types
1. Navigate to the Administration - Data screen > Work Types view.
2. Create a new record and complete the fields as appropriate.

### To set the name of the break type
1. Navigate to the Administration - Application screen > System Preferences view.
2. Query for the system preference Sch:Break Time Id.
3. In the System Preference Value field, enter the row ID for the break.

### To record break time
1. Navigate to the Activities screen > Activity List view.
2. Drill down on the Type field for a selected activity and click the Time Tracker view tab.
3. Create a new record and complete the fields as appropriate.

See “Time Tracker View” on page 86 for more information.

### About the Breakable Flag
The Breakable flag indicates that it is acceptable for an activity to stop and resume. For example, if a schedule is 9 A.M. to 1 P.M. and 2 P.M. to 6 P.M., the appointments need to be six hours long to accommodate the length of the activities. In this case, appointments could never be scheduled without the Breakable flag as there are no contiguous six-hour time slots available.

This flag is optional because there are some circumstances where the activity should be allowed to break—for example, turning the water or the power off during a weekend. The ability for activities to be breakable is why the activity duration is separate from the activity work time.

**NOTE:** The ABS is not designed to handle activities longer than a day. However, it does support breakable activities.

### To allow breaks for activities
1. Navigate to the Administration - Data screen > Activity Templates > Service Details view.
2 Select the Breakable check box.

If this flag is not set, a break is not allowed during an activity.

**NOTE:** Users can set breaks for a selected activity by selecting the Allow Breaks check box in the Activities screen > Schedule view. See “Schedule View” on page 85 for more information.

**Travel**

The Optimizer uses employee travel conditions and travel time when obtaining the lowest-cost solution for a schedule. These values are set in the Administration - User screen > Employees > Service Details view. The fields Start Shift From and End Shift At define the starting and ending conditions for travel to and from service calls. These are the possible values of these fields:

- **Home (Travel incl.)**. The employee travels from home directly to the first job. The Optimizer includes the cost of this travel when calculating schedules.
- **Home (Travel Not incl.)**. The employee travels from home directly to the first job. The cost of travel is not included.
- **Depot**. The employee starts each day by going to a service depot or office. Travel costs are tracked starting from the depot.

**Specifying Employees as Unavailable**

This task is a step in “Process of Setting Up Scheduling” on page 106.

Use the Unavailable button to instruct the Optimizer that the selected employee is unavailable for a particular period. For example, the employee’s vehicle may have broken down. Clicking this button sends an asynchronous request to the Optimizer to load the data for the selected employee, including exception hours, and reassigns or reschedules activities.

**To specify employees as unavailable**

1 Navigate to the Administration - Scheduling screen > Service Region List view.
2 Select a service region record and drill down on the Name field hyperlink.
3 Click the Employees view tab.
4 Select an employee record and click Unavailable.

**TIP:** Before using the Unavailable button, you may have to add a new record to the Administration - User screen > Employees > Employee Exception Hours view, describing the time for which the selected engineer is unavailable. If you do not have at least one exception hour defined for the employee, the Optimizer displays an error message. See “Defining Hours for Employees” on page 117 for more information.

**Creating Time Windows for Scheduling**

This task is a step in “Process of Setting Up Scheduling” on page 106.
Time windows are used to define the interval of time that should be allocated for starting an activity. The ABS uses time windows. Time windows are associated with a service region in the Administration - Scheduling screen > Service Region List view. See “Defining Service Regions” on page 109 for more information.

**To define time windows**

1. Navigate to the Administration - Scheduling screen > Time Window List view.
2. Create a new record and complete the fields as appropriate.
   
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the set of time window mappings.</td>
</tr>
<tr>
<td>Default Time Window</td>
<td>The time window applied to activities of any duration, if the Time Windows Details view does not have a mapping for an activity of a specific duration.</td>
</tr>
</tbody>
</table>

3. Scroll down to the Time Window Details list and create a new record for each activity duration range.

   The Time Windows Details view defines specific mappings that make up each time window record. To accommodate activities that vary in duration, this view maps each range of durations to a time window. For example, a work time of 1 to 60 minutes may require a time window of 120 minutes to provide Optimizer with the flexibility to change the schedule for optimization.

**To view the service regions associated with a time window**

1. Navigate to the Administration - Scheduling screen > Time Window List view.
2. Select a record in the Time Windows list.
3. Click the Service Regions view tab.

   The Service Regions view contains read-only records listing the service regions that use a selected time window.

**Creating Constraint Sets for Scheduling**

This task is a step in “Process of Setting Up Scheduling” on page 106.

Service businesses have a number of union, legal, or business constraints under which they must operate. “Examples of Constraints” lists a few examples of constraints. These constraints can be described as hard or soft, depending on whether or not they can be violated to meet scheduling requirements. The ABS uses only hard constraints while the Optimizer uses both hard and soft constraints.
■ **Hard constraints.** The ABS and Optimizer cannot violate hard constraints. Activities that do not fit these constraints are not scheduled. As a result, the engines are faster in finding solutions, but fewer solutions are obtained. The solutions result in higher costs for service.

■ **Soft constraints.** The Optimizer can weight the cost of using or violating a soft constraint when calculating solutions for a schedule. Soft constraints result in longer optimization times (lower performance of the Optimizer), more solutions, and lower costs for service. Violating soft constraints may result in a more costly schedule.

Schedules that violate hard constraints are discarded even though they may be better than other solutions. The Optimizer may use solutions that violate soft constraints, but it assigns a penalty to these violations that could make one solution less favorable than another solution. The cost function calculated for each solution includes the penalties for violating soft constraints. For more information, see “Defining Cost Functions for the Optimizer” on page 134.

To create constraint sets, perform the following tasks:

■ Defining Constraints on page 126
■ Defining Constraint Sets on page 126

### Examples of Constraints
The following constraints limit work hours:

■ Union contracts stipulate that no worker does more than ten hours of overtime in a week.
■ Laws regulating worker safety restrict employees from working more than twelve hours a day.
■ To keep costs down, management specifies that no service manager should authorize more than forty hours of overtime per week for all of their employees.
■ An engineer cannot work more than 45 hours per week.
■ An engineer cannot engage in an activity type (for example, working with hazardous materials) more than four hours per day.
■ Total workload must be less than 95 percent.
■ Total workload must be greater than 60 percent.
■ An engineer cannot travel more than four hours a day, for safety reasons.

The following constraint limits timing of an activity: All waste disposal activities must start before 8 P.M.
Predefined Constraints
Constraints fall into the categories shown in Table 28.

Table 28. Constraints for the ABS and Optimizer

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appointment Booking Activity Time</td>
<td>Limits the time of day an activity of a specified type or priority can start or end.</td>
</tr>
<tr>
<td>Appointment Booking FSE Limit</td>
<td>Limits the number of activities of any type or of a specified type, or time spent on activities by any employee or a specific employee. Or, limits the number of activities or time spent on activities that have a specified service role (for example, Installation or Preventive Maintenance).</td>
</tr>
<tr>
<td>Appointment Booking Schedule Activity Type</td>
<td>Limits the number of activities of any type, or time spent on activities of a specified type for a whole schedule.</td>
</tr>
<tr>
<td>Optimizer Activity Time Hard</td>
<td>Limits when an activity of a specified type or priority must begin or end. This is a hard constraint.</td>
</tr>
<tr>
<td>Optimizer Activity Time Soft</td>
<td>Limits when an activity of a specified type or priority may begin or end. Also, specifies the penalty for violating this soft constraint.</td>
</tr>
<tr>
<td>Optimizer FSE Limit Hard</td>
<td>Limits the following values for any employee or a specific employee during a specified period:</td>
</tr>
<tr>
<td>- % workload</td>
<td></td>
</tr>
<tr>
<td>- Number of activities of any type or of a specified type</td>
<td></td>
</tr>
<tr>
<td>- Total hours of travel time</td>
<td></td>
</tr>
<tr>
<td>- Total work hours</td>
<td></td>
</tr>
<tr>
<td>This is a hard constraint.</td>
<td></td>
</tr>
<tr>
<td>Optimizer FSE Limit Soft</td>
<td>Limits the following values for any employee, a specific employee, or a specified service role (for example, Installation or Preventive Maintenance) during a specified period:</td>
</tr>
<tr>
<td>- % workload</td>
<td></td>
</tr>
<tr>
<td>- Number of activities of any type or of a specified type</td>
<td></td>
</tr>
<tr>
<td>- Total hours of overtime</td>
<td></td>
</tr>
<tr>
<td>- Total hours of travel time</td>
<td></td>
</tr>
<tr>
<td>- Total work hours</td>
<td></td>
</tr>
<tr>
<td>Also, specifies the penalty for violating this soft constraint.</td>
<td></td>
</tr>
</tbody>
</table>
### Setting Up and Using Scheduling

#### Creating Constraint Sets for Scheduling

**Optimizer Fairness**
Ensures the equal distribution of the following values for workload, specified as a percentage, for all employees or for a specified service role (for example, Installation or Preventive Maintenance):
- Number of activities of any type or of a specified type
- Total hours of overtime
- Total hours of travel time
- Total work hours
Also, specifies the penalty for violating this soft constraint.

**NOTE:** Optimizer Fairness is called a leeway constraint because it is based on a percentage rather than an absolute value. As this is an approximate number, it allows the Optimizer to achieve acceptable schedule assignments within acceptable times.

**Optimizer Schedule Activity Type Hard**
Limits the following values for a whole schedule in a specified period:
- Hours of work time for activities of a certain type
- Number of activities of a certain type
- Percentage count of activities of a certain type\(^1\)
- Percentage hours for activities of a certain type\(^1\)
This is a hard constraint.

**Optimizer Schedule Activity Type Soft**
Limits the following values for a whole schedule:
- Hours of work time for activities of a certain type
- Number of activities of a certain type
- Percentage count of activities of a certain type
- Percentage hours for activities of a certain type
Also, specifies the penalty for violating this soft constraint.

**Optimizer Schedule Overtime Soft**
Limits the hours of overtime in a specified period for a whole schedule.
Also, specifies the penalty for violating this soft constraint.

**Optimizer Travel Time**
Limits the travel time between activities for all employees, specific employees, or a specified service role (for example, Installation or Preventive Maintenance).
This can be a hard or soft constraint.

### Table 28. Constraints for the ABS and Optimizer

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimizer Fairness</td>
<td>Ensures the equal distribution of the following values for workload, specified as a percentage, for all employees or for a specified service role:</td>
</tr>
<tr>
<td></td>
<td>- Number of activities of any type or of a specified type</td>
</tr>
<tr>
<td></td>
<td>- Total hours of overtime</td>
</tr>
<tr>
<td></td>
<td>- Total hours of travel time</td>
</tr>
<tr>
<td></td>
<td>- Total work hours</td>
</tr>
<tr>
<td></td>
<td>Also, specifies the penalty for violating this soft constraint.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Optimizer Fairness is called a leeway constraint because it is based on a percentage rather than an absolute value. As this is an approximate number, it allows the Optimizer to achieve acceptable schedule assignments within acceptable times.</td>
</tr>
<tr>
<td>Optimizer Schedule Activity Type Hard</td>
<td>Limits the following values for a whole schedule in a specified period:</td>
</tr>
<tr>
<td></td>
<td>- Hours of work time for activities of a certain type</td>
</tr>
<tr>
<td></td>
<td>- Number of activities of a certain type</td>
</tr>
<tr>
<td></td>
<td>- Percentage count of activities of a certain type(^1)</td>
</tr>
<tr>
<td></td>
<td>- Percentage hours for activities of a certain type(^1)</td>
</tr>
<tr>
<td></td>
<td>This is a hard constraint.</td>
</tr>
<tr>
<td>Optimizer Schedule Activity Type Soft</td>
<td>Limits the following values for a whole schedule:</td>
</tr>
<tr>
<td></td>
<td>- Hours of work time for activities of a certain type</td>
</tr>
<tr>
<td></td>
<td>- Number of activities of a certain type</td>
</tr>
<tr>
<td></td>
<td>- Percentage count of activities of a certain type</td>
</tr>
<tr>
<td></td>
<td>- Percentage hours for activities of a certain type</td>
</tr>
<tr>
<td></td>
<td>Also, specifies the penalty for violating this soft constraint.</td>
</tr>
<tr>
<td>Optimizer Schedule Overtime Soft</td>
<td>Limits the hours of overtime in a specified period for a whole schedule.</td>
</tr>
<tr>
<td></td>
<td>Also, specifies the penalty for violating this soft constraint.</td>
</tr>
<tr>
<td>Optimizer Travel Time</td>
<td>Limits the travel time between activities for all employees, specific employees, or a specified service role (for example, Installation or Preventive Maintenance).</td>
</tr>
<tr>
<td></td>
<td>This can be a hard or soft constraint.</td>
</tr>
</tbody>
</table>
Defining Constraints

This task is a step in “Process of Setting Up Scheduling” on page 106.

Constraints are created using the Constraint Wizard, which walks you through this process step-by-step. You choose a constraint template and then either select or fill in the appropriate values.

**CAUTION:** Do not define contradictory constraints. For example, the following two constraints conflict if both are hard constraints and the duration for the activities is less than two hours:

- A field service engineer must work a minimum of four hours per day.
- A field service engineer can have no more than two activities per day.

If both are hard constraints, the Optimizer cannot find a solution and fails to schedule these activities.

Be sure to test new constraints before releasing them into a production environment; leaving them as soft constraints may help to avoid problems. However, too many soft constraints hamper performance, so there must be a balance.

**To create constraints**

1. Navigate to the Administration - Scheduling screen > Constraints view.
2. Create a new record and follow the Constraint Wizard steps.
   - See "Predefined Constraints" on page 124 for more information about the constraints from which you can choose.
3. When the constraint is complete, click Save.
   - The Save a Constraint dialog box appears.
4. Enter a name for the constraint and click Save.
   - The Constraints list reappears. You can now define constraint sets that can be associated with a service region. See “Defining Constraint Sets” for more information.

Defining Constraint Sets

This task is a step in “Process of Setting Up Scheduling” on page 106.

Constraint sets provide the basic definition of a predefined set of constraints that a service region uses for running the Optimizer. A constraint set is associated with a constraint set in the Administration - Scheduling > Service Region List view. See “Creating Service Regions” on page 110 for more information.

**To define constraint sets**

1. Navigate to the Administration - Scheduling screen > Constraint Sets view.
2 Create a new record and complete the field as appropriate.
3 Scroll down to the Constraints list.
4 Create a new record, selecting a predefined constraint from the Add Constraint dialog box that appears.
5 Enter a start and end date for the constraint if applicable.

**To view the service regions associated with a constraint set**
1 Navigate to the Administration - Scheduling screen > Constraints Sets view.
2 Select a record in the Constraint Sets list.
3 Click the Service Regions view tab.
   The Service Regions view contains read-only records listing the service regions that use a constraint set.

**Creating Parameter Sets for Scheduling**

This task is a step in “Process of Setting Up Scheduling” on page 106.

Parameter sets hold key information that determines how the ABS and Optimizer operate. Parameter sets are associated with service regions in the Administration - Scheduling screen > Service Region List view. See “Defining Service Regions” on page 109 for more information. Each service region uses one parameter set.

If the scheduling server starts without Optimizer or ABS parameters (see Table 29), the service region is not loaded for the Optimizer or the ABS, respectively. The log files (ApptBook_xxx.log and Optimizer_xxx.log in the log directory on the Siebel Server) specify which parameters are missing.

**NOTE:** If a service region fails to load, you must restart the ABS or Optimizer. This does not require rebooting the computer.
**Schedule Parameters**

Table 29 lists the various scheduling parameters that can be used to specify a parameter set.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month Start Date</td>
<td></td>
<td>Number, 1–28</td>
<td>Determines what day the month starts on. Used for constraints that are defined in terms of months. Most users will set this to 1. The default value is 1.</td>
</tr>
<tr>
<td>Use Assignment Manager</td>
<td></td>
<td>1/0</td>
<td>Whether to submit the activity to Siebel Assignment Manager to receive a list of engineers capable of performing this work. This should be set to 1 to use the AM, unless all employees in a service region have the same skills or all are eligible to do all the jobs. The default value is 1.</td>
</tr>
<tr>
<td>Week Start Day</td>
<td></td>
<td>Number, 1–7</td>
<td>Determines what day the week starts on. Used for constraints that are defined in terms of weeks. Most users will set this to 1 (Sunday) or 2 (Monday). The default value is 1.</td>
</tr>
</tbody>
</table>
| ABS – Activity Category    |           | Order number for the Activity Category LOV. | When loading in activities into the ABS, only those with the specified category will be loaded. The default value is all categories. For example, to only load activities with a category of Repair Activity, do the following in the order shown:  
  - Navigate to the Administration - Application screen > List of Values view.  
  - Query for the LOV type, FS_ACTIVITY_CLASS.  
  - Record the order number for the category you want to exclude (that is, Repair Activity).  
  - Navigate to the Administration - Scheduling screen > Parameter Sets view.  
  - Select the parameter set for the specified Service Region and add the Variable value, ABS - Activity Category. This value is taken from the Order field of the Repair Activity LOV. The value can be comma-separated if there is more than one category listed. As a result, the ABS only loads activities with the category Repair Activity and ignores activities with other categories. |
### Setting Up and Using Scheduling

- **Creating Parameter Sets for Scheduling**

---

#### Table 29. Scheduling Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| ABS – Activity Status         |           | Order number for the Activity Status LOV. | When loading activities into the ABS, those with the specified status are excluded. Recommended default: Cancelled. For example, to exclude activities with a Cancelled status, do the following in the order shown:  
  - Find the order number of activities with a Cancelled status (the LOV type is EVENT_STATUS).  
  - Add the parameter, ABS - Activity Status. This value is taken from the Order field of Cancelled Status LOV. The value can be comma separated if there is more than one status listed. As a result, the ABS does not load activities with a Cancelled status. |
| ABS – Days to End             | Yes       | Number | When starting the ABS process, specifies how many days out the ABS should be booking appointments. It is always measured in number of days (not an absolute date) showing how far the schedule runs. Required for ABS. |
| ABS – Days to Start           | Yes       | Number | When starting the ABS process, this number specifies how many days out the ABS should start booking appointments. It is always measured in number of days, not an absolute date. Required for ABS.  
  This parameter activates at 12 A.M., which means that if ABS - Days to Start is set to 1, the ABS starts booking appointments from midnight after the region was loaded (subject to the schedule used).  
  **NOTE:** Activities that start in the past but end after the ABS - Days to Start value are still loaded to the ABS. |
| ABS – Default Number of Slots|           | Number | Specifies how many choices (maximum number of appointment slots) are returned to the user. A higher number of slots gives more flexibility, but may slow the ABS, as it takes longer to search for more slots. The default value is 5. |
### Setting Up and Using Scheduling

#### Creating Parameter Sets for Scheduling

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| ABS – Logging Level               |           | Number, 1–4                  | Controls how much information is written to the ABS log stored on the server (ApptBook_xxx.log). The lowest level, 1, writes only basic information about the server activities, while the highest level, 4, writes detailed logs, showing all actions that occurred.  
**NOTE:** You must set the Appointment Booking and Optimization Execution event for the ApptBook component to 4 to generate log files when the ABS is loaded. |
| ABS – Range of Heuristic          |           | Number, 1–3                  | Determines the time range that the selection heuristic uses:  
1 – day  
2 – week  
3 – month |
| ABS – Selection Heuristic         |           |                              | Determines the logic used when finding time slots:  
1 – Earliest First method.  
2 – Resource Loading method.  
3 – Resource Leveling method.  
See “Heuristics for the Appointment Booking System” on page 100 for more information about these methods. |
| ABS – Timeout                     |           | Number (minutes)             | Sets how long time slots are locked (in minutes) after the user requests them, but has not chosen one. After this time, the slots are released and made available for booking by other users. This is important if the user closes the browser or loses a connection, so that the slots are again available.  
**CAUTION:** Do not set this parameter to zero (0). |
| Optimizer – Activity Category     | Yes       | Sequence number for the Activity Category LOV. | When loading in activities into the Optimizer, only those with the specified category will be loaded. The default value is all categories. |
### Table 29. Scheduling Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimizer – Activity Status</td>
<td></td>
<td>Sequence number for the Activity Status LOV.</td>
<td>When loading in activities into the Optimizer, those with the specified status are excluded. Recommended default: Cancelled.</td>
</tr>
<tr>
<td>Optimizer – Default Priority</td>
<td>Yes</td>
<td>Sequence number for the Activity Priority LOV.</td>
<td>Priority used if no priority is set for an activity.</td>
</tr>
<tr>
<td>Optimizer – Glued</td>
<td>Yes</td>
<td>Number (hours)</td>
<td>The period, in hours, in which the Optimizer does not change the assigned employees (and schedules) for activities. This period extends from the time when the optimization task begins until the time that this value designates. The optimization task begins when you click the Optimize button on the Administration - Scheduling screen &gt; Service Region List view. For example, if you click the Optimize button at 10:00 A.M. and if you set this value to 4 (4 hours), the Optimizer does not reassign employees for activities (and does not reschedule activities) that are scheduled to take place between 10:00 A.M and 2:00 P.M.</td>
</tr>
<tr>
<td>Optimizer – Hard Latest Start</td>
<td></td>
<td>1/0</td>
<td>Whether the Latest Start value is considered a hard or soft constraint: 0 – Soft constraint 1 – Hard constraint The default is 0.</td>
</tr>
<tr>
<td>Optimizer – Logging Level</td>
<td></td>
<td>Number, 1–4</td>
<td>This field controls how much information is written to the Optimizer log (Optimizer_xxx.log) stored on the server. The lowest level, 1, writes only basic information about the server activities, while the highest level, 4, writes detailed logs, showing all actions that occurred.</td>
</tr>
</tbody>
</table>
Setting Up and Using Scheduling

Creating Parameter Sets for Scheduling

Table 29. Scheduling Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimizer – Optimize Heuristic</td>
<td></td>
<td>Number, 1–8</td>
<td>The heuristic used to improve the optimization solution:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 – Greedy search</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 – Steepest search</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 – Greedy search followed by a Tabu search</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 – Steepest search followed by Tabu</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 – Greedy search followed by Fast GLS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 – Steepest search followed by Fast GLS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7 – Greedy search followed by GTS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8 – Steepest search followed by GTS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>where: GLS = Guided Local search</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>GTS = Guided Tabu search</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>See “Heuristics for the Optimizer” on page 100 for more information about</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>these methods.</td>
</tr>
<tr>
<td>Optimizer – Consider Parts</td>
<td>0/1</td>
<td></td>
<td>Whether the Optimizer should consider parts in an engineer’s trunk inventory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>when considering the engineer for assignment to an activity:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 - No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 - Yes</td>
</tr>
<tr>
<td>Optimizer – Parts Period</td>
<td>Integer (hours)</td>
<td></td>
<td>If the Optimizer considers that a service engineer has the parts required</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>to solve a problem, this parameter tells the Optimizer how far in advance</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>to consider parts.</td>
</tr>
</tbody>
</table>
Setting Up and Using Scheduling

Creating Parameter Sets for Scheduling

The frequency with which the Optimizer saves results during optimization.

Because of this parameter, if an overall system failure occurs during optimization, some optimized results are not lost. For example, if the optimization time is 3 hours, and the save interval is 1 hour, the Optimizer saves results every hour during the 3 hour run. If the system fails 2.5 hours after the Optimizer starts, the first 2 hours of the optimization results are saved. When you restart optimization, the Optimizer uses the 2 hours of results from the previous run.

The time the Optimizer uses to save the results at the save interval is part of the optimization time. Saving the optimized results at the save interval uses extra resources and time. You need to consider both the importance of saving partially optimized results and the efficiency of optimization time usage. If losing partially optimized results because of a system failure is not an important consideration, set the save interval parameter to a time that is the same as or longer than the optimization time. Consequently, the Optimizer saves results only when optimization is complete. If losing partially optimized data because of a system failure is an important consideration, do not set the save interval parameter to less than 1 hour. Consequently, the Optimizer saves results infrequently and uses optimization time efficiently.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimizer – Save Interval</td>
<td>Yes</td>
<td>Integer (Minutes)</td>
<td>The frequency with which the Optimizer saves results during optimization. Because of this parameter, if an overall system failure occurs during optimization, some optimized results are not lost. For example, if the optimization time is 3 hours, and the save interval is 1 hour, the Optimizer saves results every hour during the 3 hour run. If the system fails 2.5 hours after the Optimizer starts, the first 2 hours of the optimization results are saved. When you restart optimization, the Optimizer uses the 2 hours of results from the previous run. The time the Optimizer uses to save the results at the save interval is part of the optimization time. Saving the optimized results at the save interval uses extra resources and time. You need to consider both the importance of saving partially optimized results and the efficiency of optimization time usage. If losing partially optimized results because of a system failure is not an important consideration, set the save interval parameter to a time that is the same as or longer than the optimization time. Consequently, the Optimizer saves results only when optimization is complete. If losing partially optimized data because of a system failure is an important consideration, do not set the save interval parameter to less than 1 hour. Consequently, the Optimizer saves results infrequently and uses optimization time efficiently.</td>
</tr>
<tr>
<td>Optimizer – Tardiness Cost</td>
<td>Yes</td>
<td>Number (Float)</td>
<td>The cash value, in $/hour, of violating the Optimizer – Hard Latest Start soft constraint.</td>
</tr>
<tr>
<td>Optimizer – Task Excl Cost</td>
<td>Yes</td>
<td>Number</td>
<td>Penalty used in calculating the cost function if an activity is unscheduled.</td>
</tr>
<tr>
<td>Optimizer – Timeout</td>
<td>Yes</td>
<td>Minutes (Integer)</td>
<td>The maximum time in minutes for each optimization.</td>
</tr>
</tbody>
</table>
To define parameter sets

1. Navigate to the Administration - Scheduling screen > Parameter Sets view.
   The Parameter Sets view provides the basic definition of the parameters that the ABS and the Optimizer use.

2. Create a new record and complete the fields as appropriate.
   Make sure that you give the parameter set a meaningful name—for example, East Coast Parameters.

3. Scroll down to the Parameters list and create a new record.
   The Parameters view defines each parameter in a parameter set.

4. In the Variable Code field, select the appropriate parameter from the drop-down list.
   See “Schedule Parameters” on page 128 for more information about the parameters that you can choose from.

5. In the Variable Value field, enter a value for the parameter.

To view the service regions associated with a parameter set

1. Navigate to the Administration - Scheduling screen > Parameter Sets view.
2. Select a record in the Parameter Sets list.
3. Click the Service Regions view tab.
   The Service Regions view contains read-only records listing the service regions that use a selected parameter set.

Defining Cost Functions for the Optimizer

This task is a step in “Process of Setting Up Scheduling” on page 106.

The cost function is the sum of factors that drive the optimization of a schedule. For each activity in the schedule, the Optimizer minimizes the value of the cost function while optimizing the schedule. The cost function indirectly calculates the monetary cost of carrying out a schedule.

There is only one cost function for each service region. However, many service regions can use the same cost function. Cost functions are associated with service regions in the Administration - Scheduling screen > Service Region List view. See “Defining Service Regions” on page 109 for more information.

To define cost functions

1. Navigate to the Administration - Scheduling screen > Cost Functions view.
   The Cost Functions view is used to define the function that the Optimizer uses for assessing the success of each iteration of a schedule.
2 Create a new record and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type</td>
<td>This drop-down list offers two options: Normal and Emergency. For Field Service scheduling purposes, select Normal.</td>
</tr>
<tr>
<td>Function Area</td>
<td>This drop-down list offers three options: Field Service, Workforce Management, and Professional Services. For Field Service scheduling purposes, select Field Service.</td>
</tr>
</tbody>
</table>

3 Scroll down to the Details list.

The Cost Function Details view defines each variable in a cost function.

4 Create a new record and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select this check box to indicate that the variable is active.</td>
</tr>
<tr>
<td>Variable</td>
<td>The variable to be used for the cost function. See &quot;Cost Function Variables&quot; on page 136 for more information.</td>
</tr>
<tr>
<td>Weight</td>
<td>The weighting value to be allocated to the cost function variable. For all weights in the cost function, start with values of one (which approximate the real cost of scheduling an activity), then change these values as needed.</td>
</tr>
</tbody>
</table>

**To view the service regions associated with a cost function**

1 Navigate to the Administration - Scheduling screen > Cost Functions view.
2 Select a record in the Cost Functions list.
3 Click the Service Regions view tab.

The Service Regions view contains read-only records listing the service regions that use a selected cost function.
### Cost Function Variables

The cost function is the sum of the factors shown in **Table 30**.

<table>
<thead>
<tr>
<th>Factor</th>
<th>Calculation of the Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constraint Violation</td>
<td>( \sum RuleViolationCost \times Weight )</td>
</tr>
<tr>
<td></td>
<td>This is the sum of Rule Violation Costs for each soft constraint violated. A violation is proportional to the degree of the violation. The units for the amount of the violation are the same as defined for the constraint. Time units are in hours; all other cases use the activity.</td>
</tr>
<tr>
<td>FSE Overtime</td>
<td>( FSEOTCost \times (EndtimeoflastactivityinOT - Endofnormalshift) \times Weight )</td>
</tr>
<tr>
<td></td>
<td>Where, ( FSEOTCost = (StdCost \times StdOTpercent) + (StdCost \times ExtOTpercent) )</td>
</tr>
<tr>
<td>Tardiness</td>
<td>( TardinessCost \times Amountofdelay \times Weight )</td>
</tr>
<tr>
<td>Task Exclusion Penalty</td>
<td>( TaskExclusionPenalty \times \frac{1}{TaskPriority} \times Weight )</td>
</tr>
<tr>
<td></td>
<td>Task priority allows higher priority tasks to take precedence over low priority ones. This is important when there are not enough resources to schedule all activities. The Task Priority term uses the numeric value from the Order column in the Administration - Data screen &gt; List of Values view (see <em>Siebel Applications Administration Guide</em>). This is the value that also appears in the Activities screen &gt; More Info view, Priority field. Task Exclusion Penalty and Weight cannot be zero. If they are zero, no activities are scheduled.</td>
</tr>
<tr>
<td>Travel Distance</td>
<td>( TravelDistance \times TravelCost \times Weight )</td>
</tr>
</tbody>
</table>

### Setting Up Server Key Mappings

This task is a step in "Process of Setting Up Scheduling" on page 106.

Service regions are designed to be self-contained so that they can run on separate CPUs and even separate servers. Server key mappings are used to specify the location and routing of requests to these service regions. Server key mappings also assign the service regions to different processes, which determines whether they are processed in parallel or serially by the servers. There are two server key mappings, one for the ABS and one for the Optimizer.

When the user clicks the Book Appointment button, the request is sent to the enterprise server. The enterprise server then looks at a map of the service regions and routes the request to the appropriate Siebel Server that stores that service region.
Multiple Processor Support

If the underlying operating system can support multiple processors on one computer, Siebel Scheduler can take advantage of those processors by running different service regions for the ABS and Optimizer on different processors. This is accomplished by setting different process numbers in a server key map. A server with a single processor can run multiple processes, but this may reduce performance. Service regions in different processes in different processes are run in parallel, while service regions in the same process are run serially.

**NOTE:** The number of processes running on a server computer are not related to the number of processors in that computer.

Because the ABS and Optimizer are different modules, they are already running as separate processes, even though the process number is the same. One module for one service region can run in only one process at a time.

For example, consider a four-processor computer, with only two of the processors in use. If one service region runs with both the ABS and Optimizer, the key map would look like the example shown in Table 31. Note that process refers to the number of processes for that component, not the processor number on the server.

Table 31. Server Key Mapping: Example 1

<table>
<thead>
<tr>
<th>Server</th>
<th>Service Region</th>
<th>Process</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppServer1</td>
<td>West Coast Region</td>
<td>1</td>
<td>ABS</td>
</tr>
<tr>
<td>AppServer1</td>
<td>West Coast Region</td>
<td>1</td>
<td>Optimizer</td>
</tr>
</tbody>
</table>

**NOTE:** You cannot run one module for a service region as two processes.

If two service regions run on a four-processor computer, you can use all four processors, as in Table 32. Note that process refers to the number of processes for that component, not the processor number on the server.

Table 32. Server Key Mapping: Example 2

<table>
<thead>
<tr>
<th>Server</th>
<th>Service Region</th>
<th>Process</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppServer1</td>
<td>West Coast Region</td>
<td>1</td>
<td>ApptBook</td>
</tr>
<tr>
<td>AppServer1</td>
<td>East Coast Region</td>
<td>2</td>
<td>ApptBook</td>
</tr>
<tr>
<td>AppServer1</td>
<td>West Coast Region</td>
<td>1</td>
<td>Optimizer</td>
</tr>
<tr>
<td>AppServer1</td>
<td>East Coast Region</td>
<td>2</td>
<td>Optimizer</td>
</tr>
</tbody>
</table>
If there are more than two service regions on a four-processor machine, you can run them as different processes. For example, if the West Coast Region is very large and the Central and East Coast regions are smaller, the scheme shown in Table 33 might be the best use of the processors on a server. Note that process refers to the number of processes for that component, not the processor number on the server.

Table 33. Server Key Mapping: Example 3

<table>
<thead>
<tr>
<th>Server</th>
<th>Service Region</th>
<th>Process</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppServer1</td>
<td>West Coast Region</td>
<td>1</td>
<td>ApptBook</td>
</tr>
<tr>
<td>AppServer1</td>
<td>East Coast Region</td>
<td>2</td>
<td>ApptBook</td>
</tr>
<tr>
<td>AppServer1</td>
<td>Central Region</td>
<td>2</td>
<td>ApptBook</td>
</tr>
<tr>
<td>AppServer1</td>
<td>West Coast Region</td>
<td>1</td>
<td>Optimizer</td>
</tr>
<tr>
<td>AppServer1</td>
<td>East Coast Region</td>
<td>2</td>
<td>Optimizer</td>
</tr>
<tr>
<td>AppServer1</td>
<td>Central Region</td>
<td>2</td>
<td>Optimizer</td>
</tr>
</tbody>
</table>

The West Coast region, which requires more computation, uses two processors. The East Coast and Central regions run in the same processes and on the same two processors.

Each server component is multithreaded and can load schedules for multiple service regions. These schedules are shared by multiple threads. Each request to the Optimizer runs on a new thread.

A request identifies the schedule for one service region that it requires and locks it. Requests for schedules for other service regions can continue while requests for the same schedule are queued. As the response time for the ABS is quite fast, this should not result in high latency for the booking times being returned. Generally, this is true because the think time between ABS transactions is usually several minutes.

**To set up server key mappings**

1. Navigate to the Administration - Scheduling screen > Server Key Mappings view.

   The Server Key Mappings screen assigns servers to processes and associated service regions.
Create a new record and complete the fields as appropriate. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>The name of a Siebel Server.</td>
</tr>
<tr>
<td>Process #</td>
<td>The number of a process running on the server. This number is used primarily to group service regions into the same process.</td>
</tr>
<tr>
<td>Leaf Service Region</td>
<td>The name of a service region selected from the Pick Service Region dialog box.</td>
</tr>
<tr>
<td>Component</td>
<td>The name of a component, either ABS or Optimizer, selected from the Pick Component dialog box.</td>
</tr>
</tbody>
</table>

After modifying server key mappings, you must restart the relevant server component (for example, Appointment Booking Engine or Optimization Engine) for the changes to take effect. You must also restart the relevant server if you have added or removed a key value.

**CAUTION:** If you specify more than one process on a server, you must set the Maximum MT Servers server component parameter to the same number of processes so that multiple processes can be spawned. If you do not, only the first process is created and not all regions are loaded.

It is recommended that you set the Minimum MT Servers server component parameter to the number of processes needed and Maximum MT Servers to a value greater than or equal to Minimum MT Servers. For more information about these parameters, see the chapter on tuning the performance of the Application Object Manager in the *Siebel Performance Tuning Guide* and "Setting Server Component Task Parameters" on page 139.

**NOTE:** If the Server Key Mappings - Optimizer Component is missing from the drop-down list for the Component field, the server installation was incomplete. To correct this, use the Synchronize button on the Administration - Server Configuration screen > Enterprises > Synchronize view. See the complete procedure in *Siebel System Administration Guide*.

### Setting Server Component Task Parameters

This task is a step in "Process of Setting Up Scheduling" on page 106.

The parameters that configure shell (process) startup for the Server Request Broker and the Appointment Booking Engine server components should be set in accordance with the number of service regions and the number of users.

See *Siebel System Administration Guide* for more information on changing these parameters for server components.
Setting the Number of Server Request Broker Tasks
Each service region used keeps a Server Request Broker (alias SRBroker) task permanently running. This means that the default MaxTasks setting of 100 for the server component SRBroker may need to be increased when using more than approximately 70 service regions. This precaution prevents errors such as the following from appearing in the SRBroker log:

SBL-SMI-00114: The Multithreaded Server has reached the maximum number of concurrent tasks (100)

Setting the Number of Appointment Booking System Tasks
The server component parameters for the Appointment Booking Engine (alias ApptBook) should be set in accordance with the recommendations listed in Table 34.

Setting Up and Using Scheduling  ■ Reloading the ABS and Optimizer Caches

Table 34. Recommended Task Values for the ApptBook Server Component

<table>
<thead>
<tr>
<th>Server Component Parameter</th>
<th>Alias</th>
<th>Recommended Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Tasks</td>
<td>MaxTasks</td>
<td>The value should be 10-20% of the total number of users who access the ABS.</td>
</tr>
<tr>
<td>Minimum MT Servers</td>
<td>MinMTServers</td>
<td>The value should be the same as the number of servers entered in the Administration - Scheduling screen &gt; Server Key Mapping view.</td>
</tr>
<tr>
<td>Maximum MT Servers</td>
<td>MaxMTServers</td>
<td>The value should be the same as the value for the Minimum MT Servers parameter.</td>
</tr>
</tbody>
</table>

Reloading the ABS and Optimizer Caches
This task is a step in “Process of Setting Up Scheduling” on page 106.

Dispatchers and field service engineers may change the following specifications for service activities:

■ Planned Start date for an activity
■ Planned End date for an activity
■ Engineer assigned to an activity (in the Employees field)

NOTE: Planned End, Planned Completion, and End are all the same. All these terms appear in the user interface.

All changes require updating an in-memory cache of the activities. If a user changes an activity in the database, it becomes out of sync with the cache in memory. You can reload activity data manually into memory by clicking the Load button in the Administration - Scheduling screen > Service Region List > Activities view. See “Loading Activities for Service Regions” on page 143 for more information.
Users can also freeze an activity’s scheduled time or assignment. See "Locking Schedules and Assignments (End User)" on page 153 for more information.

**CAUTION:** Keep manual changes to a minimum because the Optimizer works on the principles of constraint propagation and domain reduction, which are critical to solving complex schedules quickly. This means that no activity that violates a hard constraint can be loaded into the memory cache. (This includes implicit constraints—for example, using the employees’ work schedules or excluding double-booking.)

Therefore, the Optimizer might reject a manual change when it loads the activity. Even if the activity is loaded successfully, the Optimizer may later change the schedule for this activity.

Reloading the ABS cache daily accomplishes the following:

- Old activities are released from the cache.
- Manual activity changes are loaded to the cache.
- Days in the future become available for booking (with any currently existing appointments loaded into them).

To load employee and activity data for the service regions and reload the ABS and Optimizer caches, perform the following tasks:

- Loading Employee Data for Service Regions on page 142
- Loading Activities for Service Regions on page 143
- Reloading Service Regions to the Appointment Booking System Cache Manually on page 144
- Overriding a Row Limit on page 144
- Coalescing the Appointment Booking System on page 145
- Reloading Service Regions to the Optimizer Cache Manually on page 145
- Reloading the Appointment Booking System Cache Using Workflows on page 146

**Guidelines for Reloading Service Region Data**

It is recommended that you follow these guidelines when reloading service region data:

- Reload the caches daily, preferably after hours.
  
  The ABS - Days to End parameter controls the length of time in the ABS horizon. If this parameter is set to 14 and you do not reload the caches for three days, then you can only book appointments for 11 of the 14 days.

- Reload the ABS before the Optimizer, so that there are no conflicts in scheduling between the ABS and the Optimizer.

- Carry out both reloads in the same day.

See "About Loading and Reloading Service Region Data" on page 169 for more background information.
Loading Employee Data for Service Regions

This task is a step in “Process of Setting Up Scheduling” on page 106.

A field service engineer can belong to only one service region. This rule applies because employee information is cached in memory for performance reasons. Also, if each Siebel Scheduler process has its own cache, employees cannot be in more than one cache at a time—otherwise, each instance of Scheduler would produce conflicting schedules for the employee. Attempting to keep two service regions synchronized around common employees would consume heavy amounts of resources and would be difficult to manage.

Employee data is loaded with service region data into the ABS or Optimizer cache. You can do this manually or with the Workflow Manager. When activities are loaded, Assignment Manager retrieves the list of eligible employees and the ABS or Optimizer loads this data.

When you load the data for a new employee, the list of employees eligible for existing activities is not updated. The result is that the new employee may not be eligible to carry out any of the existing activities, but is eligible for new activities. At the next reload of the service region and its employee data, the new employee is eligible for all activities.

Service regions are specified for employees using the Service Region field on the Administration - User screen > Employees > Service Details view. All the employees for a particular service region are then listed on the Administration - Scheduling screen > Service Region List > Employees view.

**To manually load employee data**

1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. Select a service region record and drill down on the Name field hyperlink.
3. Click the Employees view tab.
   - The Employees view lists the employees assigned to a service region. This view is read-only.
4. Select the employees who should be loaded for the service region.
5. Click the Load ABS button.
   - Clicking this button sends an asynchronous request to the Optimizer to refresh the data for one or more selected employees in the ABS cache. This command must be initiated manually or by the Workflow Manager; do not use a repeating component job.

**To remove data for an employee from the ABS cache**

1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. Select a service region record and drill down on the Name field hyperlink.
3. Click the Employees view tab.
4. Select an employee record and click Unload ABS.
   - Clicking this button sends an asynchronous request to the Optimizer to remove the data. This command must be initiated manually; do not use a repeating component job.
Loading Activities for Service Regions

This task is a step in “Process of Setting Up Scheduling” on page 106.

Activity data for each service region must be loaded into the ABS or Optimizer cache. You can do this manually or with the Workflow Manager.

Service regions are specified for an activity using the Service Region field on the Activities screen > Activity List > Schedule view. See “Schedule View” on page 85 for more information. All the activities for a particular service region are then listed on the Administration - Scheduling screen > Service Region List > Activities view.

Use the Load button on the Administration - Scheduling screen > Service Region List > Activities view to manually load activities for a selected service region. You can also use this button for contract scheduling purposes—see “Running Contract Scheduling (End User)” on page 157 for more information.

Clicking the Load button sends an asynchronous request to the Siebel Server to load the selected activities into the ABS or Optimizer cache. Based on the values of the Planned Start and Planned End field for an activity and the start and end times for the ABS and Optimizer horizons, the data goes either to the ABS or Optimizer cache.

NOTE: Normally, use the Workflow Manager instead of the Load button to load activities.

Before clicking the Load button, make sure that the following conditions are met:

- The activity is not repeating.
- If Lock Schedule is set to TRUE, there are values for Planned Start and Planned End.
- If Lock Assignment is set to TRUE, there is an employee assigned to the activity.

See “Locking Schedules and Assignments (End User)” on page 153 for more information on using the Lock Schedule and Lock Assignment flags.

To manually load activities for a service region

1. Navigate to the Administration - Scheduling screen > Service Regions List view.
2. Select a service region record and drill down on the Name field hyperlink.
3. Click the Activities view tab to view the activities.
   The Activities view displays all activities for the selected service region. This view is read-only.
4. Select the activities that you want to load for the service region.
5. Click the Load button.

Employee data also needs to be loaded to the ABS or Optimizer cache. See “Loading Employee Data for Service Regions” on page 142 for more information.
Moving Activities Between Service Regions
An employee can only belong to one service region. However, this does not prevent an employee from performing activities in other service regions. For example, Sue Nelson is an engineer based in the San Francisco service region. Today is a light day for her, but the San Jose service region is completely booked. In most cases, this case would be handled by manually scheduling activities for Nelson using the Dispatch Board. However, the Optimizer can schedule Nelson in the San Jose service region. This requires switching the service region for the activity.

To move activities between service regions
1. Cancel the activity from Service Region 1 (San Francisco).
2. Set the activity to Service Region 2 (San Jose).
3. Load the activity into Service Region 2 (San Jose).

You can create a button or workflow that carries out these steps. Alternatively, the Workflow Manager can trigger this process upon rejection of an activity from Service Region 1.

Reloading Service Regions to the Appointment Booking System Cache Manually
This task is a step in “Process of Setting Up Scheduling” on page 106.
Perform the following procedure to reload information to the ABS cache.

To reload all data to the ABS for a service region
1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. In the Service Regions list, select a service region.
3. Click Load ABS.

Clicking this button erases all data for a service region in the ABS cache and reloads this data from the database. For each service region, this is an asynchronous request to the Siebel server.

NOTE: If a row limit has been imposed, all the data may not be loaded into the ABS cache. See “Overriding a Row Limit” for more information.

Overriding a Row Limit
This task is a step in “Process of Setting Up Scheduling” on page 106.
When you restart the ApptBook component or click the Load ABS button, all the data in the service region must be loaded into the ABS cache. If a limit of 10,000 rows has been imposed and there are more than 10,000 activity records in the service region, then all the required activity data will not be loaded. To resolve this, perform the following procedure.
**To override a data row limit**

1. Create a new Named Subsystem for the ABS.
2. Set the parameter DSMaxFetchArraySize to -1.

   Setting the parameter to this value does not impose any limits on the number of records allowed.

---

**Coalescing the Appointment Booking System**

This task is a step in “Process of Setting Up Scheduling” on page 106.

You can improve appointment schedules by coalescing the ABS; time gaps are removed from between booked appointments. This asynchronous request is carried out for one service region at a time.

**To coalesce the ABS**

1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. In the Service Regions list, select a service region.
3. Click Coalesce ABS.

---

**Reloading Service Regions to the Optimizer Cache Manually**

This task is a step in “Process of Setting Up Scheduling” on page 106.

Perform the following procedure to reload the Optimizer cache with all data for a selected service region.

**To reload all data to the Optimizer for a service region**

1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. In the Service Regions list, select a service region.
3. Click Load Optimizer.

   Clicking this button erases all data for a service region in the Optimizer cache and reloads this data from the database. For each service region, this is an asynchronous request.

   When an optimization is in progress, this request is not sent to the server. The user receives an error message.

   **NOTE:** See “Optimizing Schedules (End User)” on page 155 for more information about running the Optimizer on service region schedules.
Reloading the Appointment Booking System Cache Using Workflows

This task is a step in “Process of Setting Up Scheduling” on page 106.

You can reload service regions automatically using the predefined Server Requests business service to call the Appointment Booking Engine server component (alias ApptBook). You can set up a workflow process to submit the server job to ApptBook.

You can also set up workflows to specifically handle the following:

- **Unscheduled activities.** During a reload, if the capacity in a service region has changed (due to personnel changes or manual changes), some activities may become unscheduled. One way to handle this is to create a workflow that emails the service region manager about the unscheduled activities—or alternatively, creates an activity to do a reschedule with a customer.

  **NOTE:** You can also set up a predefined query (PDQ) to look for those activities where Status = Unscheduled, particularly if this occurs frequently.

- **Manual changes.** If the users are making manual changes to activities, and these changes need to be reflected in the cache immediately (without waiting for the next reload), you can create a workflow that calls LoadActivity as soon as a change is made to the Owner, Planned Start, or Planned End values.

See *Siebel Business Process Framework: Workflow Guide* for more information on setting up workflows. See *Siebel System Administration Guide* for more information on creating repeating component jobs.

**CAUTION:** When loading the ABS, use either eScript or a workflow process—do not use the business service Appointment Booking Service for this purpose.

Appointment Booking System Methods

For more information on the various inputs and outputs used with the ABS methods, see “ABS Methods” on page 584 and “Invoking the ABS and Optimization Engine Methods” on page 582.

**To create a workflow to automatically reload service region data**

1. Create a workflow process with the following steps:

   Start > Business Service > End
2 When defining the Business Service step, specify the Server Requests business service and Submit Requests method.

**CAUTION:** You can use the business services Server Requests, Asynchronous Server Requests, or Synchronous Server Requests to submit a request to the Appointment Booking Engine. However when using any of these in eScript or as part of a workflow, you must provide an appropriate value for the SubmitRequest method's input argument Request Key. The Request Key input argument's value is the activity's Service Region Id value. Each service region can be mapped to a different process number; the business service must use the Request Key value to identify the correct ABS process to which each request should be sent. Without the Request Key input argument, the request can be sent to the wrong ABS process, causing the Appointment Booking Engine to return an error message. See “Setting Up Server Key Mappings” on page 136 for more information.

3 Define the following input arguments.

<table>
<thead>
<tr>
<th>Input Argument</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApptBook.ServiceRegionId</td>
<td>Literal</td>
<td>The required service region’s ROW_ID</td>
</tr>
<tr>
<td>Request Key</td>
<td>Literal</td>
<td>The required service region’s ROW_ID</td>
</tr>
<tr>
<td>Component</td>
<td>Literal</td>
<td>ApptBook</td>
</tr>
<tr>
<td>Method</td>
<td>Literal</td>
<td>ReloadServiceRegion</td>
</tr>
<tr>
<td>Mode</td>
<td>Literal</td>
<td>Sync/Async</td>
</tr>
</tbody>
</table>

- Use Sync if you want the workflow process to wait for the ABS to finish.
- Use Async if you want the workflow process to submit requests to the ABS and then end the workflow without determining whether or not the ABS successfully reloaded the service region.

4 Deploy and activate the workflow process.

5 Create a new repeating component job, selecting Workflow Process Manager as the Component/Job field value.

6 Create a new job parameter, specifying Workflow Process Name in the Name field and the name of the workflow process (ReloadServiceRegion) in the Value field.

7 Start the job.

A new instance of the job is created with a Queued status. Once the start date arrives, the queued instance is executed.
Process of Scheduling Activities

The following list shows the procedures that end users typically perform to use scheduling within Siebel Field Service. Your company may follow a different process according to its business requirements.

To schedule activities, perform the following tasks:

1. Add required schedule information to the activity record. See "Adding Schedule Information for Activities (End User)" on page 148 for more information.
   
   **NOTE:** You must add the schedule information before booking appointments because this information is used by the ABS and the Optimizer when running.

2. Select the appropriate appointments for the activities. See "Booking Activity Appointments (End User)" on page 150.

3. Lock any assignments or schedules that should not change. See "Locking Schedules and Assignments (End User)" on page 153 for more information.

4. Make sure that schedules are optimized as required. See "Optimizing Schedules (End User)" on page 155 for more information.

5. Use the Optimizer’s Contract Scheduling feature if required. See "Running Contract Scheduling (End User)" on page 157 for more information.

Adding Schedule Information for Activities (End User)

This task is a step of "Process of Scheduling Activities" on page 148.

Use the Activities screen > Activity List > Schedule view to add schedule information required by the Optimizer and ABS. See Chapter 4, "Field Service Activities" for more general information about setting up and recording activities.

To add schedule information for activities

1. Navigate to the Activities screen > Activity List > Schedule view.

2. Select an activity record in the Service Activities list.
3 Complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Address Map</td>
<td>This button provides a hyperlink to the MapQuest Web site. Siebel does not guarantee the availability or accuracy of any content or service provided by MapQuest.</td>
</tr>
<tr>
<td>Book Appointment</td>
<td>Clicking this button sends a request to Scheduler to find the possible time slots for scheduling this activity. See “Booking Appointments from the Activities Screen” on page 151 for more information.</td>
</tr>
<tr>
<td>Cancel Appointment</td>
<td>Clicking this button sends a request to the Scheduler to remove this activity from the schedule. For more information, see “Canceling Appointments” on page 152</td>
</tr>
<tr>
<td>Contract Schedule</td>
<td>Selecting this command sends a request to the Optimizer to insert a priority service activity into a schedule with minimal disruption of the schedule and without significant increase in the cost of the schedule. See “Running Contract Scheduling (End User)” on page 157 for more information.</td>
</tr>
<tr>
<td>Earliest Start</td>
<td>The earliest time and date an activity may begin, usually used to indicate contractual commitments or deadlines. In some configuration settings this value is described as NST (No sooner than).</td>
</tr>
<tr>
<td>Latest Start</td>
<td>The latest time and date for an activity, usually used to indicate contractual commitments or deadlines. It is the same as the Due field in the form. In some configuration settings, this value is described as NLT (No later than). For reactive calls, Earliest Start and Latest Start represent both the contractually committed date and time for service. For proactive calls, these dates and times represent when a customer can be present for service.</td>
</tr>
<tr>
<td>Planned Start</td>
<td>The time in which a call is actually planned to take place. These times are usually known to the service organization and the field service engineer. Depending on the service business model, these times may or may not be communicated to the customer. If you specify values for Earliest Start or Latest Start, then Planned Start must be later than Earliest Start and earlier than Latest Start.</td>
</tr>
<tr>
<td>Planned End</td>
<td>The proposed date for completing an activity. Also appears as Planned Completion in the user interface.</td>
</tr>
<tr>
<td>Duration</td>
<td>The time required to carry out an activity, including breaks and travel time. The value is set to Planned End - Planned Start by the ABS or Optimizer.</td>
</tr>
<tr>
<td>Service Region</td>
<td>The service region to which this activity is assigned.</td>
</tr>
</tbody>
</table>
Setting Up and Using Scheduling  ■ Booking Activity Appointments (End User)

This task is a step of “Process of Scheduling Activities” on page 148.

Customer service representatives use the Book Appointment button on the Activities and Service screens to obtain a list of appointment choices for a selected activity. Clicking the button runs the ABS.

Before booking an appointment, make sure that the work time and the service region are specified for an activity and that the activity is not repeating.

**NOTE:** Do not use the ABS to schedule appointments that are far into the future—for example, preventive maintenance activities six months ahead. See “About Using Long-Range ABS Horizons” on page 99 for more information.

Booking appointments and optimizing the schedule for activities requires the following data:

- Schedules for service regions and employees
- Existing activities and appointments

### Field | Comments
--- | ---
Work Time | The time required to work on an activity, not including, for example, travel and breaks. To show the difference between work time and duration, it may be useful to describe an example. A company’s schedule is from 9 A.M. to 1 P.M. and 2 P.M. to 6 P.M. The activities being scheduled last for six hours and are breakable (see “About the Breakable Flag” on page 120 for more information). If a dispatcher starts an appointment at 4 P.M. this means that the activity finishes at 1 P.M. the next day. The work time is six hours but the duration is 21 hours.

Lock Assignment | Select this check box to ensure that the Optimizer cannot change the assignment.

**NOTE:** If the Lock Assignment flag is not set (FALSE), manually specify the employee for an activity. See “Locking Schedules and Assignments (End User)” on page 153 for more information.

Allow Breaks | Select this check box to allow scheduling of an activity around breaks. See “Breaks” on page 119 for more information.

Lock Schedule | Select this check box to prevent the ABS and the Optimizer from changing the values of Planned Start and Planned End.

**NOTE:** If the Lock Schedule flag is set (TRUE), provide values in the Planned Start and Planned End fields. In this case, no time slots are required and the Book Appointment dialog box does not appear. See “Locking Schedules and Assignments (End User)” on page 153 for more information.
Setting Up and Using Scheduling

■ Booking Activity Appointments (End User)

Siebel Field Service Guide
Version 8.0, Rev. B

Service activities
Service regions
Employees
Parts available to employees
Scheduling parameters
Service region parameters
System parameters
Constraints
Time windows
A cost function

To book or cancel appointments, perform the following tasks:
■ Booking Appointments from the Activities Screen on page 151
■ Booking Appointments from the Service Screen on page 152
■ Canceling Appointments on page 152

Booking Appointments from the Activities Screen

This task is a step of “Process of Scheduling Activities” on page 148.

The Activities screen’s Schedule view provides the Book Appointment and Cancel Appointment buttons for running the ABS and Optimizer interactively. See “Canceling Appointments” on page 152 for more information about canceling a booked appointment.

To book appointments from the Activities screen

1. Navigate to the Activities screen > Activity List > Schedule view.
2. Select an activity record in the Service Activities list.
3. Click the Book Appointment button.

Clicking this button sends a synchronous request to the ABS for time slots in which to book the selected activity. The available appointments are returned in a dialog box.

NOTE: If you do not specify Earliest Start or Latest Start times for the activity, the ABS - Days to Start and ABS - Days to End parameter values, as well as the schedule for the service region, are used. For example, if today is March 16th and the ABS - Days to End parameter is set to 1 and the service region opening hour is 8 A.M., the assumed earliest start is 8 A.M. on March 17th. Unless the service region is extremely full, the value of the ABS - Days to End parameter does not apply.

You should also note that the activity does not need to end before the Latest Start time—it must simply start before that time.
4 Using the dialog box, select and confirm an appointment or cancel if none are appropriate.

- To confirm an appointment, select an appropriate record and click Confirm.
  Clicking this button in the Book Appointment dialog box sends a server request to confirm
  the selected appointment and release the lock on the remaining slots.
- If you do not want to select any of the available appointments, click Cancel.
  Clicking this button in the Book Appointment dialog box sends a server request to reject all
  proposed appointment slots and to release the lock on these slots.

**TIP:** There is no need to cancel an activity before rebooking it for another time. Instead, you can
simply click the Book Appointment button. When you confirm a time slot, the old time slot is
automatically released within the ABS. The Cancel Appointment button is used when you want to
cancel an appointment and not rebook it.

### Booking Appointments from the Service Screen

This task is a step of “Process of Scheduling Activities” on page 148.

The Service screen > Service Request List > Activities view provides the Book Appt and Cancel Appt
buttons for running the ABS. The Activities view displays the activities associated with service
requests.

**To book appointments from the Service screen**

1. Navigate to the Service screen > Service Request List > Activities view.
2. In the Activities list, select an activity record.
3. Click the Book Appt button.
4. Using the dialog box, select and confirm an appointment or cancel if none are appropriate.

   See Step 4 in “Booking Appointments from the Activities Screen” for more information about using
   the Book Appointments dialog box.

### Canceling Appointments

This task is a step of “Process of Scheduling Activities” on page 148.

To cancel an appointment, set the service region, make sure the activity is not repeating and the
activity (Planned Start – Planned End) is not in the Glued period. If the Cancel Appt request is
successful, the fields that define an activity are unchanged except for the activity Status, which is
set to Cancelled.

The choice of sending the Cancel Appt request to the ABS or Optimizer depends on these conditions:

- If the Planned Start and Planned End values are less than the start time for the ABS horizon,
  then send a request to the Optimizer.
If the Planned Start value is less than the start time for the ABS horizon, and the Planned End value is greater than the start time for the ABS horizon, then send a request to the Optimizer and the ABS.

If the Planned Start value is greater than or equal to the start time for the ABS horizon and the Planned End value is less than the end of the ABS horizon, then send a request to the ABS.

**To cancel an appointment**

1. Navigate to the Service screen > Service Request List > Activities view or the Activities screen > Activity List > Schedule view.
2. Select an activity record.
3. Click Cancel Appointment.

Clicking this button sends a synchronous request to the ABS or the Optimizer to cancel an appointment, release the appointment for other schedules, and set the status of the selected activity to Cancelled.

The request is sent to the ABS or Optimizer, depending on the horizon that contains this activity. If the activity (Planned Start and Planned End) overlaps the ABS and the Optimizer horizons, the request goes to both the ABS and Optimizer.

**Locking Schedules and Assignments (End User)**

This task is a step of “Process of Scheduling Activities” on page 148.

Users can set two flags for an activity to freeze (lock) its scheduled time or assignment:

- **Lock Assignment flag** ensures that the Optimizer cannot change the assignment (Employees field). However, this value can be changed manually.

- **Lock Schedule flag** ensures that the ABS or the Optimizer cannot change the values of Planned Start and Planned End. However, these values can be changed manually.

Even if these flags are set, an activity can be rejected from the schedule if it violates a hard constraint. However, the Optimizer does not attempt to change the activity’s Planned Start, Planned End, or Employees fields, so that it remains on the user’s calendar. Reducing the number of hard constraints used in the schedule can minimize the possibility of rejecting an activity.

**NOTE:** It is recommended that activities with a status of Done should have the Lock Assignment and Lock Schedule flags set to TRUE.

Where an activity violates a hard constraint, the Lock Assignment and the Lock Schedule flags are both set to TRUE, and the activity is not loaded into memory or updated.
Table 35 describes the general behavior of the ABS and the Optimizer when the Lock Assignment and Lock Schedule flags are used.

### Table 35. Behavior of ABS and Optimizer Using Lock Assignment and Lock Schedule Flags

<table>
<thead>
<tr>
<th>Lock Assignment</th>
<th>Lock Schedule</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
<td>The ABS can change both the time and owner on load. The Optimizer can change both the time and owner when optimizing.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>The ABS can change the time but not the owner on load. The Optimizer can change the time but not the owner when optimizing.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>The ABS can change the owner but not the time on load. The Optimizer can change the owner but not the time when optimizing.</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>The ABS cannot change the time or owner on load. The Optimizer cannot change the time or owner when optimizing.</td>
</tr>
</tbody>
</table>

Table 36 describes the effects of the Lock Assignment and Lock Schedule flags on appointment booking.

### Table 36. Effects of Lock Assignment and Lock Schedule Flags on Booking Appointments

<table>
<thead>
<tr>
<th>Lock Assignment</th>
<th>Lock Schedule</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
<td>The ABS returns multiple time slots for multiple employees.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>The ABS only checks the activity owner’s calendar to find a list of available time slots.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Clicking the Book Appointment button does not return a list of time slots. Instead, the Insert Activity method (Contract Scheduling) is called internally to insert the activity at its originally scheduled planned start/end. If the activity cannot be scheduled at that time, a No Appointment message is returned to the user.</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Clicking the Book Appointment button does not return a list of time slots. Instead, the Insert Activity method (Contract Scheduling) is called internally to insert the activity at its originally scheduled Planned Start/End. If the activity cannot be scheduled at that time, a No Appointment message is returned to the user.</td>
</tr>
</tbody>
</table>
The ABS performs validation before scheduling an activity. If the activity has the Lock Assignment flag set without having an owner, the ABS generates a validation error and the activity is not loaded into the cache. The user must correct the error and retry. Similarly, with the Lock Schedule flag set, the Planned Start/End must be set before the user clicks the Book Appointment button. Otherwise, the ABS cannot find an appointment.

**NOTE:** During loading or when the Insert Activity method is called (this method is the same as the GetConfirmedAppointment method—see "GetConfirmedAppointment Method" on page 594 for more information), if an activity with both flags set cannot be scheduled, the ABS does not reset the activity’s status to Unscheduled. The activity status remains unchanged. However, the activity is not present in the ABS cache; it only appears as scheduled in the system.

**To freeze assignments**

1. Navigate to the Activities screen > Activity List > Schedule view.
2. Select an activity record in the Service Activities list.
3. Select the Lock Assignment check box.

**To freeze planned start and end times**

1. Navigate to the Activities screen > Activity List > Schedule view.
2. Select an activity record in the Service Activities list.
3. Select the Lock Schedule check box.

### Optimizing Schedules (End User)

This task is a step of “Process of Scheduling Activities” on page 148.

There are two ways in which a service region’s schedule can be optimized:

- **Using the Workflow Manager to launch the Optimizer.** See “About Using the Workflow Manager to Optimize Schedules” on page 156 for more information.

- **Manually launching the Optimizer.** See “Optimizing Schedules Manually” on page 156 for more information.

  **NOTE:** Stopping the optimization of a service region is a manual process. See “Stopping the Optimization of a Service Region” on page 157 for more information.

### Availability of Parts

Availability of parts is a constraint only for the Optimizer, not the ABS. Data loaded into the Optimizer cache includes all trunk inventories for all field service engineers in a service region.

The Optimizer parameter Consider Parts includes the availability of parts in an engineer’s trunk inventory when considering the engineer for assignment to an activity. The parameter Parts Period sets the number of hours that the loaded parts list is valid for an optimization. For more information, see “Defining Cost Functions for the Optimizer” on page 134 and “Schedule Parameters” on page 128.
If parts are considered, and the activity includes a part with an Order Item number, and then the product can be drop-shipped for the service call; the Optimizer does not consider this part as a constraint in scheduling. For more information, see the “Part Tracker View” on page 82.

**NOTE:** To be considered for a service call, parts in a trunk inventory must have a status of Good and an availability of On Hand.

### About Using the Workflow Manager to Optimize Schedules

Scheduling is best considered as a business process. For the Optimizer to be useful, it must be fully integrated into the normal process of delivering service. The Workflow Manager is the primary vehicle for ensuring this integration. Most Siebel customers using the Optimizer would use the Workflow Manager to accomplish the following tasks:

- Manually updating a schedule
- Locking in manual changes
- Synchronizing a schedule with manual changes
- Updating a schedule for contractual commitments
- Notifying a manager by email of rejected activities
- Moving activities to a secondary service region
- Verifying a declined assignment through wireless and reassignment

### Optimization Engine Methods

For more information on the various inputs and outputs used with the Optimization Engine methods, see “Optimization Engine Methods” on page 593 and “Invoking the ABS and Optimization Engine Methods” on page 582.

### Optimizing Schedules Manually

This task is a step of “Process of Scheduling Activities” on page 148.

Perform the following procedure to optimize a service region schedule.

**To optimize a service region’s schedule**

1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. In the Service Regions list, select a service region.
3. Click Optimize.

   Clicking this button sends a request to the Optimizer to run an optimization on the selected service region. The Workflow Manager or repeat component jobs can start an optimization.
Stopping the Optimization of a Service Region

This task is a step of “Process of Scheduling Activities” on page 148.

Perform the following procedure to stop an ongoing optimization of a selected service region. Stopping an optimization may not be immediate because the Optimizer completes the solution that is in process and saves this solution in the database.

**NOTE:** Stopping an optimization is a manual process; the Workflow Manager or repeat component jobs cannot send this command.

To stop the optimization of a service region
1. Navigate to the Administration - Scheduling screen > Service Region List view.
2. In the Service Regions list, select a service region.
3. Click the menu button and select Stop Optimization.

About Optimization and Activity Status

The Optimizer can change the status of activities to obtain the best scheduling.

When you click the Load Optimizer button on the Administration - Scheduling screen > Service Region List view, the Optimizer loads activities (with associated statuses) from the database. Likewise, when you click the Load button on the Administration - Scheduling screen > Service Region List > Activities view, the Optimizer loads the activity (with the associated status) from the database.

If you change the status of an activity, immediately click the Load Optimizer button or the Load button, and then click the Optimize button on the Administration - Scheduling screen > Service Region List view, your changed activity status is in effect after the Optimizer runs.

However, the Optimizer can change the status of activities. So if you change the status of an activity and do not click the Load Optimizer button or the Load button, your changed activity status can revert to the status value in the Optimizer cache if the Optimizer runs again.

Running Contract Scheduling (End User)

This task is a step of “Process of Scheduling Activities” on page 148.

Contract Scheduling is a feature of the Optimizer that is designed for rapid scheduling of service appointments while maintaining the critical Optimizer requirements: enforcement of contractual deadlines and use of constraints when searching for solutions.

When Contract Scheduling is invoked, the Optimizer does not unschedule any other activities. However, it does attempt to see if it can create any slack before inserting an activity. For example, if there are two half-hour spaces within an employee’s schedule and a user attempts to contract schedule a 45-minute appointment, the Optimizer attempts to slide the other appointments around to create a contiguous 45-minute space where the appointment can be placed.
The Optimizer is multithreaded, which means that it can take multiple requests at the same time. For example, two users can invoke Contract Scheduling at the same time. However, because the Optimizer can only process one request at a time, simultaneous requests are queued so that multiple users can submit requests to the Optimizer without any problems. When the Optimizer is performing optimization, users can still submit requests. The Optimizer queues those requests and processes them at the level set by the Optimizer – Save interval parameter or when optimization completes.

Companies with the following needs may use Contract Scheduling:

- Same-day break/fix calls are a higher percentage of service calls.
- Service contracts specify penalties for failing to meet response times (for example, free labor or free parts).
- A large number of constraints must be respected.

Users can run Contract Scheduling from three locations in Field Service:

- **Insert Activity button** in the Dispatch Board screen > Unscheduled Activities view. This sends a request to either the ABS or the Optimizer to schedule an appointment or insert the selected activity into the optimized schedule, depending on times relative to the horizons. See “Insert Activity Button” on page 158 for more information.

- **Contract Schedule button** in the Activities screen > Schedule view. This sends a request for scheduling the selected activity. See “Contract Schedule Button” on page 159 for more information.

- **Load button** in the Administration - Scheduling screen > Service Regions > Activities view. This is similar to the Insert Activity button in the Dispatch Board screen. See “Load Button” on page 159 for more information.

### Insert Activity Button

The Insert Activity button obtains, for a selected activity, either a confirmed appointment from the ABS or runs the Optimizer to schedule the activity. The Insert Activity button is similar to the Contract Schedule button in the Activities screen > Schedule view.

Before using this button, make sure the following conditions are met:

- The service region is set in the Dispatch Board Gantt chart.
- The activity is not repeating.
- If the Lock Schedule flag is set (TRUE), then the Planned Start and Planned End values are not null.
- If the Lock Assignment flag is set (TRUE), then the activity assignee is not null.

The choice of sending the Insert Activity request to the ABS or Optimizer depends on the Earliest Start and the Latest Start values. These values determine whether the activity falls within the ABS or the Optimizer horizon:

- If the Latest Start value is null, sends the request to the ABS.
- If the Latest Start value is in the Glued period, does not insert the activity, but returns an error message.
If the Latest Start value is less than the ABS start, sends the request to the Optimizer.

**Contract Schedule Button**
The Contract Schedule button has the same function as the Insert Activity button. See “Insert Activity Button” and “Schedule View” on page 85 for more information.

**Load Button**
The Load button for activities is intended for synchronizing data in the cache if there have been manual changes to an activity.

The choice of sending the activity to the ABS or the Optimizer cache depends on these conditions:

- If Planned Start and Planned End are specified, then the choice of the ABS or Optimizer depends on matching these values to the dates for either the ABS or the Optimizer horizon.

- If Planned Start and Planned End are not specified, then the values for Earliest Start and Earliest End are used. If these values fall within the Optimizer horizon, then the activity goes to the Optimizer cache.

- If neither of these conditions succeeds, an error message is returned.

See “Loading Activities for Service Regions” on page 143 for more information.

**About Troubleshooting the Appointment Booking System and Optimizer**
Typically, there are two main types of problems that can occur when using the ABS:

- Schedules and the associated activities will not load into the ABS on startup.

- An error stating that no appointments were found is returned when you try to book appointments.

It is recommended that you check the items described in “Troubleshooting the Appointment Booking System” on page 160 to analyze the problem encountered.

Also, any company using the Optimizer should see “Troubleshooting the Optimizer” on page 163 for recommendations on how to extract the best possible solutions in the least amount of time.

**TIP:** It is recommended that you have distinct administrator users for running the ABS and Optimizer processes. It is far easier to trace and understand Scheduler operations if the ABS and the Optimizer have different users—for example, ABSAdmin and OptAdmin. If the user is left as SADMIN, it may be unclear as to whether other workflows have affected the activity. Knowing whether a user, a workflow, or Scheduler was responsible for an action can be critical for diagnosing any problems.
Troubleshooting the Appointment Booking System

This section provides some recommended values for the various setup configurations as well as providing a checklist that you can run through if problems occur when using the ABS.

Before beginning the checks, note that all of the following settings are required for running the ABS:

- Service region for each activity
- Earliest Start and Latest Start values for each activity
- Server key mappings
- Time windows
- Parameter set
- Parameters:
  - Month Start Date
  - Week Start Day
  - ABS - Days to Start
  - ABS - Days to End
  - Optimizer - Default Priority

Service Region Configuration

Service regions should have the following items:

- A defined schedule
- A defined time window
- A defined parameter set
- Employees who are assigned to a service region and have a schedule defined for them.
- ZIP codes that are associated with the service region. This configuration allows service regions to be automatically associated with activities.

Activity Configuration

Activities that need to be scheduled should have the following items:

- A defined service region
- A specified duration and work time. For testing purposes, set the duration and work time to 30 minutes.
  
  **NOTE:** Work time can be less than or equal to the duration of the activity.

- A cleared Lock Schedule check box on the Activities screen > Activity List > Schedule view. If you are using Assignment Manager, clear the Lock Assignment check box also.
A selected Allow Breaks check box if the activities are long (they span more than a day, or the schedules have breaks in them).

Appointment Booking System Parameter Set Configuration
The parameter values for the ABS should be set as described in Table 37.

Table 37. Recommended ABS Scheduling Parameter Values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Recommended Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month Start Date</td>
<td>This value should generally be set to 1. This is primarily relevant if you are using constraints around monthly capacity.</td>
</tr>
<tr>
<td>Week Start Date</td>
<td>This value should generally be set to 1. This is primarily relevant if you are using constraints around weekly capacity.</td>
</tr>
<tr>
<td>ABS - Days to Start</td>
<td>This value should be set to at least 1. You can also set this 0, which allows booking on the same day.</td>
</tr>
<tr>
<td>ABS - Days to End</td>
<td>This value should be greater than ABS - Days to Start, but less than 60. Setting this to a higher value will result in longer loading times and may run over the 10,000 record limit.</td>
</tr>
<tr>
<td>ABS - Logging Level</td>
<td>This value is the logging level for ABS, which is separate from the general logging level. Typically this is set to 3, but when problems are encountered, set it to 4.</td>
</tr>
<tr>
<td>ABS - Default Number of Slots</td>
<td>This value should generally be between 5 to 10.</td>
</tr>
<tr>
<td>ABS - Timeout</td>
<td>This value should generally be set to 5.</td>
</tr>
<tr>
<td>Use Assignment Manager</td>
<td>If Assignment Manager is being used, this value is set to 1. For debugging purposes it can be set to 0, in which case, all employees in the service region who are on duty will be considered.</td>
</tr>
</tbody>
</table>

Schedule Configuration
For testing purposes, create a simple 9 A.M. to 5 P.M. schedule for both employees and the service region.

**NOTE:** The service region schedule overrides the employee schedule. If the service region schedule indicates that there should be no work carried out over weekends, then employees will not be scheduled, even if their schedules indicate weekend work.

Employee Configuration
All employees in the service region should have defined schedules. For those employees who do not currently have a defined schedule, use a schedule that has no times defined. You could call this Empty Schedule, for example.

**NOTE:** If Assignment Manager is being used, the employees should have the appropriate skills.
**Time Window Configuration**
Time windows should be set up contiguously, large enough to cover the maximum activity duration attempting to be scheduled.

**Server Key Mapping Configuration**
- Verify that the Appointment Booking Engine server component (ApptBook) for the service region is mapped to the correct Siebel Server.
- Check the total number of unique servers being used as this information is used when setting the ABS Server Parameters. See "Appointment Booking System Server Component Parameter Configuration."

**Appointment Booking System Server Component Parameter Configuration**
The server component task parameters should be set as described in Table 34.

**Assignment Rule Configuration**
This section applies if you are using Assignment Manager.
- Check all assignment rules. In each of them, the Check Employee Calendar check box should be cleared. It is not used for the ABS.
- Try to assign the activity by using Assignment Manager in interactive assignment mode. You perform this assignment by selecting an activity record (on the Activities screen > List view), clicking the menu button on the Activity form and selecting the Assign option. The result returned should be a list of candidates for that activity, if the Assignment Manager rules are set up correctly.
- For debugging purposes, it is recommended that you disable the Assignment Manager. This can be done by setting the Use Assignment Manager parameter to 0. See "Appointment Booking System Parameter Set Configuration" on page 161 for more information.

**Appointment Booking System Constraint Set Configuration**
Constraint sets can be a cause of loading or booking problems if the constraints are contradictory. For testing purposes, set the constraint set in the service region to blank and then check whether the problems are fixed.

**Disabling Scripting on the Activity Business Object**
If you have checked all the configuration values listed in the preceding sections and the problem still exists, try disabling the scripting on the Activity business objects.

**CAUTION:** The Action business component has a number of data integrity checks on it. Overriding or removing these checks can introduce subtle errors into the scheduling process.

The following recommendations should be noted when changing the Activity business objects, particularly the Action business component:
Do not change the code around work time and duration.
Be careful not to disable calculated field logic.

Troubleshooting the Optimizer

Before beginning the checks, note that all of the following settings are required for running the Optimizer:

- A service region
- Server key mapping
- Cost function
- Cost list
- Travel cost
- Minimum travel time
- Travel U/M
- Parameter set
- Parameters:
  - Optimizer - Activity Category
  - Optimizer - Default Priority
  - Optimizer – Glued
  - Optimizer – Save Interval
  - Optimizer – Tardiness Cost
  - Optimizer – Task Excl Cost
  - Optimizer – Timeout

**NOTE:** See “Creating Parameter Sets for Scheduling” on page 127 for more information about setting the values for these parameters.

The Optimizer has the following additional requirements:

- An activity cannot span more than one day; multiday activities are not scheduled. The Optimizer can schedule other activities during the time intended for multiday activities. However, the penalties for not scheduling these activities still contribute to evaluating the potential success of an optimized schedule. See “Defining Cost Functions for the Optimizer” on page 134 for more information.

- Activities that cross between the end of the Optimizer horizon and the ABS horizon are treated as locked by both the ABS and the Optimizer.
When loading activities into the Optimizer cache for the first time, the Optimizer produces an initial solution to the schedule by accepting the existing order and assignment of appointments. While finding the initial solution, the Optimizer first processes the activities that have Lock Assignment and Lock Schedule flags set to TRUE. This helps to ensure that these requests are honored in the optimized schedule. See “Locking Schedules and Assignments (End User)” on page 153 for more information.

While the schedule for a service region is being optimized, only Insert Activity and Stop Optimization requests are accepted. These are queued, and the queue is processed when the optimization finds the next solution. Any other request is returned. See “Running Contract Scheduling (End User)” on page 157 and “Stopping the Optimization of a Service Region” on page 157 for more information.

**Guidelines for Obtaining Good Optimization Results**

The following recommendations can help you to obtain good optimization results at the best speed:

- The most important way to return good results from the Optimizer is to make sure that it is on its own process within the server key mappings.
  
  Run the Optimizer when the server is under a light load, preferably overnight. See “Setting Up Server Key Mappings” on page 136 for more information.

- Examine the schedule parameters’ Optimizer heuristic settings.

  In general, a higher number produces a better result quality, but it takes longer to find a solution. Most companies find that setting the Optimizer heuristic parameters to 5 or 6 and running the Optimizer for three to four hours (determined by the Optimizer - Timeout parameter) to be sufficient. See “Creating Parameter Sets for Scheduling” on page 127 and “Heuristics for the Optimizer” on page 100 for more information.

- Check the service region setup as more constraints lead to a faster solution.

  Optimizer frames the scheduling problem as a solution space to explore and find the best answer. More constraints mean that the solution space is smaller, therefore the Optimizer has to explore fewer permutations to arrive at the best solution. See “Defining Service Regions” on page 109 for more information.

- Subdividing your field service engineers into types also helps to speed up optimization.

  For example, a cable company had several different activity types (cable install, cable problems, cable modem install, and cable modem problems), with service engineers keyed to those types. Even within a large service region of over 50 people, the company could receive optimum solutions quickly because the engineers were divided in this way. This was because the Optimizer was solving several small problems instead of one large one.
Optimizer Parameter Set Configuration

The parameter values for the Optimizer should be set as described in Table 38.

Table 38. Recommended Optimizer Parameter Values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Recommended Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimizer - Save Interval</td>
<td>This value should generally be set to 15</td>
</tr>
<tr>
<td>Optimizer - Logging Level</td>
<td>This value should generally be set to 3, unless diagnosing a problem.</td>
</tr>
<tr>
<td>Optimizer - Optimize Heuristic</td>
<td>This value should generally be set to 5. Set this higher for more accurate results, lower for faster results.</td>
</tr>
<tr>
<td>Optimizer - Timeout</td>
<td>This value should generally be set to 180. Three hours should be enough to find a good solution.</td>
</tr>
<tr>
<td>ABS - Days to Start</td>
<td>This value should generally be set to 1. This controls how many days out the schedule is optimized. Setting this to higher than 5 will greatly increase memory usage, and is not recommended.</td>
</tr>
<tr>
<td>Month Start Date</td>
<td>This value should generally be set to 1. This is primarily relevant if you are using constraints around monthly capacity.</td>
</tr>
<tr>
<td>Week Start Day</td>
<td>This value should generally be set to 1. This is primarily relevant if you are using constraints around weekly capacity.</td>
</tr>
<tr>
<td>Optimizer - Glued</td>
<td>This value should generally be set to 120. This is primarily relevant if you are doing Contract Scheduling during the day instead of batch scheduling overnight.</td>
</tr>
<tr>
<td>Optimizer - Default Priority</td>
<td>This value should generally be set to 3.</td>
</tr>
<tr>
<td>Optimizer - Consider Parts</td>
<td>This value should generally be set to 0.</td>
</tr>
<tr>
<td>Optimizer - Task Excl Cost</td>
<td>This value should generally be set to 500. This ensures that tasks are not dropped from the schedule unless absolutely necessary.</td>
</tr>
<tr>
<td>Optimizer - Hard Latest Start</td>
<td>This value should generally be set to 0.</td>
</tr>
<tr>
<td>Use Assignment Manager</td>
<td>This value should be set 1 if using skills to restrict candidates.</td>
</tr>
</tbody>
</table>

About Configuring the Appointment Booking Display

You can change the information displayed in the Book Appointment dialog box, as well as the format in which this information is displayed, to suit your company requirements.
The following are some suggestions on changing the displayed information:

- **By default, the employee is not shown together with the available time slots.** This is because many service companies, particularly those scheduling partners or people working on commission, do not want to allow employees to see the names of the field service engineers being scheduled. This can help avoid favoritism. If a company does want to display the employee names together with the available time slots, the administrator must expose employees within the Abs Result Pick Applet.

- **By default, the Book Appointment dialog box displays the start and end times of the time window.** The time windows are generally longer than the actual duration of the activity. Set the time window to equal the length of the activity if you want to allow customer service representatives to view the exact times for the activities instead of the time window ranges.

  **TIP:** Planned Start and Planned End are available in the Abs Result Pick Applet's list columns. However, for these to be displayed on the user interface, the corresponding applet Web template items (Planned End, Planned End - SR Time Zone, Planned Start, and Planned Start - SR Time Zone) must be activated. These Web template items are inactive by default.

  **NOTE:** You can change the time window values in the Administration - Scheduling screen > Time Windows List view. See “Creating Time Windows for Scheduling” on page 121 for more information.

- **To force the return of only one time slot per employee,** set the Earliest Start and Latest Start for the activity to less than the time window (see “Adding Schedule Information for Activities (End User)” on page 148 for more information). For example, if the time window is 40 minutes, setting the Earliest Start to 11 A.M. and the Latest Start to 11:30 A.M. will ensure that only one slot is returned for each employee with the available time and appropriate skills.

**Why Would Time Slots Not Be Displayed to Users?**
Occasionally, users may state that they are not seeing time slots when they know some are available. Assuming that time slots are definitely available and the skills required are correct, this situation can occur because the time slots are being held. Time slots are held for the customer service representative viewing them until the representative clicks Cancel or the ABS timeout limit has been reached (see Table 29 on page 128 for more information about the ABS - Timeout parameter). When only a few time slots are left, one user may hold them all.

To mitigate this, in high-volume call centers, it may be more appropriate to set the ABS - Timeout parameter to a low value—for example, one minute. Alternatively, you can also reduce the value of the ABS – Default Number of Slots parameter so that fewer slots are offered to each user.

**About Enhancing the Performance of Siebel Scheduler**

Every Siebel server can run one or more service regions. Large service regions can run on a dedicated server.
Each service region can run on only one application server. This allows the information for one service region to be cached within memory instead of being continually read from the database, reducing the load placed on the database during schedule optimization.

**CAUTION:** It is recommended that you place no more than 400 service regions on one physical server. This is due to the limitations on the Server Request Broker scalability. See “About the Relationship of Scheduler to the Server Request Broker” on page 167 for more information. If your service regions are going to exceed that amount for the ABS or Optimizer, you must test performance and scalability carefully.

The ABS and Optimizer interact with the database only at these times:

- **Data loading.** The ABS and Optimizer read large amounts of information from the database on start up, or when the service region is reloaded. For more information, see “About Loading and Reloading Service Region Data” on page 169. For this reason, it is best to avoid reloading during a busy time.

- **Saving schedules.** The Optimizer can save its result sets to the database at specified time intervals, but unless this is a very large data set, it should not noticeably affect database performance. For more information, see the parameter, Optimizer – Save Interval in Table 29.

**CAUTION:** Although it is acceptable for testing, it is recommended that you keep the Object Manager and the Scheduler components on separate machines in a production environment. This prevents spikes in user activity from interfering with the Scheduler operations.

### Guidelines for Balancing the Service Region CPU Load

In general, you should have a number of processes up to or equal to the number of CPUs on the server, as the operating system (OS) generally farms the work out on each process to a separate CPU. If you have a small number of service regions, it is recommended that you have each service region on a separate process number within a server. When you have more service regions than CPUs, and when each service region is approximately the same size, divide them equally across the processes. If the service regions are not equal, balance them according to size. For example, put a 50-person service region on Process 1 and two 25-person service regions on Process 2. Another way to load balance is to look at the amount of time to load and aim for an equivalent amount of load time on each process.

**NOTE:** You cannot specify which CPU a process works on. The OS does this specification; it generally has its own algorithms to maximize performance in a multi-CPU environment.

### About the Relationship of Scheduler to the Server Request Broker

When a request is made to Scheduler (through the user interface or the application program interface [API]), the call is routed to the correct server by the Server Request Broker (SRB) in the following way:
Setting Up and Using Scheduling

About the Relationship of Scheduler to the Server Request Broker

1. When the ABS server is started, it loads all the activities into the cache. It registers all the unique service region keys in the Siebel Server’s shared memory file. SRB uses the information stored in shared memory to determine which components are up and running. No SRB threads are established at that time.

2. At the first attempt to connect to a service region (for example, a Book Appt request from a client), the Object Manager contacts the SRB on the Object Manager machine. That SRB sends the BookAppt request to the SRB on the ABS server. After the first request is submitted to the particular region, the SRB on that server establishes a connection to the local ABS.

3. The response is sent from Scheduler to the SRB on the service region machine. The SRB then sends the response to the SRB on the Object Manager machine. Then, the SRB on the Object Manager machine relays that response to the Object Manager.

4. Subsequent connections from any Object Manager are made by each local SRB connecting to the SRB on the service region’s machine. Responses are similarly passed back through the two SRBs. The Object Manager connects to the Server Request Broker only; if there is a connection between the SRB and the ABS on the local machine, then it does not open another connection to the ABS.

5. Assignment Manager, if used, is contacted by the ABS using the SRB mechanism. Having multiple rule sets does not affect the routing. Assignment Manager has a default rule set that is always used whenever no rule set is defined.

The only persistent SRB threads are on the machine containing the SRB and the service regions on that machine.

For example, assume you have three servers in the enterprise. The Object Manager and an SRB are running on Machine 1. Machines 2 and 3 have SRBs and four processes of ABS running on them with 16 separate service regions (two for each ABS process). The user connects and books an appointment on each of the service regions. At this point, the environment should look like the following:

- All SRBs on all machines should have the server key maps for all 16 service regions within their cache.
- Machine 2’s SRB has eight open threads to the four ABS processes (two each). Each ABS service region is listening on a unique port for calls from the Machine 2 SRB. Because there is unique port per service region in the ABS process, there is one connection (thread) from the Machine 2 SRB to that port on ABS.
- Machine 3 should appear the same as Machine 2.
- Machine 1 only has connections to the SRBs on Machines 2 and 3. The SRB on Machine 1 does not connect directly to the ABS on other machines, as that would defeat the purpose of brokering.

When Scheduler shuts down, the keys are deregistered in shared memory and the connection between SRB and Scheduler is lost. If there are any Sync requests for Scheduler it fails and the user receives an error. If the request is an Async request stored in the database, it remains in QUEUED state until Scheduler is brought back up and the Service Request Processor (SRP) or the SRB then routes it accordingly.
About Loading and Reloading Service Region Data

Because the service region information is cached, it must be loaded into the caches from the database when the service is started periodically to synchronize updates. Initial loading and reloading of data are automatic processes. The data for a service region is copied automatically to the caches each time the server is restarted, and manually by clicking the Load buttons. Repeat component jobs can also load service region data automatically, using the Appointment Booking System business service. See “Reloading the Appointment Booking System Cache Using Workflows” on page 146 and “About Troubleshooting the Appointment Booking System and Optimizer” on page 159 for more information.

Every night, information needs to move from the ABS (future) cache into the Optimizer (present) cache. For example, if today is July 1st, then the Optimizer horizon holds all activities from July 1st to July 7th. The ABS horizon is defined as 14 days, so the ABS cache holds from July 8th to July 15th. Note that both horizons are measured from the beginning of the Glued period. The end of the Optimizer horizon is set to the same calendar day (at midnight) as the start of the ABS horizon.

After it becomes July 2nd, the old July 1st data is no longer necessary; it is in the past and is discarded. At the same time, the Optimizer horizon is still looking seven days out, so it needs to load the July 9th data into the Optimizer cache. However, before the data can be loaded into the Optimizer cache, it must be unloaded from the ABS cache. If it is in both caches at the same time, it could be changed in both engines simultaneously. Therefore, the activities and data for July 9th are released from the ABS cache, and then loaded into the Optimizer cache.

When a service region is being loaded, it is not available for requests. The request is returned with a return code.

At the first load of data from a service region, the Optimizer assumes that the data coming from the database was previously optimized. So while generating an initial solution, it tries to keep the assignee as well as the sequence of activities for each field service engineer. It also keeps the time stamp of this load in the cache.

What Happens When a Service Region is Reloaded to the Appointment Booking System?

When a service region is reloaded, the ABS does the following:

1. Queries for employees currently in the service region
2. Pulls the schedule for both the service region and each employee
3. Queries for any exceptions for employees
4. Constructs a master schedule

First, the ABS applies the service region schedule for all employees. It then applies a schedule for each employee.

**NOTE:** The service region schedule overrules both employee schedules and employee exceptions. For example, if the service region schedule does not indicate that the company operates on Sundays, activities are never scheduled for this day. This is an advantage of setting a liberal service region (24 hours): you can set exceptions like employees being able to work on Sundays.

5. Reads in any constraints

6. Queries for any activities in the next 15 days—the horizon is usually set at the start time of the day (00:00:00 A.M.).

The ABS does not load historical activities unless a weekly or monthly constraint is defined for the service region. If only weekly constraints are defined, the ABS loads one more week of data; if monthly constraints are defined, it loads one more month of data. However, when no weekly or monthly constraints are defined, the ABS only loads activities within the ABS horizon.

The query appears as follows:

Planned Start > ABS Load Range End and Planned End < ABS Load Range Start

The ABS attempts to place the activities in the schedule in the following order:

- Activities with the Locked Schedule and Lock Assignment flags set to TRUE
- Activities with the Locked Schedule flag set to TRUE
- Activities with the Locked Assignment flag set to TRUE
- Activities with the Locked Schedule and Lock Assignment flags set to FALSE

If two activities that are both locked for schedule and assignment overlap, only the first activity attempted is scheduled. The second is set as unscheduled.

On loading, the ABS generally attempts to insert the activities exactly as they were stored in the database. If nothing has changed (same employees, same schedules, no manual changes), the activities in the cache are exactly the same. However, if changes have occurred, the ABS will attempt to reschedule activities to counteract this. After the initial load completes, the ABS follows the rules below to reschedule any remaining appointments:

- Earliest Start/Latest Start must be respected.
- Locked Schedule/Locked Assignment flags must be respected.

If the ABS can find an open spot for an activity, the Owner, Planned Start, and Planned End are updated within the cache and written to the database. If an activity cannot be inserted, its status is set to unscheduled but the Owner, Planned Start, and Planned End remain unchanged. This allows a service manager to see the original time committed to the customer. The new status is written to the database and recorded in the log if the logging level is set to level 3 or above. The activity is not kept in the ABS cache.

Unless an activity is changed during the load, it is not modified within the database by the ABS. This means that if the ABS goes down, the version in the database should be consistent with the version in the cache. The exceptions to this are any manual changes made on the database side.
About Reloading Migrated Activity Data

If migrating activity data to a new system, you should use Siebel Enterprise Integration Manager (EIM). See *Siebel Enterprise Integration Manager Administration Guide* for more information.

The fields listed in Table 39 are critical for migrating the activity data.

Table 39. Fields Required for Migrating Activity Data

<table>
<thead>
<tr>
<th>Field</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earliest Start</td>
<td>Travel Time</td>
</tr>
<tr>
<td>Latest Start</td>
<td>Status</td>
</tr>
<tr>
<td>Planned Start</td>
<td>Owner</td>
</tr>
<tr>
<td>Planned End</td>
<td>Lock Assignment</td>
</tr>
<tr>
<td>Duration</td>
<td>Lock Schedule</td>
</tr>
<tr>
<td>Work Time</td>
<td>Service Region</td>
</tr>
</tbody>
</table>

When you load the ABS after migration, activities are scheduled according to the employee and service region schedule. If an activity can be scheduled to its original owner, at the original Planned Start and Planned End, no change is made to the activity data and the employee is scheduled for the particular activity. If the activity cannot be scheduled in this way, the activity is rescheduled, based on its Earliest Start and Latest Start constraints. The new Planned Start and Planned End, Owner (if such a change is required) and Status are updated on the activity.

To make sure that the migrated activities can be loaded into ABS and scheduled to their original Planned Start, Planned End, and Owner, the following conditions must be met:

- Planned End - Planned Start = Duration
- Work Time + Travel Time = Duration
  - Here travel time is the average travel time defined on Service Region, no on Activity.
- No doublebooking of the original activities occurs
  - If there is doublebooking, one of the overbooked activities is rescheduled—unless both the Lock Assignment and Lock Schedule flags are set to TRUE for the activity.
- Original activities do not violate any of the constraints for the service region
- Original activities can be fit into the service region schedule and employee schedule (Working Hours)

About Using Application Deployment Manager

For information on Field Service customization using the Application Deployment Manager (ADM), see *Siebel Application Deployment Manager Guide*.
## About the Dispatch Board

The Dispatch Board screen provides a drag-and-drop interface for selecting field service engineers to carry out activities and manual scheduling of these activities.

Generally, businesses use the Dispatch Board for:

- **Local dispatch.** The Dispatch Board is used by a local business to enable the manual scheduling of activities by a local service manager. In this case, the dispatcher is familiar with the territory (or territories) as well as the employees.

- **Centralized dispatch.** The Dispatch Board is used by a geographically disperse business with a centralized, dedicated dispatch team. The dispatch personnel search for and schedule employees based on their skill and proximity to activities.

See About Process Flows for Dispatch Board Scheduling on page 174 for more information about the two methods of dispatch.
About Process Flows for Dispatch Board Scheduling

Figure 3 shows two process flows: one for a local dispatch business scenario and one for a centralized dispatch business scenario. In a local dispatch scenario, the dispatcher creates an activity, creates an activity plan, and then schedules an activity. In the centralized dispatch scenario, the dispatcher searches for activities and then assigns activities. This section provides details about each procedure in the two processes.

Scheduling Activities (Local Dispatch)
Local dispatchers can schedule an activity by performing the following procedures:

1. Creating an activity. See “Recording Field Service Activities” on page 75 for more information.
2. Creating an activity plan. See “Field Service Activities” on page 69.
3. Scheduling an activity. See “Assigning Field Service Engineers for Activities (End User)” on page 196.

Scheduling Activities (Central Dispatch)
Activities can be scheduled in the following manner by central dispatchers:

1. Searching for activities. See “Searching for Activities in the Dispatch Board’s Gantt Chart (End User)” on page 196 for more information.
2. Assigning activities. See “Assigning Field Service Engineers with the Dispatch Board” on page 197 for more information.
Dispatch Board Screen Interface

The Dispatch Board provides a drag-and-drop interface for manual assignment and scheduling of service activities. The Dispatch Board has two sections:

- Gantt chart (top)
- Unscheduled Activities list (bottom)

To schedule activities, users drag-and-drop activities from the Unscheduled Activities list onto the Gantt chart. To unschedule activities, users drag the activity from the Gantt chart back to the Unscheduled Activities list.

Specific features of the Gantt chart and the Unscheduled Activities list can be used to improve activity scheduling.

About the Scheduling Information Displayed

The Dispatch Board queries the database for the schedule information—it does not show what is in the ABS and Optimizer caches. The Dispatch Board queries the database so that it can show any date and time range that the user wants to see. The Appointment Booking System (ABS) immediately writes any changes to the database so the activities in the database should reflect what is in the cache. The one exception to this is an activity that has been dragged and dropped across the Dispatch Board. These activities are not automatically loaded into the cache. See “Setting Up and Using Scheduling” on page 93 and “About Rescheduling Appointments in the Dispatch Board” on page 199 for more information.

Unscheduled Activities List

By default, the Unscheduled Activities list displays all activities that have a status of Unscheduled. Table 40 shows selected items in the Unscheduled Activities list.

You can view these additional lists using the Unscheduled Activities drop-down list:

- Declined
- Timed Out
- Not Acknowledged

Gantt Chart

The Gantt chart shows the scheduled and unscheduled time periods for a group of field service engineers associated with a service region.

The chart is divided by a frames boundary into left and right frames. The left frame lists field service engineers and related information that helps users select engineers for activities. The right frame shows scheduled time periods.

To see all of the information in the left frame, drag the frames boundary to the right. To sort the list of field service engineers, click the title of a column. You can also narrow the list of field service engineers by performing a query by name.
The right frame of the Gantt chart appears in a calendar format. Scheduled time periods are shown with colors that represent activity priority, status, and type. See “Setting User Preferences for the Dispatch Board” on page 178 for more information.

To zoom in or out on a particular time period, click a zoom interval (1/4, 1/2, 1, 2, or 4) on the current time bar.

Table 40 describes selected items in the Gantt chart.

Table 40. Selected Items in the Gantt Chart

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Service Region, Time Zone, and Date Shown   | These are set in one of two ways (whichever occurred last):  
  - From the application-level menu, choose Tools > User Preferences. On the link bar, click Dispatch Board. The user selects the appropriate options using the drop-down lists.  
  - Navigate to the Activities screen > Schedule view. A user arrives at the Dispatch Board by clicking an Activity Status link in the Activities screen > Schedule view. In this case, the items default to the choices made for the just-visited activity. If no service region is assigned to the just-visited activity, then the service region remains as is on the Gantt chart.  
  **NOTE:** To accurately display an employee’s schedule, the Time Zone selected on the Administration - User screen > Employees view must match the Service Region Time Zone displayed on the Gantt chart Current Time Bar. |
| Score                                       | The score calculated by Assignment Manager. For more information, see Siebel Assignment Manager Administration Guide.          |
Process of Setting Up the Dispatch Board

The following list shows the procedures that administrators typically perform to set up the Dispatch Board within Siebel Field Service. Your company may follow a different process according to its business requirements.

To set up the Dispatch Board for use by dispatchers and customer service representatives, perform the following tasks:

- Set up rules for Assignment Manager. See the chapter on assignment rules in Siebel Assignment Manager Administration Guide.

- Associate service regions and schedules with employees. See “Defining Employee Availability and Schedules” on page 116 for more information.

- Define employee exception hours. See “Setting Exception Hours” on page 108 for more information.

- Assign responsibilities to employees. See Siebel Applications Administration Guide for more information.

- Set system preferences for the Dispatch Board. See “Setting System Preferences for the Dispatch Board” on page 178 for more information.

- Set user preferences for the Dispatch Board. See “Setting User Preferences for the Dispatch Board” on page 178 for more information.

- Make any required adjustments to the cache size to optimize the display speed of the Dispatch Board. See “Optimizing Display Speeds for the Dispatch Board” on page 181 for more information.

---

Table 40. Selected Items in the Gantt Chart

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance</td>
<td>Distance = number of miles from source address to destination address</td>
</tr>
<tr>
<td></td>
<td>That is, the distance a field engineer needs to travel to get to the selected activity. A distance of -1 indicates an incomplete or incorrect source or destination address.</td>
</tr>
<tr>
<td></td>
<td><strong>Source address.</strong> If the field engineer is at an activity or is in transit, the source address is the ZIP Code of the field engineer’s current or previous activity, respectively. Otherwise, the source address is the ZIP Code of the field engineer’s start depot address.</td>
</tr>
<tr>
<td></td>
<td><strong>Destination address.</strong> The ZIP Code of the contact service location for the activity, unless there is more than one contact service location. If there is more than one contact service location, the ZIP Code of the account service location.</td>
</tr>
</tbody>
</table>
Setting Up and Using the Dispatch Board

Setting Up the Dispatch Board

1. Add users with dispatcher responsibility. See “Setting Up Dispatcher Users” on page 183 for more information.

2. Configure any enhancements required for the dispatchers to efficiently perform their job. See the following sections for more information:
   - Displaying Additional Information on the Dispatch Board Y-Axis on page 183
   - Adding Drilldowns to the Dispatch Board on page 185
   - Adding Query Fields to the Dispatch Board on page 187
   - Changing the Label Information Displayed on the Dispatch Board on page 188
   - Changing the Time Zoom Intervals on the Dispatch Board on page 189
   - Changing the Days of the Week Displayed on the Dispatch Board on page 190
   - Enabling Applets for Drag and Drop onto the Dispatch Board on page 191
   - Adding User Preference Colors for the Dispatch Board on page 192
   - Optimizing Display Space on the Dispatch Board on page 193
   - Restricting the Employees that Display on the Dispatch Board on page 194

Setting System Preferences for the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

The Dispatch Board allows a dispatcher or customer service representative to drag an activity from the Unscheduled Activities list to a block of time and employee in the Gantt chart. If the service region of the activity is different from the service region selected for the Gantt chart, the result depends on the setting of the system preference FSDB:Override Service Region:

- If the value of the system preference is TRUE, then the dispatcher can drop the activity on the Gantt chart and the service region for the activity is automatically changed to the service region selected for the Gantt chart.

- If the value is FALSE, then the dispatcher cannot drop the activity on the Gantt chart and an error is returned.

Setting User Preferences for the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

Field Service provides control over many aspects of the Gantt chart. To change these settings, on the Dispatch Board screen, click the menu button and then choose User Preferences.
Table 41 describes the settings for the Gantt chart.

Table 41. Options for the Gantt Chart

<table>
<thead>
<tr>
<th>Group/Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Time Value</td>
<td>Sets the timespan (for example, one day) that can be viewed without scrolling:</td>
</tr>
<tr>
<td></td>
<td>- Year</td>
</tr>
<tr>
<td></td>
<td>- Month</td>
</tr>
<tr>
<td></td>
<td>- Week</td>
</tr>
<tr>
<td></td>
<td>- Day</td>
</tr>
<tr>
<td></td>
<td>- 6 Hours</td>
</tr>
<tr>
<td></td>
<td>- 4 Hours</td>
</tr>
<tr>
<td></td>
<td>- 2 Hours</td>
</tr>
<tr>
<td></td>
<td>- Half Hour</td>
</tr>
<tr>
<td></td>
<td>- Quarter Hour</td>
</tr>
<tr>
<td>Minor Time Value</td>
<td>Sets the time increments (for example, 24 one-hour slots) of the Major Time Value:</td>
</tr>
<tr>
<td></td>
<td>- Year</td>
</tr>
<tr>
<td></td>
<td>- Month</td>
</tr>
<tr>
<td></td>
<td>- Week</td>
</tr>
<tr>
<td></td>
<td>- Day</td>
</tr>
<tr>
<td></td>
<td>- 6 Hours</td>
</tr>
<tr>
<td></td>
<td>- 4 Hours</td>
</tr>
<tr>
<td></td>
<td>- 2 Hours</td>
</tr>
<tr>
<td></td>
<td>- Hour</td>
</tr>
<tr>
<td></td>
<td>- Half Hour</td>
</tr>
<tr>
<td></td>
<td>- Quarter Hour</td>
</tr>
<tr>
<td>Start Day at</td>
<td>The start time for a workday. The default is 7 A.M. The format is 09:00:00 A.M. If you display the time in hour (or shorter) increments on the Dispatch Board, the Start Day at and End Day at fields determine the time period that displays on the Dispatch Board and thus the time period in which you can schedule activities. If you display time in longer time increments, this field has no effect. For example, if you display day time increments, you can schedule activities only at the beginning of the day (12:00 A.M.)</td>
</tr>
</tbody>
</table>
Setting Up and Using the Dispatch Board

Process of Setting Up the Dispatch Board

1. **End Day at**
   - The end time for a workday. The default is 7 P.M. The format is 05:00:00 P.M.

2. **Service Region and Date Shown**
   - These are set in one of two ways (whichever occurred last):
     - From the application-level menu, choose Tools > User Preferences. On the link bar, click Dispatch Board. The user selects the appropriate options using the drop-down lists.
     - Activities screen > Schedule view. A user arrives at the Dispatch Board by clicking an Activity Status link in the Activities screen > Schedule view. In this case, the items default to the choices made for the just-visited activity.

3. **Color Scheme**
   - Sets the colors of the time bars representing scheduled activities. To apply a color scheme, select the values in the activity fields (Activity Priority, Activity Status, and Activity Type) and select a color for each value. To designate the color of the body of the bar, select an activity field as the Major Color Scheme. To designate the color of the border of the bar, select an activity field as the Minor Color Scheme.
   - **NOTE:** When you select the values in the activity fields and the corresponding colors, your selections are automatically saved.

4. **Enable Default Colors**
   - When selected, the default color scheme overrides the user preferences and the Grid Object defaults to the account name.

5. **Activity Priority**
   - For each activity priority value, select a corresponding color.

6. **Activity Status**
   - For each activity status value, select a corresponding color.

7. **Activity Type**
   - For each activity type value, select a corresponding color.

8. **Major Color Scheme**
   - Determines the body color of the time bars for the selected activity field.

9. **Minor Color Scheme**
   - Determines the border color of the time bars for the selected activity field.

10. **Grid Object**
    - Determines the text displayed on the time bars for the selected activity field. When Enable Default Colors is selected, the Grid Object displays the account name by default.

11. **Display Current Time**
    - Displays a vertical line in the Gantt chart representing the service region’s current time.

12. **Display Earliest/Latest Start**
    - When selected, highlights (in yellow) the start time range for an unscheduled activity on the Minor Time Value bar of the Gantt chart.

---

**Table 41. Options for the Gantt Chart**

<table>
<thead>
<tr>
<th>Group/Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Day at</td>
<td>The end time for a workday. The default is 7 P.M. The format is 05:00:00 P.M.</td>
</tr>
<tr>
<td>Service Region and Date Shown</td>
<td>These are set in one of two ways (whichever occurred last):</td>
</tr>
<tr>
<td></td>
<td>- From the application-level menu, choose Tools &gt; User Preferences. On the link bar, click Dispatch Board. The user selects the appropriate options using the drop-down lists.</td>
</tr>
<tr>
<td></td>
<td>- Activities screen &gt; Schedule view. A user arrives at the Dispatch Board by clicking an Activity Status link in the Activities screen &gt; Schedule view. In this case, the items default to the choices made for the just-visited activity.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> When you select the values in the activity fields and the corresponding colors, your selections are automatically saved.</td>
</tr>
<tr>
<td>Color Scheme</td>
<td>Sets the colors of the time bars representing scheduled activities. To apply a color scheme, select the values in the activity fields (Activity Priority, Activity Status, and Activity Type) and select a color for each value. To designate the color of the body of the bar, select an activity field as the Major Color Scheme.</td>
</tr>
</tbody>
</table>
Optimizing Display Speeds for the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

To speed up display of the Dispatch Board, the Dispatch Board user interface component gets activity data from a cache rather than from the database. You can further improve the Dispatch Board’s display speed by changing the cache size.

With a large cache, a user can retrieve more data without accessing the database. Thus, a large cache size increases the display speed of the Dispatch Board. However, a larger cache also requires more server memory.

Therefore, to determine the optimal cache size, consider the following factors:

- Cache size is the number of entries in the cache. The default is 300, the maximum is 2000 entries, and the minimum is 200 entries.

- Dispatch Board uses a session (or per user) cache, so that each user has an individual activity cache.

- An entry stores a list of the activities for an employee on a particular day. Thus, as the number of employees and viewable days in the Gantt chart increases, the cache size needs to be increased to avoid a slowdown in display speed. You can calculate an appropriate cache size (before adjusting for memory considerations) as follows:

\[(10 \text{ Employees} \times 14 \text{ Viewable days}) + 60 \text{ Redundancy} = 200 \text{ entries}\]
Memory required by the cache is a function of the number of entries, the number of activities per entry, and the number and data type of ToolTip fields.

To change the cache size
1. Log into Siebel Tools as an administrator.
3. Query for the name FS Activity Cache.
4. Go to the child object Business Service User Prop.
5. Query for the name Cache Size.
6. Change the default value for cache size and then click Save.

Clearing Cached Activity Data

To speed up display of the Dispatch Board, the Dispatch Board user interface component gets activity data from a cache rather than from the database. The activity data in the cache table is duplicate data created during a user session.

You can clear the data manually at any time by invoking the clean up service, the FS Activity Cache business service. The FS Activity Cache business service uses a CleanUpCacheTable method, which takes no input or output arguments. This method clears the contents of the cache table. To clear the cache table, it is recommended that you call this method nightly during operations downtime or during low usage periods.

There are two common ways in which an administrator can invoke this business service:

- Set up a repeating component job. See Siebel System Administration Guide for more information on creating repeating component jobs.
- Use the business service simulator. See "Using the Business Service Simulator to Clear the Cache" for more information.

Using the Business Service Simulator to Clear the Cache

Perform the following procedure to clear the Dispatch Board cache from the business service simulator.

To clear the Dispatch Board cache from the business service simulator
1. Navigate to the Administration - Business Service screen > Simulator view.
2. In the Simulator list, create a new record.
3. In the Service Name field, click the select button and choose FS Activity Cache.
   NOTE: The display name for this service is Field Service Activity Cache Service.
4. In the Method Name field, click the select button and choose CleanUpCacheTable.
5 Click Run.

The business service method runs, clearing the data from the Dispatch Board cache table.

### Setting Up Dispatcher Users

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

Field Service provides responsibilities for employees, showing only the views needed to complete their job. There is a responsibility for a dispatcher, who can assign activities to service engineers. See *Siebel Applications Administration Guide* for more information about responsibilities and visibility.

**To add a user with the responsibility of a dispatcher**

1. Navigate to the Administration - Application screen > Responsibilities view.
2. In the Responsibilities list, select the Dispatcher record. If this record is not in the list, create a new record with the responsibility of Dispatcher.
3. To add the name of the employee who will take the Dispatcher’s role, add a new record on the Users list.
4. In the Views list, make sure that the selected user has access to the following views:
   - FS AxGanttChart View
   - FS AxGanttChart Declined View
   - FS AxGanttChart Timed Out View
   - FS AxGanttChart Not Acknowledged View

### Displaying Additional Information on the Dispatch Board Y-Axis

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

Generally, employee names are displayed on the y-axis of the Dispatch Board. If dispatchers want to see additional information displayed here, the administrator must configure the Dispatch Board.

The following example procedures describe how a new work phone number field is added to the Dispatch Board’s y-axis information.

See *Using Siebel Tools* for more information on performing configuration tasks with Siebel Tools.

To display phone number information on the Dispatch Board y-axis, perform the following tasks:

1. Creating a New Field on the Business Component on page 184
2. Creating the Applet User Property on page 184
3. Creating the Applet Controls on page 185
Creating a New Field on the Business Component
Perform the following procedure to create a new field on the Employee business component.

To create a new field on the business component
1. Log into Siebel Tools as an administrator.
2. Lock the Employee project for editing.
4. Query for the Employee business component.
5. Navigate to Business Component > Field and query for the Phone # field.
6. Copy the record and name the new record Phone.

**CAUTION:** The hash symbol (#) is used as a special character in the Dispatch Board user properties, so do not include it in the name of any new fields created for use with the Dispatch Board.

Creating the Applet User Property
Perform the following procedure to create a new applet user property called Y-Column7.

To create the applet user property
1. Lock the FS Dispatch Board project for editing.
2. Navigate to Object Explorer > Applet.
3. Query for the FS DB Planned GanttChart AX Applet.
4. Navigate to Applet > Applet User Prop.

**NOTE:** If Applet User Prop is not visible, go to View > Options, select the Object Explorer tab and then select the Applet User Prop object definition.
5. Query for Y-Column*, making sure to include the wildcard asterisk symbol (*).
   All the Employee business component Y-columns currently displayed in the Dispatch Board are listed in order.
6. Copy the Y-Column3 record and update the new record’s fields as follows:
   a. Enter Y-Column7 as the name for the record.
b Enter #YC-Phone#Phone#Y#Phone#N#50# in the Value field.

The information mappings for the Value field are as follows:

#Control Name#Field Name#Sortable(Y/N)#Sort Field Name#Drilldownable(Y/N)#Pixel Width(a number)#

The value field’s information mappings are also described in the Comments field.

Creating the Applet Controls
Perform the following procedure to create new applet controls called YC-Phone and Phone.

To create the applet controls
1 Query again for the FS DB Planned GanttChart AX Applet.
2 Navigate to Applet > Control.
3 Create a new record and update the fields with the following information:
   a Enter YC-Phone as the name for the record.
   b Enter Phone as the value for the Caption - String Override field.
4 Create another new record and update the fields with the following information:
   a Enter Phone as the name for the record.
   b Enter Phone as the value for the Caption - String Override field.
   c Enter Phone # as the value for the Field field.

Compiling and Viewing the New Field
Perform the following procedure to compile and view the new field on the Dispatch Board.

To compile and view the new field on the Dispatch Board
1 Compile the objects that were edited (the Employee business component and the FS DB Planned GanttChart AX Applet).
2 Replace the Siebel Repository File (SRF).
3 Restart the client and navigate to the Dispatch Board screen.
4 Drag the Dispatch Board divider bar to the right to display the new field on the y-axis.

Adding Drilldowns to the Dispatch Board
This task is a step in “Process of Setting Up the Dispatch Board” on page 177.
Dirlldowns can be added to the Dispatch Board to help streamline navigation to and from this screen. In the following example procedures, a drilldown is configured for the Phone field added in “Displaying Additional Information on the Dispatch Board Y-Axis” on page 183.

See *Using Siebel Tools* for more information on performing configuration tasks with Siebel Tools.

To allow users to drilldown on the new Phone field, perform the following tasks:

1. **Allowing Drilling Down on the Applet User Property on page 186**
2. **Creating the Drilldown Object on page 186**
3. **Compiling and Viewing the New Drilldown Object on page 187**

### Allowing Drilling Down on the Applet User Property

Perform the following procedure to allow drilling down on the Y-Column7 applet user property.

**To allow drilling down on the applet user property**

1. Log into Siebel Tools as an administrator.
2. Lock the FS Dispatch Board project for editing.
3. In the Object Explorer, navigate to Applet.
4. Query for the FS DB Planned GanttChart AX Applet.
5. Navigate to Applet > Applet User Prop.
6. Query for Y-Column7. This record was added in “Creating the Applet User Property” on page 184.
7. In the Value field of this record, change the text so that it reads as follows:

   #YC-Phone#Phone#Y#Phone#Y#50#

   The information mappings for the Value field are as follows:

   #Control Name#Field Name#Sortable(Y/N)#Sort Field Name#Drilldownable(Y/N)#Pixel Width(a number)#

   The Value field’s information mappings are also described in the Comments field.

### Creating the Drilldown Object

Perform the following procedure to create a new Phone drilldown object.

**To create the drilldown object**

1. Navigate to Applet > Drilldown Object.
2. Create a new record and update the fields with the following information:
   a. Enter Phone as the name of the record.
   b. Enter Phone as the Hyperlink Field value.
Setting Up and Using the Dispatch Board

Process of Setting Up the Dispatch Board

- Enter Employee List More Info View as the View value.
- Enter Id as the Source Field value.
- Enter Employee as the Business Component value.
- Enter Id as the Destination field value.

**NOTE:** In the applet control, the control name and the field name must match so that users can successfully drill down from the Dispatch Board.

Compiling and Viewing the New Drilldown Object

Perform the following procedure to compile and view the new Phone drilldown object on the Dispatch Board.

**To compile and view the new drilldown on the Dispatch Board**

1. Compile the FS DB Planned GanttChart AX Applet.
2. Replace the SRF.
3. Restart the client and view the changes on the Dispatch Board screen by drilling down on the Phone field. You are brought to the Employee List More Info view.

Adding Query Fields to the Dispatch Board

This task is a step in "Process of Setting Up the Dispatch Board" on page 177.

A dispatcher needs to enter specific query parameters to search for the right employee or set of employees. If the Dispatch Board’s query assistant does not include a parameter that the dispatchers need, you can add this using the following example procedures.

See *Using Siebel Tools* for more information on performing configuration tasks with Siebel Tools.

To add a query field to the Dispatch Board’s query assistant, perform the following tasks:

1. Creating the Applet Web Template Item on page 187
2. Compiling and Using the New Query Field on page 188

Creating the Applet Web Template Item

Perform the following procedure to create a new Phone Web template item.

**To create the applet Web template item**

1. Log into Siebel Tools as an administrator.
2. Lock the FS Dispatch Board project for editing.
3. In the Object Explorer, navigate to Applet.
4 Query for the FS DB Planned GanttChart AX Applet.
5 Navigate to Applet > Applet Web Template > Applet Web Template Item.
6 Create a new record and update the fields with the following information:
   a Enter Phone as the name of the record.
   b Enter Phone as the value for the Control field.
   c Enter a numeric value in the Item Identifier field.
   **TIP:** Controls are assigned unique numbers by Siebel Tools. It is recommended that you enter a high numeric value here to prevent identifiers from overlapping and causing conflict.

### Compiling and Using the New Query Field

Perform the following procedure to compile and test the new Phone Number query field.

**To compile and use the new query field on the Dispatch Board**

1 Compile the FS DB Planned GanttChart AX Applet.
2 Replace the SRF.
3 Restart the client and navigate to the Dispatch Board screen.
4 Click the menu button and select New Query.
5 Click the Query Assistant button that appears.
6 Enter a query using Phone Number.
   A successful query demonstrates that the phone number can now be used as an additional search parameter in the query assistant.

### Changing the Label Information Displayed on the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

By default, activities are displayed in the Dispatch Board Gantt chart. You may need to change the text to show other information needed for decision-making.

In the following example procedure, the Gantt chart is configured to display account names instead of activities.

See *Using Siebel Tools* for more information on performing configuration tasks with Siebel Tools.

**To change the information displayed in the Gantt chart**

1 Log into Siebel Tools as an administrator.
2 Lock the FS Dispatch Board project for editing.
3 In the Object Explorer, navigate to Applet.
4 Query for FS DB Planned GanttChart AX Applet.
5 Navigate to Applet > Applet User Prop.
6 Query for X-Foreground Text Field.
7 Change the Value field to the value that you require.
   In this example, the value is Account Name.
   **TIP:** Priority and Type are other possible values that you can enter.
8 Compile the FS DB Planned GanttChart AX Applet.
9 Replace the SRF.
10 Restart the client and view the changes on the Dispatch Board screen.
   The names of the accounts rather than the names of the activities should now appear in the Gantt chart.

### Changing the Time Zoom Intervals on the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

By default, the zoom intervals on the Dispatch Board are 1/4, 1/2, 1, 2, and 4. However, dispatchers may need to work with time frames that are larger than these defaults. You can configure the zoom intervals to different time spans, making the information display more compact. See “Setting User Preferences for the Dispatch Board” on page 178 for more information on using the time zoom intervals with the Gantt chart.

In the following example procedure, the fifth zoom interval value is configured to include a weekly zoom interval.

See Using Siebel Tools for more information on performing configuration tasks with Siebel Tools.

To change the time values displayed on the Gantt chart

1 Log into Siebel Tools as an administrator.
2 Lock the FS Dispatch Board project for editing.
3 In the Object Explorer, navigate to Applet.
4 Query for FS DB Planned GanttChart AX Applet.
5 Navigate to Applet > Applet User Prop.
6 Query for Zoom Interval* making sure to include the wildcard asterisk symbol (*).
   The query returns a series of records starting with Zoom Interval 1 to Zoom Interval 5.
7 Select the Zoom Interval 5 record, and update the Value field as follows:

#WEEK#DAY# WK#

The format for this field is:

#Major Unit Value#Minor Unit Value#3 Character Label#

The valid zoom interval values are: QUARTER HOUR, HALF HOUR, HOUR, 2 HOUR, 4 HOUR, 6 HOUR, DAY, WEEK, MONTH, YEAR

8 Select the Zoom Interval Default record and update the Value field to 5.

The valid values for Zoom Interval Default Setting are 1 to 5.

9 Compile FS DB Planned GanttChart AX Applet.

10 Replace the SRF.

11 Restart the client and view the new time intervals on the Dispatch Board screen.

Note that the fifth time interval has changed from 4 to Wk. When you click this button, the Gantt chart updates to show the information in a week and day timespan.

Changing the Days of the Week Displayed on the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

By default the Dispatch Board Gantt chart displays Monday to Friday as the days on which activities can be scheduled; Saturday and Sunday are typically excluded.

Some companies require that activities can be scheduled for employees on any day of the week, including Saturday and Sunday.

In the following example procedure, the Dispatch Board is configured to display all seven days of the week.

See Using Siebel Tools for more information on performing configuration tasks with Siebel Tools.

To display seven days of the week on the Gantt chart

1 Log into Siebel Tools as an administrator.

2 Lock the FS Dispatch Board project for editing.

3 In the Object Explorer, navigate to Applet.

4 Query for FS DB Planned GanttChart AX Applet.

5 Navigate to Applet > Applet User Prop.
6 Query for X-Display Constraint Map.
   The default value for this user property is #0#0#1#5#. This indicates that five days of the week,
   Monday (indicated by the number 1) to Friday (indicated by the number 5) are shown on the
   Gantt chart.

7 Update the Value field as follows:
   #0#0#0#6#
   These values allow the display of the 24-hour day, starting on Sunday (indicated by the last
   number 0) and ending on Saturday (indicated by the number 6).

8 Compile FS DB Planned GanttChart AX Applet.

9 Replace the SRF.

10 Restart the client and view the full week displayed on the Dispatch Board Gantt chart.

Enabling Applets for Drag and Drop onto the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

By default, only activities in the Unscheduled Activities list can be dropped onto the Dispatch Board. However, it is possible to configure additional applets so that activities on the other lists can also be dropped onto the Dispatch Board. The Dispatch Board applets can have multiple applets defined as sources for the drag-and-drop transaction in the applet's user properties.

In the following example procedure, the FS DB Timed Out Activity List Ax Applet is configured to allow users to drag and drop activities from the Timed Out Activities list onto the Dispatch Board.

See Using Siebel Tools for more information on performing configuration tasks with Siebel Tools.

To enable applets for drag and drop

1 Log into Siebel Tools as an administrator.
2 Lock the FS Dispatch Board project for editing.
3 In the Object Explorer, navigate to Applet.
4 Query for FS DB Planned GanttChart AX Applet.
5 Navigate to Applet > Applet User Prop.
6 Query for Drop Source Applet Name*, making sure to include the wildcard asterisk symbol (*).
   The query returns a series of records with user property names beginning with Drop Source
   Applet Name, for example, Drop Source Applet Name 1.
7 Create a new applet user property, the name of which starts with Drop Applet Name X, where X
   is the next increment.
   For example, Drop Applet Name 2.
Setting Up and Using the Dispatch Board

Process of Setting Up the Dispatch Board

8 In the Value field, enter the name of the applet that will be the source of the drag-and-drop event.
   In this example, the value is FS DB Timed Out Activity List Ax Applet.
9 Compile FS DB Planned GanttChart AX Applet.
10 Replace the SRF.
11 Restart the client, navigate to the Dispatch Board, and select Timed Out Activities from the visibility filter.
   You should now be able to drag and drop activities from this list onto the Dispatch Board.

Adding User Preference Colors for the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

The colors used in the Dispatch Board are defined as applet user properties. The color definitions are specified using Blue Green Red (BGR) decimal format.

Though you can add new colors for user selection on the Dispatch Board, do not change or inactivate the existing colors. The following activity fields determine the colors that display on the Dispatch Board:

- Priority (LOV type: ACTIVITY_PRIORITY)
- Status (LOV type: EVENT_STATUS)
- Type (LOV type: TODO_TYPE)

**NOTE:** Do not change or deactivate the values in the LOV types for these activity fields.

See *Using Siebel Tools* for more information on performing configuration tasks with Siebel Tools.

To add a new color to the user preferences

1 Log into Siebel Tools as an administrator.
2 Lock the FS Dispatch Board project for editing.
3 In the Object Explorer, navigate to Applet.
4 Query for FS DB Planned GanttChart AX Applet.
5 Navigate to Applet > Applet User Prop.
6 Create a new applet user property record and enter an appropriate value in the Name field.
   For example, to add a color called Blue Royal, enter the following in the Name field:
   
   #Color#Blue Royal#

7 In the Value field, enter the value that corresponds to the decimal value for that color.
   To get the decimal value for a color:
Setting Up and Using the Dispatch Board

Process of Setting Up the Dispatch Board

- Look up the hexadecimal value of the color—for example, #800000 is the HEX number for a dark blue written in BGR format.
- Convert the hexadecimal number to a decimal value—for example, the #800000 HEX number for the dark blue can be written as 128 0 0 in decimal BGR format.

8 Compile FS DB Planned GanttChart AX Applet.
9 Replace the SRF.
10 Restart the client and navigate to the Dispatch Board.
11 Click the menu button and select User Preferences.
   You should now be able to select Blue Royal as one of the color options.

Optimizing Display Space on the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

To display the optimal amount of information in the display space on the Dispatch Board, complete the following tasks:
- Change the number of rows of employee information that is displayed.
- Change the height of the display area.
  After you change the number of rows that is displayed, you must change the height of the display area to accommodate all of the rows. To determine the proper height, use the following formula:
  (23 times the number of rows) plus 84
  For example, if you change the number of rows to 20, you must change the height of the display area to 544 (23 times 20 plus 84).

See Using Siebel Tools for more information on performing configuration tasks with Siebel Tools.

To change the number of rows that display on the Dispatch Board

1 Log in to Siebel Tools as an administrator.
2 Lock the FS Dispatch Board project for editing.
3 Navigate to Object Explorer > Siebel Objects > Applet.
4 Query for the FS DB Planned GanttChart AX Applet.
5 Navigate to Applet > Applet User Prop.
   NOTE: If Applet User Prop is not visible, go to View > Options, select the Object Explorer tab, and select the Applet User Prop object definition.
6 Query for the Y-BC ViewSet Size user property.
7 Change the number in the Value field to the number of rows that you want to display.
To change the height of the display area on the Dispatch Board

1. Log in to Siebel Tools as an administrator.
2. Lock the FS Dispatch Board project for editing.
3. Navigate to Object Explorer > Siebel Objects > Applet.
4. Query for the FS DB Planned GanttChart AX Applet.
5. Navigate to Applet > Control.
6. Query for the GanttCtrl control.
7. Change the number in the HTML Height field to the number that you calculate using the revised number of rows to display.

Restricting the Employees that Display on the Dispatch Board

This task is a step in “Process of Setting Up the Dispatch Board” on page 177.

Users can determine the employees that are displayed by selecting a service region and entering a date in the Dispatch Board. They can also query to filter the list of displayed employees. Administrators can use Siebel Tools to further restrict the employees that users can view on the Dispatch Board.

See Using Siebel Tools for more information on performing configuration tasks with Siebel Tools.

To restrict the employees that display on the Dispatch Board

1. Log in to Siebel Tools as an administrator.
2. Lock the FS Dispatch Board project for editing.
3. Navigate to Object Explorer > Siebel Objects > Applet.
4. Query for the FS DB Planned GanttChart AX Applet.
5. Navigate to Applet > Applet User Prop.
   
   **NOTE:** If Applet User Prop is not visible, go to View > Options, select the Object Explorer tab, and select the Applet User Prop object definition.
6. Query for the Y-SearchSpec user property.
7. Define the search specification in the Value field of this user property.
8. Compile the changed applet definition.
Process of Assigning Activities

The following list shows the procedures that end users typically perform to assign activities within Siebel Field Service. Your company may follow a different process according to its business requirements.

To assign activities, perform the following tasks:

■ Selecting Data to Display in the Dispatch Board’s Gantt Chart (End User) on page 195
■ Searching for Activities in the Dispatch Board’s Gantt Chart (End User) on page 196
■ Assigning Field Service Engineers for Activities (End User) on page 196
■ Creating Activities with the Dispatch Board (End User) on page 198

Selecting Data to Display in the Dispatch Board’s Gantt Chart (End User)

This task is a step in “Process of Assigning Activities” on page 195. To select field service engineers and other items that appear on the Gantt chart, use any of the following options:

■ Select a service region to display the appropriate engineers.
■ If needed, query to filter the display list of engineers.
■ Enter an appropriate date.

About Displaying Parent Service Regions in the Gantt Chart

When you select a service region that is a parent region on the Dispatch Board, the list of available employees on the Gantt chart includes:

■ Employees of the selected service region
■ Employees of the child service region and all its descendants

See “Specifying Parent Service Regions” on page 112 for more information.

Using the Dispatch Board Queries with Legacy Data

If there is a large quantity of legacy data, older activities that were not scheduled using the Dispatch Board may also appear. It is advisable to limit the queries to show only records created after the Dispatch Board is installed, to make sure that extraneous data does not appear in the Activities view.

To display information relating to a specific service region

1. Navigate to the Dispatch Board screen.
2. Click Select Service Region.
In the Pick Service Region dialog box, select a service region and click OK.

The field service engineers associated with the selected service region and descendant service regions (child service regions and their children) appear in the left column of the Gantt chart.

**NOTE:** Available hours are shown in the Gantt chart with colors that represent rate types. Nonworking periods are grey, working periods are white, overtime periods are orange, and extended overtime periods are brown. If no colors are specified for activities, yellow boxes are the default to indicate activities that are assigned and scheduled.

### To display information relating to a specific date

1. Navigate to the Dispatch Board screen.
2. In the Date fields, enter the date to display in the Gantt chart and click Go.
   
   The data for the selected date appears in the chart.

### Searching for Activities in the Dispatch Board’s Gantt Chart (End User)

This task is a step in “Process of Assigning Activities” on page 195.

Perform the following procedure to search for activities in the Gantt chart.

**To search for activities**

1. Navigate to the Dispatch Board screen.
2. Search for unscheduled activities by doing one of the following:
   - Clicking the Select Service Region button on the Gantt chart.
   - Clicking the Query button on the Unscheduled Activities view.

### Assigning Field Service Engineers for Activities (End User)

This task is a step in “Process of Assigning Activities” on page 195.

After creating activities and activity plans, local dispatchers familiar with their territory and employees can assign and schedule activities manually. This can be done using one of the following screens:

- **Service screen.** See "Assigning Field Service Engineers from the Service Screen" on page 197 for more information.
- **Activities screen (using Assignment Manager).** See "Assigning Field Service Engineers with Assignment Manager" on page 197 for more information.
Assigning Field Service Engineers from the Service Screen

Perform the following procedure to assign and schedule engineers from the Service screen.

**To assign and schedule field service engineers from the Service screen**

1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Activities view tab.
3. Drill down on the Status field for the selected activity you want to schedule.

   The Dispatch Board screen appears. The unscheduled activity is listed below the Gantt chart. The Gantt chart displays employee names and their scheduled activities, if any.

   **NOTE:** The Gantt chart displays only employees pertaining to a selected service region or a service region hierarchy.
4. If no names are listed in the Gantt chart, select a service region for the activity in the Unscheduled Activities list, and drag and drop the activity onto the Gantt chart.

Assigning Field Service Engineers with Assignment Manager

Perform the following procedure to assign engineers from the Activities screen.

**To assign field service engineers with Assignment Manager**

1. Navigate to the Activities screen > Activities List view.
2. Drill down on the Type field for a selected activity and click the More Info view tab.
3. Click the menu button and choose Assign.

   A dialog box appears with names of field service employees ranked in order of preference.

   The suggested assignments are based on a variety of criteria including workload and skills, which are set up using the Assignment Manager. For instructions on configuring the Assignment Manager, see *Siebel Assignment Manager Administration Guide*.
4. Select the employee assigned to perform this activity and click OK.

Assigning Field Service Engineers with the Dispatch Board

Perform the following procedure to assign and schedule engineers from the Dispatch Board screen.

See “About Using the Dispatch Board Gantt Chart to Assign Activities” on page 198 for more information.

**NOTE:** Users can also invoke Contract Scheduling from the Dispatch Board’s Unscheduled Activities view by using the Insert Activity button. See “Running Contract Scheduling (End User)” on page 157 for more information.
Setting Up and Using the Dispatch Board

About Using the Dispatch Board Gantt Chart to Assign Activities

To assign and schedule field service engineers with the Dispatch Board

1. Navigate to the Dispatch Board screen.
   The Gantt chart appears.

2. In the Unscheduled Activities view, select an activity.
   **NOTE:** To assign an activity, it must have a type.

3. Drag and drop the selected activity onto a field service engineer’s schedule in the Gantt chart.
   The activity appears as a horizontal bar. Holding the cursor over this bar displays a pop-up window, which provides a description of the activity.

4. To remove an activity, drag it back to the Drag/Drop column in the Unscheduled Activities view.

Creating Activities with the Dispatch Board (End User)

This task is a step in “Process of Assigning Activities” on page 195.

Perform the following procedure to create a new activity using the Dispatch Board.

To create a new activity with the Dispatch Board

1. Navigate to the Dispatch Board screen.
   The Gantt chart appears.

2. In the Unscheduled Activities view, create a new record and complete the appropriate fields.
   Centralized dispatchers can assign and schedule activities after searching for activities in a service region.

About Using the Dispatch Board Gantt Chart to Assign Activities

Note the following when using the Gantt chart in the Dispatch Board:

- An unlimited number of activities can overlap (be assigned to the same hours for a field service engineer), but only three appear in the chart. Adding more than one activity to a time slot reduces the height of the bar representing that activity and removes the description of the activity. To see the description of an activity bar and the properties of this activity, hold the cursor over the bar for a few seconds. A Tooltip appears.

- Any activity in the Gantt chart can be reassigned or rescheduled.
  It is recommended that you use the Book Appointment button if you need to reschedule an appointment (see “Booking Activity Appointments (End User)” on page 150 for more information) rather than dragging the appointment to a different time on the Gantt chart. See also “About Rescheduling Appointments in the Dispatch Board” on page 199 for more information.

- Activities may be assigned to available or unavailable hours in a field service engineer’s schedule.
Setting Up and Using the Dispatch Board ▪ About Rescheduling Appointments in the Dispatch Board

- Mouse over a scheduled activity to view activity details.
- Click an activity type to see more information about the activity. The Activities screen > Schedule view appears.
- Clicking on the name of an employee shows the Administration - User screen > Employees view, with information about the selected employee.
- Dragging an activity from the Gantt chart back to the Unscheduled Activities list sets the activity status to Unscheduled and removes the value from the Employees field for this activity.
- The assignment of an activity and its duration may be changed from the Unscheduled Activities list or from the Activities view.
- The Dispatch Board can display instances of a repeated activity, with the following restrictions:
  - Drag and drop the repeated activity from the Unscheduled Activities list to the Gantt chart. This becomes the first scheduled instance of the activity.
  - The repeated instances of this activity fill in automatically.
- The user cannot drag any instance of a repeated activity to another location on the Dispatch Board or back to the Unscheduled Activities list.

**About Rescheduling Appointments in the Dispatch Board**

You can reassign or reschedule any activity in the Gantt chart using drag-and-drop, but note that these activities are not automatically loaded into the Appointment Booking System (ABS).

You can override the drag-and-drop business service to attempt a Load Activity and provide real-time feedback but manual and automated scheduling do not combine well. When loading activities into an existing schedule, Siebel Scheduler does not attempt to drop activities currently in the same time slot because the coding logic for these types of decisions can be done only on a case-by-case basis. Large numbers of users attempting to manually schedule activities simultaneously (by setting the Lock Assignment or Lock Schedule flags) are going to create conflicts, as well as a brittle schedule that cannot be easily changed if people are moved around. See "Locking Schedules and Assignments (End User)" on page 153 for more information about these flags.

**TIP:** In most cases, for appointments in the future, it is recommended that users rebook appointments using the Book Appointment button. For appointments occurring today, it is recommended that appointments be changed manually to allow dispatchers to use their discretion. This can be done by changing the ABS - Days to Start parameter to 1. See "Defining Cost Functions for the Optimizer" on page 134 for more information.
Agreements Overview

An agreement describes a product or service provided to the customer and the financial relationship between parties. In the context of your Siebel application, contracts and agreements are synonymous. In your Siebel application’s user interface, contracts are referred to as agreements. Consequently, this chapter usually uses the term agreements in reference to contracts.

Many different types of agreements can be created manually in the Agreements screen or automatically from a quote in the Quotes screen. Agreements can have a hierarchical relationship; that is, a master agreement can have multiple child agreements.
Automatic Entitlements

Entitlements can be applied automatically to agreement line items using entitlement templates that are associated with specific products. Each line item in an agreement can have multiple entitlements that cover specific costs, contacts, and accounts, metrics, service hours, responsiveness, and preventive maintenance plans.

Agreement Management

Siebel Agreements provides for renting, leasing, financing, and usage. Renting, leasing, and financing are set up in terms of nonrecurring charges, recurring charges, and schedules for agreement invoicing. Usage is set up in terms of use plans, asset measurements, and readings.

This chapter refers to nonrecurring charges (NRCs; for example, the one-time fee for a service agreement) and recurring charges (RCs; for example, a monthly service fee) as they apply to agreements. Use-based agreements are also referred to here because these may include service components.

Agreement Charges and Invoicing

The Field Service Charge Engine creates charges and the Field Service Charge Consolidation business service creates invoices. Associated workflows can be configured as needed. For more information about agreement charges and invoicing, see Chapter 9, "Charges and Invoices."

Process of Setting Up Agreements

The following list shows the procedures that administrators typically perform to set up agreements using Siebel Field Service. Your company may follow a different process according to its business requirements.

Administrator Procedures

To set up agreements, perform the following procedures:

1. Defining Pricing for Agreements on page 203
2. Setting Up Agreement Renewal on page 205
3. Setting Up Agreement Validation on page 207
4. Setting Up Agreement Approval on page 209
5. Creating Agreements from Orders and Quotes on page 210
6. Configuring Data Maps to Copy Specified Items on page 213
7. Creating an Opportunity and Quote from an Agreement Line Item Renewal on page 214
8. Adding Assets to Agreement Line Items on page 215
Defining Pricing for Agreements

Several types of pricing can be defined for agreements:

- **Asset-based pricing.** See “Defining Asset-Based Pricing” on page 203.
- **Service-based pricing.** See “Defining Service-Based Pricing” on page 204.
- **Order or quote entitlement-based pricing.** See “Defining Order or Quote Entitlement-Based Pricing” on page 204.

**NOTE:** See “Agreements” on page 548 for information on how pricing has changed since version 7.8. When a product is added to an agreement line item or another asset is added, the Product Selection and Pricing (PSP) Engine is now selected to ascertain the price of the selected product.

Defining Asset-Based Pricing

For an agreement line item, the combination of a product (typically a service product, specified in the Product field) and an asset (specified in the Asset # field) determines a unique price. This capability is named asset-based pricing. For more information, see “Line Items View” on page 253.

Asset-based pricing is used for pricing products related to assets that a customer has already purchased. Clicking the Reprice and Reprice All buttons activates the Pricing Engine, which calculates the price of the product and asset combination, retrieving the price from the price list, or price list entry, and supply information on volume discounts.

**NOTE:** The Pricer module is required if you wish to perform special pricing on products based on assets.

**To enable asset-based pricing**

1. Navigate to the Administration - Business process screen > Workflow Deployment view.
2. Enable the Dynamic Pricing Procedure workflow.

Asset-based pricing is managed using the Dynamic Pricing Procedure workflow. This workflow must be enabled in the application instead of the Pricing Procedure - Default workflow. See *Siebel Pricing Administration Guide* for more information about pricing procedures and the Product Selection and Pricing (PSP) engine.

**To use asset-based pricing**

1. Navigate to the Administration - Pricing screen > Price List view.
2. Select a price list and click the Service Pricing view tab.
3 Create a new record and complete the fields as appropriate.

   The combination of the service product in the Service Pricing view and an asset in the Service
   Price Details subview defines a unique price.

**Defining Service-Based Pricing**

Customers often require an after-sales service package for the products they are purchasing. This requirement is included in the quote or order. As an administrator, you can define a service package to cover a set of products with the price of the service package, either as a percentage of the product being covered or as a fixed price. The combination of the service package and the product being covered allows the price to be calculated. This practice is known as **service-based pricing**.

Service pricing on covered assets is managed using the Pricing Procedure - Calculate Net Price workflow. See *Siebel Pricing Administration Guide* for more information about pricing procedures and setting up service pricing.

**To create a service package for service-based pricing**

1 Navigate to the Administration - Products screen.

2 In the Products list, create a record, complete the required fields, and save the record.

   The service package should be given a suitable name such as Platinum Service Package, Gold
   Service Package, and so on.

3 Drill down on the Product field hyperlink.

   The More Info view appears.

4 Select the Service Product check box.

5 Navigate to the Administration - Pricing screen > Price List view.

6 Set up service pricing for the new service product, adding the required information, including:

   - An appropriate price as either a fixed price or as a percentage of the product being covered
   - Products to be covered by the service package
   - Adjustments necessary to the price of the service package

**Defining Order or Quote Entitlement-Based Pricing**

Orders and quotes can have associated entitlements that provides special pricing for all line items in the order and quote. This capability is also known as **contract-based pricing**.

**NOTE:** By default, entitlement-based pricing is not enabled in Field Service. The Pricer module is required if you wish to perform special pricing on products based on their entitlements.

Order and quote entitlement-based pricing is managed through the Pricing Procedure - Calculate Net Price workflow. See *Siebel Pricing Administration Guide* for more information about pricing procedures and the Product Selection and Pricing (PSP) engine.
To generate contract-based pricing of orders
1. Navigate to the Service Order screen > List view.
2. Drill down on a selected order and click the Line Items view tab.
3. Make sure that an entitlement has been selected.
4. From the menu drop-down list, select Reprice.
5. In the Totals view, from the menu drop-down list, select Save.

The Reprice command sends the order, line items, and the selected entitlement to the Pricing Engine. The engine prices each line item and includes any special pricing defined under the entitlement.

To generate entitlement-based quote pricing
1. Navigate to the Quotes screen > Quotes List view.
2. Select a quote record and then scroll down to the Quotes form.
3. Click the show more button to display additional fields.
4. In the Entitlement field, enter an entitlement.
5. Drill down on the Name field and click the Line Items view tab.
6. Click the menu button and select the Reprice All option.

Reprice All returns a price list for all line items and provides information on volume discounts.

Setting Up Agreement Renewal
Users can manually renew line items by entering a current or previous day in the Start Date field and then clicking the Renewal button. For more information, see “To manually renew a line item of an agreement” on page 229.

Workflows can be used to automatically renew agreement line items. The FS - Agreement Renewal Item workflow and the FS - Agreement Renewal All workflow can be used to set up a repeating component job to renew agreement line items automatically for predefined time periods. For example, a workflow process could be run daily to find any start dates equal to the current date, and then renew those line items automatically. See “Workflow to Automatically Renew Agreement Line Items” on page 245 and “Workflow to Automatically Renew All Agreement Line Items” on page 245 for more information.

Renewal terms for a line item are as follows:
- Start date (required)
- End date (required)
- Price adjustments
- Charge adjustments
Agreements ■ Process of Setting Up Agreements

■ Use plan

NOTE: Agreement line items are renewed using the Line Items view > Renewal Escalator subview only, and are not affected by fields in the Financials view.

To automatically renew agreement line items using a repeating component job

1. Navigate to the Administration - Server Management screen > Jobs view.
2. In the Jobs list, create a new Job record.
3. In the Component/Job field, select Workflow Process Manager.
4. Enter the desired Repeat Interval and Repeat Unit in the Job Detail view.
   For example, a Repeat Unit of Weeks and a Repeat Interval of 1 would run the renewal process on a weekly basis.
5. Scroll down to the Job Parameters list and create a new parameter record.
6. In the Name field, select Workflow Process Name, and in the Value field, enter FS - Agreement Renewal Item or FS - Agreement Renewal All.
7. Click the Start button in the Jobs list.
   TIP: It is recommended that you set up the schedule to first query for all agreements that are about to expire in 15, 30, or 60 days. Then, run the renewal workflow for that agreement line item with the current day specified. It is also recommended that an activity should be created for the sales or service team to follow up with the account for renewal.

To define the renewal terms of a line item

1. Navigate to the Agreements screen > Line Items view.
2. Drill down on a selected line item record and click the Renewal Escalator view tab.
3. Create a new record and complete the fields as appropriate. See "Renewal Escalator Subview" on page 254 for more information.

Adjustment types are described in the following table.

<table>
<thead>
<tr>
<th>Adjustment Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discount Amount</td>
<td>Decreases the price (or charge) of the renewed line item by the amount entered in the corresponding Adjustment Amount fields.</td>
</tr>
<tr>
<td>% Discount</td>
<td>Decreases the price (or charge) of the renewed line item by the percentage amount entered in the corresponding Adjustment Amount field.</td>
</tr>
<tr>
<td>Markup Amount</td>
<td>Increases the price (or charge) of the renewed line item by the amount entered in the corresponding Adjustment Amount field.</td>
</tr>
</tbody>
</table>
Agreements ■ Process of Setting Up Agreements

<table>
<thead>
<tr>
<th>Adjustment Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% Markup</td>
<td>Increases the price (or charge) of the renewed line item by the percentage amount entered in the corresponding Adjustment Amount field.</td>
</tr>
<tr>
<td>Price Override</td>
<td>Preserves the price (or charge) of the renewed line item regardless of the amount entered in the corresponding Adjustment Amount field.</td>
</tr>
</tbody>
</table>

Setting Up Agreement Validation

Users can verify an agreement to validate that the correct data has been entered. Agreement validation helps to make sure that agreement details are in accordance with company policies regarding contract creation, updating, and renewal.

Process of Setting Up Agreement Validation

To set up agreement validation, perform the following tasks:

1. Creating Agreement Validation Rule Sets on page 207
2. Creating Agreement Validation Messages on page 208
3. Creating Agreement Validation Rules on page 208

NOTE: See Siebel Order Management Guide for more information on setting up data validation.

Creating Agreement Validation Rule Sets

Typically, a validation rule set called Agreement Validation is provided out of the box for Field Service. However, if no such rule set exists in your installation, perform the steps in the following procedure.

To create an agreement validation rule set

1. Navigate to the Administration - Data Validation screen > Rule Sets view.
2. In the Validation Rule Set list, create a new rule set and enter a suitable name for the validation rule—for example, Agreement Validation.
3. In the Business Component field, select the appropriate component.
   Typically, the value for this is Service Agreement.
4. In the Business Object field, select the appropriate object.
   Typically, the value for this is also Service Agreement.
5. Click the Activate button to release the rule set.

NOTE: To revise an agreement validation rule set, click the Revise button and update the rule set. Click Activate to release it when you are finished.
Creating Agreement Validation Messages
Before defining rules for the rule set, you should create the error messages that are used for data validation. These error messages and codes are referenced during the rule creation process.

To create a validation message for agreement line item validation
1. Navigate to the Administration - Data Validation screen > Validation Messages view.
2. In the Validation Messages list, create a new record.
3. Enter an appropriate message code.
4. In the Message Level field, select the appropriate level (for example, Agreement) for the message.
5. In the Message Source field, select the appropriate source of the message.
   In this case, it is typically Agreement Validation.
6. Enter text to describe the error—for example, Account is Null.
   You can also enter different message text translations in the Translations view for the various languages supported.

Creating Agreement Validation Rules
When the agreement rule set and data validation error messages have been created, the next task is to create the rules governed by the rule set. The following procedure assumes that you have not yet released the rule set.

To create validation rules for agreement line items
1. Navigate to the Administration - Data Validation screen > Rule Sets view.
2. Select the agreement validation rule set.
3. Drill down on the Name field.
   The Rules view appears.
4. In the Rule list, create a new rule record.
5. Check the sequence of the rules to make sure that the new rule is evaluated in the correct order.
6. Add a suitable name for the rule—for example, Price list is Null.
7. In the Expression field, use the Expression Designer to create sophisticated validation expressions for verification.
   A suitable expression for this example would be [Price List] IS NOT NULL. This data validation rule checks that a correct price list has been entered into the agreement. The field of the business component against which you wish to validate should be contained in [ ].
8. In the Business Component field, enter the name of the business component being referenced.
9 In the Apply To field, select either Current Record or All Records to specify the records against which the rule should be validated.

10 In the Return Code field, select the validation message and error code you created previously. See “Creating Agreement Validation Messages” on page 208 for more information.

Setting Up Agreement Approval

Agreement approvals can be set up to make sure that once an agreement is worth more than a specified sum, approval is sought from the appropriate employee.

By default, an agreement is submitted for approval if the agreement total exceeds $50,000. The user can change this validation rule or add additional rules for further validation before submitting the agreement for approval. See “Creating Agreement Validation Rules” on page 208 and “To submit an agreement for approval” on page 228 for more information.

To review the workflows called by the agreement approval signal

1 Navigate to the Administration - Order Management screen > Signals view.
2 In the Signals list, select the ApproveItem record.
3 In the Versions list, drill down on the latest workspace.
   The Actions view appears.
4 Note the following information in the Actions list:
   ■ The Sequence field shows the order in which the calls to the business services are made.
   ■ The Service Name field shows the names of the workflows called from the signal.
   The signal updates the process for the order, quote, or agreement before the agreement is submitted for approval. See “Workflow to Approve Agreements” on page 246 for more information.

   TIP: If you want the approver to receive an email in addition to placing the agreement in their Inbox, change the parameter in the signal ApproveItem for SendMail to TRUE.

To review the agreement approval validation

1 Navigate to the Administration - Data Validation screen > Rule Sets view.
2 In the Validation Rule Set list, select the Agreement Approval record.
3 Click the Rules view tab.
   The Rules view appears, showing the expression, business component, and return code used with this particular rule.
4 (Optional) If you want to change the default amount of 50,000 or make any other changes to the rule, use this view.
Defining the Agreement Approvals List

You must define a list of approvers so that the agreement is moved to the appropriate Approval Inbox for approval or rejection.

To define a list of agreement approvers

1. Navigate to the Administration - Application screen > Approval Admin view.
2. In the Approval Item list, select the Agreement Approval record.
3. In the Approval Flow Type, make sure that the correct option is selected.
   - Select Sequential to distribute the agreement approval to approvers one after another in the sequence specified using the Sequence # field. Field Service routes the approval to the next approver only if the current approver approves the request. If any one approver in the approval chain declines the request, the approval is rejected and no further routing is conducted.
   - Select Parallel to distribute the agreement approval to all approvers simultaneously for approval. The approval is rejected if at least one approver declines the approval request.
4. In the Approval Stage list, create a new record for each user required to approve the agreement, completing the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence #</td>
<td>Identifies the numeric sequence of this approval stage in the current agreement approval. Field Service executes approval stages in numerical order based on this number.</td>
</tr>
<tr>
<td>Approval Type</td>
<td>Specifies whether the approver is a position or an employee.</td>
</tr>
<tr>
<td>Owner Login Name</td>
<td>Indicates the login name tied to this Approval Stage. Relevant only if Approval Type is Employee.</td>
</tr>
<tr>
<td>Owner Position</td>
<td>Indicates the position tied to this Approval Stage. Relevant only if Approval Type is Position.</td>
</tr>
</tbody>
</table>

**TIP:** To view a list of the agreements for approval, approvers can navigate to the Inbox screen > Inbox Items view. See Siebel Applications Administration Guide for more information on using the Inbox.

Creating Agreements from Orders and Quotes

When a user clicks the Auto Contract button from either a quote or an order, the agreement created contains a large amount of information taken from the original record. This data is carried from the quote or order to the new agreement.
The process for copying information from orders and quotes to agreements uses signals and data maps. See *Siebel Order Management Infrastructure Guide* for more information on signals and data maps.

**Data Copying Process Flow**

Data mapping and signals work together to call the ISS Copy business service, allowing the copying of appropriate data to be performed. The following is a description of what occurs in this process.

1. An administrator makes sure that the signals are set up appropriately.
2. An administrator defines a data map. This definition is stored in the Siebel database.
3. A user makes a request (for example, by clicking the Revise button). The request triggers a signal (ReviseCopyAgreement), which then launches the ISS Copy Service business service.
4. The ISS Copy Service business service retrieves the variable map definition, either from the database or from the cache.
5. The ISS Copy Service business service issues the required queries and business service calls to construct a property set.
6. The controller workflow invokes the ISS Copy Service business service’s Copy method, passing the ReviseAgreement data map as a parameter.
7. The ISS Copy Service business service writes the updated field values back to the Siebel database.

See “ISS Copy Service Business Service” on page 552 for more information about this business service.

**Using Signals to Control Data Copying**

In earlier Siebel releases, Order Management and Agreement functions were hard-coded. However, as of version 7.8, every interaction between order management and agreement components occurs through an application protocol interface (API) invocation. These API invocations are called signals. A *signal* is a request to perform a business function.

Signals can be configured or redirected. A *signal action property* specifies the business service or workflow to invoke when the signal is raised. *Signal action parameters* are the configurable input arguments used to signal action workflows or business service methods. The business service methods and workflows are defined using the Administration - Order Management screen > Signals view.

*To review the signals which control the copying of data from quotes and orders to agreements*

1. Navigate to the Administration - Order Management screen > Signals view.
2. In the Signals list, query for the following three signal names:
   - **AutoAgreeFromOrder**. This signal is invoked when the user clicks the Auto Contract button on the Service Order screen > List > Agreements view. It instructs Field Service to copy the current order to an agreement using the ISS Copy Service business service.
Agreements ■ Process of Setting Up Agreements

■ **AutoAgreement.** This signal is invoked when the user clicks the Auto Contract button on the Quotes screen. It instructs Field Service to copy the current quote to an agreement using the ISS Copy Service business service.

■ **ReviseCopyAgreement.** This signal is invoked when the user clicks the Revise button on the Agreements screen > Line Items form. It instructs Field Service to copy the agreement record and the fields on the agreement, and then lock the original agreement object.

3 In the Versions list, drill down on the latest workspace for each of the above signals. The Actions view appears.

4 Note the following information in the Actions list:
   ■ The Sequence field shows the order in which the calls to the business services are made.
   ■ The Service Name field shows the names of the workflows called from the signal.

5 (Optional) If you wish to change the sequence of calls by adding additional signal actions, make the required changes in the Actions list.

Using Data Maps to Define the Data for Copying

Data maps align the fields from the source object to the destination object. The process that maps the fields copied between objects is called MapName.

AutoAgreeFromOrder and AutoAgreement are the two data maps that map the quote and order data to the agreement when the ISS Copy business service is called. These data maps are passed into the business service as a parameter. They can be extended if it is required that more data from the quote or order be passed to the agreement.

Alternatively, if users want to create an order or quote from an agreement, administrators can create a new signal calling the ISS Copy business service and then map between the agreement and the quote or order. For example, this could be done to create a quote for a renewal. The signal could then be called from behind the Renewal button to automatically create the quote or order.

To review the data mapping behind the copying of data from quotes and orders to agreements

1 Navigate to the Administration - Application screen > Data Map Administration view.

2 In the Data Map Object list, query for the following data maps:
   ■ **AutoAgreeFromOrder.** This data map is used for mapping order data to the agreement.
   ■ **AutoAgreement.** This data map is used for mapping quote data to the agreement.

3 Note the following information in the Data Map Component list:
   ■ The Source Business Component field shows the source business components for the order or quote.
   ■ The Destination Business Component field shows the destination business component for the agreement.

   For example, in the AutoAgreeFromOrder data map, the Order Entry - Line Items source business component maps to the FS Agreement Item destination business component.
4 (Optional) If you want to make any changes to the mapping, select the new source and destination business components in the Data Map Component list.

### Configuring Data Maps to Copy Specified Items

Field Service provides conditional data mapping capabilities which can be used to specify that only certain information be copied to the agreement. To accomplish this, you can add a source search specification to the data map. The ISS Copy business service then copies a source expression to a destination field.

**To add a search specification to a data map**

1. Navigate to the Administration - Application screen > Data Map Administration view.
2. In the Data Map Object list, select the appropriate data map record.
3. Scroll down to the Data Map Component list, and select the appropriate component record.
4. In the Advanced Options field, add a source search specification as follows:
   a. Click New to create a new search specification.
   b. From the Name drop-down list, select Source Search Specification.
   c. In the Value field, add a source expression in the CSSQuery language used for calculated fields using the following format:
      
      ```
      IIf ([Flag] = 'Y', [Field], "")
      ```
      
      This expression copies the field if the flag is set—otherwise it copies the null string over.

**Example: Copying Service Products from Orders to Agreements**

The following example uses a search specification to specify that only service products should be copied from an order to an agreement.

**To copy only service products from orders to agreements**

1. Navigate to the Administration - Application screen > Data Map Administration view.
2. In the Data Map Object list, select the AutoAgreeFromOrder data map record.
3. Scroll down to the Data Map Component list, and select the Line Items record.
4. In the Advanced Options field, add a source search specification using the following expression:
   
   ```
   IIF ([Sales Service Flag] = 'Y', ([Sales Service Flag], "")
   ```
   
   The data map should now only copy service products from the order.

**TIP:** You can make similar changes to the AutoAgreement data map (used for mapping data from the quote to the agreement) if you only want to quote service products.
**Example: User Scenario**

From the order, the user creates assets, using asset-based ordering to do so. When you have asset-based ordering turned on in Siebel Order Management, end users can use the Accounts screen > Installed Assets view to create orders based on a customer’s existing assets. Installed assets can include both products and services. When these views are used with the automated asset-based order workflows, the amount of time to create quotes, orders, and agreements covering those asset records is reduced because many tasks are automated.

The user covers the assets with the service product on the order and clicks Auto Contract on the Service Order screen > List > Agreements view.

The agreement is created with only the service product for the agreement line item and the assets added as covered assets. Product line items that are not service items are not added to the service agreement.

**Creating an Opportunity and Quote from an Agreement Line Item Renewal**

When a contract is 90, 60, or 30 days prior to expiring, a company typically wants to contact the customer about a possible renewal. Quite often, this is a good opportunity for the appropriate salesperson to reacquaint themselves with the customer and to deliver a quote for renewing their maintenance agreement. Such customer contact can help avoid costly expiration of maintenance contracts and the revenue leakage associated them.

This agreement renewal process can be automated for agreements and entitlements by:

- Renewing the agreement line item and all the assets related to it
- Creating an opportunity for the account
- Creating a quote for the agreement renewal and associating the opportunity and the agreement with the quote

**Adding Opportunities and Quotes to Agreement Renewal**

Out-of-the-box, the automated renewal process only creates another agreement line item for the agreement. Typically, there is a requirement to create a new opportunity and corresponding quote for the renewal.

Automating the creation of an opportunity and quote can ensure that renewal terms are always current, as is the renewal schedule. This automation can produce renewal quotes well in advance of the renewal date so customers can be prepared to adjust their purchase orders and payables to accommodate their new invoice. As a result, renewal dates are not missed avoiding revenue leakage and lapse in service coverage for customers.

**To allow automatic creation of renewal quotes or opportunities**

1. Add steps to the following workflows to set up the source object (Agreement Item) and the destination object (Quote or Opportunity):
Agreements ■ Process of Setting Up Agreements

■ FS - Agreement Renewal Item
■ FS - Agreement Renewal All

See “Workflow to Automatically Renew Agreement Line Items” on page 245 and “Workflow to Automatically Renew All Agreement Line Items” on page 245 for more information.

2 Create a data map setup to copy the correct fields to the destination objects.

See “Configuring Data Maps to Copy Specified Items” on page 213 for more information.

When the renewal process runs, it creates the corresponding agreement item records, quote item and opportunity.

Adding Assets to Agreement Line Items

In versions previous to Field Service 7.8, each agreement line item could have only one associated asset. Since Field Service 7.8, however, the intersection table between Line Items and Asset is used to allow multiple assets to be covered by the same line item.

NOTE: The original Foreign Key to Asset, Covered Asset Id, is used to define the primary asset.

Any additional assets that are added to the agreement line item have no effect on the agreement line item overall price—this is only affected by the primary asset. To allow the pricing to change based on all agreement line item assets, some additional configuration is needed. See “Enabling Asset-Based Pricing in Orders, Quotes, and Agreements” on page 216 for more information.

To add multiple assets to an agreement line item

1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record.
   The Line Items view appears.
3 Click the Pricing view tab.
4 On the link bar, click Assets.
5 In the Line Items list, select the record to which you want to add the assets.
6 Scroll down to the Assets list and create new records for each asset, completing the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary</td>
<td>Select the check box to indicate that the current asset is the primary</td>
</tr>
<tr>
<td></td>
<td>asset for this line item.</td>
</tr>
<tr>
<td>Asset #</td>
<td>Number of the asset. Select the appropriate asset from the dialog box</td>
</tr>
<tr>
<td></td>
<td>that appears. When you do so, the rest of the fields in this view are</td>
</tr>
<tr>
<td></td>
<td>populated with the related asset information.</td>
</tr>
</tbody>
</table>
Asset Process Flow from Quotes and Orders to Agreements
The following is a description of what typically occurs when a customer seeks a quote.

1. The user creates a quote for a number of products. This quote contains an aftersales service component to cover the quoted products.

2. When the customer agrees with the quote, the order is placed for the products and their service coverage.

3. On the Sales Order screen > List > Catalog > Assets view, the user selects the Auto-Asset option from the menu button. Field Service creates an instance of the asset from the quoted products and associates it with the quote.

4. On the Quotes screen > List > Agreements view, the user clicks the Auto Contract button. This creates an agreement with the header level information corresponding to the order. The agreement line item is now the service product and the assets created from the quote are associated with the agreement line item. Assets can be added to or removed from this list as required.

    **NOTE:** The pricing of the service agreement is a combination of the price of the service product and the asset covered by the service product.

Enabling Asset-Based Pricing in Orders, Quotes, and Agreements
Typically, the pricing on agreement line items is only affected by the primary asset. However, if required, you can configure the pricing so that it is based on all agreement line item assets.

**To enable asset-based pricing**


2. Activate the Dynamic Pricing Procedure rather than the Basic Pricing Procedure, which is normally used.

    Unlike the Basic Pricing Procedure, the Dynamic Pricing Procedure workflow includes covered asset details. See *Siebel Pricing Administration Guide* for more information on switching pricing procedures.

Creating Revenue Plan Templates
Revenue plan templates must be set up by the administrator before users can add them to agreement line items. In the template, you can assign the units to be used—for example, days, weeks, or months. You must also specify the product associated with the revenue template. See “Managing Agreement Line Item Revenue” on page 232 for more information on adding the plans to line items.

**To create revenue templates**

1. Navigate to the Administration - Forecast screen > Revenue Templates view.
Creating Term Templates

Term templates are used to create standard terms which can be added to contracts, for example, Force Majeure. Force Majeure is a special term used to protect against events beyond the control of the service company. The description of this could be similar to the following:

Each party will be excused from performance for any period during which it is prevented from performing any obligation, in whole or in part, as a result of socioeconomic, global or natural causes beyond its control, and without its fault or negligence including acts of God, strikes, lockdowns, riots, acts of war, epidemics, terrorism, and power failures.

To create a term template
1. Navigate to the Administration - Contracts screen > Term Templates view.
2. Create a new record and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Term #</td>
<td>The number of the term.</td>
</tr>
<tr>
<td>Term Name</td>
<td>A representative description for the term; for example, Term Length.</td>
</tr>
<tr>
<td>Type</td>
<td>The legal type of the term: standard, nonstandard, or special.</td>
</tr>
<tr>
<td>Description</td>
<td>The actual term as it is used in the agreement.</td>
</tr>
</tbody>
</table>

See “Adding Agreement Terms to Agreements” on page 235 for more information on adding defined terms to agreements.

Running Charge Plans Using Workflows

Workflows can be used to automatically run charge plans and create charges for agreement line items. The FS - Generate Agreement Charge workflow and the FS - Generate All Agreement Charges workflow can be used to set up a repeating component job to run charges. See “Workflow to Create Agreement Charges” on page 302 and “Workflow to Generate All Agreement Charges” on page 303 and for more information.

To generate multiple charges for an agreement line item using a repeating component job
1. Navigate to the Administration - Server Management screen > Jobs view.
2. In the Jobs list, create a new Job record.
3 In the Component/Job field, select Workflow Process Manager.

4 Enter the desired Repeat Interval and Repeat Unit in the Job Detail view.
   For example, a Repeat Unit of Weeks and a Repeat Interval of 1 would run the charge generation process on a weekly basis.

5 Scroll down to the Job Parameters list and create a new parameter record.

6 In the Name field, select Workflow Process Name, and in the Value field, enter FS - Generate Agreement Charge or FS - Generate All Agreement Charges.

7 Click the Start button in the Jobs list.

**Related Topic**
"Defining Charge Plans for Agreement Line Items" on page 229

**Entitlements Overview**

Charges can be adjusted based on an entitlement associated with a service call. An agreement can have many entitlements associated with it. One agreement typically encompasses several products or assets. These products and assets can be covered by multiple service packages. Each service package can then include different entitlements. Complex pieces of machinery may have many associated components. The service package associated with each product can then have different entitlements for the various components and labor.

For example, a certain key machine part breaks down and a field engineer is required to fix the part. This fix requires three hours of the engineer’s time. If the engineer is billed at a rate of $50 an hour, the final charge for the customer would be $150. However, if the customer is covered by a service-level agreement with entitlements that cover all time and material for that particular part, the charge would have an additional charge adjustment added to subtract the ($150) leaving an outstanding balance of $0. Field Service can inform the customer of the charge adjustment and why the adjustment has been performed.

**Process of Setting Up Entitlements**

The following list shows the procedures that administrators typically perform to set up entitlements using Siebel Field Service. Your company may follow a different process according to its business requirements.

**Administrator Procedures**

To set up entitlements, perform the following procedures:

1. Setting System Preferences for Verifying Entitlements on page 219
2. Checking User Properties for Entitlements on page 220
3. Creating Entitlement Templates on page 220
4. Adding Schedule Information for Entitlements on page 222
Setting System Preferences for Verifying Entitlements

System Preferences have three settings (see Table 42) that determine the action of the Verify button. For more information, see “Service Requests Views” on page 51.

Table 42. System Preferences for Verifying Entitlements

<table>
<thead>
<tr>
<th>System Preference Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Entitlement: Verify Consumer | Sets the conditions for checking the authorization of the contact requesting service. If TRUE, the entitlements displayed must meet one of these criteria:  
- The contact for the entitlement matches the service request contact.  
- The entitlement account is set to All Contacts, and the entitlement account matches the service request account or the account for the contact for the service request. |
| Entitlement: Verify Dates | Checks that the service request falls within the time span of the entitlement. If TRUE, the entitlements displayed are only those that provide coverage on the date the service request was opened: a date between the start and end dates for the entitlement.  
If the entitlement has no start or end date, it does not appear. |
| Entitlement: Verify Product | Checks that the asset or product is entitled to service. If TRUE, the agreements displayed must meet one of these criteria:  
- The entitlement asset matches an asset in the service request.  
- The entitlement product matches a product in the service request (no asset or serial number specified).  
- The entitlement is set to All Products and the product or asset for the entitlement matches the product or asset for the service request. |

To set system preferences for entitlements

1. Navigate to the Administration - Application screen > System Preferences view.
2. Query for entitlements. For more information about system preferences, see “Setting System Preferences for Verifying Entitlements” on page 219.
3. Enter TRUE or FALSE in the System Preferences Value field.
Checking User Properties for Entitlements

Setting the Post Default Created Date to Date Saved user property in the Service Request business component controls the behavior of the Opened field in new service request records. This setting can affect how your Siebel application handles entitlements.

To check the user properties for entitlements

1. Log into Siebel Tools as an administrator.
2. In the Object Explorer, navigate to Business Component.
5. Query for the Post Default Created Date To Date Saved user property.
6. Compare the value for the user property with the descriptions in “Setting the Default Opened Date and Time for an SR” on page 39.

Creating Entitlement Templates

Entitlement templates allow you to predefine entitlements and specify the type of service provided. An entitlement template specifies the default coverage for the accounts, contacts, preventive maintenance, billing, products, and pricing.

NOTE: Entitlement templates are not limited to service products. They can also be used with sales products to allow entitlement-based pricing in quotes and orders. See “Configuring Auto-Entitlement for Quotes and Orders” on page 224 for more information.

For example, an organization sells a range of products and their associated service products for after-sales service. A service product such as Bronze Service can be created as an entitlement template and associated with a service product with a price for the after-sales service package. The package can denote the availability of technical support, a preventive maintenance schedule and whether parts and labor are additional costs under the service package.

Using automated entitlement, (by clicking the Entitle button on the Agreements screen > Line Items view) the correct entitlements are automatically located from the entitlement templates which correspond to the service products in an agreement. For more information, see “Line Items View” on page 253 and “Products Subview” on page 250.

This topic contains the following related procedures:
- To create entitlement templates on page 221.
- To define entitlement template metrics on page 221.
- To define products covered in an entitlement template on page 221.
- To define service billing details for entitlement templates on page 221.
- To define special pricing for entitlement templates on page 221
- To define preventive maintenance plans covered by entitlement templates on page 221
To define exceptions for a service activity on page 222

**To create entitlement templates**
1. Navigate to the Administration - Contracts screen > Entitlement Templates view.
2. Create a new record and complete the fields as appropriate.
   - The Name field displays an automatically assigned template number, which you should change to an identifiable name for the template, as needed.
   - The check boxes automatically associate data with the new template. For a description of these check boxes, see “Entitlement Templates View” on page 247.

**To define entitlement template metrics**
1. Navigate to the Administration - Contracts screen > Entitlement Templates view.
2. Select an entitlement template record and click the Metrics view tab.
3. Create a new record and complete the fields as appropriate.

**To define products covered in an entitlement template**
1. Navigate to the Administration - Contracts screen > Entitlement Templates view.
2. Select an entitlement template record and click the Products view tab.
3. Create a new record and complete the fields as appropriate.

**To define service billing details for entitlement templates**
1. Navigate to the Administration - Contracts screen > Entitlement Templates view.
2. Select an entitlement template record and click the Service Details view tab.
3. Create a new record and complete the fields as appropriate.

**To define special pricing for entitlement templates**
1. Navigate to the Administration - Contracts screen > Entitlement Templates view.
2. Select an entitlement template record and click the Pricing Details view tab.
3. Create a new record and complete the fields as appropriate.
   - For information about the role of Pricing Details records, see “Pricing Details Subview” on page 250.

**To define preventive maintenance plans covered by entitlement templates**
1. Navigate to the Administration - Contracts screen > Entitlement Templates view.
2. Select an entitlement template record and click the Preventive Maintenance view tab.
3 Create a new record and complete the fields as appropriate.

**To define exceptions for a service activity**

1 Navigate to the Administration - Contracts screen > Entitlement Templates view.
2 Select an entitlement template record and click the Service Details view tab.
3 Select a record.
4 In the Time Exceptions subview, create a new record and complete the fields as appropriate.
5 From the drop-down list at the top of the Time Exceptions list, select Expense Exceptions.
6 Create a new record and complete the fields as appropriate.
7 From the drop-down list at the top of the Expense Exceptions list, select Product Exceptions.
8 Create a new record and complete the fields as appropriate.

**Adding Schedule Information for Entitlements**

The service schedule for the entitlement must be defined. Exceptions also need to be specified so that holidays and other nonwork days are taken into account.

See “Defining Schedule Hours” on page 107 for more information on how to define hours of availability and exception hours for a schedule.

**Adding Escalation Times to Entitlements**

*Escalation times* are deadlines that can be added to entitlements to ensure that events are escalated to the appropriate parties at the appropriate intervals. You can use the Siebel Business Process Designer to manage such business processes. For example, you can automate the following: event escalation; notification of appropriate employees; work routing, assignment, and processing; enforcement of authorization and transition rules.

Escalation times differ from committed times in that they allow proactive rather than reactive notification. Escalation warnings are signalled before a contractual commitment has been breached, rather than afterwards like the committed times.

**Using a Service Request Workflow for Escalation**

You can activate a workflow process to automatically alert a predetermined manager when the following apply:

- An incident or problem record has reached the escalation date and time.
- The status is still Open.

An email should be sent to the manager when an incident or problem record has breached the committed date or time. The email should include the following information:
A list of all incidents and problems that have reached their escalation date and time

A list of all the incidents and problems that have breached their committed date time and by how much

These lists should include the SR number, Type, Priority, Title, Escalation Date Time, Committed Date Time, and the Owner for each record.

Process for Activating the Workflow
To enable service request email notification, you must perform the following tasks:

1. Set the communications profile argument called CommProfile on the workflow to the account name of the POP3 email server—for example, support@Demohost.Siebel.com. This populates the From line on the email. See “To set the communications profiles for the AlertEscalation Email workflow” on page 223 and “To configure the AlertsEscalation Email workflow using Siebel Tools” on page 223.

2. Using eScript, change the business service to enter the manager who receives the email and the polling period, during which the workflow checks for all the incident and problems records that have breached their Service Level Agreements (SLAs) and the ones that are in risk of breaching their SLAs.

To set the communications profiles for the AlertEscalation Email workflow

1. Navigate to the Administration - Communications screen > Communications Drivers and Profiles view.

2. In the Communications Drivers list, select the Internet SMTP/POP3 Server record.

3. Scroll down to the Profiles list to review the profiles you can use—for example, support@abc.com or HelpDesk@abc.com.

4. Set the AlertEscalation Email workflow’s communications profile argument (CommProfile) to the account name of the POP3 email server by completing the following steps:
   a. In the Profile Parameters Overrides list, click New.
   b. In the Name field, select POP3 Server.
   c. In the Value field, enter the value for the communications driver, for example, support@abc.com.

After you have found the correct communications profile, change the AlertsEscalation Email workflow using Siebel Tools, as described in the following procedure.

To configure the AlertsEscalation Email workflow using Siebel Tools

1. Log into Siebel Tools as an administrator.

2. In the Object Explorer, navigate to Workflow Process.

3. Query for the AlertEscalation Email workflow.

4. the Workflow Processes list, right-click and select Edit Workflow Process.

5. In the Process Designer, select Call Send SR Escalation Alert Email.
6 Right-click and select Show Input Arguments.
7 Note that the first parameter in the Input Arguments list is called CommProfile.
8 Change the literal parameter for CommProfile to the name of the profile you wish to use.
   For example, this could be support@abc.com.
   **NOTE:** See Siebel Communications Server Administration Guide for more information on creating a new profile for SR Escalation messages.
9 Deploy and activate the workflow.
   **TIP:** If you want to change the format of the email or the subject line, select the Send SR Escalation Alert Email business service and change the eScript through the Edit Server Script option on the business service. When the changes are complete, recompile the business service.

### Configuring Auto-Entitlement for Quotes and Orders

Entitlements are part of a contract, enabling a set of prenegotiated prices to be used in transactions (quotes and orders).

Within the quote (and orders), the user can select an entitlement to apply at the header level. In addition, the user can also use the Entitle button functionality to determine the best entitlement at a line item level. It is also possible to configure Field Service so that a suitable entitlement can be determined at the quote or order header level. This is described in “Adding Auto-Entitlement Buttons.”

**NOTE:** In terms of price execution, line item level entitlements (if any) override the quote or order level entitlement.

### Adding Auto-Entitlement Buttons

To allow entitlement-based pricing, developers can add an Auto-Entitlement button to the Quote Detail View and Order Entry - Line Items Detail View (Sales). Users can then click this button to automatically associate an entitlement with a quote and order.

Adding these buttons allows entitlement-based pricing for quotes and orders. The prices of the products on the order and quote line item are adjusted, based on the entitlement.

See Configuring Siebel Business Applications for more information on how to add buttons to Siebel applications.

**To configure an Auto-Entitlement button**

1. Add a button to the following quote and order applets:
   - Quote Item List Applet—used by the FS - Verify Entitlement Quote Best Price workflow
   - Order Entry - Line Item List Applet (Sales)—used by the FS - Verify Entitlement Order Best Price workflow
2. Behind each button, invoke the VerifyEntitlement method.
Change the FS - Verify Entitlement Order Best Price workflow’s event object to point to the Order Entry - Line Item List Applet (Sales). Typically, this condition event object points to the Order Entry - Line Item List Applet.

See “FS Create Entitlement Business Service” on page 568 for more information.

For more information on generating charges and invoices from agreements, see Chapter 9, “Charges and Invoices.”

### Process of Creating Agreements

The following list shows the procedures that end users typically perform when creating and defining agreements using Siebel Field Service.

#### End-User Procedures

To create and define agreements, perform the following procedures:

1. Defining Agreements on page 225
2. Defining Charge Plans for Agreement Line Items on page 229
3. Defining Conditional Charge Plans for Agreement Line Items on page 231
4. Managing Agreement Line Item Revenue on page 232
5. Creating Documents for Agreements, Quotes, and Orders on page 234
6. Adding Agreement Terms to Agreements on page 235
7. Using Co-Terms on page 236

#### Defining Agreements

This topic contains procedures for common tasks, such as creating agreements, entering line items, and defining them.

This topic contains the following related procedures:

- To create a new agreement on page 226
- To verify an agreement on page 226
- To revise an agreement on page 226
- To view the entitlements for an agreement on page 226
- To view the products covered by agreements on page 226
- To verify agreements for a contact on page 227
- To view the agreements for a contact on page 227
- To associate primary contacts with an agreement on page 227
- To associate activity plans with an agreement on page 227
Agreements ■ Process of Creating Agreements

- To add activities to an agreement on page 227
- To submit an agreement for approval on page 228
- To add financial details for an agreement on page 228
- To define terms and shipping information for agreements on page 228
- To add products sold under an agreement on page 228
- To attach files to agreements on page 228
- To manually renew a line item of an agreement on page 229

To create a new agreement
1. Navigate to the Agreements screen > List view.
2. In the Agreements list, create a new record, and complete the fields as appropriate.

To verify an agreement
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record.
3. In the Agreements form, click Verify.
   Alternatively, click the form’s menu button and select Verify.
   The agreement details in the form are validated against a set of rules. The results of the validation process then appear in a dialog box.

To revise an agreement
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record.
3. In the Agreements form, click the Revise button.
   This copies the agreement and increments the revision number. The revision number is suffixed to the original agreement name—for example, Agreement (002).

To view the entitlements for an agreement
1. Navigate to the Agreements screen > List view.
2. Select an agreement record and click the Entitlements view tab.
   The start and end dates indicate whether the entitlement is active.

To view the products covered by agreements
1. Navigate to the Agreements screen > List view.
2 Drill down on the Name field for an agreement record, and click the Entitlements view tab.
3 Select an entitlement record and click the Products view tab.
4 Repeat Step 3 for each entitlement in the list.

**To verify agreements for a contact**
1 Navigate to the Contacts screen > Contacts List view.
2 Drill down on the Name field for an agreement record, and click the Agreements view tab.

**To view the agreements for a contact**
1 Navigate to the Contacts screen > Agreements view.
2 Select a contact.
   The Agreement # field shows the agreements for this contact.

**To associate primary contacts with an agreement**
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record and click the Primary Contacts view tab.
   On the Primary Contacts form, the fields for the Legal Contact, Billing Contact, and Shipping Contact are automatically filled with the primary contact for the selected account.
3 If you want to change a primary contact, select an agreement record and drill down on the Account field.
4 In the Last Name field, select another contact.
   The list of available contacts is limited to the contacts that are associated with the selected account.

**To associate activity plans with an agreement**
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record and click the Activity Plans view tab.
3 Create a new record and complete the fields as appropriate.
4 In the More Info view tab, select Lock to prevent the Assignment Manager from assigning activities that are already in this activity plan.

**To add activities to an agreement**
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record and click the Activities view tab.
Agreements ■ Process of Creating Agreements

3 Create a new record and complete the fields as appropriate.

To submit an agreement for approval
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record.
3 In the Agreements form, click the menu button and select Generate Approvals.
   The list of approvers is updated with the approvers for that approval group. As the approver changes the status of the approval to Approved or Rejected, the list will be updated.

To add financial details for an agreement
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record and click the Financials view tab.
3 In the Financials form, complete the fields as appropriate.
   NOTE: Some fields are calculated and filled in using data from the Line Items view and its subviews. For example, Terms = (Agreement End Date - Agreement Start Date) / 30, and Months Left = (Agreement End Date - Today) / 30.

To define terms and shipping information for agreements
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record and click the Terms & Totals view tab.
3 Create a new record and complete the fields as appropriate.

To add products sold under an agreement
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record and click the Line Items view tab.
3 Create a new record and complete the fields as appropriate.
4 Click the Line Detail subview tab.
5 Create a new record and complete the fields as appropriate.

To attach files to agreements
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement record and click the Attachments view tab.
3 Create a new record and complete the fields as appropriate.
To manually renew a line item of an agreement

1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record and click the Line Items view tab.
3. Select a line item record and click the Renewal Escalator subview tab.
4. Create a new record and complete the fields as appropriate.
   - The start date can be the current date or a prior date.
5. In the Line Items view, click the Renewal button.
   - See “Workflows for Agreement Renewal and Approval” on page 244 for more information on how to automate the agreement line item renewal process.

Defining Charge Plans for Agreement Line Items

For payment of a contract, charges must be set up. Most contracts include two types of charges:

- An initial payment to establish the contract, referred to as a nonrecurring charge (NRC)
- A recurring charge (RC), which is usually a monthly charge for the service package

**NOTE:** There is also a third kind of charge, which is used to handle usage charges.

Scenario for Charge Plans

A company has a service package with a price of $15,000. There is an initial charge of $3000 to activate the service package, followed by 12 further monthly charges of $1000. The charges are to be made on the first day of each month. To manage this scenario, a Field Service user would need to set up a contract schedule, NRCs, and RCs for the charge plan. If the NRCs are to be broken up into installments, an NRC plan may also need to be set up.

Process for Defining and Running a Charge Plan

To define and run a charge plan, perform the following tasks:

1. Create a contract schedule for creating the charges. The schedule can be daily, weekly, or monthly. See “Defining Contract Schedules” on page 294 for more information.
2. Set up any required NRC, RC, or use plans. See “Setting Up NRC Plans” on page 288 for more information.
3. Add NRC, RC, and any charges, adjustments, and use plan details to the agreement line items. See “To define charge plans for agreement line items” for more information. This information should include the following:
   - A schedule plan for the first charge to be created
The start time for the first charge

**NOTE:** If you are adding a use plan to the agreement line item, make sure that you select the appropriate product and asset for association with the line item. You must select an asset that has measurements to allow usage to be recorded.

4 Run the charge plan to create charges for the agreement line item using either of the following methods:

- Use the Charge button on the Agreements screen > List > Line Items view. See “Running Charge Plans Using the Charge Button” on page 230 for more information.
- Set up workflows to run the charges automatically. See “Running Charge Plans Using Workflows” on page 217 for more information.

**To define charge plans for agreement line items**

1 Navigate to the Agreements screen > List view.

2 Drill down on the Name field of a selected agreement.

   The Line Items view appears.

3 Select a line item.

4 On the link bar, click Charge Plan.

5 In the Charge Plan form, complete the fields as appropriate. For more information, see “Charge Plan Subview” on page 312.

   **NOTE:** If a product measurement record is defined for this line item (product), the RC Schedule frequency must match the Frequency value in the Administration - Products screen > Service Information > Measurements view.

6 (Optional) If you are adding a use plan to the agreement line item, make sure that the appropriate product and asset are added to the agreement line item so that the measurements can be recorded for usage. To do this, perform the following steps.

   a Click the Line Detail view tab.

   b In the Service Asset # field, select the assets which were created to track usage.

      Multiple assets can be added to an agreement line item using the Agreements screen > List > Line Items > Pricing > Assets view.

**Running Charge Plans Using the Charge Button**

When a charge plan has been defined, users can then run the plan to create the charges. All the charges for the RC and NRC schedules are created with the correct amounts and adjustments as indicated in the charge plans.

**To run the charge plan using the Charge button**

1 Navigate to the Agreements screen > List view.
2. Drill down on the Name field of a selected agreement. The Line Items view appears.

3. Select a line item and enter a value in the Advance To field.

4. Click the Charge button.

You can generate multiple charges for an agreement line item by configuring the FS - Generate Agreement Charge workflow to run on a periodic basis. See "Running Charge Plans Using Workflows" on page 217 for more information.

**Defining Conditional Charge Plans for Agreement Line Items**

When conditional charge plans have been set up using the Administration - Contracts screen > Conditional Charge Plan view, users can then select the appropriate conditional charge plans for agreement line items. See “Setting Up Conditional Charge Plans” on page 293 for more information on how to set up a conditional charge plan.

**NOTE:** The day on which the agreement is terminated by the customer is the day on which the conditional charge is created. Also, if no conditional charge plan is associated with the agreement line item, the penalty is simply charged.

**Scenario for Conditional Charge Plans**

The administrator creates a conditional charge plan called Termination Plan. This plan specifies that if a customer arranges an early cancellation of their agreement, they must pay 8.33% (100% spread over 12 months of the year) of the agreed penalty charges for each remaining month until the end of the period covered by the agreement. A user setting up a photocopier maintenance agreement for a customer associates the Termination Plan with the photocopier agreement line item. The user then specifies that a total penalty of $150 applies for this line item if the agreement is canceled before a year has expired.

The customer with the maintenance agreement calls to cancel the 12-month contract after just six months have passed. According to the Termination Plan, the customer must now pay 8.33% of the total cancellation fee ($150) for each of the remaining six months. In total, the customer must pay $74.97.

**To define a conditional charge plan for an agreement line item**

1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field of a selected agreement. The Line Items view appears.
3. On the link bar, click Conditional Charges. The Conditional Charges view appears.
4 In the Conditional Charges list, create a new record. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of conditional charge—for example, Penalty, Refund, and so on.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date on which the conditional charge starts unless an effective date is specified.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date on which the conditional charge ends is no longer applied. For example, cancellation fees may only be applied if the agreement is canceled before a 12-months period has elapsed. After this period, the company may choose not to charge the customer if they cancel.</td>
</tr>
<tr>
<td>Effective Date</td>
<td>The date on which the conditional charge becomes effective.</td>
</tr>
<tr>
<td>Plan</td>
<td>Select the conditional charge plan which should control the conditional charge.</td>
</tr>
<tr>
<td>Amount</td>
<td>The total fee that the customer must pay for this conditional charge.</td>
</tr>
<tr>
<td>Reason</td>
<td>A description of the reason for creating this charge.</td>
</tr>
</tbody>
</table>

5 In the Advance To field, enter a date which is greater than the specified Effective Date and less than the End Date values.

The Advance To date should represent the remaining time left for the contract.

6 Click Charge.

Field Service calculates the total charges that must be applied to the customer in accordance with the conditional charge values. For example, if the customer has canceled their 12-month agreement after just six months, 50% of the cancellation fee must be paid over the next six months.

7 (Optional) On the link bar, click Charges to view the calculated charges for the line item.

Managing Agreement Line Item Revenue

Agreement line item revenue consists of the amounts invoiced to a customer according to the terms agreed to in the agreement. Customer payments may be periodic, paid up front, disbursed by account, or include additional service charges such as Time and Material (T&M).

Part of the opportunity management process for a customer is to track contracts after an opportunity has been won. This is done by forecasting the revenue expected to be generated for each year of the agreement term, and tracking the revenue for each year on a monthly basis. You can perform revenue forecasting by using revenue plans in conjunction with the Siebel Forecasting module.

Forecasting is one of the most important aspects of tracking. It is important not only to track the sales of products, but also the revenue generated by the sale of aftersales services. Using revenue plans, an organization can track the revenue associated with the agreement line items. See Siebel Forecasting Guide for more information about forecasting.
Adding Revenue Line Items to Agreement Line Items

The Agreements screen > List > Line Item Revenue view displays all revenue records associated with an agreement line item.

To add revenue line items to agreement line items

1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record.
   The Line Items view appears.
3. Click the Line Item Revenue view tab.
4. Scroll down to the Revenue list.
   The Revenue view contains a list of all the revenue for the selected agreement line item. For example, if the service contract is for $15,000 with an NRC of $3000 and a further 12 charges of $1000 per month, then 13 revenue line items should be created for the 13 payments.
5. Create a new record, completing the fields as appropriate.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>(drop-down lists)</td>
<td>The two drop-down lists at the top of the Revenue list direct a query of existing revenue records in this list. One field allows selection of records for specific products, the other for specific users.</td>
</tr>
<tr>
<td>Amount</td>
<td>Amount of revenue expected on the specified date.</td>
</tr>
<tr>
<td>Revenue Date</td>
<td>Date for expected revenue.</td>
</tr>
<tr>
<td>Revenue Wizard</td>
<td>Button. Runs a script wizard (Revenue Schedule Script) that helps users enter multiple revenue records over time. The Revenue Schedule Script can be customized if required.</td>
</tr>
</tbody>
</table>

Alternatively, you can click the Revenue Wizard button. The wizard walks you through questions such as number of payments, account, opportunity information, and so on.

6. (Optional) View the information in different formats by clicking the Chart or the Spreadsheet view tabs.
   - The Spreadsheet view shows the service product associated with the agreement line item and the revenue associated with the line item. The revenue item is shown in its own column for each item with a total as the last item.
   - The Chart view allows the revenue records to be viewed in a chart.

Adding Revenue Plans to Agreement Line Items

Once the administrator has created the revenue plan templates, users can then add them to agreement line items. See “Creating Revenue Plan Templates” on page 216 for more information.
When the user selects a revenue plan and enters an amount, the revenue items are then added. For example, a revenue template is created for 12 months. The user selects this template and enters an amount of $100. When the user saves the record, 12 revenue items are automatically created for $100 each.

**To add a revenue line item plan**
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record.
   - The Line Items view appears.
3. Click the Line Item Revenue view tab.
4. Scroll down and click the Revenue Plans view tab.
5. From the Template drop-down list, select a revenue template and complete the rest of the fields as appropriate.

**Creating Documents for Agreements, Quotes, and Orders**
Field Service can automatically generate documents required to implement a service agreement; for example, subcontractor agreements and work orders. For information about how to create document templates using Siebel Proposals see *Siebel Correspondence, Proposals, and Presentations Guide*.

**To generate an agreement document**
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record.
3. Click the Documents view tab.
4. Create a new record and complete the fields as appropriate.
   - Some fields and buttons are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Document</td>
<td>Command and button. Creates a new record from the default document template.</td>
</tr>
<tr>
<td>Generate Draft</td>
<td>Command. Creates a draft document and opens it in Microsoft Word or Lotus WordPro.</td>
</tr>
<tr>
<td>Local</td>
<td>Indicates this document is stored locally. This field is for information only; there is no associated code.</td>
</tr>
</tbody>
</table>
5 Click Generate Draft.
   The system launches Microsoft Word or Lotus WordPro and displays a draft agreement.
   Alternatively, you can click Auto Document to create a standard document from the default template.

To generate an order document
1 Navigate to the Service Order or Sales Order screen > List view.
2 Drill down on the Order # field for a selected order record.
3 Click the Documents view tab.
4 Create a new record and complete the fields as appropriate.
5 Click Generate Draft.
   Alternatively, you can click Auto Document to create a standard document from the default template.

To generate a quote document
1 Navigate to the Quotes screen > List view.
2 Drill down on the Name field for a selected quote record.
3 Click the Documents view tab.
4 Create a new record and complete the fields as appropriate.
5 Click Generate Draft.
   Alternatively, you can click Auto Document to create a standard document from the default template.

Adding Agreement Terms to Agreements

Agreement terms are terms that relate specifically to agreements. There are two ways in which agreement terms can be added to agreements:

- Agreement administrators can create agreement term templates using the Administration - Contracts screen > Term Templates view. See “Creating Term Templates” on page 217 for more information. Users can then select these terms and add them to the agreement using the Agreements screen > List > Terms view.
- Users can create terms directly from the Agreements screen > List > Terms view.

When the proposal is generated, these terms are then included as a part of the final document.
To add predefined agreement terms to an agreement

1. Make sure that the appropriate administrator has defined term templates for all the required terms that you need to add to the agreement.

2. Navigate to the Agreements screen > List view.

3. Drill down on the Name field for a selected agreement record.
   The Line Items view appears.

4. Click the Terms view tab.

5. Create a new record.

6. In the Section field, enter the document section number for the term.
   For example, this could be 1.1, 1.2 and so on.

7. Complete the rest of the fields as appropriate.

To create new agreement terms for an agreement

1. Navigate to the Agreements screen > List view.

2. Drill down on the Name field for a selected agreement record.
   The Line Items view appears.

3. Click the Terms view tab.

4. Click Add and select the appropriate term from the predefined list.

Using Co-Terms

Co-terms refer to the consolidation of the terms for multiple line items. Typically, an agreement has multiple line items for different service products. These service products may have different start and end dates, resulting in different payment schedules. Customers can ask for the consolidation of these terms into one start and end date. Equally, if a new product is being added to an existing service contract and the term is already partially complete, a customer may ask to prorate the charges, based on the remaining term of the contract.

The Agreements screen > List > Financials view can help you to better understand the co-term and prorate choices that are required for an agreement based on its term and the months left. See “Financials View” on page 257 for more information.

Process of Creating Entitlements

The following list shows the procedures that end users typically perform when creating and defining entitlements using Siebel Field Service.
End-User Procedures
To create and define entitlements, you can perform the following procedures:

1. Defining Entitlements on page 237
2. Adding Service Request Information to Entitlements on page 238
3. Adding Preventive Maintenance Information to Entitlements on page 239

Defining Entitlements
This topic contains procedures for common tasks, such as creating entitlements, and associating them with products, assets, and accounts.

This topic contains the following related procedures:

- To automatically create entitlements for an agreement line item on page 237
- To manually add entitlements to an agreement on page 237
- To manually associate accounts with entitlements on page 237
- To manually associate contacts with entitlements on page 238
- To manually associate products and assets with entitlements on page 238

To automatically create entitlements for an agreement line item
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record and click the Line Items view tab.
3. Select a line item (product record) and click Entitle.

**NOTE:** Entitlement templates must already be associated with the product on the agreement line item before you attempt to automatically create entitlements using the Entitle button.

To manually add entitlements to an agreement
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record and click the Entitlements view tab.
3. Create a new record and complete the fields as appropriate.

To manually associate accounts with entitlements
1. Navigate to the Entitlements screen > Agreement Entitlements view.
2. Select an entitlement and click the Accounts view tab.
3. Create a new record and complete the fields as appropriate.
4. (Optional) To provide complete coverage under the selected entitlement, select the All Products field.
To manually associate contacts with entitlements
1. Navigate to the Entitlements screen > Agreement Entitlements view.
2. Select an entitlement and click the Contacts view tab.
3. Create a new record and complete the fields as appropriate.
4. (Optional) To provide complete coverage under the selected entitlement, select the All Products field.

To manually associate products and assets with entitlements
1. Navigate to the Entitlements screen > Agreement Entitlements view.
2. Select an entitlement and click the Products view tab.
3. Create a new record and complete the fields as appropriate.

Adding Service Request Information to Entitlements
To allow service requests to be carried out in accordance with customer expectations, you must associate a service calendar with an entitlement. Performance measurements should also be added to make sure that the response time is appropriate.

To associate a service calendar with an entitlement
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record and click the Entitlements view tab.
3. Select an entitlement and scroll down to the Entitlement Details form.
4. In the Service Hours field, enter a service calendar record.

To manually add performance measurements (metrics) for an entitlement
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement record and click the Entitlements view tab.
3. Select an entitlement and click the Metrics view tab.
4. Create a new record and complete the fields as appropriate.

TIP: The calculation of the Agent Committed Time for a Service Request takes, as input, a response time according to the service request priority. By defining a series of different response times and priority levels, the Agent Committed Time can adjust according to the service request priority. To do this, add several metrics records of the Response Time type. For each response time record, choose a different Priority value. Then enter values in the other fields that make sense for the corresponding priority. For example, you might enter one hour for priority 1-ASAP, four hours for priority 2-High, and so on. Now, when the Agent Committed Time is calculated, the resulting time correlates to the service request priority.
To verify entitlements for a service request and select an entitlement

1. Navigate to the Service screen > Service Request List view.
2. Select a service request, and then in the service request form, click Verify.
   The Pick Entitlement dialog box appears, with a list of the active entitlements for this service request. If no entitlements appear, the selected service request is not entitled to receive service.
3. Select an entitlement record from the Pick Entitlement dialog box, and then click OK.
   Selecting an entitlement from the Pick Entitlement dialog box computes the Agent Committed time for the service request from the Service Calendar associated with this entitlement and from the Response Time specified in the entitlement metrics. The name of the selected entitlement appears in the Entitlement field. For more information, see “Service Requests Views” on page 51.

Adding Preventive Maintenance Information to Entitlements

Preventive maintenance (PM) plans can be added to entitlements. Actions can then be generated for agreements and entitlements on the basis of these PM plans.

To manually associate preventive maintenance plans with entitlements

1. Navigate to the Entitlements screen > Agreement Entitlements view.
2. Select an entitlement and click the Preventive Maintenance view tab.
3. In the drop-down list at the top of the Preventive Maintenance view, make sure PM Plans is selected.
4. Create a new record and complete the fields as appropriate.

To generate preventive maintenance actions for an agreement and entitlement

1. Follow Step 1 and Step 2 of “To manually associate preventive maintenance plans with entitlements” on page 239.
2. Select a preventive maintenance plan record and click Run PM.

To view preventive maintenance actions associated with a PM Plan

1. Follow Step 1 through Step 3 of “To manually associate preventive maintenance plans with entitlements” on page 239.
2. Select a preventive maintenance plan record.
3. From the drop-down list at the top of the Preventive Maintenance subview, select PM Actions.
Workflows for Entitlement Creation and Verification

This section explains the Siebel workflows used for entitlement creation and verification. Workflows are used to automate the business processes associated with verifying and creating entitlements.

You can modify these workflows to suit your own business model using Siebel Business Process Designer. For more information, see *Siebel Business Process Framework: Workflow Guide*.

**NOTE:** Some workflows in the following sections may not be relevant to your application services.

In this section, the workflows are grouped in subsections that correspond to the business processes that they automate. Each subsection describes a workflow process.

This section includes the following subsections:

- **Workflow to Automatically Create Entitlements from an Entitlement Template** on page 240
- **Workflow to Verify Entitlements on an Activity** on page 241
- **Workflow to Verify Entitlements on an Order** on page 242
- **Workflow to Verify Entitlements on a Quote** on page 243
- **Workflow to Verify Entitlement on a Service Request** on page 244
- **Workflow to Verify Entitlement with Best Response Time on a Service Request** on page 244

The methods used by these verification workflows belong to the FS Verify Entitlement business service. For more information on the individual methods and for a general description of the business service, see “FS Verify Entitlement Business Service” on page 570.

Workflow to Automatically Create Entitlements from an Entitlement Template

Entitlements can be automatically created from entitlement templates. The FS - Create Entitlement workflow automates the process of associating an entitlement template with a service product. The workflow is called when the user clicks the Auto-Entitlement button. See “Configuring Auto-Entitlement for Quotes and Orders” on page 224 for more information on configuring this button.

The three workflow processes call the following methods in the FS Create Entitlement business service:

- GetEntitlementTemplates
- ValidateEntitlementTemplates
- CreateEntitlements
The workflow calls the FS Agreement Renewal business service, passing in the date and the ID for the agreement. Figure 4 illustrates this workflow.

Figure 4. FS - Create Entitlement

Related Topics
- FS Create Entitlement Business Service on page 568
- FS Create Entitlement Business Service on page 568

**Workflow to Verify Entitlements on an Activity**

This workflow automates the process of verifying entitlements on an activity. The workflow is called FS - Verify Entitlement Activity. The workflow searches for a list of qualifying entitlements and displays them to the user in a pick applet. Figure 5 illustrates this workflow.

Figure 5. FS - Verify Entitlement Activity
Workflow to Verify Entitlements on an Order

This workflow automates the process of verifying entitlements on an order. The workflow is called FS - Verify Entitlement Order. The workflow cycles through all the entitlements for product line items of an order and identifies the best-priced entitlement for each line item, and then the workflow stamps the ID of the best entitlement on each line item. Figure 6 illustrates this workflow.

![Workflow Diagram](image)

Figure 6. FS - Verify Entitlement Order
Workflow to Verify Entitlements on a Quote

This workflow automates the process of verifying entitlements on a quote. The workflow is called FS - Verify Entitlement Quote Best Price. The workflow cycles through all the entitlements for product line items of a quote and identifies the best-priced entitlement for each line item, and then the workflow stamps the ID of the best entitlement on each line item. Figure 7 illustrates this workflow.

![Figure 7. FS - Verify Entitlement Quote Best Price](image)

Workflow Requirements
Some data setup is required to allow this workflow to function:

- The quote account must have an agreement with a pricing-type entitlement.
- Values for Products, Type of Calculation and Adjustment Value must be defined on the Agreements screen > Entitlements > Price Details view.
Workflow to Verify Entitlement on a Service Request

This is one of two workflows that automate the process of verifying entitlements on a Service Request. The workflow is called FS - Verify Entitlement SR; the other is FS - Verify Entitlement SR Best Response Time. The workflow shows a list of entitlements to the user and requests that the user choose an entitlement, and then the workflow stamps the commit time on the Service Request. Figure 8 illustrates this workflow.

![Figure 8. FS - Verify Entitlement SR](image)

Workflow to Verify Entitlement with Best Response Time on a Service Request

This is one of two workflows that automate the process of verifying entitlements on a Service Request. The workflow is called FS - Verify Entitlement SR Best Response Time; the other is FS - Verify Entitlement SR. The workflow automatically chooses the entitlement with the best response time, and then it stamps the commit time on the Service Request. Figure 9 illustrates this workflow.

![Figure 9. FS - Verify Entitlement SR Best Response Time](image)

Workflows for Agreement Renewal and Approval

Workflows can be configured so that agreement line items can be automatically renewed.

This section contains the following related subsections:
Workflow to Automatically Renew Agreement Line Items

The FS - Agreement Renewal Item workflow is used to automate the process of renewing an agreement line item. This workflow is called when the user clicks the Renewal button.

The workflow calls the FS Agreement Renewal business service, passing in the date and the ID for the agreement. Figure 10 illustrates this workflow.

![Figure 10. FS - Agreement Renewal](image)

Workflow to Automatically Renew All Agreement Line Items

The FS - Agreement Renewal All workflow is used to automate the process of renewing all appropriate agreement line items at once. This workflow can be run as a batch process. Figure 11 illustrates this workflow.

![Figure 11. FS - Agreement Renewal All](image)

**NOTE:** It is recommended that you run the renewal process every night to create renewal line items for your agreement.

**To renew agreement line items using a repeating component job**

1. Navigate to the Administration - Server Management screen > Jobs view.
2 In the Jobs list, create a new Job record.
3 In the Component/Job field, select Workflow Process Manager.
4 Enter the desired Repeat Interval and Repeat Unit in the Job Detail view.
5 Scroll down to the Job Parameters list and create a new parameter record.
6 In the Name field, select Workflow Process Name, and in the Value field, enter FS - Agreement Renewal All.
7 Click the Start button in the Jobs list.

**Workflow to Approve Agreements**

The following workflow is called for the approval process ISS Approval (Agreement).

![Workflow Diagram](image)

Figure 12. ISS Approval (Agreement)

You can review the rule set used with this workflow. These rules must be met so that the rest of the workflow can run. See “Setting Up Agreement Approval” on page 209 for more information.

The ISS Approval Bus Service approval business service is called with the method CreateNewApprovalTasks. This places the agreement in the approval Inbox for approval or rejection by the appropriate contract approval managers.

**Administration - Application Screen**

The Administration - Application screen’s System Preferences view determines the behavior of the Verify (entitlements) button. For information about this view, see the *Siebel Applications Administration Guide*.

**Administration - Pricing Screen**

The Administration - Pricing screen provides a view for configuring asset-, contract- and entitlement-based pricing. See “Defining Pricing for Agreements” on page 203.
Service Pricing View

The Service Pricing view allows users to associate multiple products that together define a unique price. (This is used for asset-based pricing.)

Service Price Details Subview

The Service Pricing Details subview specifies products that represent the targeted installed base of assets covered by a service product. In an agreement line item, specifying a service product (for example, Platinum Coverage) and selecting an asset that is covered by asset-based pricing (for example, component G with serial number XYZ) return a line item price based on the combination of service product and part. For more information, see "Line Items View" on page 253.

Administration - Contracts Screen

The Administration - Contracts screen has views for defining entitlement templates and billing plans based on one-time (nonrecurring) charges and asset usage. It also provides views for creating contract schedules and charge consolidation plans.

Entitlement Templates View

Table 43 describes fields in the Entitlement Templates view.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account All Contacts</td>
<td>Indicates the entitlement should cover all contacts associated with the account. The effect is to select the All Contacts box in the Agreements screen &gt; Entitlements view &gt; Accounts subview.</td>
</tr>
<tr>
<td>Account All Products</td>
<td>Indicates all products associated with the account under this entitlement should be covered. The effect is to select the All Products box in Agreements screen &gt; Entitlements view &gt; Accounts subview.</td>
</tr>
<tr>
<td>Activity Override</td>
<td>Determines whether the rate and price lists specified for the entitlement override the rate and price lists for a service request. For contract-based invoicing, check this box.</td>
</tr>
<tr>
<td>Billable</td>
<td>Indicates one or more services provided by this entitlement are billable to the customer.</td>
</tr>
<tr>
<td>Contact All Products</td>
<td>Indicates the entitlement should automatically cover all products for the contact. The effect is to check the All Products box in the Agreements screen &gt; Entitlements view &gt; Contacts subview.</td>
</tr>
<tr>
<td>Include Account</td>
<td>Indicates the entitlement should automatically cover the account on the agreement header.</td>
</tr>
</tbody>
</table>
Agreements ▪ Administration - Contracts Screen

Table 43. Selected Fields on the Entitlement Templates View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Contact</td>
<td>Indicates the entitlement should automatically cover the contact from the agreement header.</td>
</tr>
<tr>
<td>Initial Quantity</td>
<td>Number of services covered in the entitlement.</td>
</tr>
<tr>
<td>Service Hours</td>
<td>The hours of service that the entitlement covers. For example, the service package only covers 5 days a week between the hours of 9 A.M. to 5 P.M. The service hours influence the committed date time for responding to the service request. Service hours schedules can be added from the Administration - Service screen &gt; Schedules view.</td>
</tr>
<tr>
<td>Units</td>
<td>Unit of measure for the initial quantity covered; for example, service requests.</td>
</tr>
</tbody>
</table>

**Metrics Subview**

In the Metrics subview, add performance requirements for the entitlement template; for example, response time. These metrics are usually associated with a corresponding service level agreement within an agreement. The agreement often indicates the target metrics for response time and resolution time. The response and resolution times are quite often associated with the priority of the service request.

For example, the response time value sets the Date Committed field on the service request. This metric indicates that the service organization has committed to responding to issues by a certain date and time. The resolution time value can be used interchangeably with response time. However, the two metrics do indicate different values to be tracked. The resolution time indicates the time by which the service organization has committed to resolve the issue.

Another example of a metric that can be set is the escalation time. This metric will set the Agent Escalation Time field (Service screen > Service Requests - HelpDesk view) on the service request. This metric indicates that if no action has occurred on the service request by the escalation time, an email should be sent to the manager warning that a key metric in a service level agreement is about to be broken. Such breaches of service agreements can have both financial and legal repercussions for a service department.

Additional metrics can be added for monitoring through the Administration - Service screen > Service Metrics view.

**NOTE:** Each requirement must be in a separate record.

**Preventive Maintenance Subview**

In the Preventive Maintenance subview, add a record for each Preventive Maintenance plan included in the entitlement template. When selecting a plan from the Add Preventive Maintenance Plan dialog box, check the box in the second column to select a plan; selecting a record without checking this box fails to select one or more plans.
**Service Details Subview**
The Service Details subview defines each type of service covered by the entitlement and the billing terms for each service. Terms may include a fixed service charge and specific billable time, expenses, and parts. *Table 44 on page 249* describes some items on this view.

Table 44. Selected Items on the Service Details Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenses Billable</td>
<td>Indicates the service expenses under this entitlement are billable to the customer.</td>
</tr>
<tr>
<td>Parts Billable</td>
<td>Indicates the parts provided under this entitlement are billable to the customer.</td>
</tr>
<tr>
<td>Time Billable</td>
<td>Indicates time (labor) under this entitlement is billable to the customer.</td>
</tr>
<tr>
<td>Type</td>
<td>Defines the type of activity to which a Service Details record applies. This required value determines the other fields that appear in the Service Details view.</td>
</tr>
</tbody>
</table>

Note the following effects of a service detail record:

- Service Details apply to the selected activity type rather than to a specific entitlement template.
- No additional charges or discounts are applied to a service request activity if no corresponding service detail record is defined for the service request’s associated entitlement.
- No additional charges or discounts are applied to a billable item in a service request activity if no corresponding exception record is defined for the service detail record in the service request’s associated entitlement. For more information, see the "Time Exceptions Subview," "Expense Exceptions Subview," and "Product Exceptions Subview" sections that follow.

The subviews of Service Details define exceptions for time, expenses, and products. For example, if labor (time) is generally not billable, only the exceptions are billed. Conversely, if time is generally billable, the exceptions are not billed. You access these subviews by selecting from the drop-down list in the tab at the bottom of the screen.

**Time Exceptions Subview**
Time exceptions define the pricing of time associated with an activity type that is different than standard pricing. Time exceptions include a fixed service charge, discounts, and a limit on the billable amount.

**NOTE:** Exception records for time are associated with activity types and specific projects (specified in the Type field). For information about projects, see the chapter on project management in *Siebel Professional Services Automation Guide.*
Expense Exceptions Subview
Expense exceptions define pricing of expenses associated with an activity type that is different from standard pricing. Expense exceptions include a fixed service charge, discounts, and a limit on the billable amount.

Product Exceptions Subview
Product exceptions define pricing of products associated with an activity type that is different from standard service pricing. Product exceptions include discounts, markups, and overrides.

Products Subview
The Products subview defines specific products or assets covered by the entitlement. You can copy these products to an entitlement by selecting the Entitlement Template Products check box in the “Entitlement Templates View” on page 247.

Pricing Details Subview
The Pricing Details subview allows contract-based pricing for quotes and orders. Using this tab, you can discount products purchased under the agreement. This discounting is done so that when a product part becomes faulty and must be replaced under the agreement, the full list price does not have to be paid.

When creating a sales or service order, the user can select an entitlement which applies special pricing. Table 45 describes the items in this view.

Table 45. Selected Items on the Pricing Details Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Calculation</td>
<td>Type of price adjustment; for example, a discount or markup.</td>
</tr>
<tr>
<td>Adjustment Value</td>
<td>Amount of price adjustment described in the Type of Calculation field.</td>
</tr>
</tbody>
</table>

Administration - Product Screen
The Administration - Product screen includes the Service Information view which allows users to associate entitlements, measurements, and fulfillment information with the appropriate products.
Entitlements View

The Product Entitlements view associates entitlements with a product. You access this view by selecting Product Entitlements from the visibility filter on the More Info tab. Clicking the Entitle button on the Agreements screen automatically associates the entitlements with the products described in selected line items. This view contains three check boxes, described in Table 46. For more information, see “Line Items View” on page 253.

Table 46. Selected Items on the Product Entitlement Templates View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agree Line Item Products</td>
<td>Copies all products from the agreement line item to an automatically generated entitlement (produced by clicking the Entitle button).</td>
</tr>
<tr>
<td>Entitlement Template Products</td>
<td>Copies all products associated with the entitlement template to an automatically generated entitlement (produced by clicking the Entitle button).</td>
</tr>
<tr>
<td>All Contract Line Product Flag</td>
<td>Copies the products from all agreement line items to an automatically generated entitlement (produced by clicking the Entitle button).</td>
</tr>
</tbody>
</table>

Agreements Screen

The Agreements screen defines agreement of all types. It also includes views for the history of approvals for each agreement, entitlements, associated service requests, and activities.
Agreements List View

The Agreements List view displays all agreements that are visible to the user. Table 47 describes some items in Agreements records.

Table 47. Selected Items in the All Agreements View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>Code for the type of currency; for example, USD for U.S. dollars. For agreement-based invoicing, this value is used as the target, or overriding, currency. Before performing invoice calculations, all the input currency values, such as the ones in the NPR Plan and the Usage Plan, are converted to the target currency. Calculations are then performed in the target currency. After the calculations are completed, these values are written back as Invoices, Invoice Line Items, and Invoice Line Item Details, all in the target currency.</td>
</tr>
<tr>
<td>Effective</td>
<td>Actual date the agreement is effective. Can be later than, earlier than, or the same as the Start date.</td>
</tr>
<tr>
<td>End</td>
<td>Date the agreement will end.</td>
</tr>
<tr>
<td>Start</td>
<td>Date the agreement is planned to start.</td>
</tr>
<tr>
<td>Valid</td>
<td>Indicates the agreement is valid. Must be selected for consideration of the entitlements when verifying coverage with “Verify Button” on page 52. Also, preventive maintenance actions for assets are only initiated if this box is selected and the selected entitlement is active, based on its start and end dates.</td>
</tr>
</tbody>
</table>
**Line Items View**

The Line Items view records a description of each product sold or provided under a selected service agreement. Table 48 describes items in this view.

Table 48. Selected Items in the Line Items View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset #</td>
<td>Number of an asset associated with the product described in this line item record, or the number of an asset for a different product, used for asset-based pricing. For more information, see “Defining Asset-Based Pricing” on page 203. Specifying an asset of the product described in the line item is appropriate, for example, when specifying a trade-in. This case can include a discount available only for trade-ins.</td>
</tr>
<tr>
<td>Entitle</td>
<td>Menu command and button. Automatically associates entitlements (from entitlement templates) with the product described in the selected line item. Selecting a second time associates any new entitlements, but does not update entitlements that are already associated. For more information, see “Entitlement Templates View” on page 247 and “Products Subview” on page 250.</td>
</tr>
<tr>
<td>Product</td>
<td>Product for this line item. Can be a service product.</td>
</tr>
<tr>
<td>Reprice</td>
<td>Menu command. Calculates the price for the selected line item, based on the associated price list and pricing procedure.</td>
</tr>
<tr>
<td>Reprice All</td>
<td>Menu command and button. Calculates the price for all line items, based on the associated price list and pricing procedure.</td>
</tr>
<tr>
<td>Renewal</td>
<td>Button that displays when the Renewal Escalator subview is selected. For more information, see “Setting Up Agreement Renewal” on page 205.</td>
</tr>
</tbody>
</table>

**Totals Subview**

The Totals subview displays the total price, before tax and shipping charges, for the agreement line items and applied discounts. To see this subview, click the Totals subview tab.

**Line Item Attributes Subview**

If the product is customizable, the product attributes appear in this subview. To see this subview, click the drop-down list in the Totals subview and select Line Item Attributes.
**Line Detail Subview**

The Line Detail subview contains additional fields that define an agreement line item. Some fields are filled in automatically with the product selected in the Line Items view. Table 49 describes items on the Line Detail subview.

Table 49. Selected Items in the Line Detail Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset #</td>
<td>The number of an asset to use. For more information, see “Process of Setting Up Agreements” on page 202.</td>
</tr>
<tr>
<td>Discount %</td>
<td>A discount percentage applied directly to the selected line item.</td>
</tr>
<tr>
<td>Net Discount %</td>
<td>A calculated field whose value is equal to (Start Price - Discount Amount) / Start Price.</td>
</tr>
<tr>
<td>Discount Amount</td>
<td>A discount amount applied directly to the selected line item.</td>
</tr>
<tr>
<td>Usage Asset #</td>
<td>Number of the asset to use for billing of usage. For more information, see “Charge Consolidation Plans View” on page 310.</td>
</tr>
<tr>
<td>Line #</td>
<td>Number assigned to each line item in the Line Items view, starting with 1.</td>
</tr>
<tr>
<td>Sequence</td>
<td>Indicates the hierarchical relationship of line items.</td>
</tr>
</tbody>
</table>

**Renewal Escalator Subview**

The Renewal Escalator subview is used to create and modify renewal terms of agreement line items. When the Renewal Escalator subview tab is selected, a Renewal button is available in the Line Items view for manual renewal of line items. Alternatively, you can automate the renewal process using the FS - Agreement Renewal workflow. See “Workflow to Automatically Renew Agreement Line Items” on page 245 for more information. Table 50 describes items on the Line Detail subview.

Table 50. Selected Items in the Renewal Escalator Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>The start of agreement line item renewal.</td>
</tr>
<tr>
<td>End Date</td>
<td>The end of the agreement line item renewal.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the renewed agreement when it is created.</td>
</tr>
<tr>
<td>Line Price Adjustment Type</td>
<td>The adjustment type of the main agreement line item.</td>
</tr>
<tr>
<td>Line Price Adjustment Amount</td>
<td>The amount by which the line item price should be adjusted.</td>
</tr>
<tr>
<td>NRC Adjustment Type</td>
<td>The adjustment type of the NRC for the main agreement line item.</td>
</tr>
</tbody>
</table>
Invoice Subview

The Invoice subview displays all of the invoices associated with a line item. These records are automatically produced by the Charge Consolidation Engine (Invoice Engine) when the user clicks the Auto Invoice button or when the engine is invoked using a workflow.

Entitlements View

The Entitlements view displays entitlements and associates them with specific agreements.

**NOTE:** End users should use the Entitlements view on the Agreements screen. The Entitlements screen ("Entitlements Screen" on page 260) is used for general administrative work across agreements.

Accounts Subview

The Accounts subview associates accounts with specific entitlements. Table 51 describes the items in accounts records.

<table>
<thead>
<tr>
<th>Items</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Contacts</td>
<td>Indicates all contacts associated with this account are covered by this entitlement. Entitlement verification uses this information. For more information, see &quot;Verify Button&quot; on page 52.</td>
</tr>
<tr>
<td>All Products</td>
<td>Indicates all products are covered by this entitlement. Entitlement verification uses this information.</td>
</tr>
</tbody>
</table>
Entitlement Details Subview
The Entitlement Details subview displays additional details for a selected entitlement. Table 52 describes items in entitlement detail records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Qty</td>
<td>Enter the current quantity covered by the entitlement.</td>
</tr>
<tr>
<td></td>
<td>Your Siebel application does not automatically update the current quantity.</td>
</tr>
<tr>
<td></td>
<td>You must update it manually each time it changes.</td>
</tr>
<tr>
<td>Initial Qty</td>
<td>Enter the initial quantity covered by the entitlement.</td>
</tr>
<tr>
<td>Activity Override Flag</td>
<td>Determines whether the billable flag, rate list, and price list specified in</td>
</tr>
<tr>
<td></td>
<td>this entitlement override the billable flag, rate list, and price list specified for a service request.</td>
</tr>
</tbody>
</table>

Products Subview
The Products subview associates assets and products with entitlements. The records in this view provide a list of products covered by the selected entitlement. These records are used when the All Products check box in the Accounts subview is not selected, and the entitlement is valid only for specific products or assets.

**NOTE:** The Agreements screen > Line Items view specifies the products purchased or provided under this agreement. The Agreements screen > Entitlements view > Products subview defines the level of service provided for each product and asset associated with the agreement. For more information, see "Line Items View" on page 253.

Contacts Subview
The Contacts subview associates contacts at an account with a specific entitlement. The records in this view are used when the All Contacts check box (in the Accounts subview) is not selected and the entitlement is valid only for specific individuals.

Metrics Subview
The Metrics subview records performance measurements for an entitlement; for example, response time for a service call and customer satisfaction rating. The Response Time metric is required for calculating Agent Committed time in the Service Request view. This is the only entitlement metric that is used directly to determine a level of service. For more information, see "Service Requests View" on page 257.
Service Details Subview
The Service Details subview defines the billing terms for service activities covered by the entitlements. Table 53 describes items in Service Detail records.

Table 53. Selected Items in the Service Detail Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenses Billable</td>
<td>Indicates the service expenses under this entitlement are billable to the customer.</td>
</tr>
<tr>
<td>Maximum Expense Discount</td>
<td>Limit of expense discounts that a customer may receive for a selected activity type.</td>
</tr>
<tr>
<td>Maximum Time Billable</td>
<td>Limit of time charges that a customer may receive for a selected activity type.</td>
</tr>
<tr>
<td>Parts Billable</td>
<td>Indicates the parts provided under this entitlement are billable to the customer.</td>
</tr>
<tr>
<td>Service Charge</td>
<td>Fixed charge included in the invoice. This may be the only charge if service is based on a flat rate.</td>
</tr>
<tr>
<td>Time Billable</td>
<td>Indicates time (labor) under this entitlement is billable to the customer.</td>
</tr>
</tbody>
</table>

Price Details Subview
The Price Details subview records special pricing considerations for products covered by the entitlement; for example, discounts or markups. This special pricing is used only for pricing order line items. See “Defining Pricing for Agreements” on page 203 for more information.

Service Requests View
The Service Request view displays new or existing service requests for a selected agreement. Service request records appear automatically in this view when a user verifies coverage and selects an entitlement.

For more information about service requests, see Chapter 3, “Service Support.”

Financials View
The Financials view for the agreement references the quotes and orders corresponding to the agreement. From the Quotes screen > List > Agreements view and the Service Order screen > List > Agreements view, users can click the Auto Contract button to automatically create an agreement based on the quote and order contract. The data mapping will determine what fields are copied into the agreement. See “Configuring Data Maps to Copy Specified Items” on page 213 for more information.
The Origin and Renewal Details section contains the origins of the agreement—the order and quote information. Renewals are done at the level of the agreement line items.

The Total Amounts section contains the revenue totals for the agreement including net discounts, adjustments, taxes, and shipping.

**NOTE:** The Total Amounts section should ideally be synchronized with the Accounts Receivable system to provide suitable visibility for contract revenue.

The Estimated and Actual Revenue section contains the following information:

- The possible revenue potential and cost of that revenue
- The actual revenue and the actual cost of that contract revenue

This information is particularly useful for contract renewals. For example, a contract may have a possible revenue of $700,000 based on all the products which have a service agreement up for renewal. However, when the negotiation of the contract renewal takes place, support for some of the products is dropped because the product is not being used any more, the products are obsolete, or because they are bundled differently.

The revenue should be based on the following:

- The price of the product being supported
- The percentage of that price that the support costs

Both of these are defined in the price list and the cost list, using the Administration - Pricing screen.

Finally, the Revenue Recognition and Invoice Details section contains information about the amount invoiced, the date of the invoice and the invoice schedule. This information is supplied by the Charge and Invoice module. Table 54 describes items in the Financials view.

Table 54. Selected Items in the Financials View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Term Months</td>
<td>A calculated field, which displays the term of the agreement header.</td>
</tr>
<tr>
<td>Months Left</td>
<td>A calculated field, which displays the number of months left for the term.</td>
</tr>
<tr>
<td>Renewal Term</td>
<td>The duration of the next term should the customer chooses to renew.</td>
</tr>
<tr>
<td>Renewal %</td>
<td>The percentage likelihood of the customer renewing.</td>
</tr>
<tr>
<td>Actual Margin</td>
<td>A calculated field, which uses the preceding actual cost and actual revenue figures to calculate and display the margin between both.</td>
</tr>
<tr>
<td>Est Margin</td>
<td>A calculated field, which uses the preceding estimated cost and estimated revenue figures to calculate and display the margin between both.</td>
</tr>
<tr>
<td>Rev Recognition</td>
<td>Revenue recognition is based on the months left of the term. This is a drop-down list with the following options that the user can select from: Annually, As Received, Daily Monthly, Quarterly, and so on.</td>
</tr>
</tbody>
</table>
This view is also useful for co-term information. See “Using Co-Terms” on page 236 for more information.

**Terms and Totals View**

The Terms and Totals view displays the payment, taxes, and shipping information for an agreement.

**Terms and Totals Subview**

The Terms and Totals subview displays the totals of service, parts, shipping, and tax billed to an agreement. Table 55 describes items in totals records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment</td>
<td>Value entered in this field is subtracted from the value in the Total field.</td>
</tr>
<tr>
<td>Products</td>
<td>Sum of agreement line items that have the Service field set to No minus discounts. For more information, see “Line Items View” on page 253.</td>
</tr>
<tr>
<td>Services</td>
<td>Sum of agreement line items that have the Service field set to Yes, minus discounts. For more information, see “Line Items View” on page 253.</td>
</tr>
<tr>
<td>Shipping</td>
<td>Cost of shipping. Copied from the Shipping Charges field in the Terms and Totals view.</td>
</tr>
</tbody>
</table>

**Activities View**

The Activities view associates activities with agreements.

**Activity Plans View**

The Activity Plans view associates activity plans with agreements.

**Approval History View**

The Approval History view shows who approved this agreement. The Workflow Manager automatically creates these records as people approve an agreement.

**Attachments View**

The Attachments view displays files related to selected agreements.
Discounts View

The Discounts view displays the invoices that are associated with this agreement. These records are automatically generated for service requests that are related to a selected agreement based on a selected entitlement. The discounts reflected here are based on special pricing defined under the entitlement.

Notes View

The Notes view allows you to add notes to an agreement. You can add a private note (visible only for the logon ID under which it was created) on the Private tab or a public note (visible to all users) on the Public tab.

Orders View

The Orders view displays a list of all orders associated with an agreement. This view allows you to create orders directly from a selected agreement.

For information about orders, see *Siebel Order Management Guide*.

Entitlements Screen

The Entitlements screen displays the accounts, contacts, entitlement metrics, preventive maintenance plans, and products associated with entitlements across all agreements.

The Transferable Flag field, when selected, transfers the entitlement from an uninstalled asset to an installed asset upon recording an asset swap. For more information, see "Asset Swaps" on page 470.

Agreements Charts

The Agreements screen (Agreements screen > Charts view) provides charts for analysis, listed in Table 56.

Table 56. Agreements Analysis

<table>
<thead>
<tr>
<th>Chart</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Analysis by Effective Date</td>
<td>Number of agreements beginning as a function of effective date.</td>
</tr>
<tr>
<td>Trend Analysis by Expiration Date</td>
<td>Number of agreements ending as a function of expiration date.</td>
</tr>
</tbody>
</table>
Agreements Reports

The Reports menu (Reports button) provides reports for Agreements, listed in Table 57.

Table 57. Agreements Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement Summary</td>
<td>Summary of each agreement, printing three agreements per page.</td>
</tr>
<tr>
<td>Current Agreement Detail</td>
<td>All information about each agreement and associated line items.</td>
</tr>
</tbody>
</table>
This chapter describes Siebel Advanced Contracts. It includes the following topics:

- About Advanced Contracts on page 263
- Scenario for Advanced Contracts on page 264
- Process of Managing Advanced Contracts on page 265
- Creating Benefit and Condition Templates on page 266
- Adding Terms to Agreements on page 270
- Adding Benefits to Agreements on page 271
- Adding Conditions to Benefits on page 272
- Verifying Compliance on page 272
- About Workflows for Advanced Contracts on page 273
- About Business Services for Advanced Contracts on page 274
- About Configuring the Revise Button on page 279
- About Configuring the Add Benefits Button on page 279
- About Configuring the Entitle Button on page 279
- Using the Task UI Application to Add Assets to Agreements on page 280

**About Advanced Contracts**

Siebel Advanced Contracts may be used by Contract administrators, account managers, and customer service representatives. Agreement data is stored in Agreement records which may be created, revised, examined, and printed.

Important features in Siebel Advanced Contracts are:

- Benefits
- Conditions
- Compliance History
- Terms
- Benefit, Condition, and Term Templates

**Contracts Terms Defined**

This section defines agreements and related terms as used in the Siebel interface.
Agreements (used interchangeably with the term Contracts). A document that defines the business relationship between two parties, including obligations to offer, provide, or produce specific products or services over a set period of time for a specific amount of money.

Entitlements. Define coverage available to the customer under the terms and conditions of the agreement.

Benefits. Define the services or products available to the customer under the terms and conditions of the agreement.

Conditions. Are criteria determining whether the parties are entitled to the benefits defined by the contract.

Terms. Are language terms not already included in the agreement.

Compliance. Is the history of adherence to the terms and conditions of the agreement.

Common Agreement Types
The two most common types of agreements are:

Service agreement

A service agreement is a contract for service. For example, a customer purchases a product from an equipment manufacturer, who might negotiate a service agreement with the customer providing a special discounted rate for service over a predetermined period of time.

Sales Agreement

A sales agreement is a contract that provides for special pricing and other benefits when products are purchased. For example, a supply company negotiates a sales agreement with a customer for a rebate, based on volume purchases.

Scenario for Advanced Contracts
The following scenario is designed to illustrate the functionality of Siebel Advanced Contracts. It shows a sample business process performed by the Contract administrator and the customer service representative or account manager.

Your company may follow a different business process according to its business requirements.

Roles and Responsibilities
This section describes the responsibilities of the people involved in contract management.

Contract Administrator
The Contract administrator sets up the agreement templates (Entitlements, Benefits, Conditions, and Terms), administers the contract during its term, and manages its renewal.
Customer Service Representative or Account Manager
The customer service representative or account manager sells, documents, or sells and documents the contract. The customer service representative or account manager will create the draft agreement to represent the negotiated terms and conditions using entitlement, benefit, condition, and term templates created by the administrator. When appropriate, after the contract has been negotiated, updated in Siebel Field Service, and approved by all parties, the contract manager makes it active.

Scenario
A hardware company has signed an agreement with a purchasing department (PD) of a multinational company. This agreement entitles the PD to a 10% rebate on purchases of a specific product made by its divisions each quarter when the volume of purchases of the product exceeds 3000 units.

Independent from this contract, the administrator creates new term templates, for example, a term template stating that arbitration will be used to resolve disputes. The administrator also creates new benefit and condition templates. One benefit template, which might be used when creating the contract for this customer, defines a 10% rebate. The benefit template can be defined with associated conditions. In the case of this benefit template for the 10% rebate, the administrator might add a condition that the benefit is delivered only when more than 3000 units of the product are purchased within a given quarter.

The account manager creates a new Agreement in Siebel Field Service and adds the appropriate data. The account manager adds terms, benefits, and conditions to the agreement using templates or manually as described by the procedures in this chapter.

After the agreement becomes active, the conditions governing the benefit will be evaluated, the compliance recorded, and, if appropriate, the benefit will be delivered.

The following topics describe the individual procedures for completing these tasks.

Process of Managing Advanced Contracts
This sample process represents the tasks that are carried out in the “Scenario for Advanced Contracts” on page 264.

Administrator Procedures
See Chapter 7, “Agreements” for procedures specific to administrator tasks. In addition, the following procedure is specific to Advanced Contracts: Creating Benefit and Condition Templates on page 266.

The Contracts administrator is also responsible for setting up workflows. For more information about workflows, see “About Workflows for Advanced Contracts” on page 273.

End-User Procedures
Refer to Chapter 7, “Agreements” for procedures specific to End-User tasks. In addition, the following procedures are specific to Advanced Contracts:
Creating Benefit and Condition Templates

In this section, the Contract administrator will create templates for new benefits and conditions.

**To create a new benefit template**

1. Navigate to the Contracts Administration screen.
2. Select Entitlement Templates in the Contracts Administration screen.
3. Select an existing entitlement template or create a new entitlement template.
4. Select the Benefits tab to view Benefit templates associated with the selected entitlement template.
5. Create a new record and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>The priority of the benefit in relation to other benefits.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the benefit; for example, Rebate on a product.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of benefit; for example, Credit or Rebate.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The benefit schedule; for example, Quarterly.</td>
</tr>
<tr>
<td>Amount</td>
<td>The total amount of the benefit in the unit defined in the U/M field.</td>
</tr>
<tr>
<td>U/M</td>
<td>The unit in which the benefit is measured; for example, Percent.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the benefit; for example, Active or On Hold.</td>
</tr>
<tr>
<td>Action Basis</td>
<td>The basis for evaluating or delivering the benefit; for example, if the Benefit is triggered by an invoice for a particular quantity of products, Action Basis=Invoice.</td>
</tr>
<tr>
<td>Action Method</td>
<td>The action produced by the Action Basis; for example, if an allowance is administered by adjusting the invoice, Action Method = Adjustment.</td>
</tr>
<tr>
<td>Current Amount</td>
<td>The existing amount of the benefit including any adjustments already made, or the current liability for the benefit.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the benefit.</td>
</tr>
<tr>
<td>Field</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Benefit Basis</td>
<td>Used when the Benefit Amount is variable and is calculated based on another value; for example, 10% of Invoice Amount, Benefit Basis = Invoice Amount.</td>
</tr>
<tr>
<td>Benefit Price</td>
<td>Used when the Benefit Amount is variable and is calculated based on another value; for example, for a 5% discount, the Benefit Price specifies the starting price for Siebel Pricer.</td>
</tr>
<tr>
<td>Benefit Constraint</td>
<td>Indicates the maximum or minimum amount of the Benefit when it is calculated using Benefit Basis and/or Benefit Price.</td>
</tr>
<tr>
<td>Tier</td>
<td>Enables benefits to be defined differently for different tiers; for example 10% discount for Tier 1, 15% discount for Tier 2, where the volume of purchases determines the appropriate tier.</td>
</tr>
<tr>
<td>Division</td>
<td>Defines the division to which the benefit applies.</td>
</tr>
<tr>
<td>Product Category</td>
<td>Indicates the product category associated with the benefit.</td>
</tr>
<tr>
<td>Product</td>
<td>Indicates the product associated with the benefit.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Indicates the product line associated with the benefit.</td>
</tr>
<tr>
<td>Product Class</td>
<td>Indicates the product class associated with the benefit.</td>
</tr>
<tr>
<td>All Products</td>
<td>Indicates that All Products are associated with the benefit.</td>
</tr>
<tr>
<td>Level</td>
<td>Indicates the level at which the benefit applies; for example, Account, Agreement, Entitlement.</td>
</tr>
<tr>
<td>Comments</td>
<td>Used to capture additional comments related to the benefit.</td>
</tr>
<tr>
<td>Reset</td>
<td>Can be used to indicate that the benefit should be reset; for example, the benefit should be reset if exhausted, when the agreement is renewed or annually.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Indicates all conditions must be met (&quot;and&quot;) or only one condition must be met (&quot;or&quot;) in order to deliver the benefit.</td>
</tr>
<tr>
<td>Relationship</td>
<td></td>
</tr>
<tr>
<td>Adjustment Amount</td>
<td>Used when Action Method = Adjustment to indicate the amount of the adjustment.</td>
</tr>
<tr>
<td>Adjustment Currency</td>
<td>Indicates the currency associated with the Adjustment Amount.</td>
</tr>
<tr>
<td>Adjustment Exchange Date</td>
<td>Specifies the Exchange Date for the Adjustment Currency.</td>
</tr>
<tr>
<td>Amount Currency</td>
<td>Specifies the currency when U/M = Currency.</td>
</tr>
</tbody>
</table>
Creating Benefit and Condition Templates

Creating a new condition template

1. Navigate to the Contracts Administration screen.
2. Select Entitlement Templates in the Contracts Administration screen.
3. Select an existing entitlement template or create a new one.
4. Select the Benefits tab to view Benefit templates.
   When you select the Benefits tab, the Conditions applet is also displayed.
5. Select a Benefit Template record, and in the Conditions list, create a new record and complete the necessary fields.

**NOTE:** There must be a benefit template selected in order to create a new condition. You may use AND, OR, and other expressions to define the condition.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount Exchange Date</td>
<td>Specifies the exchange date for the Currency indicated by Amount Currency.</td>
</tr>
<tr>
<td>Count Method</td>
<td>Indicates whether the Current Amount should be incremented (to track the amount of benefit delivered) or decremented (to track remaining liability) when the benefit is delivered.</td>
</tr>
<tr>
<td>Order</td>
<td>The sequence of conditions.</td>
</tr>
<tr>
<td>Type</td>
<td>The condition type; for example Volume.</td>
</tr>
<tr>
<td>Subtype</td>
<td>The condition subtype; for example Product Line.</td>
</tr>
<tr>
<td>Operator</td>
<td>The logical operator used to define the condition; for example, when more than 3000 parts have been ordered (operator is &gt;), or if membership = Gold (operator is =).</td>
</tr>
<tr>
<td>Target Amount</td>
<td>The target amount to be reached to satisfy the condition.</td>
</tr>
<tr>
<td>Target U/M</td>
<td>The unit in which the target amount is measured; for example Units.</td>
</tr>
<tr>
<td>Enforceable</td>
<td>Indicates that the condition should be enforced when determining benefit delivery. You might set this value to N (by clearing the check box) to learn more about the customer so that you could negotiate better contracts in the future without affecting benefit delivery.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the condition.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the condition; for example, Active or Exhausted.</td>
</tr>
<tr>
<td>Field</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Timing</td>
<td>The timing of the condition; for example, if Quarterly is chosen, the condition should be satisfied in one quarter.</td>
</tr>
<tr>
<td>Comments</td>
<td>Additional comments the sales representative, customer service representative, or Contract administrator may want to add to the condition.</td>
</tr>
<tr>
<td>Current Amount</td>
<td>The existing amount used to evaluate the condition; for example for this condition: revenue &gt; $40,000, current amount is used to track the current revenue.</td>
</tr>
<tr>
<td>Range</td>
<td>Specifies a range around the target amount; for example +/- 10%.</td>
</tr>
<tr>
<td>Range U/M</td>
<td>Indicates the unit of measure for the Range amount.</td>
</tr>
<tr>
<td>Expression</td>
<td>Used to define complex conditions such as those with logical complexities or complex field combinations.</td>
</tr>
<tr>
<td>Adjustment Value</td>
<td>Used to adjust the benefit based on the condition; for example adjust benefit to 0% discount.</td>
</tr>
<tr>
<td>Adjustment U/M</td>
<td>Defines the unit of measure for the Adjustment Value.</td>
</tr>
<tr>
<td>Mix %</td>
<td>Can be used to track expected purchases; for example, 20% Product A, 15% Product B, and so on.</td>
</tr>
<tr>
<td>Type of Calculation</td>
<td>Used to adjust benefit amount.</td>
</tr>
<tr>
<td>Tier</td>
<td>Used to associate a condition with a specific tier, enabling you to define different conditions to different tiers of customers.</td>
</tr>
<tr>
<td>Product</td>
<td>Used with Subtype = Product to specify the product associated with the condition.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Used with Subtype = Product Line to specify the product line associated with the condition.</td>
</tr>
<tr>
<td>Product Class</td>
<td>Used with Subtype = Product Class to specify the product class associated with the condition.</td>
</tr>
<tr>
<td>Product Category</td>
<td>Used with Subtype = Product Category to specify the product category associated with the condition.</td>
</tr>
<tr>
<td>Target Currency</td>
<td>Defines the currency for the target amount when the target U/M is currency.</td>
</tr>
<tr>
<td>Target Exchange Date</td>
<td>Specifies the exchange date for the target currency when target U/M is currency.</td>
</tr>
<tr>
<td>Range Currency</td>
<td>Defines the currency for the range amount when Range U/M is currency.</td>
</tr>
</tbody>
</table>
Adding Terms to Agreements

This topic assumes that the agreement has already been entered in Siebel Field Service. The example is based on information provided in the section “Scenario for Advanced Contracts” on page 264.

The following procedure describes how to create terms for an agreement.

**To create terms for an agreement**

1. Navigate to the Agreements screen, and select your agreement.
2. Click the Terms view tab.
   
   If it does not appear, click the down arrow next to the third-level view tabs to select it.
3. In the Terms view, you can either create a new term or add an existing term from a template:
   
   a. Click the Add button to add an existing term to the agreement.
      
      ▪ Select a term to add to the agreement.
      ▪ Use Ctrl+Click to select multiple terms in the list.
      ▪ Use Ctrl+A to select all terms in the list.
   
   b. Click OK to add the selected Term(s) to the agreement.

Alternatively:

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range Exchange Date</td>
<td>Specifies the exchange date for the range currency when Range U/M is</td>
</tr>
<tr>
<td></td>
<td>currency.</td>
</tr>
<tr>
<td>Adjustment Currency</td>
<td>Defines the currency for the adjustment amount when the Adjustment</td>
</tr>
<tr>
<td></td>
<td>U/M is currency.</td>
</tr>
<tr>
<td>Adjustment Exchange Date</td>
<td>Specifies the exchange date for the adjustment currency when Adjustment</td>
</tr>
<tr>
<td></td>
<td>U/M is currency.</td>
</tr>
<tr>
<td>Condition Object Name</td>
<td>Specifies a business object containing the field used in evaluating the</td>
</tr>
<tr>
<td></td>
<td>condition.</td>
</tr>
<tr>
<td>Condition Object Field</td>
<td>Specifies the field within the business object identified by the Condition</td>
</tr>
<tr>
<td></td>
<td>Object Name to be used in evaluating the condition.</td>
</tr>
<tr>
<td>Count Method</td>
<td>Indicates whether the condition current amount should be incremented or</td>
</tr>
<tr>
<td></td>
<td>decremented.</td>
</tr>
</tbody>
</table>

- Range Exchange Date
- Adjustment Currency
- Adjustment Exchange Date
- Condition Object Name
- Condition Object Field
- Count Method

- Fields
- Comments
Click the New button to create a new term, which does not exist in the current library of term templates, to the agreement and complete the appropriate fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section</td>
<td>The section number for the term.</td>
</tr>
<tr>
<td>Term Name</td>
<td>A representative description for the term; for example, Term Length.</td>
</tr>
<tr>
<td>Type</td>
<td>The legal type of the term: Standard, Non-Standard, or Special.</td>
</tr>
<tr>
<td>Description</td>
<td>The actual term as it is used in the agreement.</td>
</tr>
</tbody>
</table>

**NOTE:** Once terms are inserted into the agreement from Term Templates, they may be manually edited.

### Adding Benefits to Agreements

Once the agreement has been created, the account manager creates specific benefits for the agreement.

**To create a benefit for an agreement**

1. Navigate to the Agreements screen, and select the agreement.
2. Click the Entitlements view tab.
3. Select an Entitlement or create a new Entitlement.
   
   **NOTE:** Benefits and conditions are instantiated with entitlements.

4. Click the Benefits view tab.

5. In the Benefits view, you can either add a benefit from existing benefit templates or create a new benefit.
   
   - Click the Add Benefits button to add a benefit from an existing benefit template.
     
     **NOTE:** You can use the Apply Template button to constrain the list of benefits based on the selected parent entitlement template.
   
   - Click the New button to create a new benefit and complete the appropriate fields.

The fields available in the Benefits applet are described in “Creating Benefit and Condition Templates” on page 266.

**NOTE:** Adding an existing Benefit from a template with Conditions defined will instantiate both the Benefit and related Conditions.
Adding Conditions to Benefits

Once the benefit has been created, the sales representative may need to add conditions to the benefits. You can design many different types of benefits and conditions, such as a rebate when the customer purchases a certain number of products for each quarter. Until that condition is met, the customer will not receive the benefit.

To add a condition to a benefit

1. Navigate to the Agreements screen, and select your agreement.
2. Click the Entitlements view tab.
3. Select your Entitlement or add a new Entitlement.
4. Click the Benefits view tab.
5. Select your Benefit or add a new Benefit.

The Conditions list is displayed below the Benefits list.

**NOTE:** Adding an existing Benefit from a template with Conditions defined will instantiate both the Benefit and related Conditions. See "Adding Benefits to Agreements" on page 271.

6. Click the New button to create a new condition, and complete the appropriate fields.

**NOTE:** You may use AND, OR, and other expressions to define the condition.

The fields available in the Condition applet are described in "Creating Benefit and Condition Templates" on page 266.

Verifying Compliance

Once conditions have been added to the benefits, you can use Siebel Workflow to automatically evaluate compliance, or you can verify compliance manually. Use the Compliance applet to track compliance to the conditions over time.

To manually verify compliance

1. Navigate to the Agreements screen, and select your agreement.
2. Click the Entitlements view tab.
3. Click the Benefits view tab.
4. Select the Agreement, Entitlement, Benefit, and Condition being evaluated.

The Compliance applet is displayed next to the Conditions applet.
Click the New button in the Compliance applet to create a new compliance record and complete the fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verified</td>
<td>The date that compliance was verified. This field is automatically populated with the current date when you insert a new record.</td>
</tr>
<tr>
<td>Verified By</td>
<td>The username of the person verifying compliance. This field is automatically populated with the username of the person creating the record. You can use the pick applet to locate a different name.</td>
</tr>
<tr>
<td>Actual</td>
<td>The actual value used to evaluate the condition; for example, the number of items ordered this quarter (3002), the value compared to the Target amount.</td>
</tr>
<tr>
<td>Achieved</td>
<td>A Yes or No field indicating if the condition has been achieved.</td>
</tr>
<tr>
<td>Comments</td>
<td>Additional comments you may want to add.</td>
</tr>
</tbody>
</table>

There are additional fields in the Compliance applet. They are described in Table 58.

Table 58. Additional Fields in the Compliance Applet

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>Used to track the start of the period over which the condition has been evaluated.</td>
</tr>
<tr>
<td>End Date</td>
<td>Used to track the end date of the period over which the condition has been evaluated.</td>
</tr>
</tbody>
</table>

**About Workflows for Advanced Contracts**

You can create workflows to suit your business model using Siebel Business Process Designer. For more information, see *Siebel Business Process Framework: Workflow Guide*.

Siebel workflows are especially helpful in automating the following agreement-related business processes:

- Routing an agreement for approval.
- Evaluating agreement conditions in real time, for example, when an order is invoiced, and at scheduled intervals, for example, at the end of quarter.
- Delivering contract benefits if appropriate, for example, create invoice for a rebate or place an order for a give-away.
- Tracking condition compliance.
About Business Services for Advanced Contracts

To support automation of business processes related to the agreements, there are three new business services:

- Contracts Accumulator Service on page 274
- Contracts Resolver Service on page 275
- Condition Evaluator Service on page 278

Contracts Accumulator Service

This business service can be used in workflows to manage incrementing or decrementing an allowance pool.

Manage Running Total Method

Table 59 details the input arguments for the Manage Running Total method.

Table 59. Input Arguments for Manage Running Total Method

<table>
<thead>
<tr>
<th>Input Argument</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 1</td>
<td>Count Method</td>
<td>Indicates whether the counter is incrementing or decrementing. Possible values are Increment or Decrement.</td>
</tr>
<tr>
<td>Input 2</td>
<td>Current Amount</td>
<td>Indicates the current value of the counter before the benefit amount is applied for this transaction.</td>
</tr>
<tr>
<td>Input 3</td>
<td>Valid Transaction Amount</td>
<td>Represents the amount of benefit to be applied and reflected in the running total. This may be calculated by the Contracts Resolver Service; see “Contracts Resolver Service” on page 275.</td>
</tr>
</tbody>
</table>
Table 60 details the output arguments for the Manage Running Total method.

<table>
<thead>
<tr>
<th>Output Argument</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 1</td>
<td>Adjusted Current Amount</td>
<td>The updated running total, adjusted by Accumulator to reflect the amount of benefit applied (Valid Transaction Amount)</td>
</tr>
</tbody>
</table>

Figure 13 illustrates the Accumulator business service flow.

Contracts Resolver Service

This business service can be used in workflows to resolve issues associated with managing an allowance or pool when the amount to be decremented is larger than the remaining allowance or pool.
**Resolve Transaction Amount Method**

Table 61 details the input arguments for the Resolve Transaction Amount method.

<table>
<thead>
<tr>
<th>Input Argument</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 1</td>
<td>Current Amount</td>
<td>Indicates the current value of the counter before the benefit amount is applied for this transaction.</td>
</tr>
<tr>
<td>Input 2</td>
<td>Requested Transaction Amount</td>
<td>The amount of the transaction to be considered for the benefit. This value can be calculated by a user-defined Business Service or Workflow. Example: For a Benefit of 2% credit on all invoices, the actual dollar amount calculated by taking 2% of the total invoices is the Requested Transaction Amount.</td>
</tr>
<tr>
<td>Input 3</td>
<td>Amount</td>
<td>This argument represents the amount of the benefit or the threshold for the condition. For example, if you wanted to use the business service to manage a benefit, you set this input equal to the Benefit Amount field. If you want to use this business service to manage a condition, you set this input equal to the Condition Target Amount field.</td>
</tr>
<tr>
<td>Input 4</td>
<td>Count Method</td>
<td>Indicates whether the counter is incrementing or decrementing. Possible values are Increment or Decrement.</td>
</tr>
</tbody>
</table>

Table 62 details the output arguments for the Resolve Transaction Amount method.

<table>
<thead>
<tr>
<th>Output Argument</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 1</td>
<td>Valid Transaction Amount</td>
<td>Resolver determines what portion of the requested benefit (Requested Transaction Amount) can be applied (Valid Transaction Amount).</td>
</tr>
</tbody>
</table>
Table 62. Output Arguments for Resolve Transaction Amount Method

<table>
<thead>
<tr>
<th>Output Argument</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 2</td>
<td>Remaining Transaction Amount</td>
<td>Resolver determines what portion of the requested benefit (Requested Transaction Amount) cannot be applied (Remaining Transaction Amount).</td>
</tr>
<tr>
<td>Output 3</td>
<td>Exhausted Flag</td>
<td>Indicates whether the amount of the benefit or the terms of the condition have been exhausted. You can use this setting to update the Status in either the Benefit or the Condition.</td>
</tr>
</tbody>
</table>

Figure 14 illustrates the Resolver business service flow.

![Resolver Business Service Flow Diagram](image)

Figure 14. Resolver Business Service Flow
**Condition Evaluator Service**

This business service can be used in workflows to compare two values in order to determine if a condition has been met.

**Evaluate Condition Method**

Table 63 details the input arguments for the Evaluate Condition method.

<table>
<thead>
<tr>
<th>Input Argument</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 1</td>
<td>Current Amount</td>
<td>Indicates the value used to evaluate if the condition has been met.</td>
</tr>
<tr>
<td>Input 2</td>
<td>Operator</td>
<td>The operator used for the calculation. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>=, &gt;, &lt;, &lt;=, &gt;=, BETWEEN (&lt; and &gt;), BETWEEN (&lt;= and &gt;=)</td>
</tr>
<tr>
<td>Input 3</td>
<td>Target Amount</td>
<td>This is the value to which the Current Amount is compared.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>May specify minimum and maximum bounds separated by a colon (Min:Max) for BETWEEN operator. This may be used to compare to the Benefit Amount, the Condition Amount, or the Target Amount.</td>
</tr>
</tbody>
</table>

Table 63 details the output arguments for the Evaluate Condition method.

<table>
<thead>
<tr>
<th>Output Argument</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 1</td>
<td>Compliance Flag</td>
<td>Indicates whether Condition has been met.</td>
</tr>
</tbody>
</table>

This business service compares the Current Amount to the Target Amount using the specified operator and sets the compliance flag.
About Configuring the Revise Button

When a user clicks the Revise button for an agreement:

- The agreement is revised, deep copied, and its version is incremented.
- Fields in the original agreement become read-only, according to the Read Only Upon Revise user property. See Table 65.

The read-only field behavior of the Revise button in the Agreements screen can be configured by editing the Read Only Upon Revise user property.

Table 65. How Read Only Upon Revise Determines Read-Only Behavior after Revision

<table>
<thead>
<tr>
<th>Read Only Upon Revise</th>
<th>Field Behavior of Original Agreement Record after Revise is Clicked</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All fields are read-only</td>
</tr>
<tr>
<td>Partial</td>
<td>All fields except End Date, Valid, and Status are read-only</td>
</tr>
<tr>
<td>None</td>
<td>No fields are read-only</td>
</tr>
</tbody>
</table>

For information about editing user properties, see Configuring Siebel Business Applications.

**NOTE:** Do not edit the Read Only Upon Revise Field user property.

About Configuring the Add Benefits Button

You can configure the Add Benefits button so that the available benefit templates are constrained by the parent entitlement record. This button is located in Agreements > Entitlements > Benefits. If you configure the Add Benefits button, only templates associated with the parent entitlement record will be displayed in the Benefit Template Popup Applet.

If you do not configure this button, the Benefit Template Popup Applet will display all available benefit templates instead of constraining the list to those associated with the parent entitlement template.

Set the following options to activate this user property:

- Name: Apply Template
- Value: Y

About Configuring the Entitle Button

The Entitle button is located in the Line Items view for Agreements. When you add a line item, you click the Entitle button to automatically associate entitlements with the line item based on the entitlement template associated with the product. See Chapter 7, “Agreements” for more information on the Entitle button.
You can edit the user property for the Entitle button so that it associates entitlements as well as the benefits and conditions associated with the Entitlement.

There are three possible values for the Method Invoked when the user clicks the Entitle button:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetEntitlements</td>
<td>This associates the Entitlement with the line item.</td>
</tr>
<tr>
<td>GetBenefits</td>
<td>This associates the Benefits and Conditions with the line item.</td>
</tr>
<tr>
<td>AutoEntitle</td>
<td>This associates both the Entitlement and its child Benefits and Conditions with the Line Item.</td>
</tr>
</tbody>
</table>

**Using the Task UI Application to Add Assets to Agreements**

Siebel Field Service includes the Assets to Agreement task to streamline the process of associating assets to a contract. This is a common task for salespeople who sell service contracts that cover existing assets. This repeatable task navigates through screens and views where you can enter multiple records in a way that is easier and faster than manually navigating through individual screens. For information on using the Task UI, see *Siebel Fundamentals*. For details on customizing, activating, and assigning access privileges for tasks, see *Siebel Business Process Framework: Task UI Guide*.

**Scenario for Adding Assets to Agreements with the Task UI Application**

A contract manager for a printer manufacturing company is in communication with a customer for a new support contract to cover 250 printer assets. The customer is concerned about the ongoing maintenance and repair of their printers, the responsiveness of service calls, and how quickly field repairs can be carried out. Not only does the customer require a high availability for their printers, but also a competitive price. While the contract manager understands that he wants to deliver a high quality service contract for the company to make sure the printers are kept working, he also needs to deliver a profitable service for his own company. Using the Assets to Contracts Task, he creates a service package, adds several printers to it, quotes a price for the contract, and creates a charge plan and promotional price discount for the first six months. Finally, he submits the contract for approval before printing it.

**Activating and Registering Tasks for Adding Assets to Agreements**

- To use the Assets to Agreements task in the Task UI application, you must activate and assign access privileges for the following tasks: FS Asset To Contract Task
- FS Cover Asset SubTask
Example of Using the Task UI Application to Add Assets to Agreements

The following example lists the steps that an end user performs to execute the Assets to Agreements task.

To execute an Assets to Agreement task

1. Navigate to Assets > List.
2. Click the Task button.
3. In the Task UI pane, click Assets to Agreement.
4. In the Review Address and Details screen, review and adjust any necessary fields.
5. In the Identify Agreement screen, choose to create a new agreement.
6. In the Agreement Details screen, complete or verify the information for the agreement. Click Next.
7. Select a service package to add to the agreement.
8. Verify or change the service agreement details.
9. Choose whether to add or remove assets to the service package:
   - If yes, click Next to add or remove assets to be covered under the service package.
   - If no, click Next to continue in the task.
10. Choose whether to add a charge plan to the agreement:
    - If yes, click Next to enter charge plan details.
    - If no, click Next to continue in the task.
11. In the Service Package Summary screen, review the details of the package.
12. In the Add Service Package screen, choose from the following options:
    - Create new line item
    - Use an existing line item
    - Continue
13. In the Add Agreement Terms screen, add a new record and query for the desired term.
14 In the Submit Agreement for Approval screen, choose to submit the agreement for approval or to continue.

If you submit an agreement for approval, verify the information on the Agreement Approval History screen.

15 In the Generate Agreement Document screen, click Submit.
Charges and Invoices

This chapter describes how to set up and generate charges and invoices for service requests, activities, and agreements. Topics include:

- Charges and Invoices Overview on page 283
- About Cost, Price, and Rate Lists on page 284
- Invoice Logic on page 285
- Process of Setting Up Charging on page 288
- Creating Charges on page 294
- Recording Billable Expenses on page 295
- Processes for Setting Up Invoicing on page 296
- Creating Invoices on page 298
- Post-Generation Invoice Tasks on page 300
- Workflows for Charges and Invoices on page 301
- Charges and Invoices Screens on page 308

Charges and Invoices Overview

In Siebel Field Service, you can manually or automatically create charges and invoices for service requests, activities, and agreements. A charge is an expense line item. An invoice is a bill that consolidates a group of charges incurred, or to be incurred, during a specific time period. The ability to create charges allows consolidation of all the charges for an individual account into one single invoice. An invoice can then be sent to each account.

Charges need to be generated before an invoice can be generated automatically, but not before an invoice can be generated manually. The parameters for consolidating charges into invoices are defined using a charge consolidation plan. Once the charge consolidation plan is defined, invoices can be automatically generated based on the charge consolidation plan. Invoices can also be manually generated.

Invoices for activities can include charges for parts, labor, and expenses. Invoices for service requests incorporate orders, plus the charges for all of the activities related to those particular service requests. Only records that have the Billable flag set are added to the invoice automatically.

Pro forma invoices can be printed onsite for customers and sent to an accounting system to track accounts receivable and revenue. An invoice can also be marked as delinquent, then tracked by the Workflow Manager, which can send automatic reminders to customers or employees.

Each invoice can include these line items:

- Time and materials
Charges and Invoices ■ About Cost, Price, and Rate Lists

- Miscellaneous expenses and tax
- Nonrecurring charges
- Recurring charges
- Use charges
- Project charges
- Credits or other adjustments

Siebel Invoices can be integrated with third-party software to manage taxation for entire invoices or for invoice line items. Without tax integration, Siebel Invoices prepares pro forma invoices, statements of work, or quick reports to customers. The collection of applicable charges and activities is also an efficient way to pass this information to a financial system.

Related Topics
- Agreements Overview on page 201
- Entitlements Overview on page 218

About Cost, Price, and Rate Lists

Cost, price, and rate lists must be set up for charges and invoices to be created correctly. Each list type is described in the following sections. For more information about cost lists, price lists, and rate lists, see Siebel Pricing Administration Guide.

Cost Lists

Field Service contains a costing infrastructure that allows users to track the costs as they are performed, and then export these costs to financial systems for posting to the general ledger. Previously, service organizations could only estimate the costs of performing service. Now they can associate costs of service calls at the time the service is performed.

In Field Service, price lists play an important part in charging and invoicing. The price list provides information to the Charge Engine on the price of parts and materials used in the activity associated with a service request. The price may be adjusted based on a service package.

Most companies have product cost information in their financial systems. Incorporating this information into Field Service has the following advantages:

- Costs can be associated with service requests and activities at the time they are performed.
- Costs can be associated with orders for analysis of profitability.
- Cost lists can have time limits, so that they provide an accurate record of costs at the time they occurred.
- Service inventory can be created at any time.
Price Lists
Price lists link cost lists to service requests, orders, and activities. For example, one cost list, North American Costs, describes the costs of products and resources in North America. When a field engineer chooses a price list for a service request, the associated cost list is automatically linked to the service request.

Rate Lists
Rate lists show the billable rate for a company’s employees. When creating a rate list, there are two main tasks that must be performed:

1. Create and release a new product with the resource name you require, for example, Field Engineer. Make sure the Project Resource flag is selected. Then, add the resource to your rate list with the corresponding rate.

2. Create a new position for the resource product you created and associate the position with the billing product. You can then enter the users to be billed at the newly created rate.

TIP: The service calendar is used to calculate regular, overtime, and extended overtime charges. To set up schedule hours for employees, use the Administration - Service screen > Schedules > Schedule Hours view. You can then associate the appropriate service calendar with an entitlement using the Agreements > List > Entitlements > Entitlement Details view. See "Defining Schedule Hours" on page 107 and "To associate a service calendar with an entitlement" on page 238 for more information.

NOTE: The entitlement schedule will take precedence over the schedule set at the employee level.

Invoice Logic
This section describes the business logic for generating invoices for service requests, activities, and agreements. See “FS Generate Conditional Charge Process Business Service” on page 555 for more information on the business service used to consolidate charges for invoice generation.

Logic for Service Requests
The charge consolidation business service uses the following process logic for service requests:

1. For a selected service request, find all records with the Billable flag set.

2. Find the rate and price lists for the items described in these records.

3. Calculate the price for each item.

4. If an entitlement covers the service request:
   a. Find the price and rate lists associated with the entitlement.
   b. If the Activity Override flag is set, recalculate the billable cost for the items using the price and rate lists for the entitlement instead of the lists for the activity and the entitlement service price details for the activity types covered.

5. If there is no entitlement, go to the next billable item.
6 If there are no more billable items, create an invoice.

**Logic for Activities**

The charge consolidation business service uses the following process logic for activities:

1. For a selected activity, find all expense, time, and part records with the Billable Flag set.
2. Find the rate and price list for the activity.
3. Calculate the price for each record.
4. Create an invoice.

**Logic for Agreements**

To automate the consolidation of agreement charges into invoices, the FS - All Charge Consolidation and FS - Charge Consolidation workflow processes invoke the FS Charge Consolidation business service methods. The following logic is used to:

1. Generate a list of the charge consolidation plans.
2. For the first charge consolidation plan, if the Next Invoice Date is before today, proceed.
3. Search for charges based on the consolidation rules.
4. Consolidate the charges, and create and generate the invoice.
5. Set the Last Invoice Date to today and get the new Next Invoice Date.
6. Check for additional charge consolidation plans to process.
7. If there is another plan, repeat Step 1 through Step 6.

The charge consolidation business service can generate periodic invoices that include these types of charges:

- **NRC.** Installment payments for one-time (nonrecurring) charges; for example, a one-time fee for service billed in one or more installments.
- **RC.** Payment of periodic (recurring) charges; for example, a monthly service charge.
- **Usage.** Payments based on the use of an asset; for example, the number of copies produced on a color copier each month.
- **Adjustments.** Credits or charges for the selected period.

**NOTE:** To increase flexibility, invoicing for agreements is implemented as a business service. See “FS Agreement Charge Business Service” on page 548 for more information on this business service.

**Logic for NRC Line Items**

The charge consolidation business service uses the following logic to process NRC line items:
1. If there is a previous charge, find the NRC Charged amount. If the nonrecurring amount is greater than or equal to the NRC charged amount plus the next amount to be invoiced, proceed.

2. If this is the first charge and if the NRC amount for the line item is greater than zero, proceed.

3. Calculate the NRC amount for the next charge, using the NRC plan, if selected.

4. Create an NRC line item on the charge.

**Logic for RC Line Items**
The charge consolidation business service uses the following process logic for recurring cost line items:

1. If the recurring charge on the invoice is greater than zero, proceed.

2. Calculate the RC amount.

3. Create an RC line item.

**Logic for Usage Line Items**
To generate charges from usage line items, you must first define the asset on which the usage is measured. You specify this asset in the Usage Asset # field in the Agreements screen, Line Items view, Line Detail subview. For accurate billing, the charge schedule must match the measurement frequency of the asset.

If you want to charge on estimated usage, you must define certain fields in the product measurement record of the asset’s product. See "Setting Up Use Plans" on page 289 for more information.

The charge consolidation business service uses the following logic for usage line items:

1. If there was a previous charge for this agreement line item’s use plan, find the reading on the last charge.

2. If this is the first charge for the use plan, find the reading closest to the Use Start date.

3. Find the reading closest to the current date or the Advance Invoice date.

4. If there is no new reading since the last charge or the Use Start date, and if the Estimate check box is selected (on the Administration - Service screen > Use Plans view), use the calculated average use defined in the Usage field (Assets screen > Measurements view) as the estimated reading.

5. If a reading is found, verify these values on the reading:
   - Is the Complete check box selected?
   - Is the Counter Type (defined in the Administration - Product screen > Service Information > Measurements view) set to Incremental or Absolute?

6. If the conditions in Step 5 are satisfied, calculate the usage.

**Logic for Adjustment Line Items**
The charge consolidation business service uses the following process logic for adjustment line items:
1. For the charge period and agreement, if any value exists in the Adjustment field, add a new line item of this amount to the Charges subview.

2. Create an adjustment line item on the Charges subview.

3. Clear the Adjustment and the Adjustment Reason fields.

**Process of Setting Up Charging**

The following list shows the procedures that administrators typically perform to set up charging using Siebel Field Service. Your company may follow a different process according to its business requirements.

**Administrator Procedures**

To set up the data required to generate charges automatically, perform the following procedures, in the following order:

1. Setting Up NRC Plans on page 288
2. Setting Up Use Plans on page 289
3. Setting Up Conditional Charge Plans on page 293
4. Defining Contract Schedules on page 294
5. Defining Charge Plans for Agreement Line Items on page 229

**Setting Up NRC Plans**

Nonrecurring (NRC) plans are used to define installment plans for payment of one-time charges. A good example is a service package, which may have an initial payment to start the service, followed by twelve monthly charges. These charges are billed on the first of the month. Field Service enables a service organization to define this type of charge plan and create invoices for the monthly billing charges.

See "Defining Charge Plans for Agreement Line Items" on page 229 for more information on how NRC plans are associated with agreement line items.

**To create nonrecurring charge (NRC) plans**

1. Navigate to the Administration - Contracts screen > Non-Recurring Plans view.
2 Create a new record and complete the fields as appropriate. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select this check box to display this NRC plan as an option in the Agreements screen &gt; Line Items &gt; Charge Plan view.</td>
</tr>
<tr>
<td>Commit</td>
<td>Select this check box to convert this record and child records to read-only status. Selecting this check box also makes the Plan Details view read-only.</td>
</tr>
</tbody>
</table>

**NOTE:** To use an NRC plan, it must be active and committed.

You must now add plan detail information to show the division of charges into installments, the percentage of the nonrecurring charge to bill at each schedule interval (monthly, quarterly, or annually) and any additional fee to add to each installment (as a percentage, a fixed amount, or both).

3 Click the Plan Details view tab. Each record in the Plan Details view describes the amount to charge for each payment.

4 Create a new record for each installment and complete the fields as appropriate. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>This is the installment number (for example, if 4 is entered, that line describes details about the fourth installment of the nonrecurring charge.)</td>
</tr>
<tr>
<td>NRC %</td>
<td>Percentage of the NRC total amount to charge on that installment.</td>
</tr>
<tr>
<td>Additional %</td>
<td>Any additional percentage amount to charge on that installment, such as an interest charge.</td>
</tr>
<tr>
<td>Additional Charge</td>
<td>Any additional fixed fee to charge on the installment, such as a service fee.</td>
</tr>
</tbody>
</table>

**Setting Up Use Plans**

Use plans can be defined to create usage-based charges for equipment. For example, a usage charge could be based on the number of photos printed from one of the printers sold by the company.

To set up use plans and their corresponding charges, you must first create a product and asset with associated measurements. The setup process includes creating a serialized product, creating a measurement type for the product, and creating a service product. A *service product* can be defined as a product sold as a service, which can be sold independently, packaged, or combined with the physical product.
When the asset is created with the correct measurement, measurement information can either be entered manually (for example, a gas company employee reading a gas meter) or automatically, using some type of electronic feed.

Upper and lower limits for readings may indicate threshold or trigger values for an asset. For example, exceeding an upper limit could trigger a preventive maintenance action.

See “Defining Charge Plans for Agreement Line Items” on page 229 for more information on how use plans are associated with agreement line items.

To add measurements to a service product

1. Navigate to the Administration - Product screen > List view.
2. Create or select a service product record.
   See “Defining Service-Based Pricing” on page 204 for more information on how to create a service product.
3. Click the Service Information view tab.
4. On the link bar, click Measurements.
5. Measurements associated with a product are not automatically associated with assets of the product.
6. Create a new record, and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of measurement—for example, Depth, Wear, and so on.</td>
</tr>
<tr>
<td>Name</td>
<td>The name for the measurement.</td>
</tr>
<tr>
<td>Method</td>
<td>The manner in which the measurement is collected. For example, the measurement could be collected manually or remotely.</td>
</tr>
<tr>
<td>Location</td>
<td>The location of the product.</td>
</tr>
<tr>
<td>Frequency</td>
<td>The schedule for obtaining readings of the specified measurement, chosen from a list.</td>
</tr>
<tr>
<td>Units</td>
<td>The units in which the measurement is kept.</td>
</tr>
<tr>
<td>Use Plan Bill Method</td>
<td>Method of accumulating data from readings:</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Incremental.</strong> Counter increments continuously with each reading (10, 20, 30, 40, and so on).</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Absolute.</strong> Counter is reset after each reading (10, 10, 10, 10, and so on).</td>
</tr>
<tr>
<td>Maximum</td>
<td>The largest possible value for the measurement device.</td>
</tr>
<tr>
<td>Minimum</td>
<td>The smallest possible value for the measurement device.</td>
</tr>
<tr>
<td>Upper Limit</td>
<td>The upper control limit for readings. This is less than or equal to the Maximum.</td>
</tr>
</tbody>
</table>
NOTE: A read-only version of the Measurements view is available in the Products screen.

**To add measurements to a service product asset**

- See “Defining Asset Measurements” on page 476 and “Associating Measurements with Assets” on page 479 for more information.

**To create use plans**

1. Navigate to the Administration - Contracts screen > Use Plans view.
2. Create a new record and complete the fields as appropriate.
   - Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower Limit</td>
<td>The lower control limit for readings. This is greater than or equal to the Minimum.</td>
</tr>
<tr>
<td>Expected Usage</td>
<td>Numeric value for the expected use, which is used to bill for usage if readings of usage are unavailable and if the Estimate check box on the Administration - Contracts screen &gt; Use Plans view is selected.</td>
</tr>
<tr>
<td>Use Basis (Days)</td>
<td>Time period, in days, over which the expected use is to occur. This value must match the value in the Frequency field.</td>
</tr>
</tbody>
</table>

3. Click the Plan Details view tab.
4. In the Plan Details view, create a new record, and complete the fields as appropriate.
   - The usage charge is based on asset readings or estimates for this product.
5 Scroll down to the Pricing list, create a new record, and complete the fields as appropriate. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Lowest value of a measurement for this pricing record.</td>
</tr>
<tr>
<td>Rollback</td>
<td>Provides discounted pricing for higher usage. Selecting Rollback on a specific tier causes the record’s price to override the prices for all lower tiers. A Rollback flag set for the tier labeled Over 1,000 would result in all miles billed at the rate of $0.40 per mile, if the usage reaches this tier during the specified time period. For more information, see “Adding Use Plan Pricing Information” on page 292.</td>
</tr>
<tr>
<td>Units</td>
<td>Provides the following selections:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Per Count.</strong> Charges the amount specified in the Amount field for each unit of measure; for example, $0.50 per mile.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Total.</strong> Charges the amount specified in the Amount field for the total measurement interval (From and To fields); for example, $15 for 0 to 100 miles (100 miles total).</td>
</tr>
</tbody>
</table>

6 Repeat Step 4 and Step 5 for each product included in the use plan.

7 Return to the Plan Detail view and select the Commit check box.

All records should now be read-only. Selecting this check box also makes the Pricing view’s fields read-only.

**Adding Use Plan Pricing Information**

The Pricing list on the Administration - Contracts screen > Use Plans > Plan Details view defines the price structure of each product in the selected use plan. Enter a record for each range of measurement. The Pricing subview allows tiered pricing. See Table 66 for some examples.

<table>
<thead>
<tr>
<th>Measurement Range</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-100</td>
<td>$0.25</td>
</tr>
<tr>
<td>101-500</td>
<td>$0.30</td>
</tr>
<tr>
<td>501-1,000</td>
<td>$0.35</td>
</tr>
<tr>
<td>Over 1,000</td>
<td>$0.40</td>
</tr>
</tbody>
</table>

**NOTE:** To set up aggregate rather than tiered pricing, choose Absolute for the Use Plan Bill Method field. This setting supplies a cumulative reading, starting from the beginning of the plan.
Setting Up Conditional Charge Plans

Field Service supports terminations of a contract, specifically, the charges involved in such an event like the return of products, overflow, and so on. These types of charges (typically covered by a termination or prorated plan) are handled using conditional charge plans in Field Service.

See “Defining Conditional Charge Plans for Agreement Line Items” on page 231 for more information on associating conditional charge plans with agreement line items. See “FS Generate Conditional Charge Process Business Service” on page 555 for more information on the business service used with conditional charges.

To create a conditional charge plan
1. Navigate to the Administration - Contracts screen > Conditional Charge Plan view.
2. Create a new record and complete the necessary fields.
   Use a meaningful name for the conditional charge plan—for example, Termination Plan.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the conditional charge plan.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule for the conditional charge plan. See “Defining Contract Schedules” on page 294 for more information on creating these schedules.</td>
</tr>
<tr>
<td>Commit Flag</td>
<td>Converts this record to read-only status.</td>
</tr>
</tbody>
</table>

3. Scroll down to the lower Conditional Charge Plan list.
4. Create a new record for each charge installment and complete the necessary fields.
   For example, create 12 different installments of 8.33% for each month of a 12-month agreement.
   If the customer cancels or changes the agreement before this 12-month period has expired, they must pay 8.33% of the total penalty charge each month until the year is up.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence #</td>
<td>Number to indicate the order in which the charge installments are applied. For example, you may wish to charge more the earlier a customer cancels or changes an agreement.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage amount to charge on that installment.</td>
</tr>
<tr>
<td>Additional %</td>
<td>Any additional percentage amount to charge on that installment, such as an interest charge.</td>
</tr>
<tr>
<td>Additional Charge</td>
<td>Any additional fixed fee to charge on the installment, such as a service fee.</td>
</tr>
</tbody>
</table>
Defining Contract Schedules

You can automatically generate charges according to a fixed schedule by defining one or more contract schedules. Then, when defining a charge plan for an agreement line item, you can select the schedule you want. On a particular day, on a recurring schedule, an invoice is created from the consolidation of charges. For example, you can schedule charges for a product to be generated on the last day of each month or every Sunday.

To define contract schedules

1. Navigate to the Administration - Contracts screen > Contract Schedule view.
2. Create a new record and complete the fields as appropriate.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat Type</td>
<td>This field determines how often an event occurs:</td>
</tr>
<tr>
<td></td>
<td>■ Daily. For example, every 30 days.</td>
</tr>
<tr>
<td></td>
<td>■ Monthly By Day. For example, the 5th of the month every 6 months.</td>
</tr>
<tr>
<td></td>
<td>■ Monthly By Week. For example, the 3rd Wednesday every 7 months.</td>
</tr>
<tr>
<td></td>
<td>■ Weekly. For example, every Monday and Wednesday every 2 weeks.</td>
</tr>
<tr>
<td>Released Flag</td>
<td>When selected, the schedule is available for use.</td>
</tr>
</tbody>
</table>

Creating Charges

No setup is required to create charges manually. This topic contains the following related procedures for creating charges:

■ To manually create a charge on page 294
■ To manually create a charge for an agreement line item on page 294
■ To automatically generate charges for a service request on page 295
■ To automatically generate a charge for an activity on page 295
■ To automatically generate a charge for an agreement line item on page 295

To manually create a charge

1. Navigate to the Charges screen.
2. Create a new record and complete the fields as appropriate.

To manually create a charge for an agreement line item

1. Navigate to the Agreements screen > List view.
To automatically generate charges for a service request
1 Navigate to the Service screen > Service Requests List view.
2 Drill down on the SR# field for a selected service request and click the Charges view tab.
3 Click the Auto Charge button.

To automatically generate a charge for an activity
1 Navigate to the Activities screen > Activity List view.
2 Drill down on the Type field for a selected activity and click the Charges view tab.
3 Click the Auto Charge button.

To automatically generate a charge for an agreement line item
1 Navigate to the Agreements screen > List view.
2 Drill down on the Name field for a selected agreement and click the Line Items view tab.
3 Select a line item and click the Charges subview tab.
4 In the Line Items view, click the Charge button.

Recording Billable Expenses
This topic contains the following related procedures for recording billable expenses:

- To record billable activities for a service request on page 295
- To record billable orders for a service request on page 296
- To record billable expenses for an activity on page 296
- To record billable time for an activity on page 296
- To record billable part movements for an activity on page 296

To record billable activities for a service request
1 Navigate to the Service screen > Service Request List view.
2 Drill down on the SR# field for a selected service request and click the Activities view tab.
3 Select an activity or create a new record and complete the fields as appropriate.
To record billable orders for a service request
1. Navigate to the Service screen > Service Request List view.
2. Drill down on the SR # field for a selected service request and click the Orders view tab.
3. Select an order or create a new record and complete the fields as appropriate.

To record billable expenses for an activity
1. Navigate to the Activities screen > Activity List view.
2. Drill down on the Type field for a selected activity and click the Expense Tracker view tab.
3. Select an expense or create a new record and complete the fields as appropriate.

To record billable time for an activity
1. Navigate to the Activities screen > Activity List view.
2. Drill down on the Type field for a selected activity and click the Time Tracker view tab.
3. Select a time record or create a new record and complete the fields as appropriate.

To record billable part movements for an activity
1. Navigate to the Activities screen > Activity List view.
2. Drill down on the Type field for a selected activity and click the Part Tracker view tab.
3. Select a part movement record or create a new record and complete the fields as appropriate.

Processes for Setting Up Invoicing
There are three ways to create an invoice:

- **Create an invoice manually.** Create a new invoice by entering expenses and other invoice information directly on the Invoices screen. See "Creating Invoices" on page 298 for more information.

- **Generate an invoice using Auto-Invoice.** Generate a new invoice for a service request or activity record.

- **Generate a customized invoice.** Generate a new invoice based on predefined rules for how and when charges are consolidated into an invoice.

Administrator Procedures
No setup is required to create an invoice manually. Setup processes to generate invoices using Auto-Invoice and to generate customized invoices are as follows:

- **Process for Setting Up Auto-Invoice on page 297**
- **Process for Setting Up Customized Invoices on page 297**
Process for Setting Up Auto-Invoice

You can use the Auto-Invoice feature to quickly generate invoices for service requests and activities.

**To set up Auto-Invoice**

1. Specify a price list for all of the product items determined as billable for an activity. The products must be listed as line items in the selected price list (Pricing screen > Price Lists view > Price List Line Items subview).

2. Ensure that there is a rate list line item for each type of resource (also known as a billing product; for example, a field engineer) used for an activity. The activities rate list is specified in the Activities screen > More Info view. In the Pricing screen > Rate List view > Rate List Line Items subview, the resource, rates, and markups are defined.

3. Ensure that the rate types (in the Type field) are identified for billable expenses and labor (Activities screen > Expense Tracker view and Time Tracker view).

4. Ensure that each user has a position that is associated with a billing product (Administration - Group screen > Positions view, Billing Product field).

5. Ensure that Activities have price and rate lists defined, and that Orders have a price list defined. Auto-invoicing uses these lists to determine the total amount billed to a customer.

Process for Setting Up Customized Invoices

You can create customized invoices by creating a charge consolidation plan that searches for and consolidates charges based on predefined criteria, such as account and currency. For the automatic generation of customized invoices, perform the following setup tasks:

1. “Process for Setting Up Auto-Invoice” on page 297

2. “Creating Charge Consolidation Plans” on page 297

Creating Charge Consolidation Plans

To consolidate charges onto one single invoice, use a charge consolidation plan. A charge consolidation plan consolidates all charges for a given charge schedule into a single invoice. These plans can be used to define what charges are included on an invoice and the invoiced period. Ideally, when a service package has a charge plan associated with it, a monthly invoice would be issued for the recurring and nonrecurring charges.

To define what charges are to be included on an invoice for the invoice period the following should be defined:

- A schedule that determines when consolidation occurs
- Rules that determine what charges appear on invoices
In order to use the charge consolidation plan, you need to activate the FS - Charge Consolidation workflow. For information about activating workflows, see the *Siebel Business Process Framework: Workflow Guide*.

**To define a charge consolidation schedule**
1. Navigate to the Administration - Contracts screen > Charge Consolidation Plans view.
2. Create a new record and complete the fields as appropriate.
   For more information, see "Charge Consolidation Plans View" on page 310.

**To define charge consolidation rules**
1. Navigate to the Administration - Contracts screen > Charge Consolidation Plans view.
2. Create a new record and complete the fields as appropriate.
3. Click the Consolidation Rule view tab.
4. Create a new record and complete the fields as appropriate.
   For more information, see "Charge Consolidation Plans View" on page 310.

**Related Topics**
- Invoice Logic on page 285
- FS Generate Conditional Charge Process Business Service on page 555

**Creating Invoices**
This section describes the three ways to create invoices:
- Creating Invoices Manually on page 298
- Generating Invoices Using Auto-Invoice on page 299
- Consolidating Charges to Create Invoices on page 300

**Creating Invoices Manually**
Follow these procedures to create invoices manually.

**To create an invoice manually**
1. Navigate to the Invoices screen.
2. Create a new record and complete the fields as appropriate.
3. Drill down on the Invoice # field for the selected invoice and click the Line Items view tab.
4 Create a new record and complete the fields as appropriate.  

**CAUTION:** If the amounts recorded for the activity and order do not match the amounts recorded for the invoice line item, then associating manually entered line items with activities or orders could cause data quality issues.

5 Click the Line Item Details view tab.

6 In the Details subview, create a new record and complete the fields as appropriate.

**To manually create an invoice for an agreement line item**

1 Navigate to the Agreements screen > List view.

2 Drill down on the Name field of the selected agreement and click the Line Items view tab.

3 Select a product and click the Invoices subview tab.

4 Create a new record and complete the fields as appropriate.

**Generating Invoices Using Auto-Invoice**

Follow these procedures to generate invoices using the Auto-Invoice feature.

**To automatically generate an invoice for a service request**

1 Navigate to the Service screen > Service Request List view.

2 Drill down on the SR # field for a selected service request and click the Invoices view tab.

3 Click the Auto Invoice button.

**To automatically generate an invoice for an activity**

1 Navigate to the Activities screen > Activity List view.

2 Drill down on the Type field for the selected activity and click the Invoices view tab.

3 Click the Auto Invoice button.

**About the Auto Invoice Command**

The charge consolidation business service requires the following information to generate an invoice automatically:

- **Billable flags.** Only records that have Billable flags set are included in the invoice.
- **Price list.** The price list must be specified.
- **Product prices.** In the Administration - Pricing screen > Price Lists view > Price List Line Items subview, billable products must belong to the selected price list.
Charges and Invoices ■ Post-Generation Invoice Tasks

■ **Rate list.** The rate list for field service activities must be specified in the Activities screen > More Info view.

■ **Activity prices.** In the Administration - Pricing screen > Rate Lists view > Rate List Line Items subview, the position that performs billable service activities, known as the resource, must be related to the selected rate list.

■ **Positions.** In the Administration - Group screen > Positions view, the Billing Product field for the person (known as the Resource on the rate list) providing service must be specified. This position applies to the employee who is associated with the billable service recorded in the time tracker for the activity and does not apply to the owner of the activity.

■ **Rate types.** In the Activities screen > Expense Tracker view and in the Activities screen > Time Tracker view, the rate types (Rate field) must be identified for billable expenses and labor.

**NOTE:** The Rate field is not displayed by default. You must right-click the mouse to display the Columns Displayed command and select the Rate field.

Consolidating Charges to Create Invoices

Follow these procedures to generate customized invoices.

**To automatically generate customized invoices**

1. Navigate to the Administration - Contracts screen > Charge Consolidation Plans.
2. Select a charge consolidation plan. In the More Info view, click the Execute Now button.

**To generate customized invoices using a repeating component job**

1. Navigate to the Administration - Server Management screen > Jobs view.
2. Add a Job record.
3. In the Component/Job field, select Workflow Process Manager.
4. Enter the desired Repeat Interval and Repeat Unit in the Job Details view.
5. Scroll down to the Job Parameters list and create a new parameter record.
6. In the Name field, select Workflow Process Name and in the Value field, enter FS - Charge Consolidation.
7. Click the Start button in the Job view.

Post-Generation Invoice Tasks

This section describes tasks that can be performed after an invoice is generated.
To print an invoice
1. Navigate to the Invoices screen.
2. Select an invoice record.
3. Select Reports > Customer Invoice. In the Siebel Report Viewer window, click the Print button.

To associate a payment with an invoice
1. Navigate to the Invoices screen.
2. Drill down on the Invoice # field for a selected invoice and click the Payments view tab.
3. Create a new record and complete the fields as appropriate.

To cancel an invoice
1. Navigate to the Agreements screen > List view.
2. Drill down on the Name field for a selected agreement and click the Line Items view tab.
3. Select a line item and click the Invoices subview tab.
4. Change the Status of the invoice to Cancelled.

Workflows for Charges and Invoices
This section explains the Siebel workflows used for charges and invoices. Workflows automate the business processes associated with charges and invoices.

You can modify these workflows to suit your own business model using Siebel Business Process Designer. For more information, see Siebel Business Process Framework: Workflow Guide.

TIP: The Field Service Invoice Engine Service was deactivated in Field Service version 7.7. Workflows which reference the Invoice Engine should be updated to reflect this change. For more information on the new business services, see “Invoices” on page 579.

In this section, the workflows are grouped in subsections that correspond to the business processes that they automate. Each subsection describes a workflow process.

This topic includes the following related subtopics:
- Workflow to Create Agreement Charges on page 302
- Workflow to Generate All Agreement Charges on page 303
- Workflow to Create Conditional Charges on page 304
- Workflow to Consolidate Charges on page 304
- Workflow to Batch Consolidate Charges on page 306
- Running Charges After Charge Consolidation Has Been Performed on page 307
- Improving Workflow Performance and Scalability on page 307
Workflows for Charges and Invoices

Workflow to Create Agreement Charges

This workflow automates the process of creating agreement charges. The workflow is called FS - Generate Agreement Charge. Figure 15 illustrates this workflow.

The workflow is a parent process that sequentially runs the following child workflows when the Charge button is clicked:

1. **FS - Generate NRC Charge.** This child workflow generates NRC charges for an agreement line item. The input date for this process should be in the local time format, which the process converts to ODBC format (YY-MM-DD). Once the NRC charge is generated, the process also updates the NRC last-charged date on the charge plan. This means updating the NRC Last Charged Date field on the FS Agreement Item business component.

2. **FS - Generate RC Charge.** This child workflow generates RC charges for an agreement line item. The workflow retrieves and converts the asset readings to charge amounts. The input date for this process should be in the local time format, which the process converts to the ODBC format (YY-MM-DD). Once the RC charge is generated, the process also updates the RC last-charged date on the charge plan. This means updating the RC Last Charged Date field on the FS Agreement Item business component.

3. **FS - Generate Usage Charge.** This child workflow generates charges for an agreement line item based on asset usage. The workflow retrieves and converts the asset readings to charge amounts. The input date for this process should be in the local time format, which the process converts to ODBC format (YY-MM-DD). Once the Usage charge is generated the process also updates the usage last-charged date on the charge plan. This means updating the Usage Last Charged Date field on the FS Agreement Item business component.

4. **FS - Generate Adjustment Charge.** This child workflow generates adjustment charges for an agreement line item.

These child workflows process all the items in the charge plan, including recurring charges, nonrecurring charges, usage plan charges, and adjustments.

**NOTE:** The user interface steps shown in Figure 15 simply redirect the user to the Agreements screen > List > Line Items > Charges view. See "Workflow to Generate All Agreement Charges" on page 303 for more information on running the workflow as a batch process, without these steps.
Workflow to Generate All Agreement Charges

This FS - Generate All Agreement Charges workflow automates the process of generating charges from all agreement line items. This workflow can be run as a batch process. Figure 16 illustrates this workflow.

![Workflow diagram](image)

Figure 16. FS - Generate All Agreement Charges

This workflow calls a subprocess named FS - Generate Agreement Charge wo Goto Charges View. The FS - Generate Agreement Charge wo Goto Charges View workflow is the same as the FS - Generate Agreement Charge workflow, except that the final two user interface steps are removed so that the workflow can run as a batch process. Figure 17 illustrates the FS - Generate Agreement Charge wo Goto Charges View workflow.

![Workflow diagram](image)

Figure 17. FS - Generate Agreement Charge wo Goto Charges View

**NOTE:** It is recommended that you run the charge process on the same repeating schedule as the contract schedule created for the charge plans.
To run all the charges for agreement line items using a repeating component job

1. Navigate to the Administration - Server Management screen > Jobs view.
2. In the Jobs list, create a new Job record.
3. In the Component/Job field, select Workflow Process Manager.
4. Enter the desired Repeat Interval and Repeat Unit in the Job Detail view.
   For example, a Repeat Unit of Month and a Repeat Interval of 1 would run the renewal process on a monthly basis.
5. Scroll down to the Job Parameters list and create a new parameter record.
6. In the Name field, select Workflow Process Name, and in the Value field, enter FS - Generate All Agreement Charges.
7. Click the Start button in the Jobs list.

Setting the Advance To Date in the Workflow

The workflow retrieves the Advance To date from the FS Agreement Item business component’s Object Id, which is passed into the workflow. The Advance To field on the business component is a calculated field that will default to Today(). Typically, this is not a problem, as most administrators run the job using the job scheduler.

However, if you want to set a different Advance To date, you can change the business component’s calculated field or alternatively, edit the input parameters for the workflow so that the Advance To date is changed when calling the business services.

Workflow to Create Conditional Charges

The FS - Generate Conditional Charge Process workflow generates conditional charges, on the basis of the rules defined in the conditional charge plan. Figure 18 illustrates this workflow.

![Figure 18. FS - Generate Conditional Charge Process](image)

Related Topic
“FS Generate Conditional Charge Process Business Service” on page 555

Workflow to Consolidate Charges

This workflow consolidates the charges in the Charge table based on a set of rules that are defined in the consolidation plans. Figure 19 illustrates this workflow. The process follows these steps:
1. The process creates a search specification for the FS Charge business component based on the consolidation rules.

2. After the targeted charges have been found, they are consolidated into one or more invoices. By default, only a single invoice is created. However, if the Bill To Account Flag is set for the consolidation plan, then one or more invoices are generated for each bill-to account for the charges. In addition, the charges are consolidated based on a schedule. At the end of each invoice run, the Next Invoice Date is stamped on the invoice based on the schedule and the last invoice date.

   **NOTE:** By default, the first invoice run on a consolidation sets the last invoice date to the start date of the consolidation plan.

3. The process brings the user to the Invoices Screen, which displays only those records that were just created.

   ![Diagram of FS - Charge Consolidation process](image)

   **Figure 19. FS - Charge Consolidation**

**Related Topic**

“FS Generate Conditional Charge Process Business Service” on page 555
Workflow to Batch Consolidate Charges

The FS - All Charge Consolidation workflow can be used to consolidate charges on a batch basis. Figure 20 illustrates this workflow.

**Figure 20. FS - All Charge Consolidation**

The process follows these steps:

1. The first step, GenerateConsolidationPlanList, generates a list of consolidation plans that the subsequent subprocesses process. The list is generated from the FS Invoice Consolidation Plan business component where the Release Flag field is set to Y and the Next Invoice Date is less than or equal to today's date.

2. The second step, GetNextPlan, retrieves the first consolidation plan from the list. Once it is retrieved, it then passes the Consolidation Plan Id to the subprocess Set Next Consolidation Date. This in turn calls the FS - Charge Consolidation wo Goto Invoice View workflow.

   In this subprocess, all the user interface steps are removed because the workflow is expected to be run as a batch process with little or no intervention on the part of the end user. The first step of this subprocess retrieves the consolidation rule from the consolidation plan with the correct Plan Id.

   **CAUTION:** In the repository, the FS - Charge Consolidation wo Goto Invoice View workflow’s business object property is set to FS Invoice Consolidation. Clear this business object property, redeploy the workflow, and test it. There may be performance implications if this object property is left as is.

3. The third step, ProcessOnePlan, actually runs the consolidate plan. The process then updates the Next Invoice Date field on the FS Invoice Consolidation Plan business component. This is done so that the charge consolidation workflow can determine when it should next run the plan.

   **NOTE:** It is recommended that you run the charge consolidation process on the same repeating schedule as the contract schedule created for the charge plans.
**To run charge consolidation using a repeating component job**

1. Set up the charge consolidation plans with the correct consolidation rule.
2. Set the correct start and end dates.
3. Set up a repeating component job as follows:
   a. Enter Workflow Process Manager as the component.
   b. For the job parameters, enter Workflow Process Name with FS - All Charge Consolidation as the value.
   c. Enter the appropriate repeat interval and number of repetitions information to run the process daily, weekly, or monthly.

   See “Workflow to Generate All Agreement Charges” on page 303 for a detailed example of how to set up a repeating component job.

   **NOTE:** FS - Generate All Agreement Charges and FS - All Charge Consolidation can be run in parallel to improve performance. See “Improving Workflow Performance and Scalability” on page 307 for more information.

**Running Charges After Charge Consolidation Has Been Performed**

Once the charge consolidation plan has been run, and the corresponding invoice created, you may need to rerun the charge consolidation because of errors and so on. It is not sufficient to just rerun the charge consolidation plan. The original charges, created from the charge consolidation, must be canceled.

**To cancel charges after charge consolidation has been performed**

1. Using Siebel Tools, expose the FS Charge business component’s Consolidate Flag on the FS Charge Form Applet.
2. Compile and replace the Siebel Repository File (.srf).
3. Restart the client.
4. In the client application, clear the Consolidate Flag in the Charge screen.
5. Change the charge item's status to Pending.
6. On the Charge Consolidation Plan, reset the Next Invoice Date to the previous schedule date.

**Improving Workflow Performance and Scalability**

The performance of the workflows depends on many variables—for example, the complexity of the RC, NRC, and Usage Plans, the number of line items per agreement, the number of charges being consolidated, and so on. However, you can improve the performance of the workflows and the Charge Engine in the following ways:
For the FS - Generate Agreement Charge workflow, remove the steps for some of the charge steps. For example, if you are only running charges for agreements based on NRC and RC, you can remove the usage plan sub process.

Switch off logging.

Run the processes in parallel. You can run the workflows on different machines or on a multiple processor machine. The performance of the workflows will show a linear performance improvement, based on the number of processes running.

Run the search spec of a consolidation rule on an indexed field.

Make sure that the consolidation rules are not too complex.

**Charges and Invoices Screens**

This section describes views, subviews, and fields on the following screens used to complete tasks related to charges and invoices.

**Service Screen**

The charge consolidation business service automatically creates invoices based on the information provided in a service request. The user activates this engine by choosing the Auto Invoice command in the Invoices view in the Service Requests screen.

The charge consolidation business service searches for any billable orders or activities related to the service request, applies the designated price and rate lists, then creates a new invoice. Only records that have billable flags set in the Orders and Activities views are included in the invoice calculation.

The billable flag in the Service Requests form defines the default settings for the billable flags in associated activities and orders. If the flag is set for a service request, but not for the associated orders or activities records, the activities or orders are not billed, unless the entitlement overrides the activity’s billable flag.

A user may select an entitlement by clicking Verify in the Service Requests form, More Info view or by completing the Entitlement field in the Service Details view.

**Activities Screen**

The Activities screen has four views that are related to invoices.

**Time Tracker View**

The Time Tracker view lists the labor charges associated with an activity. The Start and Stop buttons in the Time Tracker view provide convenient recording of time spent on an activity. Table 67 describes items in the Time Tracker view.
Auto Time Sheet (selected from the application-level Tools menu) produces new records in the Expense Tracker view. For more information about setting up and using Auto Time Sheet, also known as Auto Gen, see the chapters on time reporting and expense reporting in *Siebel Professional Services Automation Guide*.

Table 67. Selected Items in the Time Tracker View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable</td>
<td>A check box that indicates the charge consolidation business service should include in an invoice the price of this labor, based on the rate list for the activity, in an invoice for the associated activity. By default, this flag is set if the Billable flag is set for the activity.</td>
</tr>
<tr>
<td>Start</td>
<td>Clicking this button creates a new time record and sets the start time and date.</td>
</tr>
<tr>
<td>Stop</td>
<td>Clicking this button sets the end time for the activity and calculates the elapsed time.</td>
</tr>
<tr>
<td>Type</td>
<td>Identifies the specific category of time for the selected record. The types displayed are project records called Work Types. Work Types are defined in the Administration - Data screen &gt; Work Types view.</td>
</tr>
</tbody>
</table>

**Expense Tracker View**

The Expense Tracker view records the expenses associated with an activity. Setting the Billable flag for an expense record makes this information available to the charge consolidation business service. By default, this flag is set if the Billable flag is set for the activity.

Auto Expense Report (selected from the application-level Tools menu) produces new records in the Expense Tracker view. For more information about setting up and using Auto Expense Report, also known as Auto Gen, see the chapter on expense reporting in *Siebel Professional Services Automation Guide*.

**Part Tracker View**

The Part Tracker view records products or assets used in the field for an activity. If the Billable flag is set in a record, the charge consolidation business service includes this part in an invoice. By default, this flag is set if the Billable flag is set for the activity.
Invoices View
The Invoices view displays all invoices associated with an activity. Table 68 describes items in the Invoices view.

Table 68. Selected Item in the Invoices View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Invoice</td>
<td>Clicking this button requests that the system look for any billable expenses, time, or parts related to the an activity, applies the associated price and rate lists, then generates invoices for the selected activity. When the charge consolidation business service runs from this view, it does not consider entitlements for service.</td>
</tr>
</tbody>
</table>

Administration - Contracts Screen
The Administration - Contracts screen provides views for creating charge plans and charge consolidation plans, and for defining contract schedules.

Charge Consolidation Plans View
The Charge Consolidation Plans view shows existing charge consolidation plans and allows users to create or modify charge consolidation plans. Table 69 lists some of the fields and their descriptions for this view.

Table 69. Selected Items in the Charge Consolidation Plans View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advance To</td>
<td>Executes the consolidation plan through this date. For example, you can create invoices on the 10th of the month that include charges through the 20th of the month by entering the 20th in the Advance To field.</td>
</tr>
<tr>
<td>Currency Code</td>
<td>The currency code of the invoice to be created through the consolidation plan.</td>
</tr>
<tr>
<td>Last Invoiced Date</td>
<td>When a consolidation plan is released, the Last Invoice Date is set to the Start Date.</td>
</tr>
<tr>
<td>Next Invoice Date</td>
<td>The date on the next invoice. When a consolidation plan is released or an invoice is created, the Next Invoice Date is re-calculated based on the schedule.</td>
</tr>
<tr>
<td>Payment Terms</td>
<td>The payment terms for the plan, for example, Net 30 and so on.</td>
</tr>
<tr>
<td>Start and End Date</td>
<td>Charges dated after the start date and before the end date are included on an invoice under the charge consolidation plan.</td>
</tr>
</tbody>
</table>
Consolidation Rule Subview

Consolidation rules specify which charges are consolidated into an invoice. You can restrict the charges included to those which meet the specified rule criteria on invoices. The charges can be consolidated by Account Name, Activity Type, Agreement, Currency code, Organization ID, or Service Request ID. All the charges derived from either the activities or the recurring and nonrecurring charges for the agreement are consolidated into one single invoice for presentment. This consolidation reduces the requirement for presenting multiple invoices to the customer at possibly different billing addresses over a time period.

Table 70 describes some of the fields in this subview.

Table 70. Fields in the Consolidation Rule Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the consolidation rule. Typically, this name is the same as the charge field which is used for comparison purposes in the rule. You can also select SearchSpec from the drop-down list to define a search specification in the Value field.</td>
</tr>
<tr>
<td>Operand</td>
<td>The criteria on the field specified in Name. If the rule operand is =, LIKE, or NOT LIKE, you must enter a value in the Value field.</td>
</tr>
<tr>
<td>Sequence Number</td>
<td>The sequence number is not important in this process because if the consolidation rule contains multiple criteria records, the criteria are treated with the AND relationship.</td>
</tr>
<tr>
<td>Value</td>
<td>The value to be compared with the field specified in Name. If the rule operand is =, LIKE, or NOT LIKE, you must enter a value in this field.</td>
</tr>
</tbody>
</table>

Agreements Screen

The Agreements screen provides subviews (under the Line Items view) for contract-based invoicing.
Line Items View
The Line Items view provides controls and subviews for invoicing agreement line items. Controls are listed in Table 71.

Table 71. Selected Items in the Line Items View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charge</td>
<td>This button triggers the FS - Generate Agreement workflow. See “Workflow to Create Agreement Charges” on page 302 for more information.</td>
</tr>
<tr>
<td>Advance To</td>
<td>This field is located in the Line Items menu bar. Charges can be created no later than the date specified in this field, or until the date specified in the Charge End field on the Charge Plan Subview, whichever is earlier.</td>
</tr>
</tbody>
</table>

Charge Plan Subview
The Charge Plan subview records the billing details for the selected agreement line item. Table 72 describes items on the Charge Plan subview.

Table 72. Selected Items in the Charge Plan Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Charge</td>
<td>Positive or negative adjustment to the amount of a charge. The Charge Engine clears this field after generating a charge.</td>
</tr>
<tr>
<td>Commit</td>
<td>When selected, activates the Charge button.</td>
</tr>
<tr>
<td>Charge Basis</td>
<td>Method of charging. Make a choice from the drop-down list:</td>
</tr>
<tr>
<td></td>
<td>■ Advance. Advance charges are generated one period in advance.</td>
</tr>
<tr>
<td></td>
<td>■ Schedule. Generates the charge according to the Contract Schedule.</td>
</tr>
<tr>
<td>Charge End</td>
<td>Last possible date to generate a charge.</td>
</tr>
<tr>
<td>Non-Recurring</td>
<td>Total amount of the nonrecurring charge of which payments will be spread out per the NRC schedule. The nonrecurring charge can include a service charge or a discount.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If an NRC plan is not specified, the default behavior is to divide the NRC amount by the NRC Qty and generate the resulting amount each period.</td>
</tr>
<tr>
<td>NRC Plan</td>
<td>Predefined NRC billing plan, chosen from a dialog box. If this field is blank, the NRC amount is divided equally among the total payment installments shown in NRC Qty.</td>
</tr>
<tr>
<td>NRC Qty</td>
<td>Number of installments for paying the nonrecurring charge.</td>
</tr>
<tr>
<td>NRC Schedule</td>
<td>Defines how frequently and when the charges are generated. The NRC schedule can be different than the invoice schedule.</td>
</tr>
</tbody>
</table>
Invoices View
The Invoices view displays all invoices associated with an agreement line item and allows modification of these invoices or creation of additional invoices. Table 73 describes a check box in this view.

Table 73. Selected Items in the Invoices View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Late</td>
<td>A check box that is set automatically if the current date is past the due date.</td>
</tr>
</tbody>
</table>

Contacts Screen
The Contacts screen has an Invoices view that displays invoices for the selected contact. A user can also enter invoice records manually.

Accounts Screen
The Accounts screen has an Invoices view that displays invoices for the selected account. A user can also enter invoice records manually.
Invoices Screen

The Invoices screen shows all invoices generated automatically, and allows users to manually enter invoices and invoice line items, record payments, attach files, and add notes.

Invoices View

The Invoices view shows existing invoices and allows users to create or modify invoices. Table 74 describes items in Invoices records.

Table 74. Selected Items in the Invoices View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Late</td>
<td>A check box that is set automatically if the current date is past the due date. The due date is determined by the values of the Invoice Date and the Payment Term fields in the Invoices view.</td>
</tr>
<tr>
<td>Refresh Total</td>
<td>This command uses the data in the Payments, Line Items, and Line Items Details views to update the Total Due field in the Invoices view (More Info).</td>
</tr>
<tr>
<td>State</td>
<td>A color-coded indicator that represents the status of each invoice, based on the Status and Late fields.</td>
</tr>
</tbody>
</table>

State Indicators

Each record in the Invoices list has a bar that indicates the status of the invoice. If the invoice is late, the indicator has the appearance described in Table 75.

Table 75. Invoice Late—Indicator Appearance

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
<th>Amount of Fill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed Cancelled</td>
<td>Yellow</td>
<td>100%</td>
</tr>
<tr>
<td>Written-Off Submitted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Draft In-Process Consolidated Paid</td>
<td>Red</td>
<td>50%</td>
</tr>
<tr>
<td>Paid</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 75. Invoice Late—Indicator Appearance

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
<th>Amount of Fill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepared</td>
<td>Red</td>
<td>75%</td>
</tr>
<tr>
<td>Partially Paid</td>
<td>Red</td>
<td>75%</td>
</tr>
<tr>
<td>Open</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partially Written-Off</td>
<td>Red</td>
<td>100%</td>
</tr>
<tr>
<td>On-Hold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pending</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rejected</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If the invoice is not late, the indicator has the appearance described in Table 76.

Table 76. Invoice Not-Late—Indicator Appearance

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
<th>Amount of Fill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Gray</td>
<td>100%</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Gray</td>
<td>100%</td>
</tr>
<tr>
<td>Written-Off</td>
<td>Gray</td>
<td>100%</td>
</tr>
<tr>
<td>Submitted</td>
<td>Gray</td>
<td>100%</td>
</tr>
<tr>
<td>Partially Written-Off</td>
<td>Green</td>
<td>50%</td>
</tr>
<tr>
<td>On-Hold</td>
<td>Green</td>
<td>50%</td>
</tr>
<tr>
<td>Pending</td>
<td>Green</td>
<td>50%</td>
</tr>
<tr>
<td>Rejected</td>
<td>Green</td>
<td>50%</td>
</tr>
<tr>
<td>Prepared</td>
<td>Green</td>
<td>75%</td>
</tr>
<tr>
<td>Partially Paid</td>
<td>Green</td>
<td>75%</td>
</tr>
<tr>
<td>Open</td>
<td>Green</td>
<td>75%</td>
</tr>
<tr>
<td>Billed</td>
<td>Green</td>
<td>75%</td>
</tr>
<tr>
<td>New</td>
<td>Green</td>
<td>100%</td>
</tr>
<tr>
<td>Draft</td>
<td>Green</td>
<td>100%</td>
</tr>
<tr>
<td>In-Process</td>
<td>Green</td>
<td>100%</td>
</tr>
<tr>
<td>Consolidated</td>
<td>Green</td>
<td>100%</td>
</tr>
<tr>
<td>Paid</td>
<td>Green</td>
<td>100%</td>
</tr>
</tbody>
</table>

**NOTE:** A ToolTip is provided for each indicator. Move the cursor over the indicator bar to see its description.
Line Items View
The Line Items view shows the billable items for an invoice. Line items can be added manually. Table 77 describes items in Line Item records.

Table 77. Selected Items in the Invoices Line Items View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order #</td>
<td>The order reference number associated with this invoice, supplied by the charge consolidation business service or chosen from a dialog box. The charge consolidation business service supplies this number if the invoice is produced by Auto Gen (see “Expense Tracker View” on page 309). If an order is associated with a service request and the user activates the Auto Invoice command for a service request (Service screen, Invoice view), the order number is entered into the invoice line item.</td>
</tr>
<tr>
<td>Activity #</td>
<td>The reference number of the activity associated with this invoice, supplied by the charge consolidation business service or chosen from a dialog box.</td>
</tr>
<tr>
<td>Agreement Line Item</td>
<td>The ID of an agreement line item associated with this invoice. This ID is supplied by the charge consolidation business service or chosen from a dialog box.</td>
</tr>
<tr>
<td>Project Role</td>
<td>This field contains the project team associated with the current line item.</td>
</tr>
</tbody>
</table>

Line Item Details View
The Line Item Details view provides details of the current invoice line item.

Details Subview
The Details subview provides additional information about the items in the line item of an invoice: time, expenses, and parts. Table 78 describes items in the Invoice Line Item records.

Table 78. Selected Items in the Details Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Expense Item #</td>
<td>The ID of an expense associated with this invoice line item, supplied by the charge consolidation business service or chosen from a dialog box.</td>
</tr>
<tr>
<td>Activity Time Item #</td>
<td>The ID of a record in Time Tracker associated with this invoice line item, supplied by the charge consolidation business service or chosen from a dialog box.</td>
</tr>
</tbody>
</table>
Line item details are used by the charge consolidation business service; a manual invoice does not have to use this data.

**Payments View**
The Payments view records the payments applied against the invoice. Table 79 describes items in the Payments records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment #</td>
<td>The ID of the payment associated with this invoice, chosen from the Pick Payment dialog box. The payment records originate from a back-office application, or the user can create them in this dialog box (by using the New button).</td>
</tr>
<tr>
<td>Reference</td>
<td>A reference number that a customer assigns to a payment record.</td>
</tr>
</tbody>
</table>

**Invoice Report**
The Customer Invoice report, from the Reports menu, prints an invoice for the selected invoice record.
Figure 21 shows an example of an invoice generated from your Siebel application. The header shows information that uniquely identifies this invoice, such as Invoice # and Date. A Description line follows, then Account and Bill To information. The body of the invoice contains a list of line items and their charges. Below and at the right is the Invoice Amount total.
This chapter describes how to set up the Siebel application to obtain invoice information from your company’s third-party invoicing system. Topics include:

- Invoicing Integration Overview on page 319
- Required Setup Procedures on page 320
- Optional Setup Procedures on page 320

**Invoicing Integration Overview**

Siebel invoice integration is designed for companies that rely on back-office billing and accounting applications to generate invoices for products sold and services rendered. The invoice retrieval business process assumes that the billable source data (billable time, expenses, and materials) has been sent from the Siebel application to a billing application for invoice processing.

After generating a final customer invoice, the third-party invoicing application can publish the invoice data as an XML file. This XML file is then passed to the Siebel application, which updates the Invoice business object, populates the base tables with the invoice data, and then displays the invoice in the Invoices views.

This functionality assists Siebel users with answering inquiries from customers about their invoices. An end user can view a customer invoice in the Siebel application, without needing to access the third-party invoicing application.

To integrate with an invoicing application, you use the Siebel Invoice business service, of type Data Synchronization, and the prebuilt Siebel Invoice Application Services Interface (ASI).

For more information about how to configure, use, and modify integrations based on ASIs, see *Application Services Interface Reference*.

**Invoicing Integration Terms**

The following terms are used when referring to invoicing data:

- **Bill.** An instance of accumulated charges over a defined period of time for one or more products or services that a customer has received and for which the customer owes your company.

- **Invoice.** A document that displays a balance the customer owes to your company and to other involved parties, such as third-party shippers and government tax bureaus. Consists of billing information plus taxes plus incidentals. Contains account balance information and displays transactions against a balance. Can be associated with one bill or can consolidate multiple bills.
Required Setup Procedures

To set up the use of third-party invoicing systems, you must configure the Web service.

Configuring the Web Service

Web services are used to direct the inbound messages from the third-party invoicing application. You must make sure that the Web services are correctly configured and activated. For more information about configuring Web Services, see *Application Services Interface Reference*.

To configure the Web service

1. Navigate to the Administration - Web Services screen > Inbound Web Services view.
2. Make sure that the values of the selected record for the Namespace, Name, and Status fields match those in the following table.

<table>
<thead>
<tr>
<th>Namespace</th>
<th>Name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://siebel.com/asi/">http://siebel.com/asi/</a></td>
<td>Siebel Invoice</td>
<td>Active</td>
</tr>
</tbody>
</table>

3. In the Comments field, enter the type of protocol used for making the Web Service call, and then enter the location of the Web server and the user who is authorized to call this Web service.

Optional Setup Procedures

When you configure third-party invoicing systems, you may want to do the following:

- Extend the data set.
- Turn off invoicing.
- Customize invoicing.

Extending the Data Set

The data set can be extended by adding more fields to the relevant integration objects, provided that the fields are supported by the Siebel data model. For information about how to extend the data that is received from the third-party inventory management system, see *Application Services Interface Reference*.
Turning Off Invoicing
You may want to turn off the third-party invoicing function if, for example, your company does not have a third-party billing system. In this case, do not publish the ASI. For information about publishing ASIs, see *Application Services Interface Reference*.

Customizing Invoicing
You may want to customize the third-party invoicing function to add special functions or additional business processes. For information about extending the data that is received from the third-party invoicing system, see *Application Services Interface Reference*.

Defining Service Ports
You may want to define service ports different from, or in addition to, the ones provided with your Siebel application. For information about defining customized service ports, see *Application Services Interface Reference*.

Creating Workflow Processes
You may want to define workflow processes to automate certain functions associated with third-party invoicing. For information about creating workflow processes, see *Siebel Business Process Framework: Workflow Guide*. 
11 Fulfillment

This chapter describes the process flows for orders supported by the Siebel Order Entry module and the Fulfillment and Part Locator Engines (components of the Field Service Logistics Manager). Topics include:

- Fulfillment Overview on page 323
- Parameters for the Fulfillment and Part Locator Engines on page 328
- Parameters for the Fulfillment Engine on page 331
- Setting Up and Configuring Order Fulfillment on page 334
- Fulfilling Orders on page 335
- Administration - Product Screen on page 337
- Administration - Data Screen on page 340
- Service Order Screen on page 341

Fulfillment Overview

Siebel Field Service provides two methods for filling an order automatically:

- The Fulfillment Engine automatically locates in inventory the ordered items (or substitutes for these items), allocates these items, and generates a pick ticket.

- The Part Locator is a semi-automated version of the Fulfillment Engine. It gives the user control over fulfillment of individual line items in an order. The user can select the line items and choose to carry out these automatic procedures for the selected items:
  - Find products or substitutes in inventory.
  - Allocate these items.
  - Generate pick tickets.

Fulfillment Engine

The Fulfillment Engine automatically finds and allocates products for selected service orders, and produces pick tickets to use for the orders. The engine uses the following information to find a product:

- Distances of source inventory locations to the order address.
- Priority of an order, which can influence fulfillment relationships. For more information, see the Order Priority field in "Relationships View" on page 371.
Types of inventory locations.

Customer’s preferred inventory location. Each account has a default inventory location.

Relationships among inventory locations (to determine which location to query next if the product cannot be found in a location).

Product information (for example, available substitutes).

The engine can run from the Field Service user interface, in batch mode using the Repeat Interval, or by Siebel Business Process Designer. As a batch process, fulfillment can be initiated at regular intervals (for example, twice a day for pending high-priority orders or once a day for other orders) or according to conditions (for example, high-priority orders might be fulfilled immediately).

The Fulfillment Engine uses information entered elsewhere in Field Service to decide how to fulfill an order. For example, it considers account information to select the default source inventory location if no source inventory location is specified at the order and the order line item level. Where substitution of products is necessary, the engine uses substitutes specified for a product. If the product is out of stock at the warehouse of first choice, it reads the fulfillment relationships between inventory locations to determine from which other warehouse to fulfill the order. For more information, see “Inventory Relationships” on page 351.

The Fulfillment Engine produces this output:

- Allocated parts for each order.
- Pick tickets to be used by picker to pick, pack, and ship each order.
- Inventory transactions for part allocation.

**NOTE:** For the Fulfillment or Part Locator Engines to allocate a line item from inventory, the line item must have a status of On-Hand for Inventory Level.

**How the Fulfillment Engine Finds Fulfillment Inventory Locations**

When fulfilling an order, the Fulfillment Engine looks for parts in this order:

1. The source inventory location, if any, defined in the Line Details subview. For more information, see "Line Detail Subview" on page 343.
2. The source inventory location defined in the Fulfillment view. This may be different from the source location in the Line Details subview. For more information, see "Fulfillment View" on page 344.
3. The inventory location, if any, defined in the Accounts screen. For more information, see "Accounts View" on page 48.
4. The server component parameter for DefaultFulfillInvLoc. For more information, see “Parameters for the Fulfillment and Part Locator Engines” on page 328.
Fulfill Command
The Fulfill command on the Service Order screen finds the order line items, allocates these items, and generates a pick ticket record for the item. (The Shipping screen > PickTickets view processes pick ticket records.) The Part Locator carries out each of these tasks separately, controlled by the Locate, Allocate, and Generate PickTickets commands.

Locate Button
The Locate button on the Service Order screen > Line Items > Part Locator view finds in inventory the product specified in an order line item. It also finds substitutes if the product is unavailable. For more information about this function, see “Fulfillment Engine” on page 323.

Allocate Button
The Allocate button on the Service Order screen > Line Items > Part Locator view creates an inventory transaction of the type Allocate (see Table 91 on page 356) that reserves the product.

Generate PickTickets Command
The Generate PickTickets command on the Service Order screen produces a pick ticket record. The logic for the command follows:

■ For each line item action of the type Allocate, where the item is not on a pick ticket (the Shipment number field in the Line Items view, Actions subview is blank), theGenerate PickTickets function tries to create a valid pick ticket (a new row in table S_SHIPMENT). In doing so, it looks at the source inventory where the allocation is done.

If this inventory is not of the type defined for the InventoryTypeForPT system preference, then it tries to find a parent inventory for the source inventory with the type defined in the InventoryTypeForPT system preference (the default for this is Warehouse). If one is found, then it generates a pick ticket record for this location. For other line item actions that have same source, the same pick ticket is used. A new pick ticket is generated only when source warehouses are different.

■ Associates the line item action to that pick ticket by updating the Shipment number field.

Figure 22 on page 327 shows how the Fulfillment Engine works for an order. For each line item to be fulfilled, it does the following:

1 Sets the source as the default source for the line item or the customer site.
2 Generates a prioritized list of inventory locations based on distance to the order address, order priority, and warehouse type.
3 If the prioritized list of inventory locations is not empty, populates inventory from the list and sets the source as the inventory location.
4 Allocates the lesser of the quantity available for this product and the order quantity pending.
5 If the quantity allocated does not equal the quantity pending, reviews possible substitutes for the product and allocates as appropriate.
6 If the quantity allocated still does not equal the quantity pending, sets the source as the next source for this order priority.

7 If there is a next source, repeat Step 2 through Step 6. If there is no next source, starts again at Step 1.

8 When no line items remain to be fulfilled, generates a pick ticket per selected inventory location.
Figure 22. Logic for Fulfillment Engine
**Part Locator Engine**

The Part Locator provides semi-automated fulfillment of line items in an order. The Part Locator Engine analyzes orders, locates parts for each line item, and returns the located parts (products or substitute products) to the user. The user can manually allocate these parts and generate the pick tickets.

For example, a customer service representative (CSR) receives a service request that requires shipping a product. The CSR creates an order, selects a line item in the order, and clicks Locate from a line item of the service order. Using the configuration parameters, the Part Locator browses various inventory locations and proposes sources from which to fulfill the order.

The Locate, Allocate, and Generate PickTickets commands that run the Fulfillment Engine in semi-automatic mode are available from the Service Order screen. For more information, see "Line Items View" on page 341 and "Part Locator Subview" on page 343.

The Part Locator follows the fulfillment logic specified in Figure 22 on page 327, and uses the same parameters for the fulfillment logic.

The Part Locator, unlike the Fulfillment Engine, cannot run asynchronously, which means that when the Locate button initiates a product search, the Siebel application is unavailable for other operations.

**Parameters for the Fulfillment and Part Locator Engines**

The Fulfillment and Part Locator Engines use the parameters shown in Table 80 on page 329.
Changing the values of these parameters changes the default behavior of each engine.

**NOTE:** To activate changes to parameters, restart the Siebel Server.

Table 80. Parameters for the Fulfillment and Part Locator Engines

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SysPref_DefaultFulfillInvloc</td>
<td>SFO</td>
<td>Specifies the default inventory location to use as a source inventory location for the Fulfillment Engine and Part Locator. This is used as the Source Inventory Location if the user does not specify the Source Inventory Location at run time. The value must be the Row ID of the service inventory location. To find this ID, use the following procedure: 1 In any Service Inventory view, select an inventory location. 2 From the Help menu, select About Record. 3 In the dialog box, click Details.</td>
</tr>
<tr>
<td>SysPref_InventoryTypeForPT</td>
<td>Warehouse</td>
<td>Specifies the Inventory location type from which pick tickets are generated. The values should be from the Inventory location type LOV and individual values should be any of the LIVs.</td>
</tr>
<tr>
<td>SysPref_AllocationRule</td>
<td>1</td>
<td>Specifies the rules for substitution. The possible values are 1,2,3 where: 1 Always allocate a substitute before going to the next inventory location. 2 Allocate a substitute only if it allows shipment from a single inventory location. 3 Never allocate a substitute if the exact product can be found in another inventory location.</td>
</tr>
<tr>
<td>SysPref_FulfillSearchAllSublevels</td>
<td>TRUE</td>
<td>Specifies whether to search child locations. Possible values are TRUE and FALSE. TRUE - Search the specified inventory location and all its child inventory locations specified by Sublevel relationships. FALSE - Search the specified inventory location and all its fulfillment hierarchy locations, but not the child inventory locations specified by Sublevel relationships.</td>
</tr>
</tbody>
</table>
Substitution and Allocation Flags
The Fulfillment Engine uses the following inventory-specific attributes in its logic:

- **Auto Allocate.** If this flag is set, the Fulfillment Engine can allocate this product.
- **Auto Substitute.** If this flag is set, the Fulfillment Engine can allocate substitute parts in lieu of this product.
- **Allocate Below Safety.** If this flag is set, the Fulfillment Engine allocates from available quantity even if this allocation takes the available stock to below safety level. If the value is No, then any allocation that can take the level to below safety is not carried out.

Allocation and substitution options are set at three levels in Field Service:

- **Products.** For more information, see “Products View” on page 337.
- **Inventory types.** For more information, see “Inventory Options Subview” on page 340.
- **Inventory locations.** For more information, see “Product Inventory View” on page 370.

At the product level, these attributes are binary values, either Yes or No. But at the inventory type level or inventory location, they may be Yes, No, or Default. A Yes or No value means override the value defined at the product level and use this value. A Default value means use the value defined at the product level.

### Conditions for Auto-Substitution
If the Fulfillment Engine is running and any one of the following conditions is met, the Fulfillment Engine attempts to allocate a substitute from the inventory’s sublevel, then from the parent inventory, and then from the fulfillment center (based on order priority), assuming there are no exact products at any of these locations.

All of these conditions must be met for substitution to take place automatically during fulfillment:

- The Inventory Location and Product Level are set to Yes.
- The Inventory Location is set to Default and Product Inventory Types are set to Yes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SysPref_OrderTypeToBeFulfilled</td>
<td>Service Order, Internal Order, RMA Advance Exchange</td>
<td>Specifies the valid values for Order Type. The values should be from the Order Type LOV and individual values can be any of the LIVs.</td>
</tr>
<tr>
<td>SysPref_OrderStatusToBeFulfilled</td>
<td>Open, New, Pending</td>
<td>Specifies the valid values for Order Status. The values should be from the Order Status LOV and individual values can be any of the LIVs.</td>
</tr>
<tr>
<td>SysPref_OrderItemStatusToBeFulfilled</td>
<td>Open, New, Pending</td>
<td>Specifies the valid values for Order Item Status. The values are from the Order Item Status LOV and the individual values are LIVs.</td>
</tr>
</tbody>
</table>
The Inventory Location and the Product Inventory Type are set to Default and the Product is set to Yes.

- The Inventory Location, the Product Inventory Type, and the Product are set to Yes.
- A substitute product for the specified line item exists.
- AllocationRule = 1. For more information, see "Parameters for the Fulfillment and Part Locator Engines" on page 328.

**NOTE:** FS_PROD_ALLOC_RULES can have the values Yes, No, and Default. These values can be specified in the Administration - Application screen > List of Values view. These values are not related to the AllocationRule values.

### Parameters for the Fulfillment Engine

The Field Service engines have parameters, listed in Table 81, which determine the behavior of each engine.

Table 81. Parameters for the Fulfillment Engine

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SysPref_DefaultFulfillInvLoc</td>
<td>SFO</td>
<td>Accepts the ROW_ID of the default inventory location; for example, the ROW_ID for Warehouse 32.</td>
</tr>
<tr>
<td>SysPref_OrderItemStatusToBeFulfilled</td>
<td>Open, New, Pending</td>
<td>Specifies the valid values for the existing order item status. The values should be from the Order Item Status LOV and individual values should be LIVs.</td>
</tr>
<tr>
<td>SysPref_OrderStatusToBeFulfilled</td>
<td>Open, New, Pending</td>
<td>Specifies the valid values for the existing order status. The values should be from the Order Status LOV and individual values should be LIVs.</td>
</tr>
<tr>
<td>SysPref_OrderTypeToBeFulfilled</td>
<td>Service Order, Internal Order, RMA Advance Exchange</td>
<td>Specifies the valid values for the existing order type. The values should be from the Order Type LOV and individual values should be LIVs.</td>
</tr>
</tbody>
</table>
### Table 81. Parameters for the Fulfillment Engine

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
</table>
| SysPref_Fulfill-SearchAllSublevels | TRUE          | Specifies whether to search child locations. Possible values are TRUE and FALSE.  
TRUE - Search the specified inventory location and all its child inventory locations specified by Sublevel relationships.  
FALSE - Search the specified inventory location and all its fulfillment hierarchy locations, but not the child inventory locations specified by Sublevel relationships. |
| SysPref_InventoryTypeForPT    | Warehouse     | Specifies the Inventory location type from which pick tickets are generated. The values should be from the Inventory location type LOV and individual values should be any of the LIVs. |

**NOTE:** To register changes to parameters, restart the Field Service server.
Setting Parameters for the Fulfillment and Part Locator Engines

By specifying input parameters to the Fulfillment and Part Locator Engines, an administrator can define the logic for a specific set of orders (using Order Search Specifications), for a single order (using Order ID), and for a single line item (using Line Item ID). Table 82 contains the parameters for the Fulfillment and Part Locator Engines that are set in the Server Jobs screen for the server components FSFulfill and FS Locate.

Table 82. Parameters for the Fulfillment and Part Locator Engines

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InputMode</td>
<td>ORDERSEARCHSPEC</td>
<td>Specifies the WHERE clause for the orders and the engine will fulfill the orders based on the criteria.</td>
</tr>
<tr>
<td></td>
<td>ORDERID</td>
<td>Specifies the Single Order ID to be fulfilled and the engine will fulfill the specified Order.</td>
</tr>
<tr>
<td></td>
<td>LINEITEMID</td>
<td>Specifies the Single Order line item ID to be fulfilled and the engine will fulfill the specified Order line item.</td>
</tr>
<tr>
<td></td>
<td>TEMPTABLE</td>
<td>Places all required values into a temporary table with a particular Client Request ID and passes that ID to the server to retrieve the parameters from Temp Table.</td>
</tr>
<tr>
<td>ClientReqId</td>
<td>ROW_ID for retrieving line items input from the temporary table</td>
<td>Required when InputMode = TEMPTABLE.</td>
</tr>
<tr>
<td>RowId</td>
<td>ROW_ID of a single order to fulfill or ROW_ID of a single line item to fulfill</td>
<td>Required when InputMode = ORDERID or InputMode = LINEITEMID.</td>
</tr>
<tr>
<td>OrderSearchSpec</td>
<td>A Where clause</td>
<td>Required when InputMode = ORDERSEARCHSPEC.</td>
</tr>
</tbody>
</table>

To set Fulfillment and Part Locator Engine parameters

1. Identify the predefined parameters to determine the defaults for the Fulfillment Engine.
2. Read all the input parameters and identify all the line items from parameters or the Temp Table based on mode.
3. Fulfill each line item.
   a. Find the product or substitute product to fulfill the line item.
   b. Allocate the product.

Generate the inventory transaction for all the products of type Allocate, and generate the inventory transaction for all the substitute products of types Substitute and Allocate.
c Generate the pick ticket.

**Invoking the Fulfillment Engine**

Start the Fulfillment Engine by the following methods:

- Use the Workflow Manager.
- Use Siebel component jobs.
- Invoke the engine for orders by clicking the Fulfill or Fulfill All command after selecting one or more Order line items.
- Use the Locate or Locate All command.

**Related Topics**

- FS Fulfillment Service Business Service on page 575
- FS Part Locator Service Business Service on page 576

**Setting Up and Configuring Order Fulfillment**

This section includes procedures for setting up order fulfillment.

**Setting Up Order Processes**

Follow these procedures to define order types.

This procedure makes available from a predefined list the types of orders that appear in order-related views.

**To define order actions**

1. Navigate to the Administration - Data screen > Order Actions view.
2. Create a new record and complete the fields as appropriate.

**To define types of orders**

1. Navigate to the Administration - Data screen > Order Types view.
2. Create a new record and complete the fields as appropriate.
Setting Up the Fulfillment and Part Locator Engines

Follow these procedures to set up the Fulfillment and Part Locator Engines.

**To set the component job parameters for the Fulfillment and Part Locator Engines**
1. Insert or edit a component job for one of the following server components:
   - Service Order Fulfillment Engine
   - Service Order Part Locator Engine
2. Add or modify the server component parameters as needed.

For information about server components and component parameters, see *Siebel System Administration Guide*.

For information about synchronous and asynchronous processing, see *Siebel Application Services Interface Reference*.

**CAUTION:** In synchronous processing, the client screen can lock. Consequently, the user sees a blank screen.

**To set asynchronous or synchronous operation of the Fulfillment and Part Locator Engines**
1. From the application-level menu, choose Tools > User Preferences.
   
   The User Preferences screen appears.
2. On the link bar, click Service.
   
   The Field Service form appears.
3. In the Asynchronous Fulfillment of section, do one of the following:
   - To set asynchronous operation, select Orders.
   - To set synchronous operation, clear Orders.

Fulfilling Orders

Follow these procedures to fulfill service orders, which includes identifying and reserving items specified in an order.

**To allocate parts for a service or internal order manually**
1. Navigate to the Service Order screen > List > view.
2. Drill down on a selected order record.
3. Click the Line Items view tab, and then select the line item to allocate.
4. On the link bar, click Actions.
Fulfillment  ■ Fulfilling Orders

5 Create a new record and complete the fields as appropriate.
   
   NOTE: If the Logistics Manager and its Fulfillment Engine are installed, the Fulfillment Engine automatically specifies Allocate actions.

To generate a pick ticket for an order
1 Navigate to the Service Order screen > List view.
2 Drill down on a selected order and click the More Info tab.
3 Click the menu button and choose Generate Pick Tickets.

To locate order line items
1 Navigate to the Service Order screen List view.
2 Drill down on a selected order and click the Line Items tab.
3 Select a line item, scroll down and click the Part Locator tab.
4 In the Line Items list, click one of the following buttons:
   
   ■ Locate - Searches for the product through inventory locations, and then loads the list of available and substitute parts in the Part Locator subview.
   
   ■ Locate All - Finds inventory locations for all line items.

   NOTE: Before clicking either of these buttons, make sure that the Service Product flag on the Administration - Product screen > More Info view is cleared. If this flag is not cleared, the Parts Locator engine will not find any products.

To allocate order line items using the Part Locator
1 Follow the procedure "To locate order line items" on page 336.
2 In the Part Locator view, select a product/inventory location record in the Available Substitute subview or the Line Allocation subview.
3 In the Qty field, enter the number of items to allocate. If no quantity is specified, the total available quantity is allocated.
4 If the selected record is in the Available Substitute list, click the appropriate button:
   
   ■ Allocate All. Allocates available parts automatically, starting with the first listed inventory location, up to the value in the Qty field.
   
   ■ Allocate. Allocates the selected line item from a selected product/inventory location record.

To fulfill orders using the Fulfillment Engine
1 Navigate to the Service Order screen > List view.
2 Select an order and from the menu drop-down list, choose Fulfill.
To fulfill order line items
1. Navigate to the Service Order screen > List view.
2. Drill down on a selected order and click the Line Items view tab.
3. Select an order line item, and then do one of the following:
   - From the menu drop-down list, choose Fulfill to fulfill the selected order line item.
   - Click Fulfill All to fulfill all order line items.

To de-allocate order line items
1. Navigate to the Service Order screen.
2. Drill down on a selected order, and click the Line Items view tab.
3. Select an order line item.
4. On the link bar, click Actions.
5. Select the action item (of type Allocate) to de-allocate. Then from the menu drop-down list, choose De-Allocate.

Administration - Product Screen
The Administration - Product screen includes a view for configuring inventory locations, allocation, and cycle counting for products. For more information, see Siebel Product Administration Guide.

Products View
The Products view records basic information about each product; for example, product name, part number, and revision. Table 83 on page 337 describes items in Product records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Below Safety</td>
<td>A check box that indicates the Fulfillment and Part Locator Engines can allocate this product when its level in inventory is below the safety level, which is set in the “Product Inventory View” on page 370.</td>
</tr>
<tr>
<td>Auto Allocate</td>
<td>A check box that indicates the Fulfillment and Part Locator Engines can allocate this product. If this box is not selected, the engines do not allocate this product.</td>
</tr>
<tr>
<td>Auto Substitute</td>
<td>A check box that indicates the Fulfillment and Part Locator Engines can allocate a substitute for this product.</td>
</tr>
</tbody>
</table>
Fulfillment

Fulfillment - Administration - Product Screen

The Product Service Details view provides the information used in locating and allocating products for use in field service activities.

**NOTE:** To navigate to the Product Service Details view, use the link bar on the More Info tab.

This view has two subviews, Inventory Options and Substitute Products. For more information, see "Inventory Options Subview" on page 340 and "Substitute Products Subview" on page 340.

### Table 83. Selected Items in the Products View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equivalent Product</td>
<td>The Fulfillment Engine uses this information if the specified product is unavailable. This setting is the same as the specified substitutes. For more information, see “Substitute Products Subview” on page 340.</td>
</tr>
<tr>
<td>Field Replaceable</td>
<td>A check box that indicates this item may be replaced at the customer site. This is informational and has no effect on other fields or functions.</td>
</tr>
<tr>
<td>Orderable</td>
<td>A check box that indicates the product may be obtained by ordering from any specified source. If the product is not orderable, it does not appear in the Pick Product dialog box, which presents choices for the Product field in the Service Order screen &gt; List &gt; Line Items view.</td>
</tr>
<tr>
<td>Return if Defective</td>
<td>A check box that indicates this item, if defective, should be returned to the service center. This is informational only.</td>
</tr>
<tr>
<td>Serialized</td>
<td>A check box that indicates this product and all of its assets are serialized.Serialized products are treated in a different way. Whenever a serialized product is shipped or received, Field Service expects the right number of assets with serial numbers.</td>
</tr>
<tr>
<td>Service Product</td>
<td>A check box that indicates this product is used for service and may have special pricing. See Siebel Pricing Administration Guide for information on pricing administration and Siebel Product Administration Guide for information on product administration. When selected, prevents the Part Locator Engine from allocating parts for the product. To allow the Part Locator Engine to allocate parts for the product, clear this check box.</td>
</tr>
<tr>
<td>Tool</td>
<td>A check box that indicates this item is a tool used in service procedures. This is informational only.</td>
</tr>
</tbody>
</table>
Table 84 describes items in Product Service Details records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Below Safety</td>
<td>A check box that indicates the Fulfillment and Part Locator Engines can allocate this part when its level in inventory is below the safety level. For more information, see &quot;Product Inventory View&quot; on page 370. This check box also appears in the Products view. For more information, see &quot;Products View&quot; on page 337.</td>
</tr>
<tr>
<td>Auto Allocate</td>
<td>A check box that indicates the Fulfillment and Part Locator Engines can allocate this part. If this box is not selected, the engines do not allocate this product. This check box also appears in the Products view. For more information, see &quot;Products View&quot; on page 337.</td>
</tr>
<tr>
<td>Field Replaceable</td>
<td>A check box that indicates this item may be replaced at the customer site. This is informational and has no effect on other fields or functions.</td>
</tr>
<tr>
<td>Lead Time</td>
<td>The vendor’s response time in minutes.</td>
</tr>
<tr>
<td>MTBF</td>
<td>Mean time between failures; a measure of dependability of the product.</td>
</tr>
<tr>
<td>MTTR</td>
<td>Mean time to repair; a measure of the time required to repair the product.</td>
</tr>
<tr>
<td>Return Defective</td>
<td>A check box that indicates this item, if defective, should be returned to the service center. This is informational only.</td>
</tr>
<tr>
<td>Revision</td>
<td>The current version of the product, which is copied to new asset records.</td>
</tr>
<tr>
<td>Serialized</td>
<td>A check box that indicates this product is serialized. Serialized products are treated in a different way. Whenever a serialized product is shipped or received, the application expects the right number of assets with serial numbers.</td>
</tr>
<tr>
<td>Ship carrier</td>
<td>The default carrier for the selected product; for example, UPS or FedEx.</td>
</tr>
<tr>
<td>Ship Via</td>
<td>The default mode of transportation; for example, Air, Ground, or Sea.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of a product (for example, production, obsolete, or prototype), which is copied to new asset records.</td>
</tr>
<tr>
<td>Tool</td>
<td>A check box that indicates this item is a tool used in service procedures. This is informational and has no effect on other fields or functions.</td>
</tr>
</tbody>
</table>
Inventory Options Subview
The Inventory Options subview sets the inventory locations for a product and determines how the Fulfillment Engine allocates a product from inventory or chooses a substitute when filling an order. It also sets the cycle counting default parameters for each product in inventory. For more information, see Chapter 15, "Cycle Counting and Replenishment." Table 85 describes items in Inventory Options records.

Table 85. Selected Items in the Inventory Options Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Allocate</td>
<td>When this field is set to Yes, the Fulfillment Engine can automatically allocate a product from this location. When set to Default, the engine uses the Auto Allocate setting for the product at all inventory locations, which is set in the Product view. This setting does not affect replenishment.</td>
</tr>
<tr>
<td>Allocate Below Safety</td>
<td>When this field is set to Yes, the Fulfillment Engine can automatically allocate a product from this location when the quantity falls below the safe level. When set to Default, the engine uses the Allocate Below Safety setting for the product at all inventory locations, set in the Product view. This setting does not affect replenishment.</td>
</tr>
<tr>
<td>Auto Substitute</td>
<td>When this field is set to Yes, the Fulfillment Engine can automatically substitute a product. When set to Default, the engine uses the Allocate Below Safety setting for the product at all inventory locations, set in the Product view. This setting does not affect replenishment.</td>
</tr>
</tbody>
</table>

Substitute Products Subview
The Substitute Products subview specifies the products that the Fulfillment Engine may use to fill an order when the specified product is unavailable from inventory. The user chooses from products that are specified in the Products view. For more information, see "Products View" on page 337. The Fulfillment Engine can choose this product if the Auto Substitute flag is selected.

NOTE: Substitutions are unidirectional. Product A may substitute for product B, but B cannot substitute for A unless that substitution is explicitly defined.

Administration - Data Screen
The Administration - Data screen has two fulfillment-related views for configuring orders: Order Actions and Order Types.

Actions process orders. These actions indicate that the product has been reserved for a line item (Allocate action), it has been substituted by another product (Substitute action), it has been shipped (Ship action), and so on.
Order types define the classes of orders that Field Service processes; for example, Internal Order, Service Order, RMA Return, and so on. Each Order Type has associated Order Action Types; for example, a Purchase Order typically has a Receive Order Action Type.

**NOTE:** New order types and order action types can be added through these views. However, the processing that must occur when users select these new actions and action types must be customized.

### Order Actions View

The Order Actions view defines the actions that may be associated with an order type. An administrator chooses action types from a drop-down list. The choices available in this menu are set in the Administration - Data screen > List of Values view.

**CAUTION:** Never delete order types or order action types, as their ROW_IDs provide values for tables elsewhere in Orders. To change or replace an order type or an order action type, modify the List of Values and then update (do not delete and re-enter) the Type entry.

### Order Types View

The Order Types view defines the types of orders that are available. The administrator chooses order types from a drop-down list. The choices available in this menu are set in the Administration - Data screen > List of Values view.

The Type Code field determines whether an order is a sales or service order.

### Service Order Screen

The Service Order screen includes views that relate to fulfillment of orders.

### Line Items View

The Line Items view records all items included in an order. **Table 86** describes items in Line Item records.

Table 86. Selected Items in the Line Items View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize</td>
<td>Clicking this button invokes Siebel Configurator for products categorized as customizable. For more information, see <em>Siebel Product Administration Guide</em>.</td>
</tr>
<tr>
<td>Fulfill</td>
<td>Use this command to create an inventory transaction that allocates parts from inventory and creates pick tickets for the selected line item.</td>
</tr>
</tbody>
</table>
Configuration Note
Because of the special behavior of the Line Items business component (based on special class CSSBCLineItem), a Line Item record can be updated only if its parent Order record is exposed (present and active) in the Service Order screen.

Totals Subview
The Totals subview provides a breakdown of products and services sold in terms of the price for a selected line item, a discount, and a price adjustment. The result is the total for the selected line item before adding tax and shipping.

Table 86. Selected Items in the Line Items View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fulfill All</td>
<td>Clicking this button creates an inventory transaction that allocates parts from inventory and creates pick tickets for all the line items in a selected order.</td>
</tr>
<tr>
<td>Locate/Locate All</td>
<td>These buttons appear in the view only when the Part Locator subview tab is selected. For more information, see “Part Locator Subview” on page 343.</td>
</tr>
<tr>
<td>Reprice</td>
<td>This command activates the Pricing Engine to calculate the price for the selected line item based on the associated price list and pricing procedure.</td>
</tr>
<tr>
<td>Reprice All</td>
<td>This button activates the Pricing Engine to calculate the price for all line items based on the associated price list and pricing procedure.</td>
</tr>
<tr>
<td>Qty</td>
<td>The quantity of the item in an order. This must be an integer.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> You can change the unit of measure for your product, so that you get an integer number of units. For example, you can add a value definition for Milliliter to LOV Type UNIT_OF_MEASURE, and then use this unit of measure for liquid products.</td>
</tr>
<tr>
<td>Verify</td>
<td>This button causes the FS - Verify Entitlement Order workflow to cycle through all entitlements for the selected line item and pick the best priced entitlement. The best priced entitlement appears in the Entitlement Name field.</td>
</tr>
</tbody>
</table>

Table 86. Selected Items in the Line Items View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fulfill All</td>
<td>Clicking this button creates an inventory transaction that allocates parts from inventory and creates pick tickets for all the line items in a selected order.</td>
</tr>
<tr>
<td>Locate/Locate All</td>
<td>These buttons appear in the view only when the Part Locator subview tab is selected. For more information, see “Part Locator Subview” on page 343.</td>
</tr>
<tr>
<td>Reprice</td>
<td>This command activates the Pricing Engine to calculate the price for the selected line item based on the associated price list and pricing procedure.</td>
</tr>
<tr>
<td>Reprice All</td>
<td>This button activates the Pricing Engine to calculate the price for all line items based on the associated price list and pricing procedure.</td>
</tr>
<tr>
<td>Qty</td>
<td>The quantity of the item in an order. This must be an integer.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> You can change the unit of measure for your product, so that you get an integer number of units. For example, you can add a value definition for Milliliter to LOV Type UNIT_OF_MEASURE, and then use this unit of measure for liquid products.</td>
</tr>
<tr>
<td>Verify</td>
<td>This button causes the FS - Verify Entitlement Order workflow to cycle through all entitlements for the selected line item and pick the best priced entitlement. The best priced entitlement appears in the Entitlement Name field.</td>
</tr>
</tbody>
</table>
**Line Detail Subview**

The Line Detail subview contains more information about a selected order line item, including details specific to service products, shipping and billing information, and pricing. Table 87 describes items in Line Detail records.

**Table 87. Selected Item in the Line Detail Subview**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable</td>
<td>When selected, indicates that this order line item is billable to the customer. The engine adds this item to the invoice. Can be selected regardless of the order’s type or status.</td>
</tr>
<tr>
<td>Loaner</td>
<td>When selected, indicates that a line item is on loan.</td>
</tr>
<tr>
<td>Ship Complete</td>
<td>When cleared, this check box indicates that a service center may ship only some of the line items, as needed. This is for information only.</td>
</tr>
<tr>
<td>Related Activity</td>
<td>Associates parts and tools, selected from the Pick Related Activity dialog box.</td>
</tr>
<tr>
<td>Warranty Recovery</td>
<td>When selected, indicates that a warranty credit is being requested for this line item.</td>
</tr>
<tr>
<td>Qty Shipped</td>
<td>Updated with the sum of the line item action Quantity for records of type Ship, where the line item action Status is Complete.</td>
</tr>
</tbody>
</table>

**Attributes Subview**

If the selected product is customizable with attributes, users can use the Attributes view to select specific attributes or to view the default attributes. For information about customizable products, see *Siebel Product Administration Guide*.

**Activity Plans Subview**

The Activity Plans subview associates activity templates with order line items. The activities that belong to this plan appear in Activities subview. For more information, see “Activity Plans View” on page 56.

**Part Locator Subview**

The Part Locator subview finds the product to allocate to a line item in an order. The Locate buttons that appear in the Line Items view activate the Part Locator Engine to determine the inventory locations for line items.

After the products have been located, the Allocate command (in the menu drop-down list in the Part Locator view) reserves products for the order and the Generate PickTickets button (in the Service Order view) creates pick ticket records for the allocated line items.

The Part Locator view has these subviews:

- **Available/Substitute**. This subview lists the inventory locations at which the selected line item or a substitute for the selected line item is available.
**Fulfillment**  ■  Service Order Screen

**Line Allocation.** This subview lists the quantities of the selected line item that are allocated to each inventory location.

**Actions Subview**
The Actions subview records all transactions created for the selected line item (for example, Allocate, De-Allocate, Ship, and Receive). The Fulfillment and Part Locator Engines automatically create Allocate transactions. The shipping process can automatically create De-Allocate transactions. For more information, see “Process Shipment Button” on page 376.

This subview also records manual transactions for selected line items. The De-Allocate command in the menu drop-down list creates a transaction of the type De-allocate.

For each line item action recorded, the values available in the Type field’s picklist vary according to the transactions that have occurred previously. For example, the picklist does not offer the choice De-Allocate if no Allocate action has been performed previously on the line item.

**Warranty Subview**
The Warranty subview shows the warranties associated with a product. Pre-existing warranties can also be associated with the selected line item. For more information about warranties, see Chapter 18, “Warranties.”

**Repair Subview**
The Repairs view shows the repair numbers associated with a line item. Repair # is the same as Defective Tag. This view is read-only.

**Fulfillment View**
The Fulfillment view has an Auto Receive flag that applies to Internal Orders. Selecting this flag automatically generates line items receipt and processes their receipt for the field engineer trunk inventory location when Process Shipment is done at the source inventory location. If the order is an Internal Order and the destination inventory location type is Trunk, then the flag is selected by default.
This chapter describes how a field service business sets up and maintains a service inventory. Topics include:

- Service Inventory Overview on page 345
- Setting Up Service Inventory on page 361
- Tracking Inventory on page 364
- Creating Inventory Transactions on page 365
- Scrapping Inventory on page 366
- Administration - Service Screen on page 366
- Administration - Product Screen on page 368
- Inventory Screen on page 368
- Part Browser Screen on page 372
- Inventory Transactions Screen on page 372
- Activities Screen on page 373
- Inventory Reports on page 374

**Service Inventory Overview**

Service businesses use the Service Inventory module to manage parts throughout their life cycles and to monitor parts consumption during order fulfillment and field engineer activities. Service Inventory also allows mobile field engineers to manage their trunk inventories using a disconnected client.
Figure 23 on page 346 shows the flow of goods through a service inventory. At the center of the flow is the service parts life cycle, a closed-loop process. The service parts life cycle consists of the following stages: receiving (good), order placement, picking and shipping, in-transit, customer, receive, test and sort, repair, restock to good, back again to receiving (good), and so on. Incoming goods from the manufacturer arrive at the receiving (good) stage. Goods go out to field engineers during the in-transit and receive stages. Through the field engineers, these goods go to customer sites through an in-transit stage for on-site repairs or replacements. Goods also leave the service parts life cycle during the repair stage, where the goods may be tested, repaired, scrapped, recycled or replaced by the outsource vendor.

Figure 23. Flow of Goods in Service Inventory
A materials manager can automate all of these tasks using the Fulfillment or Part Locator Engines. The Replenishment Engine automates the production of orders to restock inventory locations. For more information, see Chapter 15, "Cycle Counting and Replenishment".

**Inventory Structure**

A primary objective of Service Inventory is to record the organization of inventory.

Figure 24 on page 348 shows an example of an inventory structure, which is hierarchical. At the top level is US Inventory. At the next level, the structure is divided into California Field Service Engineers, Dallas (warehouse), Boston Repair Center (warehouse), and Field Offices.

California Field Service Engineers is divided into Fred Roberts’ trunk and Chris Smith’s trunk. Fred Roberts’ trunk has product inventory levels classified as On-Hand and Reserved. Dallas (warehouse) is divided into Aisle A, Aisle B, and Aisle C. Aisle A has Shelf 1 and Shelf 2. Shelf 1 is divided into Bin A and Bin B. Bin B has product inventory levels for Disk Drives and CD-ROM drives. Boston Repair Center (warehouse) is also divided into Aisle A and Aisle B. Field Offices are divided into Boston, Los Angeles, and San Francisco (warehouse).
Inventory Locations

Inventory locations consolidate and manage all records pertaining to service inventory. For more information, see "Inventory Locations View" on page 369. An inventory location can be a field engineer’s trunk, a warehouse, or a portion of a warehouse, such as a shelf or an aisle. An inventory level, which specifies availability and status of an item, may be added to any location in an inventory structure.

NOTE: Inventory levels were called product buckets in previous releases of Siebel Field Service.
Building an inventory requires answers to the following questions:

- Which inventory locations does Service Inventory track, and which are tracked by other means, such as an external back-office inventory system?
- How many hierarchical levels are appropriate for each inventory location?

Different types of inventory locations can be defined. The following locations are basic to Service Inventory:

- **Warehouse.** Default inventory location where the inventory fulfillment and replenishment relationships are defined. Also, pick tickets are generated at this level. All other inventory locations may be defined as subcategories of the warehouse.

- **Trunk.** Mobile inventory that is assigned to a field service engineer. Each engineer has one trunk inventory.

- **Field Office.** May supply several field service engineers. It is intermediate between a warehouse and a trunk inventory.

- **Virtual.** A logical, rather than a physical, inventory location. One virtual inventory location named External is essential for proper functioning of inventory transactions. The External location is part of the seed data, with the ROW_ID value, VIRTUAL_INVLOC. This location allows an inventory system to receive items from the outside: a virtual inventory location is the source, while the destination is one of the physical inventory locations (for example, a shelf).

Figure 25 shows the sequence of tasks for setting up a service inventory. The steps are as follows:

1. Create inventory locations and inventory types.
2. Define relationships between inventory locations.
3. Define inventory transactions.
4. Define inventory levels.
Configure cycle counting.

Figure 25. Setting Up a Service Inventory

**Trunk Inventory**
Managing a trunk inventory location requires recording part movements on the field service engineer’s laptop computer. Field service engineers periodically connect their laptop computers to a Siebel server and synchronize data.

To maximize performance during synchronization to and from the field service engineer’s local database, docking rules control the number and context of the records that are extracted, initialized, and synchronized. Because of these rules, an engineer may not have visibility to asset records required to commit a field part movement involving a serialized product. To solve this problem, the Field Service application allows the engineer to add in asset numbers. After synchronization, an administrator reconciles the add-in asset number with the corresponding database record, and the administrator commits the transaction. After the administrator commits the transaction, the field service engineer must synchronize again to update the local database.

After the field service engineer has synchronized the laptop in the field, an administrator can use the Parts Movement Administration view. For more information about reviewing and committing transactions, see "Parts Movement Administration View" on page 366.
Inventory Relationships

An inventory location is linked to other locations by relationships that define physical spaces, replenishment sources, fulfillment sources, and cycle counting lists. An inventory structure consists of a network of relationships.

Siebel Field Service can implement an inventory structure in several ways:

- Create one inventory location (for example, a warehouse), maintain the products at this location (in inventory levels), and then attach the physical location to the inventory level.
- Assign locator numbers to logically divide an inventory location. Locators have values like A1S3B7, meaning Aisle1, Shelf3, and Bin7. A locator number does not imply an inventory type (for example, a bin). The locator numbers should be used, along with the locator order, to optimize shipping and cycle counting.
- Define each aisle, shelf, and bin as a separate inventory location. Only bin-level inventory has products; typically only one or two products reside in each bin. The inventory name can reflect the combination of location and product. These different inventory locations can be linked to each other with the relationship type Sub-level, which indicates, for example, that Aisle1 is a sublevel inventory location of Warehouse.

While considering fulfillment, generating cycle counting lists, or running the Replenishment Engine at the warehouse level, all inventories below the Warehouse level (and connected using sublevels) are automatically considered.

To improve performance (for example, to avoid traversing a tree every time it is necessary to find all sublevels of inventory for a warehouse), Field Service uses a denormalized table. This table stores every child, direct child, or grandchild (to any number of levels deep) of a parent inventory. If an inventory hierarchy is defined as follows:

- Inventory A is a parent of Inventories B, C, and D
- Inventory B is a parent of inventories E and F

Then Table 88 summarizes the entries in the denormalized table.

<table>
<thead>
<tr>
<th>Parent Invloc</th>
<th>Invloc</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>A</td>
<td>C</td>
</tr>
<tr>
<td>A</td>
<td>D</td>
</tr>
<tr>
<td>A</td>
<td>E</td>
</tr>
<tr>
<td>A</td>
<td>F</td>
</tr>
<tr>
<td>B</td>
<td>E</td>
</tr>
<tr>
<td>B</td>
<td>F</td>
</tr>
</tbody>
</table>
Inventory locations may also be related through replenishment. However, replenishment relationships should be defined for inventory locations of type Warehouse only. For example, configuring the replenishment relationship, Oakland field office replenishes trunk, may result in the trunk inventory being overstocked if the trunk location is already a sublevel of a parent inventory.

**NOTE:** Fulfillment and replenishment relationships between inventory locations should be set at the warehouse level, and not at lower levels; for example, aisles, bins, or shelves. When using relationships, the Fulfillment, Replenishment, and Part Locator Engines automatically search for parts at lower levels by using sublevel relationships.

---

**Tracking an Inventory Location**

There are two methods for tracking a part’s physical location in an inventory:

- If inventory locations are defined down to the shelf or bin level, attach the inventory level to a bin or shelf, whose fixed location identifies the part.

- Enter a description of the part’s inventory location in the Locator fields of the Product Inventory view. This view provides three Locator fields to allow for multiple possible locations; for example, a part called Defective 1 GB HD might be found first in the northeast corner of the San Francisco field office, second on shelf A in the supplies room, and third on shelf B in the supplies room.

---

**Inventory Levels**

Inventory levels are categories of products defined by a combination of availability and status. Both availability and status can have a variety of values. Availability values are Customer Owned, In Transit, On Hand, On Order, and Reserved. Status values are Good and Defective. Table 89 shows some examples of inventory levels for one product.

<table>
<thead>
<tr>
<th>Availability</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Order</td>
<td>Good</td>
</tr>
<tr>
<td>On Hand</td>
<td>Good</td>
</tr>
<tr>
<td>Reserved</td>
<td>Good</td>
</tr>
<tr>
<td>In Transit</td>
<td>Defective</td>
</tr>
</tbody>
</table>

The Inventory screen records inventory levels and asset numbers for each product in inventory. New products and inventory levels can be added to an inventory in this view, but it is not necessary to create these records manually. When an inventory transaction occurs, products and inventory levels are automatically created if they do not exist. However, products created this way are not assigned Min, Max, and Safety values or a cycle counting class (A, B, or C; X, Y, or Z), so product records may need updating on the Service Inventory screen. For more information, see “Inventory Screen” on page 368.
You can create or update inventory levels by loading them through the EIM_PRODINVLOC table. You can also create or update inventory transactions by loading them through the EIM_INV_TXN table.

**Negative Inventory Levels**
Negative inventory levels may result from certain inventory transactions. Negative inventory levels are possible only for nonserialized products. Inventory levels may acquire negative values under the following circumstances:

- When the logical inventory does not match the physical inventory (in other words, if the item is on the shelf but the database does not show that it is available).
- When reconciling transactions to or from an External Location. The External Location must have negative quantities so that it can receive inventory from an external source.

**Best Practice: Managing Inventory Levels**
If the Inventory levels do not exist, they are automatically created by inventory transactions. However, it is recommended that inventory levels be initiated as part of the Authorized Stock List for an inventory location. As part of the Authorized Stock List, the default inventory levels (for example, On Hand - Good) should be created when an inventory location is created or when a new product is added to an inventory location. If your company plans to stock a particular inventory level, then you should not rely on an inventory transaction to create it.

Creating an inventory level when a product is added to an inventory location can be automated by setting up a workflow process. For more information about Siebel workflows and how to set them up, see *Siebel Business Process Framework: Workflow Guide*.

**Location Order**
Service Inventory can specify a preferred order for using inventory at several different locations. By specifying which location to use first, Service Inventory minimizes the time required for a warehouse clerk to find an item for shipping (pick tickets), to stock inventory (replenishment), or for cycle counting. Location order can suggest order management strategies, like First-In-First-Out (FIFO). However, allocation takes the place of inventory levels and does not follow plans like FIFO or LIFO.

**NOTE:** Location Order is for information only. It has no effect on the Fulfillment or Cycle Counting Engines.

Location order is represented by locator numbers (1, 2, and 3). Each locator number is defined by a locator code that applies to a specific warehouse or inventory system. *Table 90* shows examples where part H3 may occur at three different inventory locations with different locator codes.

<table>
<thead>
<tr>
<th>Locator Number</th>
<th>Example of a Locator Code</th>
<th>Meaning of Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A3S1B1</td>
<td>Aisle 3, shelf 1, bin 1</td>
</tr>
</tbody>
</table>
Service Inventory  ■  Service Inventory Overview

The location order can be any sequence of locator numbers; for example, 123 or 213. Make sure that the location order represents the optimized path through the warehouse.

Inventory locations 1, 2, and 3 (or Locators) are specified for inventory levels in the Inventory screen, Product Inventory view, Inventory Level subview. For more information, see “Inventory Level Subview” on page 370. Location Order appears as a read-only field in the Products screen, Inventory Locations view. Locations (1, 2, and 3) appear as read-only fields in the Cycle Counts screen, Part List view.

Table 90. Sample Locations Using Locator Numbers

<table>
<thead>
<tr>
<th>Locator Number</th>
<th>Example of a Locator Code</th>
<th>Meaning of Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A3S2B6</td>
<td>Aisle 3, shelf 2, bin 6</td>
</tr>
<tr>
<td>3</td>
<td>A15S3B1</td>
<td>Aisle 15, shelf 3, bin 1</td>
</tr>
</tbody>
</table>

The location order can be any sequence of locator numbers; for example, 123 or 213. Make sure that the location order represents the optimized path through the warehouse.

Inventory and Product Serialization

If a product is serialized by selecting the Serialized check box in the Product Service Details view (for more information, see “Product Service Details View” on page 338), then a serial number is required for all movements and transactions of assets of this product, including the following:

- Inventory transactions
- Field part movements
- Cycle counts
- Shipments
- Receipts

Serialized products are treated differently from nonserialized ones. If a product is serialized, the user needs to enter assets for the product. Whenever a serialized product is shipped or received, Field Service expects the right number of assets with serial numbers. For example, if four serialized hard drives are shipped or received, Field Service expects that four separate serial numbers are entered.

**NOTE:** When a serialized asset is allocated through a manual order, the system allocates the product quantity specified in the order, not the asset itself. Consequently, the asset remains in the On Hand - Good/Defective inventory level.

For more information, see *Siebel Enterprise Integration Manager Administration Guide*.

Asset Transactions

The asset transactions that maintain an install base are Install, Uninstall, Upgrade, and Downgrade. These transactions do not directly update quantities in inventory levels.
When a field service engineer reports part movements in the field, inventory and asset transactions are generated automatically. For example, a record in the Part Movement list with a source of Customer and a destination of Trunk means that the field service engineer has taken a part out of the customer’s installed base and has put it in the trunk. The Mobile Inventory Transaction Engine reflects this transfer by creating an inventory transaction (to receive the part into a trunk) and an asset transaction (to change the installed base).

When a field service engineer is repairing, updating, or replacing items referenced in a service order, the engineer selects Service Order as a source and specifies Customer as the destination. Since the item is added to the customer’s installed base, only an asset transaction is generated.

You can create asset transactions manually in the Assets screen’s Transactions view.

If you perform any inventory transaction on a hierarchical asset, then only the Inventory Location field of the parent component will show the correct location. The Inventory Location field of the child subcomponents will be blank or will have a value of External Location.

Changes can occur in some other fields of the asset’s parent component according to the type of inventory transaction. Whether these effects occur on the fields of the hierarchical asset’s child subcomponents depends on whether the fields are set to cascade their values from the parent to the child. For more information about hierarchical assets, see “Hierarchical Assets” on page 469.

**Inventory Transactions**

The Service Inventory module is transaction-based. Field Service uses inventory transactions to update inventory levels in response to parts movements between two locations or whenever there is change in an inventory level. Each inventory transaction has a product, a quantity, a source, and a destination.

Here are some examples of business activities that create inventory transactions:

- Perform a part movement by installing or removing a part and move it into or out of the service engineer’s trunk.
- Allocate or de-allocate a part according to a line item on an order, either manually or through the Fulfillment engine.
- Ship an order and click the Process Shipment button on the Shipping screen.
- Receive an order and click the Generate Transaction button on the Receiving screen.
- Create a transaction manually in the Inventory Transactions screen.
Table 91 summarizes the types of inventory transactions.

Table 91. Summary of Types of Inventory Transactions

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment</td>
<td>Adjusts inventory levels; for example, if after a cycle count there is a variance between original inventory and counted inventory. Manually generated in the Inventory Transactions screen, or automatically in the Cycle Counts screen &gt; Variance view. For more information, see “Cycle Counts Screen” on page 439.</td>
</tr>
<tr>
<td>Allocate</td>
<td>Adds inventory to an inventory level with an availability of Reserved. Automatically generated when an Allocate action is called for an order line item.</td>
</tr>
<tr>
<td>De-Allocate</td>
<td>Clears inventory from an inventory level with an availability of Reserved. Automatically generated when a De-Allocate action is called for an order line item.</td>
</tr>
<tr>
<td>Exchange Between FSEs</td>
<td>Moves inventory from one trunk inventory to another. Intended to move inventory between field service engineers. Manually generated in the Inventory Transactions screen.</td>
</tr>
<tr>
<td>Over-the-counter</td>
<td>Moves inventory from one inventory location or level to another. Intended to move inventory from warehouses to field service engineers’ trunks. Manually generated in the Inventory Transactions screen.</td>
</tr>
<tr>
<td>Receive from TP</td>
<td>Moves inventory from a third-party location that is defined in the inventory system (in the Service Order screen &gt; Fulfillment view) to the inventory location defined in the Receiving screen, Line Item Receipts view.</td>
</tr>
<tr>
<td>Receive Internal</td>
<td>Moves inventory from an inventory level with the availability of In Transit to a defined physical inventory level, such as a shelf in a warehouse. A stock transfer, automatically generated in the Receiving screen.</td>
</tr>
<tr>
<td>Receive Other</td>
<td>Enters inventory, on receipt, into an inventory level. Part of a transaction with a customer, which uses a virtual inventory location called External Location or Customer. These locations come as seed data with Field Service. Received from the Customer location to the location specified in the Receiving screen, Line Item Receipts view.</td>
</tr>
<tr>
<td>Ship Internal</td>
<td>For internal orders, moves inventory from a physical inventory level to an inventory level with the availability of In Transit. A stock transfer, automatically generated in the Shipping screen.</td>
</tr>
<tr>
<td>Ship Other</td>
<td>For outside orders, moves inventory from a physical inventory level to an inventory level with the availability of In Transit. Part of a transaction with a customer that uses a virtual inventory location called Customer. The Customer location is included as seed data with Field Service.</td>
</tr>
</tbody>
</table>
Table 91. Summary of Types of Inventory Transactions

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship to TP</td>
<td>Moves inventory from the location from which the item was allocated and the</td>
</tr>
<tr>
<td></td>
<td>pick ticket generated to the destination location defined in the Service</td>
</tr>
<tr>
<td></td>
<td>Order screen &gt; Fulfillment view.</td>
</tr>
<tr>
<td>Stock Transfer</td>
<td>Moves inventory from one inventory level or location to another, whether the</td>
</tr>
<tr>
<td></td>
<td>inventory levels or locations are in the same warehouse or in different</td>
</tr>
<tr>
<td></td>
<td>warehouses. Manually generated in the Inventory Transactions screen.</td>
</tr>
</tbody>
</table>

**Conditions for Generating Transactions**

Table 92 defines the types of inventory transactions created for combinations of source and destination locations, inventory levels, and serialized versus nonserialized assets.

Table 92. Conditions for Generating Transactions Types

<table>
<thead>
<tr>
<th>Inventory Transaction</th>
<th>Inventory Txn Type</th>
<th>Source</th>
<th>Inventory</th>
<th>Inventory Level</th>
<th>Assets</th>
<th>Destination</th>
<th>Inventory</th>
<th>Inventory Level</th>
<th>Assets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part movement on</td>
<td>Ship Other</td>
<td>Trunk</td>
<td>On Hand</td>
<td>Yes</td>
<td>Customer</td>
<td>On Hand</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ship Other</td>
<td></td>
<td>of FE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receive Other</td>
<td>Customer</td>
<td>On Hand</td>
<td>Yes</td>
<td>Trunk of FSE</td>
<td>On Hand</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allocate action</td>
<td>Allocate</td>
<td>Customer</td>
<td>On Order</td>
<td>No</td>
<td>Ord Part Movement Source Invloc ID</td>
<td>Reserved</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insertion on order</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>entry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>De-allocate action</td>
<td>De-allocate</td>
<td>Ord Part Movement Source Invloc ID</td>
<td>Reserved</td>
<td>No</td>
<td>Customer</td>
<td>On Order</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insertion on order</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>entry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ship other</td>
<td>Ship Other</td>
<td>Ord Part Movement Source Inv</td>
<td>On Hand</td>
<td>Yes</td>
<td>Customer</td>
<td>On Hand</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>De-allocate</td>
<td>Ord Part Movement</td>
<td>Reserved</td>
<td>Yes</td>
<td>Customer</td>
<td>On Order</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Source Inv</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Siebel Field Service Guide Version 8.0, Rev. B 357
Table 92. Conditions for Generating Transactions Types

<table>
<thead>
<tr>
<th>Inventory Transaction</th>
<th>Inventory Txn Type</th>
<th>Source Inventory</th>
<th>Source Inventory Level</th>
<th>Assets</th>
<th>Destination Inventory</th>
<th>Destination Inventory Level</th>
<th>Assets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship internal</td>
<td>Ship Internal</td>
<td>Ord Part Movement Source Inv</td>
<td>On Hand</td>
<td>Yes</td>
<td>Order header. Destination Invloc ID</td>
<td>In Transit</td>
<td>Yes</td>
</tr>
<tr>
<td>De-allocate</td>
<td>Ord Part Movement Source Invloc ID</td>
<td>Reserved</td>
<td>Yes</td>
<td>Customer</td>
<td>On Order</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Receive RMA/PO</td>
<td>Receive Other</td>
<td>Customer</td>
<td>On Hand</td>
<td>Yes</td>
<td>Ord Part Movement Dest Inv</td>
<td>Ord Part Movement Avail/ Status</td>
<td>Yes</td>
</tr>
<tr>
<td>Receive internal</td>
<td>Receive Internal</td>
<td>Order Hdr Destination Inv</td>
<td>In Transit</td>
<td>Yes</td>
<td>Ord Part Movement Dest Inv</td>
<td>On Hand</td>
<td>Yes</td>
</tr>
<tr>
<td>Ship RO</td>
<td>Ship to TP</td>
<td>Ord Part Movement Source Inv</td>
<td>On Hand</td>
<td>Yes</td>
<td>Order header. Destination Invloc ID</td>
<td>On Hand</td>
<td>Yes</td>
</tr>
<tr>
<td>De-allocate</td>
<td>Ord Part Movement Source Invloc ID</td>
<td>Reserved</td>
<td>Yes</td>
<td>Customer</td>
<td>On Order</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Receive RO</td>
<td>Receive from TP</td>
<td>Order Hdr Destination Inv</td>
<td>On Hand</td>
<td>Yes</td>
<td>Ord Part Movement Dest Inv</td>
<td>On Hand</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**NOTE:** In the preceding table, the assets rows are included in the transaction validation if the product is serialized. Also, TP represents third-party provider.

The following rules regulate the generation of inventory and asset transactions:

- If a product is serialized:
  - The asset for the part movement must be specified.
  - The quantity of the part movement must be 1.
  - The asset must belong to the source inventory.

When these conditions are met, the inventory transaction is validated and the inventory database is updated.
If the product is not serialized and no asset number is specified, a committed inventory transaction is generated without validation and committed successfully.

If the product is not serialized and no asset number is specified, neither an asset validation nor an asset transaction takes place. The inventory location is not stamped on the asset.

**Bulk Inventory Transactions**

Bulk inventory transactions allow multiple assets to be simultaneously moved to a new inventory location. This can be useful in bulk stock transfers and receiving dock scenarios.

*To perform a bulk inventory transaction*

1. Navigate to the Assets screen > List view.
2. Select the assets to transfer, and click Transfer.
3. In the Inventory Transactions applet, complete the fields as appropriate. In the Selection Type field, choose Selected Items to transfer only the assets selected in the list, or choose Entire Document to transfer all assets in the list. Click Transfer.

**NOTE:** You can transfer only the assets of the serialized products. For each product that you want to transfer, the Serialized check box must be checked on the Products screen. For more information on the Serialized check box, see “Product Service Details View” on page 88.

**Workflows to Perform Bulk Inventory Transactions**

The Bulk Inventory Transaction - Asset List - Default workflow uses the FS Inventory Transaction business service and the Inventory Transaction - Asset List - Default workflow to move all assets from their current inventory locations to the specified destination. In the background, separate inventory transactions are created and can be reviewed on the Inventory Transaction screen. The workflow is called when the user clicks the Transfer button on the Inventory Transactions applet. For information on the methods used in this business service, see “FS Inventory Transaction Business Service” on page 577.

The Bulk Inventory Transaction - Asset List - Default workflow gets the asset-related details and source details, then organizes the asset list according to location, product, source, and availability. The workflow then invokes the Inventory Transaction - Asset List - Default workflow, which creates the inventory transaction headers, adds the asset details to the transaction headers, and commits the transaction.

**Mobile Inventory Transactions**

Siebel Field Service can record part movements in the field (mobile inventory) without synchronizing with the Field Service server. This allows field service engineers to record transfers of assets without having the asset number or serial number on their laptop computers.
Normally, recording transfers of assets without having asset numbers or serial numbers would cause a transaction to fail. However, with Field Service, the part movement is recorded but not applied to the inventory database.

If the mobile computer is disconnected, the local database is updated. When the mobile computer is synchronized with the Siebel server, the information about the part movement is transferred to the server. If the asset was identified in the database on the remote computer, the server records the change in inventory location in the database and then creates a transaction.

If a part movement was not validated on the remote computer (this includes all add-in assets), an uncommitted part movement appears in the Administration - Service screen > Parts Movement Administration view. For more information, see "Parts Movement Administration View" on page 366. An administrator must review uncommitted part movements and reconcile add-in serial numbers with existing asset numbers. The Commit button then creates transactions. For more information, see "To commit transactions reported by mobile clients" on page 365. For information about the types of transactions created for specific combinations of source and destination locations, see "Setting Up Service Inventory" on page 361.

The next time the remote computer is synchronized, its local database is updated to match the server database.

**Commit Buttons**

Commit buttons appear on the Activities screen’s Expense Tracker, Part Tracker, and Time Tracker views; and on the Administration - Service screen’s Parts Movement Administration view. The commit step of a transaction begins when the record is saved with the Commit flag set. The field service engineer uses the Commit button on the Activities screen to perform validations as described in the following procedure.

**To perform validation checks using the Commit button**

1. Are source and destination inventories specified? This condition must be met first. If the asset does not belong to the source inventory level, leave it uncommitted.
2. Is the position of the owner of the activity associated with a trunk inventory (location type Trunk)?
3. If an asset number is provided, is it valid?
4. For each asset transaction, is the asset at the specified inventory source location? This validation is not performed for the External location or the Customer location. For more information, see "Setting Up External Locations" on page 369.
5. Is the item available? Availability and status are verified. This validation is not performed for the External location.
6. Does the source inventory have the quantity of assets specified? This quantity is 1 if the part is serialized.
7. If the product is serialized, does the total quantity for an inventory transaction equal the total number of assets entered for this transaction?
If these validation checks are successful, the Commit flag is set in Part Tracker records and records are generated to record inventory movements. See the following procedure for more information.

**To generate records to record inventory movements**

1. Create a committed inventory transaction; for example, Receive Other.
2. Create assets for the inventory transaction.
3. Create new database records for the inventory location: source and destination.
4. Update the asset record (ID).
5. Create asset transactions; for example, Install.
6. Commit the part movement by updating the database.

**Setting Up Service Inventory**

These are procedures for setting up the structure and operation of an inventory system using Siebel Field Service. The procedures may require administrative access.

**Defining Products for Field Service**

Before you set up an inventory system, you must define the products that the inventory system will track. For more information on defining products, see *Siebel Product Administration Guide*.

**To specify an asset for a product**

1. Navigate to the Assets screen.
2. Add a new record and complete the fields as appropriate.

**To specify allocation of products**

1. Navigate to the Administration - Product screen > Products view.
2. Select a product, and then drill down on the Product field.
3. Click the Product Service Details link in the link bar, and then select the desired allocation modes: Auto Allocate, Auto Substitute, or Allocate Below Safety.

   For more information, see "Product Service Details View" on page 338.

   **CAUTION:** If you change the Allocate Below Safety, Auto Allocate, or Auto Substitute flags, you must restart the Parts Locator and Fulfillment Server components. (You do not need to restart the entire server.) If you do not restart these components, the system will not reset the product attribute settings in the Part Locator Engine and the Fulfillment Engine. For information about how to restart server components, see *Siebel System Administration Guide*. 
In the Inventory Options subview, add records for each type of inventory location from which this product may be allocated. Complete the fields as appropriate.

This subview inherits Allocate Below Safety, Auto Allocate, and Auto Substitute values from the More Info view.

For information about cycle counting, see “Configuration of the Cycle Counting Engine” on page 419.

**Setting Up an Inventory**

Follow these procedures to set up an inventory.

**To define inventory types**

1. Navigate to the Administration - Service screen > Inventory Administration view.
2. In the Inventory Location Types view, create a new record and complete the fields as appropriate.

   For information about this subview and cycle counting, see “Inventory Location Types Subview” on page 367 and “Configuration of the Cycle Counting Engine” on page 419.

**To create an inventory location**

1. Navigate to the Inventory screen.
2. Create a new record and complete the fields as appropriate.

**To add a product to inventory**

1. Navigate to the Inventory screen.
2. Drill down on the selected inventory location, add a record, and complete the fields as appropriate.

   For more information, see “Configuration of the Cycle Counting Engine” on page 419.

**To create an inventory level**

1. Navigate to the Inventory screen.
2. Drill down on the selected inventory location and select a product.
3. In the Inventory Level subview, create a new record and complete the fields as appropriate.

**To associate an employee with an inventory location**

1. Navigate to the Inventory screen.
2 Select an inventory location. Then in the Ownership field, select Owned and in the Position field, select a position.

The inventory location appears in the My Inventory Locations view for the employee associated with the selected position.

To associate a vendor with an inventory location
1 Navigate to the Inventory screen > Vendors view.
2 Create a new record and complete the fields as appropriate.

To associate an inventory location with an organization
1 Navigate to the Inventory screen > Inventory Locations view.
2 Select an inventory location. Then, in the Organization field, select an organization or add one if none appears.

The organization marked as primary appears in the Organization field.

To define inventory levels
1 Navigate to the Administration - Service screen > Inventory Administration view.
2 Click the Inventory Level Categories view tab, and then add a record. Complete the fields as appropriate.

To define the relationships between inventory locations
1 Navigate to the Inventory screen.
2 Drill down on a selected inventory location, and then click the Relationships view tab.
3 Create a new record and complete the fields as appropriate.

Setting Up Inventory Transactions

Follow these procedures to define inventory transactions.

To define types of inventory transactions
1 Navigate to Administration - Service screen > Inventory Administration view.
2 Click the Inventory Transaction Types view tab and add a record.
Synchronizing Remote and Local Databases

Siebel Remote allows mobile or remote clients (typically laptop computers) to connect to a Siebel Server and exchange updated data and files, a process known as synchronization. For information about setting up and using Siebel Remote, see Siebel Remote and Replication Manager Administration Guide.

Tracking Inventory

Follow these procedures to verify inventory.

To verify inventory status using the Inventory screen
1. Navigate to the Inventory screen.
2. Drill down on a selected inventory location, and then click the Product Inventory view tab.
3. Select a product.
   The Inventory Level subview shows the inventory status for all products at the selected location.

To verify inventory status using the Part Browser
1. Navigate to the Part Browser screen.
2. Select a product.
   The Inventory Level subview shows the inventory status for the selected product.

To generate inventory status reports
1. Navigate to the Inventory screen.
2. Select an inventory location, and then choose Reports > Product List by Location or Products Below Minimum Level by Location.

To view cycle counting parameters for a selected location
1. Navigate to the Inventory screen.
2. Drill down on a selected inventory location.

To view all inventory transactions
- Navigate to the Inventory Transactions screen.
Creating Inventory Transactions

Follow these procedures to process inventory transactions.

To create inventory transactions manually
1. Navigate to the Inventory Transactions screen.
2. Create a new record and complete the fields as appropriate.

To add an asset to an inventory transaction
1. Navigate to the Inventory Transactions screen.
2. Drill down on the selected inventory transaction.
3. In the Assets view, create a new record and complete the fields as appropriate.
   Available assets vary dynamically according to the Source Location in the inventory transaction record. The assets available to select are only those at that Source Location. If the Source Location is External Location, Field Service shows all assets not currently assigned to any location.

To receive a product as a stock transfer or over-the-counter transaction
1. Navigate to the Inventory Transactions screen.
2. Add a record. In the Type field, select Over-the-counter and complete other fields as appropriate.
3. (Optional) If the product is serialized, in the Assets view, create a new record for the transaction.

To move an item from one trunk to another: source mobile client
1. Navigate to the Inventory Transactions screen.
2. Add a record. In the Type field, select Exchange Between FSEs and complete other fields as appropriate.

To move an item from one trunk to another: destination mobile client
1. Navigate to the Activities screen.
2. Drill down on a selected activity, and then click the Part Tracker view tab.
3. Create a new record and complete the fields as appropriate.

To commit transactions reported by mobile clients
1. Navigate to the Administration - Service screen > Parts Movement Administration view.
Select an uncommitted part movement record. In the Asset # field, select an asset. The asset should correspond to the add-in serial number entered by the mobile field service engineer.

3. Select the Commit check box to generate an inventory transaction that decrements the source inventory location and increments the destination location.

**Scraping Inventory**

If you need to create inventory transactions to scrap or write off inventory of a product, follow this procedure.

*To scrap or write off inventory*

1. Assign one of the following inventory transaction types:
   - The existing type, Ship Other
   - A new type that you create; for example, Scrap

   For information about assigning a transaction type, see "To create inventory transactions manually" on page 365. For information about creating a transaction type, see "To define types of inventory transactions" on page 363.

2. Send the inventory to one of the following inventory locations:
   - The existing virtual location, External Location
   - A new virtual location that you create; for example, Scrap Location

   For information about assigning an inventory location, see "To add a product to inventory" on page 362. For information about creating a virtual inventory location, see "To create an inventory location" on page 362.

**Administration - Service Screen**

The Administration - Service screen has views for managing inventory transactions that have taken place in the field, for defining inventory transaction types, and for defining inventory level categories.

**Parts Movement Administration View**

A field service administrator uses the Parts Movement Administration view to commit transactions that have occurred in the field, but are not yet committed. These transactions can be the result of the movement of parts between trunks, customer sites, and service orders.
The administrator commits each part movement record by entering an asset number that is already in the database and clicking Commit. The Commit button creates the appropriate transactions in the database. After synchronizing with mobile computers, the changes are transferred to the local databases on the mobile clients. For more information, see "Mobile Inventory Transactions" on page 359.

**Inventory Administration View**

The Inventory Administration view contains subviews for setting the types of inventory locations, inventory transactions, and inventory categories that appear in this view.

**Inventory Location Types Subview**

The Inventory Location Types subview defines the inventory locations that are available in the Type field in Inventory > Inventory Locations. For more information, see "Inventory Locations View" on page 369. Examples of location types are Aisle, Trunk, and Virtual.

**CAUTION:** Do not delete Inventory Types, Inventory Level Categories, or Inventory Transaction Types. Their Row_IDs provide values for tables elsewhere in Inventory. To change or replace an Inventory Type, Inventory Transaction Type, or Inventory Level Category, modify the List of Values and then update (do not delete and re-enter) the Type entry.

Also, do not delete the Inventory table row with the name External Location and the type Virtual, which is shipped as seed data with Field Service. Inventory transactions use this row, and cannot process without it. Changing the name is acceptable.

**Inventory Transaction Types Subview**

The Inventory Transaction Types subview defines the transaction types that are available in the Type field of the “Inventory Transactions View” on page 373. For more information about these transaction types, see “Inventory Transactions” on page 355.

**Inventory Level Categories Subview**

The Inventory Level Categories subview defines the inventory levels that are available in Inventory > Product Inventory. For more information, see “Inventory Level Subview” on page 370. An inventory category consists of a pairing of two values, availability and status. Examples of availability are On Hand, On Order, and Reserved. Examples of Status are Good and Defective.

**NOTE:** It is not necessary to create products and inventory levels manually. When an inventory transaction occurs, products and inventory levels are automatically created in the database if they do not exist. However, products created automatically in this way are not assigned specific levels, allocation values, substitution values, or cycle counting classes. It might be necessary to go to the Inventory Administration view and update newly created records in the Inventory Location Types and Inventory Level Categories subviews.
Administration - Product Screen

The Administration - Product screen defines products. For more information, see Siebel Product Administration Guide. You can select the following views from the link bar on the More Info tab.

Products View

The Products view records basic information about each product; for example, product name, part number, and revision.

Product Service Details View

The Product Service Details view provides the information used in locating and allocating products for use in field service activities. For more information, see “Product Service Details View” on page 338.

NOTE: This view has two subviews, Inventory Options and Substitute Products.

Inventory Options Subview

The Inventory Options subview sets the inventory locations for a product. It determines how the Fulfillment Engine allocates a product from inventory or chooses a substitute when filling an order. It also sets the cycle counting parameters for each product at a specific location. For more information, see Chapter 15, “Cycle Counting and Replenishment.” For details, see “Inventory Options Subview” on page 340.

Substitute Products Subview

The Substitute Products subview specifies the products that the Fulfillment Engine can use to fill an order when the specified product is unavailable from inventory. The user chooses from products that are specified in the Products view. For more information, see “Products View” on page 368. The Fulfillment Engine can choose this product if the Auto Substitute flag is selected. For details, see “Substitute Products Subview” on page 340.

Inventory Screen

The Inventory screen sets up and manages inventory locations and the products stored at these locations. For each product, it defines the inventory levels and records information about assets of these products. For replenishing inventory, it generates orders, displays the authorized vendors, and displays pending orders. For more information, see “Replenishment Engine” on page 427. For cycle counting of inventory, parameters are defined and cycle counting lists are generated. For more information, see “Cycle Counts Screen” on page 439.

In addition, the Inventory screen defines the roles of personnel at each inventory location.
Inventory Locations View

The Inventory Locations view defines the inventory locations in a service business. The drop-down list below the view bar provides these choices for inventory locations: My Inventory Locations, All Inventory Locations, and All Inventory Locations Across Organizations.

All Inventory Locations Across Organizations

An organization is a category that limits the visibility of data within a company. The All Inventory Locations Across Organizations view shows the inventory locations for all organizations within a company. Inventory transactions can take place only between locations within the same organization (set in the Inventory Locations list). For more information about setting up organizations, see the chapter on access control in *Siebel Security Guide*.

The person who owns a record can see this record in the My Inventory Locations view, even if it is in a different organization. However, for the same person, this record does not appear in the All Inventory Locations view.

**CAUTION:** Improper configuration of organizations and inventory locations can lead to unintended results. It may not be possible to carry out inventory transactions between certain locations.

Setting Up External Locations

The seed data supplied with Field Service contains an External Location with the type, Virtual. This location is used as the default in the absence of a source or destination location. The seed data also allows inventory transactions between locations in different organizations. For more information, see “Inventory Transactions Across Organizations View” on page 373.

The administrator cannot delete the External Location record. The ROW_ID (for example, VIRTUAL_INVLOC) makes this value unique. Certain C++ code in Field Service references this value. If the administrator were to delete this row and re-create it, the record would be assigned a new ROW_ID and certain transactions would fail. The administrator can rename the location.

To assure that all field service engineers in any organization within the company can use the External Location, using the Organization field, associate all organizations in the company with the External Location.
Product Inventory View

The Product Inventory view associates inventory locations with products, sets quantities of each product, and sets cycle counting parameters for the product at the selected location. Products are specified in the Administration - Product screen. For more information, see “Administration - Product Screen” on page 368. Table 93 describes items in Product Inventory records.

Table 93. Selected Items in the Product Inventory View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>Minimum acceptable quantity of inventory at this location and product.</td>
</tr>
<tr>
<td>Max</td>
<td>Maximum acceptable quantity of inventory at this location and product.</td>
</tr>
<tr>
<td>Safety</td>
<td>Safe quantity of inventory for the selected location and product. The safe quantity (≤ Min) is the quantity below which the Fulfillment Engine should not allocate a product.</td>
</tr>
<tr>
<td>Serialized</td>
<td>Indicates whether instances of this product must have serial numbers recorded in the database.</td>
</tr>
</tbody>
</table>

Inventory Level Subview

The Inventory Level subview associates inventory levels (availability and status) with products and defines the Location Order. For more information, see “Location Order” on page 353 for each inventory level. Table 94 describes items in Inventory Level records.

Table 94. Selected Items in the Inventory Level View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Order</td>
<td>Indicates the preferred order for use of Locators 1 through 3. For example, 213 means that the item is best obtained from location 2, then 1, and finally 3. This order is used for the physical process of shipping and cycle counting. It has no effect on the Fulfillment or Cycle Counting Engines.</td>
</tr>
<tr>
<td>Locator 1-3</td>
<td>Description of the physical location of a product at an inventory level.</td>
</tr>
</tbody>
</table>

Assets Subview

The Assets subview describes all of the assets of the selected product at an inventory location. Fields in this subview indicate both asset numbers and serial numbers.
Generate Orders View

The Generate Orders view automatically produces orders to restock products in inventory, either by internal transfer between inventory locations or by purchase from an outside vendor. For replenishment, an inventory level must be defined for a product. For replenishment from a vendor, the authorized vendor must also be defined.

The Order button runs the Replenishment Engine to replenish all items that are below minimum at the selected location.

The replenishment process describes either a source inventory location to replenish a selected location or a target location to be replenished from the selected location. Specific relationships between locations are defined in the Relationships view. For more information, see “Relationships View” on page 371. For more information about replenishment, see Chapter 15, “Cycle Counting and Replenishment.”

Pending Orders View

The Pending Orders view lists orders that have been placed to replenish a location, either by part movement between inventory locations or by purchases from vendors. This view is read-only.

For more information about replenishment, see Chapter 15, “Cycle Counting and Replenishment.”

Vendors View

The Vendors view records vendors who may supply products for a selected inventory location.

Relationships View

The Relationships view records the relationships between a selected inventory location and other inventory locations. If a business uses more than one inventory location, relationships among inventory locations are useful for automating inventory replenishment and order fulfillment. A relationship may be physical (for example, a shelf belongs to an aisle) or logistical (replenishment of inventory or fulfillment of orders). Table 95 shows items in relationships records.

Table 95. Items in the Relationships View

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of location; for example, Warehouse or Trunk.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Relationship of this inventory location to the location selected in the Inventory Locations tab. The choices are Fulfills, Replenishes, and Sublevel.</td>
</tr>
<tr>
<td>Order Priority</td>
<td>Priority of an order to be fulfilled from the inventory location, if the relationship type is Fulfills (for example, Low, Medium, or High).</td>
</tr>
</tbody>
</table>
Roles View
The Roles view sets the roles of personnel associated with a selected inventory location.

Cycle Counts View
The Cycle Counts view shows the parameters for cycle counting at a selected inventory location and the status of cycle counts for this location. Cycle counts and cycle count periods are described in “Cycle Counts View” on page 438.

Part Browser Screen
The Part Browser screen presents a catalog of all parts in a service inventory. The fields in this screen are read-only.

Parts View
The Parts view presents a summary of products at every inventory location in a service business. Any product may be in more than one location.

Inventory Level Subview
The Inventory Level subview shows the quantity, availability, and status of products at each selected inventory location.

Substitutes Subview
The Substitutes subview shows the quantity, availability, status, and part number of every substitute for a selected product and inventory location.

Inventory Transactions Screen
The Inventory Transactions screen contains views that record the movement of products through inventory.
Inventory Transactions View

The Inventory Transactions view lists all inventory transactions created automatically (in other screens and views) to allocate, ship, receive, transfer, or adjust the quantity and inventory levels for a product. The same transactions can be created manually in this view. Table 96 shows items in inventory transaction records.

Table 96. Button in the All Inventory Transactions View

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commit</td>
<td>Clicking the button records a transaction in the database. Once committed, the record is read-only. Clicking this button performs all of the validations for an inventory transaction. For more information, see “Commit Buttons” on page 360.</td>
</tr>
</tbody>
</table>

Inventory Transactions Across Organizations View

Inventory transactions can take place between organizations by using two transactions and the virtual location named External Location:

- The first transaction is from the source location (Inv1) in one organization to the External Location. This transaction is committed by a user who can see Inv1 and the External Location.
- The second transaction is from the External Location to the destination location (Inv2) in a different organization. This transaction is committed by a user who can see Inv2 and the External Location.

For more information, see “Setting Up External Locations” on page 369.

Assets View

The Assets view shows the asset number of the product associated with the selected transaction. If the part is serialized, the view shows its serial number.

Activities Screen

The Activities screen has a view for recording movement of parts in the field, between two trunks, or between a trunk and a customer site.

Part Tracker View

The Part Tracker view records the movement of parts used to carry out a selected activity. This view records the movements of parts that have an asset or serial number registered in the database on the mobile computer and parts that do not correspond to a registered asset. For more information, see “Part Tracker View” on page 82.
Clicking the Commit button in this view checks that the appropriate information is provided, then creates a record that triggers an inventory transaction when you are connected to the Siebel Server. Once committed, a record becomes read-only.

## Inventory Reports

The Inventory screen provides the reports listed in Table 97.

Table 97. Inventory Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products Below Minimum Level by Location</td>
<td>A list of products of good quality and below the minimum stock level at a selected inventory location.</td>
</tr>
<tr>
<td>Product List by Location</td>
<td>A list of stock levels for products of good quality at a selected inventory location.</td>
</tr>
<tr>
<td>Inventory Cost Detail</td>
<td>A list of all products at a selected inventory location with itemized and total costs.</td>
</tr>
</tbody>
</table>
This chapter describes the shipping and receiving of orders and the records that Field Service creates to track orders. Topics include:

- Shipping Orders on page 375
- Receiving Orders on page 376
- Checks and Validations for Shipping and Receiving on page 377
- Shipping and Receiving Hierarchical Assets on page 378
- Processing and Tracking Shipments on page 378
- Processing and Tracking Receipts on page 379
- Shipping Screen on page 381
- Shipping Reports on page 385
- Receiving Screen on page 385

Shipping Orders

Shipments may be to a customer or to another inventory location belonging to the service business. Internal shipments may be triggered by the replenishment process.

Shipping activities focus on two documents, the pick ticket and the waybill. The pick ticket provides detailed information about the items required to fill orders. The waybill, which records data related to the shipment, normally travels with the shipment and mediates between shipping and receiving.

Shipping begins where fulfillment ends; with the generation of a pick ticket. Figure 26 illustrates the shipping process, which consists of the following steps:

1. Get pick ticket.
2. Pick parts.
3. Update pick ticket with parts shipped.
5. Process shipment.

Figure 26. Shipping Process
Process Shipment Button

The Process Shipment button is located on the Shipping screen’s Pick Ticket form (navigate to the Shipping screen > Shipments view and drill down on the Pick Ticket field). This button produces the following processes:

1. Examines all the records for allocated lines (in the table S_ORDPART_MVMT) for the selected pick ticket, validating the Ship transaction for each allocated line. If one of the validation constraints (for example, Product, Source Inventory Location, Source Availability, or Source Status) fails, the entire transaction is rolled back.

2. For each shipped record against an allocated record, generates an inventory transaction with a type of Ship and another type of De-Allocate. Process Shipment generates inventory transactions (for example, Ship Internal or Ship Other) based on the order type of the pick ticket. For a description of these inventory transactions, see Table 91 on page 356.

3. If the shipped quantity is less than the allocated quantity, then inserts a De-Allocate action for this line item for any extra items and generates an inventory transaction of type De-Allocate. This transaction is in addition to the De-Allocate transaction in Step 2.

4. Checks whether the Auto Receive flag is selected in the Order Fulfillment view. For more information, see “Fulfillment View” on page 344. If this condition is met, generates the receiving line item corresponding to the shipping line items being processed and processes receipt of the order. For more information, see “Process Receipt Button” on page 377.

**NOTE:** Step 2 and Step 3 are independent processes, so they generate separate De-Allocate transactions. This is useful for auditing.

Receiving Orders

Receiving applies to all types of orders:

- Replenishment of internal orders or internal transfers received by a field office, a repair center, or a field service engineer.
- RMAs (returns from a customer).
- Purchase orders and repair orders (receipt from an external vendor).
- For convenience, another receipt type, Unknown, is included to encompass any other items received.

When an item is received, a receipt is generated as proof that the item arrived. Figure 27 illustrates the receiving process, which consists of the following steps:

1. If the order is unidentified, generate unknown receipt. If the order is identified, create a receipt (Internal, Purchase/Repair Order, or RMA).
Generate transactions.

Field Service performs the necessary inventory transactions and creates the necessary line item actions on received orders.

**Checks and Validations for Shipping and Receiving**

Siebel Field Service provides these automatic validations for shipping and receiving transactions:

- Quantity to ship should be less than or equal to the quantity allocated.
- Quantity to receive should be less than or equal to the quantity shipped.
- Total number of assets should be equal to the total quantity of a serialized product.
- While generating inventory transactions, validates the source location of serialized asset.

After an inventory transaction is generated, no update is allowed for the shipped or received line item. However, it is possible to receive partial shipments for all order types except internal orders. New receive actions may be added as long as the quantity of items received does not exceed the quantity in the order.

**Process Receipt Button**

The Process Receipt button is located in the Receive Internal Order, Receive Purchase Order, and Receive RMA views in the Receiving screen. This button generates the following processes within Siebel Field Service:

- Verifies that the asset physically exists at the source inventory location.
Based on an Order Type of Internal/Other, generates the appropriate inventory transactions (for example, Receive Internal, Receive Other, and Receive from TP) affecting inventory levels. Refer to Table 91 on page 356.

If the product received was serialized, checks that the total number of assets received matches the product quantity.

Shipping and Receiving Hierarchical Assets

When you ship or receive a hierarchical asset, changes occur in certain fields of the asset’s parent component according to the type of shipping or receiving transaction that occurs. Whether these effects occur on the fields of the hierarchical asset’s child sub-components depends on whether the fields are set to cascade their values from the parent to the child. For more information about hierarchical assets, see “Hierarchical Assets” on page 469.

Processing and Tracking Shipments

Follow these procedures to process the shipping of orders.

To ship an order
1. Navigate to the Shipping screen > Shipments view.
2. Select a pick ticket record.
3. Drill down on the Pick Ticket field hyperlink.
4. In the Allocated Lines list, select a line item.
5. If the selected line item is a serialized product, add a new record for it in the Serial Numbers list.
6. In the Allocated Lines list, click Ship to ship one or more selected line items, or click Ship All to ship all line items.

This generates a shipped quantity in the Pick Ticket subview that is equal to the allocated quantity for the line items.

7. In the upper Pick Ticket form, click Process Shipment to create inventory transactions for the line items selected in the Allocated Lines list and for the quantities specified in the Shipped Line form.

NOTE: If the Qty field on the Shipped Line form does not contain a value, clicking Process Shipment will not create inventory transactions.

To find a pick ticket for a line item
1. Navigate to the Service Order screen > List view.
2. Drill down on a selected order record.
3. In the Line Items subview, select an order line item record.
4 Click the Actions view tab.
5 In the Actions list, select an Action record and copy the number in the Pick Ticket field.
6 Navigate to the Shipping screen.
7 In the Pick Tickets list, query the pick ticket number.

To consolidate pick tickets
1 Navigate to the Shipping screen > Consolidation view.
2 In the Pick Ticket form, select a pick ticket record.
3 In the Qualified Lines tab, select one or more other pick tickets to add to the consolidation.
4 Click Consolidate.
   Line items move from the Qualified Lines applet to the Consolidated Lines applet.

To fill in waybills for pick tickets
1 Navigate to the Shipping screen > Waybill view.
2 In the Pick Ticket form, select a pick ticket record.
3 In the Waybill form, complete the fields as needed to ship the items in the selected pick ticket.

Pick Tickets and Orders
Pick tickets and orders have the following relationship:
1 Orders have one or many line items.
2 Line Items may have one or many records (actions) in the database.
3 One or many records (of type Allocate) can be associated with one pick ticket.
While Order ID and Order Item ID do not appear in the Pick Tickets view, these values reside in the database:
   S_SHIPMENT_ID and S_ORDER_ITEM_ID in the S_ORDPART_MVMT table
   S_ORDER_ID in the S_ORDER_ITEM table

Processing and Tracking Receipts
Follow these procedures to process the receiving of orders.

To receive an order
1 Navigate to the Receiving screen.
2 Select an order record in the Pending Internal Orders list or in the Pending POs/ROs/RMAs list.
3 Drill down on the Receive Type field hyperlink.
   Either the Receive Internal Order, Receive PO, Receive Repair Order, Receive RMA, or Receive Unknown view appears.
4 In the Line Items list, select a line item record to receive.
5 In the Received Line Item subview, create new records and enter details of the line items received.
6 For serialized line items, in the Serial Numbers subview, create new records and enter details of the line items received.
7 In the Receive Order form, click Process Receipt.
   This generates the appropriate inventory transactions. For more information, see “Process Receipt Button” on page 377.

**To receive repaired items from a third-party vendor**
1 Navigate to the Receiving screen.
2 Select a repair order record in the Pending POs/ROs/RMAs list.
3 Drill down on the Receive Type field hyperlink.
4 In the Line Items list, select a line item record to receive.
5 In the Received Line Item subview, create a record that defines the conditions of receipt for the selected line item.
6 In the Repairs subview, create a repair record for the selected line item.
7 In the Receive Order form, click Process Receipt.
   This records the movement of inventory from the third-party repair vendor to the specified inventory location.

**To review all line items for all orders**
1 Navigate to the Receiving screen.
2 From the visibility filter, select Line Item Receipts.
3 Select a line item record and do one or more of the following:
   - Drill down on the Type field hyperlink.
     The receipt form for the selected order type shows the status of the receipt and the line items received.
   - Drill down on the Order # field hyperlink.
     The receipt form for the selected order number shows details of the original order.
   - Drill down on the Waybill # field hyperlink.
     The receipt form for the selected waybill number shows the shipping waybill for this order.
To add Unknown Receipt records

1. Navigate to the Receiving screen.
2. From the visibility filter, select All Unknown Receipts.
3. In the Unknown Receipts list, select an item.
4. Drill down on the Shipment # field hyperlink.
5. If the order number is unknown, you can select a possible order number in the Match Order # field.
6. If the receipt has line items with serial numbers, do the following:
   a. Select a serialized line item.
   b. In the Received Serial Numbers list, create a new record for the selected line item and enter the serial number.

To review all line items received with incomplete documentation

1. Navigate to the Receiving screen.
2. From the visibility filter, select All Unknown Receipts.
3. In the Unknown Receipts list, select a record and do one or more of the following:
   ■ If a value is present in the Shipment # field, click the hyperlink.
      The Receive Unknown form shows the status of the receipt and the line items received.
   ■ If a value is present in the Match Order # field, click the hyperlink.
      The Order form shows information about this order.
   ■ If a value is present in the Waybill # field, click the hyperlink.
      The Waybill Information form shows the shipping waybill for this order.

Shipping Screen

The Shipping screen provides information for processing shipments.

Shipments View

The Shipments view displays pick ticket records generated for specific orders. Pick tickets are generated automatically, by the Fulfillment and Part Locator Engines, or interactively by using the Generate Pick Tickets command on the Service Order screen. For more information, see the "Generate PickTickets Command" on page 325. The user can also create pick ticket records in this view.
The Pending Pick Ticket views, selected from the visibility filter, display only pick ticket records with a status of Open. The user can create records in this view with any status, but only records of status Open appear on return to this view. Table 98 describes items in the Shipments view.

Table 98. Selected Items in the Shipments View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment #</td>
<td>A type-in field for a shipping number. The default is the pick ticket number.</td>
</tr>
<tr>
<td>Waybill #</td>
<td>A type-in field for a waybill number. This field is linked to the Waybill # field in the Waybill view.</td>
</tr>
</tbody>
</table>

**Pick Ticket Subview**

The Pick Ticket subview records the allocated parts that appear in a pick ticket record and allows the user to generate inventory transactions (see Table 91 on page 356) affecting shipping and allocation of inventory. Table 99 describes a button in the Pick Ticket subview.

Table 99. Selected Item in the Pick Ticket Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Shipment</td>
<td>Button and command. Generates Ship and De-Allocate inventory transactions, when appropriate, for the allocated pick ticket line items (that appear in the Allocated Lines subview). For the mechanism of this button, see &quot;Process Shipment Button&quot; on page 376. After this button is activated, the Pick Ticket Status field in the Pick Tickets view is set automatically to Closed. For more information, see &quot;Shipments View&quot; on page 381. Note that for orders of type Internal, the status becomes Shipped instead of Closed.</td>
</tr>
</tbody>
</table>

**Allocated Lines Subview**

The Allocated Lines subview shows the allocated line items associated with a pick ticket. It also shows the preferred locations in inventory to obtain each line item. This view is read-only. Table 100 describes items in the Allocated Lines subview.

Table 100. Selected Items in the Allocated Lines Subview

<table>
<thead>
<tr>
<th>Item/Ship All</th>
<th>Description</th>
</tr>
</thead>
</table>
Shipped Line Subview
The Shipped Line subview shows the number of items allocated in the database for shipment by the Ship button. For more information, see the "Allocated Lines Subview" on page 382. The Qty field is read-write and accepts values less than the value in the Qty field in the Shipped Lines subview. Table 101 describes items in the Shipped Lines subview.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qty</td>
<td>The number of items (of this product) shipped. This number matches the quantity processed for shipping, displayed in the Shipped Line subview. The Process Shipment button determines this value.</td>
</tr>
<tr>
<td>Location 1/2/3</td>
<td>These fields may be used to optimize the pick-pack-ship process. They are informational only.</td>
</tr>
</tbody>
</table>

Table 101. Selected Items in the Shipped Line Subview

Serial Numbers Subview
The Serial Numbers subview accepts serial numbers for the selected Allocated line items. Serial numbers for items available in inventory are selected from a dialog box. The number of records cannot exceed the quantity in the Shipped Line subview. The quantity in the Shipped Lines subview cannot be greater than the quantity in the Allocated Lines subview.

This view is active only if the Shipped Lines subview displays a number of shipped items. The New command for adding records is available only if the selected, allocated line references a serialized product.

NOTE: If a product is serialized by checking the Serialized check box in the Product Field Service Details view, then a serial number is required for all movements and transactions of assets of this product. For more information, see “Product Service Details View” on page 338.
Repair Pick Ticket Subview
The Repair Pick Ticket subview processes the shipment of line items allocated for a repair order. The Pick Ticket, Allocated Lines, and Shipped Line views are identical to those in the Pick Ticket view. For more information, see "Pick Ticket Subview" on page 382. Instead of associating serial numbers with shipped products, this view uses the Repair # subview to associate repair numbers.

The number of repair numbers records must match the Qty field in the Shipped Lines subview. This validation constraint is enforced both for selected products that are serialized and nonserialized.

Waybill View
The Waybill view associates waybill records with pick tickets. Table 102 describes items in the Waybill view.

Table 102. Selected Items in the Waybill View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment #</td>
<td>A type-in field for a shipping number. The default is the pick ticket number.</td>
</tr>
<tr>
<td>Waybill #</td>
<td>A type-in field for a waybill number. This field is linked to the Waybill # field in the Waybill view.</td>
</tr>
</tbody>
</table>

Consolidation View
The Consolidation view is a variation of the Pick Ticket view, selected from the visibility filter, that combines line items from existing pick tickets into a single pick ticket. The purpose is to reduce shipping costs. The line items must have the same Ship To address, be shipped from the same inventory location, and have the same order type. All order types, except for Repair Orders, are processed in this view.

The Consolidation view has two subviews, Qualified Lines and Consolidated Lines.

Qualified Lines Subview
The Qualified Lines subview displays lines allocated for pick tickets that have the following attributes:

- Open or pending status
- Same Ship To address
- Same source inventory location
- Same order type
Table 103 describes a button in the Qualified Lines subview.

Table 103. Selected Item in the Qualified Lines View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consolidate</td>
<td>Button and command. Copies the qualified line to the selected pick ticket. The result of this consolidation appears in the Consolidated Lines subview. The donor pick ticket no longer appears in the All Pick Tickets view.</td>
</tr>
</tbody>
</table>

**Consolidated Lines Subview**
The Consolidated Lines subview shows the products and quantities combined into one pick ticket. The consolidated lines are processed as though they were part of the original order.

**Shipping Reports**
Shipping provides the Pick Ticket Details (Barcode) report and the Pick Ticket Details (No Barcode) report. These reports describe each pick ticket and its associated products.

**Receiving Screen**
The Receiving screen tracks incoming orders and their line items. These orders originate on the Service Order screen. For information about service orders, see *Siebel Order Management Guide*.

**All Pending Orders View**
The All Pending Orders view, selected from the visibility filter, shows all orders not yet received. The view contains two subviews: Pending Internal Orders and Pending POs/ROs/RMAs.

**NOTE:** All fields in this view are read-only.

**Pending Internal Orders Subview**
The Pending Internal Orders view shows all orders arriving from internal inventory locations. The line items that appear have a Receive Type of Internal and a status of Shipped. The data in this subview originates on the Shipping screen. For more information, see “Shipping Screen” on page 381.

**Pending POs/ROs/RMAs Subview**
The Pending POs/ROs/RMAs view shows all orders arriving from external locations and resulting from purchase orders, repair orders, and return material authorizations of all types.

The line items that appear here are from orders that do not have a Receive Type of Sales Order, Web Order, Service Order, or Internal Order and do not have a status of Cancelled or Closed.
Receive Orders Views

Clicking on any Receive Type value in the All Pending Orders view exposes a corresponding Receive Order view:

- Receive Internal Order
- Receive PO
- Receive Repair Order
- Receive RMA

**NOTE:** The Receive Unknown view is available only from the All Unknown Receipts view. For the procedure, see “To add Unknown Receipt records” on page 381.

The Receive Orders views have a Process Receipt button that carries out validations for the selected receipt and creates the appropriate inventory transaction. For more information, see “Process Receipt Button” on page 377.

Line Items Subview

The Line Items subview lists the items received in the selected receipt. The Qty field shows the number of each line item in the received order. The records are read-only.

Received Line Item Subview

The Received Line Item subview records the inventory level (availability and status) and destination inventory location of received line items. The total quantity cannot exceed the Qty value in the selected Line Items record.

Serial Numbers Subview

The Serial Numbers subview records the serial/asset number for each serialized asset received as part of the selected line item. This view accepts only as many records as the total quantity in the Received Line Item view.

**NOTE:** The Serial Number subview does not verify the uniqueness of serial numbers.

Line Items Receipts View

The Line Items Receipts view, selected from the visibility filter, shows all line items, pending, processed, and closed, for all orders. This view is useful for auditing receipts. For example, a Query by Example (QBE) could return all line items received at a location during a specific time interval. All fields in this view are read-only.
All Unknown Receipts View

The All Unknown Receipts view, selected from the visibility filter, shows received items that arrive with incomplete documentation. Users create this data and an administrator matches records with existing orders. All fields in this view are read-only.

Receive Unknown View

The Receive Unknown view is available only from the All Unknown Receipts view. For the procedure, see “To add Unknown Receipt records” on page 381.

The Match Order # field in this view lets the user choose an order, from the Pick Order dialog box, to which this unknown receipt might belong.
This chapter describes Quality Management, the Quality screen, change requests, and patch requests.

Siebel Quality supports the product development and maintenance life cycle by managing change requests, or CRs. A change request (CR) is a formal report or recommendation aimed at correcting a defect in or adding an improvement to a product. Such products can include hardware, software, manufactured goods, and capital equipment. Siebel Quality can manage multiple types of change requests, including enhancement requests and product defect reports.

Siebel Quality supports the work of the various groups that use the change management process, such as quality assurance, development engineering, and product marketing.

Siebel Quality provides tools for creating, responding to, and tracking CRs. Siebel Quality manages CRs by doing the following:

- Managing CRs from creation through resolution
- Tracking and analyzing details about CRs
- Coordinating and integrating CR management activities across multiple departments
- Displaying status information on product stability

If a customer has an urgent need to resolve a CR and cannot wait for the next product release, Siebel Quality can generate a patch request, or PR. A patch request (PR) is a recommendation to create a maintenance release to implement a product defect fix or improvement.

This chapter includes the following topics:

- Features of Siebel Quality on page 390
- Example Process for Quality on page 391
- Setting Up Roles and Responsibilities on page 399
- Setting Up Lists of Values on page 399
- Mapping Area-Subarea Combinations on page 401
- Adding Release Product Builds on page 402
- Logging Change Requests (QA End User) on page 403
- Assessing Change Requests (Product Marketing End User) on page 405
- Resolving Change Requests (Engineering End User) on page 408
- Verifying Change Request Closures (QA End User) on page 413
- Creating Patch Requests (Release Management End User) on page 414
Features of Siebel Quality

Siebel Quality operates through the Quality screen in your Siebel application. This section summarizes some features of Siebel Quality.

- Create, track, and close the various types of CRs. These features allow an organization to manage a CR from beginning to the end, and also allow different process owners to manage specific phases of the CR life cycle.

- Log, track, and resolve multiple occurrences of a CR. When an issue is found in one product, it sometimes occurs in other, related products. In such cases, end users can create child CRs, or multiple occurrence CRs, from a primary CR and link them together so that they can be managed as a single unit through resolution.

  Siebel Quality also allows end users to designate other types of relationships, such as CRs that are dependent upon each other or are duplicates of each other.

- Analyze and report on product issues. Because reports and charts are run on demand, organizations can gauge the overall health and stability of products in development.

- Track the history of a CR. Siebel Quality displays information about who the CR was assigned to, whether ownership has been reassigned, and whether the product area associated with the CR has been modified.

Quality and Release Manager

Siebel Quality is packaged with Siebel Release Manager, a tool that allows an organization to manage product development through functions such as feature tracking, engineering allocation, test plan management, and test pass management.

Together, Quality and Release Manager support the product life cycle management process from beginning to end. For more information, see Chapter 16, "Release Manager."

Best Practices: Administering and Using Quality

The following section provides some best practices for administering and using the Quality functionality.

- **Assign CRs automatically.** As a productivity aid, you can automate the CR assignment process. Use Siebel Business Process Designer to detect the creation of a new CR and invoke the Siebel Assignment Manager to assign this CR to the appropriate person.

  For information about Siebel Business Process Designer, see *Siebel Business Process Framework: Workflow Guide*. For information about Siebel Assignment Manager, see *Siebel Assignment Manager Administration Guide*.

- **Link multiple occurrences.** When the same issue occurs in different builds, testing environments, or platforms, you can link the CR records as multiple occurrences of each other. When you do this, it is possible to track multiple CRs together and close them together.
Example Process for Quality

This section provides a summary of the Siebel Quality CR life cycle. The stages of the Quality process are described in the following sections, in the order listed.

1. **Set Up and Maintain (Administrator).** See “Process for Setting Up and Maintaining Quality” on page 392.
2. **Log CRs (Quality Assurance).** See “Process for Logging Change Requests” on page 393.
Figure 28 illustrates this overall process for Siebel Quality. Each cross-reference in a box refers to the title of another figure that illustrates its details.

Figure 28. Overall Quality Process

Details of each of these operations are depicted by the descriptions and diagrams in the sections that follow.

**Process for Setting Up and Maintaining Quality**

Before end users can begin working with Quality, the administrator must set it up. The tasks applications administrators perform to set up Quality are listed below. It is recommended that you do them in the order shown.

1. **Set Up Roles and Responsibilities.** Set up roles and responsibilities to allow the employees who will use Siebel Quality to access the Quality screen and its views. See "Setting Up Roles and Responsibilities" on page 399.
2 Set Up Lists of Values. Set up lists of values (LOVs) for the fields in the Quality screen. See “Setting Up Lists of Values” on page 399.

3 Map Area-Subarea Combinations. After field value LOVs are entered, map Area and Subarea field values to one another. Link each Area-Subarea combination to Product Line, Engineering Group, and QA Owner field values. See ”Mapping Area-Subarea Combinations” on page 401.

4 Add Release Product Builds. Add product builds that can be linked to CRs. See “Adding Release Product Builds” on page 402.

These tasks are illustrated in Figure 29. They are part of ongoing maintenance as well as setup.

---

**Process for Logging Change Requests**

After you have set up Siebel Quality, Quality Assurance testers and others can log CRs.

1 Query for Existing CRs. After identifying a product issue, but before logging a new CR, the CR creator queries to see whether a duplicate issue already exists. See “Querying for Existing Change Requests” on page 403.

   - **Update Existing CR Comments.** If the search reveals an existing CR for the issue, the CR creator enters a comment with relevant information that may not already be recorded.

   - **Log New CR.** If the CR creator cannot find an existing issue, she then creates a new CR. See “Logging Change Requests” on page 403 and “Generating Change Requests from Service Requests” on page 404.

2 Add Attachment. Optionally, the CR creator can add attachments such as screen captures and configuration files to clarify the issue. See “The new CR appears in the Quality screen’s Customer Change Requests view.” on page 405.
These tasks are illustrated in Figure 30.

Figure 30. Quality Assurance Logging Process

**Process for Assessing Change Requests**

After CRs are entered in the system, product marketing managers assess the CRs to determine how important they are and who should resolve the issues.

1. **Query for Unassigned CRs.** The product manager queries for new CRs in his area of responsibility. See "Querying for Unassigned Change Requests" on page 406.
   - **Close CR.** If the product manager decides the CR is not a real issue, he closes it. See "Closing Unassigned Change Requests" on page 406.
   - **Reassign CR.** If the product manager decides that the CR is a real issue, he determines whether it can be resolved by his team. If he finds that the CR's functional area was incorrectly set, he assigns it to a new owner. See "Reassigning Change Requests" on page 406.
   - **Close CR.** The product manager investigates whether the CR is a duplicate of an existing issue. If it is, he closes the new CR as a duplicate. See "Closing Unassigned Change Requests" on page 406.

2. **Prioritize and Assign CR.** If the product manager determines that the CR represents a real issue in his area of responsibility and is not a duplicate of another CR, he prioritizes the CR and assigns it to an engineering manager. See "Prioritizing and Assigning Change Requests" on page 407.
These tasks are illustrated in Figure 31.

![Diagram of Change Request Resolution Process](image)

**Figure 31. Product Marketing Assessment Process**

## Process for Resolving Change Requests

After Product Management has assigned CRs to Engineering, Engineering can proceed to resolve the CRs.

1. **Assign CRs (Manager).** The engineering team manager to whom the product manager assigned the CR, in turn assigns it to an engineer on her team. See "Assigning Change Request to Engineers (Manager)" on page 408.

2. **Query for My CRs.** The engineer performs a query to find CRs assigned to him.

3. **Reproduce the Issue.** Upon receiving a newly assigned CR, the engineer tries to reproduce the issue in the CR.

4. **Close CR.** At this point, the engineer may close the CR for the following reasons:
   - The engineer cannot reproduce the issue.
The engineer can reproduce the issue, but it is not an issue with your company’s current product.

See “Closing Resolved Change Requests” on page 411.

5 **Create Multiple Occurrence CR.** If the engineer determines that the CR contains a real issue with your company’s current product, he checks whether the same issue occurs in multiple versions of the same product. If it does, he creates a multiple occurrence CR for each product variant or version that has the same issue. See “Creating Multiple Occurrence Change Requests” on page 408.

6 **Break Multiple Occurrence Link.** If subsequent investigation shows that the issue does not occur in one of the other product versions, or occurs differently, the engineer breaks the multiple occurrence link. See “Breaking Multiple Occurrence Links” on page 409.

7 **Define Relationship.** If the CR is not a multiple occurrence, the engineer tries to determine whether it is related to other CRs in some other way. For example, correcting the issue in one CR might depend on first correcting the issue in another. If this is the case, he determines the relationship. See “Linking Related Change Requests” on page 410.

8 **Fix Issue.** The engineer then applies the appropriate fix and closes the CR. See “Closing Resolved Change Requests” on page 411.
These tasks are illustrated in Figure 32.

Process for Verifying Change Request Closures

After engineers resolve CRs, the CR creator attempts to verify the resolutions.

1 **Query for Closed CRs.** The creator queries for CRs that she has logged that are now closed. See “Querying for Closed Change Requests” on page 413.

2 **Verify Resolution.** The creator tries to verify the resolution.
   - **Reopen CR.** If she determines that the issue is not resolved, she reopens the CR. This sends the CR back to engineering for further review. See “Reopening Change Requests” on page 413.
Close CR as Verified. If she determines that the CR is correctly resolved as stated, she closes the CR as verified. See “Closing Change Requests as Verified” on page 413.

At this point, the CR life cycle is complete.

These tasks are illustrated in Figure 33.

Figure 33. Quality Assurance Verification Process

Process for Creating Patch Requests

After CRs have been closed as verified, the Release Management group may determine that a particular CR fix needs to go to a customer immediately rather than in the next release of the product.

1 Find Verified CRs with Urgent Customer Need for Fix. A member of the Release Management group identifies a closed and verified CR that represents a fix for which a customer cannot wait until the next scheduled release.

2 Generate PR from CR. A release manager generates a PR from a CR. See “Generating Patch Requests from Change Requests” on page 414.

3 Enter Approvals. The release manager obtains the approvals necessary for shipping the patch and records the approvals in the PR record. See “Approving and Shipping Patch Requests” on page 414.

4 Retest. If all approvers do not agree that the patch is ready to ship, the patch is sent back for further development, testing, and another approval cycle.

5 Ship Maintenance Release. After all approvals are gathered for the PR, the maintenance release is ready to go to the customer. See “Approving and Shipping Patch Requests” on page 414.
These tasks are illustrated in Figure 34.

Figure 34. Release Management PR Process

**Setting Up Roles and Responsibilities**

You are typically responsible for setting up access to your Siebel application’s screens and views by assigning roles and responsibilities. This includes access to the Quality screen and its associated views.

For information about setting up roles and responsibilities and associating screens and views with them, see *Siebel Security Guide*.

**Setting Up Lists of Values**

You are typically responsible for setting up lists of values (LOVs) for use in Siebel Business Applications. This includes LOVs that are specific to Siebel Quality. For information about setting up LOVs, see *Siebel Applications Administration Guide*.
Table 104 lists the LOVs to be set up before using Siebel Quality.

Table 104. Quality LOVs

<table>
<thead>
<tr>
<th>Field</th>
<th>Type Value for LOV Items</th>
<th>Description</th>
<th>Example LOV Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>PROD_DEFECT_AREA</td>
<td>Functional product area</td>
<td>Accounts</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Orders</td>
</tr>
<tr>
<td>Browser</td>
<td>PSTASK_CLIENT_BROWSER</td>
<td>Type of Web browser running in the test environment</td>
<td>IE 5.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NS 6.2</td>
</tr>
<tr>
<td>Client OS</td>
<td>PSTASK_CLIENT_OS</td>
<td>Type of operating system running on the client computer</td>
<td>Win 2000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Mac OS</td>
</tr>
<tr>
<td>Database</td>
<td>PSTASK_CLIENT_DB</td>
<td>Type of database running in the test environment</td>
<td>IBM DB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MS SQL Svr 7.0</td>
</tr>
<tr>
<td>Priority</td>
<td>PROD_DEFECT_PRIORITY</td>
<td>Relative importance of the issue</td>
<td>P1-Critical</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>P3-Medium</td>
</tr>
<tr>
<td>Server OS</td>
<td>PSTASK_SERVER_OS</td>
<td>Type of operating system running on the server</td>
<td>HP-UX 11i</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Solaris 8</td>
</tr>
<tr>
<td>Severity</td>
<td>PROD_DEFECT_SEVERITY</td>
<td>How severe the issue</td>
<td>3-Wrong</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Behavior</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4-Minor Error</td>
</tr>
<tr>
<td>Special Tag</td>
<td>PD_SPEC_TAG</td>
<td>Statuses or actions that are not identified by the other fields, for reporting, querying, exporting, or localization purposes</td>
<td>BETA3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HIGH RISK</td>
</tr>
<tr>
<td>Status</td>
<td>PROD_DEFECT_SUB_STATUS</td>
<td>Implementation or development stage</td>
<td>Open-Disagree</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Closed-Verified</td>
</tr>
<tr>
<td>Subarea</td>
<td>PROD_DEFECT_SUB_AREA</td>
<td>Functional product area subdivision</td>
<td>Expenses</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fulfillment</td>
</tr>
<tr>
<td>Substatus</td>
<td>PROD_DEFECT_SUB_STATUS</td>
<td>Implementation or development substage</td>
<td>Unassigned</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Approved</td>
</tr>
<tr>
<td>Type</td>
<td>PROD_DEFECT_TYPE</td>
<td>Type or classification for the CR</td>
<td>Product Defect</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Enhancement</td>
</tr>
<tr>
<td>Web Server OS</td>
<td>PSTASK_SERVER_OS</td>
<td>Type of operating system running on the Web server</td>
<td>AIX 4.3.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Win NT 4.0</td>
</tr>
</tbody>
</table>
Mapping Area-Subarea Combinations

When an end user navigates to the Quality screen and selects any combination of Area and Subarea field values, the Product Line, Engineering Group, and QA Owner fields are automatically populated. You activate this process by setting up mappings for Area and Subarea combinations. After defining the lists of values, or LOVs, for Area and Subarea, you define each Area-Subarea combination. Then you designate the Product Line, Engineering Group, and QA Owner field values for each Area-Subarea combination.

As product parameters change in the course of development, you may need to map new Area-Subarea combinations.

To add an Area-Subarea combination

1. Navigate to the Quality screen > Quality Administration view.
2. Create a new record for each Area-Subarea combination.

   For example, if you want a selection of Inventory in the Area field to constrain the choices in the Subarea field to Shipping, Receiving, and Cycle Counting, then create three records with the Area and Subarea fields completed as shown in the following table.

<table>
<thead>
<tr>
<th>Area</th>
<th>Subarea</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory</td>
<td>Shipping</td>
</tr>
<tr>
<td>Inventory</td>
<td>Receiving</td>
</tr>
<tr>
<td>Inventory</td>
<td>Cycle Counting</td>
</tr>
</tbody>
</table>

3. Complete the other fields.
   These fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering Group</td>
<td>Engineering team with which this Area-Subarea combination is associated.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Grouping of products with which this Area-Subarea combination is associated.</td>
</tr>
<tr>
<td>QA Owner</td>
<td>Quality Assurance team owner with which this Area-Subarea combination is associated.</td>
</tr>
</tbody>
</table>

When these mappings are set up, the pick list values available in the Subarea field on the Quality screen’s views change dynamically according to the value an end user selects in the Area field. When the end user then selects a value in the Subarea field, the system automatically populates the Product Line, Engineering Group, and QA Owner fields.
Adding Release Product Builds

You control product version information for the organization by setting up release product builds. Because every Release Manager and Quality record must be associated with a specific release product build, you must set these up before end users enter any records.

As a product progresses through the release cycle, increasingly advanced product prototypes are created. (In the case of software development, these prototypes are known as builds.) As each new prototype becomes available, you are responsible for entering it into Quality. This allows end users of Quality and Release Manager to record each record against the appropriate build.

There are two types of releases:

- **Future Releases.** Though only one active release may be in progress, you must set up records for future releases as well. That way, if a feature or fix is deferred from the current release, an end user can target it to a specific future release.

- **Unspecified Releases.** Sometimes the appropriate future release for a given feature or fix may be unknown. For this contingency, you must set up at least one artificial release called Unspecified Release or some similar term. Orphan items can be linked to this release. When the appropriate future release has been determined, an item can then be retargeted to that release.

To add a release product build

1. Navigate to the Quality screen > Release Product Administration view.

2. In the Release Product Administration list, create a new record for a build and complete the fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build</td>
<td>Number or code that identifies this build.</td>
</tr>
<tr>
<td>End Date</td>
<td>To cause this build to disappear from the Build and Target fields of the Change Requests view after a certain time, enter a date after which it should not appear.</td>
</tr>
<tr>
<td>Language</td>
<td>Three-letter language code.</td>
</tr>
<tr>
<td>Product</td>
<td>Product of which this build is a prototype.</td>
</tr>
<tr>
<td>Target Version</td>
<td>Select to make this build available as a choice in the Target field of the Change Requests view.</td>
</tr>
<tr>
<td>Version</td>
<td>Version number of the product.</td>
</tr>
</tbody>
</table>

When you create a record in the Release Product Administration screen, the information in the Build, Language, Product, and Version fields becomes available to end users in the Build field in the Release screen’s QA Tests view and Quality screen’s Change Requests view. If you selected the Target Version check box, this information also becomes available in the Target field in the Quality screen’s Change Requests view.
Logging Change Requests (QA End User)

Anyone can log a CR. The Quality Assurance organization, however, creates the vast majority of CRs. Quality Assurance discovers most product issues during testing. When a QA tester discovers a product issue, she creates a new CR.

To add CR records and fill them out with necessary information, follow the procedures in this section.

Querying for Existing Change Requests

Before logging a new CR, a CR creator should query to see whether a duplicate issue is already recorded in an existing CR. She can do this by searching on various combinations of key words used to describe the problem.

To query for existing change requests
1. Navigate to the Quality screen.
2. In the Change Request form, initiate a query.
3. In the Summary field, enter a phrase that might describe the issue in other CRs.
   For example, if you find a problem with attaching documents to a record, you might query on phrases such as the following:
   - Attachment not working
   - Attachment function broken
4. Run the query.
5. If the query reveals that a CR record already exists for the issue, in the My Change Requests list, drill down on the CR # field hyperlink.
6. In the More Info form, update the Comments field with relevant information that is not already recorded.

Logging Change Requests

If the CR creator cannot find an existing CR that describes the issue, then the creator enters a new CR. The CR creator must enter all relevant details including the functional area in which the problem was found, the environment (operating system, server type, and so on) where the problem occurred, and the precise steps for reproducing the issue.

Most of this information is entered in the left side of the Change Requests form, labeled Change Request Description.

To log a change request
1. Navigate to the Quality screen.
2. Create a new CR record.
3. In the My Change Requests list, drill down on the CR # field hyperlink.
In the More Info form, enter values for the fields, as needed. Some fields are listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Functional product area to which the CR pertains.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter a comment describing what was done with this CR, and any additional information that may be needed by other users to understand, track, or resolve the issue.</td>
</tr>
<tr>
<td>Description/How to Reproduce</td>
<td>Detailed description of the issue. If the CR describes a product defect, write complete step-by-step directions for reproducing the issue.</td>
</tr>
<tr>
<td>Build</td>
<td>Product build in which the issue occurs.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Product line affected by the CR. Automatically filled in when the Subarea value is set.</td>
</tr>
<tr>
<td>QA Owner</td>
<td>Quality Assurance team owner of the CR. Automatically filled in when the Subarea value is set.</td>
</tr>
<tr>
<td>Severity</td>
<td>Creator’s assessment of the seriousness of the issue.</td>
</tr>
<tr>
<td>Special Tag</td>
<td>Allows you to select statuses or actions that are not identified by the other fields. Special tags may be used for purposes such as reporting, tracking, querying, exporting, and localization. You can select one or more values.</td>
</tr>
<tr>
<td>Subarea</td>
<td>Functional product area subdivision is related to the Area you selected. When you make a selection in this field, the Product Line, QA Owner, and Engineering Group fields are populated automatically.</td>
</tr>
<tr>
<td>Summary</td>
<td>Brief description of the CR. Should be concise enough so a reader can immediately understand the overall issue.</td>
</tr>
<tr>
<td>Tag Summary</td>
<td>Displays all the tags selected in the Special Tag field.</td>
</tr>
<tr>
<td>Type</td>
<td>CR type. Accept the default Product Defect, or select another value to identify the CR as an enhancement request, a user interface issue, and so on.</td>
</tr>
</tbody>
</table>

**Generating Change Requests from Service Requests**

Occasionally, a CR originates from a customer by way of a service request. If the technical support person who receives the customer’s service request decides that it represents a product issue, she can log a CR for the service request.

For more information about service requests, see Chapter 3, “Service Support.”

**To log a change request for a service request**

2. Select a service request record.
3 In the My Service Requests - HelpDesk list, drill down on the SR # field hyperlink.
4 Click the Change Requests view tab
5 In the Change Requests list, add a new CR record.

**NOTE:** As well as adding existing records in the Change Request list, the user can also create a new record. To do this the required fields will first have to be added to the list applet. Click Menu and choose Columns Displayed. In the Columns Displayed dialogue box, move the required fields from the Available Columns list to the Selected Columns list and click Save.

Additional required fields are listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Functional product area to which the CR pertains.</td>
</tr>
<tr>
<td>Subarea</td>
<td>Functional product area subdivision is related to the Area you selected.</td>
</tr>
<tr>
<td></td>
<td>When you make a selection in this field, the Product Line, QA Owner, and</td>
</tr>
<tr>
<td></td>
<td>Engineering Group fields are populated automatically.</td>
</tr>
<tr>
<td>Severity</td>
<td>Creator’s assessment of the seriousness of the issue.</td>
</tr>
<tr>
<td>Special Tag</td>
<td>Allows you to select statuses or actions that are not identified by the other</td>
</tr>
<tr>
<td></td>
<td>fields. Special tags may be used for purposes such as reporting, tracking,</td>
</tr>
<tr>
<td></td>
<td>querying, exporting, and localization. You can select one or more values.</td>
</tr>
<tr>
<td>Status</td>
<td>Brief description of the CR.</td>
</tr>
<tr>
<td>Substatus</td>
<td>Value which describes the state of the CR.</td>
</tr>
<tr>
<td>Database</td>
<td>Type of database running in the environment.</td>
</tr>
</tbody>
</table>

6 Complete the fields, as needed, from the information in the service request.

For a description of CR fields, see **Table 105 on page 412**.

7 In the Change Requests list, drill down on the CR # field hyperlink.

8 On the More Info form, in the Comments field, note that this CR originated from a service request, and add any additional information that may be relevant.

The new CR appears in the Quality screen’s Customer Change Requests view.

## Assessing Change Requests (Product Marketing End User)

After CRs have been logged, the Product Marketing team assesses the new CRs in its functional areas.

Product managers assess and assign CRs. A product manager reviews each new CR logged in the assigned area of responsibility. If the product manager determines that an issue is a real one, then the product manager defines the priority and assigns the CR to the appropriate engineering manager.
**Quality ▶ Assessing Change Requests (Product Marketing End User)**

**Querying for Unassigned Change Requests**
The product manager queries for unassigned CRs in his functional area.

**To query for unassigned change requests**
1. Navigate to the Quality screen.
2. Create a query with the appropriate field values. Some values you can use in the query are listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>(your product area)</td>
</tr>
<tr>
<td>Owner</td>
<td>IS NULL</td>
</tr>
<tr>
<td>Priority</td>
<td>IS NULL</td>
</tr>
<tr>
<td>Status</td>
<td>Open</td>
</tr>
<tr>
<td>Subarea</td>
<td>(your product subarea)</td>
</tr>
<tr>
<td>Substatus</td>
<td>Open</td>
</tr>
</tbody>
</table>

3. Run the query.

**Reassigning Change Requests**
If the product manager decides that the CR describes a real issue, he first confirms that the CR is in his functional area. If he determines that the CR's functional area was incorrectly set, he reassigns the CR to the appropriate area.

**To reassign a change request**
1. Navigate to the Quality screen.
2. Select a CR record.
3. In the Change Request form, change the values in the Area and Subarea fields, as needed.
4. In the My Change Requests list, drill down on the CR # field hyperlink.
5. In the More Info form, in the Comments field, add a brief explanation of why you reassigned the CR.

**Closing Unassigned Change Requests**
If the product manager decides the CR is not a real issue, he closes it with various possible reasons. For example, he may determine that the issue is not a product defect, or he may decide to decline an enhancement request.
**To close an unassigned change request**

1. Navigate to the Quality screen.
2. Select a CR record.
3. In the Change Request form, in the Status field, select Closed.
4. In the Substatus field, do one of the following:
   - If the CR does not reflect a real issue in the current product, select a value such as Not a Bug or No Longer Applicable.
   - If the CR is an enhancement request and you decide that the request cannot be accommodated, select Enhancement Declined.
   - If the CR is a duplicate of an existing issue, select Dup-Double Entry. Enter the existing issue's CR number in the Primary Occurrence field.
5. In the My Change Requests list, drill down on the CR # field hyperlink.
6. In the More Info form, in the Comments field, add a note explaining the reason for closing the CR.

**Prioritizing and Assigning Change Requests**

If the assessment of a CR is complete and the product manager determines this is a new issue that needs to be resolved, he assigns a priority, a target release, and an owner to the CR. The product manager usually assigns the CR to the engineering manager who is in charge of the product area where the issue occurs.

The product manager enters priority and assignment information on the right side of the Change Requests form, labeled Resolution.

**To prioritize and assign a change request**

1. Navigate to the Quality screen.
2. Select a CR record.
3. In the My Change Requests list, drill down on the CR # field hyperlink.
4. In the More Info form, in the Comments field, add a comment summarizing why you prioritized and assigned this CR as you did.
5. Complete the other fields as needed. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering Group</td>
<td>Displays the group responsible for delivering the fix. Automatically filled in when the Subarea value is set.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select the engineering manager responsible for resolving the issue reported in the CR.</td>
</tr>
<tr>
<td>Priority</td>
<td>How urgent it is to resolve the issue compared to other issues at hand. Does not have to be the same as the value in the Severity field.</td>
</tr>
</tbody>
</table>
Resolving Change Requests (Engineering End User)

The engineering manager who owns an open CR assigns the CR to an engineer on her team. The engineer first tries to re-create the issue by following the description entered by the CR creator. He debugs the issue and isolates its cause. He then makes the appropriate fix, updates the CR with all relevant details, and closes the CR.

Assigning Change Request to Engineers (Manager)
After the product manager assigns the CR to an engineering manager, the engineering manager assigns the CR to an engineer who has the right expertise to resolve the issue.

To assign a change request to an engineer
1. Navigate to the Quality screen.
2. Select a CR record.
3. In the My Change Requests list, in the Owner field, select the engineer you want to assign to resolve the issue.
4. Drill down on the CR # field hyperlink.
5. On the More Info form, in the Comments field, enter any comment or explanation that might be necessary for the engineer to understand the issue.

Creating Multiple Occurrence Change Requests
In the course of resolving a CR, an engineer might find the same problem in another testing environment, another language version, or another product release version. For this situation, your Siebel application allows end users to create parent-child relationships between CRs. With this functionality, end users can create multiple occurrence CRs and link them to a parent CR.

CRs are multiple occurrences when they have the same functional description but are logged against more than one critical factor such as environment, language, or product. Alternatively, multiple occurrence CRs can describe different symptoms that originate from the same problem and require the same resolution. Multiple occurrence CRs must have the same owner, and the files or other components to be fixed must be the same.
The ability to create multiple occurrence CRs allows end users to manage related issues from one source, eliminate double-counting of product issues, and track the linked CRs together.

To create a new multiple occurrence CR (child) for an existing primary occurrence CR (parent), use the following procedure.

**To create a multiple occurrence change request**

1. Navigate to the Quality screen.
2. In the My Change Requests list, select a CR record that will be the parent to multiple occurrences.
3. In the Change Request form, click Menu and choose Create Multiple Occurrence.
   
   The system creates a copy of the original record with a new CR number. The number of the original CR (the parent) appears in the Primary Occurrence field.
4. In the new CR record, change the field values for information that is different from the original CR. Some fields in the Change Requests view are listed in Table 105 on page 412.
5. In the My Change Requests list, drill down on the CR # field hyperlink.
6. In the More Info form, in the Comments field, record the action you have taken and note any additional information that may be relevant.

   The parent and child CRs are linked and the new CR becomes a multiple occurrence CR.

**Breaking Multiple Occurrence Links**

In some cases, links between multiple occurrence CRs need to be removed. For example, further investigation may reveal that multiple occurrence CRs are not related to each other.

You can break a multiple occurrence link either from a parent CR or from a child CR. To break Multiple Occurrence links, use the following procedures.

**To break a multiple occurrence link from the parent change request**

1. Navigate to the Quality screen.
2. In the My Change Requests list, select a CR record for a parent multiple occurrence CR.
3. Drill down on the CR # field hyperlink.
4. Click the Related CRs view tab.
   
   The Related CRs list displays the CRs with child relationships to the selected primary CR.
5. In the Related CRs list, select the multiple occurrence CR you want to remove.
   
   **NOTE:** Child multiple occurrence CRs are identified by a value of Multiple Occurrence in the Relationship Type field.
6. In the Related CRs list, click Menu and select Delete Relationship.
7. In the confirmation window, click OK.

   The CR is removed from the Related CRs list.
To break a multiple occurrence link from the child change request
1. Navigate to the Quality screen.
2. In the My Change Requests list, select a CR record for a child multiple occurrence CR.
3. Delete the value in the Primary Occurrence field. (The value in this field is the parent CR.)
4. Drill down on the CR # field hyperlink.
5. On the More Info form, in the Comments field, record the action you have taken and note any additional information that may be relevant.
6. Click Menu.
   If the link was broken successfully, the Go To Primary Occurrence option is unavailable.

Linking Related Change Requests
In addition to multiple occurrence, Siebel Quality uses several other designations to define the relationships that can occur among CRs. Related CRs are useful when investigating a solution for a CR that may be similar to others.

- **Duplicate (Dup-Double Entry).** The same CR entered more than once. Not only is the functional description the same, but other critical factors such as environment, language, or product are also the same.
- **Dependent Upon.** A CR that cannot be resolved until it receives a fix from another CR.
- **Miscellaneous (Misc).** An arbitrary relationship between CRs. Allows you to track multiple CRs together, though they may not be dependent on one another or match one another.

This section contains procedures for creating and managing the related CRs. To create a relationship between two existing CRs, use the following procedures.

To link a related change request from a parent change request
1. Navigate to the Quality screen.
2. In the My Change Requests list, select the primary CR to which you want to relate another CR.
3. Drill down on the CR # field hyperlink.
4. Click the Related CRs view tab.
5. In the Related CRs list, create a new record.
6. In the Add Change Request dialog box, select the CR you want to relate to the primary CR as a child and click OK.
7. In the Relationship Type field, select the type of relationship the related CR has to the parent CR.
8. In the Comments field, record the action you have taken and note any additional information that may be relevant.
To link a related change request from a child change request

1. Navigate to the Quality screen.
2. In the My Change Requests list, select the CR record you want to link to another CR record as a child.
   
   **NOTE:** The child CR cannot have any related child CRs of its own. To verify this drill down on the CR # field hyperlink, and check the Related CRs view tab.
3. In the Primary Occurrence field, select the CR number of the parent CR.
4. Drill down on the CR # field hyperlink.
5. On the More Info form, in the Comments field, record the action you have taken and note any additional information that may be relevant.
6. Click Menu and choose Go to Primary Occurrence.
   
   The Change Request form displays the CR record you just designated as the parent (primary occurrence).
7. Click the Related CRs view tab.
8. In the Related CRs list, select the child CR record you just linked to the parent as related.
9. In the Relationship Type field, select the type of relationship the child CR record has to the parent CR record.

Closing Resolved Change Requests

Upon receiving a newly assigned CR, the engineer tries to reproduce the issue. At this point, the CR may be closed for several reasons, such as the issue being with a third-party product, no longer applicable to the current release, or the engineer being unable to reproduce it.

If the engineer determines that the CR is a real issue, he investigates further, makes the appropriate fix, and tests the fix. When the fix is complete, he closes the CR and enters relevant information about the fix.

When closing a primary occurrence CR, an engineer can close a parent CR and all its child CRs at once, close the parent CR only, or close a child CR independently of its parent.

When closing a CR, the engineer enters information in the right side of the Change Requests form, labeled Resolution. Use the following procedures to close CRs that have been fixed or otherwise resolved.

To close a resolved change request

1. Navigate to the Quality screen.
2. In the My Change Requests list, select a CR record that you want to close as fixed.
3. In the Change Request form, set the Status field to Closed.
4. Set the Substatus field to the appropriate value.
5. In the My Change Requests list, drill down on the CR # field hyperlink.
6 On the More Info form, in the Comments field, add a comment explaining the resolution. Complete the other fields as needed. Some fields in the Change Requests view are listed in Table 105.

Table 105. Fields in the Change Requests View

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approvals</td>
<td>Allows the employees involved in processing the CR to mark and track approvals for the stages of the fix.</td>
</tr>
<tr>
<td>Files Fixed</td>
<td>Filename and archiving system location of each electronic file modified for the fix. Becomes a required field when the Substatus or Integration Status changes to Fixed.</td>
</tr>
<tr>
<td>Fixed Build</td>
<td>Product version where the resolution is implemented.</td>
</tr>
<tr>
<td>Integration Fixed Build</td>
<td>Integration branch build number in which the fix was made.</td>
</tr>
<tr>
<td>Integration Fixed Date</td>
<td>Date when the fix was made in the integration branch.</td>
</tr>
<tr>
<td>Integration Status</td>
<td>Status of the CR on the integration branch. When the Integration Status field is set to Closed, the Integration Fixed Date field is automatically populated and the Integration Fixed Build field becomes required.</td>
</tr>
<tr>
<td>Special Tag</td>
<td>Allows you to select statuses or actions that are not identified by the other fields. Special tags may be used for purposes such as reporting, tracking, querying, exporting, and localization. You can select one or more values.</td>
</tr>
<tr>
<td>Substatus</td>
<td>Reason for closing the CR. Some values are as follows:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>FOL.</strong> Fact of Life. Because of a limitation such as dependency on a third-party product, your company’s development team has no control over the issue.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>No Longer Applicable.</strong> The issue applies to an older or different version of the product, but not to the current version or the version under development.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Not Reproducible.</strong> The issue cannot be reproduced as described. (In cases where the CR issue cannot be reproduced, it is recommended that before closing the CR, you contact the CR creator directly to obtain clarification.)</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Fixed.</strong> The issue has been corrected.</td>
</tr>
<tr>
<td>Tag Summary</td>
<td>Displays all the tags selected in the Special Tag field.</td>
</tr>
</tbody>
</table>

To close a resolved parent multiple occurrence change request

1 Follow the steps of “To close a resolved change request” on page 411 for a parent CR. When you save the record, a message box appears.

2 Do one of the following:
Verifying Change Request Closures (QA End User)

After the engineer resolves a CR, the QA tester or other CR creator who reported the issue verifies that the resolution is correct.

Querying for Closed Change Requests
The CR creator queries for closed CRs in her functional area.

To query for closed change requests
1. Navigate to the Quality screen.
2. In the My Change Request form, create a query with Status = Closed.
3. Run the query.

Reopening Change Requests
The CR creator tries to verify the resolution on the version identified by the engineer. If she determines that the issue is not resolved, she reopens the CR, which sends it back to the engineer for further review.

To reopen a change request
1. Navigate to the Quality screen.
2. Select a CR record.
3. In the Change Request form, in the Status field, select Open-Disagree.
4. In the My Change Requests list, drill down on the CR # field hyperlink.
5. On the More Info form, in the Comments field, enter an explanation of why you disagree with the resolution.

Closing Change Requests as Verified
If the creator determines that the CR is correctly resolved, she closes out the CR as verified. At this point, the CR life cycle is complete.
To close a change request as Verified

1. Navigate to the Quality screen.
2. Select a CR record.
3. In the Change Request form, in the Status field, select Closed-Verified.
4. In the My Change Requests list, drill down on the CR # field hyperlink.
5. On the More Info form, in the Comments field, enter a note that you agree with the resolution.

Creating Patch Requests (Release Management End User)

The release management team, which may consist of representatives from the major functional groups, tracks the overall health of the product release. They monitor product status and stability. They monitor the development effort’s progress through Siebel Quality’s reports and charts. They then provide the final recommendations for shipment of the product.

The release management group also manages patch requests (PRs). A patch request (PR) is a resolved product issue whose fix must be delivered to a customer prior to the next scheduled release, through a maintenance release. The release management group makes sure that critical issues for which customers need fixes immediately get resolved as maintenance releases.

Generating Patch Requests from Change Requests

A member of the release management team generates a PR from a CR. The PR then forms the basis of a maintenance release. To generate a PR, use the procedure that follows.

To generate a patch request from a change request

1. Navigate to the Quality screen.
2. In the My Change Requests list, select the closed and verified CR record from which you want to generate a PR.
3. In the Change Requests form, click the view menu button and choose Copy To Patch.
   The Patch Requests view appears with the new PR record generated from the CR. Most fields are filled in from the CR.
4. In the Account field, select the customer that is to receive the patch.
5. In the Date Required field, enter the date on which the PR fix must be delivered to the customer.

Approving and Shipping Patch Requests

A PR is approved for shipping as a maintenance release in the Patch Requests view, which is used by the release management team. The main groups involved in product development must approve a patch before it can be delivered to a customer.

To record approvals and clear a patch for shipping, use the procedure that follows.
To approve and ship a patch request

1. Navigate to the Quality screen > Patch Request List view.
2. Find the patch record you want to ship.
3. In the All Patch Requests list, drill down on the Patch Request # field hyperlink.
4. As you receive approvals for the patch to be shipped, complete the Technical Services, Product Marketing, Engineering, and QA fields.
5. When all teams have approved the PR, in the Patch Status field, select Approved to Ship.
6. When the patch is shipped, in the Patch Status field, select Closed-Shipped.
15 Cycle Counting and Replenishment

This chapter presents the features of Siebel Field Service for maintaining inventory: cycle counting and replenishment. These functions are part of the Logistics Management module. Topics include:

- Cycle Counting on page 417
- Setting Up Cycle Counting on page 423
- Running the Cycle Counting Engine on page 426
- Replenishment Engine on page 427
- Setting Up Replenishment on page 432
- Replenishing Inventory on page 432
- Administration - Service Screen on page 433
- Products Screen on page 434
- Inventory Screen on page 435
- Cycle Counts Screen on page 439
- Cycle Counting Report on page 440

Cycle Counting

Cycle counting is a method of counting inventory by grouping products into classes and counting the products in each class at designated intervals over a period of time. Only part of the products are counted at one time, but over the designated time period all products are counted. Products of class A, for instance, might be counted once every three months, products of class B once every six months, and products of class C once a year.

Since assets are moving in and out of inventory, cycle counting creates a dynamic, statistical view of inventory. To enhance statistical accuracy, cycle counting uses two methods of product classification (the cycle count basis): ABC and XYZ.

- The ABC cycle count basis ranks products according to their financial value. The Cycle Counting Engine counts the items with a larger dollar value more often than those with a lower value.
- The XYZ cycle count basis ranks products according to their turnover. Higher-turnover products are counted more often, resulting in a higher accuracy of counting.
Cycle counting is configured for inventory location types, inventory locations, and products.

**NOTE:** If a configuration parameter for cycle counting can be set at different levels, the parameter for the more specific level takes precedence. For example, the cycle count basis (ABC or XYZ, meaning cycle counting based on the value of items versus their turnover rate) for an inventory location takes precedence over that for an inventory type. The cycle count class, A, B, or C; X, Y, or Z (meaning that it has high, medium, or low relative value or turnover rate), for an inventory type takes precedence over that for a product.

The Cycle Counting Engine requires this input:
- One or more inventory locations
- A start date for creating inventory lists for cycle counting
- An end date for creating inventory lists for cycle counting

Whenever the Cycle Counting Engine runs, it produces the following output:
- Cycle counting periods, which define the calendar dates covered by a cycle count.
- Cycle counting records (headers).
- Part lists for each cycle counting record. The part list provides instructions for the next physical count of inventory.

The Cycle Counts screen, Part List view accepts manual input of the count data. The Cycle Counting Engine compares this to the inventory records in its database, and, if there is a variance, allows for an adjustment of inventory.

**Figure 35 on page 419** illustrates the decision path that the Cycle Counting Engine uses to generate a parts lists. In following the decision path, the Cycle Counting Engine goes through the following steps:

1. Identifies the cycle-counting basis (ABC or XYZ) for the specified inventory location or location type.
2. If any remaining product category is to be handled, calculates the number of products to count today. If no remaining product category is to be handled, prints a parts list.
3. If there are any remaining uncounted products in the category, selects a product category that has not been counted in this counting period.
4. Adds the selected product to the parts list (or cycle counting order); flags the product counted.
5. If the products to be counted today have been selected, returns to Step 2. If the products to be counted today have not been selected yet, returns to Step 3.

**Configuration of the Cycle Counting Engine**

The Cycle Counting Engine generates cycle counting headers and cycle counting part lists by using the configuration information from the Cycle Counts view. For more information, see “Cycle Counts View” on page 438.

Cycle counting uses these configuration parameters:

- **ABC or XYZ count basis.** The method used for cycle counting of an inventory location: ABC = financial value basis, XYZ = turnover basis.
- **A, B, or C classification.** The classification of products based on the financial value of an item, where A > B > C.
**X, Y, or Z classification.** The classification of products based on the turnover of an item, where \( X > Y > Z \).

A product receives any combination of class A, B, or C and X, Y, or Z; for example, AY. However, cycle counting is based on either ABC or XYZ, not both.

**Frequency.** The interval in days between physical counts of inventory at a location; for example, if counting frequency is 7 days, inventory is counted every seven days.

**Period.** The time period in days allotted to counting all A or X, B or Y, or C or Z class items at this location. For example, if the counting period for class A or X products is 90 days, the Cycle Counting Engine makes sure that all the products in this class are included in the part list at least once every 90 days.

**Start Date and End Date.** The time span in calendar days during which the Cycle Counting Engine will create cycle count records.

Here is an example of a cycle counting scenario:

An inventory location is configured to count on a financial value basis (ABC). There are approximately 100 A-class products in inventory. Every five days (Frequency = 5 days) someone spends as much time as needed to count one-quarter (5/20) of the A-class items, with the goal of counting all of the A-class items within 20 days (Counting Period A/X = 20 days). Counting periods do not have to be even multiples of frequency.

### Configuration Information for the Cycle Counting Engine

Configuration of cycle counting takes place at several levels, on different screens (see Table 106).

<table>
<thead>
<tr>
<th>Configuration Parameter</th>
<th>Applies to</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle count basis: ABC or XYZ</td>
<td>Inventory locations</td>
<td>See “Inventory Locations View” on page 436.</td>
</tr>
<tr>
<td></td>
<td>Inventory location types</td>
<td>See “Inventory Location Types View” on page 434.</td>
</tr>
<tr>
<td>Cycle count class: A, B, or C and X, Y, or Z</td>
<td>Products associated with a specific inventory types</td>
<td>See “Inventory Options Subview” on page 435.</td>
</tr>
<tr>
<td></td>
<td>Products associated with specific inventory locations</td>
<td>See “Product Inventory View” on page 436.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Inventory locations</td>
<td>See “Inventory Locations View” on page 436.</td>
</tr>
<tr>
<td></td>
<td>Inventory location types</td>
<td>See “Inventory Location Types View” on page 434.</td>
</tr>
</tbody>
</table>
NOTE: If a configuration parameter can be set at different aspects of inventory, the parameter for the more specific aspect takes precedence. For example, the count basis (ABC or XYZ) at an inventory location takes precedence over the basis specified for an inventory type. The cycle count class (A, B, or C; X, Y, or Z) for an inventory type takes precedence over that for a product.

### System Preferences for the Cycle Counting Engine

The Field Service engines have system preferences (see Table 107 on page 421) that determine the behavior of each engine. These system preferences are stored in the table S_SYS_PREF. The BusComp is System Preferences. These are the columns of main interest:

- **SYS_PREF_CD.** Name of the System Preference.
- **VAL.** Value of the System Preference.

Changing the values of these preferences changes the default behavior of the engine.

NOTE: To register changes to System Preferences, restart the Field Service server.

#### Table 107. System Preferences for the Cycle Counting Engine

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>BucketAvailCDtobeCounted</td>
<td>OnHand, Customer-Owned</td>
<td>Specifies the valid values for the inventory level’s availability code. The values should be from the Bucket Availability Code LOV, and individual values should be LIVs.</td>
</tr>
<tr>
<td>BucketStatusCDtobeCounted</td>
<td>Good</td>
<td>Specifies the valid values for the buckets’ status code. The values should be from the Bucket Status Code LOV and individual values should be LIVs.</td>
</tr>
</tbody>
</table>

Only the inventory levels (buckets) whose Availability and Status match the values defined by the above two parameters are included in the cycle counting process.
Parameters for the Cycle Counting Engine

All engines can be invoked from the Workflow Manager or from the client. The engines require certain parameters to be passed. Set the component job parameters using the Administration - Server Management screen > Jobs > Job Detail view when creating a component job for the server component Field Service Cycle Counting Engine (alias FSCyccnt).

Table 108 describes the parameters for the Cycle Counting Engine.

Table 108. Parameters for the Cycle Counting Engine

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>SQL</td>
<td>Specify the WHERE clause to set up criteria and count the parts which meet that criteria.</td>
</tr>
<tr>
<td>Id</td>
<td></td>
<td>Specify the ID of the inventory location or the inventory type and only the parts related to that loc/type will be counted.</td>
</tr>
<tr>
<td>TempTbl</td>
<td></td>
<td>Put all the required parameters into a temporary table with a temporary Client Request ID and pass that ID to the server to retrieve the parameters from Temp Table.</td>
</tr>
<tr>
<td>ClientId</td>
<td>A row ID for retrieving params from the temp table</td>
<td>Required when Mode = TempTbl.</td>
</tr>
<tr>
<td>RowID</td>
<td>Row ID of an Inventory location or Inventory type</td>
<td>Required when Mode = ID.</td>
</tr>
<tr>
<td>StartDT</td>
<td>Start Date</td>
<td>Required. The proposed start date of cycle counting.</td>
</tr>
<tr>
<td>EndDT</td>
<td>End Date</td>
<td>Required. The proposed end date of cycle counting.</td>
</tr>
<tr>
<td>Where</td>
<td>Where Clause</td>
<td>Business Component Search Spec mode. Required when Mode = SQL.</td>
</tr>
<tr>
<td>Loc/Type</td>
<td>Inventory Location or Inventory Type</td>
<td>Required when Mode = ID or TempTbl.</td>
</tr>
</tbody>
</table>

Invoking the Cycle Counting Engine

Use these methods to invoke the Cycle Counting Engine:

- Invoke the engine by starting a single or repeating component job from the Administration - Server Management screen > Jobs view.
- Invoke the engine by clicking the Generate Counts or the Generate Counts (All Locations) button in the Inventory screen, Cycle Counts view.
- Invoke the engine from the command-line interface server manager program.
Tracing Levels for the Cycle Counting Engine

You can set different tracing levels for the Cycle Counting Engine, depending on the type and quantity of information you want to collect. For information about this functionality, see Appendix A, "Engines Logging Levels."

Setting Up Cycle Counting

Follow these procedures to set up cycle counting.

For information about synchronous and asynchronous processing, see Siebel Application Services Interface Reference.

**CAUTION:** In synchronous processing, the client screen can lock. Consequently, the user sees a blank screen.

To specify asynchronous operation of the Cycle Counting Engine for a specific user

1. From the application-level menu, choose Tools > User Preferences.
   The User Preferences screen appears.
2. On the link bar, click Service.
   The Field Service form appears.
3. Select the Cycle Counts check box.

To set component job parameters for the Cycle Counting Engine

1. Create or edit a component job for the server component Field Service Cycle Counting Engine (alias FSCyccnt).
2. Add or modify the server component parameters as needed.
   For information about server components, component parameters, and setting repeating component jobs, see Siebel System Administration Guide.

To change system preferences for the Cycle Counting Engine

1. Navigate to Administration - Application screen > System Preferences view.
2. In the System Preference Name column, locate the system preference whose value you want to change.
   **NOTE:** For cycle counting engine-related system preferences, see Table 107 on page 421.
3. In the System Preference Value field, enter a new value.
To register changes to system preferences, restart the Field Service server.

**To set up cycle counts for specific inventory locations**
1. Navigate to the Inventory screen.
2. Select an inventory location record.
3. In the My Inventory Locations list, drill down on the Name field hyperlink.
4. Click the More Info view tab.
5. In the More Info form, enter values for the Count Basis, Frequency, and Period fields.

**To define the start date and end date for cycle counting**
1. Navigate to the Cycle Counts screen.
2. From the visibility filter, select All Cycle Counts.
3. In the All Cycle Counts list, select an inventory location record.
4. Enter values for the Start and End dates.

**To define the cycle count basis for inventory locations**
1. Navigate to the Inventory screen.
2. Select an inventory location record.
3. In the My Inventory Locations list, drill down on the Name field hyperlink.
4. Click the More Info view tab.
5. In the More Info form, in the Count Basis field, select ABC or XYZ.

**To define the cycle count basis for inventory location types**
1. Navigate to the Administration - Service screen > Inventory Administration view.
2. In the Inventory Location Types list, select an existing inventory type record or add a new one.
3. In the Count Basis field, select ABC or XYZ.

**To define cycle count classes for products at specific inventory locations**
1. Navigate to Administration - Product Screen.
2. Select a product record.
3. In the Products list, drill down on the Product field hyperlink.
4. In the More Info link bar, click the Product Service Details link.
5. In the Inventory Options subview tab, select an existing inventory type or add a new type.
6 In the ABC Class and XYZ Class fields, select the relevant cycle counting classes (A, B, or C; X, Y, or Z).

**To define the cycle count class for products associated with specific inventory types**
1 Navigate to Administration - Product Screen.
2 Select a product record.
3 In the Products list, drill down on the product field hyperlink.
4 In the More Info link bar, click the Product Service Details link.
5 On the Inventory Options subview tab, select an existing inventory type or add a new type.
6 In the Class ABC and Class XYZ fields, select the relevant cycle counting classes (A, B, or C; X, Y, or Z).

**To define cycle counting frequency and periods for an inventory location**
1 Navigate to the Administration - Service screen > Inventory Administration view.
2 In the Inventory Location Types list, select an existing inventory location type or add a new inventory location type.
3 In the Frequency field, enter the number of days.
4 In the Period A/X, Period B/Y, and Period C/Z fields, enter the relevant numbers of days.

**To define cycle counting frequency and periods for an inventory location type**
1 Navigate to the Administration - Service screen > Inventory Administration view.
2 In the Inventory Location Types list, select an existing inventory location type or add a new inventory location type.
3 In the Frequency field, enter the number of days.
4 In the Period A/X, Period B/Y, and Period C/Z fields, enter the relevant numbers of days.

**To configure tracing for the Cycle Counting Engine**
1 Navigate to the Administration - Server Configuration screen > Servers view.
2 Click the Parameters view tab.
3 In the Server Parameters list, locate the Trace Flags parameter.
4 Set the appropriate values for the fields in the Trace Flags parameter record.

**To manually specify parts for a cycle count**
1 Navigate to Inventory screen.
2 Select an inventory location record.
Running the Cycle Counting Engine

Follow these procedures to carry out cycle counts of inventory.

To run the Cycle Counting Engine interactively

1. Navigate to the Inventory screen > Cycle Counts view.
2. In the Inventory Locations list, select an inventory location record for cycle counting.
3. Do one of the following:
   - Click Generate Counts to produce cycle count lists for the selected inventory location.
   - Click Menu and select Generate Counts (All Locations) to produce count lists for all inventory locations.

   The cycle counts appear on the Cycle Counts subview tab.

To review pending cycle counts and parts lists for cycle counting

1. Navigate to the Inventory screen > Cycle Counts view.
2. In the Inventory Locations list, select an inventory location record.
   The Cycle Counts subview shows records describing each instance of a cycle count. Pending cycle counts have a status of Open or Assigned.
3. Select a cycle count record.
4. Drill down on the Status field hyperlink.
   The Part List tab shows all items included in the selected cycle count.

To record the results of a cycle count

1. Navigate to the Cycle Counts screen > Cycle count List view.
2. Select a cycle count record.
3. In the My Pending Cycle Counts list, drill down on the Status field hyperlink.
4. In the Part List list, In the Count field of each product record, enter the quantity counted.
5. If a counted item is serialized:
a Select the product record.
b Enter a value in the Count field.
c Click the Counted Serial Numbers subview tab.
d In the Counted Serial Numbers list, create a record for each serialized asset that is an instance of that product.

To complete a cycle count
1 Navigate to the Cycle Counts screen > Cycle Count List view.
2 Select a cycle count record.
3 In the My Pending Cycle Counts list, drill down on the Status field hyperlink.
4 In the Part List list, click Count Complete.
   This populates the records in the Variance view and the Counted Serial Numbers subview.

To review a cycle count
1 Navigate to the Cycle Counts screen > Cycle Count list view
2 Select a cycle count record.
3 In the My Pending Cycle Counts list, drill down on the Status field hyperlink.
4 Click the Variance view tab.
5 Review the results (Original, Count, and Variance) of the product count and counted serial numbers, if applicable.
6 To adjust the inventory, click Adjust.

Replenishment Engine
Replenishment is the process of generating orders to restock depleted parts in an inventory location. The Replenishment Engine generates internal orders to other inventory locations or purchase orders to outside vendors using the following information about a product in inventory:

- Minimum and maximum stock levels, plus a safety level
- Replenishment relationships with other inventories

There are three sources for replenishment:

- **Another service inventory location.** The Replenishment Engine generates an internal order. For example, the main service warehouse replenishes a subsidiary warehouse.

- **External provider.** The product is purchased from an external vendor. In this case, the Replenishment Engine generates a purchase order.
Manufacturing inventory. The product is provided by an internal manufacturing division. Such replenishments are usually handled as if from an external provider; a purchase order is generated.

**NOTE:** Replenishment is different from fulfillment. For more information, see “Fulfillment Overview” on page 323. The replenishment process creates orders to restock inventory; the fulfillment process allocates items to fill outgoing orders and generates pick tickets.

The Replenishment Engine requires as input one or more inventory locations.

### Configuration Parameters of the Replenishment Engine

The Replenishment Engine uses the configuration parameters listed in Table 109.

Table 109. Configuration of Replenishment

<table>
<thead>
<tr>
<th>Configuration Parameter</th>
<th>Applies to</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum quantity of product to keep in stock</td>
<td>Product</td>
<td>See the “Product Inventory View” on page 370.</td>
</tr>
<tr>
<td>Maximum quantity of product to keep in stock</td>
<td>Product</td>
<td>See the “Product Inventory View” on page 370.</td>
</tr>
<tr>
<td>Relationships among inventory locations</td>
<td>Inventory location</td>
<td>See the “Relationships View” on page 371.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Product</td>
<td>See the Administration - Product screen &gt; Product Service Details view.</td>
</tr>
<tr>
<td>Vendors for an inventory location</td>
<td>Inventory location</td>
<td>See the “Vendors View” on page 371.</td>
</tr>
</tbody>
</table>

### System Preferences for the Replenishment Engine

The Field Service engines have system preferences, listed in Table 110 on page 429, that determine the behavior of each engine. These system preferences are stored in the table S_SYS_PREF. The BusComp is System Preferences. These are the columns of main interest:

- **SYS_PREF_CD.** Name of the system preference.
VAL. Value of the system preference.

Table 110. System Preferences for the Replenishment Engine

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InvLocTypeForReplenishRelation</td>
<td>Warehouse</td>
<td>Specifies the default replenishment level. Orders to replenish any level of an inventory location have this value as their Destination.</td>
</tr>
<tr>
<td>ReplenishOrderPriority</td>
<td>Medium</td>
<td>Specifies the default order priority for newly created orders. The values should be from the Order Priority LOV and individual values should be LIVs.</td>
</tr>
<tr>
<td>OrderItemStatusForOnOrderQty</td>
<td>Open, New, Pending</td>
<td>Specifies the valid values for the existing order item status. The values should be from the Order Item Status LOV and individual values should be LIVs.</td>
</tr>
<tr>
<td>OrderStatusForOnOrderQty</td>
<td>Open, New, Pending</td>
<td>Specifies the valid values for the existing order status. The values should be from the Order Status LOV and individual values should be LIVs.</td>
</tr>
<tr>
<td>OrderTypeForOnOrderQty</td>
<td>Internal Order, Purchase Order</td>
<td>Specifies the valid values for the existing order type. The values should be from the Order Type LOV and individual values should be LIVs.</td>
</tr>
</tbody>
</table>

The last three parameters specify what kind of orders, order items, and order types to look for when searching for an existing order, to avoid creating duplicate orders.

**CAUTION:** The Order Status List of Values should have Open as its Language Independent Value. If it does not, the Replenishment Engine will not work.

**NOTE:** To register changes to System Preferences, restart the Field Service server.
Parameters for the Replenishment Engine

All engines can be invoked from the Workflow Manager or from the client. These engines require certain parameters to be passed. Set the component job parameters using the Administration - Server Management screen > Jobs > Job Detail view when creating a component job for the server component Field Service Replenishment Engine (alias FSRepl). Table 111 lists the parameters for the Replenishment Engine, and what they mean.

Table 111. Parameters for the Replenishment Engine

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>InvokeMode</td>
<td>Id</td>
<td>In this mode, specify the inventory location to be replenished and the engine will replenish the specified location.</td>
</tr>
<tr>
<td></td>
<td>SQL</td>
<td>In this mode, specify the WHERE clause, meaning specify some criteria and replenish the inventory locations which meet that criteria.</td>
</tr>
<tr>
<td></td>
<td>TEMP</td>
<td>In this mode, put all the required parameters into a temporary table with a particular Client Request ID and pass that ID to the server to retrieve the parameters from Temp Table.</td>
</tr>
<tr>
<td>ClientId</td>
<td>A row ID for retrieving parameters from the temp table</td>
<td>Required when InvokeMode = TEMP.</td>
</tr>
<tr>
<td>SourceType</td>
<td>I (Inventory Location) V (Vendor)</td>
<td>Required when InvokeMode = TEMP. Defaults to I when InvokeMode = Id or SQL.</td>
</tr>
<tr>
<td>DestId</td>
<td>Destination Inventory ID</td>
<td>Required when InvokeMode = Id.</td>
</tr>
<tr>
<td>WhereClause</td>
<td>SQL Where Clause</td>
<td>Business Component Search Spec. Required when InvokeMode = SQL.</td>
</tr>
</tbody>
</table>

Setting the Implementation Logic for the Replenishment Engine

Use the following procedure to set the Implementation Logic for the Replenishment Engine.

To set the Implementation Logic for the Replenishment Engine

1. Obtain the system preferences from the system table.
   Obtain the user defined parameters to determine the defaults for the Replenishment Engine.

2. Obtain the destination inventory location.
   Obtain the value of the destination inventory location based on the InvokeMode from one of the following sources:
Cycle Counting and Replenishment

■ Input Parameter - DestId
■ Input Parameter - Where Clause
■ Temp Table

3 Generate Internal Orders for all the Destination Inventory Locations.

If the InvokeMode is Id/SQL, get the Source Inventory Location for the current Destination Inventory location.

Get the On Hand, Min, and Max Qty for all the products in the Destination inventory location and the child locations whose On Hand Qty < Min Qty.

For each product do the following:

Calculate the EffectiveQty:
Search existing orders and find the Qty on order.
EffectiveQty = Qty + Qty on order.
If EffectiveQty is less than the Min Qty:
If the order header does not exist (first time only), generate the order header of type Internal order.
Add a line item to the order header for theReqQty = Max Qty − Effective Qty.

4 Generate Purchase Order.

Get the On Hand, Min, and Max Qty for all the products in the Destination inventory location and the child locations whose On Hand Qty < Min Qty.

For each product do the following:

Calculate the EffectiveQty:
Search existing orders and find the Qty on order.
EffectiveQty = Qty + Qty on order.
If EffectiveQty is less than the Min Qty:
Get the Vendor for this product.
If Vendor exists in the user supplied Vendor list, then:
If the order header does not exists (first time only), generate the order header of type Purchase order.
Add a line item to the order header for theReqQty = Max Qty − Effective Qty.

Invoking the Replenishment Engine

Use these methods to invoke the Replenishment Engine:

■ Invoke the engine using the Workflow Manager to generate internal and purchase orders, based on stock levels.
■ Invoke the engine by clicking the Orders button in the Inventory screen, Generate Orders view.
■ Invoke the engine through the Server Manager on the application server.
Related Topic
"FS Replenish Business Service” on page 581

Setting Up Replenishment

Follow these procedures to set up replenishment.

Some procedures for setting up replenishment are the same as for setting up cycle counting. When beginning to set up replenishment, use the following procedures, substituting cycle counting for replenishment.

To set the maximum and minimum quantity of products to keep in stock

1. Navigate to the Inventory screen.
2. Select an inventory location record.
3. In the My Inventory Locations list, drill down on the Name field hyperlink.
4. For the selected product, enter values in the Max, Min, and Safety fields.

To set up replenishment relationships between inventory locations

1. Navigate to the Inventory screen.
2. Select an inventory location record.
3. In the My Inventory Locations list, drill down on the Name field hyperlink.
4. Click the Relationships view tab.
5. Create a new relationship record.
6. In the Name field, select another inventory location.
7. In the Relationship field, select Replenishes.

To set up a vendor for a product

1. Navigate to the Products screen.
2. Select a product record.
3. In the All Products list, drill down on the Product field hyperlink.
4. Click the Product Service Details hyperlink on the link bar.
5. In the Product Service Details form’s Replenishment Options section, select a vendor from the Primary Vendor field.

Replenishing Inventory

Follow these procedures to replenish inventory.
To replenish inventory by placing orders
1. Navigate to the Inventory screen.
2. Select an inventory location record.
3. In the My Inventory Locations list, drill down on the Name field hyperlink.
4. Click the Generate Orders view tab.
   This view displays a read-only list of authorized vendors for this inventory location. The subviews show the source and target locations.
5. In the Generate Orders list, click Order.
   This generates orders to replenish every product at the selected inventory location that is under the minimum level.

To verify pending replenishment orders
1. Navigate to the Inventory screen.
2. Select an inventory location record.
3. In the My Inventory Locations list, drill down on the Name field hyperlink.
4. Click the Pending Orders view tab.
   This view displays the numbers and types of pending orders for this location.

To set a vendor for an inventory location
1. Navigate to the Inventory screen.
2. Select an inventory location record.
3. In the My Inventory Locations list, drill down on the Name field hyperlink.
4. Click the Vendors view tab.
5. In the Vendors list, create a new vendor record.
6. In the Account field, select a vendor.
7. In the Type field, select Vendor or Primary Vendor.

Administration - Service Screen
The Administration - Service screen contains one view that allows assignment of cycle counting parameters to types of inventory locations.
Inventory Location Types View

You access the Inventory Location Types view by navigating to the Administration - Service screen and selecting Service Inventory from the visibility filter. The Inventory Location Types view assigns the following cycle counting parameters to all inventory locations of a specific type (see Table 112).

Table 112. Selected Items in the Inventory Location Types View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count Basis</td>
<td>A method of inventory classification that determines how often to count a product during cycle counting; ABC or XYZ chosen from a list. Inventory locations with the inventory type ABC are counted based on their relative value and locations with XYZ are counted based on their relative turnover.</td>
</tr>
<tr>
<td>Frequency</td>
<td>The interval in days between physical counts of inventory at any location with this inventory type.</td>
</tr>
<tr>
<td>Period A/X</td>
<td>The time period in days allotted to counting all A or X class items at any location with this inventory type.</td>
</tr>
<tr>
<td>Period B/Y</td>
<td>The time period in days allotted to counting all B or Y class items at any location with this inventory type.</td>
</tr>
<tr>
<td>Period C/Z</td>
<td>The time period in days allotted to counting all C or Z class items at any location with this inventory type.</td>
</tr>
</tbody>
</table>

Products Screen

The Products screen has one view, Service Details, that displays information for cycle counting and replenishment. All fields are read-only.

Service Details View

The Service Details view provides the information used in locating and allocating products. The Allocate Below Safety, Auto Allocate, and Auto Substitute check boxes in this view do not apply to cycle counting or replenishment. This view has two subviews, Inventory Options and Substitutes.
Inventory Options Subview
The Inventory Options subview sets the inventory locations for a product and determines the cycle
counting parameters for each product at a specific location. The Allocate Below Safety, Auto Allocate,
and Auto Substitute fields in this view do not apply to cycle counting or replenishment. Table 113
describes items in Inventory Options records.

Table 113. Selected Items in the Inventory Options View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class ABC</td>
<td>The classification of a product, A, B, or C, that indicates its value. Class A has the greatest financial value.</td>
</tr>
<tr>
<td>Class XYZ</td>
<td>The classification of a product, X, Y, or Z, that indicates its turnover rate. Class X has the greatest turnover rate.</td>
</tr>
</tbody>
</table>

**NOTE:** A product can receive any combination of class ABC and XYZ; for example, AY. However, cycle counting must be based on either ABC or XYZ, not both.

Substitutes Subview
The Substitutes subview specifies the products that the Fulfillment Engine may use to fill an order when the specified product is unavailable from inventory. The user chooses from products that are specified in the Products view. For more information, see "Products View" on page 337.

**NOTE:** Substitutions are unidirectional. Product A may substitute for product B, but B cannot substitute for A unless that substitution is explicitly defined.

Inventory Screen
The Inventory screen contains two views for managing cycle counting at inventory locations and for inventory replenishment.
Inventory Locations View

The Inventory Locations view sets the cycle counting parameters for each location. Table 114 describes items in Inventory Locations records. To see these fields, click the More Info view tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count Basis</td>
<td>A method of inventory classification that determines how often to count a product during cycle counting: ABC or XYZ chosen from a list. Products with ABC are counted based on their relative value and products with XYZ are counted based on their relative turnover.</td>
</tr>
<tr>
<td>Frequency</td>
<td>The interval in days between physical counts of inventory at a location.</td>
</tr>
<tr>
<td>Period A/X</td>
<td>The time period in days allotted to counting all A or X class items at this location.</td>
</tr>
<tr>
<td>Period B/Y</td>
<td>The time period in days allotted to counting all B or Y class items at this location.</td>
</tr>
<tr>
<td>Period C/Z</td>
<td>The time period in days allotted to counting all C or Z class items at this location.</td>
</tr>
</tbody>
</table>

Product Inventory View

The Product Inventory view associates inventory locations with products and sets quantities of product, whether the product is serialized, and cycle counting parameters for the product at this location. Products are specified in the Administration - Product screen. For more information, see “Administration - Product Screen” on page 337. Table 115 describes items in Product Inventory records.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC Class</td>
<td>The classification of a product, A, B, or C, that indicates its value. Class A has the greatest financial value. This value overrides the Class ABC on the Product Administration screen.</td>
</tr>
<tr>
<td>Max</td>
<td>A type-in field for the maximum acceptable quantity of inventory at this location and product.</td>
</tr>
<tr>
<td>Min</td>
<td>A type-in field for the minimum acceptable quantity of inventory at this location and product.</td>
</tr>
<tr>
<td>Safety</td>
<td>A type-in field for the safe quantity of inventory at this location and product. This quantity (≤ Min) is the quantity below which the Fulfillment Engine a product should not allocate. The user can override this value.</td>
</tr>
<tr>
<td>Serialized</td>
<td>Indicates that instances of this product must have serial numbers recorded.</td>
</tr>
<tr>
<td>XYZ Class</td>
<td>The classification of a product, X, Y, or Z, that indicates its turnover rate. Class X has the greatest turnover rate. This value overrides the Class XYZ on the Product Administration screen.</td>
</tr>
</tbody>
</table>
Generate Orders View
The Generate Orders view automatically produces orders to restock products in inventory, by either an internal transfer between inventory locations or by purchase from an outside vendor. For replenishment, an inventory level must be defined for a product. For replenishment from a vendor, the authorized vendor must also be defined. These read-only records are derived from data in the Inventory screen. For more information, see “Inventory Screen” on page 368.

The Order button and command runs the Replenishment Engine and create purchase and internal orders to replenish all items at the selected location that are below minimum.

The replenishment process describes a source inventory location to replenish a selected location and a target location to be replenished from the selected location. Specific relationships between locations are defined in the Relationships view. For more information, see “Relationships View” on page 437.

Source Locations Subview
The Source Locations subview lists valid replenishment sources for the related target locations. The Order button creates internal orders to replenish the related target locations (in the Target Locations subview).

Target Locations Subview
The Target Locations subview lists target locations lists locations to be replenished from a related source location. The Order button creates internal orders to replenish the target locations.

Pending Orders View
The Pending Orders view lists internal orders or purchase orders that have been placed to replenish a location. The records in this view, generated by the Replenishment Engine, are read-only.

For a discussion of replenishment, see “Replenishment Engine” on page 427.

Vendors View
The Vendors view records vendors who may supply products for a selected inventory location. For replenishing a location from an outside source, vendors must be specified.

Relationships View
The Relationships view records the relationships of a selected inventory location with other inventory locations. If a business uses more than one inventory location, relationships among inventory locations are useful for automating inventory replenishment and order fulfillment. A relationship may be physical, hierarchical (for example, a shelf belongs to an aisle), or logistical (for example, Fulfills or Replenishes).
Cycle Counts View
The Cycle Counts view sets specifications that the Cycle Counting Engine uses to automatically generate the cycle count lists. To reach this view, choose Cycle Counts from the visibility filter.

The Inventory Locations view is the same as previously described, with the addition of a Generate Counts button and a Generate Counts (All Locations) command. For more information, see “Inventory Locations View” on page 436. Table 116 describes commands and buttons in the Inventory Locations view for Cycle Count records.

Table 116. Selected Items in the Inventory Locations View for Cycle Counts

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Counts</td>
<td>This button produces a list of products to count for the selected inventory location. The list appears in the Parts List view. For more information, see “Part List View” on page 440.</td>
</tr>
<tr>
<td>Generate Counts (All Locations)</td>
<td>This command produces a list of products to count for all inventory location. The list appears in the Parts List view. For more information, see “Part List View” on page 440.</td>
</tr>
</tbody>
</table>

More Info Subview
The Cycle Counts view has a More Info subview containing the following items specific to cycle counting (Table 117). These fields are read-only.

Table 117. Selected Items in the More Info Subview for Cycle Counts

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC Class</td>
<td>The classification of product, A, B, or C, that indicates its value. Class A has the greatest value.</td>
</tr>
<tr>
<td>Ended</td>
<td>The actual end date for a cycle count.</td>
</tr>
<tr>
<td>Started</td>
<td>The date for the actual start of a cycle count.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of a cycle count; for example, Assigned, Closed, or Open.</td>
</tr>
<tr>
<td>XYZ Class</td>
<td>The classification of product, X, Y, or Z, that indicates its turnover rate. Class X has the greatest turnover rate.</td>
</tr>
</tbody>
</table>
**Cycle Counts Subview**

The Cycle Counts subview contains read-only records that are derived from the data recorded in the Cycle Counts view. For more information, see “Cycle Counts View” on page 438. Table 118 describes fields in the Cycle Counts subview.

Table 118. Fields in the Cycle Counts Subview

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>The employee assigned to carry out this cycle count.</td>
</tr>
<tr>
<td>Due</td>
<td>The date on which the counts of products specified in the Parts List view should be completed. For more information, see “Part List View” on page 440.</td>
</tr>
<tr>
<td>End</td>
<td>The date the cycle count period ends, which is inherited from the Cycle Counts screen.</td>
</tr>
<tr>
<td>Inventory Location</td>
<td>The name of the inventory location for this cycle count.</td>
</tr>
<tr>
<td>Start</td>
<td>The date the cycle count period starts.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of a cycle count; for example, Assigned, Closed, or Open.</td>
</tr>
</tbody>
</table>

**Cycle Counts Screen**

The Cycle Counts screen contains views for defining cycle counts at specific inventory locations, providing lists that direct the physical counting of inventory, recording the results of cycle counts, and adjusting inventory levels.

**Cycle Counts Views**

The Cycle Counts views define cycle counts at specific inventory locations and specify the timing of these counts. Table 119 describes items in Cycle Count records.

Table 119. Selected Items in the Cycle Count Views

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due</td>
<td>A type-in field containing the date on which the counting cycle should be completed. This field is for information only; the Cycle Counting Engine does not use the date.</td>
</tr>
<tr>
<td>End</td>
<td>A type-in field containing the actual date that the cycle count was completed. This date is used when generating Cycle Count Detail reports.</td>
</tr>
<tr>
<td>Start</td>
<td>A type-in field containing the date on which the cycle count should start. This date is used when generating Cycle Count Detail reports.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of a cycle count; for example, Assigned, Closed, or Open.</td>
</tr>
</tbody>
</table>
Part List View
The Part List view displays a list of the products to count at a selected inventory location and records the count results. The records in the Part List are created by clicking Generate Counts or the Generate Counts (All Locations) in the Inventory screen’s Cycle Counts view. For more information, see “Cycle Counts View” on page 438. Records can also be entered manually. Table 120 describes a button in Part List records.

### Table 120. Selected Items in the Part List View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count Complete</td>
<td>This button compares the value entered in the Count field and the number of items in the database, produces the data in the Variance view, and lists the missing assets in the Missing Assets subview.</td>
</tr>
</tbody>
</table>

Counted Serial Numbers Subview
The Counted Serial Numbers subview accepts serial numbers for each serialized product that is counted.

Variance View
The Variance view shows the differences between the quantity in the Field Service database and an actual product count. Table 121 describes a button in the Variance view.

### Table 121. Selected Items in the Variance View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust</td>
<td>Clicking this button creates database transactions to match the quantity recorded in the database with the physical count. The transactions are either Receive Other (from the External location) or Ship Other (to the External Location). The Cycle Counting Engine does not validate (quantity or source) for the External location. For more information, see “Setting Up External Locations” on page 369 and “Inventory Transactions” on page 355.</td>
</tr>
</tbody>
</table>

Cycle Counting Report
The Reports menu on the Cycle Counts screen provides the Cycle Count Detail report (Table 122).

### Table 122. Cycle Count Detail Report

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle Count Detail</td>
<td>Presents all information about selected cycle counts.</td>
</tr>
</tbody>
</table>
Applications administrators can use this chapter for configuring the Siebel application, so that end
users can use Release Manager. Product Marketing, Engineering, Quality Assurance (QA), and
Technical Publications managers can use this chapter to monitor their teams’ progress. End users
(product marketers, engineers, QA testers, and technical writers) can refer to this chapter for
procedures to record their development tasks.

The Release Manager and Quality modules of Siebel Service work together. After a product is
released, the Quality module tracks the product improvement process and channels requests for
improvements to future releases. For more information about the Quality module, see Chapter 14,
“Quality.” Topics for this chapter include:

- Release Manager on page 441
- Business Scenario for Release Manager on page 444
- Example Process Flow for Release Manager on page 446
- Administrator Setup Procedures for Release Manager on page 448
- Product Marketing End-User Procedures for Release Manager on page 452
- Engineering End-User Procedures for Release Manager on page 455
- Quality Assurance End-User Procedures for Release Manager on page 457
- Technical Publications End-User Procedures for Release Manager on page 462
- Administrator Maintenance Procedures for Release Manager on page 463

Release Manager

The Release Manager module helps to manage new product development and release cycles from
start to finish. Release Manager uses data collected in your Siebel application to help guide product
feature selection and development. Topics include:

- Release Manager Structure on page 442
- Product Release Process on page 443

Release Manager assists with a number of release-related activities. With Release Manager, users
can perform the following tasks:

- Communicate feature descriptions throughout the organization.
- Prioritize features so that the most important ones get implemented.
- Develop marketing requirements documents (MRDs) for engineers to use as product
  specifications.
- Allocate engineering resources and track engineering tasks.
- Track QA test plan development and test execution.
- Track documentation development.
- Track activities associated with release-related items.
- Monitor development status.

**Release Manager Structure**

You can think of a product release as a composite of features. The decision to implement these features generates multiple release-related items: MRDs to identify the features, engineering tasks to implement the features, QA test plans to test the features, and documentation to describe the features. The system helps to make sure that each task, test plan, and document derives from one or more new features.

Release Manager is built around features. In Release Manager, engineering tasks, MRDs, QA test plans, and technical publications documents are linked to their associated features. Users gain benefits, such as the following:

- Executives can justify decisions on how to allocate engineering resources and schedule QA testing.
- Product marketing managers can see the features specified in MRDs, and determine the development, testing, and documentation status for a given feature.
- Engineering and QA managers can know which new features need to be incorporated into their project plans and test plans.
Figure 36 on page 443 shows how the various release-related items are linked to features. This illustration shows an area that represents Release Manager. Within this area, tests are linked to test plans, and test plans, engineering tasks, MRDs, and documentation are all linked to features at the center.

**Product Release Process**

The product release process consists of the following stages:

- **Stage 1.** Product Marketing begins the release cycle by defining product features, entering those features into the system, determining which features will be implemented, and developing marketing requirements documents (MRDs).

- **Stage 2.** Engineering builds the features. Engineering defines the tasks required to implement the features, builds the features, and uses the system to track task completion.

- **Stage 3.** Quality Assurance (QA) defines test plans to test the new features, and uses Release Manager to track the test plan development. QA then tests the features by executing the test plans in various operating environments, and records the details of each test iteration.
Stage 4. Technical Publications documents each feature in the appropriate publication and uses Release Manager to track document development status.

In practice, these stages are not rigidly sequential. At any given point in the release development cycle, activities for several of the stages may overlap as teams pursue their goals simultaneously.

As illustrated in Figure 37, Stage 1 (Product Marketing), Stage 2 (Engineering), Stage 3 (Quality Assurance), and Stage 4 (Technical Publications) all lead toward the final stage, Ship.

Business Scenario for Release Manager

This scenario provides an example of a process flow performed by an applications administrator, and managers and line employees in product marketing, engineering, QA, and technical publications. Your company may follow a different process flow according to its business requirements. The scenarios for Release Manager are:

- Setup Scenario for Administrators on page 445
- Scenario for Product Marketing on page 445
- Scenario for Engineering on page 445
- Scenario for Quality Assurance on page 445
- Scenario for Technical Publications on page 446
- Maintenance Scenario for Administrators on page 446
Setup Scenario for Administrators

Before the release cycle begins, the administrator sets up a master record for the release in the Siebel application. Then the administrator defines an access list of people who will be associated with the release. Afterward, the administrator designates the people on the access list for project teams that will be associated with various stages of the release. The administrator also sets up lists of values for picklist fields in the Release Manager views. Finally, the administrator sets up activity templates by which end users can associate lists of specific activities with certain stages of the release process.

Scenario for Product Marketing

At the beginning of a release cycle, the Product Marketing group defines a set of release-defining features, requirements and enhancements for the products based on customer needs. After the detailed features list has been finalized and prioritized, Product Marketing enters the features into Release Manager as Feature records. If a feature is a complex one with multiple components, Product Marketing enters each component as a Feature record, and then designates the main feature as its parent feature.

After the features for a release have been entered, Product Marketing writes Marketing Requirement Documents (MRDs) and enters them into Release Manager. Product Marketing creates a new record for each MRD or logical group of MRDs. After the MRD records have been created, Product Marketing links the MRD document files to their respective MRD records as attachments. Finally, Product Marketing links the MRDs to the features they reference.

Scenario for Engineering

As Product Marketing defines release features, Engineering writes engineering tasks to implement those features in the product. Each engineering task is entered as an individual record in Release Manager. Each engineering task is linked to the features it is designed to implement. If a task is a complex one with multiple components, Engineering enters each component as a subtask record, then links it to the main engineering task.

Scenario for Quality Assurance

As Product Marketing defines release features and Engineering implements them, Quality Assurance writes test plans to validate the features. Each completed test plan is entered as an individual record in Release Manager. Each test plan is linked to the features it is designed to validate.

Next, Quality Assurance creates test strategies, which are logical groupings of test plans. (For example, all test plans for one application module might be grouped together as a test strategy. Alternatively, all test plans to be executed on the same platform and browser combination might be grouped together as a test strategy.) Each completed test strategy is entered as an individual record in Release Manager. Each test strategy is linked to the test plans that it groups together.
After test strategies have been defined, Quality Assurance runs test plan executions, or test passes. Each test plan execution is logged as a test pass record. As the test passes are recorded, Quality Assurance links the test pass records to their respective test plans. Defects found during testing are recorded as change request records and linked to the test passes from which they were recorded.

During and after testing, Quality Assurance managers can run various reports on test pass results to monitor the health and progress of the product release effort.

Scenario for Technical Publications

As the other teams design, implement, and test the release features, Technical Publications writes technical documents to describe the product and explain how to use it. Each technical document is entered as an individual record in Release Manager. Each technical document is linked to the features it describes. Technical Publications then links an activity plan with standard milestones and deadlines to each technical document record. After the technical document records have been created, Technical Publications links the technical document files to their respective records as attachments.

Maintenance Scenario for Administrators

While release work is ongoing, the administrator may need to do certain maintenance tasks to make sure Release Manager continues to run smoothly for end users. After Engineering completes builds of the product, the administrator adds product prototype records for which Quality Assurance records tests. As product parameters change in the course of development, the administrator may need to add new Area and Subarea category combinations to add to Release Manager’s lists of values. When a new release cycle begins, the release administrator determines the need for new and revised test plans and test strategies.

Example Process Flow for Release Manager

This section presents an example process flow for setting up, using, and maintaining the Release Manager module. Topics include:

- Administrator Setup Procedures on page 447
- Product Marketing End-User Procedures on page 447
- Engineering End-User Procedures on page 447
- Quality Assurance End-User Procedures on page 447
- Technical Publications End-User Procedures on page 448
- Administrator Maintenance Procedures on page 448
Administrator Setup Procedures

Before end users can begin working with Release Manager, the administrator must set it up. The tasks applications administrators perform to set up Release Manager follow. You should do them in the order shown.

1. Set up releases. (See "Setting Up Releases" on page 449.)
2. Set up the access list. (See "Setting Up the Access List" on page 449.)
3. Set up project teams. (See "Setting Up Project Teams" on page 449.)
4. Set up activity templates. (See "Setting Up Activity Templates" on page 452.)
5. Set up lists of values. (See "Setting Up Lists of Values" on page 450.)

Product Marketing End-User Procedures

After the administrator has set up Release Manager, Product Marketing begins its work. The tasks that Product Marketing personnel perform when using Release Manager follow. You should do them in the order shown.

1. Create features and subfeatures. (See "Creating Features and Subfeatures" on page 453.)
2. Create MRDs. (See "Adding MRDs" on page 454.)
3. Associate features with MRDs. (See "Product Marketing End-User Procedures" on page 447.)

Engineering End-User Procedures

After Product Marketing has defined features, Engineering begins its work. The tasks that Engineering personnel perform when using Release Manager follow. You should do them in the order shown.

1. Add engineering tasks and associating features. (See "Adding Engineering Tasks and Linking Features" on page 456.)
2. Add subtasks. (See "Adding a Subtask to an Engineering Task" on page 457.)

Quality Assurance End-User Procedures

After Engineering has implemented tasks, Quality Assurance begins its work. The tasks that Quality Assurance personnel perform when using Release Manager follow. You should do them in the order shown.

1. Create test plans and associate features. (See "Creating Test Plans and Linking Features" on page 457.)
2. Create test strategies. (See "Creating Test Strategies" on page 459.)
3 **Associate test plans with test strategies.** (See “Recording a Test Pass and Linking a Test Plan” on page 460.)

4 **Record test pass results.** (See “Recording a Test Pass and Linking a Test Plan” on page 460.)

5 **Associate change requests with test passes.** (See “Associating Change Requests with a Test Pass” on page 461.)

6 **View test plan results.** (See “Monitoring Test Results” on page 461.)

---

**Technical Publications End-User Procedures**

After Product Marketing has written MRDs, Technical Publications begins its work. The tasks that Technical Publications personnel perform when using Release Manager follow. You should do them in the order shown.

1 **Create technical documents and linking features.** (See “Creating Technical Documents and Linking Features” on page 462.)

2 **Add activity plans to technical documents.** (See “Adding Activity Plans to Technical Documents” on page 463.)

---

**Administrator Maintenance Procedures**

While end users are working with Release Manager, the administrator must maintain it. The tasks that applications administrators and release administrators perform to maintain Release Manager follow. You can do them as needed, in any order.

1 **Add product prototypes.** (See “Adding Product Prototypes” on page 464.)

2 **Add new area and subarea combinations.** (See “Adding New Area and Subarea Combinations” on page 464.)

3 **Update test plans and test strategies.** (See “Updating Test Plans and Test Strategies” on page 465.)

---

**Administrator Setup Procedures for Release Manager**

Administrators must set up several areas of Release Manager in advance to make sure the application is usable for product marketers, quality assurance testers, engineers, and technical writers. Depending on your company’s structure and policies, these activities might be the duties of the organization’s Release Manager, Applications Administrator, or another person responsible for setting up the system. For convenience and brevity, this chapter refers to this person as the administrator.

This section provides instructions for the following procedures:

- Setting Up Releases on page 449
- Setting Up the Access List on page 449
Setting Up Releases

When entering a release item record, an end user must associate the item record with a particular release. In Release Manager, a release is a type of project, and releases are tracked in the same way as projects are in Siebel Professional Services. For more information about setting up projects, see Siebel Professional Services Automation Guide.

There are two types of releases, as follows:

- **Future Releases.** Because each release item must be associated with a particular release, you must set up the release (project) before entering any records. Though only one active release may be in progress, you must set up records for future releases as well. That way, if a feature is deferred from the current release, the product marketing manager can immediately target it to a specific future release.

- **Unspecified Releases.** There may be times when the appropriate future release for a given feature or other release item is unknown. Because all release items must be associated with a release, you should set up at least one artificial release called Unspecified Release or some similar term. Orphan release items can be linked to this release. When the appropriate future release has been determined, an item can then be retargeted to that release.

Setting Up the Access List

Release Manager is based on the Siebel Professional Services model for project management, which includes the concept of an access list. Each project has a group of people (the ones on its access list) who are associated with a release. To be on a release access list, an employee must be associated in your Siebel application with that release project.

To be added to an access list, a person must first be added as an employee in your Siebel application. For information about setting up employees, see Siebel Security Guide.

For information about adding employees to an access list, see the chapter on project management in Siebel Professional Services Automation Guide.

Setting Up Project Teams

Release Manager is based on the Siebel Professional Services model for project management, which includes the concept of project teams. Each project has a group of people (the project team) who own, approve, or otherwise are associated with each release item (feature, MRD, engineering task, QA test plan, QA test, or document). To be associated with any release item, an employee must be a member of the project team.
To be added to a project team, a person must first be added to the release access list. For more information, see “Setting Up the Access List.” For information about setting up project teams and adding employees to them, see the chapter on project management in Siebel Professional Services Automation Guide.

## Setting Up Lists of Values

The Siebel administrator is typically responsible for setting up lists of values (LOVs) for use in Siebel Business Applications. Although the Status field is shared by all types of release items, the LOVs for the Status field are likely to be specific to each release item.

For example, while the Status values for an engineering task typically relate to the development phase of the task (Unit Test, Final, and so on), the Status values for a technical publications document typically relate to the production phase of the document (Draft, Final Edit, and so on). To prevent end users from having to sift through long lists of values for phases that are related to their work, you may need to restrict the views in which specific lists of values appear.

For information on setting up LOVs and restricting the views associated with specific LOVs, see Siebel Applications Administration Guide.

Table 123 displays information about the LOVs to be set up before using Release Manager.

<table>
<thead>
<tr>
<th>View Label</th>
<th>Associated Release Items</th>
<th>Type</th>
<th>Usage</th>
<th>Typical Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client OS</td>
<td>QA Tests</td>
<td>PSTASK_CLIENT_OS</td>
<td>Type of operating system running on the client test machine.</td>
<td>Windows 2000, Mac OS</td>
</tr>
<tr>
<td>Client Type</td>
<td>QA Tests</td>
<td>PSTASK_CLIENT_TYPE</td>
<td>Type of test machine used by the tester.</td>
<td>Dedicated, HTML</td>
</tr>
<tr>
<td>Database</td>
<td>QA Tests</td>
<td>PSTASK_CLIENT_DB</td>
<td>Type of database running in the test environment.</td>
<td>IBM DB2, Microsoft SQL Server 7.0</td>
</tr>
<tr>
<td>Effort</td>
<td>Engineering Tasks</td>
<td>PSTASK_ENGINEER_EFFORT</td>
<td>Level of effort required of the engineer to complete the task.</td>
<td>High, Low, 1 Man Month</td>
</tr>
<tr>
<td>Priority</td>
<td>Features</td>
<td>PSTASK_PRIORITY</td>
<td>Relative importance of the feature.</td>
<td>High, Medium, P1-Critical</td>
</tr>
<tr>
<td>Revenue</td>
<td>Features</td>
<td>PSTASK_REVENUE</td>
<td>Amount of revenue that can be expected if the feature is implemented.</td>
<td>High, Low, &gt;5M, &lt;1M</td>
</tr>
</tbody>
</table>
### Table 123. Release Manager LOVs

<table>
<thead>
<tr>
<th>View Label</th>
<th>Associated Release Items</th>
<th>Type</th>
<th>Usage</th>
<th>Typical Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk</td>
<td>Engineering Tasks</td>
<td>PSTASK_ENGINEER_RISK</td>
<td>Level of risk to destabilizing the product by undertaking this engineering task.</td>
<td>High, Low</td>
</tr>
<tr>
<td>Server OS</td>
<td>QA Tests</td>
<td>PSTASK_SERVER_OS</td>
<td>Type of operating system running on the server.</td>
<td>Windows NT</td>
</tr>
<tr>
<td>Source</td>
<td>Features</td>
<td>PSTASK_SOURCE</td>
<td>Source of the feature.</td>
<td>Customer Input, Market Survey</td>
</tr>
<tr>
<td>Status</td>
<td>All</td>
<td>PSTASK_STATUS</td>
<td>Current implementation or development phase of the release item.</td>
<td>Draft, Unit Test, Final</td>
</tr>
<tr>
<td>Test Class</td>
<td>QA Tests</td>
<td>PS_QA_TEST_STRATEGY_TEST_CLASS</td>
<td>Sequence category of the test.</td>
<td>Certification Pass, Full Pass, Final Pass, Acceptance Pass, Browser Certification</td>
</tr>
<tr>
<td>Test Set</td>
<td>QA Tests</td>
<td>PS_QA_TEST_PLAN_TEST_SET</td>
<td>Product area to which the test was applied.</td>
<td>Install, Upgrade, Report, Charts, General</td>
</tr>
<tr>
<td>Type</td>
<td>QA Tests</td>
<td>PSTASK_ALT_TYPE</td>
<td>Type of test that was conducted.</td>
<td>Blitz, Ad Hoc, Detailed, White Glove</td>
</tr>
</tbody>
</table>

**NOTE:** In the preceding table, the Type value is the value of the picklist record in the Applications Administration List of Values view.
Special Tag LOVs
You must also add a list of values for the Special Tag field in the QA Test Plans view. Table 124 shows an example of how you might set the fields of several new LOV records to populate the Special Tag field with values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Record 1</th>
<th>Record 2</th>
<th>Record 3</th>
<th>Record 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>LOV_TYPE</td>
<td>PS_TEST_PLAN_SPEC_TAG</td>
<td>PS_TEST_PLAN_SPEC_TAG</td>
<td>PS_TEST_PLAN_SPEC_TAG</td>
</tr>
<tr>
<td>Display Value</td>
<td>PS_TEST_PLAN_SPEC_TAG</td>
<td>Browser Specific</td>
<td>EBIZ Specific</td>
<td>Config. Specific</td>
</tr>
<tr>
<td>Language Code</td>
<td>PS_TEST_PLAN_SPEC_TAG</td>
<td>Browser Specific</td>
<td>EBIZ Specific</td>
<td>Config. Specific</td>
</tr>
<tr>
<td>Language Name</td>
<td>English-American</td>
<td>English-American</td>
<td>English-American</td>
<td>English-American</td>
</tr>
<tr>
<td>Active</td>
<td>True</td>
<td>True</td>
<td>True</td>
<td>True</td>
</tr>
<tr>
<td>Replication Level</td>
<td>All</td>
<td>All</td>
<td>All</td>
<td>All</td>
</tr>
</tbody>
</table>

Setting Up Activity Templates
The QA and Technical Publications teams have access to activity templates. An activity template contains multiple predefined activities that can be associated with a release item. These templates save end users from having to enter each activity manually, and help to standardize activities for groups or teams. If end user teams need activity templates, create them before anyone uses Release Manager.

For information about how to create activity templates and add activities to them, see “Setting Up Field Service Activity Templates” on page 73.

Product Marketing End-User Procedures for Release Manager
After Release Manager is configured, product marketers can record the progress and results of their product design efforts into the system. Their managers can monitor the information they enter.

This section provides instructions for the following procedures:

- Creating Features and Subfeatures on page 453
- Adding MRDs on page 454
- Monitoring Features and MRDs on page 454
- Monitoring Release Items on page 454
Creating Features and Subfeatures

Product marketing managers can use Release Manager to enter new product features and, if appropriate, subfeature components of these features.

To add a feature and subfeature

1. Navigate to the Release screen > Features list view.
2. Add a new feature record and complete the fields, as needed.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Account that requested the feature or to which your company is contractually obligated to deliver the feature.</td>
</tr>
<tr>
<td>Area</td>
<td>Product area associated with the feature.</td>
</tr>
<tr>
<td>Associated Parties</td>
<td>Individuals associated with the feature. The product marketing manager responsible for the feature should be set as Primary.</td>
</tr>
<tr>
<td>EAT Completion Date</td>
<td>Engineering Acceptance Test completion date.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent feature to the current feature. You can use this field to set up an n-level hierarchy of parent features and child subfeatures. However, linking to a parent feature with the Parent field does not add this feature to the parent feature’s Subfeatures list.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of this feature relative to other features targeted for the same release.</td>
</tr>
<tr>
<td>Product Line</td>
<td>The list of product line choices depends on the selection in the Subarea field.</td>
</tr>
<tr>
<td>Release</td>
<td>Name or number of the product release for which the feature is a candidate.</td>
</tr>
<tr>
<td>Revenue</td>
<td>Indicator of the level of revenue tied to delivering this feature in the targeted release.</td>
</tr>
<tr>
<td>Source</td>
<td>Source of the idea for this feature.</td>
</tr>
<tr>
<td>Status</td>
<td>Shows color codes with the following meanings:</td>
</tr>
<tr>
<td></td>
<td>■ Green - Approved for the release</td>
</tr>
<tr>
<td></td>
<td>■ Yellow - May be included in the release</td>
</tr>
<tr>
<td></td>
<td>■ Red - Not included in the release</td>
</tr>
<tr>
<td>Subarea</td>
<td>Product subarea associated with the feature. The list of subarea choices depends on the selection in the Area field.</td>
</tr>
</tbody>
</table>

3. Drill down on the Feature field and click the Subfeatures subview tab if you want to add subfeatures to the feature.
4 Add subfeatures as appropriate.

**Adding MRDs**

Product marketing managers can group like features together into an MRD and track the development of the MRD in Release Manager. Authors of the MRDs can attach electronic copies to MRD records.

**To add an MRD and link features**

2. Add a new MRD record and complete the fields, as needed.
   
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Parties</td>
<td>Individuals associated with the MRD. The author should be set as Primary.</td>
</tr>
<tr>
<td>Release</td>
<td>Name or number of the product release with which the MRD is associated.</td>
</tr>
</tbody>
</table>

3. Drill down on the MRD # field and click the Features subview tab if you want to associate features to the MRD.
4. Add subfeatures as appropriate.

**Monitoring Features and MRDs**

As a release progresses, product marketing managers can use Release Manager to track the status of their features and the related release items. In addition, product marketing managers can monitor the features to make sure that important ones are not forgotten.

**Monitoring Release Items**

During the release process, product marketing managers can monitor features to make sure they meet the following criteria.

- They are properly specified with MRDs.
- They are implemented by engineering.
- They are tested against QA test plans.
- They are described in technical publications documents.
Product marketing managers can run queries to identify features that do not meet these criteria. The procedures that follow provide examples.

**Identifying Features Without Linked MRDs**

To query for features without corresponding MRDs, do the following.

**To identify features without linked MRDs**

2. Launch a query with the following parameters.
   - In the Release field, select the current release.
   - In the MRD field, enter `NOT(EXISTS(LIKE*))`.

**NOTE:** You can follow similar procedures to query for features without corresponding engineering tasks, test plans, or technical publications documents.

**Identifying Engineering Tasks Without Linked Features**

During the release process, engineering managers can monitor development plans to make sure their teams are not working on tasks that lack corresponding features. To query for engineering tasks without linked features, do the following.

**To identify engineering tasks without linked features**

1. Navigate to the Release screen > Engineering Tasks view.
2. Launch a query with the following parameters.
   - In the Release field, select the current release.
   - In the Related Features field, enter `NOT(EXISTS(LIKE*))`.

**NOTE:** You can follow similar procedures to query for MRDs, test plans, or technical publications documents without corresponding features.

**Engineering End-User Procedures for Release Manager**

After features and MRDs are entered in Release Manager, engineers can begin recording the progress and results of their development efforts into the system. Their managers can monitor the information the engineers enter.

This section provides instructions for the following procedures:

- Adding Engineering Tasks and Linking Features on page 456
- Adding a Subtask to an Engineering Task on page 457
Adding Engineering Tasks and Linking Features

After product marketing managers have entered some features and their corresponding MRDs into Release Manager, engineering managers can begin analyzing the development work and identifying the discrete tasks required to implement the features. These tasks can be entered directly into Release Manager. As engineering task records are created, they are linked to the features they are designed to implement.

The product marketing and engineering managers match the requested features with the available engineering resources. During this process, the relative importance of the features are weighed against the investment required to implement them. Some features may be deferred to a future release. The end result is a final set of release features for which the necessary engineering resources are available.

**To add an engineering task and link features**

1. Navigate to the Release screen > Feature Engineer Tasks view.
2. Add a new record and complete the fields, as needed.
   
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Parties</td>
<td>Individuals associated with the engineering task. The engineering manager responsible for the task should be set as Primary.</td>
</tr>
<tr>
<td>Code Review</td>
<td>For software releases. Date when the code review took place.</td>
</tr>
<tr>
<td>Comp %</td>
<td>Portion of the task that has been completed to date.</td>
</tr>
<tr>
<td>Design Review</td>
<td>Date when the design review took place.</td>
</tr>
<tr>
<td>Effort</td>
<td>Indicator of the level of effort required on the part of the engineer to complete the task.</td>
</tr>
<tr>
<td>Engineering Group</td>
<td>Engineering group responsible for the task. Usually, this is the group to which the engineering manager (owner) of the task belongs.</td>
</tr>
<tr>
<td>Parent Task</td>
<td>Parent task to the current task. You can use this field to set up a hierarchy of parent tasks and child subtasks.</td>
</tr>
<tr>
<td>Release</td>
<td>Name or number of the product release with which the engineering task is associated.</td>
</tr>
<tr>
<td>Risk</td>
<td>Level of risk of destabilizing the product by undertaking this engineering task.</td>
</tr>
<tr>
<td>Target Date</td>
<td>Date when the task is expected to be completed.</td>
</tr>
</tbody>
</table>

3. Drill down on the Task # field and click the Related Features field if you want to associate features to the engineering task.
4. Add related features as appropriate.
**Adding a Subtask to an Engineering Task**

If a task is a complex one with multiple components, Engineering enters each component as a subtask record, then links it to the main engineering task.

**To add a subtask to an engineering task**

1. Navigate to the Release screen > Engineer Task - Subtasks view.
2. Add a new record and complete the fields, as needed.

**Monitoring Engineering Tasks**

During the development process, engineering managers can use Release Manager to track the status of the tasks underway. Design reviews and (for software releases) code reviews can be conducted and recorded. For each task, the fraction completed and the target completion dates are logged so that potential issues can be flagged before they become critical.

**Quality Assurance End-User Procedures for Release Manager**

After engineering tasks are entered in Release Manager, QA testers can begin recording the progress and results of their testing efforts into the system. Their managers can monitor the information the QA testers enter.

This section provides instructions for the following procedures:

- Creating Test Plans and Linking Features on page 457
- Creating Test Strategies on page 459
- Recording a Test Pass and Linking a Test Plan on page 460
- Associating Change Requests with a Test Pass on page 461
- Monitoring Test Results on page 461

**Creating Test Plans and Linking Features**

After the features for a release have been identified, QA can begin revising existing test plans or developing new ones to exercise new product functionality. Test plan development is tracked in Release Manager, with the test plan available as an attachment to the record. Parties such as product marketers who are associated with the development of the test plan are linked to the record, and their approvals are recorded.
For each test plan, the fraction completed and the target completion dates are logged so that potential issues will be flagged before they become critical. The QA manager decides whether they need to run a particular test plan to validate one or more test strategies, and if so, specifies those strategies.

**To add a test plan and link features**

1. Navigate to the Release screen > Test Plan Administration view.
2. Add a new record and complete the fields, as needed.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% Auto</td>
<td>Percent of the test that is automated.</td>
</tr>
<tr>
<td>% Auto Horizontal</td>
<td>Percent of the horizontal version of the product for which the test is automated.</td>
</tr>
<tr>
<td>% Auto International</td>
<td>Percent of the international version of the product for which the test is automated.</td>
</tr>
<tr>
<td>% Auto Platforms</td>
<td>Percent of platforms for which the test is automated.</td>
</tr>
<tr>
<td>Auto Complete Date</td>
<td>Date the automated test is completed.</td>
</tr>
<tr>
<td>Automated</td>
<td>If selected, indicates this test is automated.</td>
</tr>
<tr>
<td>Complete %</td>
<td>Portion of the test plan that has been completed to date.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Automatically populated based on the values selected in the Area and Subarea fields.</td>
</tr>
<tr>
<td>QA Owner</td>
<td>Person responsible for doing the testing.</td>
</tr>
<tr>
<td>Release</td>
<td>Name or number of the product release with which this test plan is associated.</td>
</tr>
<tr>
<td>Special Tag</td>
<td>Tags defined by your company for convenience in grouping or querying tests. You can specify multiple tags. For information about defining special tags, see “Special Tag LOVs” on page 452.</td>
</tr>
<tr>
<td>Suggested Strategies</td>
<td>Test strategies to apply to this test plan. Available selections come from test strategy records entered in the Strategy Administration view. See “Creating Test Strategies” on page 459.</td>
</tr>
<tr>
<td>Tag Summary</td>
<td>Expanded area field that makes multiple tags visible in the view. For convenience in querying tags that are selected in, but that might not appear on the view in, the Special Tag field.</td>
</tr>
<tr>
<td>Target Date</td>
<td>Date when the test plan is expected to be completed.</td>
</tr>
<tr>
<td>Test Plan Owner</td>
<td>Individuals associated with the test plan. The author of the test plan should be set as Primary.</td>
</tr>
</tbody>
</table>
3. Click in the Related Feature field to select the features you want to link to this test plan.

### Adding Activity Plans to Test Plans

An activity plan derives from a predefined activity template. An activity template contains multiple predefined activities that can be associated with a release item. This saves end users from having to enter each activity manually, and helps to standardize activities for QA teams.

**To add an activity plan to a test plan**

1. Navigate to the Release screen > QA Test Plan Activity Plans view.
2. Select a test plan.
3. Add a new activity plan record and complete the fields, as needed.

   When you have associated the activity plan with the test plan, all the activities in the activity plan become associated with the test plan and appear in the Activities view.

### Creating Test Strategies

At the beginning of a release cycle, you define a set of criteria (or matrix) that identifies the various combinations for which any given QA test plan can be run. For example, the matrix for a software product might include criteria such as Server, Database, Browser, and so on. These criteria sets are known as test strategies.

**To create a test strategy**

1. Navigate to the Release screen > QA Test Strategies view.
2. From the visibility filter, choose Strategy Administration.
3 Add a new record and complete the other fields, as needed. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactivity</td>
<td>Specifies whether the test is either in High Interactivity Mode or in Standard Interactivity Mode.</td>
</tr>
<tr>
<td>Release</td>
<td>Name or number of the product release with which this test strategy is associated.</td>
</tr>
<tr>
<td>Test Class</td>
<td>Type of test pass to be done with this test strategy.</td>
</tr>
<tr>
<td>Web Srv App</td>
<td>Application that runs on the selected Web server.</td>
</tr>
</tbody>
</table>

After the test strategy is saved, it appears as a choice in the Suggested Strategies field in the Strategy Test Plan Admin view.

4 Drill down on the Title field to access the QA Test Plans view if you want to associate test plans with the test strategy.

5 Select the test plan you want to associate to the current test strategy.

**Recording a Test Pass and Linking a Test Plan**

After a QA test plan is complete and is associated with a test strategy, tests can be run to validate the test plan. Because test plans are linked to their features in Release Manager, QA managers can focus their teams’ efforts on those test plans that are associated with the greatest number of new features. As each test is executed, QA testers record the results in Release Manager. Each test pass is linked to the test plan that it executes.

*To record a test pass*

1 Navigate to the Release screen > QA Tests view.
2 Add a new record and complete the fields, as needed. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build</td>
<td>Product prototype that was tested.</td>
</tr>
<tr>
<td>Client OS</td>
<td>Type of operating system running on the client test machine.</td>
</tr>
<tr>
<td>Client Type</td>
<td>Type of test machine used by the tester.</td>
</tr>
<tr>
<td>Cover %</td>
<td>Portion of the test plan that was executed (covered) by this test.</td>
</tr>
<tr>
<td>Database</td>
<td>Type of database running in the test environment.</td>
</tr>
<tr>
<td>Date</td>
<td>Date when the test was conducted.</td>
</tr>
</tbody>
</table>
Click the Test Plan field if you want to associate tests with the test plan.

### Associating Change Requests with a Test Pass

While doing a test pass, QA testers encounter product defects and ideas for design improvements. QA testers record these defects and ideas as change request records and associate them with the test pass in which they were found.

**To associate a change request with a test pass**

1. Navigate to the Release screen > QA Test Defects view.
2. In the Change Requests view, select the CRs that you want to associate with the test pass.
   
   For information about entering change requests, see Chapter 14, "Quality."

### Monitoring Test Results

QA managers can then review test summary information to assess overall product quality and determine when the product is ready to ship.

In the QA Test Plans view, the number of executions (passes) of the test plan and the status as assessed by the tester the last time the test plan was executed. The more passes of the test plan and the higher the stability of the tested area, the greater the overall product quality.

QA managers can run queries on these fields to pinpoint areas of risk to product quality. To identify which new product features have been tested to only a minimum level, and which features may be unstable, do the following.
To identify features that are incompletely tested or unstable

1. Navigate to the Release screen > QA Test Plans view.

2. Create a query as specified in one of the following fields:
   - In the Passes field, enter \(< n\), where \(n\) is the minimum number of test iterations that you think is adequate at this point in the release.
     In each test plan the query returns, click the Related Features field to display the features that are at risk because they have not been fully tested.
   - In the Last Build field, enter Unstable or another value listed in the Status field on the QA Tests subview that represents a low-quality assessment.
     In each test plan the query returns, click the Related Features field to display the features that are at risk because they may not have been functional in the most recent test.

Technical Publications End-User Procedures for Release Manager

As design, development, and test data are entered in Release Manager, technical writers can begin recording the progress and results of their documentation efforts into the system. Their managers can monitor the information they enter.

This section provides instructions for the following procedures:

- Creating Technical Documents and Linking Features on page 462
- Adding Activity Plans to Technical Documents on page 463

Creating Technical Documents and Linking Features

After release features have been identified, Technical Publications can begin revising existing documentation or developing new documents to describe new product functionality.

Documentation development is tracked in Release Manager, with the document available as an attachment to the record. Associated features are linked to the document. Product marketers who may be associated with the development of the document are linked to the record, and their approvals are recorded. For each document, the fraction completed and the target completion date are logged so that potential issues can be flagged before they become critical.

To add a document

2 Add a new record and complete the fields, as needed.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Parties</td>
<td>Individuals associated with development of the document. The author should be set as Primary.</td>
</tr>
<tr>
<td>Complete %</td>
<td>Portion of the document that has been completed to date.</td>
</tr>
<tr>
<td>Est Pages</td>
<td>Estimated number of pages for the completed document.</td>
</tr>
<tr>
<td>New %</td>
<td>Portion of the document that will be new in this version.</td>
</tr>
<tr>
<td>Release</td>
<td>Name or number of the product release with which the document is associated.</td>
</tr>
<tr>
<td>Target Date</td>
<td>Date when the document is expected to be completed.</td>
</tr>
</tbody>
</table>

**Adding Activity Plans to Technical Documents**

An activity plan derives from a predefined activity template. An activity template contains multiple predefined activities that can be associated with a release item. These activity templates save end users from having to enter each activity manually, and helps to standardize activities for technical publications teams.

**To add an activity plan to a technical document**

2. Select a technical document record.
3. In the Activity Plans view, add a new record and complete the fields, as needed.

When you have associated the activity plan with the technical document, all the activities in the activity plan become associated with the technical document and appear in the Activities view.

**Administrator Maintenance Procedures for Release Manager**

You must perform some Release Manager maintenance tasks on an as-needed basis. These tasks are your ongoing responsibility.

This section provides instructions for the following procedures:

- Adding Product Prototypes on page 464
- Synchronizing with Microsoft Project on page 464
- Adding New Area and Subarea Combinations on page 464
- Updating Test Plans and Test Strategies on page 465
Adding Product Prototypes

As a product progresses through the release cycle, increasingly advanced product prototypes become available for testing. (In the case of software development, these prototypes are known as builds.) When QA testers execute a test plan, they select the version number of each tested prototype. As each new prototype becomes available, you are responsible for entering it into Release Manager so that QA can record tests for it.

You enter builds as products in the Quality screen, Release Product Administration view.

Synchronizing with Microsoft Project

Some engineering organizations use resource planning tools such as Microsoft Project to develop project plans. Each line item in such a project plan corresponds to an engineering task in Release Manager.

For engineering organizations that use Microsoft Project to manage project plans, Release Manager offers Microsoft Project integration. Engineering tasks can be tracked in Microsoft Project and then synchronized with Release Manager, eliminating the need to enter and update the same information in both applications.

For information on setting up the required mappings and synchronizing Microsoft Project with Siebel Business Applications, see the chapter about Microsoft Project integration in Siebel Professional Services Automation Guide.

Adding New Area and Subarea Combinations

Area and Subarea fields are linked so that the values available in the Subarea field change dynamically according to the value selected in the Area field. These lists of values appear in both the Release Manager and Quality modules of your Siebel application. In Release Manager, an area value is associated with a feature.

As product parameters change in the course of development, you may need to add new Area and Subarea combinations to Release Manager.

To add an area and subarea combination

1. Navigate to the Quality screen > Quality Administration view.
2 Create a new record for each area and subarea combination and complete the fields, as needed. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Line</td>
<td>Grouping of products with which this Area and Subarea combination is associated.</td>
</tr>
<tr>
<td>QA Owner</td>
<td>Quality Assurance team owner with which this Area and Subarea combination is associated.</td>
</tr>
<tr>
<td>Engineering Group</td>
<td>Engineering team with which this Area and Subarea combination is associated.</td>
</tr>
</tbody>
</table>

**NOTE:** Because of the mappings created by Area records in this view, when a feature record is added, selecting a value in the Area field automatically populates the Subarea, Product Line, QA Owner, and Engineering Group fields.

### Updating Test Plans and Test Strategies

When a new release cycle begins, some test plans and test strategies from the previous release are relevant to the new release, while some are not. Existing test plans and test strategies must be sifted for relevance to the new release, and the relevant ones updated. Gaps in the existing resources must be identified and filled with new test plans and test strategies. These are ongoing tasks for a QA Release Administrator.

For information about adding and linking test plans and test strategies, see "Quality Assurance End-User Procedures” on page 447.
This chapter describes the capabilities in Siebel Field Service for tracking and managing assets. Field Service also provides for automating the collection of data from assets in the field, providing information for preventive maintenance, repairs, billing, and marketing. Topics include:

- Properties of Assets on page 467
- Setting Up Assets on page 470
- Obtaining Asset Information on page 477
- Asset Dispatch Board on page 480
- Administration - Pricing Screen on page 483
- Assets Screen on page 484

## Properties of Assets

An asset in Siebel Field Service is an instance of a product that has an individual identity and an association with a customer. An asset can be created for any product by assigning it a unique asset number. An asset has a quantity, a location, and a monetary value. An asset is associated with a product and an organization. Topics include:

- Asset Serialization on page 468
- Asset Registration on page 469
- Hierarchical Assets on page 469
- Asset Transactions on page 469
- Asset Swaps on page 470

In Siebel Field Service, assets have these additional properties:

- Assets can be physical or virtual.
- Assets can have serial numbers.
- Assets can exist individually or they can have components.
- Assets can be related to or dependent upon other assets.
- Teams of employees can be associated with an asset.

Assets can be associated with other Siebel business objects as well as with internal data and calculations. Some examples are as follows:

- Assets can contain a hierarchy of other assets as components. There is no restriction on the number of tiers and the number of components that comprise a multitiered asset.
Actions such as install, uninstall, upgrade, or downgrade can be performed on an asset. These actions can be recorded as asset transactions.

The same asset can have different products over time. For example, the product on which an asset is based may become obsolete and be replaced with a different product. In this case, the same asset record can remain in your Siebel application, but the product with which it is associated can be changed.

When an asset is serviced, service requests, preventive maintenance records, and repair records can be associated with the asset, and a service history is maintained for that asset.

Assets can have multiple types of measurements set up, including gauges, counters and sensors. Each measurement can have multiple readings recorded manually or automatically and stored for diagnosis or for usage tracking.

The current value of an asset can be calculated or revalued and stored based on its condition, value basis, and cost method.

**Asset Serialization**

Not every asset requires a serial number. If an asset requires a serial number, it is known as *serialized*.

If an asset is serialized, then a serial number is required for all movements and transactions for this asset, including the following:

- Inventory transactions
- Field part movements
- Cycle counts
- Shipments
- Receipts

For all inventory transactions involving serialized products, an asset is considered equivalent to one part (quantity = 1).

If a product is serialized, then the assets of this product must also be serialized. However, an asset can be an instance of a nonserialized product and still have a serial number. For more information, see "Product Service Details View" on page 338.

Serialized assets are treated differently from nonserialized ones. For example, whenever serialized assets are shipped or received, Siebel Field Service expects the right number of assets with matching serial numbers.
Asset Registration

An asset can be associated with an account, an account site, an owner, and one or more contacts. If a customer buys an asset, then the owner and the account are the same. If, however, the asset is leased or rented, then the account is where the asset is located, and the owner is the lessor or rental agent for the asset. All registered assets for an account can be viewed from the Accounts screen.

Hierarchical Assets

Assets can be hierarchical with other asset components.

A hierarchical asset is an asset with a hierarchical structure consisting of asset or product components. The hierarchical structure of a complex asset can consist of multiple levels and sub-levels of asset or product components and sub-components. There is no restriction on the number of levels or the number of components that can comprise a complex hierarchical asset. Asset components can be serialized or nonserialized. For example, a computer is a parent asset that has child assets: a motherboard (Part # M, Qty 1, Serial # 123), RAM (Part # RAM, Qty 16, no Serial #), and so on.

A customizable asset is an asset that is instantiated from a configurable product. It can be customized by Configurator. For information about configurable products, see Siebel Product Administration Guide.

Components of a hierarchical asset inherit some properties of the top-level asset. Changing the following fields of the top or parent level asset of a hierarchical asset changes the same fields in all installed components: Account (and all Account-related fields; for example, Site, Address Line 1, and so on), Owner, Ownership, and Organization.

Inheritance applies whether the change is initiated by a user action or by an automated process. Changes to the components occur when a user updates the fields mentioned in the previous paragraph and the record is saved. Only the top-level asset's fields can be updated. The fields of component assets are read-only.

Siebel Field Service offers views to display complex asset hierarchies. For more information, see “Explorer View” on page 490 and “Explorer Across Organizations View” on page 491.

Asset Transactions

The installed base or BOM for an asset is maintained with asset transactions of the types Install, Uninstall, Upgrade, and Downgrade. These transactions must be created manually.

For example, a computer (asset A) has a defective disk drive (asset H) that must be replaced with another disk drive (asset N). The change is effected by two asset transactions. The first uninstalls the defective asset (H) from the parent asset (A). The second installs the new part (N) in the parent asset (A).

If an asset has components, a transaction performed for that asset automatically includes its components.
Some asset transactions change inventory levels directly. For details, see "Mobile Inventory Transactions" on page 359.

**Asset Swaps**

Service activities often include the replacement of one asset with another. When replacing an asset, the field service engineer records the replacement in the Part Tracker view of the Activities screen. For more information, see "To record the swapping of one asset for another on page 77. If the installed asset is an instance of the same product or product component as the uninstalled asset, the replacement can be recorded as a swap.

When two assets are swapped, the warranties and entitlements of the uninstalled asset can be transferred to the installed asset on a pro-rata basis. For this transfer to occur, the assets should be root assets and the transferable flags—one for warranties and one for entitlements—need to be set before the swap can be recorded in Part Tracker. For more information about the transferable flags, see "Warranties View" on page 498 and "Entitlements Screen" on page 260.

**NOTE:** A warranty transfer and an entitlement transfer are executed in slightly different ways if the uninstalled and installed assets in the swap are instances of different products or product components. In this case, the warranties of the installed asset’s product are in effect. For contracts which include entitlements for the removed asset, those entitlements’ asset values on the Service Agreement Product business component are updated with the installed asset’s number, replacing the asset number of the uninstalled asset. When this business component is updated, the Asset # field on the Agreements screen > List > Entitlements > Products view changes to display the new asset. The result is that the warranties and entitlements are automatically in place for the installed asset.

Asset swaps also transfer any hierarchical relationships from the uninstalled asset to the installed asset, with one exception. The exception is that if an uninstalled asset is a child asset, the uninstalled asset’s parent becomes the installed asset’s parent, but the uninstalled asset keeps its child(ren), if any.

**Asset Swaps Business Service**

The FS Asset Swap Service business service is used during asset exchange. Using the business service methods, the warranties and entitlements of the uninstalled asset can be transferred to the installed asset. See "FS Asset Swap Service Business Service“ on page 552 for more information on this business service.

**Setting Up Assets**

This section describes how to set up assets. Topics include:

- Creating Transactions and Components on page 472
- Creating a Hierarchical Asset from a Product Bundle on page 472
- To associate a preventive maintenance plan with an asset on page 471
- Defining Field Engineer Assignments on page 472
Follow these procedures to set up assets.

**To create an asset**
1. Navigate to the Assets screen > List view.
2. Create a new record and complete the fields as appropriate.

   **NOTE:** If a predefined query on the Assets screen > List view limits the displayed records to a subset of all the assets, create an asset with a customizable product and click Customize to refresh the view. This causes the new asset record to disappear from the visible part of the view. To find the record again, you must query for it, then click Customize again to complete the configuration.

   For more information about the Customize button, see “Assets View” on page 485.

**To associate change requests with an asset**
1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Change Requests view tab.
3. Create a new record and complete the fields as appropriate.

**To associate a backup or dependent asset with a primary asset**
1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Relationships view tab.
3. Create a new record and complete the fields as appropriate.

**To associate an asset with an account**
1. Navigate to the Accounts screen > Assets view.
2. Query for the account record in the Account form.
3. In the Assets list, create a new asset record and complete the fields as appropriate.

**To associate a preventive maintenance plan with an asset**
1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Preventive Maintenance view tab.
3. Click Plans in the link bar.
4. Create a new record and complete the fields as appropriate.

   See “Preventive Maintenance View” on page 489 for more information.
Creating Transactions and Components

End users must create transactions to add components to an asset.

To manually associate a transaction with an asset

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset, and then click the Transactions view tab.
3. Create a new record and complete the fields as appropriate.

To create components

1. Follow the steps of “To manually associate a transaction with an asset.”
2. In the Type field, select Install as the transaction type. Then click the Components view tab.
   The asset selected in the transaction record appears in the Components list for the primary asset.

Creating a Hierarchical Asset from a Product Bundle

You can generate a hierarchical asset from a product bundle. For information about hierarchical assets, see “Hierarchical Assets” on page 469.

To generate a hierarchical asset from a product bundle

1. Navigate to the Assets screen > List view.
2. Add an asset record. In the Product field, select a product bundle, and then complete the other fields as appropriate.
3. Drill down on the selected asset record, and click the Components tab.
   The Components list shows the asset components created from the child products in the product bundle.

CAUTION: To successfully generate a hierarchical asset, a product bundle can consist only of parent and child products; for example, a laptop computer that comes with a CD-ROM drive. It cannot include grandchild products; for example, an airplane that comes with an engine, which in turn comes with a fuel tank.

Defining Field Engineer Assignments

Teams of employees can be assigned to particular assets and accounts. An asset service team can be set up for field service environments where there are large pieces of equipment and where it may be a requirement that the same individuals work on a given set of equipment. When you have assigned the appropriate field engineers to an asset, you can then define primary, secondary, or tertiary role priorities for each engineer.
An *account service team* is a team of service personnel associated with a particular account or a particular account site. This team either works at the account site or is called in for breaks, fixes, preventive maintenance, or related tasks at the site. The service personnel are then ranked as primary, secondary, or tertiary to make sure that sufficient coverage is available. These defined role priorities are used to assign activities to appropriate candidates.

When you assign teams of employees to a particular asset or account, service to customers can be expedited because:

- Customers know the background of the installation and how the activities are typically divided up between the team.
- Customers know their service team and whom to contact if a service requirement arises.
- Special clearances and other entry requirements for secured locations can be taken care of once for the assigned team, rather than several times for different individuals.

This topic includes the following related subtopics:

- Creating Asset Service Teams on page 473
- Adding Role Priorities to Asset Service Team Employees on page 474
- Account Service Team Configuration on page 474
- Creating Account Service Teams on page 474
- Adding Role Priorities to Account Service Team Employees on page 475
- Using Role Priorities When Defining Assignment Rules on page 475

**Creating Asset Service Teams**

Perform the steps in the following procedures to associate employees with an asset, creating an asset service team.

**To associate employees with an asset**

1. Navigate to the Assets screen > List view.
2. Select an asset record.
3. Scroll down to the Asset form.
4. In the Employees field, click the select button and select the appropriate field service engineers. To view a list of the selected employees, navigate to the Assets screen > List > Employees view. The Employees list shows the list of selected engineers.

**NOTE:** To associate skills with employees, see *Siebel Assignment Manager Administration Guide* for more information.
Adding Role Priorities to Asset Service Team Employees

Different levels of role priority can be assigned to employees associated with an asset. When dispatchers assign an activity relating to the particular asset, the primary, secondary, and tertiary candidates appear in ascending order of assignment scores received. See "Role Priorities" on page 119 for more information on using role priorities to assign activities.

Role priorities can also be used by assignment rules to support prioritized assignment of primary, secondary and tertiary field engineers, where primary engineers achieve the highest score, then the secondary, and finally, the tertiary engineer. For more information on how candidates are defined for assignment rules, see "Using Role Priorities When Defining Assignment Rules" on page 475 and Siebel Assignment Manager Administration Guide.

Perform the steps in the following procedure to assign roles to asset service team employees.

**NOTE:** This procedure assumes that employees have already been associated with the asset. If you have not yet associated employees with the asset, see “To associate employees with an asset” on page 473 for more information.

To assign role priorities to asset service team employees

1. Navigate to the Assets screen > Employees view.
2. In the Asset form, query for the appropriate asset record.
   - The Employees list updates to display the employees associated with this asset.
3. In the Role field, select a primary, secondary, or tertiary role from the drop-down list for each employee.

Account Service Team Configuration

If account service teams are required for your company’s service delivery model, then the Employee Account business component must be configured. There are no applets defined for this business component, which means that the appropriate applets and views must be configured using Siebel Tools. For an example of how this view could appear, navigate to the Asset screen > Employees view. See Configuring Siebel Business Applications for more information about adding views to an application.

**NOTE:** Membership of an account service team does not have any impact on account visibility. This means that even if an employee is part of an account’s service team, the particular account may not be displayed to this employee using the My Accounts visibility filter. To make the account visible to the employee, the appropriate position must be added using the Account Team Members dialog box. This dialog box is displayed when you navigate to the Accounts screen > Accounts List view and click the select button.

Creating Account Service Teams

When you have configured the applets and views so that Field Service now includes an Accounts screen > Employees view (similar to the Asset screen > Employees view), the account service team can be created. The procedure for this should be similar to that described in “To associate employees with an asset” on page 473.
Adding Role Priorities to Account Service Team Employees
Role priorities for an account service team identify the primary, secondary or tertiary engineer who would assist the account for the requested service activity.

When you have created an account service team, you can then add role priorities for each employee. The procedure for this should be similar to that described in “To assign role priorities to asset service team employees” on page 474.

Role priorities can be used when defining assignment rules in Assignment Manager. For more information, see “Using Role Priorities When Defining Assignment Rules” on page 475. See also “Role Priorities” on page 119 for more information on using role priorities to assign activities.

Using Role Priorities When Defining Assignment Rules
Role priorities can also be used in assignment rules to support prioritized assignment of primary, secondary and tertiary field engineers, where primary engineers achieve the highest score, then the secondary, and finally, the tertiary engineer.

Once role priorities have been assigned to asset or account service team employees, assignment rules that are based on these priorities can be defined within Assignment Manager. Assignment Manager uses these assignment rules to determine dynamic candidates. Dynamic candidates are potential assignees for activities. See “How Are Dynamic Candidates Used by an End User?” on page 476 for more information.

For example, if you associate an activity with an asset, and that asset has a team of employees, you can configure Assignment Manager to automatically consider these employees (team) for an activity and have the same employees available as potential candidates for other activities. These employees are known as the dynamic candidates.

For more information on how dynamic candidates are determined for activities see Siebel Assignment Manager Administration Guide.

To define an asset service team assignment rule
1 Navigate to the Administration - Assignment screen > Assignment Rules List view.
2 Create a new assignment rule record and complete the fields as appropriate, making sure that you select Activity from the Objects to be Assigned drop-down list.
3 Drill down on the Name field.
4 In the Assignment Rule form, select Activity Asset Team from the Person Candidates Source drop-down list.
5 Scroll down to the Criteria list and create a new record.
6 In the Rule Criterion field, select Asset Team Relationship Type from the drop-down list.
7 In the Comparison Method, select Compare to Person from the drop-down list.
8 Scroll down to the Asset Team Relationship Type list.
9 Create three new records, one each for Primary, Secondary, and Tertiary and allot scores for each. For example, 100, 50, and 25 respectively.
To define an account service team assignment rule

1. Follow Step 1 to Step 5 in “To define an asset service team assignment rule” on page 475.
2. In the Rule Criterion field, select Account Team Relationship Type from the drop-down list.
3. In the Comparison Method, select Compare to Person from the drop-down list.
4. Scroll down to the Account Team Relationship Type list.
5. Create three new records, one each for Primary, Secondary, and Tertiary and allot scores for each. For example, 100, 50, and 25 respectively.

How Are Dynamic Candidates Used by an End User?

When the asset or account service team assignment have been created, Assignment Manager controls the candidates that are presented for selection to, for example, the dispatcher.

When the dispatcher creates a new activity on the Activities screen, an asset can be specified for the activity. When the dispatcher selects Assign from the menu button’s drop-down list, the assignment rules determine that only certain employees are shown for selection. The employees that are displayed are displayed in accordance with their roles, the primary candidates receiving higher scores than secondary and tertiary. Using this information, the dispatcher can select the most appropriate candidate for the activity.

Asset Mapping

Asset mapping records the factors that adjust the cost of assets. Adjustments depend on the Condition, Value Basis, Cost List, and Cost Method fields for each asset. These factors are used to calculate the Asset Values and the Replacement Costs on the Asset Valuation screen.

For more information, see Siebel Pricing Administration Guide.

NOTE: Asset mapping applies to product lines and to all assets that belong to the same product line and cost list.

Defining Asset Measurements

Measurements are defined for a product and apply to the assets of that product.

To define measurements for assets

1. Navigate to the Administration - Product screen > Products view.
2. Drill down on the Product field of a selected product and click the More Info view tab.
3. From the visibility filter, select Product Measurements.
4. Create a new record and complete the fields as appropriate.
Obtaining Asset Information

This section describes how to obtain information about assets. Topics include:

- Calculating the Value and Cost of an Asset on page 478
- Associating Measurements with Assets on page 479
- Recording Readings from Assets on page 479

Follow these procedures to obtain information about assets.

To review all change requests for a selected asset

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Change Requests view tab.

To review all repairs for a selected asset

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Repairs view tab.

To review all activities associated with an asset

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Activities view tab.

To review preventive maintenance activities associated with an asset

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Preventive Maintenance view tab.
3. Click History in the link bar.

To view the status of a preventive maintenance plan for an asset

1. Navigate to the Assets screen.
2. Drill down on the Asset # field for a selected asset and click the Preventive Maintenance view tab.
3. Click Plans in the link bar.

To view an asset hierarchy

1. Navigate to the Assets screen > List view.
2. In the link bar, do one of the following:
   - To view assets associated with your organization, click Assets Explorer.
To view assets associated with all organizations, click Assets Explorer Across Organizations.

In the explorer list in the left pane, click the plus sign (+) in front of each asset to see a hierarchical list of its components.

Calculating the Value and Cost of an Asset

Follow these procedures to calculate the costs and value of assets.

Calculating Adjusted Cost

The following procedure calculates the adjusted cost of an asset from the original cost, plus the value of enhancements, minus the value of depreciation, write-downs, and so on.

To calculate the adjusted cost of an asset

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Value view tab.
   - a. In the Original Cost field, enter the original cost, if necessary.
   - b. In the Value Basis field, select Adjusted.
   - c. In the Condition field, select the asset’s condition.
3. For an action that affects the value of the selected asset, create a new record in the Asset Valuation subview and complete the fields as appropriate.
4. On the Value form, click Recost.

   Field Service calculates and returns the Adjustment amount and Adjusted Cost to the corresponding fields on the Value form. The adjusted cost is calculated as the original cost, plus or minus the sum of values in the Amount column of the Asset Valuation subview. The calculation also includes a factor for the asset’s condition. For more information, see “Asset Mapping” on page 476.

Calculating Value-Based Cost

The following method of determining the cost of an asset uses the value basis for the asset. These variables are defined in the “Asset Mapping View” on page 484.

To calculate the value and replacement cost of an asset

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset that has one or more associated cost lists.

   NOTE: An asset is associated with a cost list through the product on which it is based. To display the selected cost list’s associated products, navigate to Administration - Pricing screen > Cost Lists view and click the Cost List Line Items tab.
3 Click the Value view tab. Then in the Cost List field, select a cost list.

4 In the Value Basis field, select a value other than Adjusted and click Recost.

Field Service calculates and returns the Asset Value and Replacement Cost to the corresponding fields on the Value form. The calculation is done by one of the following methods:

- Asset Value = Factor * Original Cost
- Replacement Cost = Factor * Cost List Value of Product

**NOTE:** To specify which method to use for the value-based cost calculation, navigate to the Administration - Pricing screen > Cost List view and click the Asset Mapping view tab. In the Cost Field, select Asset Value or Replacement. For more information, see “Asset Mapping” on page 476.

### Associating Measurements with Assets

Measurements associated with a product are not automatically associated with assets of the product. Follow this procedure to associate measurements with assets.

**To associate measurements with an asset**

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Measurements view tab.
3. Create a new record and complete the fields as appropriate.

**NOTE:** You are only allowed to select measurement types that are already defined for the product. To define the measurement types that are associated with assets, see “To define measurements for assets” on page 476.

### Recording Readings from Assets

Follow these procedures to record readings of measurements from assets.

**To record a reading for an asset**

1. Navigate to the Assets screen > List view.
2. Drill down on the Asset # field for a selected asset and click the Readings view tab.
3 In the Readings form, create a new record and complete the fields as appropriate. The record becomes read-only. The Done check box must be selected in order for the reading to be charted.

**CAUTION:** When an asset is created, the Measurement Type records are copied over from the Product table into the Asset Table. It is common that measurement types (upper limit, lower limit, and so on) change when products are upgraded. However, assets may not be upgraded to the next version of product and would retain the measurement types of the original product. If the product of an asset has been changed after the asset was created, then measurement types that are not defined for the current product may remain associated with the asset. Therefore, it is recommended that you validate measurement types between the asset and its product when you change the product. Otherwise, it is possible to record a measurement that is invalid for the asset. It is also recommended that the Assets screen only be accessible to a user with the Service Manager responsibility, and exclude field engineers. Field engineers can enter readings using the Activities screen > Readings view.

**To record a reading for an asset associated with a selected activity**

1. Navigate to the Activities screen > List view.
2. Drill down on the Type field for a selected activity with an associated asset and click the Readings view tab.
3. In the Readings form, create a new record and complete the fields as appropriate.

**To analyze the results of readings for a selected asset**

1. Navigate to the Assets screen > List view.
2. Select an asset and in the link bar, click Charts.
3. In the Charts list, select a measurement type record.
4. In the Measurement Analysis subview, select the reading you want to measure.

**Asset Dispatch Board**

The Asset Dispatch Board provides a drag-and-drop interface for the manual scheduling of asset-related activities.

**Setting User Preferences for the Asset Dispatch Board**

Asset Dispatch Board user preferences are available by navigating to User Preferences > Asset Dispatch Board. For details on settings, see Setting User Preferences for the Dispatch Board on page 178.
Asset Dispatch Board Screen Interface

The Asset Dispatch Board has two sections:

- Gantt chart (top)
- Unscheduled Activities list (bottom)

To schedule activities, users drag-and-drop activities from the Unscheduled Activities list onto the Gantt chart. To unschedule activities, users drag the activity from the Gantt chart back to the Unscheduled Activities list.

Gantt Chart

The Gantt chart shows the scheduled and unscheduled time periods for the asset records. The chart is divided by a frames boundary into left and right frames.

The left frame lists assets and the related products and accounts. The right frame shows scheduled activities in different time periods. The right frame of the Gantt chart appears in a calendar format. Scheduled activities are shown with colors that represent its priority, status, and type. For more information, see “Setting User Preferences for the Dispatch Board” on page 178. The user preferences that are set for the Dispatch Board are also applied to the Asset Dispatch Board.

In the left frame, users can drill down on the Asset # field to quickly navigate to the Assets screen > List > Activities view. Drill down on the Product field to navigate to the Products screen > Internal Product List view. Drill down on the Account field to navigate to the All Accounts Across Organizations view.

User can also drill down on an activity’s time bar in the right frame to navigate directly to the Activities screen > Activity List > Schedule view.

Unscheduled Activities List

The Unscheduled Activities list displays all activities that have a status of Unscheduled. Users can create new activities directly from this list. This list provides the same drag-and-drop features as the Dispatch Board Unscheduled Activities list. See “Unscheduled Activities List” on page 175 for more information.

Users can drill down on the Type field to quickly navigate to the Activities screen > Activity List > Schedule view. Drill down on the Account field to navigate to the Accounts screen > Contacts view.

Using the Information Display Controls in the Gantt Chart

Users can change the way that information appears in the Asset Dispatch Board using various controls.
Date Field
The date displayed in the field at the top of the Gantt chart is the date to which the information currently shown relates. Users can enter new dates in this field to change the day for which information is displayed in the chart.

To change the date displayed in the Gantt chart
1. Click the date drop-down list to select the start day for the chart.
2. Click Go when you have selected a date.
   The Gantt chart refreshes to display the specified date.

Time Zoom Intervals
Users can change the time intervals shown in the Gantt chart using the time zoom interval buttons.

To change the time intervals displayed
- Click the appropriate time zoom interval button.
  The Gantt chart refreshes to display the time axis divided into the appropriate time intervals.
  The time zoom intervals are:
  - 1/4. Click this time interval button to display the Gantt chart with the time axis divided into quarter-hour intervals.
  - 1/2. Click this time interval button to display the Gantt chart with the time axis divided into half-hour intervals.
  - 1. Click this time interval button to display the Gantt chart with the time axis divided into hourly intervals.
  - 2. Click this time interval button to display the Gantt chart with the time axis divided into two-hour intervals.
  - 4. Click this time interval button to display the Gantt chart with the time axis divided into four-hour intervals.

Querying for Assets in the Gantt Chart
Users can use the query assistant to display only the required assets in the Gantt chart.

To query for a particular asset on the Gantt chart
1. On the Asset Dispatch Board’s Gantt chart, click Query.
   The Gantt chart refreshes to display a Query Assistant and Cancel button.
2. Click the Query Assistant button.
   The query assistant appears.
3. Select Asset # from the drop-down list

**NOTE:** You can only enter query parameters for the Asset # field.

### Viewing ToolTip Information in the Gantt Chart

Users can view a summary of asset activity details through the ToolTip feature.

**To view a summary of activity details**
- Position the mouse pointer over the activity in the Gantt chart, and in the ToolTip that appears, review details such as:
  - Activity number
  - Type
  - Status
  - Account name
  - Priority
  - Latest start
  - Duration in minutes
  - Description
  - Planned end

### Scheduling Asset Activities

Users can schedule activities by dragging-and-dropping an activity record from the Unscheduled Activities list to the Gantt chart.

**To schedule an activity for an asset**
1. Navigate to the Asset screen > Dispatch Board view.
2. In the Date field, enter the date for which you want to schedule activities.
3. Make sure that the asset for which you want to schedule activities is displayed in the Gantt chart.
4. In the Unscheduled Activities list, select an activity record.
5. Drag the activity to the Gantt chart and drop it onto the appropriate asset and time interval.

### Administration - Pricing Screen

The Administration - Pricing screen has one view for configuring the calculation of an asset’s value. To see this view, navigate to the Administration - Pricing screen > Cost List view, and then click the Asset Mapping view tab.
Asset Mapping View

The Asset Mapping view records the factor (percentage) that is used to adjust the cost of an asset. These factors are used to calculate the Asset Values and the Replacement Costs in the Value view. For more information, see "Value View" on page 486. Table 125 describes items in Asset Mapping records.

Table 125. Selected Items in the Asset Mapping View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Field</td>
<td>The field in the Asset Value view to which this calculation applies; for example, Asset Value or Replacement Cost.</td>
</tr>
<tr>
<td>Factor</td>
<td>A percentage of the cost, from the cost list, for the selected asset. If a mapping is unspecified, the factor defaults to 100%.</td>
</tr>
</tbody>
</table>

Asset mapping values apply to specific cost lists at the level of product lines (including their hierarchies of products and assets). Each combination of cost field, cost list, product line, condition, value basis, and cost method can have a record for asset mapping.

For a complete description of costs lists and asset mapping, see Siebel Pricing Administration Guide.

Assets Screen

The Assets screen records all information about assets, including service and repair history, components, associated activities, and preventive maintenance. Topics include:

- Assets View on page 485
- Activities View on page 486
- Employees View on page 486
- Warranty View on page 486
- Value View on page 486
- Readings View on page 487
- Charts View on page 487
- Components View on page 487
- Transactions View on page 487
- Change Requests View on page 488
- Repairs View on page 488
- Relationships View on page 488
- Measurements View on page 488
- Preventive Maintenance View on page 489
Assets View

The Assets view defines assets. Some fields in the Assets view are described in Table 126.

Table 126. Selected Fields in the Assets View

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serialized</td>
<td>Selected if the product selected is a serialized product. Read-only in the Assets screen.</td>
</tr>
<tr>
<td>Reference</td>
<td>Indicates that the asset can be referenced to customers or to other vendors, depending on the organization’s business process.</td>
</tr>
<tr>
<td>Operating Status</td>
<td>Whether the asset is operational and at what level.</td>
</tr>
<tr>
<td>Purchase Site</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Inherited from the product from which this asset is derived.</td>
</tr>
<tr>
<td>Class</td>
<td>Inherited from the product from which this asset is derived.</td>
</tr>
<tr>
<td>Parent Asset #</td>
<td>Read-only. The next higher level asset under which the selected asset is currently installed (for example, the parent asset of a disk drive is a computer).</td>
</tr>
<tr>
<td>Account</td>
<td>Account associated with the asset. If you select an account, the Contacts field is not limited to the contacts for the account.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Contacts associated with the asset. If you select a contact, the Account field is not populated with the account for the contacts.</td>
</tr>
</tbody>
</table>

A Customize button appears in the top of the Asset form. The button is available only if your company has a license for Configurator and the asset was instantiated from a configurable product. When an end user clicks this button, Siebel Field Service launches Configurator for the asset displayed in the form. For information about configurable products and Configurator, see Siebel Product Administration Guide.
Activities View

The Activities view associates activities with specific assets. For more information, see Chapter 4, “Field Service Activities.”

Employees View

The Employees view associates employees with specific assets. The role field can be used to prioritize employees for scheduling purposes. For more information, see “Role Priorities” on page 119 and “Defining Field Engineer Assignments” on page 472.

Warranty View

For information about this view, see “Warranty View” on page 499.

Value View

The Value view calculates the current value of an asset based on its history.

There are two ways that assets can be valued:

- **Changes in asset value.** An asset value is based on the original cost of the asset, plus or minus changes to the asset (such as upgrades or damage). This is an accurate method for tracking assets, but requires entry of detailed asset information. This information is entered in the Asset Valuation subview.

  **NOTE:** Asset Valuation records can have negative cost values to reflect devaluation in the asset cost.

- **Asset mapping.** An asset is valued as a percentage of its value on the cost list. The percentage is based on the current condition of the asset. For example, a new asset in excellent condition would be 100% of the cost list value, while a used asset in average condition would be 40% of the cost list value. For information about setting these percentages, see “Asset Mapping View” on page 484.

Both cost and value are important because they allow businesses to report the value of their inventory accurately and to make repair versus replace decisions based on asset valuation.

Recost

A Recost function is available as both a button and a menu command in the Asset Screen’s Value view. Recost assesses an asset’s cost by applying data from asset value records. To calculate the current cost and the replacement value of the asset, an end user must select a cost list, condition, and value basis and then click the Recost button or choose Recost from the view menu. Recost calculates the values by taking the cost of the asset from the cost list, factoring in the cost method, and applying the factor from Asset Mapping. Asset Mapping must provide mapping for Asset Value and Replacement Cost. If the mapping is unavailable, the factor defaults to 100%.
Readings View

Together with the Measurements view, the Readings view does the following:

- Captures asset usage and compares actual versus expected usage
- Captures data needed for preventive maintenance
- Automates meter reading, fee-per-use, and other usage-based service models
- Captures performance and quality data

The Readings view records data from measurements of an asset. Selecting the Done check box indicates that the reading is complete and the record becomes read-only.

Charts View

The Asset screen has a Measurement Analysis chart that shows the readings from a selected measurement as a function of the date of the readings. The upper and lower limits of readings (set using the Administration - Contracts screen) are also shown on the graphs.

Components View

The Components view displays immediate components of specific assets. The parent asset record appears in the Asset form, while the parent asset's child components appear in the Components list below. The sub-components of these components do not appear in the list. To view the sub-components of a child component, drill down on the Asset # field and click the Components view tab.

For example, asset A has a component asset B, which in turn has a sub-component asset C. The Component list for asset A displays only asset B. To view asset C, drill down on the Asset # field for asset B and click the Components view tab. Asset C is displayed in asset B's Component list.

You can build a hierarchy of assets by defining each level in the hierarchy as a component. Components are themselves individual assets that must exist before being included in component relationships. Component relationships are defined in the Transactions view.

Transactions View

The Transactions view allows an end user to create asset transactions manually. These transactions are of the types Install, Uninstall, Upgrade, and Downgrade.
Transactions of the type Install can create a hierarchy of components for existing assets. Removing a component requires another transaction of the type Uninstall. An Install transaction sets the Status and Install Date. An Uninstall transaction clears the Status and Install Date. Install and uninstall transactions can be entered manually in the Transactions list, or field part movements can create these transactions automatically. For more information, see “Parts Movement Administration View” on page 366.

**NOTE:** Components of customizable products should be installed through invoking the product configurator.

Depending on which transaction type you select, assets become available for selection as follows:

- **Uninstall** - Only assets that are currently installed
- **Downgrade** - All assets
- **Install** - Only assets that are not currently installed and are in the same inventory location, an external location, or no location
- **Upgrade** - All assets

**NOTE:** The asset transactions (Install, Uninstall, Upgrade, and Downgrade) do not directly update quantities for inventory levels.

### Change Requests View

For information on Change Requests, see Chapter 14, “Quality.”

### Repairs View

The Repairs view lists all of the repair numbers recorded for an asset. For more information, see “Repairs View” on page 536 for details.

### Relationships View

The Relationships view records backup assets for a primary asset and assets that depend on the operation of a primary asset.

An example of a dependent asset is a hospital power system; hospital medical equipment is dependent on the power system. By checking this view, the engineer can tell what other assets may be affected by a defective asset. The field service engineer can then take steps to make sure that no unintended disruptions occur. In this example, the engineer would make sure that the medical equipment was switched to the backup power supply before down taking the primary power supply.

### Measurements View

Together with the Readings view, the Measurements view does the following:
Captures asset usage and compares actual versus expected usage
Captures data needed for preventive maintenance
Automates meter reading, fee-per-use, and other usage-based service models
Captures performance and quality data

Measurement records are defined for a product. One or more measurement type records can be inherited by an asset of this product and adapted for the selected asset. For more information, see “Setting Up Use Plans” on page 289.

Preventive Maintenance View

The Preventive Maintenance view contains two subviews, accessible from the link bar:

- **History.** Displays preventive maintenance actions associated with assets.
- **Plans.** Associates preventive maintenance plans with assets. The Active check box indicates that the Preventive Maintenance Engine can use this plan to schedule preventive maintenance action.

In the Asset form, an End Date field allows an end user to set the latest date that the Preventive Maintenance Engine considers when generating preventive maintenance actions. Setting a date in the future allows the Preventive Maintenance Engine to generate a future schedule of preventive maintenance actions. Clicking the Run PM button runs the Preventive Maintenance Engine for the selected asset.

For more information about the PM plans, PM actions, and the Preventive Maintenance Engine, see Chapter 19, “Preventive Maintenance.”

Audit Trail View

The Audit Trail view displays an audit trail for a selected asset.

When any of the following fields in an asset record are modified, the change is automatically recorded and time stamped in the Audit Trail view.

- Account
- Status
- Operating Status
- Revision
- Inventory Location
- Contacts
- Employees
- Ownership
- Owner
- Installed Date
Assets - Assets Screen

- Registered Date
- Shipped Date
- Manufactured Date
- Purchased Date
- Primary Warranty
- Organization

The following actions are also tracked as part of the audit trail:
- Changes to the asset’s components (when components are installed or uninstalled)
- Changes to the asset’s value

**Entitlements View**

The Entitlements view displays all entitlements that cover the selected asset. This view is read-only.

**Uptime Data View**

The Uptime Data view displays a selected asset’s operating status, operating history, and a chart showing its operating status over time.

This view shows a timestamp of when the Operating Status field of the asset was changed, the original value, the new value, the employee who made the change, comments, and when the asset was taken down and why. The view also displays a chart titled Operating Status Over Time, which plots the Operating Status value (y-axis) over time (x-axis).

**Attributes View**

The Attributes view shows the attributes associated with the selected asset. This is a read-only view. Attributes are associated with configurable products and can only be changed by invoking the Configurator through the Customize button on the Asset form.

**Explorer View**

The Explorer View is accessed through the Assets link bar. This view shows an explorer-format view of assets, including a hierarchical view of assets that have components. This view displays only the assets in the user's organization.

For each hierarchical parent asset, a + sign is displayed to the left of the first column, denoting a tree structure under it. Clicking the + sign expands the tree to the next level of components. If there are further levels below, a + sign is displayed next to each line item that has more sub-components at a lower level.
Explorer Across Organizations View

The Explorer Across Organizations View is accessed through the Assets link bar. This view is the same as the Assets Explorer View, except that it shows all assets across organizations.
Warranties

Field Service offers multilevel warranty tracking, immediate recognition, and closed-loop handling. Warranties are categorized into three types: product, manufacturer, and component. Each warranty specifies the covered products, costs, and service providers. A warranty is valid for a specified amount of time or usage. Warranties are separate from entitlements that are sold to a customer.

When an asset is created for a product that is covered by warranties, the user can verify the applicable warranties by clicking the Get Warranties button on the Assets screen > List > Warranty view. The number of days remaining on the warranty is automatically tracked.

When creating a service request or repair number for repairing an asset, the user can choose the Check Warranty menu command to immediately find out the valid warranty coverage based on a specified day. If a warranty is not associated with an asset, the Check Warranty feature automatically checks the parent and root assets to determine if the asset is covered by an applicable component warranty.

When an asset returned from the field is still under warranty, an order can be created for the warranty provider, and each line item is tracked through closure, based on the warranty recovery process.

Concurrent Warranties
Siebel Field Service provides the ability to create concurrent warranties. These warranties are valid for:
- A predefined amount of time
Warranties

Setting Up Warranties

Follow these procedures to set up warranties.

To create a new warranty
1. Navigate to the Administration - Service screen > Warranties view.
2. Create a new record or select an existing warranty.
3. To make the warranty a concurrent warranty, complete the following fields:
   - Start Date Type
   - Duration (Days)
   - Measurement Type
   - Unit of Measure
   - Usage Amount

To specify the products covered by a warranty
1. Navigate to the Administration - Service screen > Warranties view.
2. Select a warranty record.
3. Click the Products view tab.
4. In the Products list, create a record and associate a product with the selected warranty.
5. Enter values for the required fields.
6. Repeat Step 4 and Step 5 for each additional product covered by the selected warranty.

To associate a warranty with warranty service providers
1. Navigate to the Administration - Service screen > Warranties view.
2. Select a warranty record.
3. Click the Service Providers view tab.
4. In the Service Providers list, create a new record to associate a service provider with the current warranty.

A predefined amount of usage
For example, an automobile warranty that expires after 3 years or 36,000 miles, whichever occurs first, is a concurrent warranty.

NOTE: In Siebel Field Service, time parameters are required fields and usage parameters are optional fields.
To associate warranties with an asset manually
1. Navigate to the Assets screen.
2. Select an asset record.
3. In the All Assets list, drill down on the Asset # field hyperlink.
4. Click the Warranty view tab.
5. In the Warranty list, create a record to associate a warranty with the selected asset.
6. Enter values in the Start Date, End Date, and Name fields.
   **NOTE:** Before a warranty can appear in the Pick Warranty dialog box, a product must be associated with that warranty in the Service Administration screen, Warranties view, Products subview.

To associate warranties with an asset automatically
1. Navigate to the Assets screen.
2. Select an asset record.
3. In the All Assets list, drill down on the Asset # field hyperlink.
4. Click the Warranty view tab.
5. In the Warranty list, click Get Warranty.
   All warranties that are associated with the asset’s product and that are applicable to the asset will be automatically instantiated in the Warranty list.
6. Modify the values in the Start Date, End Date, and Name fields of the Warranty records as required.
   **CAUTION:** If the date field specified by Start Date Type in the warranty record is not populated in the asset record, then the Get Warranty command will fail. For more information, see "Warranties View" on page 498.

To associate warranties with an order line item
1. Navigate to the Service Order screen > List view.
2. Drill down on a selected order record.
3. Click the Line Items view tab.
4. Select an order line item record.
5. On the link bar, click Warranty.
6. In the Warranty list, create a record to associate a warranty with the selected line item.
7. Enter values for the required fields.
   **NOTE:** Before a warranty can appear in the Pick Warranty dialog box, a product must be associated with that warranty in the Service Administration screen, Warranties view, Products subview.
Obtaining Information Warranties

Follow these procedures to obtain information warranties.

**To verify warranties and related information for an asset**

1. Navigate to the Assets screen.
2. Select an asset record.
3. In the All Assets list, drill down on the Asset # field hyperlink.
4. Click the More Info view tab.
   
   The form shows the Status, Installed date, and the Registered date for the selected asset.
5. Click the Warranty view tab.
6. In the Warranty list, click Get Warranty.
   
   The Warranties list displays the warranties associated with the selected asset. Each warranty record shows the start date, the end date, and the number of days left on the warranty.

   **CAUTION:** If the date field specified by Start Date Type in the warranty record is not populated in the asset record, then the Get Warranty command will fail. For more information, see “Warranties View” on page 498. If the asset does not have an appropriate measurement defined, then Get Warranty will not add the usage-based concurrent warranty correctly.

**To verify the warranties for a product**

1. Navigate to the Products screen.
2. Select a product record.
3. In the All Products list, drill down on the product field hyperlink.
4. Click the Warranties view tab.
   
   The Warranties list shows the warranties associated with this product.

**To check the products covered by a warranty**

1. Navigate to the Administration - Service screen > Warranties view.
2. Select a warranty record.
3. Click the Products view tab.
   
   The Products list shows the products covered by this warranty.

**To verify warranties for a service request**

1. Navigate to the Service screen > Service Request List view.
2. Select an open service request that has an associated product or asset.
Drill down on the SR # field hyperlink.

Click the Service Details view tab.

In the Warranty As of field, enter a date on which you want to assess the warranty status of the selected service request.

The default date is the date the service request was created.

Click Check Warranty.

If any warranties are in effect as of the specified date, the Check Warranty command indicates what types of warranties apply. It does so by selecting the appropriate check boxes (Product Warranty, Manufacturer Warranty, or Component Warranty).

**To verify warranties for an order**

1. Navigate to the Service Order screen > List view.
2. Drill down on a selected order record.
3. Click the Line Items view tab.
4. Select an order line item record.
5. On the link bar, click Warranty.

   The Warranty list displays the warranties for the selected line item.

**To identify the service providers for a warranty**

1. Navigate to the Administration - Service screen > Warranties view.
2. Select a warranty record.
3. In the Warranties list, drill down on the Name field hyperlink.
4. Click the Service Providers view tab.

   The Service Provider list shows the service providers for this warranty.

**To track warranty recovery**

1. Navigate to the Service Order screen > List view.
2. Select an order with the type RMA Return, RMA Repair Return, or RMA Advance Exchange.
3. Drill down on the Order # field hyperlink.
4. Click the Line Items view tab.
5. Select an order line item record.
6. On the link bar, click Warranty.
7. In the Warranty list, select or create a new record for the appropriate warranty.
8. Record the warranty claim information in the Status, Planned Recovery, and Actual Recovery fields.
**To verify the warranty status for defective parts**

1. Navigate to the Repairs screen.
2. Select a repair record.
3. In the My Repairs list, drill down on the Repair # field hyperlink.
4. Click the More Info view tab.
5. In the Warranty As of field, enter a date on which you want to assess the warranty status of the selected repair.
6. Click Check Warranty.

If any warranties are in effect as of the specified date, the Check Warranty command indicates what types of warranties apply. It does so by selecting the appropriate check boxes (Product Warranty, Manufacturer Warranty, or Component Warranty).

**Administration - Service Screen**

The Administration - Service screen provides views for defining warranties offered to customers.

**Warranties View**

The Warranties view lists warranties and their terms for all products and service providers. Table 127 describes the check boxes in the Warranties view.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenses</td>
<td>Indicates that this warranty covers the cost of expenses incurred by field service agents.</td>
</tr>
<tr>
<td>Labor</td>
<td>Indicates that this warranty covers the cost of labor.</td>
</tr>
<tr>
<td>Parts</td>
<td>Indicates that this warranty covers the cost of replacement parts.</td>
</tr>
<tr>
<td>Start Date Type</td>
<td>Specifies which field value in an associated asset record to use as the start date of the warranty's coverage of that asset. For example, if the Start Date Type of the warranty is Installed Date, then the Installed Date of the asset is used as the start date of the warranty associated with that asset.</td>
</tr>
<tr>
<td>Duration (Days)</td>
<td>Specifies the length of the covered period under the warranty.</td>
</tr>
<tr>
<td>Measurement Type</td>
<td>Specifies the type of measurement used to determine if the usage limitation of a concurrent warranty is exceeded or not.</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Specifies the unit of measure for measuring usage of the asset under warranty.</td>
</tr>
<tr>
<td>Usage Amount</td>
<td>The limitation on usage of the asset under warranty, above which the warranty is no longer valid.</td>
</tr>
</tbody>
</table>
Warranties

Products Subview
The Products subview specifies the products covered by a warranty. The products are selected from a dialog box. Products are configured on the Product Administration screen. For more information, see Siebel Product Administration Guide.

Service Providers Subview
The Service Providers subview records the accounts that supply services for a warranty. The service providers are selected from a dialog box.

Assets Screen
The Assets screen has one view that displays information about warranties.

Warranty View
The Warranty view displays the warranties associated with selected assets. Table 128 describes the Get Warranty button in this view.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Warranty</td>
<td>This button and command lists all warranties associated with a product and fills in the fields that describe the warranty.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transferable</td>
<td>When checked, the warranty is transferred from an uninstalled asset to an installed asset upon recording an asset swap. For more information, see &quot;Asset Swaps&quot; on page 470.</td>
</tr>
<tr>
<td>Transportation</td>
<td>Indicates that this warranty covers the cost of transportation.</td>
</tr>
</tbody>
</table>

Service Order Screen
The Service Order screen associates warranties with line items in an order.

Warranty Subview
The Warranty subview (under the Line Items view) associates warranties with line items in an order and allows users to record details of expected credit recovery.
Products Screen
The Products screen has one view for warranties.

Warranties View
The Warranties view shows the warranties that apply to selected products. This view is read-only.

Repairs Screen
The Repairs screen provides a Check Warranty button and menu command.

More Info View
A Check Warranty button and command in the More Info tab’s menu provides warranty information for an asset. Choosing this command checks the appropriate warranty boxes (Product Warranty, Component Warranty, and Manufacturer Warranty) as of the date specified in the Warranty As Of field.

Service Screen
The Service screen has one view with a Check Warranties button and menu command.

Service Details View
The Service Details view contains a Check Warranty button and command. This command identifies the warranties that are associated with a service request on the Warranty As Of date. Choosing this command checks the appropriate warranty boxes (Product Warranty, Component Warranty, and Manufacturer Warranty) as of the date specified in the Warranty As Of field.
This chapter describes the Preventive Maintenance module for Siebel Field Service and the automatic generation of service requests and activities for maintenance. Topics include:

- Preventive Maintenance on page 501
- Preventive Maintenance Triggers on page 502
- PM Plans and Actions on page 509
- Preventive Maintenance Engine on page 510
- Setting Up the Preventive Maintenance Engine on page 515
- Generating Preventive Maintenance Activities on page 517
- Administration - Service Screen on page 518
- Preventive Maintenance Screen on page 518
- Assets Screen on page 523
- Agreements Screen on page 523

**Preventive Maintenance**

The Preventive Maintenance Engine can automatically generate preventive maintenance (PM) service requests and actions (or activities), triggered by elapsed time, asset usage, measurement thresholds, or events (see Figure 38 on page 502):

- Time-based triggers call for maintenance actions at regular time intervals.
- Usage-based triggers are for equipment that can keep track of usage with a counter (for example, number of copies for photocopiers).
- Threshold-based triggers initiate a service activity when a measurement falls above or below a set level (similar to an alarm or engine warning light).
- Event-based triggers use predefined events to determine if a PM activity is required.

When a PM activity is required, you use Field Service to create service requests and detailed activities. Figure 38 on page 502 shows the process of the Preventive Maintenance Engine, which is:

1. Run the PM Engine for an asset or an agreement.
2. Select the PM Plan for the asset or for the entitlement’s assets.
3. For each trigger, if conditions require an action, create service requests or activities, and then run the PM Engine. If conditions do not require an action, run the PM Engine.
4 Continue the process until all necessary service requests and activities have been created.

Figure 38. Logic of the Preventive Maintenance Engine

**Preventive Maintenance Triggers**

Preventive Maintenance triggers initiate processes in Field Service to plan and schedule routine service activities. The Preventive Maintenance Engine responds to triggers and plans service activities. The Optimization Engine can schedule these activities (see "Guidelines for Integrating Preventive Maintenance with the Appointment Booking System" on page 104).

There are five types of triggers for preventive maintenance plans: Time Interval, Date, Usage, Threshold, and Event. Topics include:

- Logic Governing Triggers on page 503
- Prioritization of PM Plans for Date and Time Interval Triggers on page 504
Logic Governing Triggers

The following rules regulate the operation of Preventive Maintenance triggers:

- Time Interval and Date triggers are the only trigger type that can fire for a date in the future. All other triggers can fire only for the current date (when the engine runs).
- Triggers never fire in the past. If the Preventive Maintenance Engine finds a trigger that should have fired in the past, it fires for the current date unless some other constraint or condition prevents that.
- No trigger can fire more than once a day.
- No trigger can fire while there is an outstanding (future) PM activity for the asset and its associated PM plan.

When the trigger logic evaluates whether a trigger should fire, it prevents the creation of a new PM action whenever there is an existing action for the current date or any date in the future. This behavior is by design, to prevent triggers from firing multiple times for the same trigger condition. However, it means that plans with a Time or Date trigger combined with another trigger should not be run with end dates too far in the future. Time- or Date-triggered preventive maintenance actions in the future might prevent other valid triggers (such as Usage triggers) from firing, thus preventing valid service actions from being created.

**NOTE:** There are no constraints built into the PM module limiting multiple triggers.

For example, a plan with Time and Usage triggers might run with an end date one year in the future. All the PM actions for the next year are created based on the Time trigger, and during that time the Usage trigger will never fire, whatever the actual usage. You can avoid this conflict by only scheduling PM actions a few weeks or one month in advance. Then, in the worst case, the engine runs and schedules a PM action based on the Time trigger even though the asset meets the usage criteria tomorrow. The actual difference in the time between when the PM action should have been scheduled and when it was scheduled is, at most, the difference between the end date passed to the engine and the current date (when the engine runs).
When an SR Template is associated to a PM Plan and one of the triggers for the plan fires, it generates service requests and PM actions with date fields automatically filled with values, as listed in Table 129:

### Table 129. Field Values from PM Triggers

<table>
<thead>
<tr>
<th>Screen and View</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets &gt; Service Requests</td>
<td>Opened</td>
<td>Date and time the PM engine was run.</td>
</tr>
<tr>
<td>Assets &gt; Service Requests</td>
<td>Committed</td>
<td>Date and time the PM activity is due. Corresponds to the date and time of the trigger.</td>
</tr>
<tr>
<td>Assets &gt; Preventive Maintenance &gt; History</td>
<td>Created</td>
<td>Date and time the PM engine was run.</td>
</tr>
<tr>
<td>Assets &gt; Preventive Maintenance &gt; History</td>
<td>Scheduled</td>
<td>Date and time the PM activity is due. Corresponds to the date and time of the trigger.</td>
</tr>
</tbody>
</table>

**Prioritization of PM Plans for Date and Time Interval Triggers**

Priority levels can be selected for PM plans, ranging from 1-ASAP to 4-Low. This is done using the Priority field on the Preventive Maintenance screen > Preventive Maintenance List view. The priority value is used to determine whether actions (which can be overlapping) need to be generated when more than one PM plan applies to the same asset.

If the Optional flag on the PM plan is not selected, this means that action generation is mandatory and the actions are generated regardless of its priority. However, if the Optional flag is selected, action generation for this plan is dependent on the priority. Prioritization of PM plans only happens in the same run, which means that if actions from a previous plan with lower priority were already created, then the current plan does not override those actions, regardless of its priority.

Prioritization of PM plans only affects Date and Time Interval triggers. Other triggers should be set up so that they do not overlap between different PM plans. This means that Usage, Threshold, and Event triggers from different plans that trigger on the same day, can create overlapping actions without the prioritization logic being applied.

The logic of PM prioritization can handle one or a combination of the following scenarios:

- **Scenario 1.** Two or more PM plans have the same priority.
- **Scenario 2.** There are two PM plans.one with a high priority and one with a low priority
- **Scenario 3.** The PM plans have the optional flag set to FALSE.
- **Scenario 4.** The PM plans have no set priority.
Scenario 1
In Scenario 1, PM plans with equal priority behave as if they have no priority with respect to each other. This means that all the actions that need to be generated from these plans are created and that the priority is not considered to be a factor.

Scenario 2
In scenario 2, the PM Engine processes the plan with the higher priority first to generate the necessary actions. Next, the engine processes the plan with the lower priority. It then checks if the actions to be created are scheduled for the same day as those already generated by the plan with the higher priority. If a higher priority action already exists, then the lower priority plan does not create another action that overlaps the old one.

Scenario 3
In scenario 3, plan actions that must always be created will have the optional flag set to FALSE for the corresponding PM plan. In this case, the PM Engine ignores the priority and the plan executes normally. The priority of mandatory PM plans will also affect the prioritization of other plans in the same run.

Scenario 4
Finally, in scenario 4, PM plans with no priority are considered as plans with the lowest priority.

See “Plans View” on page 519 for more information on the Priority and Optional fields.

Time Interval Triggers
Time Interval triggers in a PM plan for an asset determine the dates on which the PM engine schedules PM actions for that asset. Other factors that determine these dates include:

- Installation date of the asset
- Period of time for which you run the PM engine

Time Interval triggers include the following fields:

- **Interval.** A time interval in days.
- **Valid Start.** A number that indicates the first day in the asset life to which the corresponding interval applies.
- **Valid End.** A number that indicates the day in the asset life to which the corresponding interval no longer applies.
**Example of Using Time Interval Triggers**

This topic gives one example of how the PM engine schedules PM action dates. You may use this feature differently, depending on your business model. For an asset purchased on June 8, the PM plan for the asset includes the Time Interval triggers listed in the following table:

Table 130. Sample Time Interval Triggers

<table>
<thead>
<tr>
<th>Time Interval Trigger Number</th>
<th>Interval</th>
<th>Valid Start</th>
<th>Valid End</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>2</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

Time Interval trigger number 1 indicates that for the first day of the asset life, a time interval of 1 day applies. Time Interval trigger number 2 indicates that for the second through the sixth day of the asset life, a time interval of 3 days applies. Time Interval trigger number 3 indicates that for the seventh and subsequent days of the asset life, a time interval of 5 days applies.

If you run the PM engine from June 8 to June 30, the PM engine uses the asset installation date to calculate the PM action dates, because no PM actions currently exist. The PM engine schedules the following PM action dates: June 9, 11, 14, 23, 28:

- For the first day of the asset life (June 9), Time Interval trigger number 1 applies. The engine adds 1 day to the June 8 installation date to obtain the June 9 scheduled date.
- For the second through sixth days of the asset life (June 10 - June 14), Time Interval trigger number 2 applies. The engine adds 3 days to the June 8 installation date to obtain the June 11 scheduled date, and adds 6 days to the June 8 installation date to obtain the June 14 scheduled date.
- For the seventh and subsequent days of the asset life (June 15 - June 30), Time Interval trigger number 3 applies. The engine adds 10 days to the June 8 installation date to obtain the June 18 scheduled date. (The engine adds 10 days, and not 5 days, to obtain a date that is on or after the seventh day of the asset life.)
- The engine adds 15 days to the June 8 installation date to obtain the June 23 scheduled date, and adds 20 days to the June 8 installation date to obtain the June 28 scheduled date.

If you complete the June 28 scheduled action two days early on June 26, and if you run the PM engine for the period of time from June 8 to July 15, the PM engine uses this last completion date to calculate the PM action dates. The PM engine schedules the following PM action dates: July 1, 6, 11:

- For the seventh and subsequent days of the asset life, Time Interval trigger number 3 applies. The engine adds 5 days to the June 26 completion date to obtain the July 1 scheduled date.
- The engine adds 10 days to the June 26 completion date to obtain the July 6 scheduled date, and adds 15 days to the June 26 completion date to obtain July 11 scheduled date.
If you do not complete the July 11 scheduled action, and if you run the PM engine for the period of time from June 8 to July 31, the PM engine uses this last scheduled date to calculate the PM action dates, because the last scheduled action has no completion date. The PM engine schedules the following PM action dates: July 16, 21, 26:

- For the seventh and subsequent days of the asset life, Time Interval trigger number 3 applies. The engine adds 5 days to the July 11 scheduled date to obtain the July 16 scheduled date.
- The engine adds 10 days to the July 11 scheduled date to obtain the July 21 scheduled date and adds 15 days to the June 11 scheduled date to obtain the July 26 scheduled date.

Although the interval could be less than 1 day, higher-level logic currently prevents triggers from firing more than once a day.

The asset installation date determines the age of the asset. An asset with no installation date has an age of 0 days.

NOTE: Do not change the installation date of an asset, because the existing PM actions will not be consistent with your revised installation date.

Though you cannot change the dates of scheduled PM actions for an asset, you can restart PM action scheduling to go into effect on the current date or a future date. To restart PM action scheduling for an asset, use one of the following methods:

- In the Date Completed field of the latest PM action for the asset, enter the restart date.
- The PM engine uses the existing Time Interval triggers in the asset's PM plan and this restart date to schedule PM actions.
- Delete the asset from the PM plan, and create a new PM plan for the asset with new Time Interval triggers.
- The PM engine uses the revised Time Interval triggers and the asset installation date to schedule PM actions.
- If the PM plan contains only the asset for which you want to restart PM action scheduling, set an end day corresponding to today for any Time Interval triggers that are in effect on the restart date, delete any Time Interval triggers that are in effect after the restart date, and create new Time Interval triggers to replace them.

The PM engine uses the revised Time Interval triggers and the date of the last completed PM action for the asset to schedule PM actions. If no completed PM actions exist, the engine uses the date of the last scheduled PM action for the asset instead of the date of the last completed action. If no scheduled PM actions exist for the asset, the PM engine uses the asset installation date instead of the date of the last scheduled PM action.

**Date Triggers**

Date triggers fire on a specific date. Like Time Interval triggers, they may have a valid start and end that are measured from the asset's install date.

NOTE: In the out-of-the-box configuration, Date triggers are not exposed in the user interface.
Usage Triggers

Usage triggers activate a PM plan when the reading from an asset changes by a specified amount. Each usage trigger record has start and stop values, so that the activation of a PM plan can change with the usage of the asset. For example, a service request may be generated every 3,000 counts for the first 15,000 counts, then every 10,000 counts after 15,000.

**NOTE:** For Time Interval and Usage triggers (which use Valid Start and Valid End settings), if the interval falls beyond the Valid End, the trigger does not fire.

The trigger fires if the readings for the specified measurement have a delta greater than the specified interval. The delta is determined by the difference between the most recent reading and the reading at the time of the last PM action. To be considered, the readings must be marked as Done. For more information, see “Warranty View” on page 486. If the most recent reading is less than the reading at the time of the last PM action, then the measurement is assumed to have wrapped around and the delta is calculated as follows:

\[ \text{delta} = (\text{max} - \text{last}) + (\text{new} - \text{min}) + 1 \]

Usage triggers may also specify a valid start and end, defining the values of the reading for which the trigger is valid.

A measurement is specified only by its type. For more information, see “Measurements View” on page 488. If an asset is given more than one measurement of the type specified by a Usage trigger, then if any of the measurements exceed the usage specified by its type, the trigger fires. To avoid this, you should define specific types, as applicable, in the measurement type LOV (ASSET_MEAS_TYPE).

Threshold Triggers

A Threshold trigger activates a PM Plan when a reading from an asset exceeds a set value. Threshold triggers can fire in response to a change in a binary value; for example, a threshold of 0.5 would trigger a PM plan when an on/off alarm changes state.

Threshold triggers examine the readings since the most recent PM action. If any completed reading exceeds the lower or upper limit, the trigger fires.

Like Usage triggers, Threshold triggers specify a measurement type to which they apply. The same potential issues and solutions for “Usage Triggers” on page 508 apply to Threshold triggers.

Measurements and Readings

Measurements are defined for products on the Administration - Product screen > Service Information > Measurements view. For more information, see “Setting Up Use Plans” on page 289.

The Measurements view on the Assets screen associates measurements from a product with the selected asset. The view allows these measurements to be customized for this asset. For example, a relevant measurement for a copy machine would be the number of copies, read from a counter; for a car it would be the distance traveled, read from an odometer; and for a pump it might be oil level, oil, pressure, and temperature, read from gauges. For more information, see “Measurements View” on page 488.
The Readings view on the Assets screen allows a technician to record the readings for specific measurements and specific assets. These readings may act as triggers for usage and threshold triggers.

**Event Triggers**

An Event Trigger activates a PM Plan when the number of service requests for an asset exceeds a threshold number in a specified time period. This trigger is useful for activating a higher level PM plan when a certain number of routine PM plans have taken place. For example, this trigger could activate a complete overhaul.

Currently, the only event supported is the number of service requests in a specified period.

**PM Plans and Actions**

PM plans define sets of activities for preventive maintenance. The steps in setting up a PM plan are also useful for understanding the function of a plan:

1. Create an SR template. Each SR template defines a type of preventive maintenance: for example, 5,000 mile service or major overhaul.
2. Associate one or more activity templates with each SR template. An activity template is a set of activities to carry out a preventive maintenance objective. For more information about activity templates, see “Field Service Activity Templates and Activity Plans” on page 71.
3. Create a PM plan. Define triggers and products or assets covered by the PM plan. Associate one or more SR templates with the PM plan. You can also directly associate activity templates with the PM plan.

**Service Request Templates**

A Service Request Template is used to create service requests whenever a preventive maintenance trigger is activated. An SR Template includes one or more activity templates and holds default values for the following service request fields:

- Name
- Description
- Area
- Subarea
- Symptoms
- Severity
- Status
- Substatus
- Priority
Preventive Maintenance Engine

This section describes the Preventive Maintenance Engine. Topics includes:

- Validating PM Plans for an Asset on page 510
- Running the Preventive Maintenance Engine on page 511
- System Preferences for the Preventive Maintenance Engine on page 512
- Parameters for the Preventive Maintenance Engine on page 513

When a trigger fires, the Preventive Maintenance Engine creates a service request. Activities are created in two ways:

- Activities are derived from SR templates (and PM plans). These activities are associated with the service request. See "Service Request Templates" on page 509 and "Actions View" on page 522.
- Activities are derived from activity templates associated directly with a PM plan. See "Actions View" on page 522, Activities subview.

**NOTE:** The association between activities and activity templates is made in the Activity Templates view in the Administration - Applications screen (see "Administration - Application Screen" on page 78).

Validating PM Plans for an Asset

The Products view on the Preventive Maintenance screen allows you to associate products and assets with PM plans. The PM Engine retrieves these products and assets as follows:

- The products are obtained by querying the database for all the products that are associated with the PM plan and then setting their All Assets flags to TRUE.
- The assets are obtained by querying for all the assets that are associated with the PM plan and then setting their products’ All Assets flags to FALSE.

You set the All Assets flag for products associated with PM plans in the Products view of the Preventive Maintenance screen. For more information, see "Products View" on page 521.

**NOTE:** PM plans are always associated with products and not with product lines.

To determine if a plan is applicable to an asset, the Preventive Maintenance Engine applies the following logic:

1. The engine checks the product of the asset with the collection of products held in the plan. If a match is found, the plan applies to the asset; otherwise processing continues.

2. The engine checks the asset against the collection of assets held in the plan. If a match is found, the plan applies to the asset; otherwise the plan does not apply.
Running the Preventive Maintenance Engine

There are two methods of invoking the Preventive Maintenance Engine:

- Using component jobs
- Using the Field Service client

Related Topic
“FS Preventive Maintenance Business Service” on page 580

Using Component Jobs

Administrators can set up jobs (one-time or repeating) for tasks that are serviced by the Preventive Maintenance Engine. The component-specific parameters specified by the job determine what the engine does for that job. For a detailed explanation, see "Parameters for the Preventive Maintenance Engine" on page 513.

In general, tasks must define these variables:

- A set of objects for the engine to operate on.
- A date that is the latest date to schedule preventive maintenance during the run.
- The mode in which the task is to be run. When invoking the PM Engine through component jobs, you can specify either ID or SQL mode for this variable. (The Field Service client uses another mode, TempTbl, when invoking the PM engine.)
- The sub-mode, which determines the entities that are specified for the selected mode.

The set of objects must include either assets and plans or agreements, as defined by the sub-mode parameter in the job. In the case of assets and plans, if only assets or only plans are specified, then all of the other object types are assumed. For example, if only assets are specified (Sub-mode=Assets), then the Preventive Maintenance Engine checks the specified assets with all plans. When agreements are specified, each agreement implicitly defines a set of assets and plans (entitlements have both associated assets/products and PM plans) that the engine is to process for that agreement.

Usually these jobs use a SQL parameter that completes a SQL statement. The SQL statement locates the objects that the Preventive Maintenance Engine will process for that run. Component jobs can also use ID parameters instead of the SQL parameters.

CAUTION: Do not run component jobs in Temp-Table Mode to invoke the Preventive Maintenance Engine. This mode is reserved for interactive engine jobs sent directly from a client application.

Using the Field Service Client

End users can pass client requests directly from the client application. They can do this by performing one of the following:
To invoke the PM engine from the Assets screen
1. Navigate to the Assets screen > Preventive Maintenance view.
2. Select an asset. From the menu drop-down list, select Run PM All.

To invoke the PM engine from the Agreements screen
1. Navigate to the Agreements screen > Preventive Maintenance view.
2. Select an agreement. From the menu drop-down list, select Run PM All.

System Preferences for the Preventive Maintenance Engine
The Preventive Maintenance Engine uses the two system preferences described in Table 131.

Table 131. System Preferences for the Preventive Maintenance Engine

<table>
<thead>
<tr>
<th>System Preference</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FSPrevMnt: Default Org ID</td>
<td>Org ID</td>
<td>The value of this system preference is the ROW_ID of the default organization. This default organization is used on generated service requests when the asset for which the service request is being generated does not have a specified account. If the owner account is specified for the asset, then the account's BU_ID is used.</td>
</tr>
<tr>
<td>FSPrevMnt: Def Act Owner ID</td>
<td>Act Owner ID</td>
<td>The value of this system preference is used when you create activities from a template in which the activity owner (Employees) has not been defined. The value specified should be the ROW_ID of the desired employee.</td>
</tr>
</tbody>
</table>
Parameters for the Preventive Maintenance Engine

Siebel Business Process Designer or the client can invoke all engines. These engines require certain parameters to be passed. Table 132 describes the parameters for the Preventive Maintenance Engine.

Table 132. Preventive Maintenance Engine Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>{SQL, Id, TempTbl}</td>
<td>This required parameter specifies how the engine locates the entities to process. Only SQL or ID should be specified in user requests. TempTbl is used by the client applications for submitting requests.</td>
</tr>
<tr>
<td>Sub-mode</td>
<td>{Assets, Plans, Assets&amp;Plans, Agreements}</td>
<td>This required parameter identifies which entities are specified. A Sub-mode of Assets implies ALL PM Plans, and a Sub-mode of Plans implies ALL Assets.</td>
</tr>
<tr>
<td>End Date</td>
<td>YYYY-MM-DD format</td>
<td>This required parameter specifies the date furthest into the future for which the engine will generate PM Actions. Note that currently, only time-based triggers can fire for a future date.</td>
</tr>
<tr>
<td>Asset ID</td>
<td>Row ID of an asset</td>
<td>This parameter specifies a specific asset. It is required when the Mode is Id and the Sub-mode is either Assets or Assets&amp;Plans.</td>
</tr>
<tr>
<td>Plan ID</td>
<td>Row ID of a PM Plan</td>
<td>This parameter specifies a specific PM Plan. It is required when the Mode is Id and the Sub-mode is either Plans or Assets&amp;Plans.</td>
</tr>
<tr>
<td>Agreement ID</td>
<td>Row ID of an agreement</td>
<td>This parameter specifies a specific Agreement. It is required when the Mode is Id and the Sub-mode is Agreements.</td>
</tr>
</tbody>
</table>
Preventive Maintenance

Table 132. Preventive Maintenance Engine Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset SQL</td>
<td>Where clause for the GET_SQL_ASSETS template. The where clause takes the following form: [BusComp Field Name] = 'Value'</td>
</tr>
</tbody>
</table>

This parameter specifies a search specification for assets. It is required when the Mode is SQL and the Sub-mode is either Assets or Assets&Plans.

The SQL template for retrieving assets is as follows:

```
GET_SQL_ASSETS =
SELECT asset.ROW_ID
FROM &Table_Owner.S_ASSET asset
WHERE $SEARCH_SPEC$
```

The value supplied as the Asset SQL parameter is substituted for '$SEARCH_SPEC$.' Thus, any specification that completes this template with valid values is allowed for the parameter.
Setting Up the Preventive Maintenance Engine

Follow these procedures to set up the Preventive Maintenance Engine.

For information about synchronous and asynchronous processing, see *Siebel Application Services Interface Reference*.

In synchronous processing, the client screen can lock. Consequently, the user sees a blank screen.

---

Table 132. Preventive Maintenance Engine Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan SQL</td>
<td>Where clause for the GET_SQL_PM_PLANS template. The where clause takes the following form: [BusComp Field Name] = 'Value'</td>
<td>This parameter specifies a search specification for PM plans. It is required when the Mode is SQL and the Sub-mode is either Plans or Assets&amp;Plans. The SQL template for retrieving PM Plans is as follows: GET_SQL_PM_PLANS = SELECT pln.ROW_ID FROM &amp;Table_Owner.S_PM_PLNITM pln WHERE pln.ACTIVE_FLG = 'Y' AND $SEARCH_SPEC$ The value supplied as the Plan SQL parameter is substituted for '$SEARCH_SPEC$'. Thus, any specification that completes this template with valid values is allowed for the parameter.</td>
</tr>
<tr>
<td>Agreement SQL</td>
<td>Where clause for the GET_SQL_AGREEMENT_ID template. The where clause takes the following form: [BusComp Field Name] = 'Value'</td>
<td>This parameter specifies a search specification for agreements. It is required when the Mode is SQL and the Sub-mode is Agreements. The SQL template for retrieving PM Agreements is as follows: GET_SQL_AGREEMENT_ID = SELECT agrmnt.ROW_ID FROM &amp;Table_Owner.S_DOC_AGREE agrmnt WHERE agrmnt.VALID_FLG = 'Y' AND $SEARCH_SPEC$ The value supplied as the Agreement SQL parameter is substituted for '$SEARCH_SPEC$'. Thus, any specification that completes this template with valid values is allowed for the parameter.</td>
</tr>
</tbody>
</table>
**Preventive Maintenance**

■ Setting Up the Preventive Maintenance Engine

---

**To set asynchronous operation of the Preventive Maintenance Engine**

1. From the application-level menu, choose Tools > User Preferences.
   - The User Preferences screen appears.
2. On the link bar, click Service.
   - The Field Service form appears.
3. In the Asynchronous Processing of section, select Preventive Maintenance.

---

**To set parameters for the Preventive Maintenance Engine**

1. Create or edit a component job for the server component Preventive Maintenance Engine (alias FSPrevMnt).
2. Create or edit a component job for the Preventive Maintenance Engine server component.
3. Add or modify the server component parameters, as needed. For information about server components and component parameters, see *Siebel System Administration Guide*.

---

**To change system preferences for the Preventive Maintenance Engine**

1. Navigate to the Administration - Applications screen > System Preferences view.
2. Select the name of the system preference, and then enter a new value. For the names of applicable system preferences, see Table 131 on page 512.
3. To register changes to system preferences, restart the Field Service server. For information about how to restart servers, see *Siebel System Administration Guide*.

---

**To add preventive maintenance plans**

1. Navigate to the Preventive Maintenance screen > Preventive Maintenance List view.
2. Add a new record.

---

**To add triggers for a selected PM plan**

1. Navigate to the Preventive Maintenance List screen > Triggers view.
2. Select a PM plan, and then add a new record in any applicable subview.

---

**To associate a PM plan with an agreement**

1. Navigate to the Agreements screen > Entitlements view.
2. Select an entitlement, add a new record, and then associate a PM plan.

---

**To associate assets with PM plans**

1. Navigate to the Assets screen > Preventive Maintenance - Plans view.
2 Select an asset, add a new record, and then associate an asset.

To associate activity templates with a PM plan
1 Navigate to the Preventive Maintenance screen > Preventive Maintenance List view.
2 Select a preventive maintenance plan, and click the Actions view tab.
3 In the Activity Templates applet, create a new record, and associate an activity template with the PM plan.

To associate service request templates with a PM plan
1 Navigate to the Preventive Maintenance screen > Preventive Maintenance List view.
2 Select a preventive maintenance plan, and click the Actions view tab.
3 In the SR Templates applet, create a new record, and associate a service request template with the PM plan.

Creating Service Request Templates for Preventive Maintenance
Service Request Templates provide one or more activity templates to carry out preventive maintenance.

To create a service request template for preventive maintenance
1 Navigate to the Administration - Service screen > Service Request Templates view.
2 Add a record, click the Service Request Template Activities view tab, and add activity templates as needed for preventive maintenance.

Generating Preventive Maintenance Activities
Use the following procedures to generate preventive maintenance activities (actions).

To run PM plans for an asset
1 Navigate to the Assets screen > Preventive Maintenance - Plans view.
2 Select an asset, and then add a new record to associate a preventive maintenance plan to the asset.
3 Complete the End Date field. This is the latest date that the PM Engine considers when generating PM actions. The field defaults to the current date, and you can set it to any date in the future.
4 Do one of the following:
To run the PM Engine for the selected asset and all its associated maintenance plans, click Run PM.

To run the PM Engine for all assets and all their associated maintenance plans, click the menu button and choose Run PM All.

**To review generated PM actions for an asset**

1. Navigate to the Assets screen > Preventive Maintenance - History view.
2. Select an asset.

### Administration - Service Screen

Two views in the Administration - Service screen are for configuring activity templates for preventive maintenance. These templates become part of PM plans. For more information, see “Preventive Maintenance Screen” on page 518. Topics include:

- Service Request Templates on page 509
- Service Request Template Activities View on page 518

### Service Request Templates View

The Service Request Templates view creates templates for preventive maintenance service requests. An SR template includes one or more activity templates plus default values for a preventive maintenance service request: for example, Area, Status, Priority, Symptoms, and Resolution. When activated, the preventive maintenance trigger creates the service request using this template.

**NOTE:** Service request templates apply only to preventive maintenance.

### Service Request Template Activities View

The Service Request Template Activities view associates activity templates with preventive maintenance service request templates.

Activity templates are set up in the Administration - Application screen, Activity Templates view. For more information, see “Setting Up Field Service Activity Templates” on page 73.

### Preventive Maintenance Screen

The Preventive Maintenance screen configures preventive maintenance plans for specific products and assets. Topics include:

- Plans View on page 519
- Triggers View on page 520
Plans View
The Plans view defines preventive maintenance plans for specific products and assets. Table 133 describes some of the items on this view.

Table 133. Items in the Plans view

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Selecting the Active check box allows the Preventive Maintenance Engine to process this plan. It may be useful to clear this box when you define a plan or to temporarily disable specific plans. When the plan definition is complete or a plan is reinstated, the administrator selects this box to activate the preventive maintenance plan.</td>
</tr>
<tr>
<td>Optional</td>
<td>Indicates whether action generation for the PM plan is mandatory or optional. By default, this flag is set to FALSE. However, when the flag is set to TRUE, the PM Engine can take prioritization into account when determining the action generation.</td>
</tr>
<tr>
<td>Reset Time Trigger</td>
<td>Select this check box to reset the time trigger after the plan has been activated. See “Time Interval Triggers” on page 505 for more information.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the preventive maintenance planning item. See &quot;Prioritization of PM Plans for Date and Time Interval Triggers&quot; on page 504 for more information.</td>
</tr>
<tr>
<td>Last Run</td>
<td>The time and date when the selected PM plan was last activated. The Preventive Maintenance Engine fills two time stamps when it runs:</td>
</tr>
<tr>
<td></td>
<td>■ When you run the Auto PM function on an asset, the Preventive Maintenance Engine examines each active PM plan to determine whether it applies to the particular asset. The time stamp for this examination is recorded in the PM plan (S_PM_PLNITM.LAST_RUN_DT).</td>
</tr>
<tr>
<td></td>
<td>■ When the Preventive Maintenance engine has located a PM plan that applies to the asset (the plan has an asset connector for the asset or a corresponding product connector with the All Assets flag set), it also records the time stamp in the corresponding product connector or asset connector record (S_PM_APPL_ASSET.LAST_RUN_DT). If required, you can expose this time stamp in the following business components:</td>
</tr>
<tr>
<td></td>
<td>■ FS PM Applicable Plan Item</td>
</tr>
<tr>
<td></td>
<td>■ FS PM Plan Item-Product Connector</td>
</tr>
<tr>
<td></td>
<td>■ FS PM Plan Item-Asset Connector</td>
</tr>
</tbody>
</table>
**Triggers View**

The Triggers view provides four subviews (Time Interval, Month-Day, Usage, Threshold, or Event) to define the triggers that activate PM plans.

**Time Interval Subview**

The Time Interval subview sets the interval in days between triggers that activate a selected plan. A plan can have more than one Time Interval trigger. For more information, see "Time Interval Triggers" on page 505. Table 134 describes items in Time Interval records.

Table 134. Items in the Time Interval Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval</td>
<td>Length of the interval between triggers, in number of days. Must be an integer.</td>
</tr>
<tr>
<td>Valid Start</td>
<td>The age of an asset, in days, at which this trigger becomes effective. Required.</td>
</tr>
<tr>
<td>Valid End</td>
<td>The age of an asset at which this trigger is no longer effective. If this value is blank, the end is set to infinity.</td>
</tr>
</tbody>
</table>

**NOTE:** The asset installation date determines the age of the asset. An asset with no installation date has an age of 0 days.

**Usage Subview**

The Usage subview defines the measurement and measurement parameters that trigger a PM plan. A plan can have more than one Usage trigger. For more information, see "Usage Triggers" on page 508. Table 135 describes items in Usage records.

Table 135. Items in the Usage Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Type</td>
<td>A type of reading, chosen from a dialog box.</td>
</tr>
<tr>
<td>Interval</td>
<td>The change in a reading that triggers a PM plan. Interval uses the units set in Measurement Type.</td>
</tr>
<tr>
<td>Valid Start</td>
<td>The measurement at which the trigger becomes valid. The value is in the same units as the interval.</td>
</tr>
<tr>
<td>Valid End</td>
<td>The measurement at which the trigger is no longer valid. The value is in the same units as the interval. If this value is blank, the end is set to infinity.</td>
</tr>
</tbody>
</table>

**NOTE:** For Time Interval and Usage triggers (which use Valid Start and Valid End settings), if the interval falls beyond the Valid End, the trigger does not fire.
Threshold Subview
The Threshold subview defines a reading from an asset that triggers a PM plan. A plan can have more than one Threshold trigger. For more information, see “Threshold Triggers” on page 508. Table 136 describes the item in Threshold records.

Table 136. Items in the Threshold Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Type</td>
<td>A type of measurement, chosen from a dialog box.</td>
</tr>
</tbody>
</table>

Event Subview
The Event subview defines the number of service requests in a time interval that trigger a PM plan. A plan can have only one Event trigger. For more information, see “Event Triggers” on page 509. Table 137 describes items in the Event subview. Both items are required.

Table 137. Items in the Event Subview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># of SRs</td>
<td>The number of service requests which, when exceeded, triggers a PM plan.</td>
</tr>
<tr>
<td>Over # of Days</td>
<td>The time interval, in days, during which the number of service requests must occur.</td>
</tr>
</tbody>
</table>

Products View
The Products view associates specific products and assets with PM plans. Table 138 describes the check box in the Products view.

Table 138. Item in the Products View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Assets</td>
<td>A check box that indicates all assets of this product are covered by the PM plan, whether or not they appear in the Assets list.</td>
</tr>
<tr>
<td></td>
<td>To cover only the specified assets, make sure that All Assets is not selected.</td>
</tr>
</tbody>
</table>

CAUTION: You must configure the correct measurement types in the Administration - Product screen for the products covered in the preventive maintenance plan. In the More Info view, select Product Measurements from the visibility filter. If you do not configure measurement types, then Usage and Threshold triggers can cause unpredictable and undesired results. For more information about configuring products, see Siebel Product Administration Guide.
If the asset is already associated through the All Assets flag, adding the PM plan as a record has no effect other than to display the relationship.

To perform this procedure, see “To associate assets with PM plans” on page 516.

**Assets Subview**
The Assets subview lists the assets for each product covered under the PM plan.

**Actions View**
The Actions view associates service request templates and activity templates with PM Plan records. The application does not verify duplication of activity templates, so the same activity template may be associated directly with a PM plan and indirectly through an SR template.

To create SR templates, see “Administration - Service Screen” on page 518.

The preventative maintenance trigger, when activated, creates a service request using the service request template. The trigger also creates activities (but not activity plans) for the activity templates that are associated with the service request. The following fields are copied from the service request template to the service request:

- Area
- Description
- Name
- Primary Symptom Code
- Priority
- Resolution Code
- Severity
- Source
- Status
- Sub-Area
- Sub-Status

The Commit Time field on the service request is set to the date of the preventative maintenance trigger.

The preventative maintenance trigger, when activated, creates activities (but not an activity plan) using the activity template. To view the fields that are copied from the activity template to the activities, see “Field Service Activity Templates and Activity Plans” on page 71. The Due Date field on the activities is set relative to the date of the preventative maintenance trigger.
History View
The History view displays past preventive maintenance actions for each selected PM plan. This view is read-only.

Assets Screen
The Preventive Maintenance view on the Assets screen associates PM plans with specific assets and shows the history of PM plans scheduled or carried out. The Preventive Maintenance view has two subviews, Plans and History, selected from the hyperlinks in the link bar.

Plans Subview
The Plans subview associates PM plans with selected assets.

When you select the Active check box in this view, the Preventive Maintenance Engine can process this plan. You can clear this check box while defining a plan or to disable specific plans temporarily. When the plan definition is complete or a plan is reinstated, select this check box.

**NOTE:** Selecting the All Assets check box in the Products view associates all assets of a product line with a selected PM plan. If the asset is not already associated with a PM plan (the All Assets check box is cleared for the product), users can cover the asset by adding the PM plan as a record in this subview. For more information, see “Products View” on page 521.

History Subview
The History subview reports all of the PM actions in the history of a selected asset. All fields in this form are read-only except for the Completed field, which accepts the date that the activities in a plan are completed.

Agreements Screen
The Agreements screen, Entitlements view, has one subview for preventive maintenance, which shows the PM plans that are associated with specific agreements and their entitlements and PM actions for this entitlement and agreement that are scheduled or completed. This subview is read-only.

Preventive Maintenance Subview
Select PM Plans or PM Actions from the drop-down list at the top in the Preventive Maintenance subview.
This chapter describes how to use the Repair module to process and track equipment repairs. Topics include:

- Siebel Repair on page 525
- Setting Up and Configuring Repairs on page 531
- Repairs Screen on page 535
- Assets Screen on page 536

**Siebel Repair**

Siebel Repair generates repair activity plans, assigns and schedules repair activities, tracks symptoms and resolutions, and stores repair histories. Topics include:

- How Items Are Received for Repair on page 527
- Repair Numbers on page 527
- Repair Activities on page 528
- Repair Orders on page 528
- Asset Repair Histories on page 528
- Process of Generating Inventory Transactions for Repairs on page 528

The workflow for repairs is illustrated in Figure 39 on page 526, which shows the steps of the process as follows:

1. **Receive and tag.** Receive RMA and create a repair order. The item may have been received as a stock transfer or over the counter.

2. **Internal or external repair.** If this is an internal repair, generate a repair activity and verify the service agreement. If this is an external repair, generate a repair order, ship to the external provider, and receive from the external provider.
3 **Return or keep in inventory.** After the repair is done, if the item is returned to the customer, allocate the item, generate the pick ticket, and ship. If the item is returned to good or defective inventory, generate the inventory transaction.

Repairs begin when a customer calls a service center about a defective product. The customer service representative assigns an RMA (Return Material Authorization) to the product, and requests that the customer ship the product to the service center. The RMA (either RMA Repair Return or RMA Advance Exchange) signifies that the product is to be repaired.
How Items Are Received for Repair

At the service center, the defective item is either repaired or shipped to a third-party provider for repair. If an external repair is chosen, a repair order (RO) number is assigned, which can track the item to and from the external vendor. When an external repair vendor performs the repair, the item’s repair is tracked to completion using the ship and receive dates to and from the external vendor. Siebel Repair generates the inventory transactions that record the product’s travels.

The defective product may be repaired and returned to the customer, or the product may be repaired and placed in good stock.

There are three routes for placing defective parts in the repair process:

- Repair items from customers generally arrive by a freight carrier and have an attached RMA. If no RMA is attached, it is necessary to create one.
- The field service engineer or an internal department can deliver a defective part over the counter to a repair center agent.
- The repair center may receive transfers from other internal locations (for example, if defective parts were collected at a field office and then sent to a repair facility). In the latter case, an internal order can track the parts transferred from one inventory location to another, or a stock transfer (inventory transaction) can be issued directly.

Repair Numbers

A repair number is a number assigned to a repair record, uniquely identifying the product to repair. A repair center agent physically attaches a tag containing this number to the product. The repair number, either a card or a marker (often a bar-coded label), lets the service business track defective parts through the repair process, whether or not they have serial numbers. For methods to customize this number, see “How Service Requests and Other Business Component Object Types Are Numbered” on page 52.

If the product is serialized, add the asset number to the repair record. This automatically provides the product name, inventory location, and inventory level (status and availability).

Some businesses prefer to speed up the receiving process by creating batches of repair numbers in advance. To do this, they create multiple blank repair records. When a defective part arrives, the repair center uses one of these blank records and its repair number. An agent then completes the record for this part.

Serialized Products and Inventory Locations

To generate a repair number for a serialized product, an asset number must be assigned. The transactions that accompany receiving the asset, through an RMA or field part movement, identify the destination inventory locations for these incoming parts.
Repair Activities

For the repair of an item, Siebel Field Service provides activity plans and activities:

- Repair activity plans automatically set up activities and generate activity records.
- Field service staff can manually create or update activity records.

Repair activities, activity plans, and activity templates function much as they do for other field service activities. See Chapter 4, "Field Service Activities," for more information.

As an item moves among inventory locations, Field Service records its movements by updating the Location, Status, or Availability fields in the repair record. These updates automatically generate inventory transactions.

Repair Orders

If a third-party provider performs repairs, Field Service can create a repair order. These orders record the transactions involved in shipping items to the external vendor and receiving the repaired items back from this vendor. For more information, see Siebel Order Management Guide.

Asset Repair Histories

Repair histories can be attached to assets to track defects over time. A repair history can associate several repair numbers with an asset. Failure trends can be detected from asset repair histories. Based on the occurrence of repair numbers, an asset can be identified as a financial liability. The decision to scrap may be justified if the repair cost is too high and a more reliable substitute product can be found.

Process of Generating Inventory Transactions for Repairs

Repair activities, generated from an activity plan, move parts from inventory location to inventory location. Each time a part moves, an inventory transaction is generated. Validations are performed for each transfer; for example, to move an asset to a destination inventory location, it must belong to a source inventory location. These steps summarize the transaction process for an internal repair:

1. Generate an inventory transaction as a Stock Transfer.
2. Commit the inventory transactions.
3. Update the inventory location ID (Prod_INV_ID) on the repair number (S_PART_RPR).
The rules for these inventory transactions are summarized in Table 139.

### Table 139. Rules for Inventory Transactions: Internal Repair

<table>
<thead>
<tr>
<th>Inventory Level</th>
<th>New Value</th>
<th>Transactions Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>NULL</td>
<td>NULL</td>
<td>No</td>
</tr>
<tr>
<td>NULL</td>
<td>INV1</td>
<td>No</td>
</tr>
<tr>
<td>INV1</td>
<td>INV1</td>
<td>No</td>
</tr>
<tr>
<td>INV1</td>
<td>INV2</td>
<td>Yes. Normal inventory transaction as <em>Stock Transfer</em>, with all validations.</td>
</tr>
<tr>
<td>INV1</td>
<td>NULL</td>
<td>No</td>
</tr>
</tbody>
</table>

**NOTE:** Previously, buckets were used instead of inventory levels.

### Sending Repairs to a Third-Party Vendor

In Shipping > Repair Pick Ticket, clicking the Process Shipment button generates transactions of the type Ship to TP (Third Party) to move a product from the defective inventory location to the third-party vendor, and sets the variables Defective and On Hand. This transaction updates the variables INVLOC_ID, INV_STATUS_CD, and INV_AVAIL_CD. For more information, see "Repair Pick Ticket Subview" on page 384. These steps summarize the transaction process:

1. Generate inventory transaction as Ship to TP and De-Allocate.
2. Commit inventory transactions.
3. Update the inventory location ID (Prod_INV_ID), inventory location (INVLOC_ID), status (INV_STS.STATUS_CD), and availability (INV_AVAIL_CD) on the Repair Number (S_PART RPR), using the BusComp FS Repair Without Update logic.

### Receiving Repairs from a Third-Party Vendor

On the Receiving screen, the Receive PO, Receive RMA, and the Receive Internal Order views, the Process Receipt command generates transactions, of the type Receive from TP, to move a product from a third-party vendor to the desired inventory location. This transaction updates the variables INVLOC_ID, INV_STATUS_CD, and INV_AVAIL_CD.

To receive an item from a third-party location, define the third-party location in the Service Order screen and the receiving location in the To Inventory field in the Receiving screen > Line Item Receipts view.

To go to the Receive PO, Receive RMA, or the Receive Internal Order view, first navigate to the Receiving screen, All Pending Orders view, and then click on a Receive Type field for any record. This exposes the Receive PO, Receive RMA, or Receive Internal Order views, with their subviews: [Receipt] Line Items, Received Line Item, and Serial Numbers.
These steps summarize the transaction process:

1. Generate an inventory transaction as Receive from TP.
2. Commit the inventory transaction.
3. Update the inventory location ID (Prod_INV_ID), inventory location (INVLOC_ID), status (INV_STSTUS_CD), and availability (INV_AVAIL_CD) on the Repair Number (S_PART_RPR), using the BusComp FS Repair Without Update logic.

The rules for these inventory transactions are summarized in Table 140.

Table 140. Rules for Inventory Transactions: Receive from Third-Party Vendor

<table>
<thead>
<tr>
<th>Inventory Transaction Type</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inventory</td>
<td>Inventory Level</td>
</tr>
<tr>
<td>Receive from TP</td>
<td>Source Invloc ID Comes from Service Order screen, Line Items view, Actions subview and is the Destination Location field.</td>
<td>On Hand Defective</td>
</tr>
</tbody>
</table>

**NOTE:** Previously, buckets were used instead of inventory levels. Also, in the preceding table, the asset rows are included in the transaction validation if the product is serialized.

**Exchanging an Asset During a Third-Party Repair**

If the third-party repair vendor returns a different part, the inventory transactions fail unless the new asset exists in the third-party inventory location. The user can accomplish this in one of two ways:

- Use the same Asset ID and change the serial number associated with this record.
- Create a new asset. Receive it from the third-party vendor using a Receive Other transaction. Then delete the previous asset, using another transaction.

**Returning a Product to Good Inventory**

To return a product to good inventory:

- For internal repairs, set the Inventory Location, Availability, and Status (usually Good) in the repair record.
- For repair orders, set the Inventory Location, Availability, and Status in the repair record.
Changing the values in the repair record triggers an inventory transaction which changes the inventory quantity.

**Inventory Levels for Repaired Parts**
If the defective part was received with an RMA Repair/Return, then the repair center returns the part using the regular shipping process (Allocate, Pick Ticket, and Ship).

When the part is repaired, either internally or by a third-party vendor, it receives an inventory level; for example, On Hand/Good. When the part is shipped, the inventory transaction records the product movement, but the information on the Repairs screen still points to the same inventory level, that indicates the last location for the repaired item in inventory. The inventory movements for a product do not update the last location of the product in the repair record.

**Setting Up and Configuring Repairs**
The following sections describe the configuration and transactions for repairs. Topics include:

- Setting Up Repair Activities on page 531
- Processing Defective Items for Repair on page 531

**Setting Up Repair Activities**
To create activity templates for repairs, see "To define activity templates" on page 73. See also "To associate activities with activity templates" on page 73.

*To define activity plans for repairs*
1. Navigate to the Repairs screen.
2. Select a repair record.
3. In the My Repairs list, drill down on the Repair # hyperlink.
4. In the Activities list, create a new activity plan record.
   - This action populates the fields in the Activities Plans and Activities lists.

**Processing Defective Items for Repair**
Follow these procedures to process defective items for repair.

*To receive defective parts with an RMA*
1. Navigate to the Receiving screen.
2. In the Pending POs/ROs/RMAs list, select an RMA Repair Return order.
Repairs ■ Setting Up and Configuring Repairs

3 Click the hyperlink in the Receive Type field.
4 Select a line item record in the Line Items subview.
5 In the Received Line Item list, create a record describing the received item.
6 Enter values in the fields, as needed.
7 If the item is a serialized asset, in the Serial Numbers list, create a record for it.
8 Enter values in the fields, as needed.
9 In the upper Receive RMA form, click Process Receipt.

To receive defective parts over the counter
1 Navigate to the Repairs screen.
2 In the My Repairs list, do one of the following:
   ■ Query for the repair item record with the repair number.
   ■ Create a new repair record.
3 Copy the value in the Repair # field.
4 Navigate to the Inventory Transactions screen.
5 Create an inventory transaction record.
   a In the Type field, select Over-the-counter.
   b In the Repair ID field, enter (paste) the repair number.
   c Enter values for the required fields.

To receive defective parts by stock transfer
1 Navigate to the Receiving screen.
2 In the Pending POs/ROs/RMAs list, select an Internal Order.
3 Click the hyperlink in the Receive Type Field.
   The Receive Internal Order view appears.
4 Select a line Item record in the Line Items subview.
5 In the Received Line Item list, create a new record.
6 Enter receipt details, as needed.
7 In the Serial Numbers list, create a new record.
8 Enter serialized asset details, as needed.
9 In the Receive Internal Order list, click Process Receipt.
To create a repair record
1. Navigate to the Repairs screen.
2. Create a new repair record.
3. If this repair record is for a serialized item, in the Asset # field, select an asset.
4. Associate the repair record with its service request by entering it in the SR # field.
5. Associate the repair record with its RMA by clicking the Show More button and selecting it in the RMA # field.

To add an activity plan and generate activities for a repair
1. Navigate to the Repairs screen.
2. Select a repair record.
3. In the My Repairs list, drill down on the Repair # field hyperlink.
4. Click the Activity Plans view tab.
5. In the Activity Plans list create an activity plan record.
6. In the Template field, select an activity template.
   This populates the Activities list with the activities in the template.

To view or update repair activities
1. Navigate to the Repairs screen.
2. Select a repair record.
3. In the My Repairs list, drill down on the Repair # field hyperlink.
4. Select an activity record.
5. Change the value of any field.

To track the movement of a defective part
1. Navigate to the Repairs screen.
2. Select a repair record.
3. In the My Repairs list, drill down on the Repair # field hyperlink
4. Click the More Info view tab.
5. Update the Location, Status, and Availability fields to show the current location and inventory level for a part.

To associate a repair order, RMA, or service request with a repair record
1. Navigate to the Repairs screen.
Repairs ■ Setting Up and Configuring Repairs

2 Select a repair record.
3 In the My Repairs list, drill down on the Repair # field hyperlink.
4 Click the More Info view tab.
5 Do one of the following:
   ■ To associate a repair order, in the RO Item # field, select a repair order.
   ■ To associate an RMA repair return, in the RMA # field, select an RMA.
   ■ To associate a service request, in the SR # field, select a service request.

To create a repair order
1 Navigate to the Service Order screen > List view.
2 In the My Service Orders list, create a new order record.
   a In the Type field, select Repair Order.
   b Enter values for the required fields.
3 In the My Service Orders list, drill down on the Order # field hyperlink.
4 In the Line Items list, create a record for each item to be repaired.
5 Complete the required fields.

To ship a defective part to an external repair provider
1 Navigate to the Repairs screen.
2 Select a repair record or create a new repair record.
3 Copy the value in the Repair # field.
4 Navigate to the Inventory Transactions screen.
5 Create a transaction record.
6 In the Type field, select Ship to TP.
7 In the Repair ID field, enter (paste) the repair number.
8 Complete the required fields.
   To receive a repaired item from a third-party vendor, see “To receive repaired items from a third-party vendor” on page 380.

To return a repaired or exchanged part to a customer
1 Navigate to the Service Order screen > List view.
2 Add a new order record.
   a In the Type field, select RMA Repair Return or RMA Advance Exchange.
   b Enter values for the required fields.
3 In the My Service Orders list, drill down on the Order # field hyperlink.
4 In the Line Items list, create a record for each item to be repaired or exchanged.
5 Complete the required fields.

To record time and expenses for a repair activity
1 Navigate to the Repairs screen.
2 Select a repair record.
3 In the My Repairs list, drill down on the Repair # field hyperlink.
4 In the Activities list, select an activity record.
5 Drill down on the Type field hyperlink.
   The Activity Attachments view appears.
6 Click the Time Tracker view tab.
7 Create a time record and complete the required fields.
   For more information, see the “Time Tracker View” on page 86.
8 Click the Expense Tracker view tab.
9 Create an expense record and complete the required fields.

To view an asset’s repair history
1 Navigate to the Repairs screen.
2 Select a repair record.
3 In the My Repairs list, drill down on the Asset # field hyperlink.
4 Click the Repairs view tab.
   The Repairs list shows the repair records for this asset.

Repairs Screen
The Repairs screen identifies repairs and the activities associated with these repairs. Topics include:
- More Info View on page 536
- Activity Plans View on page 536
- Activities View on page 536
- Repair Reports on page 536
More Info View

The More Info view records the information that is necessary to identify a repair, such as location, status, asset number, service request number, assigned technician, repair station, and relevant dates. Clicking Check Warranty button or selecting the Check Warranty command provides information about warranties for the asset requiring repair.

Activity Plans View

The Activity Plans view associates an activities plan and its activities with a repair number record. For more information, see "Activity Templates View" on page 79.

Activities View

The Activities view associates individual activities with a repair number record. Users can create and associate numerous activities with a single repair record.

Repair Reports

The Repairs screen provides the reports listed in Table 141.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repair Summary</td>
<td>A summary of each repair.</td>
</tr>
<tr>
<td>Repair Detail (Barcode)</td>
<td>One page for each repair and its associated activities. Includes barcodes.</td>
</tr>
<tr>
<td>Repair Detail (No Barcode)</td>
<td>One page for each repair and its associated activities. Does not include barcodes.</td>
</tr>
</tbody>
</table>

Assets Screen

The Assets screen records all information about assets, including service and repair history, components, associated activities, and preventive maintenance.

Repairs View

The Repairs view lists all the repair records for a selected asset.
This chapter presents the feature of Siebel Field Service that allows end users to enter data through barcodes. Topics include:

- Barcode Concepts and Terms on page 537
- Barcode Reader Input on page 537
- The Barcode Interface on page 538
- Setup and Configuration for Barcode Reading on page 543

## Barcode Concepts and Terms

The following terms and concepts are specific to the Barcode module.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode</td>
<td>A series of vertical bars printed or stamped on parts, containers, labels, or other media. These bars represent information that can be read by an electronic barcode reader attached to a computer system.</td>
</tr>
<tr>
<td>Barcode types</td>
<td>Multiple types of barcodes exist. Some can encode only numbers, while others can encode numbers, letters, and special computer control characters. Each uses a series of varying-width bars and spaces to represent characters. For information about supported barcode types, see Siebel System Requirements and Supported Platforms on Oracle Technology Network for your Siebel application.</td>
</tr>
<tr>
<td>Barcode scanner</td>
<td>An electronic device that detects a barcode's pattern of bars and spaces and transmits the pattern to a barcode reader.</td>
</tr>
<tr>
<td>Barcode reader</td>
<td>An electronic device that decodes the barcode patterns sent from a scanner into the characters they represent, and transmits those characters to a computer as though the data were typed in.</td>
</tr>
</tbody>
</table>

## Barcode Reader Input

Control character sequences before and after the barcode information notify your Siebel application that input is from a barcode reader, as follows:

- Ctrl - \ is the prefix signalling that the next input will be from a barcode reader.
- Ctrl - / is the suffix signalling that the barcode reader input has ended.

Any programmable barcode reader that can be configured to send this prefix and suffix before and after the barcode can be used with Siebel Field Service’s barcode automation functionality. To program the scanning preamble into a barcode reader, refer to the user manual or product reference guide provided with the barcode reader.
The Barcode Interface

This section includes procedures for using the screens and features for reading barcode data. For guidelines and details of configuration, see "Setup and Configuration for Barcode Reading" on page 543. Topics include:

- The Barcode Toolbar on page 539
- Printing Barcodes in Reports on page 541
- Scanning Barcodes for Toolbar Actions on page 541
- Entering Information from a Barcode Reader on page 542
- Finding Information with a Barcode Reader on page 542
- Setting Up a Barcode Interface on page 543
- Changing the Barcode Font for a Report on page 543

Siebel Field Service accepts data from a barcode reader into individual, active fields in your Siebel application. Data such as the following is often available in barcode format:

- Part numbers
- Asset numbers
- Repair numbers
- Order numbers
- Service request numbers
- Pick ticket numbers

**CAUTION:** The automated barcode module does not accept serial numbers as input. If end users need to scan serial numbers, make sure that the asset numbers are the same as the serial numbers.

With data from the barcode reader, an end user can perform the following types of operations:

- **New.** Enter the number from the barcode in a new line (record) in the view. In this mode, an end user goes to the view that is to receive a number, then clicks on a specific tab. Siebel Field Service creates a new record and fills the appropriate field in this record.

- **Update.** Update the number in a selected line (record) in the view. The new number replaces the existing number. In this mode, an end user goes to the view that is to receive a number, clicks on a specific tab, and selects a record. Siebel Field Service fills the appropriate field in the selected record.

- **Find.** Search the Siebel application for the place where the barcode input should go. In this mode, the incoming barcode finds its own destination, opens the appropriate view, selects a tab, and fills in the appropriate fields.

An end user can do the following operations:

- Enter individual barcodes of any acceptable type. Individual barcodes are entered with either the New or Update option.
Read multiple barcodes in succession, all of the same type (for example, either asset numbers or repair numbers). Individual barcodes are entered with the New option only.

**CAUTION:** If end users will be creating multiple barcodes in succession, make sure that all required fields in the records, except for the target field for the barcode data, have a default value.

### The Barcode Toolbar

Siebel Field Service provides a barcode toolbar that sets Siebel Field Service to use incoming data from a barcode reader. The barcode toolbar appears immediately below the application-level menu in the Siebel Service application.

The barcode toolbar is shown in Figure 40. It contains the following controls, from left to right: a New button, an Update button, a Find button, a Use drop-down list, and an Activate button.

![Figure 40. The Barcode Toolbar](image)

The barcode toolbar is shown or hidden according to the following factors:

- For a mobile client, the `sfs.cfg` file's `ShowBarcodeToolbar` parameter must be set. A value of TRUE shows the barcode toolbar, while a value of FALSE hides it. If your Siebel application is licensed to include barcode automation functionality, the parameter is set to TRUE by default.

- For a server configuration, a barcode toolbar parameter must exist in the SFSObjMgr. The name of this parameter is `Barcode Toolbar Enable Flag`. A value of TRUE enables the barcode toolbar, while a value of FALSE disables it.

**CAUTION:** A Siebel client running on an individual workstation cannot have both the Barcode toolbar and the CTI toolbar displayed at the same time.

Table 142 summarizes the functionality of the barcode toolbar buttons.

### Table 142. Barcode Toolbar Buttons, from Left to Right

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Enters a value of the specified type (Use) into a new record in the selected view.</td>
</tr>
<tr>
<td>Update</td>
<td>Enters a value of the specified type (Use) into an existing record and field in a selected record, replacing the number that was there.</td>
</tr>
</tbody>
</table>
Barcodes  ■  The Barcode Interface

Table 142. Barcode Toolbar Buttons, from Left to Right

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Locates the appropriate view and field, and enters a value of the specified type. When an end user scans the barcode, the application brings up the applicable view with the query already executed. The displays only those records that match the value scanned from the barcode.</td>
</tr>
<tr>
<td>Activate</td>
<td>Turns the barcode functionality on or off.</td>
</tr>
</tbody>
</table>

Of the first three buttons (New, Update, or Find), only one at a time can be active. Once clicked, a button remains active until another button is selected.

The Use drop-down list contains entry modes that define the type of information coming from the next barcode to your Siebel application. The contents of the Use drop-down list change according to the following factors:

■ Whether the New, Update, or Find button is selected
■ The active screen and view

It is necessary to select a value in the drop-down list only if more than one value appears in it.

### Keyboard Shortcuts for the Barcode Toolbar

Shortcut keys for barcode operation are shown in Table 143.

Table 143. Additional Keyboard Shortcuts for the Barcode Toolbar

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl - \</td>
<td>The first shortcut precedes the barcode data input and the second one follows it. When your Siebel application receives such input, it carries out a series of steps to copy the data from the barcode into the correct field in a view:</td>
</tr>
<tr>
<td>Ctrl - \</td>
<td>The first shortcut precedes the barcode data input and the second one follows it. When your Siebel application receives such input, it carries out a series of steps to copy the data from the barcode into the correct field in a view:</td>
</tr>
<tr>
<td>1</td>
<td>Determines the current view, tab, and active button on the Barcode toolbar.</td>
</tr>
<tr>
<td>2</td>
<td>Examines the records in the Barcode Mapping list to determine if there is a record for this combination of view, tab, and button selection. For more information, see “Setting Up a Barcode Interface” on page 543.</td>
</tr>
<tr>
<td>3</td>
<td>From the Barcode mapping record, determines the field in the corresponding record to receive the data.</td>
</tr>
<tr>
<td>4</td>
<td>Enters the barcode data in the target field defined in the Barcode Mapping list. Normally, these commands are programmed into the barcode reader and delivered as a prefix and suffix to the barcode data; they are not entered from the keyboard. For more information, see “Barcode Reader Input” on page 537.</td>
</tr>
</tbody>
</table>

**NOTE:** The shortcut definitions can be changed by editing the values for the Start Key Code and End Key Code user properties in the HTML FS Barcoding Tool Bar business service.

540  Siebel Field Service Guide  Version 8.0, Rev. B
Printing Barcodes in Reports

The following reports include barcodes, when available:

- **Pick Ticket Details (Shipping screen)**. The Pick Ticket number is barcoded.
- **Repair Detail (Repairs screen)**. The Repair Number number is barcoded.
- **Order Detail (Service Order and Sales Order screen)**. The Order number is barcoded.
- **Service Request Detail (Service screen)**. The Service Request number is barcoded.

The Reports menus display two versions for each report: barcoded and not barcoded. For information about barcode fonts, see *Siebel System Requirements and Supported Platforms* on Oracle Technology Network for your Siebel application.

Scanning Barcodes for Toolbar Actions

You can scan barcodes into Field Service to trigger the same actions as clicking the toolbar buttons. This is for the convenience of end users who do not have access to a mouse for clicking the toolbar buttons, or who need to shift frequently between the New, Update, and Find operations.

**Table 144** shows the barcode character combinations and their associated actions. The middle column, labeled Barcode Example, shows the actual barcodes that correspond to the Barcode Values (such as *NEW*), in a typical barcode font.

Table 144. Barcode Actions

<table>
<thead>
<tr>
<th>Barcode Value</th>
<th>Barcode Example</th>
<th>Action Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>NEW</em></td>
<td><em>NEW</em></td>
<td><strong>New Button</strong>. Scanning this barcode simulates clicking New on the barcode toolbar.</td>
</tr>
<tr>
<td><em>UPDATE</em></td>
<td><em>UPDATE</em></td>
<td><strong>Update Button</strong>. Scanning this barcode simulates clicking Update on the barcode toolbar.</td>
</tr>
<tr>
<td><em>FIND</em></td>
<td><em>FIND</em></td>
<td><strong>Find Button</strong>. Scanning this barcode simulates clicking Find on the barcode toolbar.</td>
</tr>
<tr>
<td><em>OPTIONS</em></td>
<td><em>OPTIONS</em></td>
<td><strong>Use ComboBox Selection</strong>. Scanning this barcode toggles between the various Use drop-down list selections in the barcode toolbar.</td>
</tr>
</tbody>
</table>

**CAUTION**: If you scan only the letters in barcode without the leading and trailing asterisks, the operation will fail. For example, to represent NEW, you must use this form: *NEW*.
Barcodes ■ The Barcode Interface

Entering Information from a Barcode Reader
This section explains how to enter information from a barcode reader into your Siebel application.

To create new records for barcode data
1 On the Barcode toolbar, click New.
2 Navigate to the view that is to receive the barcode information.
3 If more than one value appears on the Use drop-down list, select the type of information contained in the barcode; for example, an asset number.
4 Scan the barcode.
   The system creates a new record in the active tab and populates the appropriate field in the new record with the information from the barcode.
5 If you want to create multiple records, continue scanning the barcodes.

To update a record with barcode data
1 On the Barcode toolbar, click Update.
2 Navigate to the view that is to receive the barcode information.
3 If more than one value appears on the Use drop-down list, select the type of information contained in the barcode; for example, a part number.
4 Click the tab and select the record that is to receive the number from a barcode.
5 Select the record where you want the barcode information to go.
6 Scan the barcode.
   The system populates the appropriate field in the selected record with the information from the barcode. If the field already has a value, the barcode information replaces it.

Finding Information with a Barcode Reader
This section explains how to find information in your Siebel application with a barcode reader.

To find a record with barcode data
1 On the Barcode toolbar, click the Find button.
2 If more than one value appears on the Use drop-down list, select the type of information contained in the barcode; for example, a repair number.
3 Scan the barcode.
   If the data exists in the database, the system displays the record that matches the barcode input.
Setup and Configuration for Barcode Reading

This section describes the setup and configuration procedures for barcode reading.

Setting Up a Barcode Interface

The FS Barcode Mapping view on the Service Administration screen sets the destinations for barcode data. Based on these mappings, barcode data is copied to specific views, tabs, and fields. The data may create a new record or update an existing record. When mapping barcode data to fields, you add a record for each field that is to receive data from a barcode.

**NOTE:** Your Siebel application comes with a complete series of barcode mappings. You do not have to add or change any mappings unless you want to configure custom mappings.

To set the destinations for barcode data in specific views, tabs, and fields, use the procedure that follows.

*To map barcode data to views, tabs, and fields*

1. Navigate to the Administration - Service screen > Barcode Mappings view.
2. Create a new record for every field that is to receive barcode data.
3. Complete the fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Name</td>
<td>View that is to receive the data.</td>
</tr>
<tr>
<td>Applet Name</td>
<td>Applet (tab) that is to receive the data.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Field that is to receive the data.</td>
</tr>
<tr>
<td>Entry Mode</td>
<td>Type of information to receive from the barcode input.</td>
</tr>
<tr>
<td>Process Mode</td>
<td>Type of operation that will bring focus to the specified field</td>
</tr>
</tbody>
</table>

Changing the Barcode Font for a Report

You can change the barcode font in reports that include barcodes. For instructions about how to change the font, see the chapter on global report modifications in *Siebel Reports Administration Guide*.
This appendix provides reference information about logging levels for the engines available in Siebel Field Service as business services.

### Business Service Engines for Siebel Field Service

To facilitate configuration, maintenance, and multilanguage support, the following engines within Siebel Field Service are implemented as business services:

- Cycle Counting Engine
- Fulfillment Engine
- Mobile Inventory Transaction Engine
- Part Locator Engine
- Preventive Maintenance Engine
- Replenishment Engine

### Server Component Aliases

As with every component of the Siebel Server, each of these engines has an alias. These aliases are used as parameters in SRVRMGR commands. Table 145 lists the aliases for the server components associated with each engine.

<table>
<thead>
<tr>
<th>Engine</th>
<th>Server Component Alias</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle Counting</td>
<td>FSCyccnt</td>
</tr>
<tr>
<td>Fulfillment</td>
<td>FSFulfill</td>
</tr>
<tr>
<td>Mobile Inventory Transaction</td>
<td>FSInvTxn</td>
</tr>
<tr>
<td>Part Locator</td>
<td>FSLocate</td>
</tr>
<tr>
<td>Preventive Maintenance</td>
<td>FSPrevMnt</td>
</tr>
<tr>
<td>Replenishment</td>
<td>FSRepl</td>
</tr>
</tbody>
</table>
Logging Levels

Each engine has an associated logging level. A logging level is a level of detail for automatic event logging when a Siebel application component is running. The logging level is expressed as a number, with higher numbers representing greater levels of detail. Table 146 shows the logging levels and their definitions.

Table 146. Engine Logging Levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Error</td>
<td>Logs anything that goes wrong.</td>
</tr>
<tr>
<td>2</td>
<td>Warning</td>
<td>Logs anything exceptional even if it does not stop the operation.</td>
</tr>
<tr>
<td>3</td>
<td>Trace</td>
<td>Traces the functioning of the engine. Generates a chronology of events even if they are not errors or warnings.</td>
</tr>
<tr>
<td>4</td>
<td>Debug</td>
<td>Generates a very detailed log. Mainly for use by Siebel developers.</td>
</tr>
</tbody>
</table>

The default logging level for each of the engines is 1. If you need more detail in testing or troubleshooting, you can specify a higher logging level for the engine. You can modify the logging level by using one of the following methods:

- **For individual event types.** Navigate to the Administration - Server Configuration screen > Components view > Events subview. For the component selected in the Components view, the Events subview shows each type of event that can be logged and its associated logging level.

- **For all event types.** Invoke the SRVRMGR.EXE command line utility. The command to pass is as follows:
  
  ```change evtloglvl <parameter> = <log level> for comp <parameter>```

  For example:

  ```change evtloglvl FSPrevMnt = 3 for comp FSPrevMnt```

  This command changes the logging level for all event types associated with the engine.

  **NOTE:** This command is case insensitive, except for the parameter.

For more information about configuring business services, see the chapter on business services in *Integration Platform Technologies: Siebel Enterprise Application Integration*.  

---

Siebel Field Service Guide Version 8.0, Rev. B
This chapter is a reference that explains the methods developed for the following:

- FS Agreement Charge Business Service on page 548
- FS Agreement Renewal Business Service on page 550
- FS Holiday API Service on page 551
- ISS Copy Service Business Service on page 552
- FS Asset Swap Service Business Service on page 552
- FS Asset Warranty Service Business Service on page 554
- FS Generate Conditional Charge Process Business Service on page 555
- FS Service Charge Business Service on page 556
- FS Cycle Counting Business Service on page 562
- FS Dispatch Board Utils Business Service on page 562
- FS Service Region Business Service on page 567
- FS Activity Cache Business Service on page 568
- FS Create Entitlement Business Service on page 568
- FS Verify Entitlement Business Service on page 570
- FS Fulfillment Service Business Service on page 575
- FS Part Locator Service Business Service on page 576
- FS Inventory Transaction Business Service on page 577
- FS Generate Conditional Charge Process Business Service on page 555
- FS Preventive Maintenance Business Service on page 580
- FS Replenish Business Service on page 581
- ABS Methods on page 584
- Optimization Engine Methods on page 593

Generally, a business service has the following characteristics:

- Defines reusable business logic that can be executed within the Object Manager
- Can be a built-in service that is defined in Siebel Tools or a run-time service that is defined in the Siebel client application by administrators
- Can be based on the CSSService Class (standard business service) or on specialized classes (specialized business service)

**NOTE:** Specialized business services are used only by internal Siebel Engineering personnel. Customers should not use specialized business services unless their behavior is specifically documented.

- Can be configured by properties or scripts (written in Siebel VB or Siebel eScript)
- Can be called by a workflow, a script, or directly from runtime events
- Can be used for generic code libraries that are called from other scripts
Agreements

Since Field Service version 7.8, pricing logic is defined using Pricing Procedures. The procedures are based on the Product Selection and Pricing (PSP) engine. The advantage of using the PSP engine is that pricing is fully configurable. When a product is added to an agreement line item or another asset is added, the PSP engine is selected to ascertain the price of the selected product. For more information about the PSP engine, see Siebel Order Management Guide. For more information about the procedures used for pricing, see Siebel Pricing Administration Guide.

NOTE: Because you can use pricing procedures to define pricing logic, pricing models and pricing factors are no longer used in Siebel Pricer.

See “Charges” on page 555 for more information on how invoicing and charging have changed.

This section describes some of the business services that relate to the area of agreements. These include:

- FS Agreement Charge Business Service on page 548
- FS Agreement Renewal Business Service on page 550
- FS Holiday API Service on page 551
- ISS Copy Service Business Service on page 552

FS Agreement Charge Business Service

This business service is called by the FS - Generate Agreement Charge workflow and the FS - Generate All Agreement Charges workflow. Field Service’s modularized charging and invoicing allows administrators to extend the workflow where necessary.

The Field Service Agreement Charge business service is used to generate charges based on an agreement item’s charge plan. See “Workflow to Create Agreement Charges” on page 302 and “Workflow to Generate All Agreement Charges” on page 303 for more information on how the business service methods are used within the workflow processes. See Figure 41 on page 558 for a graphical representation of the workflow.

This business service includes the following methods:

- CalculateRCAdjustAmount. See “CalculateRCAdjustAmount Method” on page 549 for more information.

- GenerateAdjustmentCharge. See “GenerateAdjustmentCharge Method” on page 549 for more information.
GenerateNRCCharge. See “GenerateNRCCharge Method” on page 549 for more information.

GenerateRCCharge. See “GenerateRCCharge Method” on page 549 for more information.

GenerateUsageCharge. See “GenerateUsageCharge Method” on page 550 for more information.

CalculateRCAdjustAmount Method

CalculateRCAdjustAmount is used to calculate the recurring charge (RC) adjustment amount based on the values for the RC Adjustment Unit Amount and the RC Adjustment Unit (Per Day/Per Week).

Usage
This method is called by the FS - Generate Agreement Charge workflow, which adjusts the RC amount.

GenerateAdjustmentCharge Method

GenerateAdjustmentCharge is used to generate the adjustment charge for an agreement line item.

Usage
This method is called by the FS - Generate Adjustment Charge workflow.

GenerateNRCCharge Method

GenerateNRCCharge is used to generate the nonrecurring charge (NRC) for an agreement line item.

Usage
This method is called by the FS - Generate NRC Charge workflow. Once the NRC is generated, the process also updates the NRC last-charged date on the charge plan.

Additional Details
The input date for this process should be in the local time format, which the process converts to Open Database Connectivity (ODBC) format (YY-MM-DD).

GenerateRCCharge Method

GenerateRCCharge is used to generate the RC amounts for an agreement line item.
Usage
This method is called by the FS - Generate RC Charge workflow. The workflow retrieves and converts the asset readings to charge amounts. Once the RC amount is generated, the process also updates the RC last-charged date on the charge plan.

Additional Details
The input date for this process should be in the local time format, which the process converts to the ODBC format (YY-MM-DD).

GenerateUsageCharge Method
GenerateUsageCharge is used to generate the usage charge for an agreement line item based on asset usage.

Usage
This method is called by the FS - Generate Usage Charge workflow. The workflow retrieves and converts the asset readings to charge amounts. Once the usage charge is generated, the process also updates the usage last-charged date on the charge plan.

Additional Details
The input date for this process should be in the local time format, which the process converts to ODBC format (YY-MM-DD).

FS Agreement Renewal Business Service
The Field Service Agreement Renewal business service is used to renew agreement line items. See “Workflow to Automatically Renew Agreement Line Items” on page 245 and “Workflow to Automatically Renew All Agreement Line Items” on page 245 for more information on how the business service methods are used within the workflow processes.

This business service includes the following methods:

- **RenewAgreement.** See “RenewAgreement Method” on page 550 for more information.
- **RenewAllAgreements.** See “RenewAllAgreements Method” on page 551 for more information.

RenewAgreement Method
RenewAgreement is used to renew one agreement item.
**Usage**
This method is called by the FS - Renewal Item workflow. The date and agreement ID are passed in to renew the agreement. The Renewal Agreement Item Id of the newly created agreement is then passed back as an output argument.

**RenewAllAgreements Method**
RenewAllAgreements is used to renew all agreement line items with a renewal date greater than the date entered in the input argument.

**Usage**
This method is called by the FS - Renewal Item workflow.

**FS Holiday API Service**
The FS Holiday API Service is used to calculate the business time taken to accomplish a task, to calculate committed time based on a service calendar and exception calendar, or to return an output indicating whether a day is a defined holiday and return the next working day.

The business service includes the following methods:

- **GetElapsedBusinessTime.** See "GetElapsedBusinessTime Method" on page 551 for more information.
- **GetResponseTime.** See "GetResponseTime Method" on page 572 for more information.
- **IsHoliday.** See "IsHoliday Method" on page 551 for more information.

**GetElapsedBusinessTime Method**
This method calculates the business time taken to accomplish a task. It calculates the business time that has elapsed between two dates, according to a schedule that runs in a specific time zone.

**Usage**
This method is called from the FS Holiday API Service.

**Additional Details**
This method is not used as part of any workflow process.

**IsHoliday Method**
This method returns an output indicating whether a day is a defined holiday and returns a value for the next working day.
Usage
This method is called from the FS Holiday API Service. It returns Yes if the Working field is unchecked for the holiday definition of that day, or No if the Working field is checked. See “Defining Hours for Employees” on page 117 for more information on the Working field.

Additional Details
This method is not used as part of any workflow process.

ISS Copy Service Business Service

The ISS Copy Service business service is used for a number of features in Field Service, including auto contracts. Oracle’s Siebel Order Management copies data from one document type to another as a transaction progresses. Example transactions for which data is copied from one document type to another include the following:

- Quote-to-Agreement
- Opportunity-to-Quote
- Order-to-Agreement
- Agreement-to-Order

In earlier releases, the mapping between objects was either hard-coded (as in Quote-to-Agreement) or inconsistently defined (such as with business component user properties). Since the 7.8 release, all mappings between objects are defined in the Administration - Application > Data Map Administration views of the run-time client. Using the Administration - Data views and the ISS Copy business service, you can create new mappings and update existing mappings. A mapping can support one or more business components from a business object (for example, quote, quote line item, and quote payments).

See Siebel Order Management Infrastructure Guide for more information about the ISS Copy Service business service.

Asset Management

This section describes some of the business services that relate to the area of asset management. These include:

- FS Asset Swap Service Business Service on page 552
- FS Asset Warranty Service Business Service on page 554

FS Asset Swap Service Business Service

The Field Service Asset Swap Service business service is used to swap warranties or entitlements during asset exchange. See “Asset Swaps” on page 470 for more information about how asset swapping is accomplished.
This business service includes the following methods:

- **SwapAssetEntitlements.** See “SwapAssetEntitlements Method” on page 553 for more information.
- **SwapAssetWarranties.** See “SwapAssetWarranties Method” on page 553 for more information.

### SwapAssetEntitlements Method

SwapAssetEntitlements is used to swap asset entitlements. Service activities often include the replacement of one asset with another. When two assets are swapped, the entitlements of the uninstalled asset can be transferred to the installed asset on an individual basis.

For contracts which include entitlements for the removed asset, those entitlements’ asset values on the Service Agreement Product business component are updated with the installed asset’s number, replacing the asset number of the uninstalled asset. When this business component is updated, the Asset # field on the Agreements screen > List > Entitlements > Products view changes to display the new asset.

Asset swaps also transfer any hierarchical relationships from the uninstalled asset to the installed asset, with one exception. The exception is that if an uninstalled asset is a child asset, the uninstalled asset’s parent becomes the installed asset’s parent, but the uninstalled asset keeps any children it may have.

**Usage**

This method is invoked when a record in the FS Activity Part Movements List Applet (used in the Activities screen > Part Tracker view) includes the following:

- Serialized asset
- Valid Swap Part Mvmt # value
- Commit flag set to Y (by selecting the check box or clicking the Commit button).

**Additional Details**

This method can also be invoked from eScript.

### SwapAssetWarranties Method

SwapAssetWarranties is used to swap asset warranties. Service activities often include the replacement of one asset with another. When two assets are swapped, the warranties of the uninstalled asset can be transferred to the installed asset on an individual basis.

**Usage**

This method is invoked when a record in the FS Activity Part Movements List Applet (used in the Activities screen > Part Tracker view) includes the following:
FS Asset Warranty Service Business Service

The Field Service Asset Warranty Service business service is used to retrieve, check, and create services for asset warranties.

This business service includes the following methods:

- **CheckAssetWarranty.** See “CheckAssetWarranty Method” on page 554 for more information.
- **CreateAssetWarranty.** See “CreateAssetWarranty Method” on page 554 for more information.
- **GetAssetWarranties.** See “GetAssetWarranties Method” on page 555 for more information.

CheckAssetWarranty Method

CheckAssetWarranty examines all the warranties for a given asset and checks whether any are applicable according to the Warranty Criteria business service user property.

Usage

When creating a service request or repair number for repairing an asset, the user can click the menu button and select the Check Warranty option (available on the Service screen > Service Request List > Service Details view) to instantly check the valid warranty coverage based on a specified day.

Additional Details

If a warranty is not associated with an asset, the Check Warranty feature automatically checks the parent and root assets to determine whether or not the asset is covered by an applicable component warranty. By default, a warranty check is made for the asset and a component warranty check is made for the asset subcomponents. The component warranty checks whether the subcomponent can be disabled by setting the value for the Sub Component Check business service user property to N.

The criteria for selecting applicable warranties are flexible and can be altered by changing the parameters in the Warranty Criteria business service user property.

CreateAssetWarranty Method

CreateAssetWarranty adds the input warranty to the source asset.
**Usage**
When an asset is created for a product that is covered by warranties, the user can verify the applicable warranties by clicking the Get Warranties button on the Assets screen > List > Warranty view. The number of days remaining on the warranty is automatically tracked.

**GetAssetWarranties Method**

GetAssetWarranties is used to retrieve all the warranties for a specified asset's product and then add them to the asset if not already done so.

**Usage**
When an asset is created for a product that is covered by warranties, the user can verify the applicable warranties by clicking the Get Warranties button on the Assets screen > List > Warranty view. The number of days remaining on the warranty is automatically tracked.

**Charges**

The Invoice Engine was extensively rewritten for Field Service version 7.7 to make charging and invoicing for service requests and activities more modularized. To accomplish this, Oracle introduced the charge system for managing charges associated with contracts, service requests, and activities. To support the use of the Charge Engine, all the services previously used to generate invoice line items were converted to generate charges instead. A flexible framework was also implemented to allow administrators to configure invoicing to meet their company's business requirements by simply creating business services and plugging them into the framework.

This section describes some of the business services that relate to the area of charges. These include:

- **FS Generate Conditional Charge Process Business Service**
- **FS Service Charge Business Service**

**FS Generate Conditional Charge Process Business Service**

This business service includes the following methods:

- **GenerateCharge.** See “GenerateCharge Method” on page 556.
- **GetCondCharge.** See “GetCondCharge Method” on page 556.

See "Setting Up Conditional Charge Plans” on page 293 and "Workflow to Create Conditional Charges“ on page 304 for more information.
GenerateCharge Method
GenerateCharge is used to adjust charges based on conditional charges.

Usage
This method is called by the FS - Generate Conditional Charge Process workflow.

GetCondCharge Method
GetCondCharge is used to get the conditional charge for an agreement.

Usage
This method is called by the FS - Generate Conditional Charge Process workflow.

FS Service Charge Business Service
The FS Service Charge business service is used to create charges and control invoicing for service requests and activities. This business service is called directly from C++ code on the applet class. The business service is called from the code rather than from a workflow in order to support handheld products.

This business service includes the following methods:
- **CreateExpenseCharge.** See “CreateExpenseCharge Method” on page 558 for more information.
- **CreateExpenseEntitlementCharge.** See “CreateExpenseEntitlementCharge Method” on page 559 for more information.
- **CreateOrderCharges.** See “CreateOrderCharges Method” on page 559 for more information.
- **CreatePartsCharge.** See “CreatePartsCharge Method” on page 560 for more information.
- **CreatePartsEntitlementCharge.** See “CreatePartsEntitlementCharge Method” on page 560 for more information.
- **CreateServiceCharges.** See “CreateServiceCharges Method” on page 560 for more information.
- **CreateTimeCharge.** See “CreateTimeCharge Method” on page 561 for more information.
- **CreateTimeEntitlementCharge.** See “CreateTimeEntitlementCharge Method” on page 561 for more information.

If, as administrator, you want to create your own workflow, follow the flow illustrated in Figure 41 on page 558. This figure shows the flow of control for the methods that are exposed by this business service. Figure 41 also shows several instances where the CreateCharge method is driven by the user properties on the business component. These user properties pass information to the user interface about which business services and methods to call.
To alter the flow for the service charges, you must edit the user properties on the business components listed in Table 147. Each individual item in the flow can be added or removed using these user properties.

Table 147. FS Service Charge Business Components and User Properties

<table>
<thead>
<tr>
<th>Business Component</th>
<th>User Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Request</td>
<td>ChargeExecuteBusinessComponent1</td>
<td>Action</td>
</tr>
<tr>
<td>Service Request</td>
<td>ChargeExecuteBusinessComponent2</td>
<td>Order Entry - Orders</td>
</tr>
<tr>
<td>Action</td>
<td>ChargeExecuteBusinessComponent1</td>
<td>Time Sheet Daily Hours</td>
</tr>
<tr>
<td>Action</td>
<td>ChargeExecuteBusinessComponent2</td>
<td>FS Expense Item</td>
</tr>
<tr>
<td>Action</td>
<td>ChargeExecuteBusinessComponent3</td>
<td>FS Activity Part Movement</td>
</tr>
<tr>
<td>Action</td>
<td>ChargeBusinessService</td>
<td>Invoice Charges Business Service</td>
</tr>
<tr>
<td>Order Entry - Orders</td>
<td>ChargeBusinessServiceMethod1</td>
<td>CreateServiceCharges</td>
</tr>
<tr>
<td>FS Activity Parts Movement</td>
<td>ChargeBusinessService</td>
<td>Invoice Charges Business Service</td>
</tr>
<tr>
<td>FS Activity Parts Movement</td>
<td>ChargeBusinessServiceMethod1</td>
<td>CreatePartsCharge</td>
</tr>
<tr>
<td>FS Activity Parts Movement</td>
<td>ChargeBusinessServiceMethod2</td>
<td>CreatePartsEntitlementCharge</td>
</tr>
<tr>
<td>FS Expense Item</td>
<td>ChargeBusinessService</td>
<td>Invoice Charges Business Service</td>
</tr>
<tr>
<td>FS Expense Item</td>
<td>ChargeBusinessServiceMethod1</td>
<td>CreateExpenseCharge</td>
</tr>
<tr>
<td>FS Expense Item</td>
<td>ChargeBusinessServiceMethod2</td>
<td>CreateExpenseEntitlementCharge</td>
</tr>
<tr>
<td>Time Sheet Daily Hours</td>
<td>ChargeBusinessService</td>
<td>Invoice Charges Business Service</td>
</tr>
<tr>
<td>Time Sheet Daily Hours</td>
<td>ChargeBusinessServiceMethod1</td>
<td>CreateTimeCharge</td>
</tr>
<tr>
<td>Time Sheet Daily Hours</td>
<td>ChargeBusinessServiceMethod2</td>
<td>CreateTimeEntitlementCharge</td>
</tr>
</tbody>
</table>
CreateExpenseCharge Method

CreateExpenseCharge is used to create the base charge for an activity expense.
**Usage**
This method is called by the C++ class behind the Auto Charge button on the Activities screen > Activity List > Charges view. If you do not wish to have expenses charged, remove the user property ChargeBusinessServiceMethod1 from the FS Expense Item business component.

**Additional Details**
This method is not used as part of any workflow process.

### CreateExpenseEntitlementCharge Method
CreateExpenseEntitlementCharge is used to create the entitlement adjustment charge for an activity expense.

**Usage**
This method is called directly from the FS Charge List Applet - Auto Charge (used in the Activities screen > Activity List > Charges view). This view is used to create charges for an activity. The business service is called directly from the applet class.

**Additional Details**
This method is not used as part of any workflow process.

If you do not wish to have expense adjustment charged, remove the user property ChargeBusinessServiceMethod2 from the FS Expense Item business component. See Table 147 on page 557 for more information.

**TIP:** Charges can still be created even when there is a zero amount adjustment charge ($0). To remove such adjustment charges from the final invoice, you can modify the charge consolidation plan. Add a consolidation rule with Name = Search Spec and Value = [FS Charge. Amount = 0] AND [FS Charge.Entitlement Id <> NULL]. See "Consolidation Rule Subview" on page 311 for more information.

### CreateOrderCharges Method
CreateOrderCharges is used to create charges for all line items in an order.

**Usage**
This method is called directly from the FS Charge List Applet - Auto Charge (used in the Activities screen > Activity List > Charges view). This view is used to create charges for an activity. The business service is called directly from the applet class.

**Additional Details**
This method is not used as part of any workflow process.
CreatePartsCharge Method
CreatePartsCharge is used to create the base charge for an activity part movement.

Usage
This method is called directly from the FS Charge List Applet - Auto Charge (used in the Activities screen > Activity List > Charges view). This view is used to create charges for an activity. The business service is called directly from the applet class. This method then creates the charges for the parts used in the activity.

Additional Details
This method is not used as part of any workflow process.

CreatePartsEntitlementCharge Method
CreatePartsEntitlementCharge is used to create the entitlement adjustment charge for an activity part movement.

Usage
This method is called directly from the FS Charge List Applet - Auto Charge (used in the Activities screen > Activity List > Charges view). This view is used to create charges for an activity. The business service is called directly from the applet class. This method then adjusts the costs of the parts based on the associated entitlement.

Additional Details
This method is not used as part of any workflow process.

CreateServiceCharges Method
CreateServiceCharges is used to create service charges or entitlement adjustment charges for parts, expenses and time.

Usage
This method is called directly from the FS Charge List Applet - Auto Charge (used in the Activities screen > Activity List > Charges view). This view is used to create charges for an activity. The business service is called directly from the applet class. This method then aggregates all the charges for parts, time, and expenses.

If you do not wish to have expense adjustment charged, remove the user property ChargeBusinessServiceMethod1 from the Action business component. See Table 147 on page 557 for more information.
Additional Details
This method is not used as part of any workflow process.

CreateTimeCharge Method
CreateTimeCharge is used to create charges based on reported time.

Usage
This method is called directly from the FS Charge List Applet - Auto Charge (used in the Activities screen > Activity List > Charges view). This view is used to create charges for an activity. The business service is called directly from the applet class. This method then creates the time charges for the activity, based on the hourly rate of the activity owner.

Additional Details
This method is not used as part of any workflow process.

If you do not wish to have expense adjustment charged, remove the user property ChargeBusinessServiceMethod1 on the Time Sheet Daily Hours Item business component. See Table 147 on page 557 for more information.

CreateTimeEntitlementCharge Method
CreateTimeEntitlementCharge is used to create time entitlement adjustments.

Usage
This method is called directly from the FS Charge List Applet - Auto Charge (used in the Activities screen > Activity List > Charges view). This view is used to create charges for an activity. The business service is called directly from the applet class. This method then adjusts the cost of the hourly resource, based on the entitlement associated with the activity.

Additional Details
This method is not used as part of any workflow process.

If you do not wish to have time adjustment charged, you should remove the user property ChargeBusinessServiceMethod2 on the Time Sheet Daily Hours Item business component. See Table 147 on page 557 for more information.

Cycle Counting
This section describes the FS Cycle Counting business service.
FS Cycle Counting Business Service

The Field Service Cycle Counting business service has just one method, GenerateCounts. See "Cycle Counting" on page 417 for more information about the Cycle Counting Engine.

GenerateCounts Method

GenerateCounts generates parts list for counting based on product classification data (ABC or XYZ).

Usage

The following input parameters are required for this method:

■ Mode
■ Start Date
■ End Date

Based on the Mode value (SQL, ID, TempTbl), the other inputs (ClientID, RowID or Where) must be specified. Loc/Type will indicate what the ClientID, RowID or Where values represent. For example, if the Loc/Type value is Loc, this it means that the RowID is an inventory location.

Additional Details

By default, cycle counting is run as a server component and not as a business service. The inputs are called if invoking from code or from a server component job.

Dispatch Board

This section describes some of the business services that relate to the Dispatch Board. These include:

■ FS Dispatch Board Utils Business Service on page 562
■ FS Service Region Business Service on page 567
■ FS Activity Cache Business Service on page 568

FS Dispatch Board Utils Business Service

The Field Service Dispatch Board Utils business service is a collection of methods that implement the functions of the Dispatch Board.

This business service includes the following methods:

■ AssetAssignActivity. See “AssetAssignActivity Method” on page 563 for more information.
■ AssetUnassignActivity. See “AssetUnassignActivity Method” on page 563 for more information.
■ AssignActivity. See “AssignActivity Method” on page 564 for more information.
- **CalculateDistanceVals.** See “CalculateDistanceVals Method” on page 565 for more information.
- **CalculateFromToAddresses.** See “CalculateFromToAddresses Method” on page 564 for more information.
- **GetCalculatedDistanceVals.** See “GetCalculatedDistanceVals Method” on page 566 for more information.
- **GetEmployeeScores.** See “GetEmployeeScores Method” on page 566 for more information.
- **GetWirelessCoverage.** See “GetWirelessCoverage Method” on page 566 for more information.
- **UnassignActivity.** See “UnassignActivity Method” on page 567 for more information.

## AssetAssignActivity Method

AssetAssignActivity is called when an activity is dropped onto the Asset Dispatch Board. This method is configurable and can be used to enable drag-and-drop events for business components configured to be displayed along the y-axis of the Asset Dispatch Board.

### Usage

This method is called by the Asset Dispatch Board applet (Asset DB Planned GanttChart AX Applet). In this applet, the business components shown vertically on the left are the Y business components (the y-axis). The X business component is the object getting scheduled (the x-axis); the object being scheduled is normally an activity. When it is called, the method updates the X business component’s Asset Id as defined in the Drag and Drop Update Field business service user property.

For example, in the Asset Dispatch Board, Asset Mgmt - Asset is the Y business component and Action is the X business component. When the user drags the Action onto the Asset Dispatch Board to assign an asset, the AssetAssignActivity method will take the Object Id of the Asset Mgmt - Asset business component and insert it into the Action business component’s Asset Id field.

If a new Dispatch Board, which had accounts on the y-axis, was required, then Account would be the Y business component. You could then change the user property on the AssetAssignActivity method to update the Account Id. In this case, the method would take the account’s Object Id and insert it into the Action business component’s Account Id field.

### Additional Details

If pre- or post-processing needs to be done on the drag and drop business event to support a specific business process, this method’s arguments can be accessed from custom code.

## AssetUnassignActivity Method

AssetUnassignActivity is called when an activity is dropped onto the bottom applet of the Asset Dispatch Board view.
Usage
This method is called by the FS Asset DB Unplanned Activity List Ax Applet when an object is dragged off the FS Asset DB Planned GanttChart AX Applet. The calling of this method is set using the Drag Drop Business Service applet user property. When it is called, the method sets the Activity Status to Unscheduled and clears the Asset Id field as defined in the Drag and Drop Update Field business service user property.

Additional Details
If pre- or post-processing needs to be done on the drag and drop business event to support a specific business process, this method's arguments can be accessed from custom code.

AssignActivity Method
AssignActivity is the method called when an activity is dropped onto the employee Dispatch Board. This method is designed to leverage the caching mechanism implemented on the Dispatch Board to maximize end user performance.

Usage
This method is called by the FS DB Planned GanttChart AX Applet. The calling of this method is set using the Drag Drop Business Service applet user property.

This method is specific to the CSSWWFrameGanttDBActX class used for dispatching employees. It is designed to perform the specialized ownership changes particular to the updating of the Action business component’s primary owner and the subsequent updating of the Dispatch Board’s performance cache.

When it is called, the method removes any previous primary owner, sets the new primary owner to the employee on the Y business component (shown on the Dispatch Board’s y-axis), and sets the status to Scheduled.

Additional Details
If pre-or post-processing needs to be done on the drag and drop business event to support a specific business process, this method's arguments can be accessed from custom code.

CalculateFromToAddresses Method
CalculateFromToAddresses is the first API called by GetCalculatedDistanceVals (see “GetCalculatedDistanceVals Method” on page 566 for more information). This API determines the activity location and the location of each of the employee, and outputs the results to CalculateDistanceVals.
Usage
This method’s default behavior (as determined by the business service user properties) is to identify the location for an activity as the activity’s personal address. If the location is not available, the method then checks the business address for the activity. It then retrieves the activity previous to the one being scheduled. If no previous activity is scheduled for an engineer, it sets the value for From Address to the address in the engineer’s employee profile. The field engineer’s originating address is set using the Start Shift Location Field Name user property. By default, this value is the engineer’s Start Home Address Id, as provided by the Start Home Address section on the Administration - User screen > Employees > Service Details view.

Additional Details
This method will search each activity’s addresses, in accordance with the order set by the From Address Id Props and To Address Id Props business service user properties. Each of these properties specifies the business component ID and address type of the address which must be checked. If the address type is set to TRUE, this signifies that it is a personal address; if the address type is set to FALSE, this signifies that it is a business address.

If the business address business component is not the same as the default, this can be set by adding a business service user property named Business Address CUT. The business address business component can then be specified in this new user property. The field engineer’s originating address is determined by the Start Shift Location Field Name business service user property. The default value for this user property is Start Home Address Id.

CalculateDistanceVals Method
CalculateDistanceVals is the second API called by GetCalculatedDistanceVals. This method calculates the distance between the new activity location and the employee location, and outputs a list of <Employee Id, Distance Value> pairs.

Usage
This method checks the City, State, and Postal Code fields on an address for matching entries in the Zip Code business component. The master list of geocodes can be reviewed using the Administration - Data screen > Zip Code Administration view. The lookup requires that all three fields (City, State, and Postal Code) match exactly in order to return the latitude/longitude location values used in the distance calculation. This calculation determines the straight line distance between the latitude/longitude coordinates for the two ZIP Codes.

Additional Details
The method returns a distance of -1 to alert users when there is no valid result from the data provided. Typically, invalid results occur because of a missing address or unmapped ZIP Code.
**GetCalculatedDistanceVals Method**

GetCalculatedDistanceVals is the API that calculates the distance between the selected activity location and the employee location, and outputs a list of <Employee Id, Distance Value> pairs.

**Usage**
The FS DB Planned GanttChart AX Applet calls this method, which then calls CalculateFromToAddress and subsequently, CalculateDistanceVals.

The method performs the following tasks:

1. Determines the location and starting time of the new activity.
2. Determines the location of the employee by:
   a. Identifying the employee’s activity whose end time is closest to the start time of the new activity
   b. Identifying the location of this activity
   c. If no such activities are found, the method chooses the employee’s default location. The address ID is defined in the Start Shift Location Field Name business service user property.
3. Calculates the linear distance between the two locations using the addresses of the unscheduled activity and the employee location.

**Additional Details**
The distance value of -1 is displayed if the method lacks sufficient valid address information to calculate a distance.

**GetEmployeeScores Method**

GetEmployeeScores returns the appropriate scores for a given employee as defined by the Assignment Manager server component.

**Usage**
This method is invoked from the Dispatch Board after the user clicks the Assignment Score button. The method looks at the mappings listed in the Administration - Scheduling screen > Server Key Mappings view to determine the appropriate Siebel application server to call for a particular service region.

**GetWirelessCoverage Method**

GetWirelessCoverage is the method that checks whether the employee has a wireless handheld device that is in coverage.
Usage
This method is invoked from the Dispatch Board after the user clicks the Wireless Coverage button. The method verifies whether an employee’s handheld device is on the network and returns Y or N depending on whether the ping is successful.

Additional Details
The method references the Wireless Coverage Timeout business service user property, which determines how many seconds the business service waits for a ping response.

UnassignActivity Method
UnassignActivity is the API that is called when an activity is dropped onto the bottom applet in the Dispatch Board view.

Usage
The FS DB Unplanned Activity List Ax Applet calls this method (as set in the Drag Drop Business Service applet user property) when an object is dragged off the FS DB Planned GanttChart AX Applet. The method then sets the Activity Status to Unscheduled.

Additional Details
If pre- or post-processing needs to be done on the drag and drop business event to support a specific business process, this method’s arguments can be accessed from custom code.

FS Service Region Business Service
The Field Service Region business service is used to retrieve the service regions for activities. This business service includes just one method, GetServiceRegionId.

GetServiceRegionId Method
GetServiceRegionId is used to retrieve the service region ID, based on the postal code (ZIP Code) that is passed to it.

Usage
This method is called whenever an address is added to an activity or service request. It then determines the service region mapped to that activity. This method is used to set the service region in the Service Request and Activity business components when an address is specified.
FS Activity Cache Business Service

The Field Service Activity Cache Service business service is used to clear or refresh cached activity data from the Dispatch Board. This business service includes the CleanUpCacheTable method, which is described in the following section.

CleanUpCacheTable Method

CleanUpCacheTable is used to clear the activity data cache table used by the Dispatch Board. The activity data in the cache table is duplicate data, created during a user session.

Usage

This method can be called manually, using the business service simulator or through the use of a repeating component job. See “Clearing Cached Activity Data” on page 182 for more information.

Entitlements

This section describes some of the business services that relate to entitlements. These include:

- FS Create Entitlement Business Service on page 568
- FS Verify Entitlement Business Service on page 570

FS Create Entitlement Business Service

The Field Service Create Entitlement business service is used in the process of entitlement creation. See “Workflow to Automatically Create Entitlements from an Entitlement Template” on page 240 for more information on how the business service methods are used within the workflow process.

This business service includes the following methods:

- CreateCoveredProds. See “CreateCoveredProds Method” on page 569 for more information.
- CreateEntitlements. See “CreateEntitlements Method” on page 569 for more information.
- GetEntitlementTemplates. See “GetEntitlementTemplates Method” on page 570 for more information.
- ValidateEntitlementTemplates. See “ValidateEntitlementTemplates Method” on page 570 for more information.

Entitlement Creation Process Flow

The FS Create Entitlement business service performs the following steps when the user clicks the Auto Entitlement button and the FS - Create Entitlement workflow process begins:

1. Checks whether the agreement is valid.
2 Retrieves the appropriate business components.
3 Retrieves the details for each agreement line item.
4 If the agreement Product ID is not empty, the business service retrieves the entitlement templates applicable to the agreement line item product.
   It does this by setting the Product ID on the product entitlement template.
5 For each of the product templates, the business service does the following:
   a Checks to make sure the current template was not already used in generating entitlements for this particular agreement.
   b Creates a new entitlement from the template.
   c Copies over the entitlement service metrics, preventive maintenance, pricing, and service details.
   d If the entitlement template Include Account flag is set to TRUE, it copies over the account information from the agreement and uses the settings from the template.
   e If the entitlement template Include Contact flag is set to TRUE, it copies over the contact into from agreement and use the settings from the template.
   f If the entitlement template Account All Contacts flag is set to TRUE, the business service copies over all the contacts from the account.
   g If the entitlement template Account All Products flag is set to TRUE, the business service copies over all the products from the account and adds them to the entitlement with the corresponding asset number.
   h If the entitlement template Contact All Products flag is set to TRUE, the business service copies over all the products associated with the contact. This includes the asset IDs, and so on.
   See “Configuring Auto-Entitlement for Quotes and Orders” on page 224 for more information.

CreateCoveredProds Method
CreateCoveredProds is used to retrieve a list of the service products covered by a particular entitlement template.

Usage
This method is called by the FS – Create Entitlement workflow.

CreateEntitlements Method
CreateEntitlements is used to create an entitlement based on the entitlement template.
Usage
This method is called by the FS - Create Entitlement workflow, when the user clicks the Auto Entitlement button. See “Configuring Auto-Entitlement for Quotes and Orders” on page 224 for more information.

GetEntitlementTemplates Method
GetEntitlementTemplates is used to retrieve a list of the entitlement templates associated with a specific service product.

Usage
This method is called by the FS - Create Entitlement workflow, when the user clicks the Auto Entitlement button. The method retrieves a list of all entitlement templates.

ValidateEntitlementTemplates Method
ValidateEntitlementTemplates is used to retrieve a list of the entitlement templates associated with a specific service product.

Usage
This method retrieves a subset of the entitlement templates. This subset includes only those templates with which the product is associated.

FS Verify Entitlement Business Service
The Field Service Verify Entitlement business service is used for entitlement verification purposes. See “Workflows for Entitlement Creation and Verification” on page 240 for more information on how the business service methods are used within the workflow processes.

This business service includes the following methods:

- **GenerateList.** See “GenerateList Method” on page 571 for more information.
- **GetBestPricedEntitlement.** See “GetBestPricedEntitlement Method” on page 571 for more information.
- **GetBestResponseTime.** See “GetBestResponseTime Method” on page 571 for more information.
- **GetNextItem.** See “GetNextItem Method” on page 572 for more information.
- **GetPrice.** See “GetPrice Method” on page 572 for more information.
- **getResponseTime.** See “GetResponseTime Method” on page 572 for more information.
- **GetTimeZone.** See “GetTimeZone Method” on page 573 for more information.
■ **ShowEntitlementPickList.** See “ShowEntitlementPickList Method” on page 573 for more information.

■ **UpdateEntitlementCounter.** See “UpdateEntitlementCounter Method” on page 574 for more information.

■ **VerifyPricingEntitlement.** See “VerifyPricingEntitlement Method” on page 574 for more information.

■ **VerifyServiceEntitlement.** See “VerifyServiceEntitlement Method” on page 574 for more information.

### GenerateList Method
GenerateList is a utility method used for looping through the workflow.

**Usage**
This method will return a set of entitlements for a specific business component based on the search specification passed to it from the VerifyServiceEntitlement method or VerifyPricingEntitlement method.

### GetBestPricedEntitlement Method
GetBestPricedEntitlement retrieves the best-priced entitlement, based on the entitlement discounts defined in the Agreements screen > Entitlements > Price Details view.

**Usage**
This method is called by the FS - Verify Entitlement Order Best Price and FS - Verify Entitlement Quote Best Price workflows. The method automates the process of verifying entitlements by cycling through all the entitlements for product line items and identifying the best-priced entitlement for each line item. It then stamps the ID of the best entitlement on each line item.

**Additional Details**
This method could be implemented by including it in a configured pricing procedure. This procedure could then consistently include contract discounts without explicitly requiring the user to invoke the method from the line item by clicking a button.

### GetBestResponseTime Method
GetBestResponseTime is used to get the best response time entitlement for a service request.
Usage
This method is called by the FS - Verify Entitlement SR Best Response Time' workflow. This workflow is invoked when the user clicks the Verify Best Time button on the service request detail applet (used in the Service Request form on the Service screen > Service Request List view). The method chooses the entitlement with the best response time metric matching the service request priority. Entitlement response times are defined in the Entitlements screen > Metrics view. It then calculates the commit time according to the service calendar and stamps it on the service request commit time field and entitlement.

Additional Details
In addition, this workflow can be easily extended to generate a series of dates used for an escalation path as defined by metrics on the agreement or by a default set of values. For example, the commit date/time for the first callback could be four hours, the field engineer onsite date may be within eight working hours, and the resolution may be required within three days. Each of these may be an independent metric calculated by GetBestResponseTime, and saved to the service request.

GetNextItem Method
GetNextItem is a utility method used for looping through the workflow.

Usage
This method is used by the workflows to find the best price entitlement for quotes and orders. It will cycle through the list then adjust the prices of the products based on the best entitlement.

GetPrice Method
GetPrice is used to retrieve the price for a product using the entitlement discounts.

Usage
This method can be used in the Quotes and Order screens to get the price of a product after it has been adjusted by the entitlement. The Product Id, Base Price, and Entitlement Id must be passed as arguments into this method. The new price is then passed back as the output.

GetResponseTime Method
GetResponseTime is used to retrieve the response time based on entitlement and priority.
Usage
This method is called by the FS - Verify Entitlement SR workflow. This workflow is invoked when the user clicks the Verify button on the service request detail applet (used in the Service Request form on the Service screen > Service Request List view). The method evaluates the response time metric that matches the service request priority for the selected entitlement. It then calculates the commit time according to the service calendar and sets the Date Committed and Entitlement fields for the service request.

This method can also be called from the FS Holiday API Service to calculate committed time based on a service calendar and exception calendar.

Additional Details
The workflow can also be automatically called based upon the priority of the SR. Calling the workflow automatically on service level agreements where the committed date/time is often linked to the priority of the service request.

GetTimeZone Method
GetTimeZone retrieves the time zone used in the response time calculation.

Usage
This method is used to retrieve the time zone based on the following inputs:

- Entitlement time zone
- Contact time zone
- Time zone for the service request owner
- System default time zone

Each of these inputs has an associated time zone. The GetTimeZone method selects the entitlement time zone first, if available. If the entitlement time zone is unavailable, the method selects the contact’s time zone. If the contact’s time zone is unavailable, the method selects the service request owner time zone. If none of these options is available, the method selects the system default time zone. After the time zone has been retrieved, it is passed to the GetResponseTime method to calculate the response time.

Additional Details
This method can be overwritten to handle other business scenarios.

ShowEntitlementPickList Method
ShowEntitlementPickList is used to display a list of entitlements from the search specification.
Usage
This method is a user interface step that shows a list of all the relevant entitlements based on the search specification passed from the VerifyServiceEntitlement method.

**UpdateEntitlementCounter Method**

UpdateEntitlementCounter is used to update the counters on an entitlement.

Usage
This method exists for administrators to use if it is required that the counter on an entitlement should be incremented or decremented. This would ideally be used in a situation where a company sells support on a per unit or in a multiunit pack, and wants to monitor usage of those units.

Additional Details
This method is currently unused.

**VerifyPricingEntitlement Method**

VerifyPricingEntitlement is used to return a list of eligible pricing entitlements.

Usage
Based on the account, contact, and product input arguments for this method, a suitable search specification is returned. This search specification can then be provided to the ShowEntitlementPickList method to show all relevant entitlements.

**VerifyServiceEntitlement Method**

VerifyServiceEntitlement is used to return a list of eligible service entitlements.

Usage
Based on the account, contact, asset, and product input arguments for this method, a suitable search specification is returned. This search specification can then be provided to the ShowEntitlementPickList method to show all relevant entitlements.

**Fulfillment**

This section describes some of the business services that relate to fulfillment. These include:

- FS Fulfillment Service Business Service on page 575
- FS Part Locator Service Business Service on page 576
FS Fulfillment Service Business Service

The Field Service Fulfillment Service business service is used to perform order fulfillment tasks. See “Fulfillment Engine” on page 323 for more information about how fulfillment is achieved in Field Service.

This business service includes the following methods:

- **Fulfill.** See “Fulfill Method” on page 575 for more information.
- **GenPickTickets.** See “GenPickTickets Method” on page 576 for more information.

Fulfill Method

The Fulfill method fulfills an order item, order, or a group of orders.

Usage

By default, the Fulfillment Engine is used as a server component and not a business service. The Fulfill command (on the Service Order screen > List view, click the menu button and select the Fulfill option) finds the order line items, allocates these items, and generates a pick ticket record for the item.

Additional Details

This method can be used in two ways:

1. You can invoke the Fulfillment Engine in the standard manner to analyze orders and allocate parts for each line item, and automatically generate pick tickets. While fulfilling the inventory, the Fulfillment Engine will take into account the inventory relationships set in the Inventory screen > Relationships view.

   The inputs for the standard manner of usage are described in “Setting Parameters for the Fulfillment and Part Locator Engines” on page 333.

2. You can explicitly specify the order in which inventory locations are considered by the Fulfillment Engine for fulfillment.

   Individual inventories may not be related to other inventories in the list—the inventories are sorted by the score. Inventory scoring can be used for geocode-based fulfillment, which means that orders should be fulfilled from the nearest possible warehouse.
The additional inputs required for this manner of usage are described in Table 148. See “Setting Parameters for the Fulfillment and Part Locator Engines” on page 333 for more information on the standard inputs.

Table 148. Inputs for Fulfill Method: Explicitly Specifying Inventory Location Order

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InvLocIds</td>
<td>A property set of Inventory Id and Score. The Inventory locations are considered in the sorted order of the Score.</td>
</tr>
<tr>
<td>Fulfill List Mode</td>
<td>The value for this can be ASCENDING or DESCENDING.</td>
</tr>
</tbody>
</table>

For example:
```
Fulfill List Mode = ASCENDING
{
  "XX-ABCD", 10
  "YY-PQRS", 34
  ...
} Type = InvLocIds
```

**NOTE:** If you intend to call the Fulfillment Engine with Fulfill List Mode set to Ascending (explicitly passing the sequence of Inventory Location IDs to be searched), do not set up Fulfills relationships between inventory locations in the Inventory screen > Relationships view. Order Fulfillment with Fulfill List Mode set to Ascending is intended to use only the inventory locations explicitly defined in the input and their sublevel locations.

### GenPickTickets Method

GenPickTickets is used to produce a pick ticket record.

**Usage**
The input for this method is the order ID for which the pick tickets are to be generated. The Generate Pick Tickets command (on the Service Order screen > List view’s Service Order form, click the menu button and select the Generate PickTickets option) produces a pick ticket record.

### FS Part Locator Service Business Service

The Field Service Part Locator Service business service is used to locate parts for fulfillment. See “Part Locator Engine” on page 328 for more information about this engine.

This business service includes just one method, Locate.
Locate Method

Locate is used to find (in inventory) the product specified in an order line item. The method also finds substitutes if the product is unavailable.

Usage
This method is called when the user clicks the Locate button on the Service Order screen > Line Items > Part Locator view. The method then locates the order line items in the inventory hierarchy.

Additional Details
By default, the Part Locator Engine is used as a server component and not as a business service. This method is similar to the Fulfillment method except that it does not allocate or generate pick tickets.

Inventory

This topic describes the Field Service Inventory Transaction business service.

FS Inventory Transaction Business Service

The Field Service Inventory Transaction business service is used by the Bulk Inventory Transaction - Asset List - Default workflow and Inventory Transaction - Asset List - Default workflow to transfer one or more assets at a time. See “Workflows to Perform Bulk Inventory Transactions” on page 359 for more information on these workflow processes.

This business service includes the following methods:

- **AddAssetsToTxn.** See "AddAssetsToTxn Method" on page 577 for more information.
- **AggrAssetsPerProdPerSource.** See "AggrAssetsPerProdPerSource Method" on page 578 for more information.
- **BulkTransfer.** See "BulkTransfer Method" on page 578 for more information.
- **CommitTxn.** See "CommitTxn Method" on page 578 for more information.
- **GetDetails.** See "GetDetails Method" on page 578 for more information.
- **SetTxnDetails.** See "SetTxnDetails Method" on page 579 for more information.
- **SetTxnDetailsFromTxnSet.** See "SetTxnDetailsFromTxnSet Method" on page 579 for more information.

AddAssetsToTxn Method

AddAssetsToTxn adds assets to the inventory transaction record.
**Usage**
This method is called by the Inventory Transaction - Asset List - Default workflow.

### AggrAssetsPerProdPerSource Method
AggrAssetsPerProdPerSource is used to aggregate assets, based on the properties specified by the Aggregate per Property 1...n string. Each such aggregation forms one transaction. This method allows assets of the same product with the same source details to be part of the same transaction.

**Usage**
This method is called by the Bulk Inventory Transaction - Asset List - Default workflow.

### BulkTransfer Method
The Bulktransfer method loops and calls the next step to create each inventory transaction. During each iteration, a child is removed and passed to the next step to create the transaction. When the child count reaches zero (0), the loop stops.

**Usage**
This method is called by the Bulk Inventory Transaction - Asset List - Default workflow.

### CommitTxn Method
CommitTxn commits the transaction.

**Usage**
This method is called by the Inventory Transaction - Asset List - Default workflow.

### GetDetails Method
GetDetails is used to query the specified business component and retrieve the fields that start with Input: xxx. These fields are added to the property set as properties. The method loops for each line item and queries for the fields.

**Usage**
This method is called by the Bulk Inventory Transaction - Asset List - Default workflow.
SetTxnDetails Method
SetTxnDetails creates the inventory transaction record. It can take only the input arguments that are fields on the Inventory Transaction business component or the fields that start with Default. This method generates the ID of the created transaction.

Usage
This method is called by the Inventory Transaction - Asset List - Default workflow.

SetTxnDetailsFromTxnSet Method
SetTxnDetailsFromTxnSet reads the transaction details from the Inventory Transaction Set property set and creates a transaction record. All fields specified by Inv Txn Field are populated on the transaction. This method calls the SetTxnDetails method internally.

Usage
This method is called by the Inventory Transaction - Asset List - Default workflow.

Invoices
This section describes the FS Charge Consolidation business service.

FS Charge Consolidation Business Service
The Field Service Charge Consolidation business service is used for invoice consolidation. See “Workflow to Consolidate Charges” on page 304 for more information on how the business service methods are used within the workflow process.

This business service includes the following methods:
- **CancelInvoice.** See “CancelInvoice Method” on page 579 for more information.
- **ConsolidateCharge.** See “ConsolidateCharge Method” on page 580 for more information.

CancelInvoice Method
CancelInvoice is used to cancel invoices, allowing for the charge consolidation to run again.

Usage
This method can be used to perform an update to change the status of existing charge records for an agreement line item to Expired or Canceled. See “Running Charges After Charge Consolidation Has Been Performed” on page 307 for more information.
ConsolidateCharge Method

ConsolidateCharge is used to consolidate the charges in the charge table, based on a set of rules that are defined in the consolidation plans.

Usage
This method is called by the FS - Charge Consolidation workflow, which is called when the user clicks the Execute Now button on the Administration - Contracts screen > Charge Consolidation Plans view.

Preventive Maintenance

This section describes the FS Preventive Maintenance business service.

FS Preventive Maintenance Business Service

The Field Service Preventive Maintenance business service has just one method, GeneratePM. See “Preventive Maintenance” on page 501 for more information about the Preventive Maintenance Engine.

GeneratePM Method

GeneratePM generates service requests and activities for the maintenance of assets, based on predefined triggers.

Usage
The following input arguments are required for this method:

- Mode
- End Date
- Sub-mode

Depending on the combination of the Mode and Sub-mode values, the other inputs can be specified. For example, if the value for Mode is SQL and the Sub-mode value is Assets&Plans, then the Plan SQL and Asset SQL arguments must be specified.

DefOrgID and DefActOwnerId denote the default organization for the service requests or activities created and the owner for the activities.

The input parameters are called if invoking from code or from a component request. See “Parameters for the Preventive Maintenance Engine” on page 513 for more information about the parameters used with this engine.
Additional Details
By default, this service is not used.

Replenishment
This section describes the FS Replenish business service.

FS Replenish Business Service
The Field Service Replenish business service is used for replenishment purposes. See “Replenishment Engine” on page 427 for more information about this engine.

This business service includes the following methods:

- GenerateOrder. See “GenerateOrder Method” on page 581 for more information.
- UnlockAllInventories. See “UnlockAllInventories Method” on page 581 for more information.

GenerateOrder Method
GenerateOrder is used to select source and target inventories when restocking is needed. The method then generates the orders required to obtain materials from an external provider, an internal inventory site, or an internal manufacturing facility.

Usage
The input parameters are called if invoking from code or from a component request. See “Parameters for the Replenishment Engine” on page 430 for more information about these parameters.

Additional Details
By default, the Replenishment Engine is run as a server component and not as a business service.

UnlockAllInventories Method
UnlockAllInventories is an API which can be used to unlock all the inventories.

Usage
In certain error situations, where the inventory may not be unlocked during replenishment, this API can be run to unlock the inventories.
Scheduling

This section describes the ABS and Optimization Engine methods. To load the ABS or Optimization Engine, use either eScript or a workflow process. See “Invoking the ABS and Optimization Engine Methods” for more information.

The following sections provide a list of methods that are supported for the ABS and Optimization Engine components:

- ABS Methods on page 584
- Optimization Engine Methods on page 593

Invoking the ABS and Optimization Engine Methods

The Appointment Booking System and Optimization Engine can be invoked through script by calling the predefined Server Requests business service and specifying the Appointment Booking Engine or Optimization Engine component. The methods must first be loaded and residing on the server before they can be called. Only the server request broker can determine the correct component that should be called for a given service region. See Siebel Business Process Framework: Workflow Guide for more information about using the Server Requests business service.

The following script is an example of how to call the ABS component with the GetAppointment method.

```javascript
var SRMSvc, BSWrite, BSRead;
var srmInputs, apptBookInputs, srmOutputs, tempPropSet;
var childPropSet, activePropSet, apptPropSet;
var errCode;

// use Server Request to call the Booking Engine

SRMSvc = TheApplication().GetService("Server Requests");
srmInputs = TheApplication().NewPropertySet();
apptBookInputs = TheApplication().NewPropertySet();
srmOutputs = TheApplication().NewPropertySet();
tempPropSet = TheApplication().NewPropertySet();

srmInputs.SetProperty("Mode", "Sync");
srmInputs.SetProperty("Method", "GetAppointment");
srmInputs.SetProperty("Component", "ApptBook");
```
apptBookInputs.SetProperty("ActId", "1-93J9");
apptBookInputs.SetProperty("SvcRegnId", "1-1BGD");

srmlinputs.AddChild(apptBookInputs);
SRMSvc.InvokeMethod("SubmitRequest", srmlinputs, srmOutputs);

// write out the outputs for debugging
childPropSet = TheApplication().NewPropertySet();
activePropSet = TheApplication().NewPropertySet();

childPropSet = srmOutputs.GetChild(0);
errCode = childPropSet.GetProperty("ErrCode");

if (errCode == "0")
{
    var apptCount = childPropSet.GetChildCount();
apptPropSet = TheApplication().NewPropertySet();
    for (var i = 0; i < apptCount; i++)
    {
        activePropSet = childPropSet.GetChild(i);
apptPropSet.AddChild(activePropSet);
    }
    // write out the inputs for debugging
    apptPropSet.SetProperty("number of appointments", apptCount);
apptPropSet.SetType("addedPropSet");
    Outputs.AddChild(apptPropSet);
}
else
{

ABS Methods

The ABS is used for scheduling purposes in Field Service. See “About the Appointment Booking System” on page 96 for more information about the ABS.

The following methods can be used with the ABS:

- **CancelAppointment.** See “CancelAppointment Method” on page 585 for more information.
- **CancelRequest.** See “CancelRequest Method” on page 585 for more information.
- **ConfirmAppointment.** See “ConfirmAppointment Method” on page 586 for more information.
- **DefragmentServiceRegion.** See “DefragmentServiceRegion Method” on page 587 for more information.
- **Get Appointment.** See “GetAppointment Method” on page 587 for more information.
- **Get Appointments.** See “GetAppointments Method” on page 588 for more information.
- **GetConfirmedAppointment.** See “GetConfirmedAppointment Method” on page 590 for more information.
- **LoadActivities.** See “LoadActivities Method” on page 591 for more information.
- **LoadEmployees.** See “LoadEmployees Method” on page 592 for more information.
- **ReloadServiceRegion.** See “ReloadServiceRegion Method” on page 592 for more information.
- **UnloadEmployees.** See “UnloadEmployees Method” on page 593 for more information.
**CancelAppointment Method**

CancelAppointment is used to cancel a scheduled appointment. The method sets the appointment status to Cancelled and removes the planned start and planned end. The time previously booked for this activity is then open and available for booking by the ABS.

**Usage**

This method is invoked when the user clicks the Cancel Appointment button on the Service screen > Service Request List > Activities view and the Activities screen > Activity List > Schedule view.

**Additional Details**

The inputs for this method are described in Table 149.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActId</td>
<td>Activity ID of the activity which needs to be scheduled.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

Table 149. Inputs for CancelAppointment Method

**CancelRequest Method**

CancelRequest is used to free all of the reserved time slots previously reserved by the GetAppointment method. The time slots are then available to be booked by the ABS for other requests.

**Usage**

This method is called when the user clicks the Cancel button on the Pick Appointment dialog box (Abs Result Pick Applet). This dialog box appears when the user clicks the Book Appointment button on the Activities screen > Activity List > Schedule view.

**Additional Details**

The inputs for this method are described in Table 150.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReqId</td>
<td>Request ID returned by the ABS for the GetAppointment method.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

Table 150. Inputs for CancelRequest Method

There are no outputs for this method.
ConfirmAppointment Method

ConfirmAppointment confirms the selected appointment (time slot) that the GetAppointment method has reserved. The activity is assigned to the given owner and starts during the selected time slot. This method also releases the other time slots that GetAppointment previously reserved.

The GetAppointment and GetAppointments methods generate a property set containing a list of time slots that are available for the activity. Each returned time slot contains properties. The time slot that these methods pass to the ConfirmAppointment method includes the Slot Start - SR Time Zone property, which is the slot start time in the time zone of the activity's service region.

Usage

This method is called when the user clicks the Book Appointment button on the Activities screen > Activity List > Schedule view, and selects a time slot from the Pick Appointment dialog box (Abs Result Pick Applet).

Additional Details

The inputs for this method are described in **Table 151**.

**Table 151. Inputs for ConfirmAppointment Method**

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReqId</td>
<td>Request ID returned by the ABS for the GetAppointment method.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

There are no outputs for this method.

ConfirmAppointment needs an additional input property request key for the Server Requests business service. See "Invoking the ABS and Optimization Engine Methods" on page 582 for more information. The following is a sample script that defines this additional input.

```javascript
var SRMSvc = TheApplication().GetService("Server Requests");
var srmInputs = TheApplication().NewPropertySet();
var apptBookInputs = TheApplication().NewPropertySet();
var srmOutputs = TheApplication().NewPropertySet();
srmInputs.SetProperty("Mode", "Sync");
srmInputs.SetProperty("Method", "ConfirmAppointment");
srmInputs.SetProperty("Component", "ApptBook");
srmInputs.SetProperty("ReqKey", Inputs.GetProperty("strSRId"));
// Or whatever way the service region ID is determined
```
```csharp
apptBookInputs.SetProperty("ActId", Inputs.GetProperty("strActId"));
apptBookInputs.SetProperty("SvcRegnId", Inputs.GetProperty("strSRId"));
apptBookInputs.SetProperty("ReqId", Inputs.GetProperty("strReqId"));
apptBookInputs.SetProperty("SlotStart", Inputs.GetProperty("strSlotStartTimeSRTimeZone"));
srmInputs.AddChild(apptBookInputs);
SRMSvc.InvokeMethod("SubmitRequest", srmInputs, srmOutputs);
```

### DefragmentServiceRegion Method

DefragmentServiceRegion is used to defragment the service region employees calendar. This removes gaps between scheduled appointments.

**Usage**

This method is called when the user clicks the Coalesce ABS button on the Administration - Scheduling screen > Service Regions List view.

**Additional Details**

The inputs for this method are described in Table 152.

### Table 152. Inputs for DefragmentServiceRegion Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

There are no outputs for this method.

### GetAppointment Method

GetAppointment reserves and returns a set of employee time slots in the service region for a given activity. This method is followed by ConfirmAppointment or CancelAppointment. This method has a timeout function to release reserved time slots in the event that neither of these are called in a timely fashion.

**Usage**

This method is called when the user clicks the Book Appointment button on the Service screen > Service Request List > Activities view and the Activities screen > Activity List > Schedule view.
Additional Details
The inputs for this method are described in Table 153.

Table 153. Inputs for GetAppointment Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActId</td>
<td>Activity ID of the activity which needs to be scheduled.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

This method outputs a property set containing a list of time slots that are available for the activity. Each returned time slot contains the properties described in Table 154.

Table 154. Outputs for GetAppointment Method

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Id</td>
<td>Unique ID to identify the request sent to the engine.</td>
</tr>
<tr>
<td>Assignee</td>
<td>Assignee available during the time slot.</td>
</tr>
<tr>
<td>Slot Start - SR Time Zone</td>
<td>Slot start time, in activity service region time zone.</td>
</tr>
<tr>
<td>Slot End - SR Time Zone</td>
<td>Slot start time, in activity service region time zone.</td>
</tr>
<tr>
<td>Slot Start</td>
<td>Slot start time. This parameter is always in GMT time zone, not the login user’s time zone.</td>
</tr>
<tr>
<td>Slot End</td>
<td>Slot end time, in client time zone. This parameter is always in GMT time zone, not the login user’s time zone.</td>
</tr>
<tr>
<td>Service Region Id</td>
<td>Service region ID of the activity.</td>
</tr>
<tr>
<td>Activity Id</td>
<td>Activity ID of the activity being scheduled.</td>
</tr>
</tbody>
</table>

GetAppointments Method

GetAppointments returns a time slot for each employee during which the employee could potentially be booked. The method reserves these time slots in memory until ConfirmAppointment or CancelRequest is called, or until the timeout elapses.

Usage

This method is similar to GetAppointment, but is called specifically by Assignment Manager. GetAppointments differs from GetAppointment in the following ways:

- The actual activities being booked do not exist yet, and will not be created until ConfirmAppointment is called.
- GetAppointments checks for several employees in the same request.
GetAppointments only returns one time slot for each employee instead of the number defined by the ABS - Default number of slots parameter. See “Schedule Parameters” on page 128 for more information.

- GetAppointments provides the additional flag, SameTimeFlag.
  - If SameTimeFlag is set to TRUE, all the employees must be scheduled together for the same time. Time slots will be returned for all or none of the specified employees.
  - If SameTimeFlag is set to FALSE, the employees can each be scheduled for different times between the earliest start time and latest start time. Time slots will be returned only for only those employees that can be scheduled.

Additional Details
The inputs for this method are described in Table 155.

Table 155. Inputs for GetAppointments Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
<tr>
<td>ReqId</td>
<td>Unique number to identify this request for a subsequent call to either confirm some of the time slots returned by this function or to cancel the request and free those slots.</td>
</tr>
<tr>
<td>EmployeeIds</td>
<td>IDs of all the employees that need to be scheduled during this time.</td>
</tr>
<tr>
<td>ActType</td>
<td>Type of the activity, This could be call, appointment, administration, and so on.</td>
</tr>
<tr>
<td>ActPriority</td>
<td>Value from the Priority field of the activity; 1-ASAP, 2-High, 3-Medium, or 4-Low.</td>
</tr>
<tr>
<td>NoSoonerThan</td>
<td>Value from the Earliest Start Time field of the activity.</td>
</tr>
<tr>
<td>NoLaterThan</td>
<td>Value from the Latest Start Time field of the activity.</td>
</tr>
<tr>
<td>Duration</td>
<td>Actual length of time for which each employee is required.</td>
</tr>
</tbody>
</table>
This method outputs a property set containing a list of time slots, which are available for the activity. Each returned time slot contains the properties described in the following table.

The outputs for this method are described in **Table 156**.

### Table 156. Outputs for GetAppointments Method

<table>
<thead>
<tr>
<th><strong>Output</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Id</td>
<td>Unique ID to identify the request sent to the engine.</td>
</tr>
<tr>
<td>Assignee</td>
<td>Assignee available during the time slot.</td>
</tr>
<tr>
<td>Slot Start - SR Time Zone</td>
<td>Slot start time, in activity service region time zone.</td>
</tr>
<tr>
<td>Slot End - SR Time Zone</td>
<td>Slot end time, in activity service region time zone.</td>
</tr>
<tr>
<td>Slot Start</td>
<td>Slot start time. This parameter is always in GMT time zone, not the login user's time zone.</td>
</tr>
<tr>
<td>Slot End</td>
<td>Slot end time. This parameter is always in GMT time zone, not the login user's time zone.</td>
</tr>
<tr>
<td>Service Region Id</td>
<td>Service region ID of the activity.</td>
</tr>
<tr>
<td>Activity Id</td>
<td>Activity ID of the activity being scheduled.</td>
</tr>
</tbody>
</table>

---

**GetConfirmedAppointment Method**

GetConfirmedAppointment is used to insert an activity into the schedule without presenting time slot alternatives.
Usage
This method is called when the user clicks the Contract Schedule button on the Activities screen > Activity List > Schedule view. It is also called when the user selects Insert Activity from the menu button on the Dispatch Board’s Unscheduled Activities list.

Additional Details
The inputs for this method are described in Table 157.

Table 157. Inputs for GetConfirmedAppointment Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActId</td>
<td>Activity ID of the activity that needs to be scheduled.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

The outputs for this method are described in Table 158.

Table 158. Outputs for GetConfirmedAppointment Method

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignee</td>
<td>Employee assigned to the activity.</td>
</tr>
<tr>
<td>StartDt</td>
<td>Activity scheduled start time, in service region time zone.</td>
</tr>
</tbody>
</table>

LoadActivities Method

LoadActivities is used to load activities into the ABS cache. When called, the ABS attempts to insert the activities into the employee schedules.

Usage
This method is called when the user clicks the Load button on the Administration - Scheduling screen > Service Region List > Activities view.

Additional Details
The inputs for this method are described in Table 159.

Table 159. Inputs for LoadActivities Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActIds</td>
<td>Comma separated activity IDs.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activities that need to be loaded.</td>
</tr>
</tbody>
</table>
There are no outputs for this method.

**LoadEmployees Method**

LoadEmployees is used to reload an employee into the ABS cache. This method can be useful in situations where there is a new employee being added to a service region, or where there is a schedule change for an employee already loaded into the ABS.

**Usage**

This method is called when the user clicks the Load ABS button on the Administration - Scheduling screen > Service Regions List > Employees view.

**Additional Details**

The inputs for this method are described in Table 160.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the employees that need to be loaded.</td>
</tr>
<tr>
<td>EmployeeIds</td>
<td>Comma separated employee IDs.</td>
</tr>
</tbody>
</table>

There are no outputs for this method.

**ReloadServiceRegion Method**

ReloadServiceRegion loads or reloads service region data into the ABS cache. This method should be called if the parameter sets or the schedule changes for a service region. It is also used to change the ABS time horizon for a service region.

**Usage**

This method is called when the user clicks the Load ABS button on the Administration - Scheduling screen > Service Region List view. It is typically invoked from a repeating component request that refreshes the service regions time horizon.
Additional Details
The inputs for this method are described in Table 161.

Table 161. Inputs for ReloadServiceRegion Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID that needs to be reloaded.</td>
</tr>
</tbody>
</table>

There are no outputs for this method.

UnloadEmployees Method
UnloadEmployees is used to remove employees from the ABS cache.

Usage
This method is called when the user clicks the Unload ABS button on the Administration - Scheduling screen > Service Region List > Employees view.

Additional Details
The inputs for this method are described in Table 162.

Table 162. Inputs for UnloadEmployees Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the employees that need to be unloaded.</td>
</tr>
<tr>
<td>EmployeeIds</td>
<td>Comma separated employee IDs.</td>
</tr>
</tbody>
</table>

There are no outputs for this method.

Optimization Engine Methods
The Field Service Optimization Engine (Optimizer) is used together with the ABS for scheduling purposes. See “About the Scheduling Optimizer” on page 96 for more information.

The following methods can be used with the Optimization Engine:

- **CancelAppointment.** See “CancelAppointment Method” on page 594 for more information.
- **GetConfirmedAppointment.** See “GetConfirmedAppointment Method” on page 594 for more information.
- **LoadActivities.** See "LoadActivities Method” on page 595 for more information.
CancelAppointment Method

CancelAppointment is used to cancel a scheduled appointment. This method sets the appointment status to Cancelled, removes the planned start and end time, and removes the activity from the cache.

Usage
This method is the same as the Appointment Booking Service’s CancelAppointment method. See “CancelAppointment Method” on page 585 for more information.

Additional Details
The inputs for this method are described in Table 163.

Table 163. Inputs for CancelAppointment Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActId</td>
<td>Activity ID of the activity that needs to be canceled.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

The outputs for this method are described in Table 164.

Table 164. Outputs for CancelAppointment Method

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>Optimizer error tracing message that is returned if an error occurs.</td>
</tr>
<tr>
<td>ErrorCode</td>
<td>Error code returned from the Optimizer, indicating whether or not the operation is successful. A value of 0 indicates success.</td>
</tr>
</tbody>
</table>

GetConfirmedAppointment Method

This method is used to insert the activity into the schedule without presenting time slot alternatives.
**Usage**
This method is the same as the Appointment Booking Service’s GetConfirmedAppointment method. See “GetConfirmedAppointment Method” on page 590 for more information.

**Additional Details**
The inputs for this method are described in Table 165.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActId</td>
<td>Activity ID of the activity which needs to be scheduled.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activity.</td>
</tr>
</tbody>
</table>

The outputs for this method are described in Table 166.

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignee</td>
<td>Employee assigned to the activity.</td>
</tr>
<tr>
<td>StartDT</td>
<td>Scheduled start time for the activity, in service region time zone.</td>
</tr>
<tr>
<td>Message</td>
<td>Optimizer trace message returned. This can include error messages.</td>
</tr>
<tr>
<td>ErrorCode</td>
<td>Error code returned from the Optimizer, indicating whether or not the operation is successful. A value of 0 indicates success.</td>
</tr>
<tr>
<td>ErrArgs</td>
<td>Arguments for the error message associated with the returned error code.</td>
</tr>
</tbody>
</table>

**LoadActivities Method**
LoadActivities loads activities into the Optimizer cache. The Optimizer then inserts them into an employee's calendar if the activities can be scheduled. The activity should already have a planned start and planned end.

**Usage**
This method is the same as the Appointment Booking Service’s LoadActivities method. See “LoadActivities Method” on page 591 for more information.
**Additional Details**
The inputs for this method are described in Table 167.

Table 167. Inputs for LoadActivities Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActIds</td>
<td>Comma separated activity IDs.</td>
</tr>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activities that need to be loaded.</td>
</tr>
</tbody>
</table>

The outputs for this method are described in Table 168.

Table 168. Outputs for LoadActivities Method

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>Optimizer error tracing message that is returned if an error occurs.</td>
</tr>
<tr>
<td>ErrorCode</td>
<td>Error code returned from the Optimizer, indicating whether or not the operation is successful. A value of 0 indicates success.</td>
</tr>
</tbody>
</table>

**LoadEmployees Method**

LoadEmployees is used to reload an employee into the Optimizer cache. This method can be useful in situations where there is a new employee being added to a service region, or where there is a schedule change for an employee already loaded into the Optimizer.

**Usage**
This method is called when the user clicks the Load Optimizer button on the Administration - Scheduling screen > Service Regions List > Employees view.

**Optimize Method**

This method starts the Optimizer for the requested service region.

**Usage**
This method is called when the user clicks the Optimize button on the Administration - Scheduling screen > Service Region List view.
Additional Details
The inputs for this method are described in Table 169.

Table 169. Inputs for Optimize Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activities that need to be optimized.</td>
</tr>
</tbody>
</table>

The outputs for this method are described in Table 170.

Table 170. Outputs for Optimize Method

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>Optimizer error tracing message that is returned if an error occurs.</td>
</tr>
<tr>
<td>ErrorCode</td>
<td>Error code returned from the Optimizer, indicating whether or not the operation is successful. A value of 0 indicates success.</td>
</tr>
</tbody>
</table>

ReloadServiceRegion Method

ReloadServiceRegion reloads the service region data into the Optimizer cache.

Usage
This method is called when the user clicks the Load Optimizer button on the Administration - Scheduling screen > Service Region List view.

Additional Details
The inputs for this method are described in Table 171.

Table 171. Inputs for ReloadServiceRegion Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the activities that need to be reloaded.</td>
</tr>
</tbody>
</table>
The outputs for this method are described in Table 172.

Table 172. Outputs for ReloadServiceRegion Method

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>Optimizer error tracing message that is returned if an error occurs.</td>
</tr>
<tr>
<td>ErrorCode</td>
<td>Error code returned from the Optimizer, indicating whether or not the operation is successful. A value of 0 indicates success.</td>
</tr>
</tbody>
</table>

**StopOptimize Method**

StopOptimize halts optimization for the service region.

**Usage**

This method is called when the user clicks the menu button and selects Stop Optimization. This selection is made from the Service Regions list on the Administration - Scheduling screen > Service Region List List view.

**Additional Details**

The inputs for this method are described in Table 173.

Table 173. Inputs for StopOptimize Method

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID on which optimization should be stopped.</td>
</tr>
</tbody>
</table>

The outputs for this method are described in Table 174.

Table 174. Outputs for StopOptimize Method

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>Optimizer error tracing message that is returned if an error occurs.</td>
</tr>
<tr>
<td>ErrorCode</td>
<td>Error code returned from the Optimizer, indicating whether or not the operation is successful. A value of 0 indicates success.</td>
</tr>
</tbody>
</table>
**UnloadEmployees Method**

UnloadEmployees can be used when employees become unavailable as a result of vehicle breakdown and so on.

This method updates an employee's schedule by adding new exception hours to the cache. The activities scheduled during the employee's exception hours will be rescheduled or unscheduled. Activities are rescheduled for any open slots that meet the hard constraints. Employees must have at least one defined exception hour.

**Usage**

This method is called when the user clicks the Unavailable button on the Administration - Scheduling screen > Service Region List > Employees view.

**Additional Details**

The inputs for this method are described in Table 175.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvcRegnId</td>
<td>Service region ID of the employees that need to be unloaded.</td>
</tr>
<tr>
<td>EmployeeIds</td>
<td>Comma separated employee IDs. However, the Optimizer only processes one employee at a time. This means that if more than one employee ID is provided, the Optimizer will only process the first employee ID.</td>
</tr>
</tbody>
</table>

The outputs for this method are described in Table 176.

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>Optimizer error tracing message that is returned if an error occurs.</td>
</tr>
<tr>
<td>ErrorCode</td>
<td>Error code returned from the Optimizer, indicating whether or not the operation is successful. A value of 0 indicates success.</td>
</tr>
</tbody>
</table>
A

ABS
ABS horizon, about using for long-range appointments 99
ABS horizon, defined 98
appointment booking, business process steps 101
appointment booking, technical process steps 102
coalescencing 145
constraints (table) 124
invoking from script using methods 582
methods 146
overview 96
preventive maintenance and ABS, guidelines for 104
reloading the cache manually 144
reloading the cache, about 140, 169
reloading the cache, guidelines for 141
reloading the cache, overriding a row limit 144
rules enforced by 103
running, requirements for 160
scenario 96
schedule data, cache management 169
schedule parameters (table) 128
scheduling horizons, example 98
scheduling horizons, list of 98
service region’s schedule, methods for obtaining 100
troubleshooting 160
ABS horizon, about 98
access list, role of 449
account service teams
about 473
adding role priorities 475
configuring 474
creating 474
accounts
entitlements, associating manually 237
entitlements, associating with 255
viewing invoices for 313
Accounts screen
about 313
Accounts Across Organizations view, about 47
Accounts reports 49
Accounts view 48
Activities views 56
Activity Plans view 56
Agent Committed, about 53
Agreements view 48
Assign command, about 54
Attachments view 56
Audit Trail view 56
Calendar view 56
Change Requests view 57
Charts view 59
Contact view 48
Decision Issues view 57
Entitlements view 48
information, summarized 46
Invoices view 58
Messages view 57
Metrics view 58
numbering service requests 52
Orders view 59
Service Details view 57
Service Hours view 58
Service Profile view 48
service requests across organizations 50
Service Requests views 51
Service screen 49
Solutions view 59
Survey view 58
Verify button, about 52, 53
Verify button, entitlement rules 54
Actions view, about using 344, 522
activities
about and types of 69
activity data, clearing cache 182
activity materials, ordering 76
activity templates and plans, using 71
adding scheduling information to 148
additional skills, recording 78
agreement, adding to 227
agreements, about associating with 259
analysis charts, list of 87
asset, reviewing by 477
assigning and scheduling 196
booking appointments for, about 150
Category field 72
calendar, creating 72
different time zones, considerations 100
expenses, tracking 309
hours spent on, logging 75
invoice, generating automatically 77
invoices, logic for generating 286
Lock Assignment flag, using 72
materials, verifying availability 76
moving between service regions 144
on-hand inventory, verifying 76
Preventive Maintenance Engine, about creating activities 510
pricing of 249
process of scheduling 148
products and assets, tracking 309
repair activities, recording time and expenses 535
repair activities, viewing and updating 533
repair, generating activity plan and activities for 533
reports, described 87
rules, assigning 81
schedules, viewing 85
service parts, recording movement 76
service region, about displaying activities for 143
service request, adding new activity 77
service request, associating with 43
service request, updating for 43
substitute product suggestions, viewing 88
tracking, about 31
trunk inventory, verifying 76
Unscheduled Activities list, about 175
verifying 76
viewing invoices by activity 310

Activities screen
All Activity view, about 80
Assignment Skills view, about 85
Charts view, about and fields (table) 87
Expense Tracker view, using for field service activities 82
Expense Tracker view, using for invoices 309
Instructions view, about 84
Invoices view, using for field service activities 84
Invoices view, using for invoices 310
Items view, about and fields (table) 85
Part Browser screen, about 89
Part Tracker view, about using for invoices 309
Part Tracker view, about using for service inventory 373
Part Tracker view, using for field service activities 82
Products screen, about and fields (table) 88
Readings view, about 84
Reports menu, activity reports 87
Schedule view, about 148
Schedule view, using for field service activities 85
Schedule view, using for scheduling 148
Steps view, about and fields (table) 86
Time Tracker view, using for field service activities 86
Time Tracker view, using for invoices 308
using, about 373
Activities view 56
about and buttons (table) 152
Assets screen, about using 486
Repairs screen, about using 536
service region, about displaying activities for 143
activities, billable
creating invoices for 299
expenses, recording for 296
parts, recording for 296
recording for service request 295
time, recording for 296
activity breaks, about and rules 119
activity data, maintaining and loading 143
Activity Gantt Chart
about 175
about using 198
behavior, changing 178
data, selecting activity for 195
queries and legacy data, using with 195
activity labor charges, tracking 308
activity plans
agreements, about associating with 259
repair, generating for 533
service request, associating with 43
technical documentation, adding to 463
test plans, adding to 459
Activity Plans view
about 56
about using 343
Repairs screen, about using 536
activity templates
about 71
Actions view, about associating preventive maintenance plans with 522
activity assignment, overview of 72
fields copied from, list of 71
order line items, associating with 343
preventive maintenance plans, associating with 517
Release Manager, setting up 452
Activity Templates view
about 78
Service Details subview, about and fields 79
Add Benefits button
  about configuring 279
adding
  conditions to benefits 272
adjustments
  invoice charges, about 286
  line items, invoicing logic 287
Administration-Application screen, about 246
Administration-Contracts screen, about 247
Administration-Pricing screen, about 246, 483
administrative tasks, list of 34
Agent Committed
  about 53
Agent Committed Time, about calculating 256
aggregate pricing, about setting up 250
agreement approval list, defining 210
agreement contacts
  agreements, viewing for 227, 229
  primary contact, associating 227
  verifying 227
  viewing 227, 229
agreement line items
  adding revenue line items 233
  adding revenue plans 233
  billing details, using for invoices 312
  charge plans, defining 229, 230
  conditional charge plans, defining 231
  creating automatically 237
  detail fields, viewing 254
  entitlements, creating automatically 237
  invoices associated with, viewing 255
  invoices, modifying 313
  invoicing logic 286
  line item detail, viewing 253
  pretax and preshipping price, viewing 253
  product attributes, viewing 253
  renewal terms, creating and modifying 254
  revenue, managing 232
  service pricing 247
agreement pricing plans
  asset-based pricing, about 203
  asset-based pricing, defining 203
  contract-based pricing, defining 205
  discounts, viewing 260
  nonrecurring plans, defining 288
  order-entitlement-based pricing, configuring 204
  service-based matrix pricing, about 204
  use plans, defining 291
agreement renewal, from opportunities and quotes 214
agreement terms
  adding to agreements 235
  defining 228
  terms and totals, viewing 259
agreement validation
  creating messages for 208
  creating rule sets for 207
agreements
  activities, about associating with 259
  activities, adding 227
  activity plans, about associating with 259
  activity plans, associating 227
  adding agreement terms 235
  adding multiple assets 215
  agreement approvals, setting up 209
  agreement charges and invoicing, about 202
  agreement management, about 202
  Agreement record, field descriptions 252
  agreement renewal, setting up 205
  agreement validation, setting up 207
  analysis charts, viewing 260
  approvals, submitting 228
  approvals, viewing 259
  attachments, viewing 259
  benefits, creating for 271
  business services 548
  configuring data maps for 212
  configuring signals for 211
  contract schedules, defining 294
  contract, verifying for 227
  cost of materials and revenues, viewing 257
  creating opportunities and quotes 214
  creating revenue plan templates for 216
  entitlements, manually adding 237
  files, attaching 228
  financial details, adding 228
  generated documents, viewing 234
  generating agreement documents 234
  generating approvals using ISS Approval (Agreement) workflow 246
  invoices, logic for generating 286
  ISS Approval (Agreement) workflow 246
  level of service, viewing 256
  new agreements, creating 226
  new agreements, verifying 226
  notes, adding 260
  overview 201
  preventive maintenance actions, generating 239
  preventive maintenance plans, associating with 516
  process of setting up 202
  related orders, viewing 260
  renewing using FS - Agreement Renewal All
Index ■ A

- workflow 245
- renewing using FS - Agreement Renewal workflow 245
- reports, viewing 261
- revising 226
- shipping information, defining 228
- terms, adding to 270
- use plan pricing, defining 291
- using 225
- using Auto Contract 210
- viewing by entitlement 226

agreements and products
- covered products, viewing 226
- products, adding 228
- purchased products, viewing 256

Agreements screen
- Line Items view, about using and fields (table) 311
- Preventive Maintenance subview, about using 523
- using for preventive maintenance, about 523

agreements, renewing
- using repeating component jobs 245

agreements, using co-terms 236

alarms, setting for activities 75
- about 74
- configuring 74

All Activities view
- about and views (table) 80
- activities, rules for assigning 81

All Exceptions view, about naming set of exceptions 109

All Inventory Locations Across Organizations, about 369

All Pending Orders view
- Pending Internal Orders subview, about using 385
- Pending POs/ROs/RMAs subview, about using 385
- using, about 385

All Schedule view
- about using to create multiple schedules 107

All Unknown Receipts view, about using 387

Allocate button, about using 325

Allocated Lines subview, about and fields (table) 382

Application Administration Screen, Activity Templates view 78

application design
- about 33

Appointment Booking System (ABS)
- See ABS

appointments

booking from the Activities screen 151

booking, conditions for 152

canceling 152

conditions for canceling 152

configuring booking information displayed 165

moving about and classes of operations 100

rescheduling in the Dispatch Board, about 199

time slots, displaying 166

approvals
- agreements, submitting for 228

asset costing
- adjusted cost, calculating 478
- Asset Mapping view, about mapping and cost adjustment 484
- cost delta and value 486
- Recost function, about 486
- replacement cost delta, calculating 478

Asset Dispatch Board, interface
- about 481
- Gantt chart, about 481
- Gantt chart, changing the date 482
- Gantt chart, changing the time intervals 482
- Gantt chart, querying for assets 482
- Gantt chart, viewing ToolTip information 483
- scheduling asset activities 483
- Unscheduled Activities list 481

asset hierarchy
- Components view, about displaying components 487
- hierarchical asset, generating from a product bundle 472
- overview 469
- shipping and receiving, considerations 378
- Transaction view, about working with 487

asset mapping
- Asset Mapping view, about cost adjustment 484
- overview 476
- Value view, about valuing assets 486

Asset Mapping view, about and fields (table) 484

asset measurements
- Asset Mapping view, about cost adjustment 484
- associating assets with measurements 479
- defining 476
- Measurement Analysis chart, about 487
- Measurements view, about 488
- reading from assets, recording 479
- reading results, analyzing 480
- recording readings 480
- usage data, about capturing 487
asset numbers, about recording serial/asset numbers 386

asset service teams
about 472
adding role priorities 474
creating 473

asset swaps, about 470

asset transactions
about 354
asset swaps, about 470
creating an asset 471
generation rules 357
transaction types, about 469
Transaction view, about creating 487

asset-based matrix pricing
defining 203
service products 247

asset-based pricing
about 203
enabling 216

assets
activities, reviewing all associated with 477
adding to agreement line items 215
allocation of products, specifying 361
asset hierarchy, reviewing 477
asset numbers by product and transaction, viewing 373
Assets view, about defining assets 485
asset-swapping during repairs 530
Audit Trail view, about viewing audit trail 489
business services 552
change requests, reviewing for assets 477
covered by entitlement, viewing 250
creating asset service teams 473
defining field engineer assignments 472
entitlement, associating 238
Entitlements view, about displaying entitlement for an asset 490
entitlements, associating manually 238
hierarchical, inventory transactions on 354, 355
movement of 88
movement tracking, viewing 373
operating status and history, viewing 490
preventive maintenance activities, reviewing 477
preventive maintenance plan, viewing the status for an asset 477
preventive maintenance plans, associating with 516
preventive maintenance plans, validating 510
by product and inventory location,
viewing 370
product, specifying for 361
properties of 467
readings from assets, recording 479
Recost function, about 486
registration 469
Relationships view, about recording backup and dependent assets 488
repair history, about attaching 528
repair history, viewing 535
repairs, reviewing for selected asset 477
serialization of 468
service request, adding additional assets to 44
service request, adding to 44
service request, generating for preventive maintenance 517
specifying for a product 361
Value view, about valuing an asset 486
warranties, associating with 495
warranties, automatically associating with 495
warranties, verifying and related information 496

Assets screen
Activities view, about using 486
Assets view, about and fields (table) 485
Assets, about using 484
Attributes view, about using 490
Audit Trail view, about using 489
Charts view, about using 487
Components view, about using 487
Entitlements view, about 490
Explorer Across Organizations view, about using 491
Explorer view, about using 490
History subview, about using 523
Measurements view, about using 488
Plans subview, about using 523
Preventive Maintenance view, about using 489
preventive maintenance, about using 523
Readings view, about using 487
Relationships view, about using 488
Repairs view, about using 488
Repairs, about using 536
Transaction view, about using 487
Uptime Data view, about using 490
Value view, about using 486
Warranties, about using 499
Warranty view, about using 499

Assets subview
Inventory screen, about and using 370
Products view, about using 522
Assets view
Assets screen, about and fields (table) 485
Inventory Transactions screen, about using 373
assets, setting up
associating with account 471
change requests, associating with 471
components, creating 472
measurements, defining 476
preventive maintenance plans, associating with 471
primary asset, associating with backup asset 471
role priorities, adding to employees associated with asset 474
transactions, manually associating 472
Assign command
about 54
field service engineers, assignment rules 54
Assignment Engine
about running automatically and interactive mode 55
Assignment Manager
about and using for scheduling activities 94
using to assign field service engineers 197
assignment rules
using role priorities 475
Assignment Skills view, about 85
Attachments view 56
Attributes subview, about using 343
Attributes view, about using 490
audit trail
content 62
overview 61
Siebel Remote users, about audit trail 62
Audit Trail view 56
Assets screen, about using 489
audit trails, about viewing by assets 489
Auto Contract
using with quotes and orders 210
Auto Receive flag, about 344
auto-entitlement
adding buttons 224
configuring 224
auto-invoice
about setting up 297
required information 299
auto-substitution, conditions for 330

B
backup assets
about recording using the Relationships view 488
Barcode report, about 385
Barcode Toolbar Enable Flag parameter, about 539
barcodes
barcode interface, setting up 543
barcode toolbar, about 539arcode toolbar, showing or hiding 539
concepts and terms 537
control characters 537
end user operations, list of 538
interface entry modes 540
interface overview 538
interface, control characters 540
new records for barcode data, creating 542
printing in reports 541
record, finding with barcode data 542
record, updating with barcode data 542
reports, changing fonts for 543
scanning, actions triggered by 541
toolbar buttons, described (table) 539
benefit template, creating 266
benefits
conditions, adding to 272
creating for an agreement 271
billable expenses
recording 295
Billable Flag, about 308
billable items
See invoice, billable items
billing terms
defined by service 249
discounts, viewing 260
entitlement services 249
expense exceptions 250
service billing details, viewing 257
service product exceptions 250
services, pricing for 247
time exceptions 249
break/fix activities. See repairs
Breakable flag, about 120
breaks
about and rules 119
activities, including in 120
break time, recording 120
break type, setting name of 120
defining and allowing them for activities 120
business constraints
contractual or legal, tracking 105
parts, availability of 155
business service engines
list of 545
logging levels, about and table 546
server component aliases 545
business services
Condition Evaluator Service 278
Contracts Accumulator Service 274
Contracts Resolver Service 275

**buttons**
Add Benefits, about configuring 279
Entitle button, about configuring 279
Revise, about configuring 279

**C**
cache
- clearing Dispatch Board’s cached activity data 182
- reloading service region data automatically to the ABS 146
- reloading service region data manually to the ABS 144
- reloading service region data manually to the Optimizer 145

**Calendar view** 56
**Category field**
- about 72
- child records, about creating 72

**centralized dispatch model and field service optimization** 105

**change request closures, verifying**
- about 413
- closed change requests, querying for 413
- closing change requests as verified 413
- reopening change requests 413

**change request, assessing by product marketing**
- about 405
- change request, reassigning 406
- prioritizing and assigning change requests 407
- unassigned change request, closing 406
- unassigned change requests, querying for 406

**change requests**
- assessing importance of, process of 394
- asset, associating with 471
- assets, viewing by 477
- closed change requests, querying for 413
- closing change requests as verified 413
- closing resolved change requests 411
- closures, verifying 397
- engineers, assigning to 408
- logging, process of 393
- multiple occurrence change requests, creating 408
- multiple occurrence links, breaking 409
- patch requests, process of creating 398
- prioritizing and assigning change requests 407
- products, verifying changes requests associated with 46
- reassigning 406
- related change requests, linking 410
- reopening change requests 413
- resolving, process of 395
- service request, associating with 42
- solution, associating with 64
- test passes, associating with 461
- unassigned change requests, closing 406
- unassigned change requests, querying for 406

**Change Requests view**
- about 66
- Service screen 57
- Solutions screen 67

**change requests, logging by quality assurance**
- about 403
- change request, logging 403
- existing change request, querying for 403
- service requests, generating change requests from 404

**change requests, resolving by engineering**
- about 408
- closing resolved change requests 411
- engineers, assigning change requests to 408
- multiple occurrence change requests, creating 408
- multiple occurrence links, breaking 409
- related change requests, linking 410

**charge consolidation plans**
- canceling charges 307
- creating 297

**Charge Consolidation Plans view**
- about 310
- Consolidation Rule subview 311
- Contract Schedule view 294

**charge plans**
- defining for agreement line items 229
- process for defining and running 229
- running, using the Charge button 230
- running, using workflows 217
- scenario 229
- setting up 288

**charges**
- automatically generate a charge for an activity 295
- automatically generate a charge for an agreement line item 295
- automatically generate multiple charges 230
- automatically generating for a service request 295
business services 555
canceling after charge consolidation 307
consolidating to generate invoices 300
creating manually for an agreement line item 294
FS - Generate Agreement Charge wo Goto Charges View workflow 303
FS - Generate Agreement Charge workflow 302
FS - Generate All Agreement Charges workflow 303
FS - Generate Conditional Charge Process workflow 304
process of setting up 288
repeating component job, using to generate multiple charges 206, 217
running batch consolidation 307
running charges after charge consolidation 307
workflow to consolidate charges 304
workflows, about 301
charges, workflows
improving performance and scalability 307
running in batch mode 307
Charts view 59
Assets screen, about using 487
Charts view, about and fields (table) 87
Check Trunk, using to verify on-hand inventory 76
closing a service request 45
coalesc ing, the ABS 145
Commit buttons
about 84
mechanism described 360
using, about 85
compliance, verifying 272
component job parameters
Cycle Counting Engine, setting a repeating job 423
Cycle Counting Engine, setting for 423
Fulfillment Engine, setting 335
Part Locator Engine, setting 335
Preventive Maintenance Engine (table) 512
Replenishment Engine (table) 430
Components view, about using 487
Condition Evaluator Service 278
condition template, creating 268
conditional charge plans
defining for agreement line items 231
scenario 231
setting up 293
conditions
adding to benefits 272
configuration parameters
Cycle Counting Engine, technical explanation 419
inventory, about aspect precedence 420
precedence rule for cycle counting 418
Replenishment Engine (table) 428
Consolidated Lines subview, about using 385
Consolidation Rule subview 311
Consolidation view
Consolidated Lines subview, about using 385
Qualified Lines subview, about using 384
Shipping screen, about using 384
Constraint Sets view
Constraints view, about 126
constraints
ABS and Optimizer (table) 124
Constraint Wizard, about using to create 126
creating constraint sets 126
creating constraints 126
service business constraints and examples 122
types of 123
viewing associated service regions 127
work hours, examples of limiting 123
Constraints Sets view
Service Regions view, about 127
Constraints view
Constraint Sets view, about 126
contacts
viewing invoices for 313
Contacts screen, about 313
Contacts view 48
contract management
See Siebel Contract Management
Contract Schedule button, about 159
Contract Schedule view, about for invoicing 294
contract scheduling
about and running 157
Contract Schedule button, about 159
cost function, factor calculations 134
Insert Activity button, about and conditions for using 158
Load button, about and conditions for use 159
Contract Scheduling period, defined 98
contract-based pricing
about 250
defining 205
order-entitlement-based pricing, configuring 204
contracts
See agreements
Contracts Accumulator Service 274
### Contracts Resolver Service 275
**correspondence**
service request, generating for 45

### Cost Function Details View, about 135
cost functions
about 123
about defining Optimizer function 134
factor calculations 134
viewing associated service regions 135
cost lists, about tracking 284
costs, calculating asset adjusted cost 478
co-terms, about 236

### Counted Serial Numbers subview, about using 440

### Customer Satisfaction Survey view
about 67
customers
repaired or exchanged parts, returning to 534
repaired parts, shipping to 531

### cycle count basis
inventory location type, defining for 424
inventory location, defining for 424

### cycle count class
inventory type and product, defining 424, 425

### cycle count setup
inventory location type, defining for 424
inventory type and product, defining 424, 425

### Cycle Count view, about using 372
cycle counting
business services 561
completing a cycle count 427
frequency and periods, defining for an inventory location type 425
overview 417
Part List view, about displaying product counts by location 440
parts lists, reviewing 426
parts, specifying manually 425
pending cycle counts, reviewing 426
populating variance and serial number data 427
precedence rule, about 418
results of a cycle count, recording 426
results, reviewing 427
scenario 420
variance information, viewing 440

### Cycle Counting Detail report 440

### Cycle Counting Engine
about 33
component job parameters, setting 423
component job parameters, setting a repeating job 423
configuration parameters (table) 420
configuration parameters, technical explanation 419
configuring tracing 425
counting results, reviewing 427
cycle count, running 427
FSCycnt parameters (table) 422
input and output 418
logging levels, modifying 546
methods, using to invoke 422
process overview and logic diagram 418
product classification methods 417
running interactively 426
synchronous or asynchronous operation, specifying 423
system preferences, changing 423
tracing levels, about 423
cycle counting parameters, viewing for a location 364
cycle counting setup
cycle count, defining basis for inventory locations 424
frequency and periods, defining for an inventory location 425
Inventory Location Types view, about assigning cycle counting parameters 434
inventory location, setting up by 424
parameters by location, defining 436
product parameters by location 435
start and end dates, defining 424
system preferences 421

### Cycle Counts screen
Cycle Counts view, about and fields (table) 439
using, about 439

### Cycle Counts subview, about and fields (table) 439

### Cycle Counts view
Cycle Counts subview, about and fields (table) 439
Inventory screen, about and fields (table) 438
More Info subview, about and fields (table) 438
Part List view, about and fields (table) 440
Variance view, about and fields (table) 440

### Cycle Counts views, about and fields (table) 439

---

**Siebel Field Service Guide Version 8.0, Rev. B 609**

---

**D data**
activity data, maintaining and loading 143
employee data, maintaining and loading 142
loading for service regions 169
Data Administration screen
Order Action Types view, about using 341
Order Types view, about using 341
views for configuring orders, about 340
data cleansing application, about 115
data maps
configuring for copying 213
using with agreements 212
data set, extending 320
Databases
remote and local databases, about
synchronizing 364
synchronization, trunk inventory 350
Date triggers, about 505
De-Allocate transaction
about and using Process Shipment
button 376
Shipped Line quantity conflict 383
decision issues
service request, finding for 46
view 57
Def Act Owner ID system preference, about 512
defective parts
defective items, receiving 527
external provider, shipping to 534
movement, tracking 533
over the counter, returning 532
processing for repair 531
stock transfers, tracking 532
warranty status, verifying 498
DeInstall transaction, about 469
dependent assets, recording 488
Details subview, about and fields
(table) 316
discounts, viewing 260
Dispatch Board
about and scheduling activities 173
business services 562
centralized dispatch procedures 174
local dispatcher procedures 174
overview 173
process flows, about 174
process for assigning activities 195
process for setting up 177
Dispatch Board, setting up
activity data, clearing cache 182
activity data, clearing cache using business
service simulator 182
adding drilldowns 185
adding query fields 187
adding user preference colors 192
changing days of the week displayed 190
changing label information displayed 188
changing time zone intervals 189
dispatcher responsibility, assigning to
users 183
displaying additional information on the y-
axis 183
enabling applets for drag and drop 191
optimizing display speeds 181
setting system preferences 178
setting user preferences 178, 192
Dispatch Board, user interface
about 29, 175
about scheduling information shown 175
about using 198
Activity Gantt Chart, about 175
Unscheduled Activities list 175
Dispatch Board, using
activities, searching for 196
assigning and scheduling activities, about 196
creating activities 198
displaying parent service regions, about 195
displaying specific dates 196
displaying specific service regions 195
field service engineers, assigning and
scheduling 197
querying with legacy data, about 195
rescheduling appointments, about 199
selecting data for display in Gantt chart 195
dispatcher responsibility
assigning to users, about 183
list of views for 183
Documents view, about and fields
(table) 234
Downgrade transaction, about 469
dynamic candidates
using for activity assignment 476
E
employee data
maintaining and loading 142
removing from the ABS cache 142
employee schedules
about and control of 116
associating with employees 117
break time, recording 120
break type, setting name 120
breaks, about and rules 119
breaks, defining and allowing them for
activities 120
breaks, including activities 120
constraints, examples of 123
defining employee unavailability 121
exception hours, defining 117
roles, about 119
rules for defining 116
shifts, about and rate types 118
skill-based routing, about 119
tavel conditions and travel time, about and setting fields 121
employees
associating with assets 473
defining assignments 472
roles, defining with locations 372
schedules, associating with 117
Employees view
about listing employees assigned to service region 142
Entitle button
about configuring 279
Entitle button, about using 247
entitlement templates
about 220
configuring auto-entitlement 224
creating 220
defining 221
metrics, defining 248
overview 247
preventive maintenance plans, defining 221
Preventive Maintenance subview, about and preventive maintenance plan 248
products, defining 221
service billing details, defining 221
special pricing, defining 221
template metrics, defining 221
entitlement-based pricing
adding auto-entitlement buttons 224
associating with quote 205
entitlements
accounts, associating manually 237
agreements, manually adding entitlements to 237
agreements, viewing for 226
assets, associating manually 238
assets, viewing 250
automatic entitlements, about 202
billing terms, defining 249
business services 568
Contacts subview, about using to associate contacts with an entitlement 256
contacts, associating manually 238
details, displaying for specific entitlement 256
FS - Agreement Renewal All workflow 245
FS - Agreement Renewal workflow 245
FS - Create Entitlement workflow 240
FS - Verify Entitlement Activity workflow 241
FS - Verify Entitlement Order workflow 242
FS - Verify Entitlement Quote Best Price workflow 243
FS - Verify Entitlement SR Best Response Time workflow 244
FS - Verify Entitlement SR workflow 244
Metrics subview, about recording performance measurements for 256
overview 218
performance metrics, adding 238
preventive maintenance plans, associating manually 239
products, associating manually 238
service billing details, viewing 257
service request, verifying for and selecting an entitlement 239
setting up 218
use plan pricing, defining 291
user properties, checking 220
using 236
verification workflows 240
viewing 255
Entitlements view
Accounts screen 48
Assets screen 490
entitlements, setting up
AlertEscalation Email workflow, activating 223
titlement template metrics, defining 221
titlement templates, defining preventive maintenance plans 221
titlement templates, defining service billing details 221
titlement templates, defining special pricing 221
escalation times, defining 222
products covered by entitlements, defining 221
schedule exceptions, defining 222
service activity, defining billing exception 222
service calendar, associating 238
service hours, defining 222
system preferences for verifying, table of 219
verification system preferences 219
Verify entitlements button, setting system preferences 219
escalation times, defining 222
Event subview, about and fields (table) 521
Event triggers, about 509
exception hours
about defining and scheduling 108
  defining a day or continuous blocks of
days 109
  defining for employees 117
  schedules, adding to 109

**Exception Hours view, about** 109

exchanged part, returning to customer 534

**expense exceptions, defining** 222

**Expense Tracker view**

field service activities, about and fields
  (table) 82
  invoices, about using for 309

**expenses**

activity, logging for 75
  recording for repair activities 535

**explanations**

service request, finding for 46

**Explorer Across Organizations view, about using** 491

**Explorer view, about using** 490

external locations
  about 353
  setting up 369

**F**

**Fast Guided Local search optimization method, about** 101

**field part movements, verifying** 44

**field service activities**

invoice, automatically generating 77
  material, verifying availability 76
  materials, ordering 76
  new activity, adding 77
  on-hand inventory, verifying 76
  order status, verifying 76
  service parts, recording movement 76
  substitute product suggestions, viewing 88
  tracking 82
  trunk inventory, verifying 76

**field service activities, setting up**

alarms, setting for activities 74
  field service activity templates, setting up 73

**field service activities, using**

activity, logging hours spent on 75
  expenses, logging for an activity 75
  field service engineer’s activities, reviewing 78
  instructions, recording additional 78
  materials for an activity, verifying availability
  and order status 76
  on-hand inventory, verifying using Check
  Trunk 76
  part movements in the field, verifying 78
  service activity steps, recording
  additional 77
  service parts, recording movement in the
  field 76
  skills required to complete activity, recording
  additional 78

**field service activity templates**

activity templates, associating activities
  with 73
  activity templates, defining 73
  steps, skills, parts and tools, and instructions,
  associating with an activity 73

**Field Service client**

invoking Preventive Maintenance Engine 511

**field service engineers**

activities, reviewing 78
assigning and scheduling with Assignment
  Manager 197
assigning and scheduling with Dispatch
  Board 197
assigning and scheduling with Service
  screen 197
Assignment Manager, employee assignment
  rules 54

**field service engines, list of** 33

files, attaching to agreements 228

**FS Activity Cache business service**

about 568

**FS Agreement Charge business service**

about 548

**FS Agreement Renewal business service**

about 550

**FS Asset Swap business service**

about 552

**FS Asset Warranty business service**

about 554

**FS Charge Consolidation business service**

about 579

**FS Create Entitlement business service**

about 568

**FS Cycle Counting business service**

about 562

**FS Dispatch Board Utils business service**

about 562

**FS Fulfillment Service business service**

about 575

**FS Generate Conditional Charge Process
  business service**

about 555

**FS Holiday API service**

about 551

**FS Inventory Transaction business service**

about 577

**FS Part Locator business service**
about 576
FS Preventive Maintenance business service about 580
FS Replenish business service about 581
FS Service Charge business service about 556
FS Service Region business service about 567
FS Verify Entitlement business service about 570
FS_PROD_ALLOC_RULES, about specifying 331
FSCyccnt component request parameters 422
FSFulfill component job parameter, about and table 333
FSLocate component job parameter 333
FSPrevMnt component request parameter, about 512
FSRepl component parameters (table) 430
fulfillment
Allocate button, about using 325
business services 574
Fulfill command, about 325
Generate PickTickets command, business flow 325
Locate button, about using 325
methods for 323
parameters, about and table 328
parameters, Fulfillment and Part Locator Engines 333
parameters, setting (procedure) 333
replenishment relationships, about setting 351
Fulfillment Engine
about 33
auto-substitution, conditions for 330
component job parameters, setting up 335
filling orders 336
inventory line items, status requirement 324
inventory locations, overview of locating 324
inventory option fields 340
inventory-specific attributes, list of 330
logging levels, modifying 546
overview 323
parameters, about 328
parameters, about and table 333
Parts Locator, compared to 323
process overview and function diagram 325
starting 334
substitute products, viewing 340
synchronous/asynchronous operation, setting 335
system preferences, table of 331
Fulfillment view
about using the Auto Receive flag 344
Future Release release type, about 402
G
Generate Orders view
about using 371
Inventory Locations view, about using 437
Source Locations subview, about using 437
Target Locations subview, about using 437
Generate PickTickets command, business flow 325
geocodes
about 113
data, specifications for 115
importing geocode data 114
Get Warranty button, about 499
Glued period, defined 98
Greedy search optimization method, about 101
Greenwich Mean Time (GMT), about and list of time zones 99
Guided Tabu search optimization method, about 101
H
handheld devices
computing support, about 30
hard constraints, about 123
heuristic methods
for the ABS 100
for the Optimizer 100
hierarchical assets
See asset hierarchy
History subview, about using 523
History view, about using 523
holidays, about using the Exception Hours view 109
I
inbound service center calls, handling sequence 28
Insert Activity button, about and conditions for using 158
Install transaction, about 469
installment plan
See nonrecurring payment plans
Instructions view, about 84
internal orders, allocating parts manually 335
inventory
assets and products, linking 361
cycle count, adjusting after 427
inventory module, about 31
inventory order, about specifying 353
mobile inventory transactions, about 359
on-hand inventory, verifying 76
on-hand inventory, verifying using Check Trunk 76
options allocated 368
Pending Internal Orders subview, using to view orders 385
Received Line Item subview, about recording inventory level 386
replenishing (procedure) 432
status for allocation 324
inventory categories, setting 367
Inventory Level Categories view, about using 367
Inventory Level subview
Product Inventory view, about and fields (table) 370
Product Inventory view, about using 372
inventory levels
about and examples 352
creating (procedure) 362
defining (procedure) 363
Inventory Level Categories view, about using 367
negative levels 353
products, associated with 370
Inventory Location Types subview, about using 367
Inventory Location Types view, about and fields (table) 434
inventory locations
across organizations 369
cycle count parameters, viewing for a location 364
cycle count, defining basis for 424
cycle counting frequency and period, defining for an inventory location type 425
employee, associating with 362
Inventory Locations Types view 367
location choices, displaying 369
multiple locations, viewing relationships among 371
organization, associating with 363
overview and location types, list of 348
relationships between, defining 363
Relationships view, about viewing relationships 437
repair numbers 527
truck inventory 350
Vendor view, about recording vendors 371
vendor, associating with a location 363
inventory locations and cycle count
cycle basis, defining 424
cycle count classes, defining 424
cycle count, setting up 424
cycle counting frequency and periods, defining 425
cycle counting parameters, viewing for a location 364
cycle counting replacement, about using for 435
cycle counting and replacement, about using 435
cycle counts parameters, viewing for a location 364
inventory location types, defining cycle count basis for 424
location types, about setting 367
overview of setting up 362
positions, defining roles 372
replenishment relationships, defining 432
setup diagram 349
structure network, overview 351
virtual locations 373
inventory locations, setup
cycle count classes, defining 424
cycle count, setting up 424
cycle count, verifying 364
cycle counting frequency and period, defining 425
cycle counting parameters, viewing for a location 364
defining cycle count basis for 424
defining inventory location types, setting 367
defining location types, setting 424
defining parameters, setting 424
defining replenishment relationships, setting 432
defining setup diagram 349
defining structure network, overview 351
defining virtual locations 373
Inventory Locations view
All Inventory Locations Across Organizations, about 369
external location, setting up 369
Generate Orders view, about using 437
Inventory screen, about and fields (table) 436
Inventory screen, about using 369
Pending Orders view, about using 437
Product Inventory subview, about and fields (table) 436
inventory locations, setup
cycle count classes, defining 424
cycle count, setting up 424
cycle count, verifying 364
cycle counting frequency and periods, defining 425
cycle counting parameters, viewing for a location 364
cycle counting replacement, about using for 435
cycle counting and replacement, about using 435
cycle counts parameters, viewing for a location 364
inventory location types, defining cycle count basis for 424
location types, about setting 367
overview of setting up 362
positions, defining roles 372
replenishment relationships, defining 432
setup diagram 349
structure network, overview 351
virtual locations 373
Inventory Options subview
Product Field Service Details view 340
Product Service Details view, about using 368
Products screen, viewing from 88
Service Details view, about and fields (table) 435
Inventory screen
about using 368
Cycle Count view, about using 372
cycle counting and replacement, about using for 435
cycle counting parameters, viewing for a location 364
Cycle Counts view, about and fields (table) 438
Generate Orders view, about using 371
Inventory Location view, about and fields (table) 436
Inventory Locations view, about using 369
inventory status reports, generating 364
inventory status, using to verify 364
Pending Orders view, about using 371
Product Inventory view, about using 370
Relationships view, about and fields (table) 371
Roles view, about 372
Vendors view, about 371
inventory structure
inventory hierarchy structure, about 351
structure diagram 347
inventory tracking
cycle counting parameters, viewing for a location 364
inventory levels, about and examples 352
inventory status reports, generating 364
inventory status, verifying using the Inventory screen 364
inventory status, verifying using the Part Browser 364
reports, list of 374
tracking methods, about 352
inventory transaction types
defining 363
view containing 367
Inventory Transaction Types view, about using 367
inventory transactions
about 355
across organizations, about 373
Allocate button, using to allocate 325
asset numbers by product, viewing 373
asset swaps during repair 530
assets, adding to transactions 365
assets, assigning to transactions 365
Commit buttons, mechanics of 360
conditions for generating, types of (table) 357
customers, shipping to 531
destination mobile client, moving item to another trunk 365
good inventory, returning to 530
hierarchical assets 354, 355
inventory generation rules 357
mobile client transactions, committing 365
negative inventory level, and 353
over-the-counter transaction, receiving a product as 365
products created automatically 368
repair activities, about 528
screen and view 372
serialized assets, quantity definition 468
source mobile client, moving item to another trunk 365
stock transfer, receiving a product as 365
third-party vendor, repairs received from 529
third-party vendors, repairs sent to 529
types, summary of (table) 356
viewing 364
write-off 366
Inventory Transactions screen
Assets view, about using 373
Inventory Transactions view, about and fields (table) 373
using, about 372
Inventory Transactions view
inventory transactions across organizations, about 373
Inventory Transactions screen, about and fields (table) 373
inventory transactions, creating
asset, adding to 365
creating manually 365
destination mobile client, moving item to another trunk 365
source mobile client, moving item to another trunk 365
stock transfer or over-the-counter transaction, receiving product as 365
inventory, products
creating (procedure) 361
restocking products 371
serialization 354
substituting products, about using 368
writing off inventory 366
invoice integration
data set, extending 320
overview 319
service ports, defining 321
terms, invoicing integration 319
third-party invoicing software, disabling 321
Web services, configuring 320
workflow processes, about creating 321
invoice, billable items
expense tracking 309
expenses, recording for an activity 296
labor charges, tracking 308
orders, recording for a service request 296
parts, recording for an activity 296
time, recording for an activity 296
viewing, about and Line Items view 316
invoices
activity invoice, creating automatically 299
auto-invoice feature, about setting up 297
auto-invoice, required information 299
billable activities, recording for a service request 295
business services 579
canceling an invoice 301
charge consolidation plan, creating 297
consolidating charges for invoices 300
creating and modifying 314
creating automatically for service requests 299
creating manually 298
customized invoices, process for setting up 297
discounts associated with agreement 260
field service activity, generating automatically 77
FS - Generate Agreement Charge wo Goto Charges View workflow 303
FS - Generate Agreement Charge workflow 302
FS - Generate All Agreement Charges workflow 303
FS - Generate Conditional Charge Process workflow 304
nonrecurring charges 286
nonrecurring plans 289
overview 283
part, product, and asset tracking 309
payments, associating 301
printing 301
processes for setting up 296
recurring charge line items, processing logic 287
report for 317
service request, generating and printing for 45
status indicators (table) 314
types of charges 286
view 58
workflow to consolidate charges 304
workflows, about 301

invoices and agreements
discounts, viewing 260
invoices and agreement line items, associating 255
line items, modifying 313
renewal terms, creating and modifying 254

Invoices screen
Invoices view, about and fields (table) 314
invoices, about using for 314
Line Item Details view, about and fields (table) 316
Line Items view, about and fields (table) 316
Payments view, about and fields (table) 317

Invoices view
field service activities, about using for 84
invoices, about using for 310
Line Items view, about and fields (table) 316

invoices, viewing
agreement line item billing details 312
billable items, about and Line Items view 316
by activity 310
by contact 313
discounts 260
line item detail, viewing and Details subview 316
Payments view, about and fields (table) 317

ISS Copy Service business service
about 552

Items view, about and fields (table) 85

L
labor charges, tracking 308
laptop computers
remote and local databases, about 364
synchronization of trunk inventory 350
Latitude format, about 115
legacy data and Dispatch Board queries 195
Line Detail subview, about and fields (table) 343
Line Item Details view, about and fields (table) 316
line items
orders, reviewing 380
Line Items Receipts view, about using 386
Line Items subview, about using 386
Line Items view
Actions subview, about using 344
Activity Plans subview, about using 343
Agreements screen, about using and fields (table) 311
Attributes subview, about using 343
Charge Plan subview, about using 312
Invoices screen, about and fields (table) 316
Invoices view, about using 313
Line Detail subview, about and fields (table) 343
Part Locator subview, about using and lists 343
Repair subview, about using 344
Service Order screen, about and fields (table) 341
Totals subview, about using 342
updating order line items, configuration note 342
### Warranty subview, about using 344
### Load button, about and conditions for use 159
### Locate button, about using 325
### locating order line items 336
### Lock Assignment order, about specifying 353
### Lock Schedule flag, about 72, 153
### logging levels, service engines 546
### Longitude format, about 115

## M

### Manual assignment, about and scheduling activities 94
### Marketing Release Document (MRD) adding 454
### materials availability and order status, verifying 76
### Measurement Analysis chart, about 487
### measurements about defining 508
### Measurements view, about using 488
### Messages view 57
### Metrics view about using 248
### Accounts screen 58
### Microsoft Project, synchronizing with mobile clients about synchronizing 364
### Commit buttons, mechanics of 360
### committing transactions 365
### destination mobile client, trunk-to-trunk transfers 365
### inventory transactions, about 359
### parts movement, process overview 366
### source mobile client, trunk-to-trunk transfers 365
### Mobile Inventory Transaction Engine about 33
### asset transactions, about using for 354
### logging levels, modifying 546
### mobile inventory transactions about 359
### Commit buttons, mechanism of 360
### modules, list of 29
### More Info subview, about and fields (table) 438
### More Info view repairs, about using for 536
### warranties, about using for 500
### multiple occurrence change requests, creating 408
### links, breaking 409

## multiprocessor support, about and examples 137

## N

### No Barcode report, about 385
### nonrecurring charges, about 286
### nonrecurring payment plans about 289
### defining 288
### NRC view 289
### nonserialized products creating (procedure) 361
treatment of 88

## O

### one-time charges 289
### on-hand inventory, verifying 76
### operating status and history, viewing by asset 490
### Optimization Engine
   - invoking from script using methods 582
   - invoking using Workflow Manager 156
   - See also Optimizer
### Optimizer
   - appointments, moving and classes of operations 100
   - business priorities, about 97
   - centralized dispatch model, about 105
   - constraints (table) 124
   - Contract Scheduling horizon, defined 98
   - contractual or legal constraints, about enforcing 105
   - cost functions (table) 136
   - defining geographic areas for 113
   - geocode and ZIP Code requirements 114
   - guidelines for optimizing schedules 104
   - obtaining good results, guidelines for 164
   - optimization, levels of 105
   - Optimizer horizon, defined 98
   - optimizing scheduling, role in 97
   - overview 96
   - parts, availability of 155
   - reloading the cache manually 145
   - reloading the cache, about 140, 169
   - reloading the cache, guidelines for 141
   - repairs and service contracts, scheduling concerns 97
   - running optimization manually 156
   - running, requirements for 163
   - schedule parameters (table) 128
   - scheduling calls, high-traffic areas 105
   - scheduling horizons, example 98
   - scheduling horizons, list of 98
service region’s schedule, methods for obtaining 100
stopping optimization 157
troubleshooting 163
Workflow Manager, about using 156

Order Action Types view, about using 341
order line items
activity templates, associating with 343
adjustment line items, logic for 287
allocating using Part Locator Engine 336
attributes, selecting for customizable products 343
deallocating (procedure) 337
fields in view 341
fulfilling (procedure) 337
invoicing logic for nonrecurring charges 286
line items processed, viewing 386
locating parts using Part Locator subview 343
locating using Part Locator Engine 336
pick tickets, finding for line item 378
pricing details, viewing for 342
reviewing line items 380
selected order line item, getting more details on 343
transactions, viewing 344
updating, configuration note 342
warranties, associating with 495
warranties, verifying for 497

order line items, finding 336
order line items, receiving
incomplete documentation, reviewing 381
order, receiving 379

order line items, shipping
allocated items and associated pick ticket, viewing 382
allocated items and shipment, viewing 383
qualified items, viewing 384
Repair Pick Ticket view, about viewing items allocated for repairs 384
serial numbers 383
shipping orders, viewing 378

Order Types view, about using 341
order-entitlement-based pricing, about and configuring 204
orders
All Pending Orders view, about using 385
billable orders, recording for service request 296
contract-based pricing 250
defined and field service 27
Fulfillment Engine, using to fulfill orders 336
Generate Order view, about generating by
Replenishment Engine 437
generating agreement documents 234
Order Action Types view, about using 341
Order Types view, about 341
pick ticket, generating for an order 336
pick tickets, relationship with 379
receiving hierarchical assets 378
related agreements, viewing 260
repair orders, creating 534
restocking inventory 371
service or internal orders, allocating parts manually 335
service requests, reviewing associated with 44
status, verifying for field service activity 76
view 59

orders, receiving
line items for all order, reviewing 380
line items with incomplete documentation, reviewing 381
overview 376
pending orders (purchase, repair and return material), viewing 385
receiving (procedure) 379
repair orders, creating 534
related agreements, viewing 260
Unknown Receipt records, adding 381
validations for transactions 377
viewing received orders 386

orders, setting up
Fulfillment and Part Locator Engines, setting asynchronous or synchronous 335
order action types, defining 334
types of orders, defining 334

orders, shipping
hierarchical assets, considerations 378
pick ticket generation, process overview 375
pick ticket, finding for line item 378
pick tickets, consolidating 379
Process Shipment button, processes invoked 376
reports 385
Shipped Line quantity conflict 383
shipping procedure 378
validations for transactions 377

organizations
defined 47, 369
inventory locations across organizations 369
inventory transactions across organizations, about 373
primary organization, setting for inventory location 363

overtime, about defining and scheduling 107, 117
P
Parameter Sets view, about 134
parameters
Cycle Counting Engine (table) 422
fulfillment and Part Locator Engine, setting
parameters (procedure) 333
Fulfillment Engine and Part Locator Engine,
about and table 328
Fulfillment Engine, table of 331
precedence rule for cycle counting 418
Preventive Maintenance Engine (table) 513
Replenishment Engine (table) 430
Replenishment Engine, configuration of
(table) 428
Parameters view, about 134
parameters, scheduling
about 127
appointments, moving about and classes of
operations 100
defining parameter sets 134
viewing associated service regions 134
parent service regions
specifying for scheduling 112
viewing in the Dispatch Board Gantt
chart 195
Part Browser screen
inventory status, using to verify 364
on-hand inventory, using to verify 76
Part Locator, about and differences from 89
Product Inventory view, about using 372
service inventory, about using for 372
Part List view
Counted Serial Numbers subview, about
using 440
Cycle Counts view, about and fields
(table) 440
Part Locator Engine
about 33
component job parameters, setting up 335
Fulfillment Engine, compared to 323
inventory line items, status requirement 324
line item fulfillment, about 328
logging levels, modifying 546
order line items, allocating 336
order line items, finding 336
parameters, about and table 328, 333
parameters, setting (procedure) 333
synchronous/asynchronous operation,
setting 335
Part Locator subview, about using and
lists 343
Part Locator, differences from Part Browser
screen 89
Part Movement Administration view, about
using 366
part movements
verifying in the field 78
Part Tracker view
Activities screen, about and fields (table) 82
Commit button, about 85
invoices, about using for 309
service industry, about using for 373
parts
allocating manually 335
availability of 155
billable parts, recording for activity 296
customers, shipping repaired parts to 531
exchanged, returning to customer 534
on-hand inventory, verifying 76
physical location in inventory 353
Pick Ticket view, about viewing allocated
parts 382
recording movement in the field 76
repaired parts, returning to the
customer 534
service parts information, about 31
specifying manually for cycle counting 425
tracking by activity 309
trunk inventory, verifying 76
parts movement
asset transaction generation 354
Commit buttons, mechanism of 360
defective parts, receiving 527
good inventory, returning 530
mobile clients, process overview 366
mobile inventory transactions, about 359
physical location, tracking 352
recording movement 76
tracking by asset or serial number 373
patch requests, creating
about 414
approving and shipping patch requests 414
change request, generating from 414
process of creating 398
payment plans
nonrecurring payments 289
usage-based plans 291
payments
invoice payments, viewing and Payments
view 317
invoices, associating 301
Payments view, about and fields (table) 317
Pending Internal Orders subview, about
using 385
Pending Orders view
cycle counting and replenishment, about
using for 437
Relationships view, about using 437
service inventory, about using for 371
Vendors view, about using 437
Pending POs/ROs/RMAs subview, about using 385
performance
improving workflow performance 307
performance measurements
service requests, viewing for 45
performance metrics
entitlement, adding manually 238
Metrics subview, about using 256
Pick Ticket view
Serial Numbers subview, about and fields (table) 383
pick tickets
allocated line items and pick tickets, viewing 382
allocated line items and shipment, viewing 383
consolidated pick tickets, viewing 384
consolidating (procedure) 379
line item, finding for 378
order, generating for 336
orders, relationship with 379
overview 375
Pick Ticket Details report, about 385
products and quantities, viewing on one pick ticket 385
qualified order line items, viewing 384
Shipments view, about using and fields 381
waybills, filling in 379
Planned Completion, about making schedule changes 140
Planned End, about making schedule changes 140
Plans subview, about using 523
Plans view, about using 519
positions
defining with locations 372
inventory locations, associating with 362
postal code
See ZIP Code
preventive maintenance
activities, reviewing by asset 477
asset, reviewing generated activities for 518
assets and preventive maintenance plans, associating with 516
business services 580
Event triggers, about 509
history, viewing 523
module, about 32
overview 501
plans, setup overview 509
preventive maintenance engine, about 33
preventive maintenance plans, defining 516
service request templates, creating 517
status of plan, viewing for an asset 477
Threshold triggers, measurements and readings 508
Time Interval triggers, about 505
triggers, prioritization 504
triggers, rules and examples 503
usage triggers, about 508
Preventive Maintenance Engine
activities, about creating 510
asset, validating PM plans for 510
FSPPrevMnt server component 512
logging levels, modifying 546
logic (diagram) 501
parameters, listed (table) 513
parameters, setting 516
running 511
synchronous or asynchronous operation, setting 515
system preferences, changing 516
triggers, defining for preventive maintenance plans 516
preventive maintenance plans
activity templates, associating with 517
agreements, associating with 516
asset, running for 517
associating actions 239
entitlements, associating manually 239
generating for agreements and entitlements 239
preventive maintenance action, associating 239
use with entitlement templates 248
Preventive Maintenance screen
Actions view, about using 522
History view, about using 523
Plans view, about using 519
Products view, about and fields (table) 521
Triggers view, about using 520
using, about 518
Preventive Maintenance subview, about using 523
Preventive Maintenance view, about using 489
Price Details view, about using 257
price lists, about tracking 285
pricing
aggregate, about setting up 285
asset-based 203
contract-based pricing 250
nonrecurring payments 289
service pricing and exceptions     249
time exceptions     249
usage-based plans     291
use plan pricing, defining     291

**Pricing Administration screen**
Asset Mapping view, about and fields (table)     484
using, about     483

**printing**
barcodes in reports     541
invoices     301

**problem resolutions**
setting up     63

**Process Receipt button, about processes generated**     377

**Process Shipment button, processes invoked**     376

**processor, about multiprocessor support and example**     137

**Product Administration screen**     337
fulfillment, about using for     337
Product Field Service Details view, about and fields     338
Products Service Detail view, about     368
Products view, about using     368
service industry, about using for     368

**product builds, adding**     402

**Product Field Service Details view**
Inventory Options subview, about     340
Product Administration screen, about and fields (table)     338
Substitute Products subview, about and using     340

**Product Inventory subview, about and fields (table)**     436

**Product Inventory view**
Assets subview, about using and fields     370
Inventory Level subview, about using     372
Inventory Level subview, about using and fields     370
Inventory screen, about using     370
Part Browser screen, about using     372
Substitutes subview, about using     372

**product prototypes, about**     464

**product serialization**
about     354
serialized compared to nonserialized     354
serialized products, creating     361

**Product Service Details view**
Inventory Options subview, about using     368
Product Administration screen, about using     368
Substitute Product subview, about using     368

**products**
allocation of, specifying     361
allocation, specifying     361
asset, specifying     361
associating inventory levels with     370
change requests, verifying associated with a product     46
displaying information about using     368
in inventory locations     372
inventory locations for, viewing     370
inventory, adding to     362
locating and allocating, views for     338
nonserialized products, creating     361
Products view, about associating with PM plans     521
repair history, verifying     46
restocking     371
returning to good inventory     530
serialized and nonserialized, treatment of     88
serialized compared to nonserialized     354
service pricing exceptions     250
service products and asset-based pricing     247
substitute service product suggestions, viewing     88
warranties, verifying for     496
warranty coverage, checking     496
warranty coverage, specifying     494

**products and agreements**
agreement line item attributes, viewing     253
agreement, adding sold under     228
products in an agreement, viewing     226

**products and assets**
asset-based pricing     203
assets by products for a location, viewing     370
assets, specifying     361

**products and entitlements**
associating     251
associating manually     238
entitlement template, defining     221
products covered by entitlement, viewing     250

**Products screen**
cycle counting and replenishment, about using for     434
field service activities, about and fields (table)     88
Service Details view, about using     434
Substitute Products subview, about     89
warranties, about using for     500

**Products subview, about using**     499

**Products view**
Assets subview, about using     522
fulfillment, about and fields (table)     337
Index ■ Q

Preventive Maintenance screen, about using and fields (table) 521
service inventory, about using for 368

project teams, about setting up 449

purchase orders
about viewing orders arriving from external locations 385

Q
Qualified Lines subview, about using 384
quality management
area-subarea combination, adding 401
change requests, logging 393
features of 390
list of values, setting up 399
overview 389
process example 391
release product builds, releasing 402
roles and responsibilities, about setting up 399
setup and maintenance, list of 392
Siebel Quality and Release Manager, about 390
querying
closed change requests, querying for 413
existing change requests, querying for 403
unassigned change requests, querying for 406

quotes
entitlement-based quote pricing 205
generating agreement documents 234

R
rate lists, about tracking 285
readings (meter) and triggers 508

Readings view
Activities screen, about using 84
Assets screen, about using 487

receipts
All Unknown Receipts view, about using 387
Line Items subview, about listing items received in 386

Receive Orders views
Line Items subview, about using 386
Received Line Item subview, about using 386
Receiving screen, about using 386
Serial Numbers subview, about using 386

Receive Unknown view, about using 387

Receiving screen
All Pending Orders view, about using 385
All Unknown Receipts view, about using 387
Line Items Receipts view, about using 386
Receive Orders views, about using 386
shipping and receiving, about using for 385

recommended tools, about and repair activities 69

Recost view, about using 486
recurring charges, about 286
registration of assets 469

Related Solutions view 66

Solutions screen 67

Relationships view
Assets screen, about using 488
Inventory screen, about and fields (table) 371
Pending Orders view, about using 437

release features
creating 453
ingineering subtasks, adding 457
engineering tasks, linking to 456
engineering tasks, monitoring 457
features, identifying without linked MRDs 455
monitoring features and MRDs 454
new features and subfeatures, adding 453
technical documentation, linking to 462
test plans, linking to 457

Release Manager
access lists, role of 449
activity templates 452
administrator setup procedure process 447
area-subarea combinations, adding 464
business scenarios 444
ingineering procedures overview 447
features, creating 453
features, identifying without linked MRDs 455
list of values, setting up (table) 450
maintenance procedures 448
marketing procedures overview  447
Microsoft Project, synchronizing with  464
monitoring features and MRDs  454
monitoring release items  454
overview  441
product prototypes, adding  464
product release, process diagram  444
product release, process overview  443
project teams, setting up  449
quality assurance procedures  447
releases, types of  449
Special Tag, list of values (table)  452
Status field, about setting up and example  450
structure  442
structure diagram  442
subfeatures, creating  453
technical publications procedure, overview of  448
test results, monitoring  461
test strategies, creating  459
Release Manager, engineering
engineering tasks, monitoring  457
procedures overview  447
subtasks, adding  457
tasks, linking to features  456
Release Manager, marketing
MRDs, adding  454
procedures overview  447
Release Manager, technical publications
activity plans, adding  463
features, adding and linking to  462
procedures, overview of  448
Release Manager, test plans
creating and linking to  457
updating  465
release product builds, adding  402
repair history
product, verifying for  46
repair items
good items, returning to inventory  530
receiving items, overview  527
repair numbers, viewing  344
repair orders
creating  534
external locations, about viewing orders arriving from  385
Repair Pick Ticket view, about  384
Repair subview, about using  344
repaired items
Repair Pick Ticket view, about using to view  384
vendors, receiving from  380
repaired part, returning repaired parts to

customer  534

repairs
activities and activity plans, generating  533
activities, recording time and expenses  535
activities, viewing and updating  533
asset swapping during repair  530
asset’s repair history, viewing  535
assets, reviewing for selected asset  477
customers, shipping to  531
defective items, processing for repair  531
defective part, shipping to external repair provider  534
defective parts, receiving  527
defective parts, receiving by stock transfer  532
defective parts, receiving over the counter  532
defective parts, tracking movement of  533
inventory transactions, about  528
pending orders, viewing  385
received repair order, viewing  386
repair activities and activity plans, about  528
repair activities, setting up  531
repair histories, about attaching to assets  528
repair number, about  527
repair order, creating  534
repair orders, about  528
repair records and orders, linking  533
repair records, creating  533
repaired or exchanged part, returning to customer  534
serialized product numbers, about generating  527
service contract scheduling concerns  97
third-party vendor, received from  529
third-party vendors, repairs sent to  529
workflow process steps  525
Repairs screen
using, about  535
warranties, about using for  500
Repairs view
assets, about using for  488
repairs, about using for  536
replacement cost of asset, calculating  478
replenishment
business services  581
inventory location and vendor, associating  433
inventory location relationships, setting  432
inventory, procedures for  432
maximum and minimum stock levels, setting  432
orders, verifying pending  433
overview 427
Pending Orders view, about viewing internal orders 437
Pending Orders view, about viewing pending orders 437
restocking orders 371
Source Locations subview, about identifying sources for target locations 437
Target Locations subview, about listing target locations 437
Vendors view, about viewing vendors by location 437
vendors, defining 432

Replenishment Engine
about 33
configuration parameters (table) 428
Generate Orders view, about automatic order generation 437
implementation logic, setting 430
invoking 431
logging levels, modifying 546
overview 427
parameters (table) 430
system preferences (table) 428

reports
activity reports (table) 87
activity reports, described 87
agreement reports, viewing 261
barcode, printing in 541
barcodes, changing fonts for 543
Customer Invoice report 317
Cycle Counting Detail report 440
inventory reports, list of 374
inventory status reports, generating 364
invoice report 317
repairs, list of 536
service inventory reports. list of 374
shipping 385

resolution documents
editing 66
editing, allowing 64
solution, adding to 63
view 67

Response Time metric, about using 256
Return Material Authorizations (RMAs)
defective part, receiving with an RMA 531
described 525
external locations, about viewing orders arriving from 385
pending orders, viewing 385
received RMA, viewing 386
repair record, associating with 533
RMA repair and return, about shipping to a customer 531

revenue line items, adding to agreements 233
revenue plan templates, creating 216
revenue plans, adding to agreements 233
Revise button, about configuring 279
role priorities
adding to account service teams 475
adding to asset service teams 474
setting for employees 119
using to define assignment rules 475
roles
about 119
Roles view, about 372
ROs (repair orders)
See repairs

S

S_SHIPMENT table and Generate PickTickets command 325
S_ZIPCODE table
gecode data, importing 114
Schedule Hours view, about using to define day and time periods 108
Schedule view, about and fields (table) 85
scheduler
See Siebel Scheduler
schedules
ABS heuristic methods 100
constraint sets, about creating 126
constraints, about creating 126
creating and setting schedule hours 107
defined 94
employee, associating a schedule with 117
employee, defining exception hours 117
entitlements, associating with 238
exceptions and exception hours, adding to 109
locking 153
Optimizer heuristic methods 100
reloading migrated data, about 171
service region, associating schedule with 112
schedules, making changes to
about 140
caution, about making manual changes 141
scheduling
ABS and Optimization cache management 169
activities, tools for assigning and scheduling 94
booking activity appointments, about 150
business requirements 95
information displayed on Dispatch Board 175
optimization, levels of 105
optimizing for high-traffic areas 105
process for scheduling activities 148
process for setting up 106
server inventory system, integration with 104
time periods, example 98
time periods, list of 98
wireless updates, guidelines for 103

Scheduling Administration screen
Constraint Sets view, about 126
Cost Functions view, about 134
Parameter Sets view, about 134
Service Regions List view, about 111
Time Windows view, about 121

scheduling, setting up
creating constraint sets 122
creating parameter sets 127
creating time windows 122
employee availability and schedules 116
guidelines 102
reloading ABS and Optimizer caches 140
setting server component task parameters 139
setting server key mappings 136
setting Server Request Broker tasks 140
universal time codes, about and list of 99

scheduling, using
adding scheduling information to activities 148
booking appointments from the Activities screen 151
booking appointments from the Service screen 152
canceling appointments 152
launching the Optimizer 155
locking schedules and assignments 153
running contract scheduling 157
stopping the Optimizer 157

serial numbers
allocating inventory, about selecting for 383
assets, serialization of 468
Counting Serial Numbers subview, about input serial numbers 440
populating in a cycle count 427
Serial Numbers subview, about recording serial/asset numbers 386
transactions and 354

Serial Numbers subview
Pick Ticket view, about and fields (table) 383
Receive Orders views, about using 386

serialized orders, receiving 379

serialized products
creating (procedure) 361
nonserialized, compared to 354
repair number, about generating for 527
serial numbers, about for Allocated line items 383
treatment of 88

server component task parameters
specifying values for 139

server inventory system, about integration with 104

server key mappings
about 136
setting up 138

Server Key Mappings view, about 138

server processes
enhancing performance of 166
setting up multiprocessor support 137

Server Request Broker
relationship with Scheduler, about 167

servers component aliases, about and table 545

service activities
billing exception, defining 222
resolution, recording 44
skills required to complete, recording 78
steps, recording additional recommended 77
template, creating 38

Service Administration screen
All Exceptions view, about 109
All Schedules view, about 107
cycle counting and replenishment, about using for 433
Exception Hours view, about 109
Inventory Location Types view, about and fields (table) 434
Parts Movement Administration view, about using 366
preventive maintenance, about using for 518
Schedule Hours view, about 108
Service Inventory view, about using 367
Service Request Template Activities view, about using 518
Service Request Templates view, about using 518
Warranties view, about and fields (table) 498
warranties, about using for 498

service center, handling sequence of inbound calls 28

service charge
quote, generating 43

Service Details view
about 57
Inventory Options subview, about and fields (table) 435
Products screen, about using 434
Service screen, about 500
Substitutes subview, about using 435
symptom codes for a service request 58

service engineers
activities, tracking 31
information, tracking 31

service events
activities, tracking 31

Service Hours view 58

service inventory
cycle counting parameters, viewing for a location 364
flow of goods (diagram) 346
hierarchy structure, about 351
inventory status reports, generating 364
inventory type, defining 362
inventory, scrapping 366
locations, overview and location types 348
overview 345
and product serialization 354
products, adding to inventory 362
reports, list of 374
Service Inventory view
Inventory Level Categories subview, about using 367
Inventory Location Types subview, about 367
Inventory Transaction Types subview, about using 367

service inventory levels
creating (procedure) 362
defining (procedure) 363

service inventory locations
creating (procedure) 362
defining relationships between locations 363
employee positions, associating with 362
organizations, associating with 363
tracking, methods of 352
vendors, associating with inventory locations 363

service inventory transactions
about 355
asset transactions, about 354
asset, adding to 365
destination mobile client, moving item to another trunk 365
mobile client transactions, committing 365
source mobile client, moving item to another trunk 365
stock transfer or over-the-counter transaction, receiving product as 365
transaction types, defining 363

Service Inventory view
Inventory Level Categories subview, about using 367
Inventory Location Types subview, about 367
Inventory Transaction Types subview, about using 367

service metrics, setting up 39

Service Order screen
Fulfillment view, about using the Auto Receive flag 344
fulfillment, about using for 341
Line Items view, about and fields (table) 341
warranties, about using for 499

service orders, allocating parts, manually 335

service parts information
See parts

service ports, defining 321

service pricing, grouping multiple products 247

Service Profile view 48
Service Providers subview, about using 499

service providers, identifying for a warranty 497

service regions
about and defining 109
caches, about 110
Dispatch Board, adding to 195
moving activities between 144
reloading data automatically to the ABS 146
reloading data manually to the ABS 144
reloading data manually to the Optimizer 145

Service Regions view
Activities view, about 143
Cost Functions view, about using 135
Employees view, about 142
Time Windows view 122
Zip Codes view, about 114

service regions, setting up
associating schedules with 112
break time, recording 120
cautions, defining service area and ZIP Code 113
creating service region records 110
defining geographic areas for 113
employee travel conditions and travel time, about 121
geocode data and ZIP Codes, about 113
geocode data, importing 114
geocode data, specification for 115
service region data, loading and reloading 169
specifying parent service regions 112
service reports, about 61
service request activities
activity plan, defining 56
new activity, adding 77
Service Request Template Activities view, about using 518
service request templates
about 509
Actions view, about associating PM plans with 522
preventive maintenance service request 509
preventive maintenance templates, creating for 517
Service Request Templates view, about using 518
service requests
Agent Committed, about 53
asset swapping during repairs 530
asset, generating plans for 517
audit trail content 62
audit trail overview 61
billable activities, recording 295
change request, associating with a solution 64
change request, generating from 404
default opened date and time, setting 39
defined and field service 27
entitlements, verifying and selecting an entitlement 239
invoices, creating automatically 299
invoices, logic for generating 285
numbering, about 52
organizations, across all 50
problem resolutions, setting up 63
processing workflow 37
repair record, associating with 533
resolution document, adding to a solution 64, 66
resolution documents, allowing editing 64
service activity template, creating 38
service metrics, setting up 39
Siebel Remote users, about audit trail 62
solution, adding 63
solutions, about 63
solutions, associating with 64
solutions, associating with each other 64
symptom codes 58
Verify button, about 52, 53
Verify button, entitlement rules 54
viewing 257
views 51
warranty, verifying for 496
Service Requests view
Solution Administration screen 66
Solutions screen 67
service requests, logging
account, contact, and asset, verifying 41
activity plan, associating with a service request 43
activity, associating with 43
change request, associating with service request 42
entitlement, selecting for a service request 41
logging a service request 41
process flow 40
service agreement and entitlements, verifying 41
service charge quote, generating 43
valid hours for completing service request, verifying 42
waranties, verifying 42
service requests, updating
activities, updating for a service request 43
assets, adding 44
assets, adding additional to service requests 44
change requests, verifying associated for a product 46
closing a service request 45
correspondence, generating 45
decision issues, finding for a service request 46
field part movements, verifying 44
invoice, generating and printing 45
orders, reviewing associating with service requests 44
performance measurements, viewing for a service request 45
product, verifying repair history 46
resolution, recording for a service activity 44
service request, associating with a related service request 46
Service screen 49
Activities view, about and buttons (table) 152
appointment booking, conditions for 152
warranties, about using for 500
Service screen, using to assign field service engineers 197
service support, setting up
service activity template, creating 38
service metrics, setting up 39

**service-based pricing**
- about 204
- defining 204

**SFPrevMnt component request parameter, about** 512

**shifts, about and rate types** 118

**Shipments view**
- Allocated Lines subview, about and fields (table) 382
- Consolidation view, about using 384
- Pick Ticket view, about and fields (table) 382
- Pick Tickets view, about and fields (table) 382
- Repair Pick Ticket view, about 384
- Shipped Line subview, about and fields (table) 383
- Shipping screen, about using and fields (table) 381
- Waybill view, about and fields (table) 384

**Shipped Line quantity and De-Allocation transactions** 383

**Shipped Line subview, about and fields (table)** 383

**shipping**
- agreements, adding information to 228
- costs, about using Consolidation view to reduce cost 384
- De-Allocate transaction 376
- hierarchical assets, considerations 378
- pick ticket generation, process overview 375
- pick ticket, finding for line item 378
- pick tickets, consolidating 379
- Process Shipment button, processes invoked 376
- reports 385
- Shipped Line quantity conflict 383
- shipping, procedure 378
- validations for transactions 377
- waybills, filling in for pick tickets 379

**Shipping screen**
- Shipments view, about using and fields (table) 381
- shipping and receiving, about using for 381

**ShowBarcodeToolbar parameter, about** 539

**Siebel Advanced Contracts**
- about 263
- Add Benefits button, about configuring 279
- benefit, creating for an agreement 271
- common agreement types 264
- compliance, verifying 272
- Condition Evaluator Service 278
- conditions, adding to benefits 272
- Contracts Accumulator Service 274
- Contracts Resolver Service 275
- Entitle button, about configuring 279
- managing advanced contracts, process of 265
- new benefit template, creating 266
- new condition template, creating 268
- Revise button, about configuring 279
- scenario 264
- term templates, creating 217
- terms defined 263
- terms, adding to agreements 270
- workflows, about 273

**Siebel Appointment Booking System**
- See ABS

**Siebel Contract Management**
- about 31

**Siebel Contracts**
- about 31

**Siebel data model and third-party invoicing software**
- about extending the data set 320

**Siebel Field Service Analytics Applications**
- about 33

**Siebel Invoice ASI, about** 319

**Siebel Invoice business service, about** 319

**Siebel Professional Services**
- about integrated with 33
- field service engines 33

**Siebel Remote**
- synchronizing, about 364

**Siebel Scheduler**
- about 30
- balancing service region CPU load 167
- defined 94
- enhancing performance of 166
- relationship with Server Request Broker, about 167

**Siebel Shipping and Receiving**
- about 32

**Siebel Wireless**
- using, about 33

**signals, using with agreements** 211

**skills**
- recording required skills 78
- skills-based routing, about 119

**soft constraints, about** 123

**Solution Administration screen**
- Change Requests view 66
- Related Solutions view 66
- Resolution Documents view 66
- Service Requests view 66
- service support, about using for 65
- Solution Categories view 66
- Solutions list, about and views 66
Solution Categories view 66
solutions
adding a solution 63
associating with each other 64
change request, association with a solution 64
resolution documents, adding 64, 66
resolution documents, allowing editing 64
service request, associating with a solution 64
Solutions list, about and views 65
Solutions screen
Change Requests view 67
Customer Satisfaction Survey view 67
Related Solutions view 67
Resolution Documents view 67
Service Requests view 67
service support, about using for 66
Solutions view 67
Solutions view 59, 67
Source Locations subview, about using 437
SRVRMGR command, about 545
Steepest search optimization method, about 101
Steps view, about and fields (table) 86
Substitute Products subview
Product Field Service Details view, about and using 340
Product Service Details view, about using 368
Products screen, about using 89
viewing 88
Substitutes subview
Product Inventory view, about using 372
Service Details view, about using 435
substitution, conditions for auto-substitution 330
Survey view
about 58
system preferences
Cycle Counting Engine, changing 423
Cycle Counting Engine, location and list of 421
Dispatch Board 178
Fulfillment Engine, table of 331
Preventive Maintenance Engine (table) 512
Replenishment Engine S_SYS_PREF table 428
Verify button 219

T
Tabu search optimization method, about 101

Target Locations subview, about using 437
Task UI application tasks
Assets to Agreements 280
Execute Field Task Start to Finish 89
templates
activity templates, associating with preventive maintenance plans 517
activity templates, setting up 452
benefit template, creating 266
new condition template, creating 268
service activity template, creating 38
service request template, creating for preventive maintenance 517
term templates, creating 217
terms
adding agreements to 270
test passes
change requests, associating with 461
linking to test plan 460
test plans
activity plans, adding to 459
creating and linking to 457
test pass, linking to 460
updating 465
test results, monitoring 461
test strategies
creating 459
updating 465
third-party invoicing software
disabling 321
service port definition 321
Siebel data model, extending to accommodate 320
Siebel Invoice integration, overview 319
terms, invoicing integration 319
Web service configuration 320
workflow, about defining 321
third-party vendors
asset swapping during repair 530
defective parts, shipping to 534
repaired items, receiving 380
repairs, received from 529
repairs, sent to 529
replenishment, defining for 432
Vendors view, about viewing by replenishment location 437
Threshold subview, about and fields (table) 521
Threshold triggers, measurements and reading 508
time and exception pricing 249
time codes, about and list of 99
Time Interval subview, about and fields
Index

U

Unknown Receipt records, adding 381
Unscheduled Activities list, about 175
Unspecified Release release type, about 402
Upgrade transaction, about 469
Uptime Data view, about using 490

Usage plans
adding service product measurements 290

Usage subview, about and fields (table) 520

Usage triggers, about 508
usage-based charges
estimated usage, calculation fields 287
invoice charge, about 286
line items, invoicing logic 287
usage-based payment plans
about 291
pricing, defining 291
usage-based pricing, usage data, about capturing 487

use plans
adding pricing information 292
creating 291
setting up 289

user preferences
Dispatch Board 178

V

Value view
Assets screen, about using 486
Recost view, about using 486

Variance view, about and fields (table) 440

vendors
asset swaps during repair 530
associating with inventory locations 371
inventory location, setting a vendor for 433
inventory locations, associating with product, setting up for 432
repair items, receiving from 380
repairs received from 529
repairs sent to 529

Vendors view
Inventory screen, about 371
Pending Orders view, about using 437

Verify button
about 52, 53
system preferences for verifying 219

table 520
Time Interval triggers, about 505
time recording
repair activities, recording for 535

Time Tracker view
field service activities, using for invoices, about using for 308

Time Window Details view, about 122
time windows
creating for schedules 122
viewing associated service regions 122

Time Windows view
Scheduling Administration screen, about and using 121
Service Regions view, about 122
Time Window Details view, about 122

tracing
Cycle Counting Engine, configuring 425
levels, about setting for Cycle Counting Engine 423

Transaction view, about using 487
trace
conditions and travel time, about and setting fields 121
employee travel conditions and travel time, about and field values 121

triggers
Event triggers, about 509
measurements and readings, about associating with an asset 508
preventive maintenance plans, defining for 516
prioritization of date and time interval triggers 504
rules and examples 503
Threshold triggers, measurements and reading 508
Time Interval subview, about setting time interval 520
time interval triggers, about 505
Usage triggers, about 508

Triggers view
Event subview, about and fields (table) 521
preventive maintenance, about using for 520
Threshold subview, about and fields (table) 521
Time Interval subview, about and fields (table) 520
Usage subview, about and fields (table) 520

troubleshooting
ABS configuration 160
Optimizer configuration 163

trunk inventory
about 350
database synchronization 350
source mobile client, moving item to another trunk 365
verifying 76
turning on alarms for an activity 75
system preferences, setting 219

W

warranties
asset, verifying for 42
asset, verifying warranties and related information 496
concurrent warranties, about 493
defective parts, verifying warranty status 498
order, verifying for 497
overview 493
product, verifying warranties for 496
products, checking coverage 496
service providers, identifying 497
service request, verifying for 496
warranty recovery, tracking 497

Warranties view
Products screen, about using 500
Products subview, about using 499
Service Administration screen, about and fields (table) 498
Service Providers subview, about using 499

warranties, setting up
asset, associating with automatically 495
assets and warranties, associating 495
covered products, specifying 494
new warranties, creating 494
order line items, associating 495
warranties and warranty service providers, associating 494
Warranties screen and views 498

Warranty subview
Line Items view, about using 344
Service Order screen, about using 499

Warranty view, about using 499
Waybill view, about and fields (table) 384

waybills
about 375
pick tickets, filling in 379
Waybill view, about using to associate with pick tickets 384

Web services, configuring for invoice integration 320
wireless application protocol (WAP)-enabled phone
about using Siebel Wireless 33
wireless devices
computing support, about 30
Workflow Manager, scheduling 156
workflow processes, about creating for invoicing functions 321
workflow processes, improving performance 307

workflows
Siebel Advanced Contracts, about 273

Z

ZIP Codes
about 113
about using in multiple service regions 116
data cleansing, about 115

Zip Codes view
about 114